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Chapter 1: Introduction and 
Initial Setup 
From front desk to operatory, Dentrix Enterprise provides proftable integration solutions for managing a 
variety of information, including patient demographics, clinical details, and production analyses. Dentrix 
Enterprise can boost staf productivity, enhance professionalism, increase collections, help keep your chairs 
full, and improve your bottom line. 

Tis chapter covers the following topics about the various Dentrix Enterprise modules and the basic steps to 
set up and begin using the program in your ofce: 
• Dentrix Enterprise Overview 

• Opening Dentrix Enterprise Modules 

• National Confguration Settings 

• Setting Up Clinics 

• Setting Up Tird-party Integrations 

• SSetting Up Clinic Resources 

• Setting Up the Appointment Book 

• Setting Up the Ledger 

• Setting Up Continuing Care Types 

• Setting Up Fee Schedules 

• Editing Procedure Codes 

• Setting Up Multi-codes 

• Customizing Practice Defnitions 

• Setting Up Practice Defaults 

• Setting Up Auto Chart Numbering 

• Setting Up Default Printers 

• Setting Up Security 

• Setting Up Program Preferences 

Before setting up your Dentrix Electronic Dental Record (EDR), it is important to understand the 
relationship between RPMS and Dentrix.  An interface has been installed that allows information to fow or 
be “pushed” from one program to the other.  RPMS will push each patient’s demographics ONLY (name, 
address, birth date, SS#, and so on) into Dentrix. 

If dental staf enter a change of address into Dentrix it will not be saved because the demographic information 
DOES NOT fow from Dentrix back into RPMS.  Once that new information is entered into RPMS, 
however, within seconds, the new information will be displayed in Dentrix because it will automatically fow 
over to Dentrix from RPMS. 

At this time,  the only information that is pushed from Dentrix over to RPMS are the completed procedures 
done in the Patient Chart—the “coding” is sent for billing purposes from the work done in the Patient Chart. 
RPMS > Patient Information > Dentrix 
Dentrix > Completed ADA and IHS Procedures in Patient Chart > RPMS 
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Dentrix Enterprise Overview 
Te following fve main modules of Dentrix Enterprise each manage specifc types of information: 

• Family File – Te Family File module can help you enter and manage patient information, such as a 
patient’s name, address, employer, insurance information, notes, and continuing care (recall or recare). 

• Patient Chart – Te Patient Chart module can help you enter and manage the clinical information for 
your patients. In the Patient Chart, you can chart existing, completed, and recommended procedures. 
Additionally, you can keep extensive and detailed notes regarding patient care. 

• Ledger – Dentrix Enterprise automatically posts procedures completed in the Patient Chart in the Ledger, 
where patient accounts are managed. Te Ledger contains a record of all fnancial transactions entered 
into Dentrix Enterprise, including charges, payments, and adjustments. You can create claims and pre-
treatment estimates from the Ledger. Te Ledger also provides you with information concerning patient 
portions versus insurance portions, deductibles owed, and payment arrangements. 

• Ofce Manager – Te Ofce Manager ofers useful, customizable reports and lists (reports are also 
available from the DXOne Reporting module). Te Ofce Manager works with Microsoft Word to 
help you create efective, professional-looking letters: welcome letters, congratulatory letters, thank-
you notes, a variety of appointment and continuing care reminders, progress reports, and collection 
notices. Additionally, the Ofce Manager contains a set of utilities that you can use to customize Dentrix 
Enterprise to ft your needs. 

• Appointment Book – Te Appointment Book module can help you maximize production by using 
visual, goal-oriented scheduling. In the Appointment Book, you can make changes to scheduled 
appointments easily and reschedule appointments by clicking and dragging them. Convenient toolbars 
and fip tabs help you navigate through the Appointment Book, search for open times, organize 
appointments and notes, record broken appointments, and print route slips. Also, you can clearly see the 
times when a clinic is closed and when a provider is unavailable. 

In addition to the fve main modules, Dentrix Enterprise also includes the following components and features: 

• Treatment Planner – Te Treatment Planner can help you provide patients with easy-to-understand 
treatment options. 

• Perio Chart – With the Perio module, you can record periodontal measurements, such as plaque, pocket 
depth, and bleeding. 

• Quick Letters – Dentrix Enterprise works with Microsoft Word to help you quickly create a letter for a 
patient. You can choose from over forty pre-defned letter templates for your practice correspondence or 
create your own. 

• Quick Labels – With Quick Labels, you can quickly print a variety of labels for a patient. 

• Continuing Care – Continuing Care can help you monitor your patients’ on-going dental care. 

• Send Message – With the Send Message feature, you can create and send email messages for patients 
from within Dentrix Enterprise. 

• Patient Questionnaire – Te Patient Questionnaire module can store information from new patient 
forms, health history updates, and other forms used in your ofce to collect information from patients. 

• Prescriptions – Te Prescriptions module can help you quickly create prescriptions and accurately track 
medicines prescribed to your patients. 

• Ofce Journal – Like a journal of your daily activities, the Ofce Journal has two main functions: to keep 
a record of past events and remind you of events in the future. 
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• Document Center – Te Document Center can help you create a truly paperless ofce. You can scan, 
capture, and import documents (such as patient medical and dental history, proof of income, insurance 
cards, patient letters, EOBs, and referral letters) or images (such as patient pictures and X-rays). You can 
then attach these documents to patients, providers, insurance carriers, and referral sources, or you can 
print or email them. 

• Collections Manager – Te Collections Manager can help you increase your practice’s revenue by 
decreasing your accounts receivable. Based on criteria you select, the Collections Manager displays a list 
of accounts that need to be contacted. From this list, you have access to all the necessary information 
when contacting an account, including an aged balance, payment information, Ofce Journal entries, and 
insurance estimates. 

• Patient Alerts – Patient alerts are customizable alerts that you can attach to a patient or family when you 
want a message to appear whenever you access information about that patient or family, according to 
criteria you specify. 

• Medical Alerts – You can access medical alerts from the Family File, Patient Chart, and Treatment 
Planner. When a patient has a health condition requiring attention, the medical alerts icon in those 
modules and on the patient’s appointment (in the Appointment Book) is red. You can then click the icon 
to view a list of the patient’s medical alerts. 

Te following products and packages are available as add-ons or integrated technologies for Dentrix 
Enterprise: 

• eClaims – With eClaims (sold separately), you can send electronic insurance claims. Te cost of sending 
claims electronically is signifcantly lower than the cost of sending paper claims because of the savings on 
labor, materials, and postage. If your claim cannot be sent to the payor electronically, it will be printed to 
paper and mailed within 24 hours. Claims sent through eClaims go directly into the insurance company’s 
computer, which helps dental ofces receive payment in a more timely manner. 

• QuickBill – With QuickBill (sold separately), you can generate billing statements without having to print 
a page, stuf an envelope, or lick a stamp. Instead, QuickBill sends statements to a clearinghouse where 
they are professionally printed, folded, and mailed. 

• AxiaMed – With the integration of Dentrix Enterprise with AxiaMed, you can process credit card 
payments and refunds from within the Ledger using the AxiaMed credit card processing service and a card 
reader (each sold separately). 

• eEOB and the 835 import utility – eEOB and the 835 import utility (each sold separately) work 
together with eClaims, to help you manage all electronic explanation of beneft statements (eEOBs) from 
a central location. Combining eEOB and the 835 import utility with electronic funds transfers (EFTs), 
which are available separately from some individual carriers, helps streamline the collection process even 
further, so you get paid faster and easier. 

• Automated insurance eligibility verifcation – With the automated insurance eligibility verifcation 
feature (sold separately), a service automatically verifes patients’ insurance eligibilities for their upcoming 
appointments. You must set up the eligibility service to use any existing eTrans (eClaims) accounts (each 
sold separately) that you may have or to use Data Services accounts (each sold separately), and you can 
link each account to specifc clinics. Also, you must enroll in the automated eligibility verifcation service, 
and there is a per-verifcation charge to use the service. 

• Patient Portal – With Patient Portal (sold separately), you can send messages and patient records to a 
patient’s online portal if you have purchased a subscription for this feature. Updox is the third-party 
provider of the Patient Portal service. 

• ePrescribe – With ePrescribe (sold separately), you can send and manage electronic prescriptions online. 
AllScripts is the third-party provider of the ePrescribe service. 
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• Outcome – With the Outcome feature (sold separately), you can assess possible oral health outcomes, 
such as the risk of caries, for a patient based on particular diseases, conditions, and/or exposures that 
pertain to the patient. Quintiles is the third-party provider of the Outcome service. 

• Meaningful Use – With the Meaningful Use feature (sold separately), you can use Dentrix Enterprise as a 
certifed electronic health record for Meaningful Use. 

Opening Dentrix Enterprise Modules 
Tere are three ways to open a Dentrix Enterprise module: 

• Te Windows Start menu – After you install Dentrix Enterprise, a DXONE folder will appear in your 
All Programs list on the Windows Start menu. 

Click the name of the module you want to open. 

Note: If you select a module other than the Ofce Manager, the Ofce Manager will open behind the 
module you selected to open. Te Ofce Manager must remain open if you want to have any other 
module open. 

• A shortcut icon on the Windows Desktop – You can create a shortcut on the Windows Desktop for the 
Ofce Manager. 

Double-click it to open the Ofce Manager module (open another module from there, if needed). 

• Another Dentrix Enterprise module – Once you have opened the Ofce Manager, you can open other 
modules from the File menu or the toolbar (for example, the Treatment Planner module includes a 
Dentrix Enterprise Modules toolbar). 

Clicking the frst buttons on this toolbar will start the Chart, Family File, Ledger, Appointment Book, 
and Ofce Manager, respectively. 

Dentrix Enterprise will keep the current patient active when you open another module. For example, if 
you are working in a patient’s Ledger and open the Family File from the Ledger, information for the same 
patient appears in the Family File, and the patient name appears on the Family File window’s title bar. 



Chapter 1: Introduction and Initial Setup    5 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

National Confguration Settings 
Te Indian Health Service (IHS) National Confguration meeting was held September 15 – 17, 2009, at 
the Henry Schein Practice Solutions (HSPS) building in American Fork, UT.  Representatives from HSPS, 
Science Applications International Corporation (SAIC), and IHS met to decide upon a national confguration 
to be used for installation at future clinics as a part of the IHS EDR project.  Te national confguration 
established a suggested pattern for installation, while also allowing for some decisions to be made by the 
local clinic being installed. Te purpose of this section is to list the standards established by the national 
confguration, as well as to establish those settings that will be decided by the local clinic. 

Te standardized confgurations listed in this document have been set up in the default database that is 
installed at all installations of Indian Health Clinics that are participating in the IHS EDR Project. You will 
refer back to these confguration settings as your site is set up with Dentrix. 

National Settings 
• Within the clinical notes feature of the Dentrix chart there is an option to use an “approve” button to lock 

a clinical note. Tis approval will lock the note so that the original note cannot be edited.  It will allow 
for appended notes, but not an edit of the actual note that existed when the “approve” button is utilized. 

Tose in attendance at the National Confguration meeting decided that this button needs to be enabled 
through the global settings utility that is used when a clinic is installed with Dentrix Enterprise. 

• In regards to password security settings, it was decided that the security rights settings that are used in 
RPMS should be followed in the installation of Dentrix Enterprise: 

• A new password must be established every 90 days. 

• A user cannot use any password that has been used as one of the user’s previous 6 pass-words. 

• Te password must be “strong”, meaning at least 8 characters in length, consisting of a combination 
of upper case letters, lower case letters, numbers and special characters. 

• After three attempts, the user is to be locked out for an automatic stay of 1 hour.  Another user with 
appropriate permissions may unlock the user sooner than the one hour. 

• Another setting to be established in the Global Setting utility at the time of installation is the enabling of 
the Medical History Review option.  Tis option will enable a window that will pop up the frst time each 
day that a patient’s record is accessed through the Patient Chart. 

• In the Appointment Book, it was decided to create a standard list of defnitions to be used as 
Appointment Statuses.  Tis list is not comprehensive, allowing the local clinic to customize the list to 
meet the needs of the clinic. 

Te appointment statuses that were added to the National Confguration are as follows, including the 
colors to be assigned: 

• Confrmed • Dark Blue 

• Left Message • Light Blue 

• Unable to Contact • Brown 

• Patient Here • Green 

• ER/Walk In • Red 

• Special Needs • Orange 
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Continuing Care GJOO~ 
File Ed it View s S.tatus Offic e Journal Doc um ent Center 

ALL-> ALL ALL 

Date Type Appl? Status Prior Treat. Name Age Prov. Clinic 'hond 
I lla■all ·~·· 1!11 '""""' ,., ..... ,. ... , .. lllllilll .._ 

05/2012011 ORTHO 6M Bowen, John 46 P,ov1 ME SA IHC 
05/2012011 ORTHO 6M xBowen, Charlie 60 P,ov1 ME SA IHC 

0512412011 ORTHO 6M B,own, Carlie 40 P,ov1 ME SA IHC 

0512412011 ORTHO 6M xBrnwn, Carl 10 P,ov1 MESA IHC 

0512412011 ORTHO 6M B,o var, Pro ni 6 P,ov1 ME SA IHC 

0512512011 ORTHO 6M xAhali, Brnan 60 P,ov1 MESA IHC 

~ 

• As Initial Reasons used for scheduling appointments, also found in the Defnitions area of the Ofce 
Manager, the following procedures were decided upon: 
• New Patient 

• Comprehensive Exam 

• Pano 

• 4 Bitewings 

• 2 Bitewings 

• FMX 

• Prophy 

• Child Prophy 

• Fluoride 

• Oral Hygiene Instructions 

• Periodic Exam 

• Limited Exam 

• Under 3 Exam 

• Consult 

• Ofce Visit (Follow Up) 

• Palliative Tx 

• Perio Maintenance Terapy 

• Also found in the Appointment Book is the Continuing Care List. 

It was decided to include the following standard lists as a part of the National Confguration: 

• Last month of patients who were due for treatment but never seen. 

• Last 3 months of patients who were due for treatment but never seen. 

• Last 6 months of patients who were due for treatment but never seen. 

• All patients that have been due for treatment but never seen. 

• Te list of available continuing care types that can be tracked automatically by Dentrix Enterprise is to 
include the following: 

• Space Maintainer to be tracked at every 6 months and attached to ADA codes D1510 and D1515. 

• High Risk Caries to be tracked at every 3 months.  Te attached code is to be determined. 

• Oral Path to be tracked at every 1 month.  Te attached code is to be determined. 

• Hygiene is to be tracked at every 6 months and attached to ADA codes D1110, D1120, and D4910. 

• Ortho is to be tracked at every 1 month and attached to ADA code D8670. 

• In the Procedure Code Setup area of the Ofce Manager, the only change to be established on the 
national level is the op site(treatment area) for ADA code D0220 and D0230 is to be set to tooth, thereby 
requiring a tooth number. 
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• In the Letter Merge area of Dentrix Enterprise there will be templates included that will provide Post Op 
instructions for the following codes and letter names: 

• SSC 

• Dental Surgery 

• Simple Extraction 

• Pedodontic Extraction 

• Trauma 

• Dentures 

• Pulpotomy 

• Sinus Opening 

• Excuse Letter 

sscpost.doc 

surgery.doc 

simpext.doc 

pedoext.doc 

trauma1.doc 

denture.doc 

pulppop.doc 

sinusop.doc 

excslip.doc 

• It was decided that Prescriptions will continue to be entered as they currently are, meaning that they will 
be entered through the EHR. 

• It was decided to include the following as Allergies within the Defnitions: 
• Latex 

• Penicillin 

• Amoxicillin 

• Clyndamycin 

• Sulfa 

• Ibuprofen 

• Local Anesthetic 

• Tylenol/Acetaminophen 

• Aspirin 

• Codeine 

• Hydrocodone 

• Iodine 

• Erythromycin 

• Tetracycline 

• See Notes 

• It was decided to include the following as Medical Alerts (in addition to those already included in the 
installation): 

• Bisphosphonates 

• Auto Immune Disorders 

• Hepatitis C 

• In the Patient Chart, it was decided to use the following color scheme to represent the associated 
treatment type: 

• Treatment Plan 

• Completed 

• Existing 

• Existing Other 

• Conditions 

Red 

Blue 

Blue 

Blue 

Black 
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Chart Button Template ~ 

;,elect Template: I• ..:.1 

Assigned Codes 

1D2140 102160 lomo 

1D7140 100120 100140 

102750 100150 100160 

1D3310 100210 100220 

101351 100274 loom 

101110 101120 1D9110 

l1s110 los110 1D5120 

115009 1D6240 1D6750 

QK C,,ncel 

• Also in the Patient Chart, it was decided to establish 21 of the 24 Quick Procedure Buttons. 

Te following codes and icons are used: 

• 0000 1st Visit Tis Fiscal Year (10/1) 
• 0190 All Subsequent Visits 
• D1110 Adult Prophy 
• D1120 Child Prophy 
• D0274 4 BWX 
• D0272 2 BWX 
• D7140 Tooth Extraction, erupted/uncomplicated 
• D0330 Panorex 
• 9990 Treatment Plan Completed 
• D1206 Fluoride Varnish 
• D2140 Amalgam Restoration (use for anterior and posterior, any number of surfaces) 
• D2391 Comp/Resin Restoration (use for anterior/posterior, any number of surfaces) 
• D2940 Sedative Filling 
• D1330 OHI 
• D9110 Palliative Treatment 
• D2930 Stainless Steel Crown 
• D2750 Porcelain Fused to High Noble Crown 
• D3310 RCT – any area of the mouth 
• D3220 Pulpotomy 
• D1351 Sealant 
• D0220 Periapical X-ray, frst one 
• Site Decision Te clinic can decide which code and icon to use 
• Site Decision Te clinic can decide which code and icon to use 
• Site Decision Te clinic can decide which code and icon to use 
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• Within the Password Setup, it was agreed to include fve employee password templates that would be used 
to base the assignment of password rights for all other employees.  Tese fve templates will be assigned to 
“users” with the following names and roles: 

• FD Template Front Desk 

• DA Template Dental Assistant 

• Prov Template Dentist 

• FA Template Full Access 

• RDH Template Dental Hygienist 

Te rights assigned to each are as follows: 

Security Option FD DA Prov FA RDH 
Appointment Day Notes, Modify X X X X X 
Appointment Lists X X X X X 
Appointment Views, Add New X X 
Appointment Views, Delete X X 
Appointment Views, Edit X X 
Appointments, Break X X X X X 
Appointments, Delete X X X X X 
Appointments, Edit X X X X X 
Appointments, Open X X X X X 
Appointments, Purge X 
Appointments, Schedule New X X X X X 
Appointments, Set Complete X 
Appointments, Setup Clinic X 
Appointments, Setup Providers O X 
Appointments, Setup Schedule O X 
Approval Status X X X X X 
Appt Lists, View All Clinics X X X X X 
ApptBook, Change Prov Color X X 
ApptBook, Copy View X X 
ApptBook, Copy Views to Users X X 
ApptBook, Remove Prov X X 
Auto Chart Number Setup Set up to not assign 
Batch Processor, Delete Reports X X 
Batch Processor, Print/Display Reports X X X X X 
Billing/Payment Agreement, Modify X X 
Chart Setup X 
Chart, Open X X X X X 
Clinic Admin X 
Clinic ID Change X 
Clinic Resource Setup O X 
Clinical Notes, Append X X X 
Clinical Notes, Approve X X X 
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Security Option FD DA Prov FA RDH 
Clinical Notes, Delete X X X 
Clinical Notes, Modify O X X X 
Collections Manager, Open X 
Completed Procedures, Delete X X X X 
Completed Procedures, Edit X X X X 
Completed Procedures, Enter X X X X X 
Conditions / Diagnosis, Delete X X X X 
Conditions / Diagnosis, Edit X X X X 
Conditions / Diagnosis, Enter X X X X 
Continuing Care, Clear Patients X X X X X 
Continuing Care, Edit Patients X X X X X 
Continuing Care, Open X X X X X 
Continuing Care, Setup X 
Credit Adjustment, Delete X 
Credit Adjustment, Edit X 
Credit Adjustment, Enter X 
Customize Toolbars X 
Database Mode Setup X 
Debit Adjustment, Delete X 
Debit Adjustment, Edit X 
Debit Adjustment, Enter X 
Dunning Messages, Modify X 
DXOne Report, Launch X X X X 
Employers, Add New/Edit Info 
Existing Procedures, Delete X X X X 
Existing Procedures, Edit X X X X 
Existing Procedures, Enter X X X X 
Family File, Open X X X X X 
Fast Checkout X 
Fee Schedule, Setup X 
Guarantor Notes, Modify X 
Guarantor Payment, Delete X 
Guarantor Payment, Edit X 
Guarantor Payment, Enter X 
Image, Open X X X X X 
Ins Payments, Delete X 
Ins Payments, Edit X 
Ins Payments, Enter X 
Insurance Claims, Create New X 
Insurance Claims, Delete X 
Insurance Claims, Edit X 
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Security Option FD DA Prov FA RDH 
Insurance Claims, Open X 
Insurance Coverage, Modify X 
Insurance Payment Tables, Modify X 
Insurance Plans, Add New/Edit Info X X 
LC/FC, Delete X 
LC/FC, Edit X 
LC/FC, Enter X 
Ledger + History X 
Ledger Setup X 
Ledger, Open X 
Ledger, Open Treatment Plan X 
Letters, Add New X X X X X 
Letters, Birthday X 
Letters, Collection X 
Letters, Continuing Care X X X X X 
Letters, Delete X 
Letters, Edit X X X X X 
Letters, Inactive Patient X 
Letters, Misc. X X X X X 
Letters, Referral X X X X X 
Letters, Welcome X X X X X 
Medical Alerts, Edit X X X X X 
Medical Alerts, View X X X X X 
Medical Consultation X X X X 
Month End - Charges X 
Month End - Payment Plan X 
Month End - Update X 
More Info / Family Appointment List X X X X X 
Multi-Clinics, Purge Appt X 
Multi-Codes Setup X 
Ofce Journal, Add En-tries X X X X X 
Ofce Journal, Delete Entries X X X X X 
Ofce Journal, Edit Entries X X X X X 
Ofce Journal, Open X X X X X 
Ofce Manager, Open X X X X X 
Ofce, Report Multiple Clinics X 
Password Administration X 
Password, Multi-Clinic X 
Patient Alerts, Modify X X X X X 
Patient Notes, Modify X X X X X 
Patient Notes, View X X X X X 
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Security Option FD DA Prov FA RDH 
Patient Prescriptions, Delete X 
Patient Prescriptions, New X 
Patient Prescriptions, Open X 
Patient Questionnaire Setup X 
Patient Questionnaire, Edit X 
Patient Questionnaire, New X 
Patient Questionnaire, Open X 
Patient Quick Letters X X X X X 
Patient Referrals, Delete X X X X X 
Patient Referrals, Open X X X X X 
Patients, Add New 
Patients, Archive 
Patients, Delete 
Patients, Edit Family Relations 
Patients, Edit Information X X X X X 
Payment Agreement Types, Setup X 
Payment Plans, Add New / Edit Info X 
Perio Chart, Open X X X X X 
Practice Defnitions Setup X 
Practice Preferences Setup X 
Prescriptions Setup X 
Prescriptions, View X 
Presenter, Open X X X X X 
Print Appointment Book Views X X X X X 
Print Billing Statements X 
Print Charts or Progress Notes X X X X 
Print Continuing Care Lists X X X X X 
Print Day Sheets X 
Print Day Sheets, MTD/YTD X 
Print Future Due Payment Plans X 
Print Insurance Aging Reports X 
Print Insurance Claims X 
Print Ofce Journal Reports X X X X X 
Print Patient Notes X X X X X 
Print Patient Prescriptions X 
Print Patient Questionnaire X 
Print Payment Agreements X 
Print Perio Chart Letters or Charts X X X X X 
Print Route Slips X X X X X 
Print Treatment Plans X X X X X 
Procedure Code Setup X 
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Security Option FD DA Prov FA RDH 
Procedure-Instructor, Enter / Edit X 
Providers, Inactivate X 
Purge Insurance / Employers X 
Referral Analysis, Open X X X X X 
Referrals, Add New/Edit Info X X X X X 
RVU, Auto Changes X 
Sched Reports, Delete Any X 
Sched Reports, Print/View Any X 
Send Electronic Billing X 
Send Electronic Claims X 
Suspended Credits, Apply X 
Treatment Plan, Delete O X X O 
Treatment Plan, Edit O X X O 
Treatment Plan, Enter O X X O 
Trojan, Import X 
User Self Setup X X X X X 
View All Operatories X X X X X 
View All Patients X X X X X 
View All Providers X X X X X 

*Any option listed with an O in the box is to be left for the local clinic to decide. 

Local Settings 
As a part of the National Confguration Meeting, it was decided that there were aspects of the software setup 
that should be left to the local clinic for decision making, including the following: 

• Production Types 

• Appointment Checklist 

• Appointment Book time increments 

• Multi-codes 

• Approval Status for Treatment Plans 

• Appointment Types 

• Billing Types 

• Medications 

Te local clinics are also to have the ability to add to any of the lists of standardized confgurations to make 
the software apply more efectively to the local clinic. 
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r - American Fork Dental P 

Enterprise Setup 

Clinic Information----------------------------~ 
The Dentist Group 
1 234 0 akdale Dr 

American Fork, UT 84003 
(801 )555-9999 

January Clinic Resource Setup 

Clinics-------------------------------~ 

AF 
DRAPER 

NO CLINIC 
PINEDALE 

Advanced Women Health Care 
The Dentist Grou 

. I 

.Qescriptive ID · 

JAF 

Financial ,!::!umber: 

Cjinic TIN 

Clinic NPI 

Title: 
JMy Dental Corporation 

Time Zone· 

J100001s 

Merchant ID: 

Entitl! ID Code: 

r 
Clinic OID: 

JIUTC-07:00) Mountain Time [US & Canada) 

~ddress: 

I 1234 Pine Drive 

.S.treet 

.City 

!American Fork 

Ehone 

I 1001 )555-1111 

ST Zip 

~ ~ 
Ei:;t. fax 

1 ~lrs-o-11-55-5-.2-2-22--

Cancel 

Setting Up Clinics 

1 

You can add and edit clinic information for all clinics in Dentrix Enterprise. Set up clinics prior to setting up 
providers. You must be in the Central clinic to set up a clinic. Te Central clinic provides access to all setup 
features. Confguring clinic information from one computer afects all computers running Dentrix Enterprise 
on the network. 

To add or edit a clinic 

1. While logged on to the Central clinic, in the Ofce Manager, 
from the Maintenance menu, point to Practice Setup, and 
then click Enterprise Setup. 

Te Enterprise Setup dialog 
box appears. 

2. Select your clinic (for example, 
“MESA IHC”), and then click 
Edit. 

Te Clinic Information dialog 
box appears. 

2 
OR 

3. Enter the following clinic 
information: 

General tab 
3 

• Descriptive ID – Type an ID that is four to 11 characters 
in length (the maximum depends on a certain global 
setting). Valid characters include A-Z, a-z, 0-9, and 
a hyphen (-). Tis ID is used to reference the clinic 
throughout Dentrix Enterprise and on reports. 

• Financial Number – Type the account number for the 
clinic’s fnancial institution. 

• Merchant ID – Type the ID used by the clinic for 
processing credit card payments. 

• Clinic TIN – Type the Tax Identifcation number of the 
clinic. 

• Entity ID Code – Type the code used to identify the 
entity for the clinic. 

• Title – Type the name of the clinic. 

• Time Zone – Select the clinic’s time zone. 
4 

• Address – Type the clinic’s address, the phone number 
and extension of the contact person in the clinic (if applicable), and the clinic’s fax number. 
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2:J 
Clime Informati on - AF X 

General Settings I Optional Settings J Subscriptions I E:-iport Settings J 

Bdministrative Contact: IMHAYES 

.e_ank Deposit Number 

ln2345s 
Show/Hide/Mask 2_SN: 

2:l 

I Use Central Clinic Option <S how Completely> 

Qata Units 

ius Standard 

Eiscal }'ear's beginning month (1-12): r,-

..:.l 

..:.l 

Bjlling Statements---------~ 

J Use Clinic Info on Statements ..:.l 
Custom Settings I 

Change P,ovider Completion Options----~ 

P" Override P,ovider For All Transactions 
r- Per Patient 
r Per Session 

Change Fee Schedule Rounding Option---~ 

Round to: I D olla, ..:.J by delaull 

Clinical Note Naming--------~ 

r Use First Clinical Note Template to Name 
Clinical Note Pages 

Insur a nee Automated Resolution for Over/Under Chrgs 

P Use Central Clinic Option P" 835Auto Post 

Close Claim-----------~ 

P' ,Claim Must Be Zero to Close 

P' Be-calculate Insurance Estimate 

r Al~a}'s Calculate Insurance Oveuide 

OK Cancel 

Settings tab 

• Administrative Contact – Click the search button to 
select the business contact at the clinic. Only providers 
who have been entered into Dentrix Enterprise and who 
have a 10-digit phone number are available for selection. 

• Bank Deposit Number – To have the clinic’s bank 
account number print on deposit slips, type the 
appropriate number. 

• Show/Hide/Mask SSN – Select one of the following 
options: 

• Use Central Clinic Option – Te setting will be the 
same as that for the Central clinic. 

• Show Completely – Shows the entire Social Security 
Number throughout Dentrix Enterprise. 

• Hide Completely – Hides the Social Security 
Number. All felds that display Social Security 
Number will be blank except in dialog boxes where 
the number is entered or edited (for example, the 
Patient Information dialog box). 

• Mask Completely – Masks all digits of the Social 
Security Number. 

• Mask All But Last Four – Masks all but the last four 
digits of the Social Security Number. 

For a comprehensive explanation of where the Social Security Numbers will be shown, hidden, or 
masked throughout Dentrix Enterprise, see the “Enterprise Setup” topic in the Dentrix Enterprise Help. 

• Fiscal year’s beginning month (1-12) – Type the number of the month that your fscal year begins. 
Te default value is 1 (January). 

• Billing Statements – Select the option that corresponds to the information you want to have appear 
on billing statements: 

• Use Central Ofce Info on Statements – To print the name and address of the Central clinic on 
a statement sent to a patient of this clinic. 

• Use Clinic Info on Statements – To print this clinic’s name and address on a statement sent to a 
patient of this clinic. 

• Use Provider Info on Statements – To print the name and address of the patient’s primary 
provider on a statement sent to a patient of this clinic. 

• Use Custom Settings on Statements – To print a specifed name, address, phone number, and 
message on a statement that is sent to a patient of this clinic. Tis option is available only if a 
certain global setting is enabled. 

With Use Custom Settings on Statements selected, you can specify the clinic or provider name, 
clinic address, clinic phone number, and statement message separately, and each clinic can have 
diferent settings. To customize the settings for this clinic, do the following: 

a. Click Custom Settings to open the Custom Settings dialog box appears. 

Note: You must be logged in to the Central clinic to make changes to these settings; 
otherwise, you can only view them. 
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b. Set up the following options: 

• Name – Specify whether you want to use a provider’s name or a clinic’s name, and then 
select the desired provider or clinic from the corresponding list. 

• Address – Select the clinic whose address you want to use. 

• Phone – Select the clinic whose phone number you want to use. 

• Statement Message – Enter the message that you want to have appear at the bottom 
of statements that are sent to patients of this clinic. Tis message will be used only if 
the Use same Statement Message for all check box is clear when setting up options to 
generate billing statements. 

c. Click OK. 

• Change Provider Completion Options – If the completing provider for procedures is often not the 
same as the treatment-planning provider, you can change the provider for those procedures and have 
that provider be the default for any procedures completed for a selected patient or for all patients. To 
enable the completing provider override feature, select Override Provider For All Transactions, and 
then select one of the following options: 

• Per Patient – Te specifed provider will be used for completed procedures being posted for a 
given patient until you select another provider or patient. 

• Per Session – Te specifed provider will be used for completed procedures being posted for all 
patients until you select another provider or close all Dentrix Enterprise modules. 

• Change Fee Schedule Rounding Option – Select the default rounding option for automatic fee 
schedule changes. Tis setting is available only if you are logged in to the Central clinic. 

• Clinical Note Naming – To have the default name of a new clinical note (“Note#”) changed to the 
category and name of the template that was used to create the note (if multiple templates were used 
to create the clinical note, the category and name of the frst template used is used), select this check 
box. Tis setting is available only if you are logged in to the Central clinic. Tis setting afects all 
clinics. 
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Information - CENTRAL X 

General J Settings Optional Settings J Subscriptions I E:-iport Settings J 

Automatic Log Off 

r Enable Automatic Log Off 

Idle Time: i-- Minutes 

r Enable Warning Messages 

Display 115"""3 seconds before 
termination 

Additional Settings 

P Enable Patient Access Logging 

~ Minutes between identical log records 

P Enable Patient Print Logging 

r Patient Birthdate/Age on Title Bar 

P Indude Appt Procedures in INS EST on Route Slip 

Copy To Clinical Notes 

P° Patient Health Assessment r Patient Education 

P Prescriptions r Medical Alerts 

r Medical Alerts Review 

I Instant Patient Search 
~ P Enable Instant Patient Search I 

Appointment Book Late Appt• Tracking 

P Enable Late Appt· Tracking 

IFIRM ..:.1 Appt Stab.JS to Watch for 

rs- Minutes before patient is considered LATE I Patient Education 

r Use Spanish patient education if patient's 

preferred language is Spanish 

P Use description for finding patient education 

Family File Settings 

P Require Patient Email Address 

P Require Referral for New Patients I Reject Old Treatment Plans 

P Enable Reject old Treatment Plans 

~ Days before Treatment Plan 
1s considered Stale Date I Insurance Section Settings 

~ r Required Financial Class Type I 
I OK I Cancel I 

Optional Settings tab (Central clinic only) 

• Automatic Log Of 

• Enable Automatic Log Of – To have users logged 
of of Dentrix Enterprise after a specifed length 
of idle time, select this check box. Type the length 
of Idle Time, in minutes, that is allowed before a 
user is logged of the program. Dentrix Enterprise 
is considered to be idle while there are no mouse 
movements or keyboard strokes in any Dentrix 
Enterprise module on the computer to which a user 
is logged on except for the DXOne Report Manager, 
DXPrint, and DXOne Reporting processes, which 
are used for reports. However, if a report is being 
run, and the user is logged of automatically, the 
generation of the report is canceled. 

• Enable Warning Messages – To have a warning 
message appear before users are logged of 
automatically, select this check box. In the Display 
feld, type the length of time, in seconds, that you 
want the warning message to appear before a user is 
logged of automatically. Te message will present the 
options to the user to continue working in Dentrix 
Enterprise without being logged of or to log of 
immediately. If the message is ignored, after the 
specifed number of seconds, the user is logged of 
automatically. 

• Additional Settings 

• Enable Patient Access Logging – To enable the tracking of emergency access to patient 
information for users without sufcient rights, select the check box. When accessing a patient 
record multiple times the same way (in the same module, at the same clinic, on the same date, 
and by the same user) within the number of minutes specifed in the Minutes between identical 
records feld, Dentrix Enterprise will create only one entry for the Patient Information Accessed 
Report. In this feld, type a value from 5 to 1440 (180 or above is recommended). 

• Enable Patient Print Logging – Select this check box to enable the tracking of the following: 
when reports that contain patient information are generated; when patient records are accessed; 
additions, deletions, and modifcations of patient information; and when patient health 
information is exported to a patient’s portal. Tis audit information appears on the Audit - 
Combined Report. 

• Patient Birthdate/Age on Title Bar – To have the birth date and age of a patient selected in 
a patient-specifc module (except for the Family File) appear on the title bar of that module’s 
window, select this option. 

• Include Appt Procedures in INS EST on Route Slip – Te state of this check box afects route 
slips generated in all clinics: 

• With this check box selected: 
• Te Patient Information section includes patient fnancial information: aged balances, 

estimated insurance portion, suspended credits, balance, and estimated patient portion 
(Balance + Appt Amount - Ins Est). Te estimated insurance portion (Ins Est) is the 
insurance estimate for the procedures attached to the appointment for which the route 
slip is generated. 
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• Te Account Information section includes the estimated guarantor portion (Balance 
+ Appt Amount - Ins Est). Te estimated insurance portion (Ins Est) includes the 
insurance estimate for other family members’ completed procedures (whether or not they 
are attached to a claim) and includes the insurance estimate for the procedures attached 
to the appointment for which the route slip is generated. 

• With this check box clear: 
• Te Patient Information section does not include patient fnancial information. 
• Te Account Information section does not include the estimated guarantor portion, 

and the estimated insurance portion is the insurance estimate for the patient’s and the 
other family members’ completed procedures (whether or not they are attached to a 
claim). 

• Copy to Clinical Notes 

• Patient Health Assessment – To have a clinical note created automatically each time a health 
assessment for a patient is recorded, select this check box. 

• Prescriptions – To have a clinical note created automatically each time a prescription is entered 
for a patient, select this check box. 

• Medical Alerts Review – To copy a list of a patient’s problems, allergies, and medications to a 
clinical note on the day that you mark the patient’s medical alerts as having been reviewed. 

• Patient Education – To have the details of a patient education topic be copied automatically into 
a clinical note each time you record that patient education has been presented to a patient. 

• Medical Alerts – To have a clinical note created automatically each time a medical alert is entered 
for a patient, select this check box. 

• Enable Instant Patient Search – With this check box selected, when you are searching for a patient, 
after you enter the frst few characters of your search criteria, Dentrix Enterprise automatically 
displays matches and updates the list of matches as you type. With this check box clear, when you 
are searching for a patient, after you enter your search criteria, you must click Search to view the 
matches. 

• Appointment Book “Late Appt” Tracking – To allow the time from the scheduled time of 
appointments to the arrival time of the corresponding patients to be monitored by Dentrix Enterprise 
(for the Appointment Statistics Report), select this check box. Ten, set up the following options: 

• Appt Status to Watch for – Select the status appointments will have before the corresponding 
patient arrives. Dentrix Enterprise will begin monitoring a patient’s visit when the specifed status 
is selected for his or her appointment from the Appointment Information dialog box. 

• Minutes before patient is considered LATE – A patient will be considered late for his or her 
appointment when the specifed number of minutes has elapsed from the time of the scheduled 
appointment until the status your ofce uses to indicate a patient has arrived is selected for that 
appointment. If a patient is late for his or her appointment, the Late Appt check box is selected 
in the Appointment Information dialog box, and a red dot appears in the upper-right corner of 
the appointment on the schedule. 

• Patient Education 

• Use Spanish patient education if patient’s preferred language is Spanish – With this check 
box selected, and if a patient’s language preference is Spanish (in the Patient Information 
dialog box, under Demographics, Spanish is selected as the Language), when the Patient 
Education dialog box appears for that patient, the Spanish option is selected; otherwise, English 
is the default selection. Having the Spanish option selected allows you to Search Online with 
MedlinePlus for patient education resources in Spanish. 
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linic Info rmation - CENTRAL 

Outcome--------------~ 

Setup 
Outcome 

'#Licenses: fio" 

Expiration Date : I 01/ 31/2014 

ePrescribe--------------~ 

Setup 
ePrescribe 

# Licenses: fio" 

Expiration Date : I 01/31/ 2014 

Updox---------------~ 

Setup 
Updox 

:. Licenses: fio" 

Expiration Date : I 01/ 31/2014 

Meaningful Use------------~ 

Setup 
Meaningful Use 

::. Licenses: fio" 

Expiration Date : I 01/ 31/2014 

OK Cancel 

• Use description for fnding patient education – Select this check box to have the description 
instead of the code (such as SNOMED) be used when you do either of the following: 

• Click the Patient Education button in the Medical Alerts dialog box (or Patient 
Prescription dialog box) to search for patient education resources online with MedlinePlus 
for a selected problem, medication (or prescription), or allergy. 

• Click Search Online in the Patient Education dialog box, which you can open from a 
patient-specifc module (such as the Family File), to search for patient education resources online 
with MedlinePlus for a problem, medication, or lab that match the search criteria that you enter. 

• Family File Settings 

• Require Patient Email Address – Select this check box to require that an email address be 
entered for each patient in the Family File. If a patient declines to provide an email address, that 
can be specifed instead of entering an email address. 

• Require Referral for New Patients – Select this check box to require that a referral source be 
selected when a new patient record is created in the Family File. 

• Reject Old Treatment Plans – You can have old treatment-planned procedures archived 
automatically, so they do not show in the Chart or Treatment Planner. Tis is an organization-wide 
setting (for all clinics) and is available only when you are setting up the Central clinic’s information. 
To turn on this feature, select the Enable Reject old Treatment Plans check box. Ten, in the Days 
before Treatment Plan is considered Stale Date feld, type the number of days a treatment plan case 
remains valid. When a treatment plan case becomes “stale,” Dentrix Enterprise automatically rejects 
it, and adds a note, stating why and when the case was rejected, to the case’s status history. 

• Required Financial Class Type – Select this check box to require that a fnancial class be specifed 
when you add or edit an insurance plan. 

Subscriptions tab 

• Outcome – If you have purchased a subscription for 
this feature (Quintiles is the third-party provider of the 
Outcome service), click Setup Outcome to enable and set 
up Outcome. 

• ePrescribe – If you have purchased a subscription for 
this feature (AllScripts is the third-party provider of the 
ePrescribe service), click Setup ePrescribe to enable and 
set up ePrescribe. 

• Updox – If you have purchased a subscription for this 
feature (Updox is the third-party provider of the Patient 
Portal service), click Setup Updox to enable and set up 
Patient Portal. 

• Meaningful Use – If you have purchased a subscription 
for this feature, click Setup Meaningful Use to enable 
and set up Meaningful Use. 

4. Click OK. 

For comprehensive information about setting up Outcome, 
ePrescribe, Updox, and Meaningful Use, see the “Changing clinic 
information” topic in the Dentrix Enterprise Help. 
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Integration Settings 

Data Services 

File Exchange 

MiPACS 

Patient Forms Settings 

RxBE (340B) 

Select from the options on the left. 

QK !;_lose 

Setting Up Third-party Integrations 
You can integrate credit card processing. 

To set up integrations 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Integration Settings. 

Te Integration Settings dialog box appears. 
1 

2. On the Axia tab, if you have purchased a subscription for this 
feature (Axia is the third-party provider 
of the credit card processing service), 
you can enable and set up credit card 
processing. 

2. If you have a primary database (the 
main Dentrix Enterprise database) 
and a secondary database (a database 
for working in Dentrix Enterprise 
ofine), and want to use services to 
watch for exported fles so that they 
can be imported automatically into the 
primary database through HL7 when 
the secondary database is back online, 
confgure the settings on the File Exchange tab. 

2 

For comprehensive information about setting up integration with Axia, see the “Setting up Axia” topic in the 
Dentrix Enterprise Help. 

For comprehensive information about setting up File Exchange, see the “Setting up File Exchange” topic in 
the Dentrix Enterprise Help. 

For comprehensive information about setting up automated insurance eligibility verifcation, see the “Setting 
up automated insurance eligibility verifcation” topic in the Dentrix Enterprise Help. 

For comprehensive information about activating Patient Forms, see the “Activating Patient Forms” topic in 
the Dentrix Enterprise Help. 

For comprehensive information about setting up prescription data export, see the “Setting up prescription 
data export” topic in the Dentrix Enterprise Help. 
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Enterprise Setup 

Clinic Information----------------------------~ 
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DRAPER 

NO CLINIC 
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The Dentist Group 
TL-. ..... n .... ~1;~1 ~ ...... , ,,.., 

The Dentist Group 
1234 0 akdale Dr 

American Fork, UT 84003 
(801 )555-9999 

Januar_y 

Close 

Clinic R esoUJce Setup 

American Fork, UT ..... 
Dra er, UT 

Pinedale, WY 
0 ..... ,, .... IIT 

New 

Edit 

Delete 

Setting Up Clinic Resources 
You can edit your clinic information, operatory IDs, provider information, and staf information. 

To access the Clinic Resource Setup 

• For any clinic 

1. While logged on to the Central clinic, in the Ofce 
Manager, from the Maintenance menu, point to Practice 
Setup, and then click 
Enterprise Setup. 

Te Enterprise Setup dialog 
box appears. 

2. Select the clinic that you want 
to edit. 

3. Under Clinic Information, 
click Clinic Resource Setup. 2 

3 

1 

Te Clinic Resource Setup 
dialog box appears. 

• For the clinic that you are logged on to 

In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Clinic Resource Setup. Te Clinic 
Resource Setup dialog box appears. 

Te sections that follow explain about setting up clinic resources. 
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Changing Clinic Information 
You can edit a clinic’s information as needed. 

To edit a clinic’s information 

1. In the Clinic Resource Setup dialog box, 
under Clinic Information, click Edit. 

Te Clinic Information 
dialog box appears. 

2. Change the clinic 
information as needed. 
For information about 
the available options, see 
“Setting Up Clinics” in 
this chapter. 

3. Click OK. 

1 
2 

3 

Setting Up Operatories 
An operatory is a room, chair, or other location where treatment is performed in your ofce. Appointments 
are scheduled by operatory on any given day. 

To add or edit an operatory 

1. In the Clinic Resource Setup dialog box, 
under Operatories, do one of the following: 

• Click New to add an operatory. 

• Select an existing operatory, and then click 
Edit to edit that operatory. 

Te Operatory Information dialog box 
appears. 

2. Type the following information: 3 

2 

• ID – Te unique ID for the operatory. 

• Operatory Title – Te title to use for the 
operatory instead of the ID when printing 
the Operatory Appointment List. 

3. Click OK. 
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Setting Up Providers 
Each individual that provides billable treatment to patients is considered a provider in Dentrix Enterprise.

 During the initial push of information, all doctors (primary providers) will be moved into Dentrix from 
RPMS. Tis initial information will need to be edited so that Dentrix contains appropriate User lD’s, logon 
information, site address, NPI numbers, and so forth. 

Hygienists do not get pushed over from RPMS. Tere will be one “place holder” hygienist in the Dentrix 
Clinic Setup that can be tweaked to contain a dental hygienist’s information. Additional hygienists can be 
added and mapped into Dentrix allowing that production to move back to RPMS under the Dental Chief ’s 
Dentrix lD for billing purposes. 

Important: To add a primary provider not listed in Dentrix Enterprrise, you MUST have that provider set up 
in RPMS frst, and then call Dentrix Technical Support to have a technician “map” the provider in RPMS to 
Dentrix Enterprise. After that, the new doctor can be pushed to Dentrix Enterprise. 

To edit a provider 

1. In the Clinic Resource Setup dialog box, 
under Provider(s), select an existing provider, 
and then click Edit to edit that provider’s 
information. 

Te Provider Information dialog box appears. 

Tip: If you want to view providers that have 
been inactivated in addition to the active 
providers listed, select List Inactive at the 
bottom of the Clinic Resource Setup dialog 
box. 

1 

1 
OR 

2. Enter or change the following 
information: 

• Name – Type the provider’s 
Last name, First name, and MI 
(middle initial). 

• ID – Tis ID is pre-populated 
with the provider’s NPI number 
Change the ID to something 
more descriptive (for example, 
DRWROBERTS, for Dr. Wesley 
Roberts; and HYMJONES, 
for Mary Jones, RDH). Type a 
unique ID for the provider. Te 
ID must be 4 to 10 characters 
in length. You can use letters, 
numbers, and hyphens (-). 

2 

Note: Provider IDs are used 
throughout Dentrix Enterprise. 
Whenever a provider is displayed 
or printed, it is usually only the 
provider ID that is seen. 

3 



24    Chapter 1: Introduction and Initial Setup 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ 
■ 

■ 

■ 

• Title – Type the provider’s title, such as DDS, DMD, or RDH. 

• Non-Person – If this provider is an entity, such as a corporation or association, select this check box. 

• Specialty – Select the appropriate specialty for the provider. 

• Address – Type the business address of the provider. Tis address will be used on all correspondences 
to patients, referrals, insurance carriers, and so forth. Also, type the provider’s E-Mail address. 

• Phone – Type the business phone number and extension (if applicable) of the provider. 

• Class – Select the class for the provider: Primary, for primary care providers, such as dentists; or 
Secondary, for secondary care providers, such as hygienists. 

• Insurance Claim Options – To avoid having to sign each printed insurance claim, select Print 
Provider’s Signature Using, and then select Signature on File or Provider’s Name. If you want to 
use the clinic TIN on insurance claims, select Use Clinic TIN. 

• Log On User ID – If you are adding a new provider, type the ID that this provider will use to access 
Dentrix Enterprise. 

• Password – In the User Password feld, type the password that this provider will use to access 
Dentrix Enterprise. Enter the same password in the Confrm Password feld. 

Important: Te password must be at least 8 (for standard users) or 15 (for administrative users) 
characters in length and meet the following requirements: have at least one uppercase letter, have 
at least one lowercase letter, have at least one number, and have at least one special character (for 
example, #, %, or &). 

• Fee Schedule – If this provider will use a diferent fee schedule from the default fee schedule, click 
the search button , and then select the appropriate fee schedule. 

• RVU Schedule – To associate an RVU schedule with this provider, click the search button , and 
then select the appropriate RVU schedule. 

• Clinic – Click the search button , and then select the clinic where the provider works. 

• TIN – If the clinic Tax Identifcation number (TIN) will be used by the provider (Use Clinic Tin is 
selected under Insurance Claim Options), the feld displays “<CLINIC>.” Click the Tin # search 
button , and then add, edit, or remove the TIN of any clinics as needed. You must have at least 
one TIN entered. 

• SS # – Type the provider’s Social Security number. Tis number will appear on insurance claims. 

• State ID #, State, and State Expiration Date – Type the provider’s state license number, the state 
where that license was issued, and the expiration date of that license. Te state ID will appear on 
insurance claims. 

• DEA #, License Expiration, and Schedule – Type the provider’s DEA number and the date that 
DEA license expires, and select the classes of medication that the provider can prescribe. Te DEA 
number can be used with specialized insurance claims. 

• Additional IDs – Enter any of the following IDs, which can be used with specialized claims: 
Medicaid #, NPI, Blue Cross/Blue Shield ID # (you must select one or the other), Provider #, 
Ofce #, Other ID #, and UPIN#. 

3. Click OK. 

For information about adding other IDs through the Provider ID Setup, see the “Setting up provider IDs for 
dental insurance” topic in the Dentrix Enterprise Help. For information about setting up the provider to use 
ePrescribe, see “Editing and disabling/enabling ePrescribe user accounts” in the “Adding, editing, inactivating, 
and reactivating providers” topic in the Dentrix Enterprise Help. 
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Inactivating Providers 
You cannot delete providers. When a provider no longer works at a clinic, you can inactivate that provider. 
Inactivated providers are not available for selection throughout Dentrix Enterprise wherever providers can be 
selected except when setting up options for reports. New procedures and treatment plans cannot be posted for 
inactivated providers. New prescriptions and payment plans cannot be entered for an inactive provider. Also, 
existing treatment-planned procedures associated with an inactivated provider cannot be set complete. 

To inactivate a provider 

In the Clinic Resource Setup dialog box, under Provider(s), select the provider who you want to inactivate, 
and then click Inactivate. 
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Setting Up Staff 
Staf members are employees who have not been entered as providers and who will use Dentrix Enterprise. 

To add a staf member or edit a staf member’s information 

1. In the Clinic Resource Setup dialog box, 
under Staf, do one of the following: 

• Click New to add a staf member. 

• Select an existing staf member, and then 
click Edit to edit his or her information. 

Te Staf Information dialog box appears. 

2. Enter or change the following information: 

• Log On User ID – Enter or edit the ID 
that this staf member will use to access 
Dentrix Enterprise. 

• Password – In the User Password feld, 
type the password that this staf member 
will use to access Dentrix Enterprise. 
Enter the same password in the Confrm 
Password feld. 

OR 

1 

1 

Important: Te password must be at 
least 8 (for standard users) or 15 (for 
administrative users) characters in length 
and meet the following requirements: have at least one 
uppercase letter, have at least one lowercase letter, have at 
least one number, and have at least one special character 
(for example, #, %, or &). 

• Clinic – Click the search button , and then select the 
clinic where the staf member works. 

2 

• Name – Type the staf member’s full name. 

• ID – Type a unique ID for the staf member. Te ID 
must be 4 to 10 characters in length. You can use letters, 
numbers, and hyphens (-). 

• Title – Type the staf member’s position (for example, 
receptionist or ofce manager). 

3 

• Address – Type the staf member’s home address. 

• Phone – Type the staf member’s home phone number and extension (if applicable). 

• E-Mail – Type the staf member’s email address. 

• SS # – Type the staf member’s Social Security number. 

3. Click OK. 
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Inactivating Staff 
Staf cannot be deleted. When a staf member no longer works at a clinic, you can inactivate that staf member. 

To inactivate a staf member 

In the Clinic Resource Setup dialog box, under Staf, select the staf member who you want to inactivate, 
and then click Inactivate. 
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Setting Up the Appointment Book 
You can customize several features of the Appointment Book to meet the needs of your practice. Tese options 
can be set up and/or changed at any time without afecting data already entered. However, for consistency, 
you should set them up before you begin using Dentrix Enterprise. 

Tis section covers the following topics about setting up the Appointment Book: 
• Setting Up Views • Setting Up an Operatory 
• Setting Up a Clinic • Setting Up Flip Tabs 
• Setting Up a Provider 

Setting Up Views 
Views allow you to see the Appointment Book in various ways; for example, you can have one view for when 
you are in the operatory and a diferent one for when you are at the front desk. For each view, you specify 
which providers, operatories, hours, and patient details are shown in the Appointment Book. 

You can have up to 111 diferent views for the Appointment Book on any given computer in the ofce unless 
a certain global setting is enabled; in which case, you can have an unlimited number of views. 

To add or edit a view 

1. In the Appointment Book, click View on the menu bar. 

Te Select View dialog box appears. 

1 

2. Do one of the following: 

• To add a new view, click New. 

• To edit a view, select it, and then click Edit. 

Te Edit View dialog box appears. 

3. Set up the following options: 

• Appt. View Name – Type a name for the view. 

• Short-cut key to view – Select the shortcut key 
that you want to use to access the view. 

• Clinic – Select the clinic that you want to view. 

• Selected Providers – Click Modify List to select 
the providers for the view. 

• Selected Operatories – Click Modify List to 
select the operatories for the view. 

• View Options – Select any of the following: 

• View Amount – To have the scheduled 
production amount for the day, week, or 
month appear. 

OR 2 
2 

3 

4 
• View Appointment Notes – To view a note symbol on any appointment with a note. 

• View Alerts – To view a red plus sign on any appointment for a patient with medical alerts. 

• View Provider Columns – To view the colored provider bar. 

• View Ins Eligibility – Select to see an insurance eligibility icon on any appointment for a patient 
with an insurance plan attached to his or her record. 
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• Select Days – Select the days of the week that the ofce is normally open. Te week and month views 
will show only the selected days. 

• Month Time View – For the month view, Dentrix Enterprise requires that a start and end time be 
entered. Type the earliest hour that you will see patients in the Start Hr feld. Type the latest hour 
that appointments will last in the End Hr feld. Click am or pm for both felds. 

• Appointment Display Info – Depending on the length of an appointment, up to nine lines of 
information can be displayed on the face of an appointment. For each Line, select the information 
you want to have displayed on that line, or select [None] to leave that line blank. 

Tip: On average, appointments will probably display 2 – 4 lines, so assign the most important items 
to the frst lines. 

• Default View – Select this check box to have this view be your default for the current clinic. 

4. Click OK. 

Setting Up a Clinic 
You can customize your practice hours, certain appointment defaults, and the time block size used throughout 
the program. Any changes will afect all your computers that have Dentrix Enterprise installed. 

To set up a clinic 

1. In the Appointment Book, from the Setup menu, click Clinic Setup. 

Te Clinic Appointment Book Setup dialog box appears. 

2. Select a Clinic. 

3. Set up the following options for the selected clinic: 

• Default Schedule – Select the check box next to 
each day of the week the clinic is normally open. 
Also, you can break each day into three time ranges. 
To set the working hours for any day, click the day’s 
search button , and then enter the start and end 
times of each range that you want for that day. 

1 

2 

• Time Block Size – You can schedule your 
appointments in 5-minute, 10-minute, 
15-minute, 20-minute, or 30-minute intervals. 
Select the time block size option that fts the 
scheduling needs of your practice. 43 

Important: Time block size is used when setting up procedure codes to indicate how long a 
procedure will take to complete. Dentrix Enterprise stores this information in units, not actual time; 
as a result, changing the time block size can change your procedure time settings for a procedure. For 
example, if your original procedure used 10-minute time blocks, then a procedure that requires 60 
minutes would be entered as six units. If you change the time block size to 15 minutes, the procedure 
still has six units, but now, instead of being 60 minutes, the procedure will default to 90 minutes. 

• View Time at Right – To have the time column appear on the right side of the window in addition 
to the left side, select this check box. 

4. Click OK. 

For a comprehensive explanation about all the available options for clinics, see the “Setting up a clinic” topic 
in the Dentrix Enterprise Help. 
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Setting Up a Provider 
You can customize work hours, colors, and aliases for each provider in your ofce. Any changes will afect all 
your computers that have Dentrix Enterprise installed. 

Note: You can set up providers in more than one clinic. When setting up the provider’s default schedule, 
Dentrix Enterprise will warn you if the scheduled hours overlap in other clinics. 

To set up a provider 

1. In the Appointment Book, from the Setup menu, click Provider 
Setup. 1 
Te Provider Setup dialog box appears. 

2. Select a Clinic. 

3. Select a Provider. 

4. Click Setup. Te Provider Setup dialog box appears. 

2 
3 4 

5. Set up the following options for the selected provider: 

• Default Schedule – Select the check box next to 
each day of the week that the provider normally 
works. Also, you can break each day into three 
time ranges. To set the working hours for any 
day, click the day’s search button , and then 
enter the start and end times of each range that 
you want for that day. 

• Provider Color – All appointments scheduled 
with that provider will use the designated 
color as the background for the appointment 
information. To assign the provider a unique 
color, click the colored button, and then choose 
the desired color. 

6 

5 

Tip: Appointment information text is displayed in black, so choose a light color for the provider’s color 
that contrasts with the black text. 

6. Click OK. 

For information about setting up provider time blocks, see “Setting Up Perfect Day Scheduling Time Blocks” 
in Chapter 3: Appointment Book. 
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Setting Up an Operatory 
You can customize available hours for each operatory in your ofce. Set up the operatories for each clinic 
separately. Any changes will afect all your computers that have Dentrix Enterprise installed. 

To set up an operatory 

1. While viewing the operatories for a clinic in the Appointment 
Book (the view does not have to be displaying all operatories), from 
the Setup menu, click Operatory Setup. 

Te Operatory Setup dialog box appears. 

1 

2 3 
2. Select the operatory for which you want to set the available time 

and days. 

3. Click Setup. 

Te Operatory Setup dialog box appears. 

4. Select the check box next to each day of the week the operatory is 
normally used. Also, you can break each day into three time ranges. 
To set the available hours for each selected day, click the day’s search 
button . In the Set Time Limits dialog box, enter the start time 
and end time of each range you want for that day, and then click OK. 

5. Click OK 

4 

5 

Setting Up Flip Tabs 
Acting as a bookmark, a fip tab allows you to jump forward or backward several days, weeks, or months 
in the Appointment Book, according to a user-defned length of time, such as seven days, two weeks, or six 
months. No fip tabs are set up with the initial installation of Dentrix Enterprise. 

Flip tabs are workstation-specifc and must be set up on each workstation individually. You can have up to 
four fip tabs per computer. 

To set up a fip tab 

1. 
Setup. 

Te Flip Tabs Setup dialog box appears. 

2. Click the Day View, Week View, or 
Month View tab to set up fip tabs for the 
corresponding Appointment Book view. 

3. For each fip tab you want to create, set up 
the following options: 

• Description – Type a short description 
for the fip tab (for example, “1 Week” 
or “6 Months”). 

3 

• Text Color – Click the colored button 
to assign a color to the text description 
of the fip tab. 

In the Appointment Book, from the Setup menu, click Flip Tabs 
1 

2 

4 
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• Type – Select the type of fip tab: 

• Absolute – Absolute requires that an actual calendar Date, such as 09/07/2012, be specifed. 

Note: An “Absolute” tab will always jump to the specifed date in the Appointment Book. 

• Relative – Relative requires that a number of Days, Weeks, or Months (depends on the fip tab) 
be specifed. 

Note: A “Relative” tab will jump to a date relative to the current system date or currently 
displayed date. For example, if today’s date is January 1st, a relative tab set to move you seven 
days forward relative to today will move you to January 8th, and then, if clicked again, the tab 
leaves you on the 8th. However, a relative tab set to move you seven days forward relative to the 
displayed date, will move you to the 8th, and then, if clicked again, the tab will move you to the 
15th (another seven days ahead). 

• Direction – For a relative fip tab, select a direction option: Forward, to go forward by the specifed 
number of days, weeks, or months in the Appointment Book; or Backward, to go backward by the 
specifed number of days, weeks, or months. 

• Relative to – For a relative fip tab, select whether the book should move you relative to the current 
date or relative to the date currently being displayed. 

4. Click OK. 
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Setting Up Procedure Button 
Templates 
Tere are 24 procedure buttons in the Patient Chart that allow for quick access to recording charting needs. 
You can set up templates for those procedure buttons based on specifc needs and then assign those templates 
to users. Also, each user can choose to use one of the templates or create a custom set of procedure buttons. 
Tis section covers the following topics: 

• Adding Procedure Button Templates 

• Assigning a Procedure Button Template to Users 

Adding Procedure Button Templates 
You can create a new template for the 24 procedure buttons that are available to users in the Patient Chart. 

To add a procedure button template 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Chart Procedure Button Setup. 

Te Chart Procedure Button Setup dialog box appears. 

2. Do one of the following: 

• To create a new 
template based on 
the default button 
set, click New. 

1 

• To create a new 
template based 
on an existing 
template, select the 
template, and then 
click Copy. 

Te New Chart Button 
Template (or Copy 
Chart Button 
Template) dialog box 
appears. 3 

Note: For each button 
in the table on the left, the corresponding code appears in 
the table on the right. 

3. In the Template Name feld, type a name for the 
template. 

4 

4. For each button that you want to customize, do the 
following: 

a. Click the button, such as . 

Te Edit Procedure Button Setup dialog box 
appears. 

5 

OR 

2 

2 
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r. Procedure: 

jD2140 -2:.J 
r Dental Diagnostic: 

~ 
Select Tooltip Text-------~ 

r. Use Procedure Descri ption 

r Use Custom Text 

)Amalgam-1 surf . prim/ perm 

Select Button Face -------------------, 

r♦ Use Image r Use Code Text 

Font: I 

OK 

.:J 

Cancel 

~ 

b. Under Select Code, select one of the following options: 

• Procedure – To assign a procedure code to the button. Ten, either type the desired procedure 
code (ADA, administrative, condition, or product code) or multi-code, or click the search button 

 to select the desired code. 

• Dental Diagnostic – To assign a dental diagnostic code to the button. Ten, either type the 
desired dental diagnostic code, or click the search button  to select the desired code. 

Notes: 

• Dentrix Enterprise uses a smart-code feature. When you are charting a procedure code, 
depending on the surfaces or roots selected, the procedure will be updated when it is posted. 
For example, if you chart a one-surface amalgam (D2140) but select three surfaces, Dentrix 
Enterprise will automatically post the three-surface amalgam (D2160). 

• With the smart-code feature, Dentrix Enterprise not only updates procedure codes based on 
surfaces and roots when posting resins and amalgams but also updates them by tooth number. 
For example, if you use a one-surface anterior resin procedure button when posting a three-
surface resin to tooth 28, Dentrix Enterprise will update and post the procedure to refect three 
surfaces and the posterior tooth. 

• Because of the smart-code feature, you do not need to assign multiple variations of the same 
code, such as for amalgams or root canals, to your procedure buttons. 

c. If you position your pointer over a procedure button, a tooltip will appear with identifying text for 
that button. Under Select Tooltip Text, select one of the following options: 

• Use Procedure Description – To use the procedure or diagnostic code’s description in the 
tooltip. 

• Use Custom Text – To use custom text in the tooltip. Ten, type the desired description in the 
feld provided. 
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d. Under Select Button Face, select one of the following options: 

• Use Image – To use a pre-defned graphic to identify the button. Ten, from the button menu, 
click one of the 65 charting symbols that represent procedure codes. 

• Use Code Text – To use the procedure or diagnostic code to identify the button. Ten, select the 
desired Font. 

Tip: For best results, use a 6-point Arial font. 

e. Click OK. 

5. In the New Chart Button Template (or Copy Chart Button Template) dialog box, click OK. 

Assigning a Procedure Button Template to 
Users 
You can assign any procedure button template as the default for all users or specifc users. 

To assign a procedure button template to users 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Chart Procedure Button Setup. 

Te Chart Procedure Button Setup dialog box appears. 
1 

2. Select a template. 

3. Do one of the following: 

• To assign the template to all users, select the 
Set Selected Template for All Users check box 
(or the [Template Name] is set as the default 
template for all users check box, if a template is 
already assigned to all users). Ignore the following 
steps. 

2 

Important: With a template assigned as the 
default for all users, users cannot use a diferent 
button set or create their own custom button sets. 

• To assign the template to specifc users as their 
default procedure button set, click Set Template 
for User. Tis button is not available if a template 
has been assigned to all users. 

Note: Users can customize the procedure button 
set for the template from the Patient Chart. Te original template will not be afected. Users can also 
create their own custom procedure button sets. 

OR 

3 

3 
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User ID ' I Last . Flrst Name I Oinic I Group 

AGORM Gorman. AJbert AF 

DESMITH Smith , Dennis AF 

MHAYES Hayes , Mane AF 

u Copy I Cancel I 
/4 

Te Set Chart Template “[Template Name]” to Users dialog box appears. 

4. Filter the list of users as needed: 

• To view users with rights in a specifc clinic, 
select that clinic from the Current Clinic 4 
list. To view users with rights in any clinic, 
select <All Clinics> from the Current 
Clinic list. 

• To view users that belong to a specifc user 
group, select that group from the Groups 
list. To view users that belong to any user 
group, select <All Groups> from the 
Groups list. 

5. Select the desired users, and then click Add to 
Selected Users. 

Te selected users are moved to the Selected 
Users list (the lower list). 

5 

6 

6. Click Copy. 
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Setting Up the Ledger 
Tere are several features of the Ledger that you can customize to meet the needs of your practice. You can 
set up or change these at any time without afecting data already entered. However, for consistency sake, it is 
a good idea to set them up before you begin using the system. Tis section covers the following topics about 
setting up the Ledger: 

• Setting Up Checkout Options 

• Setting Up Automatic Credit Allocation Options 

• Setting Up Direct Print Options 

Setting Up Checkout Options 
In most ofces, there are typically three tasks that are completed as a patient checks out after a visit. Te 
Fast Checkout button  combines these three tasks. With the click of a button you can collect a payment, 
generate an insurance claim, and print a receipt. 

To customize the Fast Checkout button 

1. In the Ledger, from the File menu, click Set 
Checkout Options. 1 
Te Checkout Options dialog box appears. 

2. Select the task options you want to complete 
when the Fast Checkout button is clicked: 

• Enter Guarantor Payment – To post a 
payment to the Ledger. 

• Create Insurance Claim – To generate an insurance 
claim. Also, select whether you want to send the claim 
to the batch processor in the Ofce Manager or print 
the claim immediately. 

2 

• Walkout – To print a receipt for the patient. Also, 
select whether you want to send the report to the batch 
processor in the Ofce Manager or print the report 
immediately. 

3 

• Always Show Checkout Options – If the tasks you perform as a patient leaves vary, you can select 
this option so that the Checkout Options dialog box will appear each time the Fast Checkout 
button is clicked, thus allowing you to select the options you need for each patient individually. 

3. Click OK. 
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Setting Up Automatic Credit Allocation 
Options 
Dentrix Enterprise can automatically apply suspended credits and post automatic adjustments for re-allocating 
credits according to selections you make. 

To set up the options for automatic credit allocation 

1. In the Ledger, from the File menu, click Set Auto 
Credit Allocation Options. 1 
Te Set Automatic Credit Allocation Options 
dialog box appears. 

2. Set up the following options: 

• Automatic Suspended Credit Allocation Options 

• Automatically Allocate Suspended Credits 
when Applicable – To have Dentrix Enterprise 
automatically allocate any suspended credits to 
all charges that have a remaining balance. Tis 
will apply all applicable suspended credits to all 
applicable charges, not just the recently posted 
charges. 

• Do Not Automatically Allocate Suspended 
Credits – To have Dentrix Enterprise not 
automatically allocate any suspended credits. 

• Automatic Insurance Payment Adjustment 
Options 

• Credit Adjustment Type – Click the search 
button  to select the adjustment type that you 
want Dentrix Enterprise to use for the credit 
adjustment to ofset a charge adjustment when a 
leftover insurance payment amount needs to be 
allocated automatically. 

• Automatically Allocate – Select Use Automatic 
Suspended Credit Allocation Options to 
default to the selection made for Automatic 
Suspended Credit Allocation Options when 
entering insurance credit adjustments, or select 
Flag Adjustment “Do not automatically allocate” to have Dentrix Enterprise not allocate 
the insurance credit adjustment automatically regardless of selection for Automatic Suspended 
Credit Allocation Options. 

3 

• Charge Adjustment Type – Click the search button  to select the adjustment type that you 
want to use for the charge adjustment when a leftover insurance payment amount needs to be 
automatically allocated. 

• Itemize Automatic Adjustments for Billing Statements – To have Dentrix Enterprise itemize 
automatic adjustments on billing statements. 

Note: It is recommended that you leave this check box clear because the automatic adjustments 
will always be ofsetting adjustments, so they will not afect an account balance and can be 
confusing if included on billing statements. 

2 
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• Adjustment Type for Negative Payments 

• Enable Automatic Adjustments for Insurance Payments – To allow negative insurance 
payments to be posted for claims, select this option. 

• Auto-post Refund adjustments to replace negative payments – To allow negative insurance 
payments to be posted for claims, select this option. A negative payment will appear as a charge 
adjustment on the Ledger. Next, select the Charge Adjustment Type you want to have used as the 
charge adjustment that automatically replaces a negative insurance payment. 

Tip: You may need to add a new adjustment type in Practice Defnitions for this charge 
adjustment. 

• Electronic EOB Options 

• -Credit Adjustment Type – Click the search button to select the default adjustment type to 
use for credit adjustments in the Batch Insurance Payment Entry dialog box. 

• +Charge Adjustment Type – Click the search button to select the default adjustment type 
to use for charge adjustments in the Batch Insurance Payment Entry dialog box. 

3. Click OK. 

Setting Up Direct Print Options 
You can print insurance claims and several reports from the Ledger: walkout statements, billing statements, 
and a family ledger report. A button for each of these reports is located on the toolbar. With the direct print 
options, you can indicate whether the report should be printed immediately or sent to the batch processor in 
the Ofce Manager, where you can print it at a later time. 

To set up direct print options 

1. In the Ledger, from the File menu, click Direct 
Print Options. 1 
Te Direct Print Options dialog box appears. 

2. For each report, select whether you want the 
report to go directly to your printer or to be sent 
to the Batch Processor. 

Tip: If your ofce will be sending claims 
electronically, click Batch for insurance claims, so all 
insurance claims generated during the day will be sent to 
the Batch Processor and can be transmitted simultaneously 
at the end of the day. 3 

2 

3. Click OK. 
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Setting Up Continuing Care Types 
You can add or edit the default continuing care types that you assign to patients to help you track ongoing 
patient care (recall or recare). 

To add or edit a continuing care type 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup > Continuing Care, and then click Continuing 
Care Setup. 

1 

Te Continuing Care Setup dialog box 
appears. 

2. Do one of the following: 

• Click New to add a continuing care type. 

• Select an existing continuing care type, 
and then click Edit to edit that type. 

Te New Continuing Care Type or Edit 
Continuing Care Type dialog box appears. 

3. Set up the following options: 

• Type – Type an abbreviated name for 
this type of continuing care in all capital 
letters. 

OR2 2 

• Description – Type a more complete description of this continuing care type. Tis description will be 
used on continuing care reminder cards, so pay 
special attention to spelling, punctuation, and so 
forth. 

• Interval – Te interval indicates how often 
the patient should be recalled for treatment or 
follow-up. Specify the number of days, weeks, 
months, or years for the interval. Select +1 Day 
to prevent insurance billing problems if the 
carrier has strict interval requirements. 

• Provider – If you want the provider of 
continuing care appointments to be the 
patient’s primary provider by default, click 
Prov1. If you want the provider of continuing 
care appointments to be the patient’s assigned 
secondary provider, click prov2. 

3 

4 

• Default Appt. Time – To enter the amount of time this patient will need for appointments with this 
continuing care type attached, select Time?. Drag the slider to set the number of units, and then set 
up the time pattern for each unit (chair time , assistant’s time , or provider’s time ) to help you 
make use of all operatories when scheduling appointments and maximize your productivity. 

4. Click OK. 
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Setting Up Fee Schedules 
You can add or edit fee schedules to specify the fees that you charge for each procedure. You can have up to 
99,999 fee schedules. 

To add or edit a fee schedule 

1. In the Ofce Manager, from the Maintenance menu, point 
to Practice Setup, and then click Fee Schedule Setup. (Tis 
option is available only if you are logged in to the Central 
clinic.) 

Te Fee Schedule Maintenance dialog box appears. 

1 

Tip: To search for a fee schedule, begin typing the name of a 
fee schedule in the Find Fee Schedule feld. Continue typing 
as needed to narrow down the list. 

2. Do one of the following: 

• Add – To add a fee schedule, click New. Proceed to step 
3. 

OR 

2 

2 

• Edit – To edit a fee schedule, select that fee schedule, and then click Edit. Skip step 3. 

Te New Fee Schedule dialog box appears. 

3. Set up the following options: 

• Fee Schedule Name – Te name of the fee schedule. 3 
• New Fee Schedule Options – Select one of the following 

options: 

• Start with Blank Fee Schedule – To begin with a fee 
schedule with zeros for all the amounts. 

• Copy From Fee Schedule – To use an existing fee 
schedule as the basis or as-is for this new fee schedule. 
Select the desired fee schedule from the list. 4 

Note: You can change any of the amounts as needed later on. 

• New Fee Schedule Position – Select one of the following options: 

• Use Fee Schedule – To use the frst available ID number for this new fee schedule. 

• Select Fee Schedule Position – To use the ID number of an existing fee schedule for this new fee 
schedule. Select the desired ID number from the list. 

• Defne New Number – To specify the ID number for this new fee schedule. 

Tip: Overwriting an existing fee schedule afects all patients, providers, and insurance carriers with 
that existing fee schedule attached. To view the number of patients, providers, and/or insurance 
carriers that the fee schedule is attached to, click Attachments in the Fee Schedule Maintenance 
dialog box. 

4. Click OK. 
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Te View/Edit Fee Schedule dialog box appears. 

5. Do any of the following: 

• Change the Fee Schedule Name. 

• To replace all the amounts in this fee schedule 
with those from another fee schedule, click 
Copy From, and then search for and select 
the desired fee schedule. 

• To attach the fee schedule to one or more 
clinics, next to Attach To, select All Clinics 
or Filter Clinics (and then click the search 
button  to select the desired clinics). To 
not attach the fee schedule to a clinic, select 
Unassigned. With the fee schedule attached 
to a clinic, everywhere in Dentrix Enterprise 
that you can select a fee schedule (such as a 
patient’s dental insurance plan in the Family 
File), you can flter the list of fee schedules by 
clinic. 

5 

6 
• To change a procedure code’s amount (as displayed in the BEFORE column), click that procedure 

code’s fee in the AFTER column, and then type the new amount. Te background color of the 
AFTER cell changes to yellow, and the Diference between the original and the new fee appears 
with a green background (for an increase) or a red background (for a decrease). Repeat this process as 
needed to change other amounts. 

Tip: To help you quickly fnd a procedure code, begin typing a procedure code in the Find 
Procedure Code feld. Te frst matching code is selected. 

• To change all amounts to zeros, click Clear, click Clear only the fee amounts, and then click Yes. 

• To change all amounts to zeros and clear the Fee Schedule Name feld, click Clear, click Clear the 
name and fee amounts, and then click Yes. 

6. Click Save. 

For a comprehensive explanation of fee schedules, see the “Fee Schedule Maintenance” topics in the Dentrix 
Enterprise Help. 
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Editing Procedure Codes 
Many tasks and transactions in a dental ofce are linked to an ADA Procedure Code. Dentrix Enterprise 
comes with all of the procedures listed in American Dental Association Code on Dental Procedures and 
Nomenclature. Edit, or at least review, the following information for the procedure codes you use in your 
ofce: fees, procedure time, and attached continuing care. 

To edit a procedure code 

1. In the Ofce Manager, from the Maintenance menu, point 
to Practice Setup, and then click Procedure Code Setup. 1 

Te Procedure Code Setup dialog box appears. 

2. Select a Procedure Code Category. All procedure 
codes associated with that category appear in the list 
box to the right. 

3. Select a procedure code, and then click Edit. 

Te Procedure Code Editor - Existing dialog box 
appears. 

4. Set up the following options: 

• Auto Continuing Care – When 
a procedure with a continuing 
care type attached to is completed, 
Dentrix Enterprise automatically 
adds the continuing care type to 
the patient and/or updates that 
patient’s continuing care due date. 
Click the search button to select 
a continuing care type for this 
procedure. 

• Procedure Time – To enter the 
number of Appointment Book units 
this procedure takes to perform, 
click the search button . Drag 
the slider to set the number of units, 
and then set up the time pattern for 
each unit (chair time , assistant’s 
time , or provider’s time ) to 
help you make use of all operatories when scheduling appointments and maximize your productivity. 

5 

• Fee Schedule – No fees are pre-assigned with the initial install of Dentrix Enterprise. To change the 
fees for a procedure, select the fee for the fee schedule that you want to change, and then click Edit 
Fee. Te fee in a feld next to the name of the fee schedule can now be edited. Next, type the dollar 
amount you want to charge, and then press Enter to save the change or Tab to move down to the next 
fee schedule. Repeat this process for all fees that you want to change. 

Tip: Te practice’s usual, customary, and reasonable (UCR) fees should be the frst fee schedule. 

5. Click Save. 

For a comprehensive explanation of all the options available for procedure codes, see the “Adding and editing 
ADA-CDT dental codes” topic in the Dentrix Enterprise Help. 

4 
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Multi-Code List 

Multi-Code 

sx111 
xx2,A 
sx2sC 
xx3,A 
sx3sC 
xxBRG 
sxCCA 
xxCCP 
xxClm 
xxNPX 
xxOAM 
xxORS 
xxPDX 
xxPex 
xxPMx 
sxRCC 
xxSCA 

Abb. Desc. 

CrnPClns 
DO Amalg. 
DO Comp. 
MOD Amalg 
MOD Comp. 
Bridge 
CCAdull 
CCChild 
Crnlmp 
NP Ex 
Oamalg 
Oresin 
ParlMand 
PerioExam 
PartMax 
RC/Crwn 
Scale 

Description 

Crn, Psi & Core, Insert 
DO Amalgam, permanent 
DO Composite, post-permanent 
MOD Amalgam 
MOD Composite, post-permanent 
Bridge 
Cont. Care· Prophy, Adult 
Cont. Care · Prophy, Child 
Crown/I mplanl 
New Patient Exam 
0 Amalgam, permanent 
0 Resin, post-perm 
Partial Mand 
Initial Perio Exam 
Partial Max 
Root Canal and Crown 
Scaling 9~''"'-·'-·" ,~'~YI '"" --Cl-os_e __ 

Multi-Cod~ Editor 

Description: Crn, Pst &: Core, Insert 

Multi·Code:~ Abbrev. Desc · lcrnPClns 

Appointment Type: ~I H-,g-h-P,-od_u_ct-,o-n -------3~ 

Procedure Time:f'3, ..::J Unit(s) 
r Type: 

r. Standard 

Code 

"0 2752 
"02954 
"02761 

Description 

Crown-po,c fused noble metal 
Prefab post&:core in add to crn 
Crown Insert 

"Procedure requires lrealmenl info 

r Disable This Multi-Code 

r Bridge I 

Cancel 

Setting Up Multi-codes 
A multi-code allows you to post several procedures simultaneously. A multi-code is a group of procedure codes 
that are typically recommended, scheduled, or completed at the same time. 

To add or edit a multi-code 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Multi-Code Setup. 

Te Multi-Code List dialog box appears. 

2. Do one of the following: 

• Click New to add a multi-code. 

• Select an existing multi-code, and then click Edit to 
edit that code. 

Te Multi-Code Editor dialog box appears. 

3. Set up the following options: 

• Description – Type a description for the multi-code. 

• Multi-Code – Dentrix Enterprise automatically assigns 
“xx” as the frst two characters of a multi-code. Type 
three additional alphanumeric characters to represent 
the code that will be used to identify the multi-code 
when posting. 

22 OR 

1 

• Abbrev. Desc. – Type an abbreviated description of the 
multi-code. 

• Type – If the multi-code will post a bridge, select 
Bridge; otherwise, select Standard. 

• Procedure Codes – To add a procedure code to 
the multi-code, click Add. In the Add Code dialog 
box, type an ADA procedure code, or click the 
search button  to select a procedure code. If the 
procedure code selected requires the entry of additional 
information, additional options appear in the lower-
right corner of the Add Code dialog box so that you 
can pre-defne a surface(s), a quadrant, or a sextant. 
Ten, click OK. 

Important: A multi-code may consist of one or 
more procedures that require additional treatment 
information to be entered, such as a tooth number. 
Multi-codes that require additional information will be fagged with an asterisk (*) in the list box. Te 
additional information must be supplied when posting the multi-code. 

4 

3 

4. Click OK. 
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Practice Definrtions 

Definition IJ,pe 

Allergen Type 
Allergies 
Allergy Reaction 
Alternate Procedure Code Names 
Appointment Check List 
Appointment Break Reasons 
Appointment Reasons 
Appointment Status 
Approval Status 
Appointment Types 
Billing Types 
Blood Type 
Claim Format 
Claim Resubmit Reason 
Continuing Care Stat us 
Custom N ates 
Dental Diagnostic Code Categories 
Ethnicity 
Firif:lnci.:11 Clc1~" T voe<:c 

Definition T e:-:t r Professional Discount 

• I 
2: -Cash Discount 
3: -Credit Adjustment 
4: +Debit Adjustment 
5: +Patient Refund 
6:-Write-011 

rican Fork Dental P 

Maintenance An, 

Desc,i tion 

-Mailing Labels 

bdd 

!;hange 

Delete 

Customizing Practice Defnitions 
Dentrix Enterprise provides several “practice defnitions” and allows user-defnable entries for each. Tese 
practice defnitions, in addition to other features, can help you customize Dentrix Enterprise for your specifc 
needs. 

You can add and edit practice defnitions. 

Important: Before you customize defnitions, read the following recommendations carefully: 

• Customize defnitions that have not yet been assigned to patients in order to avoid potential problems. 

• Dentrix Enterprise assigns the defnition number to a patient, not the customizable description. 
Modifying the text description of a defnition will change that defnition for all patients to whom the 
defnition has been assigned. For example, if patients are assigned medical alert 13 “hay fever,” and it is 
changed to “pregnancy,” those patients will still have medical alert 13, but it will now show as “pregnancy” 
in their fle. 

• Before deleting a defnition, try changing the existing description to a new, more useful description. 
Deleting a defnition can lead to data corruption. For example, if the appointment status 4 “Patient 
has Arrived” will not be used in your ofce, you can change it to a more useful defnition such as, “Left 
Message.” 

• With the exception of medical alerts, defnitions are listed in numerical order. As a result, the frst 
defnition serves as a default selection for most defnition types. Be sure to make the most commonly used 
defnition the frst defnition in the list. 

To customize a practice defnition 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Defnitions. 

Te Practice Defnitions dialog box appears. 

2. Select a 

1 

Defnition Type 
to add or edit 
defnitions for 
that type. 

3. Do one of the 
following: 

• To add a new 
defnition, 
for some 
defnitions, 
select and 
replace the 
existing ID (if relevant) and Defnition Text with a new ID and description, and then click Add. For 
other defnitions, click Add to set up the necessary options. 

2 

OR 

3 

3 

• To edit a defnition, for some defnitions, select that defnition, replace the existing Defnition Text, 
and then click Change. For other defnitions, select the defnition, and then click Change to modify 
the options. 

For comprehensive details about customizing each defnition type, see the “Practice Defnitions” topic and its 
subtopics in the Dentrix Enterprise Help. 
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r - American Fork Dental P 

Dale 

03/16/2017 Continuing Ca,e Display List - Mailing Labels 

Practice Defaults 

General I Claim Providers ) eClaims Override I 
Default S. tudent Prov: 

Default Erovider: jDESMITH ..:.:J jsmith. Dennis E 

Default.Qperatory: .---------..:.:J 
Default Cop~ Patient Information-----------------, 

Copy Patient Clinic: IAF ..:.:J !American F Olk Dental Pr actic 

Copy Patient Provider: '"jD_S_M_I-TH ____ ..:.:J jsmith. Dennis 

Character to be Appended To Charttt: i 
Default Cbart Provider--------------------, 

C. Patient's P,ov1 l'7 Provider from Selected Appointment 

r Specific Provider ..:.:J 

Default Billing Type Default Billing Statement 

I - •· .: 
02 - Standard Billing - no finance charges D 
03 - Insurance Family - delay finance charges 
04 - Insurance Family - finance charges 
05 - P avment Plan - finance charaes 

,. 
Full Sheet 
11x6 Mailer-8096 
9.5x6 Mailer-8095 
Short Form -9164 

□ 

Insurance Eligibility---------------------, 

_Eligibility Check Date valid for ~ days. 

Signature on File Defaults------------------~ 

Dental: r Release of Information r Assignment of Benefits 

Medical: r Release of Information r Assignment of Benefits 

Preferences .. I OK Cancel 

Setting Up Practice Defaults 
When entering patient information or performing certain tasks, the process of having to choose a provider 
or operatory can be redundant. Dentrix Enterprise allows you to set a default provider, billing type, chart 
provider, insurance claim providers, and billing statement. Changing the practice defaults afects only the 
computer from which you are changing the defaults. You can change the practice defaults at any time. 

To set up the practice defaults 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Practice Defaults. 

Te Practice Defaults dialog box appears. 

2. Set up the following defaults: 

General tab 

1 

• Default Provider – Te provider selected will be the primary provider assigned to each new head-of-
house. If you want to remove a selection, delete the text. 

• Default Chart Provider – Te provider selected will be the default provider when charting 
procedures for the patient. Click Patient’s Prov1 to have the patient’s primary provider act as this 
default, or click the Specifc Provider search button  to select a provider. 

By default, the Provider from Selected 
Appointment check box is clear. Select 
this check box if you want to keep the 
provider for a selected appointment in the 
Appointment Book as the provider for 
charting when you open the Patient Chart 
from the Appointment Book (by clicking 
the Patient Chart module button or by 
clicking Chart from the File menu) with 
an appointment selected. If an appointment 
is not selected in the Appointment Book 
when the Patient Chart is opened, the 
default Patient Chart provider will be the 
selected patient’s Provider 1 or the provider 
you specify, regardless of whether or not 
the Provider from Selected Appointment 
check box is selected. 

2 

• Default Billing Type – Te billing type 
selected will be the billing type given to 
each new head-of-house. 

• Default Billing Statement – Te billing 
statement selected will be the form used 
when printing billing statements. 3 

• Signature on File Defaults – You can 
specify the default status of the Release of Information and Assignment of Benefts check boxes 
when attaching dental insurance plans to patients and attaching medical insurance plans to patients. 

Note: Changing these settings does not afect insurance plans that have already been assigned to 
patients. 
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Defaults 

Gene,al Claim Providers ) eClaims Override I 

Clinic: !CENTRAL 

Claim Provider Templates: 

Main T em late 
Template for Aetna 
Template for Delta 

• Selected Active Template 

P1eferences ... 

[ill 

Select Template I 

Add 

Edit 

Delete 

Copy 

OK Cancel 

Claim Providers tab – You can set up the  
default insurance claim providers for each 
clinic. Each clinic can have its own defaults. 
Also, Dentrix Enterprise can handle exceptions 
for various insurance plans as needed, so you 
don’t have to change the defaults each time you 
want to create claims for certain insurance 
carriers. 

You set up templates to handle the default 
providers for claims. Each clinic can have a 
“main” template and any number of “exception” 
templates (which may vary based on the 
insurance plan). Te Central clinic’s defaults 
are used for all clinics that do not have a main 
template. 

• Add – While logged in to any clinic, you 
can set up templates for Central or any 
other clinic. To add a template, do the 
following: 

a. Select a Clinic. 

b. Click Add. 

c. Set up the following options as needed: 

• Claim Provider Template Name – Te name for the template. Template names within a 
clinic must be unique, but templates with the same name can exist in multiple clinics. 

• Billing Provider – Te provider will be the provider printed on claims. 

Select one of the following: 

• Provider of Procedures – To use the provider applied to procedures. 

• Patient’s Prov1 – To use a patient’s primary provider selected in the Family File. 

• Specifc Provider – To always have a specifc provider listed and then click the search 
button  to select the appropriate provider. If you want to override the name in the 
database, select Name to use for Provider; and then click the search button to select 
a provider name, or type a name in the feld. 

• Rendering Provider – Te provider selected will be the provider that performs the services 
being billed on a claim. 

Select one of the following: 

• Provider of Procedures – To use the provider applied to procedures. 

• Patient’s Prov 1 – To use a patient’s primary provider selected in the Family File. 

• Specifc Provider – To always have a specifc provider listed and then click the search 
button  to select the appropriate provider. Te rendering provider specifed for a claim 
will only be used for electronic claims. 

• Pay-To Provider – Te provider selected will be the provider whose name appears in the pay 
to provider section of a claim. 

Select one of the following: 

• Claim Provider of Procedures – To use the provider applied to procedures. 

• Patient’s Prov 1 – To use a patient’s primary provider selected in the Family File. 
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• Specifc Provider – To always have a specifc provider listed and then click the search 
button  to select the desired provider. If you want to override the name in the 
database, select Name to use for Provider; and then click the search button to select 
a provider name, or type a name in the feld. 

• Insurance Plan Exceptions (For a main template) 

• Add exceptions after you have added your main template and the necessary exception 
templates for the selected clinic. To add an exception for a plan that does not use this 
template, click the Insurance plan search button to select the insurance plan that 
you want to associate with this exception. Ten, click Add. 

• Remove exceptions that are no longer valid or that were added my mistake. To remove 
an exception, select that exception, and then click Remove. On the confrmation 
message that appears, click Yes. Te exception is removed not the associated insurance 
plan or template. 

Note: Any exceptions that you add to an exception template are ignored when claims are 
created. Only exceptions for a main template are used for claims. 

d. Click Save. 

• Delete – To delete a template, do the following: 

a. Select a Clinic. 

b. Under Claim Provider Templates, select a template, and then click Delete. 

c. On the confrmation message that appears, click Yes. 

• Select Template – Select the main template (the default or primary template) for the selected clinic. 
By default, the frst template you add is the main one, but you can make any template the main one 
as needed. To specify the main template, select a template under Claim Provider Templates, and 
then click Select Template. Te main template’s name is preceded by an asterisk (*) in the Claim 
Provider Templates list box. 

• Copy – Copy a template to the same or a diferent clinic with a diferent name. Exceptions, if 
any, from the original template are not copied because each clinic can have its own unique set of 
templates. To copy a template, do the following: 

a. Select a Clinic. 

b. Select a template, and then click Copy. Te Copy Claim Provider Template dialog box appears. 

c. Click the New Template Clinic search button  to select the clinic where you want the new 
template to be added. 

d. Type a name for the template in the New Template Name feld (it can be the same as the original 
if you are copying the template to a diferent clinic than the original’s). 

e. Click OK. 

f. Click OK on the message that appears. 
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Practice Defaults 

General I Claim Providers eClaims Override I 

Clinic: !CENTRAL 2..:.l 
Name and IDs-------------------~ 

C. Claim Billing Prov r Claim Rendering Prov r Claim Pay-Ta-Prov 

r Specific Pmvider I 
r Name to use for Provider I 

Address and Phone------------------~ 

C. Claim Billing Prov 

r Rende,ing Clinic 

r Specific P,ovider I 

P!eferences .. . 

r Claim Rendering Prov r Claim Pay-Ta-Prov 

OK 

r Numeric 

r. Alpha / N ume,ic 

r None 

Cancel 

eClaims Override tab – For each clinic, do the  
following: 

a. Select a Clinic. 

b. Set up the following options for the clinic: 

• Name and IDs – Specify the provider 
whose name and provider IDs you want to 
use for the billing provider’s name and IDs 
on claims submitted electronically. 

• Address and Phone – Specify the provider 
whose address and phone number you want 
to use for the billing provider’s address 
and phone number on claims submitted 
electronically: 

3. Click OK to save the changes. 

For comprehensive information about all the practice defaults, see the “Practice Defaults” topic in the Dentrix 
Enterprise Help. 

Setting Up Auto Chart Numbering 
You can set up Dentrix Enterprise to generate chart numbers for your patients automatically (MSSQL databases 
only). By using this feature, you can eliminate duplicate chart numbers and speed data entry for new patients. 

Note: If your ofce uses the HL7 interface to connect Dentrix Enterprise with a medical practice management 
system (PMS), chart numbers will likely be generated in the medical PMS and transferred to Dentrix Enterprise. 

To set up auto chart numbering 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Auto Chart Number Setup. 

Te Automatic Chart Numbering Setup dialog box appears. 

2. Select an automatic chart numbering option: 

• Numeric – To assign numeric chart numbers to all new patients. 

• Alpha/Numeric – To assign an alphanumeric chart number to all new 
patients. Te chart number will be the initial two characters of the 
patient’s last name and then a unique numeric ID (for example John 
Smith might be assigned SM0001). 

1 

2 

3 
4 

• None – Not to use chart numbers in your ofce or to assign chart 
numbers manually. 

3. From the Select Minimum Length list, select the minimum length for automatically-generated chart numbers. 

4. Click OK. 
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Office Manager - American Fork Dental P 

Date 

'1!i DXONE Printer Selection 

Select Off ice Manager Printer: 

<Default Printe1> 
Mic,osoft XPS Document W,iter 

i~~ Flom Copie, 0 
Send To OneNote 2010 
novaPDF 
Adobe PDF 
Snagit 11 

Select P,inter A,ea: 

r. 0 ff ice Manager P,inter r P,escriptions P,inter 

r Chait Printe, r Perio P,inter 

r Label Printe, r P,esente, Printer 

r Document Cente, Printe, 

Cancel Apply 

Setting Up Default Printers 
You can set up a default printer for printing from the Ofce Manager and other areas throughout Dentrix 
Enterprise. However, before printing from the Ofce Manager or other modules, the printer to which you 
want to print must frst be selected. 

To select a default printer 

1. In the Ofce Manager, from the File menu, click Setup 
Printer. 1 
Te DXONE Printer Selection dialog box appears. 

2. Under Select Printer Area, select the area of Dentrix 
Enterprise to which you want to assign a default printer: 

• Ofce Manager Printer – To print reports from the 
Ofce Manager module. 

• Chart Printer – To print from the Patient Chart module. 

• Label Printer – To print labels. 

• Document Center Printer – To print documents from 

3 

the Document Center module. 

• Prescriptions – To print prescriptions from the 
Prescriptions module. 

• Perio Printer – To print periodontal examinations from 
the Perio module. 

4 

• Presenter Printer – To print treatment plan presentations from the Treatment Planer module. 

3. In the list box of printers, select the printer that will be used to print from the selected area. 

4. Click OK. 

2 
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Setting Up Security 
Passwords in Dentrix Enterprise serve many diferent functions. First, you can use passwords to prevent an 
unauthorized person from performing certain sensitive tasks, such as changing information, deleting transactions, 
and accessing fnancial information. Second, you can have the extra security of fagging certain operations to 
require additional user verifcation—the password must be re-entered—to perform those operations. 

You can create user groups to group users by role or some other method that suits your needs. Having users in 
groups allows you to manage security rights for all users in a given group at the same time instead of having to 
manage rights per user. 

Te enhanced security rights feature of Dentrix Enterprise provides you with the fexibility to implement and 
manage security rights to suit your preferences. You can choose whether to use user groups or not use them. 
You can choose whether to assign all or only some users to groups. You can assign a user to multiple groups. 
Also, on a user-by-user basis, you can customize a user’s rights whether or not those rights have been assigned 
to that user by a group. 

In Dentrix Enterprise, each user is assigned “rights” to the tasks they need to complete. Dentrix Enterprise 
then allows access to each password-protected operation, according to the security rights assigned to the 
logged-on user. If a user does not have rights to perform a certain function, they cannot access that particular 
area of the program or perform that particular task. 

Assigned rights are clinic-specifc. Each user will need to be given rights for each clinic to which they have access. 

Note: It is recommended that the doctor read this section carefully and be aware of who is given “Password 
Administration” rights in the ofce. 

Tis section covers the following topics on setting up passwords: 
• Password Requirements 
• Database Encryption 
• Adding User Groups 
• Assigning Users to Groups 
• Customizing Security Rights 
• Copying Security Rights 
• Setting Up Secure Passwords 
• Assigning User Verifcation to Tasks 

Password Requirements 
Te passwords for user accounts must adhere to the following criteria: 

• Complexity – Te password must be at least 8 (for standard users) or 15 (for administrative users) 
characters in length and meet the following requirements: have at least one uppercase letter, have at least 
one lowercase letter, have at least one number, and have at least one special character (for example, #, %, 
or &). 

• Changes – When the password is changed, at least 75% of the characters must be diferent in the new 
password than in the old password. 

• Storage and transmittal – Passwords must encrypted when being stored or transmitted. 

• Expiration – A password can be valid for one to up to 60 days. Ten, it expires and must be changed. 

• Reuse – When changing a password, any of a given user’s previous six passwords cannot be reused. 

• Temporary passwords – A temporary password can be provided for a given user to log on to a system, 
but a permanent password must be created by the user immediately upon logging on. 
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Database Encryption 
Employ at least 128-bit encryption to protect data at rest in the EDR SQL database. Bit Locker encryption 
that is implemented at the operating system level does not sufce for this control. 

Employ encryption to protect the confdentiality and integrity and availability of data during transit. Tough 
EDR and RPMS servers are usually collocated, information is still vulnerable from attackers seeking to hijack 
information in transit. Encryption is required because EDR and RPMS are both High systems. DIS-SOP-06-
11a:8.3 recommends a FIPS 140-2 certifed encryption solution when transmitting and receiving PHI. 

Encrypting Data at Rest 
Enabling transparent data encryption (TDE) protects data at rest. Backup fles are also protected. Refer to 
https://msdn.microsoft.com/en-us/library/bb934049(v=sql.110).aspx. 

Notes: 

• TDE requires decryption after data is retrieved from the disk, which will slow down the server. Data in 
memory is not encrypted. 

• To restore the database from a backup, the certifcate protecting the database encryption key must also be 
available, so you must maintain backups of the server certifcates to prevent data loss. 

For information about creating and using SQL server certifcates and asymmetric keys, refer to https://msdn. 
microsoft.com/en-us/library/bb895327(v=sql.110).aspx. 

Encrypting Data During Transit 
Protect data during transit by doing the following: 

• Enabling Secure Sockets Layer (SSL) protects data during transit. Refer to https://technet.microsoft.com/ 
en-us/library/ms189067(v=sql.110).aspx. SSL requires some confguration changes on the SQL server. 

• Using Internet Protocol Security (IPSec). Refer to https://en.wikipedia.org/wiki/IPsec. IPSec does not 
require any confguration changes on the SQL server. 

https://en.wikipedia.org/wiki/IPsec
https://technet.microsoft.com
https://msdn
https://msdn.microsoft.com/en-us/library/bb934049(v=sql.110).aspx
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Users Groups 

Us rou:ps : ~-----------------..... Billing Coordinators 

Oinical 

Doctors 

Front Desk 

New Group Setup 

Group Name: I 
~ Select Security Options Rights ----------­

lt]···D Administration 

~ndlist 

Co[lapse List I 

;i:electA/1 

RefilOVe A/1 

1B D Appointments 
~ D Central 0 inic Only 
IB···D Continuing Care 
~ D Family Rle 
IB O Diart 
~ ···D Treatment Plans 
IB···D Completec Procecures 
ltl···D Insurance 
IB O Ledger 
~ ···D Billing and Collections 0 
1B D Letters 
~ ···D Office Journal 
!B O Referrals 
ltl···D Prescriptions/ Immunizations 
ltl···D Questionnaire 

~ ···D Office Manager 
IB···D Practice/Oinic Setup 
$ ···0 Document Center 
IB···D Emergency Access 

U Q_K l __ !::.l_os_• ~ __ bP_P_ly~ 

Adding User Groups 
You can create user groups as needed to group users by role or some other method. 

To add a user group 

1. In the Ofce Manager, from the Maintenance menu point to 
Practice Setup > Security Setup, and then click Security Rights 
Setup. 

Te Security Rights Setup dialog box appears. 

2. Click the Groups tab. 

1 

2 
3. Under User Groups, click New. 

Te New Group Setup dialog box appears. 

4. Set up the following options: 

• Group Name – Type a name to identify the 
group. 

• Rights – Select the check boxes of the rights 3 
(categories and/or individual rights) that users 
in this security group should have by default. 

5. Click OK. 

4 

5 
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Assign Groups to Users 

Clear Al l 

Groups 

Security Rights Setup 

· Users Groups I 
User Groups : 

B1fl1ng Coord1natorn 

Oinical 

Doctors 

Front Desk 

Full Access 

Queue 

Ass igned Users-------------, 

r- By Clinic r By User 

Clinics 

Users 

I 

S=~t~roup(s) 
do you want to 
add users to? 

~-------------~ 

User I Group I Oinic 

Add 

Users 

ID I Last I Rrst 

Add 

Cli nics 

Add 

tuser(s)do o 
uwantto 

assign to the 
groups above? 

Step 3) 

What clinic(s} do 
you want the users 
above to have the 
assigned groups 
for? 

~ ---C_los_ e""'-

Assigning Users to Groups 
After you have created the necessary user groups, you can assign users to those groups as needed. A user can be 
assigned to multiple groups. 

To assign users to a group 

1. On the Groups tab of the Security Rights 
Setup dialog box, under Assigned Users, with a 
group sselected, click Add. 

Te Assign Groups to Users dialog box appears. 

2. Set up the following options: 

• Groups – To select the groups that you 
want to add users to, click Add. 

• Users – To select the users that you want to 
add to the selected groups, click Add. 

• Clinics – To select the clinics that you want 
the selected user groups to have rights in, 
click Add. 

3. Click the Add to Queue button . 

4. Click Process Queue. 

5. Click Close. 

1 

5 

3 

4 

2 
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Customizing Security Rights 
You can customize a user’s rights whether or not those rights were assigned to that user due to that user being 
part of a group. 

To customize a user’s rights 

1. On the Users tab of the Security Rights Setup dialog box, under Select User, select a user. 

1 

2 

3 

2. From the Clinic selected list, select the clinic that you want to customize rights for. 

3. Under Preview, click Edit Rights. 

Te Edit User Rights dialog box appears. 

4 

5 
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!Select Security Options Rights 

El···OO Administration 

1. !·····■ P_a~sword_ Administration , :···■ a,nic Adm1n 
: L.... Reset Locked User 

!Select Security Options Rights 

El···~ Administration 

1. I·····■ Password Administration 
: :··· ~ timlllllll 
i L.... Reset Locked User 

!Select Security Options Rights 

El···[I) Administration 

1. L.... P.assword. Administration \ (···■ 0 1rnc Adm1n 
i L ... 0 Reset Locked User 

!Select Security Options Rights 

El~ • 
1. L ... ~ P.assword. Administration 
: :···~ a,nic Adm,n 
i L ... ~ Reset Locked User 

!Select Security Options Rights 

El···~ Administration 

1. L ... o Password Administration 

: : ~ timlllllll 
: L ... 0 Reset Locked User 

!Select Security Options Rights 

El···O Administration 

1. L ... o P.assword. Administration 
\ (···D 0 1rnc Adm1n 
: L ... 0 Reset Locked User 

!Select Security Options Rights 

El~ . , " . 

! !..... P_a~sword_ .Administration 
I :--- ·· Oirnc Admrn 
i i.... Reset Locked User 

4. Change the assigned rights as needed by selecting and/or clearing the desired check boxes: 

• If the check box of a category has a black X, the rights in that category are assigned by a security 
group. All the check boxes of the rights in that category have gray backgrounds. 

If you clear all the check boxes in a category, the check boxes of the rights in that category will still 
have gray backgrounds, and if you then select a check box, the background stays gray. 

• If the check box of a category has a gray X, the rights in that category are assigned by a security 
group. Te check boxes of only the rights in that category that are assigned to the user have gray 
backgrounds. Te check boxes of unassigned rights are clear. 

• If the check box of a category has a black check mark, the rights in that category are not assigned by a 
security group. All the check boxes of the rights in that category are selected. 

• If the check box of a category has a gray check mark, the rights in that category are not assigned by 
a group. Te check boxes of only the rights in that category that are assigned to the user are selected. 
Te check boxes of unassigned rights are clear. 

If you clear all the check boxes in a category, the category check box will be cleared automatically. 

5. Click OK. 

For a comprehensive list of all security options and their corresponding descriptions, see the “Security rights 
list” topic in the Dentrix Enterprise Help. 
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Copying Security Rights 
If diferent users will have the same security rights selected, or if a user works at more than one clinic, you can 
save time by copying the rights to diferent users and clinics and to a user group. 

To copy security rights 

1. From the Security Rights Setup dialog box, select a user. 

2 

1 

3 

2. From the Clinic selected list, select a clinic. 

Note: To show active and inactive users or show only active users in the Select User list, select or clear the 
List Inactive check box. 
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Security Rights · Copy Rights From Other User 

Rights wi ll be copied to: !Smith, Dennis 

Current C li nic : !CENTRAL 

Rights to Copy-------------------~ 

r Individual Rights (" Group Rights r+ Individua l and Group Rights 

Use r to be Copied F rem: 

User ID I User Name 
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Close 

Cl inics selected to copy rights from: 

Security Rights · Copy Rights from Current Clinic to Other Clinics 
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User ID: "'JD-=E""s"'M"'IT"'H ____ _ 
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Rights to Copy-----------------------, 

C. Individua l Rights r Group Rights r Individual and Group Rights 
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r Do Not Ovel'\uite Exis ting Rights 

OK Cancel 

3. Do any of the following: 

• Copy Rights From Other User – To copy rights from a specifed user to the selected user, do the 
following: 

a. Click Copy Rights From Other User. 

Te Security Rights - Copy Rights From 
Other Users dialog box appears. 

b. Under Rights to Copy specify if you want 
to copy Individual Rights (rights assigned 
to a user individually), Group Rights 
(rights assigned to a user due to being part 
of a group), or Individual and Group 
Rights. 

c. Under User to be Copied From, select the 
user from whom you want to copy rights. 

d. To prevent disabling the rights that the 
user who the Rights will be copied to has 
enabled for the Current Clinic, select the 
Do Not Overwrite Existing Rights check 
box. 

e. Do one of the following: 

• From the Clinics available for selection list, select the clinics that you want to copy rights 
from, and then click the right arrow button to move them to the Clinics selected to copy 
rights from list box. Ten, click Copy from ALL selected clinics. 

• To copy rights from the Current Clinic only, click Copy from Clinic: [Current Clinic]. 

• Copy Rights To Other Clinics – To copy rights for the selected user from the selected clinic to 
specifed clinics, do the following: 

a. Click Copy Rights To Other 
Clinics. 

Te Security Rights - Copy Rights 
from Current Clinic to Other 
Clinics dialog box appears. 

b. Under Rights to Copy specify 
if you want to copy Individual 
Rights (rights assigned to a user 
individually), Group Rights (rights 
assigned to a user due to being part 
of a group), or Individual and 
Group Rights. 

c. From the Clinics available for 
selection list, select the clinics that 
you want to copy rights to, and then 
click the right arrow button to move 
them to the Clinics selected to copy rights to list box. 

d. To prevent disabling the rights that the user has enabled for the Clinics selected to copy rights 
to, select the Do Not Overwrite Existing Rights check box. 

e. Click OK. 
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• Copy Rights To Other Users – To copy rights of the selected user for the selected clinic to other 
users, do the following: 

a. Click Copy Rights To Other Users. 

Te Security Rights - Copy Rights 
To Other Users dialog box appears. 

b. Under Rights to Copy specify 
if you want to copy Individual 
Rights (rights assigned to a user 
individually), Group Rights (rights 
assigned to a user due to being part 
of a group), or Individual and 
Group Rights. 

c. From the Users available for 
selection list, select the users who 
you want to copy rights to, and then 
click the right arrow button to move 
them to the Users selected to copy 
rights to list box. 

d. To prevent disabling the rights that the Users selected to copy rights to have enabled, select the 
Do Not Overwrite Existing Rights check box. 

e. Click OK. 

• Copy Rights To Group – Click this button to copy the selected user’s rights to other users. 

Ten, from the Copy Group Setup dialog box, type 
a Group Name, select the check boxes of the rights 
(categories and/or individual rights) that users in this 
security group should have by default, and then click 
OK. 
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P' Require Secure User Passwords 

Password Expira tion---------~ 

r. Expiration 

expires every ~ days 

P' Warn ~ days before expiration 

C- No Expiration 

Set Security Default,; 

17 Lock user out for 

...:J minutes after 

..:.J failed logon attempt,; 

17 Do not allow use of the past 

~ previous passwords 

Save Close 

Setting Up Secure Passwords 
A clinic can set up a time interval that forces users to change their passwords regularly. For instance, an ofce 
may want to enforce a change of password every three months. In conjunction with this, your ofce can set a 
requirement that users cannot reuse any of their previous passwords. 

To set up secure user passwords 

1. While logged on to the Central clinic, in the Ofce Manager, 
from the Maintenance menu point to Practice Setup > Security 
Setup, and then click Secure User Password Setup. 

Te Secure User Password Setup dialog box appears. 

2. Set up the following options: 

• Password Expiration – If you want passwords to expire 
so that users have to change their passwords after a 
certain length of time, click Expiration, and then select 
a password expiration date in days. If you want users 
to be forewarned of a pending password change, check 
Warn, and then select the days before the expiration date 
that you want the notifcation to appear. If you do not 2 

1 

want passwords to expire (users will never have to change 
passwords), click No Expiration. 

• Set Security Defaults 

• Lock user out for – To select how many logon 
attempts a user has before that user is locked out of 
the system for a specifc period of time, check this 
option, select the time interval for which a user will be 
locked out in minutes, and select the number of logon 3 
attempts users have. 

Note: When a user is locked out, an administrator can reset any and all locked out users. 

• Do not allow use of the past – If you want to prevent users from reusing a specifc number of 
old passwords, check this option, and then select how many previous passwords you want to 
block. 

3. Click Save. 
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Assigning User Verifcation to Tasks 
Once a user has logged on to Dentrix Enterprise, the user may perform all tasks to which they have rights. 
Tere can be certain situations for which additional protection is desired. In these cases, the security options 
can be fagged to “Verify User Before Access.” With this security fag enabled for a task, users will be prompted 
to re-enter a user name and password when attempting to perform that task. 

Tip: Consider how frequently the security task is performed before assigning the “Verify Users Before Access” 
fag. Tis fag will always prompt users to enter their passwords before they can continue working; a lot of 
interruptions might not be worth the added security. 

To assign user verifcation 

1. In the Ofce Manager, from the Maintenance menu point to 
Practice Setup > Security Setup, and then click Verify User 
Before Access. 

Te Verify User Before Access dialog box appears. 

2. Select one or more tasks. 

3. Click Verify User Before Access. 

Te selected tasks are fagged and moved to the bottom of the list. 
An asterisk (*) appears before a security option that is fagged to 
require re-entry of a password every time users attempt to perform 
that task. 2 

1 

4. Click OK. 

3 

4 
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Setting Up Program Preferences 
You can customize Dentrix Enterprise to the way your practice works. Each computer can have diferent 
preference settings. 

To set up preferences 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Preferences. 1 
Te Preferences dialog box appears. 

2. On the General Options tab, set up the following preferences: 

• Find Appointment Time Defaults – Set 
the defaults for the Find Appointment 
Time button in the Appointment Book. 
Select the Block size in minutes and an 
Appt Length. Select All Operatories 
Selected to search all operatories and/or 
Sort by Operatory ID to sort the results 
by operatory ID. Select whether to search 
by the current Appointment Book view or 
by the current clinic. 

2 

• Apply to Charges for’ Default – To have 
charges default to the family of the selected 
patient when making a payment or credit 
adjustment, click Family. Or, to have 
charges default to whomever’s account is being viewed in the Ledger, click Ledger View. 

3. On the Print Options tab, set up the following preferences: 

• Use ADA Codes in Descriptions – 
To have ADA codes print with their 
descriptions, select this check box. 

• Provider ID Column for Statements – To 
have the provider ID printed next to each 
transaction description on walkouts and 
billing statements, select this check box. 

• No Insurance Flag(*) on Statements – To 
remove the text “*Indicates this procedure 
has been billed to Insurance” from billing 
statements, select this check box. 

• Verify Billing Statements to Send – To 
preview billing statements before printing 
them or sending then electronically, select this check box. 

3 

4 

• Sort Claim by ID – To print procedures on insurance claims in the order the procedures were posted 
in the Patient Chart or Ledger, select this check box. 

• Sort Pretreatment by ID – To print procedures on pre-estimate claims in the order the procedures 
were posted in Patient Chart or Ledger, select this check box. 

4. Click OK. 
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Chapter 2: Family File 
Te Family File stores and displays important patient information, such as a patient’s name, address, phone 
number, medical alerts, birth date, insurance coverage, employer, and referral information. Dentrix Enterprise 
organizes patients by family in the Family File. 

Tis chapter covers the following topics about using the Family File: 

• Te Family File Window 

• Selecting a Patient 

• Adding Families and Patients 

• Working with Employers 

• Working with Insurance 

• Assigning Continuing Care 

• Working with Patient Notes 

• Working with Referrals 

• Assigning Medical Alerts 

• Archiving Patients 

• Editing Family Relations 

• Merging Duplicate Patients 
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16 Dentrix Family Fil e - (Crosby, Brent) [AF] [UTC -07:00 [MST)] [DESMITH) [CR0004C] G][ffil~ 
,tile f dit !::!elp 

l~ lMII ~1~i~ oi0lc:ol~l~l~l~li:DIOl~lct ll ~1~~1~~llt-l~II~ ldll , lruiEJl~l~l~l~l~I 
Name: Crosby, Brent Chari U: CR 0004C ~ Addreu: 1234 Oak St Consent: 11/26/2002 Clinic: AF 

American Fork, UT 84003 First Visit: 1112612002 S SU: 123-45-6789 
Lasl Visit: 11/13/2017 Birthday: 11 / 11 /1973, 44 

Phone: H (801 )555-6177. W (801 )555-3563 Missed Appl: 11 /0812017. 3 Provider: DE SMITH . MHAYES 
Fee Sched: <Prov Default> 

Status: Active, M, Married, Guar, Ins, H-of-H E-Mail: documentation@henr_yschein.com 

Medical ~ !Employer _ Cont 09/15/17 Perio Exam 
Alerts Care 08102118 PROPHY 

ranee: I Dental Primar_y ..:J Patient Noles View I ·- Company: Delta PMI 
Group Plan: Ca 721 

- 6 ~up #: 123456 

Coverage: 10000.00 Used: 0.00 

~ -Ded_ S/P/D: 5010150 Mel: 01010 

o-->30 I 31--> 60 161-->90 I 91--> ISu:s:pende~ Balance I Referred By 04/1512015 
985.00 350.00 1280.00 3161.00 -449.00 5327.00 +Evans, Natalie (Dentist) 

Payment Ami: NA Amt Past Due: NA Referred To 05/1112015 
Bill Type: 13 Last Payment: 20.00 0410712015 + Oral Surgery Abulafia, Lewis 

Slalus Name Position Gender Patient Birlhdav 
Ho/H Guar Ins C1osbv 81ent Mariied Male Yes 1111111973 . 

C,osby, Shirley Married Female Yes 11/11 /1975 
□ Crosby, Crystal Child Female Yes 1111112002 

Ins C,osby, Tom Single Male Yes 11111 /2002 
T 

- -

Status Name Position Gender Patient Birthda'° 
HofH Guar Ins Crosbu Brent Married Male Yes 11/11/1973 . 

Crosby, S hidey Ma1ried Female Yes 11/11/1975 
□ Crosby, Crystal Child Female Yes 11/11/2002 

Ins Crosby, Tom Single Male Yes 11/11/2002 
T 

The Family File Window 
Tis section covers the following topics to help you understand how to use the Family File window: 

• Te Family File Blocks 

• Te Family Member List 

• Te Family File Toolbar 

The Family File Blocks 
Te Family File window contains several sections, called “blocks,” that display information. By double-
clicking any of these blocks, you can enter, edit, or delete corresponding patient information. 

Patient Information 
Block 

Continuing 
Care Block 

Employer Block 

Medical Alerts Block 

Patient NotesInsurance 
BlockInformation Block 

Referral Blocks 
Agreement Block 
Billing and Payment 

Note: From the Billing and Payment Agreement block in the Family File, you can change a family’s billing 
type, set up payment agreements, and manage guarantor notes. Tese functions are discussed in Chapter 7: 
Ledger. 

The Family Member List 
Te Family Member List displays all members of the family. Double-click a family member to quickly access 
that family member’s information in the Family File. 
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The Family File Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Family File are explained in the following table. 

Click the Select Patient button to select a patient whose record you want to view in the Family File. 

Click the Add New Family Member button to create a patient record in the family currently being 
viewed in the Family File. 
If the patient currently being viewed in the Family File has referred any patients to your practice, 
click the Referral Analysis button to monitor referrals or enter gratuities. 
Click the Patient Notes Report button to print patient notes and other types of notes in Dentrix 
Enterprise for the patient currently being viewed in the Family File. 
Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed 
in the Family File. 
Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient 
currently being viewed in the Family File. 
Click the Patient Referrals button to enter or manage referrals to and from your practice for the 
patient currently being viewed in the Family File. 

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Family File toolbar” 
topic in the Dentrix Enterprise Help. 

Selecting a Patient 
To view or edit a patient’s information in the Family File (or any other patient-specifc module), you must 
select the patient. By default, you search for patients by lastname; however, you can search for patients using 
other information, such as frst name, a home phone number, chart number, or Social Security number. 

Note: When you frst install Dentrix Enterprise, no patients are in the database. Patient information must be 
entered manually or through an electronic data conversion. 

To select a patient 

1. From the File menu, click Patient. 
1 

Te Select Patient dialog box appears. 

2. Type all or the frst few letters of the patient’s last name 
in the Enter Name feld to view a list of patients that 
match the search criteria. If the clinic setting to allow 
instant patient searches is not enabled, or if you have 
entered only one or two letters, click Search to view 
the patients that match your search criteria. 2 
Tips: To include archived patients in your search, 
select Include Archived Patients. Also, you can 
use the wildcard character (%) when performing 
searches. 

3. In the list, double-click the patient. 

3 
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Adding Families and Patients 
Tis section covers the following topics about how to add patient records into Dentrix Enterprise: 
• Viewing Patient Records 
• Adding a New Patient with an Appointment 

Viewing Patient Records 
Before you can work with a patient in Dentrix, such as charting a procedure and submitting a claim, a patient 
record in the database is needed. For billing and communication, patient records are grouped by “family,” 
even for a single patient who lives alone. A family in Dentrix Enterprise must hve at least one person, the 
head of household (guarantor), even if that person is not a patient. When you register a patient in RPMS, the 
patient and corresponding demographics are pushed to Dentrix Enterprise. If you want to add a patient in 
Dentrix Enterprise, contact Dentrix Technical Support. 

Important: Te current functionality of an HL7 interface is to transfer data from a “host” system (RPMS) 
to a “secondary” system (Dentrix Enterprise). Tis means that any changes to some patient demographic 
felds you make in Dentrix Enterprise may be overridden the next time the HL7 interface is processed and an 
update message comes across. 

Since all patients in Dentrix Enterprise come from RPMS, the only time you may need to add a family 
member to a family is for insurance purposes. 

To add a family member 

1. With the appropriate family account being viewed in the Family File, from 
the File menu, click Add New Family Member. 

1 
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Patient Information ~ 

_eersonal Qemograph1cs Qffl ce Info I 

Last First Patient Status Sex Provl Prov2 

I Cros by I I Pat ient 3 I Male 3 I DE.SMITH ~ I ~ 
Midd le Preferred Marit al Language Clin ic In it ial Provider 

I I I unknow n ..:J I Unspe cif ied ..:J I AF ~ I ~ 
Suff ix Sa lutat ion Race Other Race Fee Schedu le 

I I I Unspecif ied 3 I Unsp ecif ied 3 I < Prov Default> ~ 
Tit le Pat Class E.thn icity Other Ethnicity Chart # : 

I r Tit le on Stmt: r-- I Unspecif ied 3 I Unspe cif ied 3 I <AUTO> ~ 
Birth date Age Death Date: Poverty Level Religion Con sent Date 

I i I I Uns pecif ied 3 I Unsp ecif ied 3 i 1112112017 

SS# Other ID Veteran W orker First Visit Last Visit 

I I I Unspecif ied 3 I Unsp ecif ied 3 i 1112112017 I 
F d L U L 1u: v riv~r 1 .... ,, .... .,.,,. User Def. Cat. Homeless Last Missed Appt # Miss ed 

I I ! unspecif ied 3 I Unspe cif ied 3 I I o 

I lE3 I 
Gender Identity Housing Status I 

,!>,dd ress I Unspecif ied ...:] I Unspe cif ied 3 Patient ,!>,lias 
ib4 CSR St 

. 

Sexu al Orientati on Last Name First Name 

American Fork, UT, 84003 I Unspecif ied ...:J 0 I I 
Midd le Suff ix 

Effect ive Date: I I E.nd Date: 

.Contact Info Communication Mother's Maiden 
Home Mobil e Contact Preferen ce Last Name First Name 

I I I Unspecif ied 3 I I 
W ork Ext, Other r No ph one call s 

Midd le Suffix 

I I I ' I r No correspondence 
FAX Time To Call 

I r---- r Disclosure re strictio n 

Home Emai l 

I r Decl ined 

W ork Emai l 

I 0 
I 

I j eferred I COPJ'. Pat ient I ~ ~~ 
-

Te Patient Information dialog box appears. 

2 

3 

2. Te last name, primary provider, and address of the head of household are already entered for this 
patient. However, you can change any of that information as needed and enter the rest of the patient’s 
information. 

3. Click OK. 



68    Chapter 2:  Family File 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

Appointment Book <The Dental Group> <MESA> 

File View Status 

+ 
+ 

f 
+ 
+ 
+ 
~ 

Appointment Information - (Catrell, Jim)< New Patient> 

.... .... I Continuing 
P1ov: 1AM CCLU RE ..:..::J Care 

"p!>,llached 
ENCn 11052312 ..2.J 17 Use Reason To Auto Update CC 

Reason----------------------~ 

lnitial I Pc Proph_ylaxis-adult 

~ 
Misc. I 

D fsc: ProphyAd 

Len~lh: J60 min 2j 
Amo~nl: I 1 65. 00 

RVU: p.oo 

.$_talus: I <none> ..:.J Op:jCENT-OP01 2j 
Schedule: ~I F-IX_E_D ___ ..:.J~ Qale: 111 / 27 /2017 2j 

T~pe:I General ..:.J lime: 11:30pm 2j 

:10 
:20 
:30 
:40 
:50 
9:0 am 
:10 
:20 
:30 

I :40 

105ooam D 
:10 
:20 
:30 
:40 

Change Pat 

New Pal Inf I 1 
QI her Appl( s I 

Ins J;;laim Info 

Schd. Ne~I 

Yi art/Will Call 

Eind 

Pin]l_oard 

!:!istor_y .------
Stall: 22,] T:-:Request: ,--.....-----~ 

OK 
Orig. Sched. Operator: IDSMITH Dale Sched .. 

[iotes-----------------------

r Main Concern? 
r If Pain, How Long? 
r Insurance Name? 

Insert Dateline 

r Policy Holder Name? r Last Denial Exam? 

r Subs. SSU? DOB? r Patient's DDB _Age? 
r Employer Name? Grpl r Referred By? 

Cancel 

r Chari Pulled 

r LaleAppl 

Adding a New Patient with an Appointment 
When you schedule an appointment for a new patient, a patient record does not exist for that patient. It’s not 
until the patient arrives for his or her appointment that you want to create a record for him or her in your 
patient database, but you don’t want to have to re-enter any of the patient information you entered when you 
scheduled the appointment. Tat’s why Dentrix Enterprise provides a way for you to quickly create a patient 
record based on information recorded for a new-patient appointment. 

To add a new patient with an appointment 

1. Once the patient has been 
registered in RPMS and 
pushed across to Dentrix 
Enterprise, double-click the 
new patient’s appointment 
in the Appointment Book. 
(A new-patient appointment 
has an “NP” preceding the 
patient’s name.) 

Important: All 
demographics for the 
patient come from RPMS. 
Do not add a patient or 
change patient information 
in Dentrix Enterprise. 

1 

2. Click Change Pat, and then select the patient. 

3. Click OK. 

Te Appointment Book now shows the 
appointment as a regular appointment 
(the “NP” is gone), and you can now 
post treatment for this patient. 

2 

3 
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Select Employer 

Enter Emplo_yer Name: 

IHSPS 

Name Address 

a, DentrD: Family File - (Crosby, Brent) [AF] [UTC --07:00 (MST]) [DESMITH) [C 

file fdit !::felp 

Employer Information 

Name: Crosby, Brenl 
Address: 1234 Oak St 

American Fork, UT 84003 

Phone: H (801 )555-6177, W {801 )555-3563 

~elect Emplo_ye, 

OR 

Enter New Emplo_yer Information 

Employer !:!ame:IEI~ 

Conser 
First Vii 
last Vi i 

Missed Ap1 

Cont 
Care 

Palien 

pende Balance 
49.00 532700 
A 

Street 8111 Type: 13 Lasl Payment 20.00 0 /07/2015 

Slalus Name 

ST Cit Phone ti 

E nte, New E mploye, Information 

Emplo_yer tlame: l~lectric 

Employer ]:hone: lra01 )555-6789 

.Clear OK Cancel 

Working with Employers 
Tis section covers the following topics about how to manage patients’ employers: 

• Assigning Employers 

• Changing an Employer 

Assigning Employers 
You can attach an employer to an insurance plan to make it easier to fnd the correct insurance plan (in 
a long list of plans) to assign to a patient. You can generate a report that lists employers and employees if 
you have a need to see this information in one place. Employers attached to patients can appear on several 
reports. Having employer information on hand can also be benefcial in case you need to contact the patient’s 
employer. 

Additionally, to make the process of assigning an employer faster, Dentrix Enterprise compiles a database of 
employers that you can choose from when assigning an employer to any patient, so you only have to enter 
information for each employer once. Also, you can add, edit, and delete any of the employers in your database 
from the Ofce Manager. 

To assign an employer to a patient 

1. In the Family File, with a patient selected, double-click the 
Employer block. 

Te Employer Information dialog box appears. 

2. Type the frst few characters of the employer’s name in the 
Employer Name feld, and then click Select 
Employer. 

Te Select Employer dialog box appears so that you 
can verify that the employer does not already exist in 
Dentrix Enterprise. 

3. Do one of the following: 

Information dialog box, and then type 
the employer’s name, address, and phone 
number. 

4. Click OK. 

For information about adding an employer from 
the Ofce Manager, see the “Adding and editing 
employers” topic in the Dentrix Enterprise Help. 

OR 

3 

4 

3 

• If the employer 
already exists, 
select it, and 
then click OK. 

• If the patient’s 
employer does 
not already exist, 
click Cancel 
to return to 
the Employer 
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3 Dentrix Family File· (Crosby, Brent) [AF] [UTC -07:00 !MST)] [DESMITH] [CR0004C] 

file £dit !:f!:lp 

Name: Crosby, Brent 
Address: 1234 Oak St 

American Fork, UT 84003 

Phone: H {801 )555-6177, W [801 ]555-3563 

:,:1:;ar r. ~~~~o 
Insurance: Dental Prima 
Company: Delta PMI 

Group PJa, 

Fe!~i~e Employer Information 
Coverag 

Char 
Consent: 11/26/2002 Cir 

First Visit: 11/26/2002 S 
last Visit: 11/13/2017 Birthc 

Missed Appt: 11/08/2017, 3 Prov, 
Fee S ci 

E-Mail: documentation@henrysd 

Cont. 09/15/17 Per i 
Care 08/02/18 PR OPf 

Palienl Noles 

~ 

~ elect Employer I 
OR 

Enter New Employer Information 

Employer H ame: I~ leclric 

Street 
/l,ddress: IS LC O II ice 

City ST Zip 
l~S-LC _____ fur ~84-0-03----

E mployer Ehone: I (801 )555-6789 

.Clear Cancel 

Changing an Employer 
When a patient changes employers, or a patient’s current employer changes its name, address, and/or phone 
number, you can change or clear the employer that is attached to a patient’s record as needed. Any changes 
you make to an employer’s information afects other patients who have that same employer. 

To change the employer assigned to a patient 

1. In the Family File, with a patient selected, double-
click the Employer block. 

Te Employer Information dialog box appears. 

2. Do one of the following: 

• To remove the patient’s employer from his or 
her record, click Clear. 

• If the patient’s current employer has changed 
its name, address, or phone number, make the 
necessary changes. 

• To assign a diferent employer to the patient, click 
Clear, and then select the correct employer as 
explained in “Assigning Employers” in this chapter. 

3. Click OK. 

If you have changed the information in any feld (not 
OR 

cleared the employer and not selected or entered a 
new employer), a message appears and states that 
the changes to this employer will afect the employer 
information for all patients with this employer. To 
apply the changes to the employer, click OK. 

2 

2 
3 

Working with Insurance 
You can add insurance coverage to a head of household or patient in the Family File. Tis section covers the 
following topics about how to add and remove dental insurance for a patient or head of household: 

• Assigning Dental Insurance to a Subscriber 

• Assigning Dental Insurance to a Non-subscriber 

• Changing Dental Insurance Carrier Information 

• Assigning Coverage Tables 

• Clearing Dental Insurance Coverage 
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Insurance Information - (Crosby, Brent) 

Denta l Insurance I Med ica l Insurance I 

Insurance Plans 

1. . 
2, De lla Dental PPO 
3. Hea lthnet 
4. None 

Select Dental Insurance Plan 

Enter Carrier Name: 

ae 

Carrie, Name 
_, Grou Plan 

Aetna Life and Cas. .. Aetna 

r Employer 

Insurance: jDenlal Pumary ..:J 
Compa ny: DeDI• P 

limup Pla n: Ca 
limup U: 12 

Fee Sche d: 
Cove,a ge: 10 sed: 0.00 

Ded. S/P/0: 50/0 Met: 0/0/0 

0-->30 31 -->60 61-->90 91--> 
985.00 350.00 1280.00 3161.00 

usoende Ba lanc 
-449.00 5327.0 

Payment Ami: NA Ami Pad Due: NA 
Bill Type: 13 Last Payment: 20.00 04/07/2015 

Status Na me 
HofH Guar Ins C1osb Brent 

C1osby.Shirley 
C1osby.Crystal 

Ins C1osby, Tom 

Pos ition 
Married 
Married 
Child 
Single 

Plan Information n 
Sybscriber. -I C-,-o,-b-y-, B- ,-, -nt------~ 

C~rrier. I Delta PM! 

Subscriber !d # : i 111111111 

Signature on f il e------~ , ------

Group Plan 

r Group Number 

Grau tt 

321863 

Address 

IN, Fo,t Wayne 

c­
c 

New Insurance Plan•f l------------------- OK Cancel 

Assigning Dental Insurance to a Subscriber 
To ensure that you can submit claims for patients covered by insurance plans to the correct insurance carriers, 
and to ensure that those claims have the correct information on them, you need to properly assign insurance 
to each patient’s record. Before assigning insurance to dependents, make sure that the insurance plan has 
been assigned to the subscriber and that the subscriber is part of the same family as the patient to whom you 
are assigning the insurance plan. If the dental insurance plan that you want to assign to a subscriber doesn’t 
already exist, you can create a new dental insurance plan, and assign it to the subscriber. 

Notes: 

• By default, when you add a family member to a family with a subscriber that already has insurance plans 
attached to his or her record, Dentrix Enterprise automatically assigns the subscriber’s insurance plans to 
that family member, adding the family member as a dependent to those plans. But, you can change the 
family member’s insurance as needed. 

• Even if an insurance subscriber is not one of your patients, you should still create a Family File record for 
them, setting their status to “Non-patient” and assigning insurance to them as a subscriber, so you can 
add insurance to his or her dependents who are your patients. 

To assign dental insurance to a subscriber 

1. In the Family File, with a patient selected, double-click the 
Insurance Information block. 

Te Insurance Information dialog box appears. 

2. From the Coverage Order list, select the None option that 
corresponds to the type of plan that you want to add to the 
subscriber: 1 (primary), 2 (secondary), 3 (tertiary), or 4 
(quaternary). 

3. If the current patient is not already 
selected as the Subscriber, click the 
search button , and then click 
Current Patient. 

4. Click the Carrier search button 
to verify that the insurance plan you 
want to add does not already exist. 
In the Select Dental Insurance 
Plan dialog box, type 
the frst few characters 
of the carrier’s name 
(you can also search by 
employer, group plan, 
or group number), and 
then click the search 
button  to view a 

2 

5

5 
OR 

list of all the carriers 
that match your search 
criteria. 

4 

3 

Important: It is very important to search for existing insurance plans before adding a new insurance plan 
to prevent adding duplicate insurance plans to your database. 
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Insurance Information - (Crosby, Brent) 

Dental Insurance ) Medica l Insura nce ) 

Insu rance Plans 
~overage Orde r 

1. I 

2, Delta Dent al PPO 
3. Hea lt hnet 
4 . Non e 

Clear Co~e rag e 

View Insurance Plan .t!istory 

Plan Information 
Sybscriber: I Crosby, Brent Insurance Data 

I Delt a PM! C.Qverage Table 

Payment Table 

Ded/ Benef it s 
-I Ass ignment of Benef its 

Plan Exp iration Date: 

r Not Eligib le 

< Spouse La st El igibility Check: I ~l/01/2017 

r child I ..:.] 
r Olhe , ~I -----..:.1~ 

Eli gibility Start: 

Eli gibility End: 

OK 

I 01i0112010 

j 1213112018 

Can cel 

5. Do one of the following: 

• If the carrier already exists, select it, and then click OK to return to the Insurance Information 
dialog box. 

• If the carrier does not already exist, click New Insurance Plan to add the insurance plan and return 
to the Insurance Information dialog box. For an explanation about setting up the options for a new 
insurance plan, see “Changing Dental Insurance Carrier Information” in this chapter. 

6 

7 

6. Set up the following options: 

• Subscriber Id # – Enter the subscriber’s ID number. 

• Signature on File – If you want the words “Signature on File” to print on insurance claims for the 
subscriber to authorize the release of information, select Release of Information. If you want to 
authorize payments directly to the provider instead of the subscriber, select Assignment of Benefts. 

Important: If your ofce accepts assignment of benefts from insurance carriers, you must select the 
Assignment of Benefts check box; if you do not, insurance checks will be mailed to the subscriber, 
not the ofce. 

• Relation to Subscriber – Make sure Self is selected to indicate that the current patient is the 
subscriber. 

7. Click OK. 
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Insurance Information - (Crosby, Brent) 

Dental Insurance I Medical Insuran ce I 

Insurance Plans 

5;;;overage Order 

1. . 
2. Delta Dental PPO 
3. Healthnet 
4. None 

Clear Co~erage 

View Insurance Plan tlistory 

lnsu,ance: jDental Prtm&y ~ Pa 

Company: DeltDP 
61oup Plan: Ca 7 

61oup U: 123 
Fee Sched: 

Cove,age: 1000 sed: 0.00 
Ded. S/P/0: 50/0/5 Met: 0/0/0 

0-->30 31-->60 61 -->90 91--> 
985.00 350.00 1280.00 3161.00 

uspende Balanc 
-449.00 5327.0 

Payment Ami: NA Ami Past Due: NA 
Bill Type: 13 lasl Payment 20.00 04/07/2015 

Status Name 
HofH Guar Ins C1osb Brent 

C1osby.Shirley 
C1osby,Crystal 

Ins C,osby. Tom 

Position 
Married 
Married 
Child 
Single 

Plan Information n 
Sybscriber: ~I c-,-o-sb_y_, B- ,-e-nt-------~ 

C! rrier: I Delta PM! 

Subscriber jd # : i 111111111 

Signature on f ile------------~ 

P' Release of Information P' Ass ignment of Benefits 

last Plan Eligibility Check: 

c_ 

Plan Effective Date: I 01/01/2010 Plan Expiration Date: I 
Patient Information 

Relation to Subscriber: 

C, Self 

r Spouse 

r child I 3 

r Othe, .-1-----3--r 

r Not Eligible 

last El igibility Check: ~ 
Eligibility Start: rc 
Eligibility End: fi 

OK 

Assigning Dental Insurance to a Non-
subscriber 
To ensure that you can submit claims for patients covered by insurance plans to the correct insurance carriers, 
and to ensure that those claims have the correct information on them, you need to properly assign insurance 
to each patient’s record. In Dentrix Enterprise, you can assign insurance to a patient as a non-subscriber 
(dependent). 

Notes: 

• By default, when you add a family member to a family with a subscriber that already has insurance plans 
attached to his or her record, Dentrix Enterprise automatically assigns the subscriber’s insurance plans to 
that family member, adding the family member as a dependent to those plans. But, you can change the 
family member’s insurance as needed. 

• Before assigning insurance to dependents, make sure that the insurance plan has been assigned to the 
subscriber and that the subscriber is part of the same family as the patient to whom you are assigning the 
insurance plan. 

• Even if an insurance subscriber is not one of your patients, you should still create a Family File record for 
them, setting their status to “Non-patient” and assigning insurance to them as a subscriber, so you can 
add insurance to his or her dependents who are your patients. 

To assign dental insurance to a non-subscriber 

1. In the Family File, with a patient selected, double-click the 
Insurance Information block. 

Te Insurance Information dialog box appears. 

2. From the Coverage Order list, select the None option that 
corresponds to the type of plan that you want to add to the 
patient: 1 (primary), 2 (secondary), 3 (tertiary), or 4 (quaternary). 

3. If the correct subscriber’s name 
is not in the Subscriber feld, 
click the search button to 
select the correct subscriber 

3 

(with the correct plan). 

Note: Dentrix Enterprise 
automatically inserts the rest 
of the Plan Information 
associated with the selected 
subscriber. If you were to 
change any of these options, 
the change would afect all 
other dependents covered 
under this subscriber’s plan: 
• Carrier 
• Coverage Table 
• Subscriber Id # 5 

4 

2 

• Signature on File 

4. Make sure the patient’s Relation to Subscriber is correct: Spouse, Child, or Other. 

5. Click OK. 
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Insurance Information - (Crosby, Brent) 

Dental Insurance I Medica l Insu rance I 

Insurance Plans 

~ove rage Order 
1. Delta PM! 
2. De lta Dent al PPO 
3. Hea lt hn et 
4. None 0 

Clear Co~e rage 

View Insu rance Plan !:ii story 

Insurance: jDental Pnmary ...:J 
Company: DeltaoM 

Group Plan: Ca 721 
Group U: 1234 

Fee Sched: 
Cove,age: 10000. ed: 0.00 

Ded. S/P/0: 50/0/50 Met: 0/0/0 

0-->30 31-->60 61-->90 91--> 
985.00 350.00 1280.00 3161.00 

Pa 

usoende Balanc 
-449.00 5327.0, 

Payment Ami: NA Ami Past Due: NA 
Bill Type: 13 lasl Payment 20.00 04/07/2015 

Slalus Name 
HofH Guar Ins C1osb Brent 

Plan Information n 
Sybscriber: ,-I C_r_o_s_by-,-B-re_n_t _______ ~ Insurance Data 

C~rrier: I Delt a PM! :::I CQverage Ta bl e 

Subscribe r Jd #: I 111111111 

Signatu re on f il e-------------~ 

P' Release of Info rmation P' Assi gnment of Benefits 

Last Plan Eli gibility Check: 

Plan Effective Date: I 01/01/2010 

Patient Information 
Relation to Subscriber: 
r- Self 

Plan Expiration Dat e: 

r Not Eli gible 

Payment Tab le 

Ded/Benefits 

r Spou se Last Eli gibility Check: I Pl/01/2017 

r Ch il d I ..:] 
r other r-1-----3--r 

Eli gibil ity Start: 

Eli gibility End: 

OK 

I 0110112010 

I 1213112018 

Cancel 

~ 

Posilion 
Married 
Married 
Child 
Single 

Changing Dental Insurance Carrier 
Information 
You can change information for a dental insurance carrier at any time. You can edit this information from the 
Family File or Ofce Manager. 

To change insurance carrier information 

1. In the Family File, with a patient selected, double-click the 
Insurance Information block. 

Te Insurance Information dialog box appears. 

2. From the Coverage Order list, select the plan with the carrier that 
you want to edit. 

3. Click Insurance Data. 

3 

2 

6 

Te Dental Insurance Plan Information dialog box appears. 
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Dental Insurance Plan Information 

Carrier Name: !Aetna Dental .:.:J 
Group Plan: I HS PS Aetna .:.:J 

Employer: I HS PS .:.:J 
Street Address:~11-2-34- M- ap-le_R_d_. ______ _ 

Cit_y, ST Zip: !American Fork 

Phone: lrso1 )555-1111 

Contact 

Group tt:1123456 Local: i----

Last l)pdate: I 01 10112014 .!, enelit Renewal: jji\N 
Alt Co~e: IADA .:.:J Other Code: j 

Claim E ormai:I DX2012 ..:J Cjaim S elup I 
Fee .$.chedule: l<NONE > .:.:J 

RVU S cbedule: I <NONE > .:.:J Proyider ID Setup I 
Pa~or ID: .-------- .:.:J 

Plan External ID: 

N ationaj Plan ID: 

S 2urce of P a_yment: I Commercial Insur a nee Co. 

MU Payor SOP: 

..:J 
.:.:I 

Insurance Claim Options---~---_-_- _- _- _- _- _ -_-~---~ 

Diagnostic Code S _ystem: I Unspecified ...:J 
l'7 Replace initial character of procedure code with: [o" 
r Do Not include Dental Diagnostic Codes 

r Do Not Include Group Plan Name 

r Do Not Bill to Dental Insurance 

r Do Not Bill to Dental Insur a nee if 0% Cover age 

Advanced I 
Financial Class T_ypes------------~ 
r. No Financial Class T _ypes 

r Use Financial Class T _ypes 

~ 
Auto Adjustment------------~ 

r. No Adjustment 

r Write Off Estimated Insurance Portion 

I 3: -Credit Adjustment 

r Post when Claim Created 
r Receive Claim 

r Send to Batch 

r Appl.Y Insur a nee Portion to Maximums 

r Apply deductibles based on expected 
Patient Portion 

r. Post when Procedure Completed 

r Use Insurance Fee Schedule to Calculate: 
[ adjustment amount = provider /patient fee 
schedule amount - insurance fee schedule amount) 

I 3: -Credit Adjustment ..:J .:.:J 
r. Post when Claim is paid 
r Post when Procedure completed 

r Create/Fl eceive Claim 

r Send lo Saleh 
r Appl_y deductibles based on expected 

Patient Portion 

Rate Code Options:-----------~ 

r Send Rate Code with Claim: 

Send R ale Code With: 
r. The Total of All Procedures 

r Practice's Rate 

r NoAmounl 
$ looo 

Send Procedure Codes With: 

I With A Zero (0. 00) Dollar Amount 

r Post Rate Code to Ledger 

.:.:I 

Cancel 

4. Change any of the following options as needed: 

• Carrier Name – Type the 
insurance carrier’s name. 

• Group Plan – Type the 
group plan name. If you 
do not have a group plan 
name, type the employer 
name as the group plan 
name; this will assist 
you later on when you 
are assigning previously 
entered insurances to 
patients. 

4 

• Employer – Click the 
search button to 
select the employer that 
administers the group 
plan. 

• Contact Information – 
Type the address where 
insurance claims are to 
be mailed for this carrier. 
Also, type the contact 
phone number and 
extension (if applicable), 
and the contact person. 

• Group # – Type the 
group number for this 
plan. 

5 

• Beneft Renewal – Type the month that the yearly insurance benefts renew for the insured patients. 

• Claim Format – Te claim format defaults to the frst claim format listed in Practice Defnitions, but 
you can select a diferent one if applicable. 

• Claim Setup – If the selected Claim Format is DX2012, this button is available so that you can 
customize the options for claims for this plan. 

• Fee Schedule – (Optional) Click the search button to select a fee schedule to attach to this 
insurance carrier. 

Note: If you attach a fee schedule to an insurance plan, Dentrix Enterprise uses that fee schedule 
instead of the fee schedule attached to the patient’s primary provider. A fee schedule assigned to a 
patient overrides any other fee schedule attached to the patient’s insurance plan or provider. 

• RVU Schedule – Click the search button  to select an RVU fee schedule to attach to this 
insurance carrier. 

• Payor ID – Type the payor ID that is to be used with electronic claims, or click the search button 
to fnd and select a payor ID. 
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• Auto Adjustment – Choose from the following automatic adjustment options: 

• No Adjustment – If you do not want an automatic adjustment posted for this insurance carrier. 

• Write Of Estimated Insurance Portion – To automatically make an adjustment for the 
estimated insurance portion in the Ledger. 

Select the credit adjustment type you want to use for the adjustment. 

• If you want to post an adjustment after a claim is created, click Post when Claim Created. 
Tis option should be used if claims will always be created for the insurance. Select Receive 
Claim to change the claim status to “Received” with a zero payment after the adjustment 
is made. If Receive Claim is selected, you can set up further actions you want to occur 
automatically after a claim is received – Send to Batch, Applying Ins. Portions to 
Maximums, and Apply deductibles based on expected Patient Portion. 

• If you want to post an adjustment when a procedure is completed, click Post when 
Procedure Completed. Tis option should be used if no claims will be created for the 
insurance. With this option selected, any changes made to the coverage table after the 
procedure has been set complete will not be refected in the adjustment. 

• Use Insurance Fee to Calculate – To have the adjustment calculated using the following 
formula: Provider or patient fee schedule amount - Insurance fee schedule amount = 
Adjustment amount. 

Te following will happen with this option selected: 

• If the patient has been assigned a fee schedule in the Family File, an adjustment will be 
posted that equals the diference between the patient fee schedule amount and the insurance 
fee schedule amount. 

• If the patient does not have a fee schedule assigned to him or her, the patient’s primary 
provider’s assigned fee schedule will be used. An adjustment will be posted that equals the 
diference between the provider’s fee schedule and the insurance fee schedule amount. To use 
this option, a fee schedule must be selected for the insurance carrier. 

Select the credit adjustment type that you want to use for the adjustment: 

• If you want to post the adjustment using this calculation when the claim has been received, 
click Post when Claim is Paid. 

• If you want to post the adjustment using the formula previously mentioned when a 
procedure is set complete, Post when Procedure completed. Select Create/Receive Claim 
to have the following occur automatically: create a claim, post the adjustment, and then 
change the status of the claim to “Received” with a zero payment. If Create/Receive Claim 
is selected, you can set up further actions you want to occur automatically after a claim is 
received: Send to Batch and Apply deductibles based on expected Patient Portion. 



Chapter 2: Family File     77 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 

 
 

 

 

 

• Rate Code Options – Some insurance companies (usually state Medicaid) pay a practice a set dollar 
amount per visit no matter how many or how few procedures were performed on a patient during 
that visit. Te “rate code,” also known as an “encounter code” or “visit code,” is a procedure code that 
tells the insurance company how much that amount is. You can choose to include and under what 
conditions to include an encounter, rate, or visit code on a claim: 

a. Select Send Rate Code with Claim, and then click the search button to select the 
appropriate code. 

b. Under Send Rate Code With, select one of the following options: 

• Te Total of All Procedures – Te selected rate code will be used as the frst procedure on 
the claim (printed or electronic), and the amount of the rate code will be the sum of all the 
procedures on the claim. 

Te fee used for this calculation will be the default fee schedule (with the ID number “1”) for the 
billing provider for the claim. Tis is the same fee schedule that is used for an “F” claim format. 

• Practice’s Rate – Te selected rate code will be used as the frst procedure on the claim 
(printed or electronic), and the amount of the rate code will be the rate entered in the feld. 
By default, the feld has the insurance plan’s fee schedule, but you can change it to specify the 
rate code that you want to be used on the claim. 

• No Amount – Te selected rate code will be used as the frst procedure on the claim (printed 
or electronic), but the amount or charge on the claim for the rate code will be blank. 

c. From the Send Procedure Codes list, select one of the following options: 

• With A Zero (0.00) Dollar Amount – Te procedures will be listed after the rate code on 
the insurance claim (printed or electronic) with a zero dollar amount (0.00). 

• With Te Procedure’s Fee – Te procedures will be listed after the rate code on the 
insurance claim (printed or electronic) with each procedure’s fee as the amount charged. 

• No Amount – Te procedures will be listed after the rate code on the insurance claim 
(printed or electronic) with each procedure’s charged amount being blank. 

• Do Not Send Procedures – Only the rate code will be listed on the insurance claim (printed 
or electronic). 

d. If you want the rate code to be posted in the Ledger, select Post Rate Code to Ledger. Te rate 
code will not appear in the Patient Chart. Te fee shown in the Ledger will be the same fee that 
appears on the claim. 

Important: Te fee schedules for the procedure code(s) and rate code on the claim must not 
confict or double the account balance in the Ledger. 

Notes: 

• Since the rate code has to be medically crossed coded to be placed on a medical claim, Dentrix 
Enterprise will post the rate code and automatically edit the rate code to select the appropriate 
AMA CPT and ICD-9-CM diagnostic code (with the installation of Dentrix Enterprise, a 
“Rate Code” has been added to the AMA CPT list and ICD-9-CM diagnostic code list) as long 
as the rate procedure code is cross coded with the AMA CPT “Rate Code” and ICD-9-CM 
“Rate Code”. 

• Te AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code 
will not appear on the claim (printed or electronic). 

• If the AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code 
are deleted, the rate code option for the claim will not work properly, and you will have to 
cross code the rate code again. 
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Insurance Plan ... !II~ 
r. Change Plan for All 

(" Add As New Plan 

OK Cancel 

5. Click OK to save the insurance plan and return to the Insurance Information dialog box. 

6. Click OK. 

7. If the insurance plan is being used by more than one person (subscriber or non-subscriber in any family), 
the Insurance Plan Changed dialog box appears. Do one of the following: 

• If you want the changes to afect all other subscribers who have the 
same insurance plan, which will, in turn, afect the family members 
of the those subscribers, select Change Plan for All, and then click 
OK. 

• If you want the changes to afect only the current subscriber and 
the changed insurance plan to be added as a new insurance plan 
without changing the original plan, select Add as New Plan, and 
then click OK. 

7 
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Insurance Information - (Crosby, Brent) 

Denta l Insurance I Med ica l Insurance I 

Insurance Plans 

~overage Order 

1. . 
2. Delta Dental PPO 
3. Hea lthnet 
4. None 

Clear Co!'.erage 

View Insurance Plan t!istory 

Plan Information 

Sybscriber: I Crosby, Brent 

CArrier: Delta PMJ 

Subscriber !d # : I 111111111 

Signature on f il e------------~ 

P" Release of Information P" Ass ignment of Benef its 

last Plan Eli gibil ity Check: 

Plan Effective Date: I 01/1)1/2010 

Patient Information 
Relation to Subscriber.·. ---­

r, Self 

Plan Expiration Date: 

r Not Eli gible 

Insurance: jDenlal Pnm31y ...:J 
Company: Delta PMO 

liroup Plan: Ca 721 
li10up II: 123456 

Fee Sched: 
Coverage: 10000.00 it: 0.00 

Ded. S/P/ 0 : 50/0/50 Met: 0/0/0 

0--> 30 31 -->60 61 --> 90 91 --> ~uspended Balanc 
985.00 350.00 1280.00 3161.00 -449.00 5327.0, 

Payment Amt: NA Ami Past Due: NA 
Bill Type: 13 La st Payment: 20.00 04/07/2015 

Status 1 Name 
HolH Guar Ins C10sb Brent 

I
C,osby, Shirley 
C10sby, Crystal 

Ins C1osby, Tom 

Insurance Data 

C.Q.verage Tab le 

Payment Tab le 

Ded/ Benefits 

Married 

I 
M.arried 
Child 
Single 

r Spouse Last Eligibility Check: I Plilll/2017 

r chil d I ~ 
r Other r-1-----~--, 

Eligib ility Start: 

Eligib ility End: 

OK 

I 01ro112010 

j 1213112018 

Cancel 

Assigning Coverage Tables 
Most insurance companies provide the patient with a schedule of benefts, which declares the maximum 
annual benefts for the individual and entire family. Te schedule of benefts also states the deductible 
amounts, plan maximums, and the percentage of the usual and customary fee that the insurance company will 
pay. You can add this information to an insurance plan as a coverage table. A coverage table helps you create 
treatment plan estimates that accurately refect the benefts paid by an insurance carrier. 

Note: If you change any of the coverage information, the change afects all other dependents covered under 
the plan. 

To assign or edit an insurance plan’s coverage table 

1. In the Family File, with a patient selected, double-click the 
Insurance Information block. 

Te Insurance Information dialog box appears. 

2. From the Coverage Order list, select the plan whose coverage you 
want to edit. 

3. Click Coverage Table. 

2 

3 

6 

Te Insurance Coverage dialog box appears. 
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Insurance Coverage - (M etropolitan Life/Metropo litan) ~ 
Deductible 

Lifetime Annual Annual 1 Maximum B enelit I 

Individual Individual Familv Individual: ~ I Standard ro- ~ ~ [2ooo 8000 

Preventive ro- ro- ro- r O rlho Plan - Use as O rtho Lifetime Max 

Other ro- ro- 1° r Claim ~ »I eadline: 

Cover age Table .. • 
Beg End Cov Pre 

Proc Proc Category % Ded Co-Pay Est? 

100100 1D0999 loiagnostic fsofsi3 i-o:oo r 
II ····· I II A Add 
D1000 -D 1999 Preventive 80 s 0.00 N 

8 D2000 -D2999 Restorative 80 s 000 N Change 
D3000 -D3999 E ndodontics 80 s 0.00 N 
D4000 -D4999 Periodontics 80 s 0.00 N Delete 
D5000 -D5999 Proslho, remov. 80 s 0 00 N 
D6000 -D6999 Prostho. fixed 80 s 0 00 N T 

Clear Table I 
----- ----,-·, 

r Co-Pa}'ment Calculations for Ins Porlion: Select 
C. Total Fee x Cover age % Table: r (Total Fee - Co-Pay) x Cov % 12:l r (Total Fee X Cov %) . Co-Pay 

( 
.... 

Notes I l OK I Cancel I . 
-

2j 

4. Set up the following options: 

• Deductible – You can assign each 
range of procedure codes in your 
coverage table its own deductible type. 
Te following types of deductibles are 
available: 

• Standard (S) – Used for most 
insurance coverage tables. 

• Preventive (P) – Used if an 
insurance carrier’s coverage has a 
separate deductible for preventive/ 
diagnostic procedures. 

• Other (O) – Used if an insurance 
carrier’s coverage has a separate 
deductible for specifc procedures 
other than preventive/diagnostic. 

5 

4 

For each type of deductible, you can specify the following amounts: 

• Lifetime Individual – Used for insurance carriers that require subscribers to pay one deductible 
for the life of the policy for the patient. 

• Annual Individual – Used for insurance carriers that require patients to pay a deductible amount 
each beneft year. 

• Annual Family – Used for insurance carriers that require a maximum deductible amount for the 
entire family each beneft year. 

Tip: When Dentrix Enterprise calculates the patient’s portion of charges, the appropriate deductible 
amounts will be added to the patient’s payment due amount. Tis fgure will appear in the Ledger as 
the Est. Patient Portion. 

• Maximum Beneft – Type maximum amount of benefts that will be paid by the insurance carrier for 
the Individual patient and Family annually. 

• Coverage Table – A coverage table allows you to group several procedures into ranges and assign the 
percentage the insurance will pay. Dentrix Enterprise provides fve standard coverage tables that you 
can modify from the Ofce Manager to ft your specifc insurance plan needs. When you assign a new 
insurance plan to a subscriber, Dentrix Enterprise automatically assigns the frst standard coverage 
table to the plan. If you do not have or know the insurance company’s schedule of benefts, as you 
make insurance payments and estimates in the Ledger, Dentrix Enterprise will provide you the option 
to automatically update a payment table for the insurance plan, storing what the insurance company 
actually pays for a procedure. Insurance estimate calculations will refect the payment table amounts 
whenever possible, making your estimates very accurate. 

You can use one of the standard coverage tables as is or create a custom coverage table (for this plan 
only) based on one of the standard coverage tables. 

• To select a diferent coverage table, click the Select Table search button , select the table that 
is most like the coverage for the current insurance plan you are adding or editing, and then click 
OK to copy the selected table to this plan’s coverage table. You can modify the coverage table as 
needed. 
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Note: If you need to modify the plan’s coverage table, keep the following in mind: 

• You must use ADA Procedure Codes. 

• You may not overlap the beginning and ending procedure codes in any given range. 

• A procedure code can be in only one range at a time. 

• To modify the coverage table, do the following: 

a. Select a procedure code range (either to change it or to add a new range based on it), and 
then do the following:change any of the following options for the selected range: 

b. Change any of the following options for the selected range: 

• Beg Proc – Te beginning procedure code in the range. 

• End Proc – Te ending procedure code in the range. If you are assigning only one 
procedure to a range, type that procedure code as the Beg Proc and leave the End Proc 
feld blank. Te feld will automatically be flled in with the beginning procedure code. 

• Category – Te name you assign to represent the range of procedure codes. 

• Cov % – Te percentage the insurance plan will pay for all of the procedures in the 
range. 

• Ded – Te deductible type for the range of procedure codes. 

• Co-Pay – If you are setting up a capitation plan, type the patient’s co-pay amount. 

• Pre Est? – If the insurance company requires you to submit a pre-treatment estimate for 
a procedure in the range, select this option. 

c. Do one of the following: 

• To add the selected range to the coverage table, click Add. 

• To apply the changes to the selected range, click Change. 

d. Repeat steps a – c for any other ranges you want to add or modify. 

Note: To delete a selected procedure code range from the coverage table, click Delete. 

• Co-Payment Calculations for Ins Portion – If the plan requires that specifc co-pay amounts be 
paid by the patient for each procedure, select this check box, and then select the method that will be 
used to calculate the amount the insurance company will pay: 

• Total Fee x Coverage % 

• (Total Fee - Co-Pay) x Cov % 

• (Total Fee x Cov%) - Co-Pay 

Important: If the plan you are setting up is not a capitation type plan with specifc co-payment 
amounts for each procedure, do not select the Co-Payment Calculation for Ins Portion box. 

5. Click OK. When a message appears and states that the changes you have made will afect all patients 
assigned to this insurance carrier., click OK. 

You are returned to the Insurance Information dialog box to make other changes as needed. 

6. Click OK. 
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Insurance Information - (Crosby, Brent) 

Dental Insurance I Medical In surance I 

Insurance Plans 

£overage Order 
1. I 

2. Delta Dental PPO 
3. Healthnet 
4. None 

Clear Co!!era ge 

View Insurance Plan !::!istory 

Plan Info rmation 

Syb scribe r. 

C_2rrie r. 

I Crosby, Brent 

I Delta PM! 

Subscriber Jd # : I 111111111 

Signature on file------------~ 

P' Release of Information P' Ass ignment of Benefits 

La st Plan Eligib ility Check: 

Plan Effe ctive Date: I 01/01/2010 

Patient Info rmation 
Relation t o Subscriber.'---­

r, Self 

Plan Expi ration Date: 

r Not Eligible 

Insurance: jDental Pnmary ...:J 
Company: Delta PMO 

Group Plan: Ca 721 
Group U: 123456 

Fee Sched: 
Cove,age: 10000.00 d: 0.00 

Ded. S/ P/0 : 50/0/50 Met: 0/0/0 

0-->30 31-->60 61-->90 91--> 
985.00 350.00 1280.00 3161.00 

Payment Amt NA Ami Pasl Due: NA 
Bill Type: 13 lasl Payment: 20.00 04/07/201 5 

Slalus 
HofH Guar Ins C1osb Brent 

C1osby. Shirley 
C1osby, Crydal 

Ins Cmsby. Tom 

Insurance Data 

C.2vera ge Table 

Payment Table 

Ded/ Benefits 

Name Posilion 
Married 
Married 
Child 
Single 

r Sp ouse La st Elig ibil ity Check: I Pl /01/2017 

r child I ..:] Eligibility Start: 

r Other !'" -----3--r Eligibility End: 

OK 

I 01/0112010 

I 12/31/2018 

Cancel 

Pa 

Clearing Dental Insurance Coverage 
Circumstances may require that you remove a patient’s insurance coverage: 

• To move the patient from one family to another, you must frst clear the patient’s insurance information. 

• To switch the patient’s primary and secondary coverage, you must frst clear the primary and secondary 
insurance. 

• Te primary, secondary, tertiary, and/or quaternary insurance was assigned to the patient in error, so you 
must clear the applicable insurance information. 

To clear a patient’s insurance coverage 

1. In the Family File, with a patient selected, double-click the 
Insurance Information block. 

Te Insurance Information dialog box appears. 

2. From the Coverage Order list, select the plan whose coverage you 
want to clear. 

3. Click Clear Coverage. 

2 

3 

4 

Notes: 

• Repeat steps 2 – 3 to clear any of the patient’s other coverage as needed. 

• If you are switching the coverage, select the Subscriber and Carrier for the primary insurance and 
then for the secondary. 

4. Click OK. 
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8D Dentrix Family File - (Crosby, Brent) [AF] [UTC -07:00 !MST]] [DESMITH] [CR0004C] 

file fdit .!:::!elp 

Name: Crosby, Brent 
Address: 1234 Oak St 

American Fork, UT 84003 

Phone: H (801 )555-6177, W (801 )555-3563 

Status: Active, M, Marr ied. GuaJ", Ins. H-of-H 

Patient Continuing Care - (Abbott, James SJ 

Dale Tooe Aool? 
07/21/2012 PROPHY 04/ 22/2013+ 6M 

"lab-Aspen 
' Lab-Alpine 

K) 
xlab-H eritag 
' Lab-H iT ech 

C<I.LLAMALG 
DI.LL CROWN 
DI.LL RC 
FMS 
ORTHO 
PANOREX 
PERIO 
PERIO 
Pmt Promise 
PROPHY 

Set.. . Clear 

Set Continuing Care - (Abbott, James SJ 

Type: 

IBITEWINGS 

Description: 

!Annual Bitewings 

Status 

Consent: 11 /2£/2002 
First Visit: 11 /2£/2002 
last Visit: 11/13/2017 Birthd 

MissedAppt: 11/08/2017. 3 Provid 

Palienl 

Prior Treat 
01/20/ 2012 

Close 

Fee Sch 
ation@henrysch, 

15/17 Perio 
2/ 18 PROPH' 

~ 
Prov 
Prov2 & 

~ 

Date Set: Motivational Note: 

Due Dale: 

I 0312s12014 

Status: 

[None] 

Provider:------------. 

C. Prov1 r Prov2 

DefaultAppt. Time:----------

r Time? ~ Set Time. 
Cancel 

17 Ix 

Assigning Continuing Care 
Having continuing care (recare or recall) assigned to patients is key to achieving your goal of keeping patients 
coming back for routine, scheduled maintenance. As you schedule and reschedule a patient for a specifc 
type of continuing care (such as an exam, a cleaning, or X-rays) that continuing care type gets attached to 
the patient and updated automatically. However, you can assign a continuing care type to a patient’s record 
manually, such as to get the patient’s record ready before their appointment or to correct a situation where 
continuing care is not attached to the patient’s record after their appointment. 

To assign a continuing care type to a patient 

1. In the Family File, with a patient selected, double-
click the Continuing Care block. 

Te Patient Continuing Care dialog box appears. 

2. Select the continuing care type you want to set. 

Note: If the selected continuing care type is 
already set for the patient, the Date column 
for the continuing care type contains a date, 
and the Set button is labeled “Edit.” 

3. Click Set. 

Te Set Continuing Care dialog box appears. 
2 

4. Customize the following options as needed: 

• Due Date – To set the interval for the 
patient’s continuing care, click the search 
button . Change the Interval to 
refect the amount of time that elapses 
between the patient’s continuing care 
visits. Select +1 Day to extend the interval 
an extra day to prevent insurance billing 
problems for patients with strict interval 
requirements. 

3 

• Status – To assign a continuing care status to 
the patient, select the desired status. Statuses 
are relevant primarily when you generate 
continuing care lists. 

4 

• Provider – To assign the patient’s primary 
or secondary provider as the provider of 
appointments for this continuing care type, 
select Prov1 or Prov2. 

5 

• Default Appt. Time – To enter the amount of time this patient will need for appointments with this 
continuing care type attached, select Time?. Drag the slider to set the number of units, and then set up the 
time pattern for each unit (chair time , assistant’s time , or provider’s time ) to help you make use of 
all operatories when scheduling appointments and maximize your productivity. 

5. Click OK. 

For comprehensive details about all the options available when assigning continuing care types, see the 
“Assigning continuing care” topic in the Dentrix Enterprise Help. Also, for more information about setting 
up continuing care types and their default settings, see “Setting Up Continuing Care Types” in Chapter 1: 
Introduction and Initial Setup. 
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Patient Note• 

Patient Notes ~ 

- Fri - Oct 12. 2007 -
Karen is divorced from Harmon Davis who is listed in her file as 
a non-patient to provide insurance cover age for lheir children. 
He is also set up in his own F amil_y File. 

Working with Patient Notes 
You can enter internal notes about a patient in Dentrix Enterprise that will not be seen by the patient as 
patient notes. A patient note can contain a patient’s interests, hobbies, dislikes, and personal situations or 
events to remember. A patient note is appropriate for documenting fnancial or insurance information that 
you don’t want in an account note or insurance plan note or create apatient alert for. A patient note can 
include this and any other information you want to be available internally in your ofce, which may help you 
build a relationship with the patient or serve them better. 

Note: Patient notes apply to an individual patient, and you can view them only from the patient’s 
appointment information in the Appointment Book, from the patient’s Family File, or on the patient notes 
report. 

Tis section covers the following topics about how to use patient notes in the Family File: 

• Viewing and Hiding Patient Notes 

• Adding and Editing Patient Notes 

• Generating the Patient Notes Report 

Viewing and Hiding Patient Notes 
Each time you log on to Dentrix Enterprise, patient notes are hidden for all patients by default. When you 
frst open the Family File of a patient with a patient note, the patient note is hidden by default. Afterwards, 
for each patient that you select in the Family File, the notes are viewed or hidden depending on the state of 
the previously selected patient’s notes. 

Note: If no notes have been entered for the patient, the block displays “No Note,” and the View/Hide option 
is not available. 

To view and hide patient notes 

If the notes are being hidden, you can view the notes 
by clicking View. (When you click View, the button 
label changes to “Hide.”) 

If the notes contain confdential information, it is 
recommended that you hide the notes by clicking 
Hide after each time the notes are viewed. (When 
you click Hide, the button label changes to “View.”) 
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[are 00/02/1;:j PAOPHY 

Patient Notes ~ 

0 
Referred By 04/15/2015 

+Evans.Natalie (Dentist) 

Referred To 05/11/2015 
+ Oral Su,geryAbulafia, Lewis 

Patient Note ___________ ~ 

Insert Dateline I ~ 
Patient Noles Here Mon - Dec 22,2008 -

0 
I n Cancel ~~~ Clear 

Adding and Editing Patient Notes 
You can add notes to an individual patient’s record. Also, you can edit those notes at any time. 

To add or edit notes for a patient 

1. In the Family File, with a patient selected, double-click the 
Patient Notes block. 

Te Patient Note dialog box appears. 

2. Type the patient’s hobbies, interests, fnancial arrangements, or 
any other notes useful to your practice. A patient note is 
limited to 4,000 characters. 

1

2 

3 

Tip: If you want to delete the patient notes for this 
patient, click Clear. Te notes will not be deleted until 
you click OK, so if you click Clear accidentally, you can 
restore the notes to how they were before you opened the 
dialog box by clicking Cancel instead of OK. 

3. Click OK. 
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Patient Notes Report 

Report Date: 1 □3/27/2013 

Select Patient:--------~ 

From: l~bbott, James S 

To: !Abbott, James S 

r Guarantors Only 

2j 
2j 

Select Provider--------~ 

From: l<ALL> 2j To:l<ALL> 2j 
Select Billing Type: -------~ 

From:I <ALL> 2j To:I <ALL> 2j 

Note Types:-----~ 

r Patient Alert Notes 

1 □312mo11 - 1 ... o-11-21-12-0-11-

r Perio Exam Notes 

103/27/2013 - 103/27/2013 

r Appointment Notes 
10212512011 - l ... 01_12_1_12-01-1 

Send to batch Print 

r Patient Note 

r Medical Alerts 

r Continuing Care Notes 

r Insurance Claim Notes 

r Payment Plan Note, 

r Guarantor Note 

r Guarantor Statement Note 

Save as Default I 
Cancel 

Generating the Patient Notes Report 
You can generate a report of all notes entered for a patient from the Family File. You can also run this report 
from the Ofce Manager. 

To print the Patient Notes Report 

1. In the Family File, with a patient selected, from the File menu, click 
Print Patient Notes. 

1 

Te Patient Notes Report dialog box appears. 

2 

3 

2. Set up the following options: 

• Filters – You can include notes for the current patient or a range of patients and for only guarantors. 
If you run the report for a range of patients, you can further flter the report by patients’ providers 
and/or billing types. 

• Note Types – Select the types of notes you want to include on the report: 
• Patient Alert Notes – Notes entered in the Patient Alert system. You can also specify a date range 

to include notes that were entered within that time period. 
• Perio Exam Notes – Notes entered in the Perio Clinical Notes dialog box (which is accessed 

from the Diagnostics menu in the Perio Chart). You can also specify a date range to include 
notes that were entered within that time period. 

• Appointment Notes – Notes attached to appointments. You can also specify a date range to 
include notes that were entered within that time period. 

• Patient Notes – Notes entered in the Patient Notes block of the Family File. 
• Medical Alerts – Medical alerts for patients. 
• Continuing Care Notes – Motivational notes added from the Set (or Edit) Continuing Care 

dialog box. 
• Insurance Claim Notes – Notes entered for insurance claims. 
• Payment Plan Notes – Notes attached to a future due payment plan set up for the patient. 
• Guarantor Note – Guarantor note entered in the Ledger. 
• Guarantor Statement Note – Guarantor billing statement note entered in the Ledger. 

Tip: If you want the selected note types to be selected the next time you run the report, click Save As 
Default. 

3. Click either Send to batch or Print. 
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Working with Referrals 
To track the efectiveness of your referral sources, you need to frst add them to your Dentrix Enterprise 
database. Once you have added sources to the database, you can assign them to patients as they are referred 
to your ofce. From the Referred By block in the Family File, you can view and enter information about 
the individual or source that referred the current patient to your practice. Tere are Referred by Patient and 
Referred by Doctor/Other referral types. 

You can also add other dental providers, professionals, and specialists to whom you refer treatment or services 
as referrals. Ten, you can attach those outbound referrals to patients and treatment-planned procedures. 
Dentrix Enterprise can help you track the patients who have been referred to another doctor or specialist. 
From the Referred To block, you can see to whom you have referred a patient. 

Tis section covers the following topics about patient referrals and referrals out to specialists: 

• Entering Patient Referrals 

• Entering Doctor/Specialist Referrals 

• Sending Correspondence to Referrals 
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Referred By----------------------------~ 

Name Date 

r Evans Jeff 03/27/2013 
Crosby, Brent (Patient) 03/02/1993 

Select Referral Type 

Clear Referral I 

Select Patient 

Search By Appointments Advanced Search 

Patient Into ---------------~ Clinic 

@ This cl inic 

(0 Al l cl inics 

(E) My clinics 

@ Last Name (Last. First) ~ Medicaid # ~ Subscri ber ID 

~ First Name (First Last) ~ Chart # 

~ Preferred Name ~ SS # 

f nter Last Name (Last. First): 

crol 
IEJ toclude Archived Patients 

HoH I Last Name 

Crosby 

Crosby 

I First Name 

Brent 

Shirley 

~ Home Phone 

~ Birthday 

Show On Screen Keyboard 

Abbott, James Referred By 

Name: Dr. Evans,Jeff 

Address: 1450 N 500 W 
Provo, UT 84601 

Phone: 555-5622 
Total Referrals: 9 

Provider: !DESMITH 

CRS 
CRa 

Patient Referred-By Dale: 103/27/2013 

r Patient Summary Record Provided 

Edit OK Cancel 

Entering Patient Referrals 
To track the efectiveness of your referral sources, you need to frst add them to your Dentrix Enterprise 
database. Once you have added sources to the database, you can assign them to patients as they are referred to 
your ofce. You can enter a referral from a patient who referred another patient to your practice. 

To enter a patient referral 

1. In the Family File, with a patient selected, double-click the 
Referred By block. 

Te Patient Referrals 
dialog box appears. 

2. Next to the Referred 
By list box, click Add 
Referral. 

Te Select Referral 
Type dialog box appears. 

1 

2 
3 

5 

3. Select Patient, and then click 
OK. 

Te Select Patient dialog box 
appears. 

4. Select the person who referred 
the patient. 

Tip: If you cannot fnd the 
referring patient’s name, frst 
check the spelling; then, if you 
still cannot locate the patient’s 
name, he or she has not been 
entered in the Family File yet, 
or the referring party is not one of your patients and must be 
entered as a non-patient referral (Referred by Doctor/Other). 

4 

5. To change the date the patient was referred to your practice or to 
change the provider to associate with this referral, with the referring 
patient selected in the Referred By list box, click Edit. In the dialog 
box that appears, type the correct date in the Patient Referred-By 
Date feld, and then click OK. 

For more information on referral sources, clearing referrals, and referral 
analysis, see the “Working with referrals” topic and its subtopics in the 
Dentrix Enterprise Help. 
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_::.J 

,:j + Evans,Nate111e(Dent1stJ 

Referred To 
+ Oral Surgery Abulalia. Lewis 

.m der Palient Birthda 
"1 ale y., 11/11/1973 
imale Ye, 11/11/1975 D ~male Yes 11/11/2002 
\ll ale y., 11 /11/2002 

Pati ent Referrals -Crosby, Brent [CRO101] X 

Referred By---------------------------­

Name Date 

Abbott,James [Patient) 09/04/ 1997 

Edit 

Analysis 

Add Referral I 
Clear Referral I 

Referred To---------------------------~ 
Name 

riMMifflli-WirnffliiN 

Send Email P,int Label Quick Letters ) 

_::.J 

Enter Name for Search: 

Name 
Charles M. Clark, M. D. 
Clark, Robert 
Mark Tyler. D.D.S 

New 

Specially Q .::.1 
Surgery, Oral&: Maxi 
Endodonlisl 
Endodontics 

Edit 

~ 

I Not Specified ..:.l 
I 
ro-

" 

Cancel 

Entering Doctor/Specialist Referrals 
You can add other dental providers, professionals, and specialists to whom you refer treatment or services 
as referrals. Ten, you can attach those outbound referrals to patients and treatment-planned procedures. 
Dentrix Enterprise can help you track the patients who have been referred to another doctor or specialist. 

To enter a referral to a doctor/specialist 

1. In the Family File, with a patient selected, double-click the 
Referred To block. 

Te Patient Referrals dialog box appears. 

2. Next to the Referred To list 
box, click Add Referral. 

Te Select Referred To dialog 
box appears. 

3. Initially, all doctors/specialists 
are listed. To narrow the 
search, type the frst few 
characters of the doctor/ 
specialist’s name in the Enter 
Name for Search feld, and 
then click the search button 

to view the doctors/ 
specialists that begin with 
those letters. 

Tip: If the doctor/specialist 
is not listed, click New to 
add the doctor/specialist. 
In the Referred To Information dialog box, type the referral 
information, and then click OK. 

2 

4 

4. Select the doctor/specialist. 

5. Set up any of the following options: 

• Provider – Click the search button  to select the provider 
you want to associate with this referral. 

• Patient Referred-To Date – If necessary, change the date to 
refect the correct date that you referred the patient to a doctor 
or specialist. 

• Scheduled Date – Enter the date of the patient’s next 
scheduled appointment, relating to this referral, at your ofce. 

• Referral Status – Select the current status of this referral. 

• Completed Date – Enter the date that the referral was 
completed. Te value in the Days in Referred To box is updated automatically; it is the number of 
days since the Patient Referred-To Date up to the Completed Date (if one is entered). 

5 

6 

• Reason for Referral – Enter any notes regarding the purpose of this referral. 

6. Do one of the following: 

• Click OK to return to the Patient Referrals dialog box. Ignore the steps that follow. 

• Click Edit to edit the referral information. Proceed to the next step. 

3 

9 
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Title 
I Bruce 

Specialty 
I Periodontics 

Salutation 

ID Number Type 

r Non-Person 

ID Number 

liNone] .iJ 
Address------------------~ 

Street 
11234 Palma Rd 

ltt201 
City ST Zip 

"IA-ny- to_w_n _____ [us 111111 

E-mail 

DIRECT E-mailAddress 

Phone 

I 1soo1555-666o 
Ext 

i 
Fax 

Other 

Notes 

Patient Referrals -Abbott. James S(Jim) [ABB101] 

0o __ c_a_n_ce_l~ 

j Refened By 
+Evans, Natalie(Dentist] 

Refened To 05 
+ Oral SurgeryAbulafia, Le 

nder Patienl Birlhda 
ale Yes 11/11/ 1973 
male Yes 11/11/1975 
male Yes 11/11/2002 
ale Yes 11/11/2002 

Referred By---------------------------~ 

Name Date 

I I 

03/ 02/1993 

Referred To----...,....----------------------~ 

Name Date 

03/2712013 

Send Email Print Label Quick Letters I 

Edit 

Analysis 

Add Referral I 
Clear Referral 

Edit 

Analysrs 

Add Referral I 
Clear Referral 

Close 

7. In the Referral To Information dialog box, edit any of the following referral information as needed: 

• Name – Te doctor/specialist’s name, title (if 
applicable), specialty, and salutation (for letters you 
send to the doctor/specialist). 

7 

Tip: Do not put a doctor’s credentials in the Title 
feld, as that appears before the doctor’s name; 
instead, add credentials after the name in the Last/ 
Referral Name feld. 

• Address – Te address, email address, and contact 
numbers for the doctor/specialist. 

• Notes – Any notes or useful information regarding 
the doctor/specialist. 

8. Click OK to save the changes and return to the Referred 
To dialog box. 

9. Click OK to return to the Patient Referrals dialog box. 

8 

Sending Correspondence to Referrals 
You can quickly send correspondence to a referral. 

To send correspondence to a referral 

1. In the Family File, with a patient selected, double-click the 
Referred By or Referred To block. 

Te Patient Referrals dialog box appears. 

2. Select the referral you want 
to correspond with. 

3. Click any of the following 
buttons: 

• Send Email – To 
compose and send an 
email message to the 
referral. 

• Print Label – To print 
a single address label for 
the referral. 

2 

• Quick Letters – To 
quickly print a letter for 
the referral. In the Quick 
Letters dialog box, select 
the appropriate letter, 
and then click Print. 

3 
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• New Patient Medical Alert(s) 

Enco unter#: ...:J 
Selected Alerts: 

Problem 3ll/2019 Artificial Joints 

Add Y Remove 

Problem Description I Status I Severity 

ASTHMA Active 

Chronic migraine without... Active 

Echinococcus multilocula... Active 

Unknown 

Unknown 

Unknown 

3 Oentrix Family File - (Crosby, Brent) (AF] [U 

,Eite fdit !:::!elp 

Name: Crosby, Brent 
Add,eu: 1234 Oak St 

American Fork. UT 8401 

Phone: H (801)555-6177. 'W (80 

I Discovered .. 

01/07/2014 

01/24/2018 

01/24/2018 

c::, ]~ ~ 

Discovery Date: 3/ 7/2019 0• Enc Date: ~-----□-•~J [ Unconfirmed 

17 No Enc Date or Enc Date Unknown 

-• __ I ~--------------------------~ ...:::...i 

Severity: 

[Lu_n_kn_o_w_n ____ ~l ...:J 
Code-s.: 

SNOMED: [3723001 

:::::===:::: 
Medispa n: 

JCD-9: First DataBa nk: 

JCD-10: 

~I 
Encounter Number Required; 

Cancel 

Assigning Medical Alerts 
You can add alerts for problems, medications, allergies, and implantable devices to a patient’s account. You can 
customize the list of available problems, medications, and allergies in Practice Defnitions. For information 
about setting up medical alerts, see the “Customizing Medical Alerts” topic in the Dentrix Enterprise Help. 

To add a medical alert to a patient 

1. In the Family File, with a patient selected, double-click the Medical Alerts 
block, or click the button in that block. 

Te Medical Alerts dialog box appears. Any existing problems, medications, 
and/or allergies are listed. 

Note: You can also view a patient’s medical alerts from the Patient Chart, the 
Treatment Planner, and the Appointment Book. 

2. Click the New Medical Alert button , 
and then click one of the following 2 
options on the menu: 

• Problem 

• Medication 

• Allergy 

• Implantable Device 

Te selection dialog box that 
appears varies according to the 
type of medical alert selected. 

3. Add the problem, medication, 
or allergy, and then click OK. 
Or, for a device, 
search for the 
UDI, or click 
No UDI. 

Te New 
Patient 
Medical 
Alert(s) dialog 
box appears. 

4. Specify the date 
of discovery 
and other 
details as 
needed, and 
then click OK. 

For comprehensive 
information about 
all the available 
options, see the 

3 

“Assigning medical 
alerts” topic in the 
Dentrix Enterprise Help. 

4 
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t9, Dentrix Fami ly File - (Crosby, Brent) [AF) [UTC -07:00 (MST]) [DESMITH) [CR0004C ] 

!::::!elp 

Na me : Crosb.v, Brent 
Addre ss: 1234 0ak5t O Consent: 11/26/2002 

American Fork, UT 84003 First Visit: 11/26/2002 
Last Visit: 11/13/2017 

P hone : H (801)555-6177. W (801 )555-35 Misse d Appt: 11/08/2017. 3 

Cha t! II: CR0004C 
Clinic: AF 

S5 11: 123-45-6789 
Birthday: 11/1 1/1973, 44 
Provide r: DESMITH . MHAYES 

Fee Sched: <Prov Default> 
S ta tus: Active, M. Married. Guar, Ins. H-of-H E-Ma il: documentation@hem.vschein. com 

Patient Information 

Personal 
Last First 

I Cro sby I Brent 

Middle Preferred 

Suffix Salutat ion 

Demo ra hies 
Patient Status 

I Patient ..:J 
Pati ent 
Non-Pati ent 

Sex 

I Male 

Language 

I Eng li sh 

Other Race 

I Unspecif ied """ 

Iv 

Archiving Patients 
If a patient becomes deceased, or there is no possibility that they will be seen in your ofce again, you can 
archive the patient in Dentrix Enterprise to efectively “hide” them but preserve the clinical, fnancial, 
administrative, and other records. You cannot post new procedures or treatment plans, set treatment-planned 
procedures complete, or create new prescriptions for archived patients. 

Note: Archived patients appear in the following areas: 

• Te Family Member List and the Ledger with “<A>” preceding their names. 

• Te View menu in the Ledger with “(Archived)” preceding their names. 

• Te Appointment Information dialog box title bar with “<A>” preceding their names, 

• Te Ledger, Ofce Journal, and Document Center title bars with “<A>” preceding their names. 

Important: Although you can reactivate an archived patient, archiving a patient should be considered a 
permanent action, as this will signifcantly change that patient’s data in the database, and some data will not 
be able to be easily restored later. 

To archive a patient 

1. With a patient selected in the Family 
File, double-click the Patient 
Information block. 

Te Patient Information dialog 
box appears. 

1 

2. Under Demographics, from the 
Patient Status list, select Archived. 

3. Click OK. 

For information on changing a patient’s 
status, see “Viewing Patient Records” in 
this chapter. 

2 

Editing Family Relations 
In the Family File, you can change the head of household, delete a patient, delete a family, and combine or 
separate families. For detailed information on completing these tasks, refer to the “Changing the head of 
household,” “Deleting patients,” “Deleting families,” and “Combining and separating families” topics in the 
Dentrix Enterprise Help. 
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Name: Crosby, Brent 
Add,en: 1234 Oak St 

~--------------_,_----'----""""'":.mJ""'-.J.J.J.~03 
Merge Patients - (Abbott, Patricia) [CENTRAL] ~ 11, 

Merge Criteria: , Ir 

I f the patients have the same Last Name., First Name, Gender, Date of Birth, 
and Zip code, they will be merged. I f you would like to modify the merge 
criteria, d ick the •Advanced• button. 

Select Patients to Merge: 
Advanced 

Primary Patient Info (to keep)------,-~ ---==--, 

I Abbott, Patricia " » I 
Gender: Female DOB: 11/11/1963 SSN: ~ 
Chart: ABB102 PatExt!D: 
City: American Fork ST: UT Zip: 84003 

Home#: 555-111 1 Work#: 

E-Mail : 

Secondary Pa tient Info (to be deleted)---------("'"\~ = --,>-">~ I 

SSN: ~ Gender: DOB: 
Chart: PatExt!D: 
City: ST: Zip: 

Home#: Work#: 

E-Mail : 

WARNING : To see the items that will be merged from the Secondary Patient to 
the Primary Patient, dick the -,...,erge Info. button. Otherwise Click the -,...,erge• 
button to merge patients. 

Merge Info I 
Merge Close 

Merging Duplicate Patients 
Sometimes someone will add a patient record, and maybe even post some treatment in that record, without 
realizing that a record has already been created for that patient. You don’t want to have to re-enter data into 
the correct patient’s record and delete the wrong record. Or, maybe a long time has passed since the duplicate 
record was created, and you can’t delete the wrong patient. So, Dentrix Enterprise provides a way for you to 
merge the two patient records into one, using specifed criteria, such as last name, birth date, and gender. 

Notes: 

• Do not have either of the patients you are going to merge selected in any Dentrix Enterprise module on 
any computer on the network except in the Family File on your computer. 

• Te patients being merge must have a status of Active or Non-patient; but, even if the patients do not 
have to have the same status, you cannot merge an active record into a non-patient record. 

• Duplication of patients can occur as a result of a data conversion from another dental practice 
management software to Dentrix Enterprise. Duplication can also occur if you have an HL7 interface 
(used for communication between Dentrix Enterprise and your medical software), and a patient record is 
entered manually into Dentrix Enterprise and your medical software. 

To merge patients 

1. In the Family File, with a patient selected, from the Edit menu, click 
Merge Patients. 

1 

Te Merge Patients dialog box appears. 

2. Te primary patient is the patient record you want 
to keep. Te secondary patient’s information will 
be transferred into the primary patient’s record. By 
default, the patient currently selected in the Family 
File is the primary patient. To select a diferent 
primary patient, click the the Primary Patient 
Info search button . 

2 
4 

3. Te secondary patient is the patient record you 
do not want to keep. Te secondary patient’s 
information will be merged into the primary 
patient’s record. To select a secondary patient, click 
the Secondary Patient Info search button . 

3 

Note: If the secondary patient is a guarantor, all 
family members of the secondary patient will be 
moved to family of the primary patient. 

4. To change the merge criteria, click Advanced. In 
the Advanced Merge Patients Criteria dialog box, 
select the patient information that must all match 
for both the primary and secondary patient for 
Dentrix Enterprise to perform the merge: Last Name, First Name, Gender, Date of Birth, Zip, Social 
Security #, City, State, E-Mail, Home Phone #, and/or Work Phone #. Ten, click OK. 

5 
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Note: If you want to view the merge information, click Merge Info. Te patient information that will be 
transferred from the secondary patient to the primary patient is listed on the left; the information that 
will not be merged, on the right. Be aware that the only exceptions to what will and won’t be merged 
happen when joining a head of house (secondary) with a head of house (primary): 

• Medical alerts, medications, and allergies are moved from the secondary head of house to the primary 
head of house. 

• If the primary head of house does not have a referral, but the secondary head of house does, the 
secondary head of house’s referral information is moved to the primary head of house. 

• If the primary head of house does not have continuing care, but the secondary head of house does, 
the secondary head of house’s continuing care information is moved to the primary head of house. 

5. Click Merge. On the confrmation message that appears, click Yes. 
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Chapter 3: Appointment Book 
Te Dentrix Enterprise Appointment Book was created to facilitate “productivity scheduling.” Convenient 
toolbars and exclusive fip tabs help you navigate through the schedule, search for open times, organize 
appointments and notes, and handle all the common tasks you need to perform throughout the day. You can 
schedule appointments, record broken appointments, and print route slips. 

Tis chapter covers the following topics: 

• Te Appointment Book Window 

• Changing a Clinic’s Schedule 

• Changing a Provider’s Schedule 

• Changing an Operatory’s Schedule 

• Switching Between Views 

• Finding Open Appointment Times 

• Scheduling Appointments for Existing Patients 

• Scheduling Appointments for New Patients 

• Scheduling Events 

• Managing Appointment Book Lists 

• Using the Scheduling Assistant 

• Managing Appointments 

• Managing Events 

• Generating Appointment Book Reports 

• Working with Notes in the Appointment Book 

• Using Perfect Day Scheduling 
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The Appointment Book Window 
Te Appointment Book is divided into the menu bar, calendar, time bar, provider color bar, date bar, 
operatory ID, toolbar, navigation buttons, pin board, day view, week view, month view, and fip tabs. 

Calendar Time Bar Provider Color Bar Date Bar Operatory ID 

Navigation 
Buttons 

Day View 

Week View 

Month View 

Pin Board 

Flip Tabs 

Tis section covers the following topics to help you understand how to use the Family File window: 

• Te Appointment Book Toolbar 

• Using the Month Calendar 

• Te Time Bar 

• Provider Colors 

• Operatory IDs 

• Understanding Appointments 

• Using the Navigation Buttons 

• Using the Day View 

• Using the Week View 

• Using the Month View 

• Using the Pinboard 

• Using the Flip Tabs 
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Calendar fo r 

Scheduled Produ ction 

Cancel 
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The Appointment Book Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Appointment Book are explained in the following table. 
Click the Schedule Appointment button to choose the patient for whom you want to schedule an 
appointment, and then enter the appointment information. 
Click the Find New Appointment Time button to fnd an available appointment time by entering 
search criteria. 
Click the Locate Appointment button to choose a patient so that you can locate any existing 
appointments for that patient. 
With an appointment selected, click the Break Appointment button to remove the appointment 
from the schedule and place it on the Unscheduled List. 
Click the Set Complete button to post the scheduled treatment for the selected appointment as 
complete to the Ledger and Patient Chart. 

Click the Print Route slip button to print a route slip for the selected appointment. 

Click the Delete Appointment button to delete the selected appointment. 

Click the Perfect Day Scheduling button to turn Perfect Day Scheduling on and of. If the button 
has red and blue rectangles, this feature is turned on. If the button does not have red and blue 
rectangles, this feature is turned of. Perfect Day Scheduling must be turned on to see the Perfect Day 
Scheduling time blocks. 

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Appointment Book 
toolbar” topic in the Dentrix Enterprise Help. 

Using the Month Calendar 
Click the Calendar button to open a monthly calendar. From the calendar you can view 
production goals, scheduled production, and actual production, making it easy to quickly evaluate 
your progress in meeting production objectives. 

Te following options are available: 

• Click the double left and right arrow 
buttons to navigate to the desired month. 

• Click Scheduled Production on the menu 
bar to view scheduled production for each 
day. 

Totals for Scheduled, Production, and New 
Patients are displayed at the bottom of the 
calendar. 

• Click a date square to go to that date in the 
Appointment Book. 
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The Time Bar 
Te time bar on the left and right sides of the Appointment Book splits up hour intervals into 
your selected time block size. Te red bar indicates the current time of day For information about 
changing the time block size, see “Setting Up a Clinic” in Chapter 1: Introduction and Initial 
Setup. 

Provider Colors 
You can assign a unique color to each treatment provider in your ofce. Tese colors will be used to fag each 
appointment so that you can tell which provider the patient is seeing by the color of the appointment. 

On the left side of the Appointment Book, a color column for each treatment provider appears. Te color 
depends on the unique color assigned to that provider. A colored block in a column indicates that the 
corresponding provider is scheduled to be working on a patient during that time. 

For example, in the blue column you see a blue block from 9:10am to 9:30am, indicating that the “blue” 
provider will be involved with a patient during that time. If a provider has been double-booked, the color 
block will be white with stripes in the color assigned to that provider. If the provider column is gray, this 
indicates that the provider is not available at that time. 

For information about changing provider colors, see “Setting Up a Provider” in Chapter 1: Introduction and 
Initial Setup. 

Operatory IDs 
Te Appointment Book displays a column for each operatory added to Dentrix Enterprise.  

Operatories are displayed in alphabetical order using operatory IDs. Tere is a limit of 10 operatories per 
Appointment Book view. For information about views, see “Setting Up Views” in Chapter 1: Introduction 
and Initial Setup. 



Chapter 3: Appointment Book    99 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

- 'winters, Barbara 
X Clt'w'l212 ) 

H: 
Pati ent nam e: Winters;, Barbara 
Des;criptio,n : EmergE:x 
Phon e numb er: 
Provider: DESMITH 
Date: 11/08/2017 10 :00 
Local time zon e: (UTC -07 :00 [MST]) 
Clinic name: AF 
Scheduling op erator: DSMITH 

Understanding Appointments
 Every scheduled appointment is assigned to an operatory and a provider and has a length. 

• Te color of the appointment depends on the unique color assigned to the provider who has been selected 
as the treating/rendering provider for the appointment. 

• Te markings in the white column on the left side of the appointment correspond to the chair (blank), 
assistant (/), and provider (X) times specifed for the appointment. 

• Depending on the length of the appointment, Dentrix Enterprise displays up to nine lines of 
customizable information, such as the patient’s name and the appointment reason. 

• To quickly change the length of the appointment, click the gray square  in the lower-right corner of the 
appointment so that the cursor turns into double-headed arrow, and then drag the bottom edge of the 
appointment up or down. 

• Te appointment can have one or more icons on it in the upper-right corner. 

• A yellow fag indicates that the patient has a patient alert. 

• A blue musical note indicates that the appointment has a note. 

• A red plus sign indicates that the patient has a medical alert. 

• To quickly view appointment information, position your mouse pointer over an appointment. 

Using the Navigation Buttons 
Te navigation buttons are used to move from day to day in the Appointment Book. Click the 
left arrow button to move back one day. Click the right arrow to move forward one day. Click 
the circle button to quickly return the current system date. 

Te navigation buttons function diferently for views other than the day view: if you are displaying the week 
view, the navigation buttons will move you forward or backward a week at a time; if you are displaying the 
month view, the navigation buttons will move you forward or backward a month at a time. 
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Using the Day View 
Opening the Appointment Book in the day view allows you to see detailed information pertaining 
to an individual day and its scheduled appointments. You can schedule appointments by double-
clicking at an available time. If you are on the week or month view, click the Day View button to 
switch to the day view. 

Using the Week View 
A time-saver when looking for an available appointment time, the week view allows you to see a 
week’s worth of appointments at one time. Click the Week View button to switch to the week view. 
Te week view displays large columns for each day of your work week. Each day column is further 
divided into operatory columns that show provider color blocks, which indicate appointments that 
have already been scheduled, making it easy to see free scheduling opportunities. To schedule an 
appointment, double-click at an available time. 

Tip: To see details about an appointment, while pressing the Shift key on your keyboard, right-click the 
appointment. A pop-up box appears and displays the patient name, appointment reason, phone number, 
provider, appointment date and time, and status. 

Using the Month View 
If your schedule is packed weeks in advance, then the month view will make fnding a free 
appointment time much easier. Click the Month View button to display an entire month’s worth 
of appointment times for each provider. On the left side of the Appointment Book, each provider 
is listed by ID and in color for each work day in the month. On the top of the Appointment Book, 
the time of day is shown. To view the appointments on a particular day, click in that date’s row to 
move to that date in the day view. 

Note: Only appointments that have been scheduled using provider time (“X”s will appear on the left side of 
each appointment) appear in the month view. See “Scheduling Appointments” in this chapter. 

Using the Pinboard 
Similar to a real pin board, the Appointment Book Pinboard can temporarily store appointment or event 
information until you can fnd a new appointment or event time. You can have multiple appointments and 
events on the Pinboard at any given time. 

Dragging an appointment to the pin board Dragging an event to the pin board 
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Using the Flip Tabs 

Flip tabs act as bookmarks allowing you to jump forward or backward several days, weeks, or 
months in the Appointment Book according to a specifed length of time, such as seven days, two 
weeks, or six months. No fip tabs are set up with the initial installation of Dentrix Enterprise. For 
information about defning fip tabs, see “Setting Up Flip Tabs” in this chapter. 

Changing a Clinic’s Schedule 
Occasionally you will need to change the hours your ofce is open for a particular date. Dentrix Enterprise 
allows you to change your working hours for a single day or to close the ofce completely on a single day. 
Changing the hours of operation for a day or closing the ofce on a day does not make changes to any 
previously scheduled appointments. For example, if you have scheduled patients for March 5th, and then you 
close March 5th, those patients remain scheduled on March 5th. 

To set up when a clinic is closed for vacation days and holidays 

1. In the Appointment Book, from the Setup menu, click Clinic 
Schedule. 

Te Schedule Calendar for Clinic dialog box appears. 

2. Click the double left or right arrows to navigate to the correct 
month, and then select the day you want to close or open the ofce. 

3. From the Ofce Closed menu, click one of the following options: 

• Close Ofce on selected date – Closes the ofce on the 
selected day. Te cell for that day will become light gray. Use 
this option to close the ofce for yearly holidays that do not 
occur on the same day of the month every year (for example, 
Tanksgiving). 

• Open Ofce – Opens the ofce on the selected day if it was 
previously closed. 

• Set Yearly Holiday on selected day – Closes the ofce on 
the selected day. Te cell for that day will become pink. Use this option to close the ofce for yearly 
holidays that fall on the same day of the month every year (for example, Christmas is always on 
December 25). 

• Delete Holiday – Opens the ofce on the selected day if it was previously closed for a yearly holiday. 

4. Click Close. 

1 

2 

4 

3 
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Provider Setup 

Clinic: I MESA 

Provider: 

D0S1 
DROBB 

Schedule ar for DSMTTH at CENTRAL 

Opt10 

Practice Closed: 
Practice Holidays: 
Provider vacation: 

I Setup ! 

~ Add Provider 

Close 

Changing a Provider’s Schedule 
Occasionally, you may need to change the hours a particular provider is available. In Dentrix Enterprise, you 
can change a single provider’s hours for one day or to schedule the provider to be out of the ofce for one 
day. Changing a provider’s hours for a day or scheduling a provider out of the ofce on a certain day does 
not make changes to any previously scheduled appointments. For example, if you have scheduled patients for 
March 5th and then set a vacation day for a provider who has patients on March 5th, those patients remain 
scheduled on March 5th.. 

To change a provider’s schedule 

1. In the Appointment Book, from the Setup menu, click Provider 
Setup. 

Te Provider Setup dialog box appears. 

2. Select a Clinic. 

3. Select the desired Provider. 

4. Click Schedule. 

Te Schedule Calendar for dialog box appears. 

5. Click the double left or right arrows to 
navigate to the correct month, and then select 
the day you want to set or remove a vacation 
day. 

6. From the Option menu, click one of the 
following options: 

• Set Vacation on selected date – Makes 
the provider not available on the selected 
day. Te cell for that day will become 
purple. 

• Delete Vacation day – Removes the 
provider’s vacation day for the selected 
day if it was previously set. 

• Reset Hours to default on selected 
date – Returns the selected day to the 
provider’s default work day for that day of the week. 

1 

3 
4 

8 

2 

5 

7 

6 

7. Click Close to return to the Provider Setup dialog box. 

8. Click Close. 
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Schedule Calendar for MEW D 
Reset Hours for Selected Date 

« March 2 

Operatory Setup 

MESA2 
MESA3 
MESA4 

~ 

Setup I 

~ 

~ 

Changing an Operatory’s Schedule 
Occasionally, you may need to change the hours a particular operatory is available. In Dentrix Enterprise, you 
can change a single operatory’s hours for one day. Tis does not make changes to any previously scheduled 
appointments or events. For example, if you have scheduled patients for March 5th and then change 
an operatory’s hours, and that operatory has patients scheduled on March 5th outside of the operatory’s 
availability, those patients remain scheduled in that operatory on March 5th. 

To change an operatory’s schedule 

1. While viewing the operatories for a clinic in the Appointment 
Book (the view does not have to include all operatories), from the 
Setup menu, click Operatory Setup. 

Te Operatory Setup dialog box appears. 

2. Select the desired operatory. 

3. Click Schedule. 

Te Schedule Calendar for dialog box appears for the selected operatory. 

4. Click the double left or right arrows to 
navigate to the correct month, and then 
double-click the day to change the hours 
for the selected operatory on that date. 

5. If you want to return the selected day to the 
operatory’s default availability, click Reset 
Hours for Selected Date on the menu bar. 

6. Click Close to return to the Operatory 
Setup dialog box. 

7. Click Close. 

1 

2 
3 

7 

4 

6 
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Enter Vif!!IY Name: 

View Name ! Short-at 

Central F5 

F2 

Test View F3 

Edit 

Qelete 

• Default View of the Clinic 

OK Caacel 

Switching Between Views 
You can quickly switch between views by pressing the shortcut key (F1, F2, F3, and so forth) that corresponds 
to the shortcut key that is assigned to the desired view. However, if you don’t know the view’s shortcut key, the 
view doesn’t have a shortcut key, or you don’t want to use the view’s shortcut key, you can select the view that 
you want to switch to from a list. 

For information about adding and editing views, see “Setting Up Views” in Chapter 1: Introduction and 
Initial Setup. 

Alternatively, to switch to another view 

1. In the Appointment Book, click View on the menu bar. 

Te Select View dialog box appears. 

2. Select the view you want to use. 

3. Click Select. 

1 

32 
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Finding Open Appointment Times 
Dentrix Enterprise provides you with multiple ways to search for an available appointment time as explained 
in the following topics: 

• Manually Finding an Appointment Time 

• Using the Find Appointment Tool 

Manually Finding an Appointment Time 
Dentrix Enterprise provides the following features to help you search for an available appointment slot manually: 

• Day view – For information about this feature, see “Using the Day View” in this chapter. 

• Week view – For information about this feature, see “Using the Week View” in this chapter. 

• Month view – For information about this feature, see “Using the Month View” in this chapter. 

• Month calendar – For information about this feature, see “Using the Month Calendar” in this chapter. 

• Flip tabs – For information about this feature, see “Using the Flip Tabs” in this chapter. 
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Find N~ Appointment Time 

Select Provider(s) 
AMCCLURE 
DRDBB 

(,' Select All Ops 

Start Date 

104123/2013 

r. Day(s) 

C- Week(s) 

(" Month(s) 

Time Range 

r Time Pattern Search 

Start: ~..:..:.J 

End ~2,j 

..:.l 
..:.l 

No Duplicate Operatory Times 

Select Time Block----------~ 
r Search By Time Block 

r. Provider 
r Opertory 

Block Name Ope1atory 

r Search ByAppt Type 

Appl Type: !High Production 

SearchNiew 

-2:.J 

Provider 

..:.l 

Using the Find Appointment Tool 
When a patient with very specifc scheduling needs calls to make an appointment, combing through your 
schedule and looking for any available time slot that both meets the needs of your ofce and the patient can 
be complicated and a little stressful. To help you fnd available openings in the Appointment Book, Dentrix 
Enterprise provides an efective tool that allows you to quickly plug in as many or as few search parameters as 
you desire and then presents possible openings that meet those criteria. 

To search for an available appointment time 

1. In the Appointment Book, from the File menu, click Find New 
Appointment Time. 1 

Te Find New Appointment 
Time dialog box appears. 

2. Set up the following options: 

• Select Provider(s) – Select 
the providers whose 
availability you want to 
search for. By default, the 
providers assigned to the 
current view being used 
in the Appointment Book 
appear in the list. 

• Select Op(s) – Leave 
Select All Ops selected to 
search for open times in all 
operatories, or deselect the 
operatories that you do not 
want to search for open times in. By default, the operatories assigned to the current view being used 
in the Appointment Book appear in the list. 

3 

2 

• Select Days – Select the days of the week that you want to include in the search. 

• Start Date – Type the date from which you want to start searching, or click the search button to 
select the date from a calendar. By default, this is today’s date. 

Note: Alternatively, to advance the Start Date by a specifed interval relative to the date currently 
entered, select an interval type (Day(s), Week(s), or Month(s)), and then click a number button. For 
example, if you want to look for an available appointment time starting six months from today, click 
Month(s) and then 6 to advance the starting date by six months. 

• Appt Length – Leave the default length selected, or click the search button to set the amount of 
time needed for the appointment. You can also indicate a time pattern: chair (blank), assistant (/), 
and provider (X) time. 

• No Duplicate Operatory Times – If the search fnds the same open time in multiple operatories on a 
given date, and you want only the frst of those duplicate times to be listed, select this check box. 
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Avail able Appointm ent Times 

,. 
Thu 03/28/2013 1:00pm · 5:00pm 
Fri 03/29/2013 8: 00am · 12: 00pm 
Fri 03/2912013 1:00pm · 5:00pm 
Mon 04/0112013 8: 00am · 12: 00pm 
Mon 04/0112013 1 :00pm · 5:00pm 
Tue 04/02/2013 8: 00am · 12: 00pm 
Tue 04/02/2013 1:00pm · 5:00pm 
Wed 04/03/2013 8:00am - 12: 00pm 
Wed 04/03/2013 1:00pm · 5:00pm 

5 

4 

3. Click Search/View. 

Te Available Appointment Times dialog box appears and 
lists the frst 10 available times that match your search criteria. 

4. Select the date and time that you want to preview in the 
Appointment Book, and then click View. Te Appointment 
Book displays that date and outlines that time. 

Tip: If none of the 10 displayed dates and times will work, 
click More to list the next 10 available dates and times. 

5. To use the selected date and time to schedule the 
appointment, click Select; otherwise, click Cancel to change 
your search criteria. 

For comprehensive details about all the search options available, see the “Using the Find Appointment Tool” 
topic in the Dentrix Enterprise Help. 

Scheduling Appointments 
Keeping the schedule organized can create harmony for the whole team just as a messy and disorganized 
schedule can create a ripple efect of unnecessary stress and chaos throughout the day. Since the most common 
operation performed in the Appointment Book is simply scheduling an appointment, it’s important that they 
are scheduled correctly and include all pertinent information so that you not only serve your existing patients, 
but also make sure the ofce reaches any daily production goals. 

Dentrix Enterprise provides a fexible framework for scheduling various types of appointments: 

• Scheduling Appointments for New Patients 

• Scheduling Appointments for Existing Patients 

• Scheduling Continuing Care Appointments 



108     Chapter 3: Appointment Book 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 
Select Patient 

Search By I Appcintments I ll<fvanced Search I 
r- Patient Info 

@ Last Name (Last. First) IE) Medica ld # IE) Subscri ber ID 

IE) First Name (First Last) IE) Chart # IE) Home Phone 

tE) Preferred Name IE) SS# IE) Birthday 

giter Last Name (Last. First): 

I I Search I 
[] [nclude Archived Patients 

HoH I Last Name I Rrst Name I Ml 

◄ I 

Previously Selected Patients: 

HoH I Last Name I Rrst Name I Ml 

I.Walker 
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IWA0016E 
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I 

I OK I 

~ 

I 5511 

► 

I 5511 

I 111111111 

► 

I Cancel I 

Scheduling Appointments for New Patients 
Scheduling an appointment is often a new patient’s frst experience with your ofce. Since this is a potential 
new customer, you need to make a good impression, so you will want to ask for only enough information 
to schedule the initial appointment rather than asking for the patient’s entire health history over the phone 
(according to your organizations procedure). Also, a beneft of scheduling a new-patient appointment is that 
doing so does not create a patient record in your database, so if the patient cancels or doesn’t show up, you 
don’t clutter up your patient database with a patient who you might never hear from again. 

Notes: 

• When you create an appointment for a new patient, the patient’s contact information is stored only in the 
Appointment Book. Dentrix doesn’t automatically create a patient record in the Family File. Instead, you 
must create a patient record in the Family File record when the patient arrives for the appointment, but 
Dentrix Enterprise uses the information entered for the appointment to create that patient record to make 
it so that you don’t have to re-enter anything. 

• If the new patient fails to show up for his or her frst visit, you can delete the appointment from the 
Appointment Book. 

• Be aware that your organization’s standards and policies may require you to collect or not collect certain 
information when scheduling a new-patient appointment. 

To schedule a new-patient appointment 

1. In the Appointment Book, locate an available time on the schedule as 
explained in “Finding Open Appointment Times” in this chapter, and then 
double-click in the desired operatory at the desired time. 

Te Select Patient dialog box appears. 

1

2. Search for 
the patient to 
make sure that 
he or she does 
not already 
have a Family 
File record. 
Ten, if the 
patient does 
not exist in 
your database, 
click New 
Patient. 

2 
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Select Initial Reasons 

dEx,Pro EmergEx 
NP Exam Consult 
Comp. Eval 
Ext.Eva[ 
PeriodicX 
PA 1st 
2BWX 
48WX 
Pan 
Prophy·Adult 
Prophy-Child 
Prophy/FI-Ch 

Procedure Cod~ 

[None] 
Diagnostic 
Preventive 
Restorative 

CategOfy 

Periodontics 
Prosth,remov 
MaxilloProsth 
lmplantServ 
Prostho.fixed 
Oral Surgery 
Orthodontics 

03421 
03425 
03426 
03430 
D3450 
D3460 
D3470 
D3910 
D3920 
D3950 
D3960 

2J 

Procedure Code list 

Apicoect/Peri,ad-bicus/1 st root .,.. 
Apicoect/Perilad-molar/1 st root 
Apicoect/Perilad (each + root) 
Aetiograde filling-per root 
Root amputation-per root 
Endodontic endosseous implant 
lntentionalreplant,incsplint 

Hemisection. no root can ther ii:' 
Surg isolation of th w/rub dam B 
Canal prep/tit of dowel/post 
Bleachin of discolored looth 

Enter New Patient Information ~ 
Last First Ml 

Name: 
~-------~--, 

Phone: 

Street 

Address: 

City ST Zip ..---'------,---

New Appointment Information - (Moore, Brenda)< New Patient> 

2.:J E~~~inuing 

,----- 2.:J Attached 
P" Use Reason To Auto Update CC 

0 
Length: ro-- min 2.:J Status: l<none> ..:.l Op:jAF·OP02 

Schedule: rl F-IX_E_D ___ _, ..:J Date: I 11 12212017 

T _ype: I <none> ..:.l Time: 12:30pm 

Staff: ..:..:J T:-: Request: 

Orig. Sched. Operator: r::ID-::S-:cM"'IT::-H:--- Dale Sched.: 111 / 22/2017 

r Main Concern? 

r If Pain, How Long? 

r lnsu,ance Name? 

r Polic_y Holder Name? r Last Dental Exam? 

r Subs. SStt? DOB ? r Patient's DOB Age? 
r Employer Name? Grpl r Referred By? 

Cancel 

_J 

..:..:.l 

..:..:.l 

..:..:.l 

..:..:.l 

Change Pat I 
New Pat Inf Ir 

Other Appl(sl 

Ins Claim Info 

Schd. Next 

Wait/Will Call 

Find 

Pin Board 

r Chart Pulled 

Te Enter New Patient Information dialog box appears. 

3. Enter the following information: 

• Name – Type the patient’s last name, frst name, and 
middle initial. 

• Phone – Type the patient’s home phone number. 

• Address – Type the patient’s address. 

• Referred By – If the patient was referred to your ofce, 
click the search button  to select the referral source. 

4. Click OK. 

Te New Appointment Information dialog box appears. 

5. Select the reasons for the appointment: 

• Initial – If the patient is 

3 

4 

being seen for work that is 
part of an initial visit, such 
as an exam and cleaning, 
click Initial. Te Select 
Initial Reasons dialog box 
appears. Select the desired 
reasons, and then click OK. 

• Misc – If the patient is 
being seen for something 
else, click Misc. Te 
Procedure Codes dialog 
box appears. Select the 

5 

7 

6 

desired procedure code, and then click OK. 

6. Set up any other options as needed as explained in “Scheduling Continuing Care Appointments” in this 
chapter. 

7. Click OK. 
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Treatment Plan 

Od, Date 

? 04/12/2002 
? 01 /15/2009 
? 01 /15/2009 
? 01 /15/2009 
? 01 /15/2009 
? 01 /15/2009 
? 01 /15/2009 
1 01/09/2009 
1 12/15/2008 
2 01 /09/2009 
2 01 /09/2009 
2 01 /09/2009 

NewTx l__:!J 

Procedure Cod~ 

[None] 
Diagnostic 
Preventive 
Restorative 

Catego,y 

Periodontics 
Prosth,remov 
Ma!iilloProsth 
lmplantServ 
Prostho.fi!ied 
OralSurgeiy 
Orthodontics 

Code 

07110 
0 5214 
06970 
06970 
06971 
06971 
0 6971 
0 5213 
0 7140 
06210 
0 6210 
06210 

D3421 
03425 
D3426 
D3430 
D3450 
D3460 
D3470 
D3910 
D3920 
D3950 
D396D 

Description Tooth 

Extraclion-single l oolh 31 
Mand parlial-melal base w/sdls 25•26 
Posl/core + brdg 1elaine1, lab, 5 
Posl/core + brdg retainer. fab, 7 
Casi post/par! of brdg retainer 23 
Casi post/part of brdg retainer 24 
Casi post/part of brdg retainer 25 
Maxil partial -metal Base W/sdls 12•14 
Extract.erupted th/exposed rt 1 
Pontic-cast high noble metal 19 
Ponlic-casl high noble metal 20 
Pontic-cast high noble metal 21 

~ 

~ 
Procedure Code List 

Apicoect/Peri,ad-bicus/1 st rool: ,.. 
Apicoect/Peri,ad•molar/1 st root 
Apicoect/Perirad (each+ root) 
Retiograde filling-per rool: 
Root amputation-per root 
Endodontic endosseous implant 
Intentional replant inc splint 

Hemisection, no root can ther =' 
Surg isolation of th w/rub dam B 
Canal prep/fit of dowel/post 
Bleachin of discolored tooth 

~ 
Surf 

30 

10 
10 
10 
10 
10 

10 
10 
10 
10 

~ lect Patient 

AU 

:50 
1:00pm 

:10 
:20 
:30 
:40 0 

Search By Appointments Mvanced Search 

Patient Info ---------------­

@ Last Name (Last, First) el Other ID el Subscriber ID 

el First Name (First Last) el Chart # el Home Phone 

el Preferred Name el SS # el Birthdate 

£.nter Last Name (Last. First): 

Search 

[J include Archived Patients 

HoH I Last Name I Ml I Preferred Name 

Crosby Brent 

Scheduling Appointments for Existing 
Patients 
You can schedule appointments for your patients of record. You can schedule an appointment for any 
procedure codes and for treatment-planned procedures. 

To schedule an appointment 

1. In the Appointment Book, locate an available time on the schedule as 
explained in “Finding Open Appointment Times” in this chapter, and then 
double-click in the desired operatory at the desired time. 

Te Select Patient dialog box appears. 

2. Search for the desired patient, and then double-click the 
patient name in the list of matches. 

Te New Appointment Information dialog box appears. 

3. Select the reasons for the appointment: 

• Tx – If the patient is going to be seen for treatment-
planned work, click Tx. Te Treatment Plan dialog box 
appears. Select the desired procedures, and then click 
Close. 

2 

Tip: To add to the treatment plans listed in the Treatment Plan dialog box, click New Tx. 

• Misc – If the patient is being seen for treatment that has not been treatment-planned, click Misc. Te 
Procedure Codes dialog box appears, select the desired procedure code, and then click OK. 



Chapter 3: Appointment Book    111 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

r 
rx 

New Appointment Information - (Crosby, Shirley) 

2d E~~~inuing 

,----- 2,j Attached: 
17 Use Reason To Auto Update CC 

.d 

0 
Length: ro-- min 2,j S talus: I< none> ..:J Op: IAF-0 P02 2,j 
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RVU: .----- lype:l<none> ..:J Time: 12:30pm 2,j 
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Notes----------------------~ 

Insert Dateline 

r Main Concern? 
r II Pain. How Long? 
r Insurance Name? 

r Policy Holder Name? r Last Dental Exam? 
r Subs. SStt? DOB? r Patient's DOB Age? 
r Employer Name? Grpl r Referred By? 

Change Pat I 
P alien! I nlo 11 
Other Appl(s) 

Ins Claim Info 

Schd. Ne,I 

Wail/Will Call 

Find 

Pin Board 

History 

OK 

Cancel 

4. Set up the following options as needed: 

• Provider – By default, Dentrix 
Enterprise assigns the patient’s 
primary provider, but you can 
select another provider for the 
appointment. 

• Appointment Desc – Dentrix 
Enterprise updates the 
description automatically as you 
add an appointment reason, but 
you can change it as needed. 

• Length – Dentrix Enterprise 
updates the length automatically 
as you add an appointment reason. 
If more or less time is needed to 
complete the appointment, you can 
change the length. You can also set 
up the time pattern for each unit of 
the length (chair time , assistant’s 
time , or provider’s time ) to help you maximize your productivity and the use of all operatories. 

3 

4 

• Amount – Dentrix Enterprise updates the amount as you add an appointment reason, but you can 
change it as needed. 

• Staf – If applicable, click the search button to select the staf member who will assist with this 
appointment. 

• Schedule – You can categorize appointments into three groups. Select one of the following options: 

• FIXED – Te patient has an infexible schedule and can only be seen at the scheduled time. 

• OPEN – Te patient is willing to change the date and time of the appointment if necessary. 

• ASAP – Te patient want to be seen earlier if an appointment time becomes available. 

• Type – If you are using Perfect Day Scheduling, select an appointment type. For an explanation of 
Perfect Day Scheduling and appointment types, see “Using Perfect Day Scheduling” in this chapter. 

• Op, Date, Time – Dentrix Enterprise automatically inserts the operatory, date, and time for the 
appointment that corresponds to the time slot where you double-clicked to begin scheduling this 
appointment. You can change the Op, Date, and/or Time as needed. 

• Note – If clarifcation is needed or to add other details about the appointment, type a note. 

• Chart Pulled, Check List – If you have pulled the patient’s paper chart, select Chart Pulled. Also, 
you can select any of the check boxes (the check list items as set up in the Practice Defnitions) at the 
bottom of the dialog box as needed. 

5. Click OK. 

5 
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Search 
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Scheduling Continuing Care Appointments 
To schedule a continuing care appointment 

1. In the Appointment Book, locate an available time on the schedule as 
explained in “Finding Open Appointment Times” in this chapter, and then 
double-click in the desired operatory at the appropriate date and time. 

Te Select Patient dialog box appears. 

2. Search for the desired patient, and then double-click the 
patient name in the list of matches. 

Te New Appointment Information dialog box appears. 

3. Te initial reasons are the most common procedures that 
your ofce performs, typically for initial and recurring visits, 
such as exams and cleanings. To select the continuing care 
appointment reasons, click Initial. Te Select Initial Reasons 
dialog box appears. Select one or more reasons, and then click 2 
OK. 

Note: If any of the selected procedures corresponds to a continuing care type that is not attached to the 
patient’s record, and the Use Reason to Auto Update CC check box is selected, a message appears and 
asks if you want to attach the missing continuing care to the patient’s record using the default settings. 
Click Yes to attach the continuing care to the patient’s Family File. 
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4. Set up the following options as needed: 

• Provider – By default, Dentrix 
Enterprise assigns the patient’s 
primary provider, but you can 
select another provider for the 
appointment. 

• Appointment Desc – Dentrix 
Enterprise updates the description 
automatically as you add an 
appointment reason, but you can 
change it as needed. 

• Length – Dentrix Enterprise updates 
the length automatically as you add 
an appointment reason. If more or 
less time is needed to complete the 
appointment, you can change the 
length. You can also set up the time 
pattern for each unit of the length 
(chair time , assistant’s time , or 
provider’s time ) to help you maximize your productivity and the use of all operatories. 

3 

4 

• Amount – Dentrix Enterprise updates the amount as you add an appointment reason, but you can 
change it as needed. 

• Staf – If applicable, click the search button to select the staf member who will assist with this 
appointment. 

• Schedule – You can categorize appointments into three groups. Select one of the following options: 

• FIXED – Te patient has an infexible schedule and can only be seen at the scheduled time. 

• OPEN – Te patient is willing to change the date and time of the appointment if necessary. 

• ASAP – Te patient want to be seen earlier if an appointment time becomes available. 

• Type – If you are using Perfect Day Scheduling, select an appointment type. For an explanation of 
Perfect Day Scheduling and appointment types, see “Using Perfect Day Scheduling” in this chapter. 

• Op, Date, Time – Dentrix Enterprise automatically inserts the operatory, date, and time for the 
appointment that corresponds to the time slot where you double-clicked to begin scheduling this 
appointment. You can change the Op, Date, and/or Time as needed. 

• Note – If clarifcation is needed or to add other details about the appointment, type a note. 

• Chart Pulled, Check List – If you have pulled the patient’s paper chart, select Chart Pulled. Also, 
you can select any of the check boxes (the check list items as set up in the Practice Defnitions) at the 
bottom of the dialog box as needed. 

5. Click OK. 

For a comprehensive description of all the options available for scheduling appointments, see the “Scheduling 
appointments” topics in the Dentrix Enterprise Help. 

5 
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Scheduling Events 
Te Dentrix Enterprise Appointment Book is not just for managing patient appointments. It also allows you 
to schedule events, such as staf meetings, vacations, and activity reminders. You can use an event to block out 
time or close one or all operatories in the Appointment Book, so you have a visual reminder that you cannot 
schedule during that time. An event can be for a single day or be a recurring event for up to one year. 

To schedule an event or a series of events 

1. In the Appointment Book, navigate to the starting date of the 
event, right-click in the desired operatory at the desired starting 
time for the event, and then click Schedule Event. 

Te Schedule Event dialog box appears. 

2. Set up the following options: 

• Time, Days, Operatores – By default, 
Dentrix Enterprise uses the operatory, date, 
and time for the event that corresponds to 
the time slot where you right-clicked to begin 
scheduling this event. You can change the 
Event Time, Event Days, and/or Operatories 
as needed. If the event will last the entire day, 
select Close Operatory (All Day Event). 

1 

2 

Notes: 

• You must select at least one day. If the 
event starts and ends on the same day, 
select that day of the week. 

• You cannot schedule an event that overlaps 
a scheduled appointment or another event. 

• Description – Type a description for the 
event or series. To center the description 
horizontally at the top of the event block 
in the Appointment Book, select Center 
Description on Scheduled Event. With 
this check box cleared, the description is left 
aligned. 

3 

• Event Color – Click the button to choose a color for the event. 

Tip: When choosing a color for the event, choose a light color that contrasts with the black text 
of the event description, so you can see the words easily. For example, black text will not be easily 
readable on a dark blue background. 

• Notes – Type any notes that apply to the event. 

Important: If you create a repeating event, be aware that if you want to delete the whole series, you must 
delete each event in that series one at a time. 
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3. Click OK. 

Notes: 

• Te event creation process may 
take several minutes, depending on 
the date range specifed, the days 
of the week selected, the number 
of operatories selected, and the 
number of future appointments 
scheduled. 

• If you attempt to schedule a single 
event that overlaps with an existing 
appointment or event, a message 
appears and states that the operatory 
is already scheduled at the requested 
time. 

• If Dentrix could not create an event that is part of a series because that event overlaps with an existing 
appointment or event, a log fle appears for your reference. You can correct the conficts and then 
schedule events to match those in the series you created previously. 
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Managing Appointment Book Lists 
Failed or canceled appointments can cost a dental ofce thousands of dollars a year in lost production time. 
Dentrix Enterprise helps you avoid that missed revenue by providing you with several types of appointment 
lists that can be used to fll open blocks of time in your schedule. Tis section covers the following topics 
about how to use these lists: 

• Using the Appointment List 

• Using the ASAP List 

• Using the Open List 

• Using the Unscheduled List 

• Using the Pinboard List 

Using the Appointment List 
Te Appointment List displays all appointments scheduled in the Appointment Book for a selected date. 
As a useful tool to confrm appointments, the Appointment List displays the time, status, name of patient, 
provider, operatory, reason, length, and patient phone number for the appointment. 

To use the Appointment List 

1. 

Clinics (to view appointments for all clinics). 

Te Appointment List View dialog box appears. 

2. Make your provider and operatory selections to flter the 
appointments in the list, and then click OK. 

Te Appointment List window appears. 

3. Perform any of the following tasks: 

• To see more information regarding 
an appointment or to make changes 
to an appointment, double-click it to 
open the Appointment Information 
dialog box. 

• To move back one day at a time or 

In the Appointment Book, from the Appt Lists menu, point to 
Appt List, and then click either Current Clinic (to view 
appointments for the clinic currently being viewed) or All 

1 

2 

3

forward one day at a time, click the 
left or right arrow button. To select a specifc date, click the calendar button. 

• To move a selected appointment to the Pinboard for quick rescheduling, from the Appt menu, click 
Move Appointment to Pinboard. 

• To break a selected appointment and move it to the Unscheduled List, from the Appt menu, click 
Break Appointment. 

• To delete a selected appointment permanently, from the Appt menu, click Delete Appointment. 

• When confrming a selected appointment, from the Status menu, select the appropriate status type to 
indicate the last contact with the patient. 

• To open the Ofce Journal of the patient that corresponds to a selected appointment, on the menu 
bar, click Ofce Journal. 
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Using the ASAP List 
Many times patients call wanting an appointment sooner than your next available time. In these situations, 
you can ofer to call the patient if an appointment time becomes available. With Dentrix Enterprise, you can 
fag scheduled appointments as ASAP (As Soon As Possible). 

Once you have fagged an appointment as ASAP, it appears on the ASAP List. Tis satisfes the patient’s 
request for a sooner appointment, while benefting the ofce at the same time, by providing a list of patients 
who can fll holes in an otherwise full schedule. 

In addition to providing you with names of patients who can fll open appointment times, the interactive 
nature of the ASAP List makes it simple to contact a patient and then create or move an appointment as 
needed. 

To use the ASAP List 

1. In the Appointment Book, from the Appt Lists menu, point to 
ASAP List, and then click either Current Clinic (to view 
appointments for the clinic currently being viewed) or All 
Clinics (to view appointments for all clinics). 

Te ASAP List View dialog box appears. 

2. Make your provider, operatory, and day span selections to 
flter the appointments in the list, and then click OK. 

Te ASAP List window appears. 

1 

3. Perform any of the following tasks: 

• To see more information regarding 
an appointment or to make changes 
to an appointment, double-click 
it to open the Appointment 
Information dialog box. 

• To change the start date for the 
view, click the calendar button. 

• To move a selected appointment to 

• To delete a selected appointment permanently, from the Appt menu, click Delete Appointment. 

• If you or someone else changed an appointment in another module or on another computer, to 
update the ASAP List to refect the most recent changes, on the menu bar, click Refresh. 

• When confrming a selected appointment, from the Status menu, select the appropriate status type to 
indicate the last contact with the patient. 

• To open the Ofce Journal of the patient that corresponds to a selected appointment, on the menu 
bar, click Ofce Journal. 

the Pinboard for quick rescheduling, from the Appt menu, click Move Appointment to Pinboard. 

2 

3
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Using the Open List 
When a patient calls to cancel at the last minute, the ofce must either scramble to fnd a patient willing 
to come in on short notice or else lose valuable production. Te Open List can help you quickly fll those 
available slots by providing you with a list of scheduled patients who have more fexible schedules and may be 
willing to come in at the last minute. 

In addition to providing you with names of patients who can fll open appointment times, the interactive 
nature of the Open List makes it simple to contact a patient and then create or move an appointment as 
needed. 

To use the Open List 

1. In the Appointment Book, from the Appt Lists menu, point to 
ASAP List, and then click either Current Clinic (to view 
appointments for the clinic currently being viewed) or All 
Clinics (to view appointments for all clinics). 

Te ASAP List View dialog box appears. 

2. Make your provider, operatory, and day span selections to 
flter the appointments in the list; under Type of Search, 
select Open; and then click OK. 

1 

that are fagged as Open. 

3. Perform any of the following tasks: 

• To see more information regarding 
an appointment or to make changes 
to an appointment, double-click 
it to open the Appointment 
Information dialog box. 

Te ASAP List window appears, displaying appointments 2 

3

• To change the start date for the 
view, click the calendar button. 

• To move a selected appointment to the Pinboard for quick rescheduling, from the Appt menu, click 
Move Appointment to Pinboard. 

• To delete a selected appointment permanently, from the Appt menu, click Delete Appointment. 

• If you or someone else changed an appointment in another module or on another computer, to 
update the Open List to refect the most recent changes, on the menu bar, click Refresh. 

• When confrming a selected appointment, from the Status menu, select the appropriate status type to 
indicate the last contact with the patient. 

• To open the Ofce Journal of the patient that corresponds to a selected appointment, on the menu 
bar, click Ofce Journal. 
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In the Appointment Book, from the Appt Lists menu, point to 
Unscheduled List, and then click either Current Clinic (to view 
appointments for the clinic currently being viewed) or All Clinics 
(to view appointments for all clinics). 

Te Unscheduled List View dialog box appears. 

Make your provider selections to flter the appointments in the list, 

1 

2 

3 

Using the Unscheduled List 
Te Unscheduled List provides you with an easy way to view broken or wait/will call appointments. 

To use the Unscheduled List 

1. 

2. 
and then click OK. 

Te Unscheduled List window appears. 

3. Perform any of the following tasks 

• To see more information 
regarding an appointment 
or to make changes to an 
appointment, double-click 
it to open the Appointment 
Information dialog box. 

• To move a selected 
appointment to the Pinboard 
for quick rescheduling, from 
the Appt menu, click Move 
Appointment to Pinboard. 

• To delete a selected appointment permanently, from the Appt menu, click Delete Appointment. 

• If you or someone else changed an appointment in another module or on another computer, to 
update the Unscheduled List to refect the most recent changes, on the menu bar, click Refresh. 

• To open the Ofce Journal of the patient that corresponds to a selected appointment, on the menu 
bar, click Ofce Journal. 
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Using the Pinboard List 
Te Pinboard List provides you with an easy way to view appointments and events that are on the Pinboard of 
users in all clinics. 

To use the Pinboard List 

1. In the Appointment Book, from the Appt Lists menu, click 
Pinboard List. 1 
Te Pinboard List window appears. 

Notes: 

• An appointment with a date and 
time was put on the Pinboard 
by clicking one of the Move 
to Pinboard options from the 
shortcut menu that appears when 
you right-click an appointment, 
by clicking one of the Move to 
Pinboard menu options with 
an appointment selected, or by 
clicking the Pin Board button that is available from an appointment’s Appointment Information dialog 
box appears only on the Pinboard or in the Pinboard List window. 

2 

• An appointment without a date and time that was put on the Pinboard by dragging it there, still appears 
on the schedule. 

• If you close the Appointment Book or click Refresh from the File menu, any appointment or event that 
was dragged to the Pinboard remains on the Pinboard and is still scheduled at its original date, time, and 
operatory. 

2. Perform any of the following tasks: 

• To see more information regarding an appointment or to make changes to an appointment, double-
click it to open the Appointment Information dialog box. 

• To delete a selected appointment permanently, from the Appt menu, click Delete Appointment. 

• If you or someone else changed an appointment in another module or on another computer, to 
update the Pinboard List to refect the most recent changes, on the menu bar, click Refresh. 

• To open the Ofce Journal of the patient that corresponds to a selected appointment, on the menu 
bar, click Ofce Journal. 
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Using the Scheduling Assistant 
Te Scheduling Assistant module enhances the scheduling workfow by combining the Continuing Care, 
Unscheduled Appointments, ASAP, Unscheduled Treatment Plans, and Treatment Request Manager lists into 
one window. Also, the Scheduling Assistant includes quick access to a patient’s details and Ofce Journal 
entries, and you can schedule appointments directly from the Scheduling Assistant. Tis section covers the 
following topics about the Scheduling Assistant: 

• Viewing Patients in the Scheduling Assistant 

• Scheduling Appointments from the Scheduling Assistant 

Viewing Patients in the Scheduling Assistant 
You can open the Scheduling Assistant from the Ofce Manager module, and flter the list of patients in that 
window to suit your preferences. 

To view patients in the Scheduling Assistant 

1. In the Ofce Manager, from the File menu, click Scheduling 
Assistant. 

Te Scheduling Assistant opens. 

2. Set up the following flters as needed:: 

• List – Select the type of list that you want to view: 

• Continuing Care – Te list displays patients with 
continuing care attached to their records and/or who need 
continuing care appointments scheduled. Te number 
in square brackets is a count of patients that meet the 
Continuing Care flter settings. 

If none of the check boxes under Continuing Care are 
selected, the list displays patients with continuing care 
attached to their records, whether or not appointments 
have been scheduled for those continuing care types. To 
view patients with unscheduled continuing care types 
that will be due starting at a certain time and/or that have 
been overdue for a certain length of time, select any of the 
following check boxes: 

1 

2 

• Due w/out Appointments – Any continuing care 
types that will be due. 

• Overdue 1-30 Days – Any continuing care types that 
have been overdue for one to 30 days. 3 

• Overdue 31-60 Days – Any continuing care types 
that have been overdue for 31 to 60 days. 

• Overdue 61-90 Days – Any continuing care types that have been overdue for 61 to 90 days. 

• Overdue >90 Days – Any continuing care types that have been overdue for more than 90 
days. 

Note: A continuing care type is considered due or overdue according to the specifed Due w/out 
Appointments Date Range of the Continuing Care flter. 
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• Unscheduled Appointments – Te list displays patients who have broken appointments that 
need to be rescheduled. Te number in square brackets is a count of patients that meet the 
Unscheduled Appointments flter settings. 

• ASAP Appointments – Te list displays patients who have appointments that are marked as 
ASAP. Te number in square brackets is a count of patients that have appointments on the ASAP 
List. 

• Unscheduled Tx Plans – Te list displays patients who have unscheduled treatment plans. Te 
number in square brackets is a count of patients that meet the Unscheduled Tx Plans flter 
settings. 

• Unscheduled Tx Requests – Te list displays patients who have unscheduled treatment requests. 
Te number in square brackets is a count of patients that meet the Unscheduled Tx Requests 
flter settings. 

• Clinics – To view patients in all clinics, select the All check box. Or, click the search button to 
select the clinics whose patients you want to view. By default, the patients for the clinic that you are 
currently logged in to are displayed. 

• Prov – To view patients for any provider, select the All check box. Or, click the search button to 
select the providers whose patients you want to view. 

3. Click the Refresh/Apply flter settings button . 

For comprehensive information about customizing the flter settings for the lists in the Scheduling Assistant, 
see the “Customizing the Scheduling Assistant Filters” topic in the Dentrix Enterprise Help. 
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Scheduling Appointments from the 
Scheduling Assistant 
You can schedule an appointment from the Scheduling Assistant. 

To schedule an appointment 

1. In the Scheduling Assistant, select a 
record. 

2. Click the Create Appointment button 
. 

1 

Te Select View dialog box appears. 
Also, the Appointment Book opens in 
the background if it is not already open. 

3 

2 

4 

3. Select an Appointment Book view. 

4. Click OK. 

Te New Appointment Information dialog box appears. 

Notes: 

• If you are scheduling a continuing care appointment, the continuing care type and assigned provider 
are attached to the appointment automatically. 

• If you are rescheduling a broken appointment, the original appointment details, such as the provider, 
reason, description, length, and amount, are entered automatically in the new appointment. 

• If you are scheduling an ASAP appointment, the original appointment details, such as the provider, 
reason, description, length, and amount, are entered automatically in the new appointment. 

• If you are scheduling a treatment-planned procedure, it is linked to the appointment automatically 
along with the assigned provider and any corresponding continuing care. 

• If you are scheduling a treatment request, it is linked to the appointment automatically along with 
the patient’s provider. 
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New Appointment Information - (Crosby, Brent) 

........ I Lonhnu1ng 
Piov: IDES MITH ..'...:'.J Care 
ENCtt I 2:J />,llached: 

I PROPHY 08102/2018 2:1 
r Use Rea son To Auto Update CC 

Reason-----------------------, 

~sc: IPROPHY 

Len~th: !40 min 2:J _$_talus: l <none> .:.J Op: I ~----2:J 
Amo~nt: I Schedule: ~I F-IX_E_D ___ .:.J_ Q ate: I 0810212018 2:J 

RVU: I.---- T~pe: l <none> .:.J lime: I 2:J 
Stall: I 2:J T x Request: I 2:J 

Orig. Sched. Operator: IDSMITH Date Sched.: 111121 12017 

Notes----------------------~ 

I 
r Main Concern? 

r II Pain, How Long? 
r Insur a nee Name? 

Insert Dateline I 

r Policy Holder Name? r Last Dental Exam? 

r Subs. SStt? DOB? r Patient's DOB _Age? 
r Employer Name? Grpl r Referred By? 

Change Pal I 
E atient I nlo 11 
Q ther Appl( s I I 
Ins !;laim Info I 
Schd. Ne~t I 

y{ ait/Will Call I 
Find J... 

Pin~oa,d( 

History~ 

OK I 
Cancel I 

r Chari Pulled 

5. Set up the appointment details, such as the provider, encounter number, and reason. 

6. Click Pin Board. 

7. Navigate to the desired date for the 
appointment, and then drag the 
patient’s appointment from the 
Pinboard to the desired time slot in 
the correct operatory. On the 
confrmation message that appears, 
click Yes. 

6 

5 

7 

Managing Appointments 
With Dentrix Enterprise, you can not only schedule appointments, but you can quickly perform other 
appointment-related tasks. Tis section will explain the following tasks: 

• Locating Existing Appointments 

• Editing Appointments 

• Moving Appointments 

• Breaking or Canceling Appointments 

• Rescheduling Broken or Canceled Appointments 

• Posting Scheduled Work 

• Deleting Appointments 
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Seim Patient 

51lai!!appointments for: I 1012012015 GJI 
[ti Always start with "loday" 

last Name I First Name ] Preffered Name I Phone 

Crosby Brent 8015551212 

Appointments fo r Abbott, James S 

Date Day Time 

02/02/2009 Moo 8:30a 
01/20/2009 Tue 9:00a N□answ 

01/13/2009 Tue 9:lOa NOansw 
12/18/2008 Thu 8:40a NOansw 
12/15/2008 Moo 11:00a <Cmpl> 
12/08/2008 Moo 1:00p 

Seim Patient 

Search By Appointments Advanced Search 

Patient Info ----------------

@ Last Name (Last. First) e> Other ID e> Subscri ber ID 

e> First Name (First Last) e> Chart # e) Home Pho"" 

e> Birthdate ~ Preferred Name ~ SS # 

~ter Last Name (Last. First) : 

Search 

El !nclude Archived Patients 

HoH I last Name 

Crosby 
I: Nao I Ml I Preferred Name 

Clinic Date scheduled 

P2 CENTRAL 02/02/2009 
EF-□P3 CENTRAL 01/20/2009 

DEF=DP2 CENTRAL 01/13/2009 
DEF_OPl CENTRAL 12/18/2008 
DEF_OP3 CENTRAL 12/17/2008 
DEF_OPl CENTRAL 12/15/2008 

I Clinic 
r- Cunent r All 

Locating Existing Appointments 
You have several options for fnding existing appointments: 

• Using the Locate Existing Appointment option 

1. In the Appointment Book, from the File menu, click Locate 
Existing Appointment. 1 
Te Select Patient dialog box appears. 

Note: On the Appointments tab, you can locate a patient’s 
appointment for a specifed date. Ten, to go to that 
appointment in the Appointment Book, double-click it. 

2 

2. Search for the desired patient. (If you are looking for a new patient, in the results list an “NP-” 
precedes the last name of that patient.) Ten, double-click the patient name in the list of matches. 

Te Appointments for dialog box appears. 

Note: By default, the 
appointments for this patient in 
the Current clinic appear in the 
list. To view appointments for 
this patient in any clinic, under 
Clinic, select All. 

3 

3. Select the appointment that you 
want to view or edit. 

4. Click either Locate appt (to go to 
the selected appointment in the 
Appointment Book) or Edit appt 
(to open the Appointment Information dialog box for the selected appointment). 

4 
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Family Appointment List ~ 

I Guar Abbott, Patricia 49 CC: PROPHY 0512212002 .. '••· I ,. I I Child Smith. Timothy 8 CC: PROPHY 05/08/2002 

Appointment Op Clinic Continuing Care I [No Appointment] CC: PRO PHY 071211201 2 A 

' 01 1201201 2 Fri 1:00pm DROBB PR -01 PROVO 0 □ 
' 01 11312012 Fri 1:00pm DROBB PR-01 PROVO T 

Treatment Plan 

I ? 

04/1212002 D 7110 Extraction-single tooth 31 30 min 

( ) View Appl I Create New Appt. I I Close I 
I 

• By right-clicking an appointment 

1. To fnd other appointments a patient has, with one of that patient’s 
appointments selected in the Appointment Book, right-click it, and 
then click Other Appointments. 

1 

Te Family Appointment List dialog box appears. 

Notes: 

• Tis dialog box also 
displays appointments for 
other family members of 
the selected patient. To 
switch between family 
members, select a diferent 
family member from 
the top list box. To view 
appointments for all family 
members at the same time, 
click Select All. 

• To create a new 
appointment, select a 
family member, click Create New Appt. 

3 

2. Select the appointment that you want to view. 

3. To go to the selected appointment in the Appointment Book, click View Appt. 

2 
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Summary 
Dental Ins <D ® Medical Ins (D ~ I Patlag 1 

Primary: Delta PMI Primary: ACME Medical Pat Tag 2 

App o intment s Next Appointments + i.)J Continuina Care 
Date Cli nic Prov Date Type Appl 

Procedure s 
11/ 12/20199:00AM IAF I DSMITH 12/18/2019 I PERIO 

I 09/17/2019 11/ 13/20199:00AM AF DSMITH 3/ 18/2020 PROPHY 
Medical A le rts 

Treatment Plans 

Balance Aging: Pat ient: Family: 
Health Assessments 

0-30 500.80 1181.62 
Outstanding Claims 

31-60 0.00 0.00 
Treatment Requests Created Sent Amount Clinic 61-90 0.00 0.00 

6/17/2019 1 6/17/2019 1 302.40 IAF 90+ 3222.70 3812.70 
Billing 9/17/2019 9/17/2019 158.40 AF Suspended -400.00 -400.00 

Total 3323.SO 4594.32 

Ins Est for Comp I Proc 460.80 1057.72 

e Ins Est for Appl Proc 0.00 0.00 

EST Portion 2862.70 3536.60 

Summary 
Date Time TimeZone Status Reason Prov Operatory Clinic Ln 

11/ 13/2019 9:00AM UTC -07:00 <no ne> ReEval DSMITH AF-OP-01 AF 10 

Appointments 11/ 12/2019 9:00AM UTC -07:00 <no ne > Sialo DSMITH AF-OP-01 AF 10 

2/16/2017 3:50 PM UTC .07 :00 <none> RtCrnPFHn"30 MHAYES AF-OP03 AF 90 
Procedures 

2/23/2017 10:00AM UTC .07:00 <none> Res2PosPr=3 DESMITH AF-OP02 AF 20 

M edical A lerts 

Treatment Plans 

Health Assessments 

Treat m ent Request s 

Billing IE] Hi de Pa st App ointments IE] Hide Unsch eduled Appointments + Q \) 

Family ~ 

St atus Name Age 

Guar Crosby, Brent 45 

Married Crosby, Shirley H. 42 

Single Crosby, Tom N. 16 

Child Crosby, Crystal 14 

•  From the More Information window 

1. Open a patient’s More Information window as explained in “Viewing More Patient Information” in 
Chapter 11: Other Features. 

2. Te Summary tabs shows the patient’s Next Appointments. To view an appointment, select it, and 
then click the Locate Appointment button . 

3. You can also view this patient’s appointments on the Appointments tab. To view an appointment, 
select it, and then click the Locate Appointment button . 

4. You can also view appointments for other family members. Double-click any family member who is 
listed to view that patient’s information in the More Information window. 
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Abbott,James S 
ApicPosFI, ProphJOl,.d 
H:555-1111 
DROBB 
048 

New Appointment Information - (Abbott, James) 

!II 

04/11/2017 Prov: !DESMITH 

ENCtt 

........ I Continuing 
..:::::J Care 
2jAllached: 

P" Use Rea son To Auto Update CC 

2:1 
Reason----------------------, 

~ Pc 

--2:.J 
Prophylaxis-adult 

0 
Status: I <none> ..:.l Op: IAF-OP02 

Desc: ProphyAd 

Length: ISO min 22.J 
Amount: I 1 65. 00 ..:.l Schedule: ~I F-IX_E_D __ _ Date: I 11 12212011 

RVU : 12.00 Type: I Gener al ..:.l Time: j 230pm 
,-----

SI a 11: 2:1 T:-: Request: 

Orig. Sched. Operator: jDSMITH Date Sched.: 111 /22/2017 

1 Noles 

Change Pat I 
Palienl Info 11 
Olher Appl( s I 

Ins Claim Info 

Schd. Nexl 

Wail/Will Call 

Find 

Pin Board 

Editing Appointments 
You change any information pertaining to an appointment (provider, reasons, time, notes, and so on) as 
needed. 

To quickly change an appointment length 

To quickly change the length of the appointment, click the gray 
square in the lower-right corner of the appointment so that 
the cursor turns into double-headed arrow, and then drag the 
bottom edge of the appointment up or down. While you are 
dragging, a small box appears and shows the length, in minutes, 
of the appointment. 

To edit an appointment 

1. 

Te Appointment Information dialog box appears. 

2. Make any necessary changes to the options 
explained in “Scheduling Appointments 
for Existing Patients” in this chapter. 

3. Click OK. 

In the Appointment Book, double-click an appointment. 1 

2

3
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· ~660!1. Pat11c1a 
):l.malg3Per1113 +-~ h!fflrm:~!!!11'~ 

· ~:555-1586 · DDS,.. _____ _, 

New Appointment Information - (Abbott, James) 

P,ov: !DESMITH 

ENCtt 

, .... I Continuing 
~ Ca,e 
2jAttached: 

04/11/2017 

l'7 Use Rea son To Auto Update CC 

2:1 
Reason---------------------~ 

~ Pc P1ophylaxis-adull 

--2:..J 

Desc: P,ophyAd 

Change Pat I 
Patient Info 11 
Othe, Appt{s) 

Ins Claim Info 

Schd. Next 

Wait/Will Call 

Length: 16Q min 2j Status: j <none> ..:.J Op: AF-OP02 2j Find 

Amount: 1165.00 Schedule:~, F-IX_E_□---..:.J~ Date: ~1,-, ,-2-2,-2-01_7_ 2j Pin Boa,d 

RVU: 12.00 Type:j Gene,al ..:.J Time: 12:30pm 2j Histo,y 

Stall: ~----2j TxReques. ~ 

01ig. Sched. Ope1at01: ! □SMITH K 
Notes ancel I 

Moving Appointments 
Whether a patient needs to reschedule or the ofce needs to lighten the schedule, from time to time you will 
need to move an appointment to a new date or time: 

• On the same date – In the Appointment Book, click and drag the appointment to a new time and/or 
operatory. On the confrmation message that appears,  
click OK. 

• To a diferent date 

1. In the Appointment Book, click and drag the 
appointment to the pin board. 1 
Tip: To return an appointment on the pin 
board to its original date and time, from the 
File menu, click Refresh. 

2. Once you fnd a new date and time for the 
appointment, click and drag the appointment 
to the desired spot on the schedule. On the 
confrmation message that appears, click OK. 

• By double-clicking an appointment 

1. If you know the exact date and time to which you want to move an 
appointment, in the Appointment 
Book, double-click the 
appointment you want to move. 
Te Appointment Information 
dialog box appears. 

2. Type the new Date and Time, and 
if necessary, select the desired Op. 

3. Click OK. 

2 

1 

3

2

Tip: To move multiple appointments to the pin board, from the Move to Pinboard menu, click one of the 
following options: 

• All Appts for Displayed Date – To move all the appointments scheduled on the date being displayed. 

• Family Appts for Displayed Date – To move all the appointments for all patients in the same family 
with appointments on the date being displayed. 

• Provider’s Appts for Displayed Date – To move all the appointments with the same provider as the 
selected appointment. 

• Operatory Appts for Displayed Date – To move all the appointments in the same operatory as the 
selected appointment. 
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Appointment Book <American Fork Dental Practice> <AF> < U 

:ietup Appl j,,ists Move to Pinboard !:! 

4:00pm file Qptions ~iew 
:10 
:20 
:30 
:40 
:50 

- PRIVACY REQUESTS 

2 3 4 5 6 

~[§]~ 

8 s 10 1 Diagnostic 

n n, .. I n, .. 1 Rest or alive 

Preventive 

Endodonlics 

ff 150 I ff 150 I Periodontics P,osth remov 

[Ell [El.I Maxilla Prosth Implant Serv 

Proslho fixed Oral Surgery 

(I) lfil I l(JJ I O rlhodonlics Adjunct S erv 

~ ~ I ff,. I Conditions IHS-Olher 
---------il''.:.Q.~ ~/Rl~(l(l jfj~- -=~~ -1-iiiiiiiiiiiiiii.!ll 

80030] (05/05/. 

Breaking or Canceling Appointments 
When a patient calls and cancels an appointment, to prevent these broken appointments from being 
forgotten, Dentrix Enterprise moves them to the Unscheduled List, where they can be reviewed on a regular 
basis. When you break an appointment, Dentrix Enterprise moves all of the entered information to the 
Unscheduled List so that you don’t have to re-enter it later. If the patient fails to call back and confrm a 
date and time, the appointment remains on the Unscheduled List where you can access it to fll last-minute 
cancellations or to increase production during slow months. 

Also, when you try to schedule an appointment for a patient with a broken appointment, Dentrix Enterprise 
displays a message that states that the patient has a broken appointment and prompts you to reschedule it. 

To break or cancel an appointment 

1. Code/complete the canceled or broken appointment. 

2. In the Appointment Book, select the appointment, and then click the Patient Chart button on the 
toolbar to open the Patient Chart module. 

3. Verify that the provider with whom the patient was scheduled is displayed on the title bar of the Patient 
Chart window. If the correct provider is shown, skip step 4. 

4. If you need to change the provider being displayed in the Patient Chart, from the File menu, click 
Change Provider to open the Select Provider dialog box. Select the correct provider, and then click OK. 

5. Click the IHS - Other procedure code category button to open the Select Procedure Code dialog box. 
Select the broken or canceled appointment code, and then click OK. 

6. Click Comp to complete the code. Te code and description are displayed in the progress notes, and the 
code will be sent to RPMS like any other completed code. 
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~ , ~ 
Proslho fi,ed I Oral Surgery I -

~~ (1)1 liJUIJ - Orthodontics I Adjunct Serv I ~ I ~ j,f(ER Conditions I IHS-Olher I r 
1"1 rttl/VJ 

l 
Other I 

[il l ~ I,~ ~ Tx II Comp 1 .. 1 

Clear II I 9340 ____, - -
Date Tooth Suri Proc Prov Clinic D escriotion Stal AP Amount v' III IO .. 

0512712015 9340 DESMIT AF Cancelled Am:iointment C 0.00 I P' TrealPlan r Completed r E,isling 
P' Conditions r E,ams 
r Proc. Noles r Clinic Noles 

~ 

-

\j.. Appointment Book <American Fork Dental Practice> <AF> < lJ1 
fi le Y'.iew Status 5etup Apptl,ist, Move to Pinboard !::!• 

l~@Hiil t l~ olalr=alITfill m I s l~lt:il le:il 1ml [Note I RVU Fee: 02 J RVU Goal Mon day - N over 

~•~J~ ArnP01 I 3:00pm : Abboll. James I 1~ -u~~~-~ 
:30 
:40 Appointment Information - (Abbott, James) - PRIVACY REQUESTS ~ 
:50 2:J Continuing 2:J ~ 4:00pm 
:10 Prov: jDESMITH Care I » Change Pal I I 
:20 ENCtt 11052313 

Attached: 

:30 2.:1 - 17 Use Reason To Auto Update CC E atient Info 11 
:40 Reason 

Qther Appt(s) :50 - !nitial I T< ? Resin-1 surface, poster tt13 0 Delete I 
Ins (;laim Info 

~ Del.All I 
Misc. I Schd. Ne~I 

D~sc: jRes1PosPrU13 
\',! ait/Will Call 

Len,gth: 12D min 2:J ,2tatus: l<none> ..:J Op:jAF-OP01 2.:1 £ind 

Amo~nt: 1190.00 Schedule: I FIXED ..:J Q_ate: 11112712017 2.:1 Pin,6_oard 

RVU: 12.00 T ~pe: I Gener al 3 lime: j 3:00pm 2.:1 History 

Slaff: I 2.:1 T, Request: I 2.:1 
OK 

Orig. Sched. Operatm: IDSMITH Date Sched .. I 1112712017 

·!:!ates Cancel 

I Insert Dateline I 
--------- ----- Mon - Nov 27,2017 ---------------death in family - out of town next week ... 
- left message on recorder on Saturday -AK 

r Chari Pulled 
T r LaleAppl 

I 

I r Main Concern? r Policy Holder Name? r Last Dental E :-:am? 

r If Pain. How Long? r Subs. SSU7 DOB? r Patient's DOB _Age? 
r Insurance Name? r Employer Name? Grpt r Referred 8y7 

7. Update the appointment note: 

8. Double-click a patient’s appointment to open the Appointment Information dialog box. 

9. Under Notes, click Insert Dateline, and then type the reason for the broken or canceled appointment. Be 
sure to add your initials at the end of the note. 

10. Also, as part of the note, type the number of times this appointment has been missed and the next date 
the patient is allowed to be seen. 

11. Click OK to save the note. Te information in the note will stay with this appointment, for your 
reference, when you reschedule the patient. 

12. Move the appointment to the Unscheduled List: 
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Break Appointment 

The appointment will no longer be displayed from the Appointment Lisi. 
It will be moved to the Unscheduled List. BREAK appointment? 

Reason: , , 

New Appointment Information - (Abbott, James) 

04/11 /2017 Prov: !DESMITH 

ENCtt 

'" .... I Continuing 
~ Ca,e 
_:j Attached: 

P" Use Reason To Auto Update CC 

OK 

2j 

Reason----------------------, 

~ Pc 

~ 
~ 
Desc: ProphyAd 

Prophylaxis-adult 

I Pnnth· ~ mit"J »I c;t.:1h1,;-· LnnnP> ~I no iAF-OP02 

Cancel 

Change Pat I 
Patient Info 11 
Other Appt(s) I 
Ins Claim Info I 

aitMillCall 

Finr! 

• Break the appointment – For no shows, last-minute cancelations with short notice, and patients 
arriving too late to be seen, use this method to move the appointment to the Unscheduled List. 

a. In the Appointment Book, select the appointment. 

b. From the File menu, click Break Appointment. 

Te Break Appointment dialog box appears. 

c. Select a Reason. 

d. Click OK. 

a 

b 

c 

d 

• Flag the appointment as “Wait/Will Call” – When a cancellation is made with advanced notice or 
you must reschedule the appointment, use this method to move the appointment to the Unscheduled 
List 

a. In the Appointment Book, double-click the appointment. 

Te Appointment Information dialog box appears. 

b. Click Wait/Will Call. 
a 

b

Note: Dentrix Enterprise moves the appointment from the Appointment Book window to the Unscheduled 
List and updates the last missed appointment information in the Family File to refect the date the patient 
broke the appointment and the number of times the patient has broken appointments. 
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Family Appointment list 

G ua, Abbott, Patricia 

Child Smith. Timothy 

IN o Appointment] 
IN o Appointment] 

II 

49 CC: PROPHY 0512212002 
I ••1• 

8 CC: PROPHY 05/08/2002 

CC:"Lab· 
CC: PRO 

~2212002 
0312009 

Treatment Plan 

04/1212002 D 7110 Extraction-single tooth 
1211512008 D7140 Extract.erupted th/exposed rt 
01109/2009 D5213 Maxil partial-metal Base Wlsdls 
01 10912009 D 621 0 Pontic-cast high noble metal 

ViewAppt. Create New Appt. I 

Clinic Continuing Care 

31 
1 
12"14 
19 

Close 

30min 
10min 
40min 
10min 

□ 

.OU 

:50 
1:00pm 

:10 
:20 
:30 
:40 0 

Rescheduling Broken or Canceled 
Appointments 
To help keep missed or canceled appointments from falling through the cracks, Dentrix Enterprise stores 
appointments that have been broken and appointments that have been fagged as Wait/Will Call on the 
Unscheduled List. You can use the Unscheduled List to fll gaps in your schedule to avoid missing out on 
valuable production. Also, if you contact a patient, or if a patient contacts you, to reschedule a broken or 
canceled appointment, you can quickly reschedule it from the Unscheduled List without having to re-enter 
the main details of that appointment. 

Tip: If you attempt to schedule an appointment for a patient who has an appointment on the Unscheduled 
List, Dentrix Enterprise will ask if you want to view a list of that patient’s appointments, which will include 
the unscheduled appointment. You can then reschedule that appointment without having to create a whole 
new appointment from scratch. However, if you don’t take care of the unscheduled appointment, you will 
continue to receive messages that the patient has unscheduled appointments, and the Unscheduled List will 
have an appointment for treatment that may have already been scheduled or even performed. And, if the 
patient is contacted about rescheduling that treatment, it can make your ofce or the staf member doing the 
contacting seem somewhat unprofessional. 

To reschedule a broken or canceled appointment 

• When attempting to schedule an appointment (from the Family Appointment List) 

1. In the Appointment Book, double-click an open time slot. 

Te Select Patient dialog box appears. 

2. Search for the desired patient, and then double-click the patient name 
in the list of matches. If the patient has an unscheduled appointment, 

1

a message appears. To view the appointment list for the patient and 
other family members, click Yes. 

Te Family Appointment List dialog box appears. 

3 

4 

3. Select an unscheduled appointment (with “<Unscheduled Appt>” instead of a date and time) in the 
middle list box. 

4. Click View Appt. 
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New Appointment Information - (Abbott, James) 

Prov: !DESMITH 

ENCtt 

"" I Continuing 
...::.::J Care 

21 Attached: 
0411112017 

17 Use Reason To Auto Update CC 

21 
Reason---------------------~ 

~ Pc P1oph_ylaxis-adult 

~ 
~ 
D esc: Proph)¢>.d 

Length: 16D min 22.J 
Amount: 1165.00 

Status: I <none> ..:.J Op: IAF-OP02 21 
Schedule: ~IF-IX_E_D ___ ..:.J~ Dale: 11112212017 21 

RVU: 12.00 Type: I Gener al ..:.J Time: I 2: 30pm 21 
~----

Stall: ..2.:.J TxRequest: 2j 
Orig. Sched. Operator: IDSMITH Dale Sched.. 11112212017 

NiltP~ 

12) Unsch~ ul~ List < Clinic ALL> 

View Appt Refresh Office Journal 

Change Pat I 
Patient Info 11 
Other Appl( s I I 
Ins Claim Info I 
Schd. Ne,t I 

Wail/V,/ill Call I 
Find 

Pin Board 

History 

OK 

Cancel 

DESMITH Wed - Nov 22,2017 

Date I Timezone I Status I Name I Prov/ Op J Clinic 

10/22/2003 UTC -06:00 [MDT] Broken Baber, Kirk D DESMITH AF 
10/22/2003 UTC -06:00 [MDT] Broken Robinson, Harry C DESMITH AF 
11/14/ 2003 UTC -07:00 [MST] W/ Call A Patricia DESMITH AF 
12/17/2003 UTC -07:00 [MST] W/ Call ' DESMITH AF 

~w1&w : . i•ll➔SIII# 
05/25/2015 UTC -06:00 [MDT] Broken mes DESMITH AF 
11/08/2017 UTC -07:00 [MST] Broken s, Carl DESMITH AF 
11/09/2017 UTC -07:00 [MST] W/ Call Crosby, Brent DESMITH AF 
11/21/2017 UTC -07:00 [MST] W/ Call Wi nters, Carl DESMITH CENTRAL 
11/21/ 2017 UTC -07:00 [MST] W/ Call Wi nters, Carl DESMITH CENTRAL 

I Reason I Ln I Phone 

consult fo r new b . 40 585-3776 
Com pr Exa, 4BWX 40 (619)474-5581 
Try In, Waxbite 30 (619)474-6755 
Periodic)(, 4BWX 60 656-4410 
js§j@ DlftiliiJb\.i3Fi 
Waxbite 20 (801)555-6320 
UnspcAdjP 10 
PROPHY 40 
ExtSinqTh#3 30 
ExtSinqTh#3 30 

McClureAngel, • 
S mith,D ennis D 
B rown,M ary D 

f7 View All 

GJ[§J~ 

I Break Rea son I · 

IMil,i.i 

t In-Office Can cellation 
In-Office Can cellation 

. 

Te Appointment Information dialog box for the selected appointment appears. 

5 

5. Click Pin Board to move the appointment to the Pinboard. 

6. Drag the appointment to the desired date, time, and operatory on the schedule. 

6 

• From the Unscheduled List 

1. In the Appointment Book, from the Appt Lists menu, point 
to Unscheduled List, and then click either Current Clinic (to 
view appointments for the clinic currently being viewed) or All 
Clinics (to view appointments for all clinics). 

Te Unscheduled List View dialog box appears. 

2. To flter the list by provider, select the desired providers; 
otherwise leave View All selected to not flter the list by provider. Ten, 
click OK. 

Te Unscheduled List window appears. 

1 

2 

3 

3. Double-click an appointment. 
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New Appointment Information - (Abbott, James) 

Prov: !DESMITH 

ENCtt 

...... I Continuing 
~ Care 
d Allached: 

04/11 /2017 

P' Use Rea son To Auto Update CC 
Reason----------------------~ 

~ Pc Prophylaxis-adult 

---2:.J 
~ 
D esc: Prophl"',d 

Length: ISO min 2:J 
Amount: I 1 65. 00 

Status: I <none> ..:J Op:jAF-OP02 d 
Schedule: ~I F-IX_E_D ---..:J~ Dale: j, 1 /2212017 d 

RVU : 12.00 Type:IGeneral ..:J Time: 12:30pm d 
~----

Stall: 2.:) TxRequest: ,2.d 
Orig. Sched. Operator: IDSMITH 

Nntr=-~ 

· ~660!1, Pat11c1a 

_ ~~~~~rs~:13 ... - ~larnll!l'1"erlm,; 
- oos,,,_ ____ _, 

Dale Sched.: 111 /2212017 

Change Pal I 
Patient Info 11 
Other Appl( s I I 
Ins Claim Info I 

Schd. Ne,t 

Wait/Will Call I 
Find 

Pin Board 

Histor.11 

OK 

Cancel 

Te Appointment Information dialog box for that appointment appears. 

4 

4. Click Pin Board to move the appointment to the Pinboard. 

5. Drag the appointment to the desired date, time, and operatory on the schedule. 

5 

Deleting Appointments 
You can permanently delete an appointment from the Appointment Book. Te only time you should 
delete an appointment for patient of record is if you scheduled the appointment for the wrong patient or 
the appointment should not have been scheduled in the frst place. Te only time you should delete an 
appointment for a new patient is when that patient will not be coming to your ofce at all. 

To delete an appointment 

1. In the Appointment Book, select the appointment you want to delete. 

2. From the File menu, click Delete Appointment. On the confrmation message that appears, click Yes. 
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Edit Event 

Start: llll!I!ffl 2:J End 15: OOpm 2:J 
r Close Operatory (All Day Event) 

Event Da_ys-------------~ 

Start:1 □4116/2013 2:J End: 1 □411612013 2:J 
Select Days of the Week--------~ 

r Sun. r Mon. r,;' Tues. r Wed. 

r Thurs. r Fri. r Sal. Clear All 

Description: 

Event 

Event 

N□o~ holi 
empl 

~ 
Operatories 

OP1 

r All 

iE:::::::-7 
~ r Center Description on Scheduled Event 

Notes-----------------------~ 

Insert Dateline I~ 

NOTE: If multiple operatories and/or da_ys are specified for the Event, separate Events 
(one per da_y per operator.vl will be created/displayed in the Appointment Book. The 
Event creation process may take sever al minutes depending on the criteria specified. 

Delete OK Cancel 

Managing Events 
WithDentrix Enterprise, you can not only schedule events, but you can quickly perform other event-related 
tasks. Tis section will explain the following tasks: 

• Rescheduling Events Using the Pin Board 

• Editing Events 

• Deleting Events 

Rescheduling Events Using the Pin Board 
You can drag a partial-day or all-day event to the pin 
board as a means to reschedule the event. A copy of the 
event will appear as an event icon on the pin board. To 
reschedule that pin board event, drag the icon to the 
desired date, time, and operatory. 

Editing Events 
You can edit an event’s details as needed. If the event is part of a series (an event that repeats at regular 
intervals), only the occurrence you are editing is afected. 

To edit an event 

1. In the Appointment Book, double-click the event you want to edit. 

Te Edit Event dialog box appears. 

2. Edit the various event options as needed. For 
information on setting up event options, see 
“Scheduling Events” in this chapter. 

3. Click OK. 

2 

3 

1 
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r Center Description on Scheduled Event 

Notes-----------------------~ 
Insert Dateline I ~ 

NOTE: If multiple operatories and/or da_ys are specified for the Event, separate Events 
(one per da_y per operator_y) will be created/displa_yed in the Appointment Book. The 
Event creation process ma_y take sever al minutes depending on the criteria specified. 

Delete OK Cancel 

Deleting Events 
You can delete a single event or an event that is part of a series. You cannot delete a whole series of events at 
one time; you must delete each occurrence separately. 

To delete an event 

1. 

Te Edit Event dialog box appears. 

2. Click Delete. On the confrmation message that appears, click Yes. 

In the Appointment Book, double-click the event you want to delete. 
1 

2
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11 ~n 

Select View ~ 
Select 

Provider( s I 

~ 
Line 1: r Print Appl Colors 

Line 2: (Appt Reason ..:.l r Print Day Note 

r Print Perlect Day 
Select Line 3: I Phone ..:.l r Print Time at Right Op(s) 

..:J Time View 

I 
Line 4: I Provider 

Start Hr: [s" 
Line 5: !Amount ..:.l C.- am r pm 

..:.l 
End Hr: 15"" Line 6: !Appl Type 

r am r, pm Date 

10411612013 ..:.:J Line 7: ! stall ..:J Save Print View 

Line 8: (work Phone ..:.l Load Print View 

Line 9: I Pref. Name ..:J 

Print I I Batch Cancel 

Generating Appointment Book 
Reports 
Tere are two reports that can be printed directly from the Appointment Book: 

• Appointment Book View Report 

• Route slip 

Appointment Book View Report 
Te Appointment Book View Report shows your daily schedule. 

To print the Appointment Book View Report 

1. In the Appointment Book, from the File menu, click Print 
Appointment Book View. 

Te Select View dialog box appears. 

Notes: 

1 

2 

• Te current view in the Appointment Book 
determines the default settings for the report. 

• If you have print settings saved on this computer, 
you can click Load Print View to apply those 
saved settings. 

• Saved print settings do not include provider or 
operatory selections. 

2. Change any of the following options as needed: 

• Select Provider(s) – Select up to 10 providers to 
include on the report. 

• Select Op(s) – Select up to 10 operatories to 
include on the report. 

4 

• Date – By default, the current date is used as the date for which the schedule will be printed, but you 
can type a new date in the Date feld or click the search button to select a date. 

• Appointment Display Info – Depending on the length of an appointment, up to nine lines of 
information can be displayed on the face of an appointment. For each Line, select the information 
you want to have displayed on that line, or select [None] to leave that line blank. 

• View Options – Select any of the following: 

• Print Amount – To print the scheduled production amount for the day, week, or month. 

• Print Appt Colors – To print in color if you are using a color printer instead of in grayscale. 

• Print Day Note – To print the Appointment Book day note for the date being printed. 

• Print Perfect Day – To print the perfect Day Scheduling time blocks. 

• Print Time at Right – To include the time bar on the right side of the appointments in addition 
to the time bar along the left side. 

• Time View – Type the earliest hour of appointments that you want to print in the Start Hr feld. 
Type the latest hour of appointments that you want to print in the End Hr feld. Click am or pm 
for both felds. 

3 
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3. If you want to save the current settings, except for the provider and operatory selections, for the next time 
you print the Appointment Book View, click Save Print View. You can save only one set of print options 
per computer. 

4. Click Print to print the report to the default printer for the Ofce Manager, or click Batch to send the 
report to the Batch Processor in the Ofce Manager. 

Route slip 
Te route slip provides up-to-date, comprehensive information for a patient. You can use the route slip as a 
reminder of medical alerts, patient notes, collection information, and so forth for patients being seen that day. 

To print a single route slip for a patient 

1. In the Appointment Book, select an appointment. 

2. From the File menu, click Print Route Slip. 

Te Print Route Slip dialog box appears. 

3. Click Print to send the route slip to the default printer for the 
Ofce Manager, or click Batch to send the route slip to the Batch 
Processor in the Ofce Manager. 

Tip: To generate route slips for all scheduled patients, in the Ofce Manager, from 
the Reports menu, point to Lists, and then click Daily Appointment List. Set 
up the options, making sure the Patient Route Slips check box selected, and then 
click OK. For more information, see the “Daily Appointment List” topic in the 
Dentrix Enterprise Help. 

1 

2 

3 
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New Appointment Information - (Abbott James) 

Prov: !DESMITH 

ENCtt 

, , I Continuing 
...::.:::.I Care 
~ Attached: 

0411112017 

P' Use Reason To Auto Update CC 
Reason---------------------~ 

~ Pc Proph_ylaxis-adult 

~ 
~ 

Status: I < none> ..:.l 0 p: IAF-0 P02 

Desc: IProphJl".d 

Length: l60 min ..22,] 
Amount: 1165.00 ..:.l Schedule: ~I F-IX_E_D __ _ Date: I 1112212011 

RVU : 1200 T_ype: I General 
~----

Stall: ~ 
Orig. Sched. Operator: IDSMITH 

r N.o.le·,······· Wed· Nov 22,2017 ·· 

patient is sensistiv~ 

..:.l Time: 12:30pm 

T, Request: 

Dale Sched.: 1112212017 

Insert Dateline ) 

Change Pat I 
Patient Info 11 
Other Appl(sl 

Ins Claim Info 

Schd. Ne,t 

Wail/Will Call 

Find 

Pin Board 

Histor_y 

OK 

Working with Notes in the 
Appointment Book 
You can attach important information directly to an appointment or date. Tis section covers the following 
topics on Appointment Book notes: 

• Adding Appointment Notes 

• Adding Appointment Book Day Notes 

Adding Appointment Notes 
Appointment notes are attached directly to an appointment and usually reference special situations the ofce 
should be aware of before a patient is seen. 

To add an appointment note 

1. In the Appointment Book, double-click an appointment. 

Te Appointment Information dialog box appears. 

1 

2. Type a new note or change an existing 
note in the Notes feld. Click Insert 
Dateline to date stamp the note. 

Tip: To insert a blank line or start a new 
line, while pressing the Ctrl key, press 
the Enter key. 

3. Click OK. 

Te appointment now as a blue 
musical note in the upper-right corner, 
indicating that the appointment has a 
note. 3 

2 
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Appointm ent Book Note - Monday - Ap ril 22,2013 

Reorder supplie~ 

Note 0 

Clear OK Cancel 

Adding Appointment Book Day Notes 
An Appointment Book day note can be created for each day of the year and is generally used as a reminder 
for a specifc date (for example, to order supplies, to call a school about a hygiene class, or to attend a dental 
society meeting). 

To add an Appointment Book day note 

1. In the Appointment Book, click the Note icon located in the upper-left corner 
of the schedule. 

Te Appointment Book Note dialog box appears. 

2. Type a note or reminder for the day. 

3. Click OK. 

Te Note icon is now has a yellow background, 
indicating that the day has a note. 

1 

2 

3 
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Using Perfect Day Scheduling 
Many practice management consultants advocate a strategy of scheduling a day that consists of just the right 
balance of high production, medium production, and low production procedures. Dentrix Enterprise helps 
you achieve that perfect balance by allowing you to reserve certain times during the day by blocking those 
times for the scheduling of specifc procedure types (for example, crowns or exams). 

Tis section covers the following topics about setting up and using Perfect Day Scheduling: 

• Customizing Appointment Types 

• Customizing Procedure Codes 

• Setting Up Perfect Day Scheduling Time Blocks 

• Activating Perfect Day Scheduling 

• Finding an Available Time Block 

Customizing Appointment Types 
Te initial installation of Dentrix Enterprise includes four appointment types: General, High Production, 
Medium Production, Low Production. If necessary, you can delete or change these type and add more (up to 
a total of 10) in Practice Defnitions. For information about setting up appointment types, see the “Practice 
Defnitions” and “Customizing Appointment Types” topics in the Dentrix Enterprise Help. 
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Procedure Code ~up 

ADA-CDT Codes I Dental Diagnostic Codes } AMA-CPT Codes I 1CD ·9CM Diagnostic Codes 

Procedure Code Editor - Existing 

Description: !Prophylaxis-adult 

Patient Friendly Description 

Cleaning of adult's teeth to help prevent disease 

Code Names Treatment Flags 
r D illicult Proc. ADA Code r Condition 

Abbrev Desc r Remove Tooth 

17 Show in Chart 
CPT 

Medicaid 
[ Auto Continuing Care 

PRO PHY ~ I 
Code 5 [ Procedure Timed] 

5 Unit(s) ~ 

Procedure Category:( Preventive ..:.l 
Appointment Type: Low Production 

Treatment Area: IM outh 

Paint Type:hNone) 

Educational ~ideo 

Edit Note New Code Ne,t Code 

ADA 

D1120 
D1201 
D1203 
D1204 
D1205 
D1206 
D1310 
D1320 
D1330 
D1351 
D1352 

Fee Schedule I RVU Schedule I 
r 

I 

2. PULLEM 
3. DONTIST 
4. DMO 
5. FEE 5 
6. BSolPA 
7. DELTA 
8. UPto999 
9. 

10. 
11 . 
12. 
13. 
14. 
15. 
16. 

xpenses 
Lab Materials 

~ ~ 
r Flag for Medical Cross Coding 
r Do Not Bill to Dental Insurance 

r Do Not Send Over HL7 
r Require Start/Completion Dates 

r Implantable Device 
r E claims: Require Attachment 

I Close ! 

User Code 

Edit Fee I 
: II 

44.00 
40.00 
38.00 
3700 
30.00 

0.00 
0.00 
000 
0.00 
0.00 
0.00 
0.00 
000 
0.00 

Desc1iption 

Prophylaxis-child 
Prophylaxis with fluor1 
Fluoride w/o prophyl, 
Fluoride w/o prophyl, 
Prophylaxis with fluor1 
Topical fluoride varni' 
N utrilional counseling 
Tobacco counseling 
Oral hygiene inslructi 
Sealant-per tooth 
Preventive Restoratio 

Edit 

~ 

□ 

Customizing Procedure Codes 
Each procedure code in Dentrix Enterprise can be assigned a default appointment type. Once a type has been 
properly designated for a procedure, Dentrix Enterprise automatically assigns the correct appointment type to 
any appointments scheduled using that procedure code. When you schedule an appointment in a Perfect Day 
Scheduling time block, Dentrix Enterprise verifes that the appointment’s type matches the type permitted for 
that reserved time block. 

To edit a procedure code 

1. In the Ofce Manager, from the Maintenance menu, point 
to Practice Setup, and then click Procedure Code Setup. 

Te Procedure Code Setup dialog box appears. 

2. Select a Procedure Code Category. All procedure 
codes associated with that category appear in the list 
box to the right. 

3. Select a procedure code, and then click Edit. 

Te Procedure Code Editor - Existing dialog box 
appears. 

4. Select an Appointment Type. 

5. Click Save. 

1 

4 

5 
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Provider Setup [AMCCLURE, MESA] 
Default Schedule 

r Sunday ..:.:I 
17 Monday ..:.:I 
17 Tuesday ..:.:I 
17 Wednesday ..:.:I 
17 Thursday ..:.:I 
17 Friday ..:.:I 
r Saturday ..:.:I 

IP,~ 
~ 

Slaff Mtg 

Block Settings 

Time Block Name: 

Week Days 

r Sunday 

r Monday 

17 Tuesday 

r Wednesday 

r Thursday 

r Friday 

r Saturday 

Add Provider I 
Close 

~ 

!staff Mtg I I 
Start End 

..:.:I ..:.:I 

..:.:I ..:.:I 
1:00pm ..:.:I 2:30pm ..:.:I 

.d _j 

..:.:I ..:.:I 

..:.:I ..:.:I 

.d ..:.:I 
Block Aeet T ~ee 

! <all> ..:.J 
Cancel I 

Setting Up Perfect Day Scheduling Time 
Blocks 
You can set up Perfect Day Scheduling time blocks for each provider. Each provider can have up to six time 
blocks. Also, be aware that each operatory can have up to 12 time blocks. 

Note: Te practical limit of time blocks between all providers in all clinics is 20; anymore than that can cause 
errors. 

To set up a time block 

1. In the Appointment Book, from the Setup menu, click Provider 
Setup. 

Te Provider Setup dialog box appears. 

2. Select a Clinic. 

3. Select the provider for which you want to set a time block. 

4. Click Setup. 

Te Provider Setup dialog box appears. 

1 

2 

3 4 

5. Under Set Time Blocks, click Add to add a 
new time block. 

Note: A provider can have up to six time blocks 
per clinic. 

5 

Te Block Settings dialog box appears. 

6. Set up the following options: 

• Time Block Name – Type a short 
description of the block’s purpose (for 
example, “Crowns” or “Exams”). 8 
Note: Te name must be diferent than any 
other time blocks for this provider in the 
selected clinic only. 

• Color – Click the color button to the right of the Time 
Block Name feld to choose a color to represent the time 
block. 

• Week Days – Select the days of the week for which you want 
to set the time block. Ten, for each selected day, click the 
Start and End search buttons to set the time range. 

Note: A given time block can occur only once per day. 

• Assigned Op – Select the operatory where the types of 
procedures for this time block are performed. 

• Block Appt Type – Select the appointment type you want to 
assign to this time block. 

7. Click OK to return to the Provider Setup dialog box. 

8. Click OK. 

7 

6 
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Find N~ Appointment Time: 

Select Provider(s) 
AMCCLURE 
DRDBB 

Select Op.(s) 

17 Select All Ops 

Select Days Start Date 

r Sunda}' 10412312013 2.:1 
P Monda,Y r. Day(s) ~_3.12] 
P Tuesday < Week(s) 

P Wednesday 
< Month(s) ~~~ 

P Thu,sday Time Range 

P Friday 
Appt Length:~ 22.J 

r Saturday r Time Pattern Search 

Clear All I Start: ~..:.:l 
End: ~..:.:l 

P,oviders/operatories in-----~ 

r. View !Main 

r Clinic IMESA 

..:.l 
..:.l 

r No Duplicate Operatory Times 

Select Time Block 
r Search By Time Block 

r. Provider 

r Opertory 

Block Name Ope1atory 

r Sea,ch By Appl Type 

Appl Type: I High Production 

SearchNiew 

: 00 jRVU Goal _ 
AF-OP01 

~ 

Provider 

..:.l 

Activating Perfect Day Scheduling 
To display the Perfect Day Scheduling time blocks in the Appointment Book, you must activate Perfect Day 
Scheduling. If Perfect Day has not been activated, the defned time blocks do not appear in the Appointment 
Book, and no warning will appear if anyone tries to schedule appointments during reserved time blocks. 

To activate Perfect Day Scheduling 

From the File menu, click Perfect Day Scheduling. If the Perfect Day Scheduling menu option has a check 
mark next to it, the feature is already activated. 

Once Perfect Day Scheduling has been activated, Dentrix Enterprise will display the defned provider time 
blocks in the Appointment Book. When you schedule an appointment in a defned time block, Dentrix 
Enterprise will check both the provider and the appointment type to verify that the provider and appointment 
type match what is allowed for that time block. If either the provider or the appointment type do not 
match, a warning message appears and asks if you want to override the time block setting and schedule the 
appointment. 

To move a time block 

Individual time blocks can be moved within their respective operatory by dragging the time block to the 
desired time. 

To resize a time block 

You can increase or decrease the size of the time block by clicking the bottom border of the time block and 
dragging up or down. 

Finding an Available Time Block 
You can locate the frst available blocked time for the type of appointment you are scheduling. 

To fnd the frst available time block 

1. In the Appointment Book, from the File menu, click Find New 
Appointment Time. 

Te Find New Appointment Time dialog box appears. 

2. Set up your search criteria as 
explained in “Using the Find 
Appointment Tool” in this 
chapter. If you have Perfect Day 
Scheduling time blocks set up, 
select Search By Time Block, 
and then select the desired time 
block; or, select Search By Appt 
Type, and then select the desired 
Appt Type. 

3. Click Search/View to see the 
available times for scheduling 
the appointment. 

For information on previewing and 

1 

2 

3 
scheduling appointments using the 
Find Appointment Tool, see “Using 
the Find Appointment Tool” in this chapter. 
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Chapter 4: Patient Chart 
Te Dentrix Enterprise Patient Chart can be used for entering and maintaining clinical records for your 
patients. Its complete chair-side integration makes it the perfect tool to simplify record keeping while giving 
you opportunity to take advantage of the newest technical innovations in dentistry. Te Patient Chart module 
consists of the following: 

• Patient Chart – Te Patient Chart provides a quick and easy way to enter existing, recommended, and 
completed treatment or conditions. Dentrix Enterprise uses standard, easy-to-recognize textbook charting 
symbols. Treatment is color coded so that with a single glance at the patient’s graphic chart, you can tell 
whether a procedure is a condition, existing, treatment-planned, or completed. 

• Clinical notes – You can use clinical notes to document and track patient care. Tese notes can be 
attached to a patient as a clinical record. Dentrix Enterprise provides several template options (including 
customizable templates) to help make entering notes a simple process. 

• Treatment Planner – You can use the Treatment Planner to help explain and demonstrate proposed 
treatment to patients. Te Treatment Planner can be opened from the Patient Chart and the Ledger. For 
more information about the Treatment Planner, see Chapter 6: Treatment Planner. 

• Perio Chart – Using customizable script settings, you can enter periodontal treatment information 
quickly and completely in the Perio Chart. Information can be displayed graphically in the Perio Chart, 
making it possible for patients to visually understand perio data. Te Perio Chart also provides a variety 
of letters for you to generate correspondence quickly for patients, referring dentists, and insurance 
consultants. For more information about the Perio Chart, see Chapter 5: Perio Chart. 

Tis chapter covers the following topics: 

• Te Patient Chart Window • Changing the Displayed Dentition 

• Setting Up Procedure Buttons • Setting the Default Dentition 

• Clearing the Patient Chart • Entering Chart Notes 

• Changing the Provider for a Charting Session • Working with Clinical Notes 

• Entering Treatment • Completing Oral Health Status Surveys 

• Editing Treatment • OHSS – Electronic Screening Form and Report 

• Deleting Treatment • Printing from the Patient Chart 

• Invalidating Procedures in History 
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Oentrix Chart- (Crosby, Brent) (AF] \UTC -07:CIO [MSTI] [) [CR0004CJ [11/11/1973 ] [45] 

16 
17 
30 MOD 
32 
15 MO 
15 MO 
14 
18 190.00 

APA 100.00 

Conditions Products 

Other 

Ex Treat Plan Complete 

C 

P' Treat Plan 
P' Completed 
r Existing 
r Conditions r Exams 
r Pree.Notes 
r Clinic Notes 
r Consent Forms 

The Patient Chart Window 
Te Patient Chart window consists of the menu bar, toolbar, graphical chart, procedure buttons, procedure 
code category buttons, status buttons, and progress notes. 

Procedure Buttons Procedure Code Category Buttons 

Graphical Chart 
Status Buttons 

Chart Notes 

Progress Notes 

Tis section covers the following topics to help you understand how to use the Patient Chart window: 

• Te Patient Chart Toolbar 

• Te Graphical Chart 

• Te Procedure Buttons 

• Te Procedure Code Category Buttons 

• Te Status Buttons 

• Te Chart Notes 

• Te Progress Notes Panel 
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The Patient Chart Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Patient Chart are explained in the following table. 
Click the DentriXlink button to open third-party software, such as a digital X-ray or imaging 
program, that has been installed and set up to work with Dentrix Enterprise. 
Click the Select Patient button to select a patient whose record you want to view in the Patient 
Chart. 

Click the Print Dental Chart button to print the patient chart for the selected patient. 

Click the Work Chart button to display the work chart view. 

Click the Full Screen Chart button to display the full screen chart view. 

Click the Progress Notes button to expand the Progress Notes panel to fll the Patient Chart 
window. 

Click the Treatment Planner button to open the Treatment Planner module. 

Click the Perio Chart button to open the Perio Chart module. 

Click the Clinical Notes button to display any clinical notes for the selected patient. 

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Patient Chart toolbar” 
topic in the Dentrix Enterprise Help. 
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The Graphical Chart 
Te graphical chart visually depicts the condition of the patient’s mouth. Treatment is shown on the chart 
using textbook charting symbols. In addition, treatment is color-coded to indicate the status of the treatment. 
For example, completed work can be displayed in blue while recommended treatment can be displayed in red. 

Permanent Primary 

In the graphical chart, you can select the teeth you want 
to post treatment to by clicking the appropriate teeth. 
Selected teeth have a dotted box around each one. 

Tip: To deselect teeth, click each tooth you want to 
deselect to remove the dotted box, or click Clear below 
the procedure buttons. 

The Procedure Buttons 
You can select the treatment to post with the procedure buttons. Te 24 procedure buttons 
collectively represent the most common procedures performed in an operatory. Each user-
defnable button can represent a single ADA Procedure Code, Dental Diagnostic Code, 
multi-code, or condition. 
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Diagnostic Preventive 

Restorative E ndodontics 

Periodontics Prosth, remov 

M axillo Prosth Implant S erv 

P,ostho, fixed Oral Surgery 

Orthodontics Adjunct S erv 

Conditions Misc. 

ED I Ex I Treat Plan Complete I + I 

Select Procedure Code 

Code Description 

0120 Per1od1c oral evaluation 
D0140 
D0150 
D0160 
D0170 
D0180 
D0210 
D0220 
D0230 
D0272 
D0274 
D0277 
D0290 
D0330 
D0350 
D0460 
D0470 

Limited oral evaluation 
Comp oral eval-new/estab pat 
Detail/extensive oral eval, BIR 
Limited ,e-evaluation estab pat 
Comprehensive perio evaluation 
lntraoral-complete series lbw) 
lntraoral-periapical-1 st film 
lntraoral-periapical-each add'I 
Bitewings-two films 
Bitewings-four films 
Vertical bitewings-7 to 8 films 
Skull &facial bone survey film 
Panoramic film 
Oral/Facial Photographic Images 
Pulp vitalit_y tests 
Diagnostic casts 

OK Cancel 

The Procedure Code Category Buttons 
You can select treatment to post from the procedure code category buttons. 

Each of the procedure code category buttons opens a Select Procedure Code dialog 
box that displays a list of specifc procedure codes 
for that category. For example, exam and X-ray 
codes are accessed from the Diagnostic category 
since those are diagnostic procedures. 

The Status Buttons 
Te status buttons and felds are used to specify the type of treatment being posted. Once posted, a treatment 
appears in the Progress Notes panel and is painted on the graphical chart (if a charting symbol is used in 
conjunction with the posted procedure) in the color assigned to that status. 

Te status buttons consist of the following options: 

• Existing Other – Te EO button is used when entering existing work performed by a provider outside of 
your practice. (Used almost exclusively when charting existing work for new patients). 

• Existing – Te Ex button is used when entering existing work performed by a provider within your 
practice. (Used almost exclusively when charting past work done by your ofce). 

• Treatment Plan – Te Treat Plan button is used to enter recommended treatment for a patient. 

• Completed – Te Complete button is used when entering completed work and conditions for a patient. 

• Auto-State – Tis button is used to quickly assign several procedures the same status. After clicking the 
Auto-State button, the next button selected will remain selected until another procedure status buttons is 
selected. While the auto-state is turned of, the button has a plus sign (+). While the auto-state is turned 
on, the button remains depressed and has a minus sign (-). 

Important: If you do not turn of the auto-state when you fnish charting for a patient, whatever status 
was selected will remain selected for the next patient’s charting. 

• Surfaces – Tis box shows the surfaces, if applicable, for the procedure being posted. You can type a 
surface(s) in the feld (multiple surfaces must be separated by commas). 

• Procedure Code – Tis box shows the procedure code being posted. You can type a procedure code in the 
feld. 

Tip: To clear the procedure code and treatment area(s) from the boxes and deselect any tooth/teeth that are 
selected on the graphical chart, click Clear below the procedure buttons. 



152     Chapter 4: Patient Chart 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

Toolh Surf Proc Prov Clinic D escriotion Slal AP Amount ~ ~11APJl1JIOI 11 /25/2003 D0150 TD1 AF Como oral eval-new/estab oat C 0.00 
11/25/2003 D0210 TD1 AF lntraoral-comolete series fbwl C 0.00 L f7 Treat Plan 
05/ 18/2006 D1110 TD1 ALPINE Prooh laxis-adult C 65.00 P" Completed 
05/18/2006 67 M 2336 TD1 CENTRAL Como Abrasion 1-Surface C 90.00 r Existing 
05/27/2015 D0272 DE SMIT AF B itewinns-two films TP 135.00 r Conditions 
05/27/2015 13 0 D2391 DE SMI T AF Resin-1 surface, ooster TP 190.00 r Exams 
09/18/201 7 D7295 DE SMIT AF Bone Harvest for Graftinn C 200.00 r Proc. Notes r Clinic Notes r Consent Forms 

~ 

~IIAPjlrt [IO 
[00 

P' Treat Plan [Q] P' Completed 
r Existing r Conditions 
r Exams r Proc. N ates r Clinic Notes 
r Consent Forms 

The Chart Notes 
Te Chart Notes box can contain general notes regarding a patient’s clinical chart. Te notes will always be 
visible to anyone who opens the patient’s Chart. 

The Progress Notes Panel 
Progress notes centralize documentation and exam information to help you quickly review a patient’s history. 
If you are viewing the work chart view, the Progress Notes panel is located below the graphical chart. Progress 
notes are displayed in chronological order. 

Each time a procedure, exam, condition, treatment plan, referral, or clinical note is posted in the Patient 
Chart, Dentrix Enterprise adds a line to the progress notes. For each item recorded in the progress notes, 
you will see the date the treatment was entered, treatment areas (if applicable), the procedure code, provider, 
a description, treatment 
status, treatment approval 
status, and the dollar 
amount associated with that 
procedure. 

Notes: 

• If a procedure has a note attached to it, a double arrow (>>) is visible to the right of the description. 

• If a procedures has a referral attached to it, an “R” is added to the beginning of the treatment status. 

You can use the controls on the Progress Notes panel to work with the items in the progress notes. Te 
following table explains each control. 

Click the Set Complete button to mark the selected treatment-planned 
procedures as completed. 

Click the Delete button to remove the selected treatment-planned or existing 
procedures from the Patient Chart. 

Click the Print Progress Notes with Chart button to print the progress notes 
and graphical chart currently being viewed. 

Select the check boxes that correspond to what you want to have show in the progress 
notes: treatment-planned procedures, completed procedures, existing and existing other 
work, conditions, perio exams, procedures notes, clinical notes, and/or consent forms. 

Note: Te next time the Patient Chart is opened, those same options will be used as the 
default view settings. Each computer on your ofce network can have diferent settings, 
and each Dentrix Enterprise user can have diferent settings on any given computer. 

Setting Up Procedure Buttons 
Dentrix Enterprise provides you with 24 procedure buttons that can be used to quickly post procedures in the 
Patient Chart. Tis section covers the following topics about customizing the procedure buttons: 

• Selecting Your Procedure Button Set 

• Creating Your own Custom Procedure Button Set 
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Selecting Your Procedure Button Set 
Each user can choose which procedure button template to use as the default button set in the Patient Chart, 
unless a specifc template has been set as the default for all users. 

To select your procedure button set 

1. In the Patient Chart, from the File menu, click Setup Procedure Buttons. 

Te Chart Button Template dialog box appears. 1 

2. From the Select Template list, select a template. 

3. Click OK. 

2 

3 
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Creating Your own Custom Procedure 
Button Set 
In the Patient Chart, each user can create a custom procedure button set from an existing template or the 
Dentrix Default template, unless a specifc template has been set as the default for all users. 

Note: If you edit an existing procedure button template from the Patient Chart, when you save the changes, 
that button set becomes your Custom template, overwriting any customizations you might have made 
previously to the Custom template. Te original source template, which was set up from the Ofce Manager, 
is not afected. 

To create your custom procedure button set 

1. In the Patient Chart, from the File menu, click Setup Procedure Buttons. 

Te Chart Button Template dialog box appears. 

2. From the Select Template list, select a template or Custom. 

3. For each button that you want to customize, do the following: 

a. Click the button, such as . 

Te Edit Procedure Button Setup dialog box 
appears. 

1 

2 

3 

4 

b. Under Select Code, select one of the following options: 

• Procedure – To assign a procedure code to the button. Ten, either type the desired procedure 
code (ADA, administrative, condition, or product code) or multi-code, or click the search button 

 to select the desired code. 

• Dental Diagnostic – To assign a dental diagnostic code to the button. Ten, either type the 
desired dental diagnostic code, or click the search button  to select the desired code. 

Notes: 

• Dentrix Enterprise uses a smart-code feature. When you are charting a procedure code, 
depending on the surfaces or roots selected, the procedure will be updated when it is posted. 
For example, if you chart a one-surface amalgam (D2140) but select three surfaces, Dentrix 
Enterprise will automatically post the three-surface amalgam (D2160). 
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• With the smart-code feature, Dentrix Enterprise not only updates procedure codes based on 
surfaces and roots when posting resins and amalgams but also updates them by tooth number. 
For example, if you use a one-surface anterior resin procedure button when posting a three-
surface resin to tooth 28, Dentrix Enterprise will update and post the procedure to refect three 
surfaces and the posterior tooth. 

• Because of the smart-code feature, you do not need to assign multiple variations of the same 
code, such as for amalgams or root canals, to your procedure buttons. 

c. If you position your pointer over a procedure button, a tooltip will appear with identifying text for 
that button. Under Select Tooltip Text, select one of the following options: 

• Use Procedure Description – To use the procedure or diagnostic code’s description in the 
tooltip. 

• Use Custom Text – To use custom text in the tooltip. Ten, type the desired description in the 
feld provided. 

d. Under Select Button Face, select one of the following options: 

• Use Image – To use a pre-defned graphic to identify the button. Ten, from the button menu, 
click one of the 65 charting symbols that represent procedure codes. 

• Use Code Text – To use the procedure or diagnostic code to identify the button. Ten, select the 
desired Font. 

Tip: For best results, use a 6-point Arial font. 

e. Click OK. 

4. In the Chart Button Template dialog box, click OK. 

Clearing the Patient Chart 
To protect the privacy of an individual patient, it may be wise to display a blank chart in your operatories 
while waiting for patients to arrive. 

To display a blank chart 

In the Patient Chart, from the File menu, click Clear Patient. 

No patient information is displayed in the Patient Chart until another patient is selected. 
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Changing the Provider for a Charting 
Session 
By default, Dentrix Enterprise assigns all treatment posted in the Patient Chart during a patient’s charting 
session according to the default chart provider setting in the Practice Defaults dialog box. However, you can 
select a diferent provider for the current charting session. All procedures posted during the current charting 
session will be assigned to the selected provider. Te next time a patient is selected, work will automatically 
return to the default chart provider. 

To change the provider for a charting session 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Change Provider. Te Select Provider dialog box appears. 1 

2. Select the provider to whom all work posted 
during this session should be assigned. 

3. Click OK. 

Note: You can change the provider for an 
individual procedure by editing it after it has been 
posted. 2 

3 

Entering Treatment 
Tis section covers the following topics on how to chart treatment in the Patient Chart: 

• Charting Treatment with Procedure Buttons 

• Charting Treatment with Procedure Code Category Buttons 

• Charting Treatment with the Auto-State Button 

• Charting Supernumerary Teeth 

• Charting Conditions and Existing Treatment 
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Charting Treatment with Procedure Buttons 
You can chart treatment, with the procedure buttons if the procedure (an ADA code, a condition, a Dental 
Diagnostic code, or a multi-code) for the treatment you want to enter is assigned to a procedure button. 
Procedure buttons are customizable and user specifc, so any procedures you use frequently are readily 
accessible at the click of a button. 

To chart treatment with a procedure button 

1. In the Patient Chart, with a patient selected, if the 
treatment you are entering requires a tooth number, 
select the appropriate tooth/teeth in the graphical 
chart. 

2. Click a procedure button. 

3. Do one of the following: 

• If the selected procedure requires the selection 
of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection 
dialog box appears. Select the applicable 
treatment areas, and then click OK. 

1 2 

4 

• If the selected procedure requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following: 

• If one tooth is selected: 

a. Select the applicable treatment areas. 

b. Click OK. 
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• If multiple teeth are selected: 

a. With the frst tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add. 

b. Do one of the following for the other teeth listed: 

• To apply the specifed surfaces to all the other 
teeth listed, click Apply to all teeth. On the 
confrmation message that appears, click either 
Yes to apply the surfaces to all the teeth listed 
(you can change the surfaces of any tooth as 
needed before you click OK) or No to apply the 
surfaces to only the selected tooth (you must 
then add surfaces to each tooth separately before 
you click OK). 

• To add surfaces to each tooth separately, select 
a diferent tooth in the list on the left, select the 
check boxes of the applicable surfaces, and then 
click Add. Repeat this process as needed for the 
other teeth listed. 

Notes: 

• You can also change the surfaces for any tooth in the 
list by selecting that tooth. 

• To continue, every tooth in the list must have at 
least one surface applied. 

c. Click OK. 

4. Click the applicable status button for the procedure being entered: 

• EO – Use when entering existing work performed by a provider outside of your practice. 

• Ex – Use when entering existing work performed by a provider within your practice. 

• Treat Plan – Use when entering recommended treatment for a patient. 

• Complete – Use when entering completed work and conditions for a patient. 

Te procedure is posted to the selected tooth/teeth. Te procedure is added to the graphical chart (if a 
charting symbol is used in conjunction with the posted procedure) and the progress notes. 

Note: All completed work posted in the Patient Chart is automatically posted to the Ledger, and 
the appropriate charges are listed on the patient’s account. Similarly, all treatment-planned work is 
automatically posted to the Ledger-Treatment Plan. 



Chapter 4: Patient Chart     159 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

          

 

Quadrant Selec.. X 

r UR r UL 

r LR r LL 

{CR0004C) {11/11/1973] (45] ~~ 
-Codes D,ntal Diagnostics Hdp 

~-~~-~1+1.101~IOOl<©'l~l»xll¥Jcralffi 

Sextant Selection X 

r s, r s2 r s3 

r ss r s5 r s4 

8 8 Diagnostic 

Restorative 

Arch Selection X 

Preventive 

Endodontics 

Code 

D0140 
D0150 
D0160 
D0170 
D0180 
D0210 
D0220 
D0230 
D0272 
D0274 
D0277 
D0290 
D0330 
D0350 
D0460 
D0470 

Description 

Limited oral evaluation 
Comp oral eval-new/ tab pat 
Detail/extensive oral val, 8/R 
Limited re-evaluatio estab pat 
Comprehensive pe o evaluation 
lnlraoral-complele eries (bw) 
I ntr aor al-periapic -1 st film 
lntraoral-periapi I-each add'I 
B itewings-two f' s 
B itewings-four lms 
Vertical bilew· gs-7 lo 8 films 
Skull &facial one survey film 
Panoramic f m 
0 r al/F acia holographic I mag es 
Pulp vitali tests 
D iagnost" casts 

OK Cancel 

Charting Treatment with Procedure Code 
Category Buttons 
You can chart treatment with procedure code category buttons if the procedure for the treatment you want to 
enter is not assigned to a procedure button but is assigned to a procedure code category button. 

To chart treatment with a procedure code category button 

1. In the Patient Chart, with a patient selected, if the treatment you are entering requires a tooth number, 
select the appropriate tooth/teeth in the graphical chart. 

2. To select a procedure, 
click a procedure 
code category button. 
Te Select Procedure 
Code dialog box 
appears. Select the 
desired procedure 
code, and then click 
OK. 

Note: Procedures 
are only available on 
the Procedure Code 
Categories panel if 
those procedures have 

Procedure Codes” in Chapter 1: Introduction and Initial Setup. 

3. Do one of the following: 

• If the selected procedure requires the selection of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable treatment 
areas, and then click OK. 

been assigned to a procedure code category other than “None” and set 
up to be shown in the Patient Chart from the Procedure Code Editor 
dialog box. For details about setting up procedure codes, see “Editing 

1 

4 

2 

• If the selected procedure requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following: 



160     Chapter 4: Patient Chart 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

r Mesial 

r I ncisal/O cclusal 

r Distal 
r Lingual 

r F acial/B uccal 
r Class Five 

Surfaces ~ 

r lncisal/Occlusal 

r Distal 
r Lingual 

r F acial/B uccal 
r Class Five 

Su,faces ~ 

Apply to all teeth j 

~ I Cancel ! 

Surface Selection X 

I 
Tooth 19: OD, 

r Mesial 

r lncisal/Occlusal 

r Distal 
r Lingual 
r F acial/B uccal 
r Class Five 

Surfaces ~ 
loo, 
I Apply to all teeth 

~ Cancel I 
Surface Selection X 

Tooth 18: M, r Mesial 

r lncisal/Occlusal 

r Distal 
r Lingual 

r F acial/B uccal 
r Class Five 

Surfaces ~ 
loo, 

Apply to all teeth j 

~ Cancel I 

• If one tooth is selected: 

a. Select the applicable treatment areas. 

b. Click OK. 

• If multiple teeth are selected: 

a. With the frst tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add. 

b. Do one of the following for the other teeth listed: 

• To apply the specifed surfaces to all the other 
teeth listed, click Apply to all teeth. On the 
confrmation message that appears, click either 
Yes to apply the surfaces to all the teeth listed 
(you can change the surfaces of any tooth as 
needed before you click OK) or No to apply the 
surfaces to only the selected tooth (you must 
then add surfaces to each tooth separately before 
you click OK). 

• To add surfaces to each tooth separately, select 
a diferent tooth in the list on the left, select the 
check boxes of the applicable surfaces, and then 
click Add. Repeat this process as needed for the 
other teeth listed. 

Notes: 

• You can also change the surfaces for any tooth in the 
list by selecting that tooth. 

• To continue, every tooth in the list must have at 
least one surface applied. 

c. Click OK. 
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4. Click the applicable status button for the procedure being entered: 

• EO – Use when entering existing work performed by a provider outside of your practice. 

• Ex – Use when entering existing work performed by a provider within your practice. 

• Treat Plan – Use when entering recommended treatment for a patient. 

• Complete – Use when entering completed work and conditions for a patient. 

Te procedure is posted to the selected tooth/teeth. Te procedure is added to the graphical chart (if a 
charting symbol is used in conjunction with the posted procedure) and the progress notes. 

Note: All completed work posted in the Patient Chart is automatically posted to the Ledger, and 
the appropriate charges are listed on the patient’s account. Similarly, all treatment-planned work is 
automatically posted to the Ledger-Treatment Plan. 

Charting Treatment with the Auto-State 
Button 
In most ofces, charting is entered in order by treatment status. For example, during a new patient exam, the 
treatment provider might frst chart existing work and conditions. Once existing work has been charted, the 
provider might then enter work that needs to be completed (treatment-planned). Finally, work completed that 
day will be entered. 

To make charting in this manner easier, Dentrix Enterprise provides the Auto-State button. To save you the 
extra step of entering the status for each procedure individually, the Auto-State button keeps the status button 
of the type of treatment you are charting selected and assigns that status to procedures entered. 

To chart treatment with the Auto-State button 

1. In the Patient Chart, with a patient selected, click 
the Auto-State button (+). 

2. Leave the Treat Plan button selected, or click the 
status button that corresponds to the type of work 
you want to chart: 

• EO – Use when entering existing work 
performed by a provider outside of your 
practice. 

• Ex – Use when entering existing work 
performed by a provider within your practice. 

• Treat Plan – Use when entering recommended 
treatment for a patient. 

3 4 

1 

• Complete – Use when entering completed 
work and conditions for a patient. 

Note: Te selected status button will remain selected until another 
procedure status buttons is selected. 

3. If the treatment you are entering requires a tooth number, select the 
OR

appropriate tooth/teeth in the graphical chart. 6 

2 

6 

4. Specify the desired treatment by using a procedure button (or a procedure 
code category button, the Procedures menu, or the Multi-codes menu). 
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5. Do one of the following: 

• If the selected procedure requires the selection of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable treatment 
areas, and then click OK. 

• If the selected procedure requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following: 

• If one tooth is selected: 

a. Select the applicable treatment areas. 

b. Click OK. 

• If multiple teeth are selected: 

a. With the frst tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add. 
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b. Do one of the following for the other teeth listed: 

• To apply the specifed surfaces to all the other 
teeth listed, click Apply to all teeth. On the 
confrmation message that appears, click either 
Yes to apply the surfaces to all the teeth listed 
(you can change the surfaces of any tooth as 
needed before you click OK) or No to apply the 
surfaces to only the selected tooth (you must 
then add surfaces to each tooth separately before 
you click OK). 

• To add surfaces to each tooth separately, select 
a diferent tooth in the list on the left, select the 
check boxes of the applicable surfaces, and then 
click Add. Repeat this process as needed for the 
other teeth listed. 

Notes: 

• You can also change the surfaces for any tooth in the 
list by selecting that tooth. 

• To continue, every tooth in the list must have at 
least one surface applied. 

c. Click OK. 

6. Once you have posted all work for the selected status, click a diferent status button to enter work for that 
status, or click the Auto-State button (-) to turn of auto-state for the status buttons. 

Charting Supernumerary Teeth 
Because it is not possible to select a supernumerary tooth in the graphical chart, it is necessary to post the 
procedure to the nearest tooth and then edit the posted procedure with the appropriate supernumerary tooth 
number, based on the following ADA recommendations: 

• Permanent Teeth – Add 50 to the tooth number nearest the supernumerary tooth (for example, 1 = 51, 2 
= 52, 3 = 53, and 32 = 82). 

• Primary Teeth – Add an “S” after the tooth letter nearest the supernumerary tooth (for example, A = AS, 
B = BS, C = CS, and T = TS). 
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Conditions Products 

Other 

T ,cal Plan I Complete ] -+ 

Charting Conditions and Existing Treatment 
Charting a condition, such as an open contact or missing tooth, helps to provide an accurate representation of 
the patient’s oral cavity in the graphical chart. For further accuracy, you can also chart existing treatment that 
was completed within or outside of your clinic network. 

To chart a condition or existing treatment 

1. In the Patient Chart, with a patient selected, if the 
condition or existing treatment you are entering 
requires a tooth number, select the appropriate 
tooth/teeth in the graphical chart. 

2. Do one of the following: 

• For existing treatment, specify it by using a 
procedure button (or a procedure code category 
button or the Procedures menu).

4

2 

OR 

1 2 

• For a condition, click the Conditions 
procedure code category button, and then 
double-click a condition. (Or, click Procedures 
on the menu bar, click the Conditions category, 
and then double-click a condition.) 

3. Do one of the following: 

• If the selected condition or procedure requires the selection of quadrants, sextants, or arches, the 
Quadrant Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable 
treatment areas, and then click OK. 

• If the selected condition or procedure requires the selection of surfaces, the Surface Selection dialog 
box appears. Do one of the following: 

• If one tooth is selected: 

a. Select the applicable treatment areas. 

b. Click OK. 

https://menu).42
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Surface Selection X 

Tooth 19: 
r Mesial 

r lncisal/Occlusal 

r Distal 
r Lingual 

r F acial/ 8 uccal 
r Class Five 

Surfaces ~ 

Apply lo all teeth I 
~ I Cancel I 

Surface Selection X 

I 
Tooth 19: OD, 

r Mesial 

r lncisal/Occlusal 

r Distal 
r Lingual 
r F acial/ 8 uccal 
r Class Five 

Surfaces ~ 
I□□-
I Apply lo all teeth 

~ Cancel I 
Surface Selection X 

Tooth 18: M, r Mesial 

r lncisal/Occlusal 

r Distal 
r Lingual 

r F acial/ 8 uccal 
r Class Five 

Su,faces ~ 
loo. 

Apply lo all teeth j 

~ Cancel j 

• If multiple teeth are selected: 

a. With the frst tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add. 

b. Do one of the following for the other teeth listed: 

• To apply the specifed surfaces to all the other 
teeth listed, click Apply to all teeth. On the 
confrmation message that appears, click either 
Yes to apply the surfaces to all the teeth listed 
(you can change the surfaces of any tooth as 
needed before you click OK) or No to apply the 
surfaces to only the selected tooth (you must 
then add surfaces to each tooth separately before 
you click OK). 

• To add surfaces to each tooth separately, select 
a diferent tooth in the list on the left, select the 
check boxes of the applicable surfaces, and then 
click Add. Repeat this process as needed for the 
other teeth listed. 

Notes: 

• You can also change the surfaces for any tooth in 
the list by selecting that tooth. 

• To continue, every tooth in the list must have at 
least one surface applied. 

c. Click OK. 

4. Click the desired status button for the procedure being entered: 

• EO – Use when entering existing work performed by a provider outside of your practice. 

• Ex – Use when entering existing work performed by a provider within your practice. 

Te condition or existing treatment is posted to the Patient Chart. Te procedure is added to the 
graphical chart (if a charting symbol is used in conjunction with the posted condition or existing 
treatment) and to the progress notes as a condition or as an existing treatment. 
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Edit or Delete Procedure 

Operator: I □ SMITH Encounter tt: 

Dale: liJ310712019 Start Dale: Completion Date: 

Procedure: 1D1110 ~ --ro-p-hy- la-,-is--a-d-ul-1 ------ Procedure Status 

r T realmenl Plan Clinic: 'IA_F ____ ~ 
Approval Status 

48.00 

2.00 

0 verride Ins. estimate 

r Prim. Ins r--­
r Sec. lns.r---

r Do Not Bill Dental Insurance 

I None ..:.J 
r. Completed 

r E xisting-Cunent Prov 

r Existing-Other Prov 

Provider: IDS MITH r Require Start/Completion Date Modifier: I 

Ciedits >> I 

r With Verification r Automatic r None 

eneral scaling with hand instruments. Ultrasonic scaler on lower anteriors•lingual. 
king soda used on upper and lower arch. Flossed all contacts. Patient rinsed 

with a medicated rinse after Px. 

Related Referral-------------------------~ 

Referred: 

IBY: Dr. Evans. Jell 
ID Number Type 

22.l Remove I nm ..:.l 
ID Number 

~ 

Editing Treatment 
After treatment has been entered into the Patient Chart, you can make changes to the procedure, as needed, 
as long as the procedure is not in history or attached to a claim. For an IHS-completed procedure, do not edit 
the procedure; delete it, and then re-enter it. 

To edit treatment 

1. In the Patient Chart, with a patient selected, 
from the Progress Notes panel, double-click 
the treatment item you want to change. 

Te Edit or Delete Procedure dialog box 
appears. 

2. Make any necessary changes: 

• Date – Type the correct date of the 
procedure. 

• Clinic – To change the clinic, click 
the search button to select the 
correct clinic. 

• Procedure – To change the 
procedure code, click the search 
button  to select the correct 
code. 

• Treatment area – To change 
the treatment area do one of the 
following: 

• For a tooth, type the correct 
Tooth number or letter (or 
supernumerary tooth number 
or letter). 

2 

• For a Surface, Quadrant, 
Arch, or Sextant, click the 
corresponding search button

3 

to select the correct area. 

• Amount – Type the correct amount charged for the procedure. 

• Provider – To change the provider attached to the procedure, click the search button to select the 
correct provider. 

• Notes – Make any necessary changes to the note, and specify the reason for the procedure needing to 
be changed (for auditing purposes) 

3. Click OK. 
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17 
30 MOD 
32 
15 MO 
15 MO 
14 
18 D 

Edit or Delete Procedure 

D1110 DESMIT AF 
D71 40 DESMIT AF 
D7140 DESMIT AF 
D71 40 DESMIT AF 
D2393 DESMIT AF 
071 40 DES MIT AF 
D2392 DESMIT CENTR 
15105 DES MIT CENTR 
D3110 DESMIT AF 
D2391 DES MIT AF 
2793 DSMITH CENTR 

Operator: I DSMITH Encounter tt 

Date: liJ3/07 /2019 Sta,t Date: Completion Date: 

P1ocedure: 1D1110 ..:.:J rl P-,o-p-hy-la-,i-,--ad_u_lt _____ _ 

Clinic: rlA_F ___ ..:.?.J 

Amount:j 48.00 

RVU I 2.00 

0 verride Ins. estimate 

r P,im.lns r----

r Sec. lns. r----

r Do Not Bill Dental Insurance 

Procedure Status 

(" Treatment Plan 
App1oval Status 

I None ..:J 
C:- Completed 

(" E xisting-Cu1rent P1ov 

r Existing-Other P,ov 

Modifier:j 

C: 

Related Referral------------------------

ID Number T}'pe ID Number 

2J Remove ! JIIIM ..:J 

Deleting Treatment 
You can delete completed, treatment-planned, or existing procedures that were posted incorrectly unless the 
procedure is in history or attached to a claim. You can also delete conditions. 

To delete a completed, treatment-planned, or existing procedure 

1. In the Patient Chart, with a patient selected, on 
the Progress Notes panel, double-click the 
completed, treatment-planned, or existing 
procedure you want to delete. 

Te Edit or Delete Procedure dialog box 
appears. 

2. Click Delete. On the confrmation 
message that appears, click OK. 

To delete treatment-planned or 
existing procedures 

1. In the Patient Chart, with a 
patient selected, 
on the Progress 
Notes panel, click 
the treatment-
planned or existing 
procedure you 
want to delete. 

1 

Tip: To select 
multiple 
procedures, while 
pressing the Ctrl 
key, click each procedure. 

2. Click the Delete button next 
to the progress notes. On the 
confrmation message that appears, click OK. 

2 

2 
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D714O DESMIT AF 
MOD D2393 DESMIT AF 

D71 4O DESMIT AF 
MO D2392 DESMIT CENTR 

Validate / Inva lidate Procedure in History 

C. Validate Procedure r Invalidate Procedure 

Operator: !ESME 

Date: ~I o-, -,o-9-12_0_0_0_ 

Clinic: ~ F 

Encounter :It: 

Procedure: ID6750 

Tooth:l5 

Amount: ! 

Rvu l 
Provider: IM HAYES 

Conditions: .2:J 
Diagnoses: .2:J 

Retainer crn-porc fused-hi nob 

Override Ins. estimate 

r Prim. Im r---
613.00 r Sec. Ins r---

0.00 Modifier: ) 

r Require Start/Completion Date 

Start Date: 

Completion Date: 

Procedure Status 

r Treatment Plan 
Approval Status 

I None ..:.J 
C. Completed 

r Existing-Current Prov 

r Esisting-Other Prov 

r Do Not Bill Dental Insurance 

.--------------------------
Notes: 

ID Number Type ID Number 

OK Cancel 

Invalidating Procedures in History 
Dentrix Enterprise saves your ofce from repetitive data entry by posting procedures to both the Ledger and 
Chart at the same time. However, a diferent standard regarding record keeping exists for each module. Te 
Ledger, as a fnancial record, uses generally accepted accounting principles (GAAP). In contrast, the Patient 
Chart is a clinical record of patient care. Ten, what do you do when you discover a posting error for 

a procedure in a month that has been closed out? Te procedure has been locked to prevent deletions and 
changes, which is good for a fnancial record, and you can simply enter an adjustment in the Ledger to correct 
the problem. However, the clinical record needs to accurately represent the actual care given, but you can’t 
delete or change the procedure or “adjust” the clinical record in the Chart. To solve this discrepancy, Dentrix 
Enterprise allows you to invalidate a procedure in history (in closed out months). Invalidating a procedure 
removes it from the Chart while leaving it in the Ledger. 

To invalidate a procedure 

1. In the Patient Chart, with a patient selected, on 
the Progress Notes panel, double-click a 
procedure in history. 

Te Validate/Invalidate Procedure in History 
dialog box appears. 

2. Under Validate/Invalidate Procedure, 
click Invalidate Procedure. 

3. Click OK. 2 
Te invalidated transaction is removed 
from the Patient Chart but left in the 
Ledger as a history transaction. In the 
Ledger, a plus sign (+) appears to the left of 
the transaction description to indicate that 
the transaction has been invalidated. 

Important: 

• Post an ofsetting adjustment equal to 
the amount of the procedure, as the 
account has already been billed for that 
procedure. 

• If needed, post the procedure again 
using the correct information. Be sure 
to change the date to refect the date 
the procedure was originally posted, 
and change the charge amount to zero 
because the account has already been 
billed for the procedure. 

3 



Chapter 4: Patient Chart     169 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

2:J 

I EO j Ex j Treat Plan Complete j + j 

Chart Notes 

This is a chart note for the patient. It is a general note that is 
visible in the patient's chart at all times and is not attached to a 
specific procedure. 

Amoun 
'l=iO 00 

Changing the Displayed Dentition 
Whether the patient you have in the chair has all primary teeth, all permanent teeth, or mixed dentition, you 
want your charting software to show a true representation of each patient’s mouth. To achieve this accuracy in 
a patient’s clinical record, the Dentrix Chart allows you to customize the dentition that appears on a patient-
by-patient basis. You can quickly switch between primary and permanent dentition for all teeth at once or for 
selected teeth. 

To change the dentition being displayed in the graphical chart 

1. In the Patient Chart, with a patient selected, if you are changing the dentition for certain teeth, select 
those teeth. If you are changing the dentition for all teeth, you do not have to select any teeth. 

2. From the Prim/Perm menu, click one of the following options: 

• Change All – Reverses the primary/permanent state for all teeth. For example, if all teeth have been 
changed to primary and the Change All option is clicked, all the teeth in the mouth will change to 
permanent. 

• Change Selected – Reverses the primary/permanent state for the selected teeth in the graphical chart. 

Setting the Default Dentition 
You can indicate whether you want the Patient Chart to open with primary or permanent dentition that is 
being displayed in the graphical chart for all patients by default. 

To set the default dentition 

In the Patient Chart, with a patient selected, from the Prim/Perm menu, click one of the following options 
(the option with the check mark is the default dentition currently being used): 

• Default to Permanent – Changes all the teeth in the graphical chart to permanent dentition. Also, every 
time you open the Patient Chart, the graphical chart will display all permanent teeth, even if you select a 
patient that does not have any permanent teeth or that has mixed dentition. 

• Default to Primary – Changes all the teeth in the graphical chart to primary dentition. Also, every time 
you open the Patient Chart, the graphical chart will display all primary teeth, even if you select a patient 
that does not have any primary teeth or that has mixed dentition. 

Ten, on a patient-by-patient basis, you can change the dentition as explained in “Changing the Displayed 
Dentition” on this page. 

Entering Chart Notes 
You can enter a general note regarding a patient’s clinical chart directly in that patient’s Chart while 
performing work on that patient. Te note will always be visible to anyone who opens that patient’s Chart. 

To enter a chart note 

With a patient selected in the Patient Chart, in the Chart 
Notes box, enter notes for the patient. 

Note: Alternatively, you can click the More button 
notes in the Edit Chart Notes dialog box that appears, and 
then click OK. 

, enter 
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Notes: 

1±1 03/25/2013 
El 01124/2012 

El Note#1 11 
Pg1 - 12 41 37 PM [DROBB] [CENTRAL] 

: Pg2 - 12:43:32 PM [DROBBJ [CENTRAL) 
1±1 Note#2 11 

1±1 11124/2011 

Patient experiences pa in but has 
UR quadrant. The pain seems to 
tooth 1. 

0 

Working with Clinical Notes 
Keeping accurate and thorough documentation of each procedure performed in the dental ofce is an essential 
part of clinical dentistry. In Dentrix Enterprise, you can enter a clinical note to store information about a 
patient’s exam and treatment that are not specifc to a procedure. 

Tip: You can access a patient’s clinical notes from not only the Patient Chart but the Ledger and Family File. 

Tis section covers the following topics about clinical notes: 

• Adding Clinical Notes • Adding an Addendum to a Clinical Note 

• Adding Clinical Notes Using Templates • Printing Clinical Notes 

• Editing Clinical Notes • Signing Clinical Notes 

Adding Clinical Notes 
Clinical notes are notes for a patient’s exam and/or treatment that are not specifc to a procedure. You can add 
notes by typing them from scratch. Once a clinical note has been signed or is in history, it cannot be edited or 
deleted. However, an addendum can be made to a clinical note in history. 

Notes: 

• A clinical note was automatically started when information was entered into a patient health assessment 
and/or a medical history review. 

• Te clinical notes are arranged by date, note number, and then page. You can have as many notes as you 
want, with a maximum of 10 pages per note. 

To add a clinical note 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

1 

Te Clinical Notes window appears. 

2. Do one of the following: 

• Click the New Clinical Note button . 

5 42 

Te Change Date and Time dialog box 
appears. Leave the current system date 
and time entered, or specify a diferent 
date and/or time; and then click OK. 

• If you want to add a page to an existing 
clinical note, expand the appropriate date 
and note in the left pane, and then click 
the New Clinical Note Page button . 
Te Change Time dialog box appears. 
Leave the current system time entered, or type a diferent time; and then click OK. 

3 

3. Type a note you want to attach to this patient regarding an exam or treatment given. 

4. To assign a diferent clinic than the clinic currently selected for the clinical note, click the Change Clinic 
for Selected Note button  to select the appropriate clinic. 

5. Click the Save Clinical Note button . 
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Notes: ~ §I 
El 04/16/2013 

B Note/11 [111 22333) 
Pg1 - 1 42 55 PM [AMCCLURE] [CENTR 

1±1-· 03/25/2013 
1±1 01/24/2012 
1±1 .. 11/24/2011 

"' 

Dydonine 
Bhocaine 
Lidocaine solution 
Lidocaine ointment 
Lidocaine spray 
O@qix 
Procaine 
T opicaine anesthetic gel 
T opex anesthetic gel 
T opex anesthetic spray 

~-O_K_~I I Cancel 

1±1 Administrative 

B Anesthetics 

Anesthetic, Spe 

Local Anesthetic, 

No Injection Given .. 

GJ Clinical Exams 

1±1 Endodontics 

1±1 Fixed Prosthetics 

1±1 Hygiene 

1±1 Medical Alerts 
1±1 Orthodontics 
1±1 Patient Complaint 
1±1 Pedodontics 
1±1 Periodontics 

1±1 Prescriptions 

1±1 Recommendations 

Adding Clinical Notes Using Templates 
Using a clinical note template as a guide, you can quickly and accurately document a patient’s visit with 
minimal typing or editing. Once a clinical note has been signed or is in history, it cannot be edited or deleted. 
However, an addendum can be made to a clinical note in history. 

To add a clinical note using a template 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

Te Clinical Notes window appears. 

1 

3 
4 

2 

5 

2. Do one of the following: 

• Click the New Clinical Note button . Te Change Date and Time dialog box appears. Leave the 
current system date and time entered, or specify a diferent date and/or time; and then click OK. 

• If you want to add a page to an existing clinical note, expand the appropriate date and note in the left 
pane, and then click the New Clinical Note Page button . Te Change Date and Time dialog 
box appears. Leave the current system time entered, or type a diferent time; and then click OK. 

Note: If a clinical note page is not selected when you choose a template, a new clinical note will be added. 
So, to add a template to an existing note, make sure the correct page of that clinical note is selected. 

3. In the template pane (on the right), expand a category to view the list of available templates for that 
category by clicking the plus sign (+) next to the category name, and then double-click the desired 
template. 

4. Respond to the prompts associated with the template, if applicable. 

Te template text and any responses you entered appear in the note feld (in the middle). 

Note: You can edit the note or add additional information as needed. 

5. Click the Save Clinical Note button . 

For more information about clinical note templates, see the “Creating clinical note templates,” “Creating 
clinical note prompts,” and “Setting up clinical note template categories” topics in the Dentrix Enterprise 
Help. 
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Pgl - 12 41 37 PM [DROBB] [CENTRAL] 
i : Pg2 - 12:43:32 PM [DROBB) [CENTRAL) 

: l±l Note/12 I I 
l±l 11124/2011 

Patient experiences pa in but has no swe 11 ing in the 
UR quadrant. The pain seems to be associa1Ed with 
tooth 1. 

0 

Editing Clinical Notes 
You can edit a clinical note that has not been placed into history after the month-end process, that has not 
been signed, or that has not been locked. 

To edit a clinical note 

1. 

2. Expand the 
appropriate date 
category in the left 
pane, and then 
select the page of 
the clinical note you 
want to edit. 

3. If you are adding to 
the note at a date 

In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

Te Clinical Notes window appears. 

1 

6 5 

4 
2 

3 

other than when 
the clinical note was 
originally entered, 
click at the end of 
the text, press Enter, and then click the Insert Date/Time button  to insert a date and time stamp. 

4. Add to, change, or remove a part of the clinical note as needed. 

5. To assign a diferent clinic than the currently selected clinic for the clinical note, click the Change Clinic 
for Selected Note button to open the Select Clinic dialog box and select the appropriate clinic. 

6. Click the Save Clinical Note button . 
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• (Abbott, James SJ [CENTRAL] [AMC CLURE] [ABB101] [11/11/1962] [SO] 

Notes: ~ 

El 5/131201 0 
El Note~1 

·pg1 - 12 41 37 PM [DROBB] [CENTRAL 

Performed general scaling with hand ins1ruments. Flossed all contacts 

Patient rinsed with Peridex after 1reatment. 
Pg2 11 :05:28AM [DDS1][CENTRAL] 

Note~2 Proper technique of brushing demons1rated. Flossing with fingers and 
holder demons1rated. Patient given a soft toothbrush and fioss. l±l 1112/ 2010 

New Addendum· 01/24/2012 · Note#l · *Pgl -12:41:37 PM [DROBB] [CENTRAL] 

Proper tEchnique of brushing demonstratEd. Flossing 
with fingers and a fioss holder demonstratEd. Patient 
given a soft toothbrush and floss. 

0 

OK 

1B Administrative 

1B Anesthetia 
1B Clinical Exams 

1B Endodontics 
1B Fixed Prosthetics 
1B Hygiene 

1B Medical Alerts 

1B Orthodontics 
1±1 Patient Complaint 

1B Pedodontics 
1B Periodontics 
1B Prescriptions 
1±1 Recommendation§ 

1B Removable Prosthetia 
III Restorative 

1B Treatment: 

III X-rays 

Adding an Addendum to a Clinical Note 
You cannot edit a locked clinical note (a note that has been moved into history after the month-end process, 
has been signed or approved, or has been locked automatically). However, you can add an addendum to a 
clinical note that has been locked. 

To add an addendum to a clinical note 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

1 

Te Clinical Notes window appears. 

2. Expand the appropriate 
date category in the left 
pane, and then select the 
page of the clinical note 
to which you want to 
add an addendum. 

3 

3. Click the New 
Addendum button . 

2 

Te New Addendum 
dialog box appears. 

4. Type the text of the 
addendum. 

5. Click OK. On the confrmation 
message that appears, click Yes. 

4 

5 
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Notes: Iii § 
~ 03/25/2013 
I;] 01/24/2012 

B Note/11 [I 
Pg1 - 12 41 37 PM [DROBBJ [CENTRAL! 

Patient experiences pain but has r 
UR quadrant. The pain seems to b 
1Doth 1. 

i ' Pg2 - 12:43:32 PM [DROBBJ [CENTRAL] 
l±l·· Note/12 [) 

1±1 11/24/2011 

~ Print Clinical Notes - (Abbott, James S) [CENTRAL] [AMCCLURE] [ABB101) (11/11/1962] [SO] 
Select Date Range 

r♦ Dale Range 

From: I 04/16/2013 

To l1J411 s12013 

r Relative Date Range 

..:.l 

Patient Selection 

r. Current Patient 

r All Member's of Current Patient's 
Family 

Repo,t T _ype Selection------<1 

r♦ All Noles 

r Noles Already Approved 

r Notes Needing Approval 

Save as Default I Clea, Defaults 

Printing Clinical Notes 
From the Clinical Notes window, you can print all clinical notes within a certain date range for the current 
patient and/or all members of that patient’s family. For instructions on how to print the Clinical Notes Report 
from the DXOne Reporting module, see “List Reports” in Chapter 9: DXOne Reporting. 

To print clinical notes 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

Te Clinical Notes window appears. 

2. Click the Print button . 

Te Print Clinical Notes dialog 
box appears. 

1 

2 

3. Set up the following options: 

• Select Date Range – Select 
Date Range, and then type 
a range in the From and To 
felds. Or, select Relative 
Date Range, and then select 
a range. Te clinical notes 
within that date range will 
appear on the report. 

Tip: Using a relative date 
range is recommended if 
you are saving your report 
settings as the default so that 
you do not have to manually 
type a date range each time 
you run the report. 

4 5 

3 

• Patient Selection – Select whether you want to include clinical notes for the patient currently 
selected or for the current patient and anyone else in that person’s family. 

• Report Type Selection – Select whether you want to include all clinical notes, clinical notes that have 
already been approved or signed, or clinical notes that have not been approved or signed. 

• Clinic Selection – Click the search button  to select the clinics you want to include on the report, 
or leave All selected to include all clinics. 

• Provider/Staf Selection – Click the search button  to select the providers you want to include on 
the report, or leave All selected to include all providers. 

4. To save the current settings for the next time you run the report, click Save as Default. 

5. Click OK to preview the report. 



Chapter 4: Patient Chart     175 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

I 

ITT~ CTi _ 
Notes: Iii §I 

~ 1/24/2012 
EI -Note111 

Pg1 12 41 37 PM [DROBB] [CENTRAL] 

Patient experiences pa in but has no swe II ing in 
UR quadrant. The pain seems to be associated 
tooth 1. 

' Pg2 -12:43:32 PM [DROBB) [CENTRAL) 

1±1·· Clinical Notes, Approve 

User Name: !Cardon, Thomas 

User ID: I DDS9 

Password: I 

OK 

0 
Cancel 

Sign Clinical Note 

Name: I Dennis Smith (D.D.S.J 

WARN I NG: Adding a signature to Oinical N 
will prohibrt any edrting of the Oinical Note . 

Date: 104/ 16/2013 

OK Caocel 

I 

Signing Clinical Notes 
A provider can digitally sign a clinical note to indicate his or her approval of the note. Signing a clinical locks 
it to prevent changes from being made to the text and to prevent the note from being deleted; however, a 
signed or locked note can be appended to. 

Tip: You can sign multiple clinical notes at once from the Ofce Manager. 

To sign a clinical note 

1. In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes. 

Te Clinical Notes window appears. 

2. Expand the appropriate date 
category in the left pane, and 
then select the page of clinical 
note you want to sign. 

3 

1 

3. Click the Sign Clinical 
Note button . 

Te Approval Verifcation 
dialog box appears. 

4. Type your User ID and 
Password, and then click OK. 

Te Sign Clinical Note dialog 
box appears. 

2 

4 

5. In the signature box, sign your 
name using a mouse, light pen, fnger on a touch 
screen, or stylus on a writing tablet. 

Tip: If you need to clear the signature to re-sign, 
click Clear. 

6. Click OK. 

5 

6 

Notes: 

• When a signature has been added to the clinical note, a “Signed on [date]” stamp is added to the end of 
the clinical note. 

• If you select a clinical note that has been signed, the Sign Clinical Note button changes to the 
Signature button . To view a signature for the selected clinical note, click the Signature button. 
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Last OHS Update for Patient Crosby, Brent 

Last OHS Update: 9/18/2019 
OHS Cla ssif ication: 1 

Do yo u w ant to update OHS now? 

Completing Oral Health Status 
Surveys 
Te primary goal of a continuous assessment of a patient’s oral health status (OHS) is to reduce the likelihood 
of a patient sufering a preventable urgent or life-threatening oral health condition. Most dental “emergencies” 
are due to an acute fare-up of an existing condition—usually a periapical or periodontal abscess. 

From the standpoint of overall healthcare system cost efectiveness, this prevention-oriented program, which 
provides a way to record and track oral health, leading to early diagnosis and timely intervention, should 
decrease the number of emergency room visits for evaluation and/or treatment of serious oral infections. 

From a program implementation perspective, the OHS survey makes the process of entering OHS metrics 
as efcient and consistent as possible. Te simplifed objective data collection and criteria may also prove to 
be appropriate for oral assessments done in “visual exam only” scenarios, which may increase its use in non-
clinical, oral health evaluation settings. 

OHS classifcations (a classifcation is current if an OHS survey has been done within the past 24 months): 

• OHS 1 – Excellent. No dental treatment is required. 

• OHS 2 – Moderate/Good. Te patient has moderate dental treatment needs. 

• OHS 3 – Compromised. Urgent dental treatment is indicated. 

• OHS 4 – Poor. Very urgent dental treatment is indicated. 

• OHS 5 – Poor. For a class 4 patient, it has been 24-36 months since the last completed OHS survey. 

Note: Tis classifcation allows you to track class 4 patients for another 12 months for continued 
identifcation and, therefore, treatment. 

• OHS 6 – Unknown. One of the following conditions is met: 

• Te patient does not have a completed OHS survey. 

• For a class 1, 2, or 3 patient, it has been 24 months since the last completed OHS survey. 

• For a class 5 patient, it has been 36 months since the last completed OHS survey. 

To enter or update OHS 

1. Sign a clinical note. 

If the patient has a prior completed OHS survey, a message appears and displays the date of that OHS 
survey and the classifcation that was calculated from that survey. Proceed to step 2; otherwise, skip to 
step 3. 

2. To update the OHS, click Yes. 

Te OHS Oral Health Status dialog box appears. 
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OHS Oral Health Status - Crosby, Brent [AF] [UTC -06:00 [MDT]] [DSMITH] [CRO101] (11/11 / 1973] (45] X 

Patient Ora l Health (Dental Provide r [objective] Observations) 

0 1. Was a complete examination including charting of abscessed teeth, carious lesions and 
needed restorations completed at this appointment? 0 No O Yes 

0 2. Are any teeth identified for extractions due to caries, periodontal disease or abscesses? 0 No O Yes 

0 Soft Tissue Exam 

3a. Any defin itive ly d iag nosed oral or pharyngeal cancer? 0 No O Yes 

3b. Any abnormal o ral les io ns ind icated fo r biopsy? 0 No O Yes 

0 4. Comm unity Periodontal Index (CPI) 0 S. Active Ca ries Depth Metric 

Accept Previous Entry? No Yes 

CPI Status 

1-5 6-11 12-16 

□□□ 28-32 22-27 17-21 

□□□ 
Patient Ora l Health Risk Factors 

0 6. Caries Risk: 

0 7, Smoking: 

0 8. Diabetes? 

0 9. Dry Mouth? 

I Unspecified 

I Unspecified 

I Unspecified 

I Unspecified 

Accept Previous Entry? , No 

Active Caries Depth 

1-5 6-1 1 12-16 

□□□ 28-32 22-27 17-21 

□□□ 

OK 

Yes 

I I Cancel 

Patient does not have a completed OHS survey 
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~ OHS Oral Health Status - Crosby, Brent [AF] [UTC -06:00 [MDT]] [DSMITH] [CRO101] (11/11 / 1973] (45] X 

Patient Ora l Health (Dental Provide r [objective] Observations) 

0 1. Was a complete examination including charting of abscessed teeth, carious lesions and 
needed restorations completed at this appointment? 0 No O Yes 

0 2. Are any teeth identified for extractions due to caries, periodontal disease or abscesses? 0 No O Yes 

0 Soft Tissue Exam 

3a. Any defin it ive ly d iag nosed oral or pharyngeal cancer? 0 No O Yes 

3b. Any abnormal o ral les io ns ind icated fo r biopsy? 0 No O Yes 

0 4. Comm unity Periodontal Index (CPI) 0 S. Active Ca ries Depth Metric 

Accept Previous Entry? 0 No O Yes Accept Previous Entry? 0 No O Yes 

CPI Status Active Caries Depth 

1-5 

J 

6-11 12-16 

28-32 22-27 17-21 

C 

Last Update: 9/ 18/ 2019 

Patient Ora l Health Risk Factors 

0 6. Caries Risk: 

0 7, Smoking: 

0 8. Diabetes? 

0 9. Dry Mouth? 

I Unspecified 

I Unspecified 

I Unspecified 

I Unspecified 

1-5 6-11 12-16 

28-32 22-27 17-21 

C 

Last Update: 9/1 8/2019 

Updated: 9/18/ 2019 

OK I I Cancel 

Patient has a prior completed OHS survey 

3. Enter responses for the following: 

#1 Was a complete examination including charting of abscessed teeth, carious lesions and needed 
restoration completed at this appointment? – Select No or Yes. 

Notes: 

• Charting of all conditions is not required. Treatment planning of proposed procedures by specifc 
appointments is not required. An immediate treatment/restoration query applies to caries-related 
procedures and elective (non-caries related) restorative, endodontic, surgical, or prosthetic 
procedures. 

• Your response does not afect the overall OHS status. 
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1. Was a complete exam ination including charting of abscessed teeth, carious lesions and 
needed restorations completed at this appointment? @[N-~ 0 Yes 

No 

When was the date of last complete exam? 

Numberofremaining teeth: D B 
Are there any abscessed teeth? 0 No O Yes 

Last baml '---------'~=1=s,.,I • 1 New Patient 

Please estimate how many teeth have active cario us lesions? 0 0 0 1-3 0 4-10 0 11 + 

Do any teeth req ui re immediate treatmenVrestoration? 0 No O Yes 

~ OHS Oral Health Status - Tooth Status - Adults 16+ (Crosby, Brent) X 

Tooth Status 

4 S 6 7 8 9 10 11 12 13 14 15 16 

32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 

OK 

lu 1. Was a complete exam ina tion including charting of abscessed teeth, carious lesions and 
needed restorations completed at this appoi ntment? 0 No @[Yi.~ 

Yes 

Numberof remainingteeth: D B 
Are there any abscessed teeth? 0 No O Yes 

How= teeth have active carious lesions? 0 0 0 1-3 0 4-10 0 11 + 

Do a ny teeth req uire immediate treatmenVrestorat ion? 0 No O Yes 

If you select No, other options become available. 

• When was the date of last complete exam? – Enter or select the Last Exam date. 

Note: You cannot select New Patient manually, so it is always unavailable. New Patient is 
selected automatically if the patient does not have a prior completed survey or a survey was not 
completed on the specifed Last Exam date. 

• Number of remaining teeth – Enter a value, or click the search button to select the missed 
teeth (the correct number of remaining teeth will be inserted into the Number of remaining 
teeth box automatically). 

Note: Te options in the tooth selection dialog box vary according to the age of the patient. 

• Are there any abscessed teeth? – Select No (class 1) or Yes (class 4). 

• Please estimate how many teeth have active carious lesions? – Select all that apply: 0 (class 1), 
1-3 (class 2), 4-10 (class 3), and 11+ (class 4). 

• Do any teeth require immediate treatment/restoration? – Select No (class 1) or Yes (class 4). 

Note: If you select Yes for this survey, if No is selected for the next survey, the current date will be 
inserted as the Last Exam date. 

If you select Yes, other options become available. 

• Number of remaining teeth – Enter a value, or click the search button to select the missed 
teeth (the correct number of remaining teeth will be inserted into the Number of remaining 
teeth box automatically). 
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~ OHS Oral Health Status - Tooth Status - Adu lts 16• (Crosby, Brent) X 

Tooth Status 

1 

r 
4 5 6 7 8 9 10 11 12 13 14 15 16 

32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 

OK 

Note: Te options in the tooth selection dialog box vary according to the age of the patient. 

Note: If you select Yes for this survey, if No is selected for the next survey, the current date will be 
inserted as the Last Exam date. 

• Are there any abscessed teeth? – Select No (class 1) or Yes (class 4). 

• How many teeth have active carious lesions? – Select all that apply: 0 (class 1), 1-3 (class 2), 
4-10 (class 3), and 11+ (class 4). 

• Do any teeth require immediate treatment/restoration? – Select No (class 1) or Yes (class 4). 

#2 Are any teeth identifed for extractions due to caries, periodontal disease or abscesses? – Select No 
or Yes. 

Note: Tis includes any teeth that are recommended for extraction due to problematic exfoliation 
(deciduous teeth), non-restorable caries, periodontal bone loss, periodontal or periapical abscess, or 
any other non-elective reason. Tis includes third molars with probability for urgent treatment within 
24 months. 

#3 Soft Tissue Exam: 

#3a Any defnitively diagnosed oral or pharyngeal cancer? – Select No or Yes. 

#3b Any abnormal oral lesions indicated for biopsy? – Select No or Yes. 

Note: A Yes response to oral or pharyngeal cancer requires defnitive diagnosis by biopsy. 

#4 Community Periodontal Index (CPI): 

• If there is a prior OHS survey for the patient, Accept Previous Entry? is available, and the 
community periodontal indexes (CPI) that were entered in the previous survey appear. If no 
changes are needed, select Yes. To update any of the entries, select No, and then enter the one of 
the following community periodontal indexes for the applicable sextants: 

• X – No teeth in sextant. 

• 0 – No pockets > 3.5mm (black band fully visible). 

• 1 – No pockets > 3.5mm, bleeding on probing (black band fully visible). 

• 2 – No pockets > 3.5mm, calculus present (black band fully visible). 

• 3 – Pocket > 3.5mm but < 5.5mm (black band partially visible). 

• 4 – Pocket > 5.5mm (blank band not visible). 

• If there is not a prior OHS survey for the patient, Accept Previous Entry? is not available. Enter 
one of the following community periodontal indexes for each sextant: 

• X – No teeth in sextant. 

• 0 – No pockets > 3.5mm (black band fully visible). 

• 1 – No pockets > 3.5mm, bleeding on probing (black band fully visible). 
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• 2 – No pockets > 3.5mm, calculus present (black band fully visible). 

• 3 – Pocket > 3.5mm but < 5.5mm (black band partially visible). 

• 4 – Pocket > 5.5mm (blank band not visible). 

Te class is determined according to the following criteria: 

• Class 1 – No more than one CPI score of 3 and no CPI score of 4. 

• Class 2 – Tree or fewer CPI scores of 3 and no CPI score of 4. 

• Class 3 – Four or more CPI scores of 3 and three or fewer CPI scores of 4. 

• Class 4 – Four or more CPI scores of 4. 

Notes: 

• Tird molars are excluded unless they are in the functional position of second or frst molars. As 
a general rule for scoring, if in doubt, enter the lower score. When heavy extrinsic stain is present 
in the absence of calculus or pockets, the sextant may be scored as 2 if dental services are needed 
to remove the stains. 

• Te CPI options are available only if the patient is 15 years old or older. 

#5 Active Caries Depth Metric: 

• If there is a prior OHS survey for the patient, Accept Previous Entry? is available, and the active 
caries depths that were entered in the previous survey appear. If no changes are needed, select Yes. 
To update any of the entries, select No, and then enter one of the following active caries depths 
for the applicable sextants: 

• X – All teeth in sextant are missing. 

• 0 – No caries are present in sextant. 

• 1 – Caries present; deepest caries does not penetrate past DEJ. 

• 2 – Deepest caries penetrating past DEJ (includes any root surface caries). 

• 3 – Deepest carious lesions encroaching on pulp chamber (from any surface). 

• 4 – Deepest carious lesion penetrating into pulp chamber. 

• If there is not a prior OHS survey for the patient, Accept Previous Entry? is not available. Enter 
one of the following active caries depths for each sextant. 

• X – All teeth in sextant are missing. 

• 0 – No caries are present in sextant. 

• 1 – Caries present; deepest caries does not penetrate past DEJ. 

• 2 – Deepest caries penetrating past DEJ (includes any root surface caries). 

• 3 – Deepest carious lesions encroaching on pulp chamber (from any surface). 

• 4 – Deepest carious lesion penetrating into pulp chamber. 

Te class is determined according to the following criteria: 

• Class 1 – All depth scores are X or 0. 

• Class 2 – All depth scores are X, 0, 1 or 2 (no 3 or 4). 

• Class 3 – All depth scores are X, 0, 1, 2 or 3 (no 4). 

• Class 4 – Any depth score of 4. 

Note: As a general rule for scoring, if in doubt, enter the lower score. 
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#6 Caries Risk – Select an option: 

• Unspecifed. 

• Low – No restorations or new active carious lesions within last 36 months. 

• Medium – 1–2 replacement restorations or new active carious lesions within 36 months. 

• High – 3 or more replacement restorations or new active carious lesions within 36 months. 

Note: Your response does not afect the overall OHS status. 

#7 Smoking – Select an option: 

• Unspecifed 

• Never smoked tobacco 

• Tobacco smoking consumption unknown 

• Occasional tobacco smoker (does not smoke every day but smokes almost every week) 

• Light tobacco smoker (1 cigar or fewer than 10 cigarettes per day) 

• Heavy tobacco smoker (more than one pack per day) 

• Smokes tobacco daily 

• E-cigarette user 

• Smokeless tobacco user 

• Ex-smoker 

Notes: 

• Your response does not afect the overall OHS status. 

• Te smoking option is available only if the patient is 10 years old or older. 

#8 Diabetes? – Select an option: 

• Unspecifed 

• No patient history of diabetes 

• Type I; well controlled 

• Type I; not well controlled 

• Type II; well controlled 

• Type II; not well controlled 

Notes: 

• A laboratory test/report is not required. Input is based on the provider’s discussion with the 
patient. 

• Your response does not afect the overall OHS status. 

• Te diabetes option is available only if the patient is 5 years old or older. 

#9 Dry Mouth? – Select an option: 

• Unspecifed 

• Normal saliva 

• Reduced saliva fow 

• Very dry mouth 
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OK I I Cancel 

The 1nformat1on submitted 1s: not complete 

Click YES to close this message and the OHS form w ithout 
saving any information. 

Cl ick NO to close this message to return and complete the 
OHS form. 

• Patient using saliva substitute 

• Patient Using fuoride rinse 

• Patient using prescription strength fuoride toothpaste 

• Patient using fuoride trays 

• None 

Notes: 

• A laboratory test/report is not required. Input based on the provider’s discussion with the patient. 

• Your response does not afect the overall OHS status. 

• Te dry mouth option is available only if the patient is 7 years old or older. 

Te indicator refects the OHS status as determined by the responses on the survey. 

4. Click OK. Tis button is available only if the survey is complete. 

Notes: 

• If you attempt to close the dialog box before the survey is complete, a message appears and asks if you 
want to close without saving or if you want to return to the survey to complete it. 

• If you close the module from which you opened the Clinical Notes window (Family File, Ledger, Chart, 
or Appointment Book), the OHS Oral Health Status dialog box closes too. 

• If you close the Clinical Notes window, the OHS Oral Health Status dialog box remains open. 
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I Settings l □ ptional Settings ) Subscriptions I Export Settings ) 

8dministrative Contact: 

Electronic Collection 

17 Screening D ala 

Insurance Automated Resolution for Over/Under Chrgs 

17 Use Central Clinic Option 17 835Auto Post 

Close Claim------------~ 

17 J;;laim Must Be Zero to Close 

P' fie·calculate Insurance Estimate 

r Al~a_ys Calculate Insurance Override 

OK Cancel 

OHSS – Electronic Screening Form 
and Report 
With the electronic Oral Health Screening Survey (OHSS) form, you can collect details regarding a patient’s 
oral health, such as the condition of his or her teeth and the urgency of treatment. Also, you can export the 
data from screenings to a fle that you can view in a spreadsheet program, such as Microsoft Excel. 

Tis section covers the following topics: 

• Prerequisites 

• Setting Up Clinics 

• Completing Electronic Screening Forms 

• Generating Electronic Screening Reports 

Prerequisites 
• Tese features are available in Dentrix Enterprise versions 8.0.5.257, 8.0.7.553 (CU7), 8.0.9, and later. 

• Tese features are available only if the “Electronic Collection Reports” global setting has been enabled. 
Contact Dentrix Enterprise Customer Support to have a technician enable this global setting. Ten, you 
can activate the functionality per clinic. 

Setting Up Clinics 
With the correct global setting enabled, you can activate the electronic screening form and report on a clinic-
by-clinic basis. 

To set up a clinic 

1. While logged in to the Central clinic, in the Ofce Manager, on the Maintenance menu, point to 
Practice Setup, and then click Enterprise Setup. 

2. In the Enterprise Setup dialog box, select a clinic in the Clinics list, and then click Edit. 

3. In the Clinic Information dialog box, select the Settings 
tab. 

4. Under Electronic Collection, select the Screening Data 
check box. With the electronic collection of screening 
data activated, the buttons to access the screening form 
and report appear on the Patient Chart toolbar. 

3 

4 
5. Click OK. 

5 
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Screening Survey - Children 0-5 Years of Age (Crosby, Crystal) X 

Site Information Screeni ng Information 

IHS Area I Unspecified • I Date of Screening rl0_1_/0_8_/ _20_2_1_1_:4_2_P_M_ ~trn~, ~I 

Clinic Name l~A_F ______ •~I 
Patient Information 

Age 3 Gender Female Race I Unspecified 

Tooth Status 

A B C D G 

T s R Q p 0 N 

Teeth with pulpal involvemen~ abscess, fistula @ No O Yes 

Treatment Urgency I No obvious problems "' I 

· I 

H 

I 
M 

I 

K 

Comment (optiona l) ~---------------------------' 

~-O_K_~I I Cancel 

Completing Electronic Screening Forms 
If electronic screenings are activated for your clinic, you can complete an electronic screening form for a 
patient. 

To complete an electronic screening form 

1. With a patient selected in the Patient Chart, change the provider for the charting session if applicable. On 
the File menu, click Change Provider. In the Select Provider dialog box, search for and select a provider, 
and then click OK. 

2. Click the Screening Forms button . 

Note: Tis button is available only if the electronic collection of screening data has been activated for the 
clinic that you are logged in to. 

Te age-appropriate Screening Survey dialog box appears. 

For a patient who is 0 to 5 years old 
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~ Screening Survey - Children 6-9 Years of Age (Crosby, Crystal) X 

Site Information Screen ing Information 

IHSArea I Unspecified vi Date of Screening 101/08/ 2021 1:41 PM ~ I 
Clinic Name I AF vi 

Patient Information 

Age 8 Gender Female Race I Unspecified · I Grade ~ 

Tooth Status 

A B C D G H 

I 
2 3 4 6 7 8 g 10 11 

I 

12 13 14 15 

31 30 29 28 27 26 25 24 23 22 

I 

21 20 19 18 

T s R Q p 0 N M 

I 

K 

Treatment Urgency No obvious problems ·I 
Comment (optional) 

OK II Cancel 

~ Screening Survey - Children 10-15 Years of Age (Crosby, Crystal) X 

Site Information Screen ing Information 

IHSArea I Unspecified vi Date of Screening 101/08/ 2021 1:39 PM ~ I 
Clinic Name I AF vi 

Patient Information 

Age 12 Gender Female Race I Unspecified ·I Grade ~ 

Tooth Status 

2 3 4 6 7 8 9 10 11 12 13 14 15 

31 30 29 28 

I 

27 26 25 24 23 22 

I 

21 20 19 18 

Treatment Urgency No obvious problems ·I 
Comment (optional) 

OK II Cancel 

For a patient who is 6 to 9 years old 

For a patient who is 10 to 15 years old 
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I!: Screening Survey - Adults 16+ (Crosby, Crystal) X 

Site Information Screen ing Information 

IHS Area I Unspecified v I Date of Screening ,-IO_l_/ 0_8_/ _20_2_1_1_:3-8- PM- --trn~, .,I 

Clin ic Nam e l~A_F ______ v~I 

Patient Information 

Age 16 

Ask Patient 

Gender Female 

Do you have Diabetes? 

Race I Unspecified 

Unspecified 

Do you use che..Ying tobacco or snuff? Unspecified 

Have you smoked at least 100 cigarettes in your entire life? 

Do you currently smoke cigarettes? Unspecified 

Tooth Status 

2 3 4 5 6 7 8 9 

32 31 30 29 28 27 26 25 24 

Period ical Status Removable Dentures 

vi 
vi 

@ No 0 Yes 

10 11 12 13 14 

23 22 21 20 19 

2-5 6-11 12- 15 
Has ~ denture I Unspecified .., I Has lower denture 

15 

18 

28-31 22-27 18-21 
Needs ~ d enture [ Unspecified .., I Needs lower denture I 

Treatment Urgency No obvious problems v I 

16 

17 

Unspecified · I 

Unspecified · I 

Comm ent {optional) ~-------------------------------~ 

~_O_K_~I I Cancel 

For a patient who is 16 or more years old 

3. Specify the following information: 

• IHS Area – Te state where the patient is being screened. 

• Clinic Name – Te clinic where the patient is being screened. By default, this is the patient’s 
preferred clinic, but you can change it as needed. 

• Date of screening – Te date of the screening. By default, this is today’s date, but you can select a 
diferent date as needed. 

• Age – Te patient’s age at the time of the screening. To change the age, you must change the patient’s 
Birth date in the Family File. 

• Gender – Te patient’s gender. To change the gender, you must change the patient’s Sex in the Family 
File. 

• Race – Te patient’s race. By default, this is the Race that is entered in the patient’s Family File 
record, but you can select a diferent race as needed. 

Note: Selecting a diferent race for the form does not update the patient’s record, but the next time 
you screen the patient, the prior Race selection will be selected by default on the form. 

• Grade – Te patient’s grade level in school. 

Note: Tis question is available only if the patient is 6 to 15 years old. 



188     Chapter 4: Patient Chart 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Do you have Diabetes? – Select the patient’s response to this question. 

Note: Tis question appears only if the patient is 16 or more years old. 

• Do you use chewing tobacco or snuf? – Select the patient’s response to this question. 

Note: Tis question appears only if the patient is 16 or more years old. 

• Have you smoked at least 100 cigarettes in your entire life? – Select the patient’s response to this 
question. 

Note: Tis question appears only if the patient is 16 or more years old. 

• Do you currently smoke cigarettes? – Select the patient’s response to this question. 

Note: Tis question appears only if the patient is 16 or more years old, and this question is available 
only if Yes is selected for the Have you smoked at least 100 cigarettes in your entire life? question. 

• Tooth Status – For each tooth, right-click the corresponding box, and then click one of the following 
statuses: 

• None – Clears the tooth box. 

• Sound – Inserts a check mark in the tooth box. 

• Sealant – Inserts “S” in the tooth box. 

• Decayed – Inserts “D” in the tooth box. 

• Filled – Inserts “F” in the tooth box. 

• Crown – Inserts “C” in the tooth box. 

• Extracted due to decay – Inserts “X” in the tooth box. 

• Unerupted – Inserts “UE” in the tooth box. 

Note: Tis status is available only if the patient is 0 to 15 years old. 

• Missing – NOT because of decay – Inserts “Z” in the tooth box. 

Note: Tis status is available only if the patient is 0 to 9 years old. 

• Ortho extraction – Inserts “O” in the tooth box. 

Note: Tis status is available only if the patient is 10 to 15 years old. 

• Missing for any other reason – Inserts “M” in the tooth box. 

Note: Tis status is available only if the patient is 16 or more years old. 

• Fractured or restored (injury/trauma) – Inserts “I” in the tooth box. 

Note: Tis status is available only if the patient is 0 to 5 years old or 10 or more years old. 

• Hypoplasia – Inserts “H” in the tooth box. 

Note: Tis status is available only if the patient is 0 to 5 years old or 10 or more years old. 

• Fixed dental prosthesis/crown abutment – Inserts “P” in the tooth box. 

Note: Tis status is available only if the patient is 16 or more years old. 
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~ Screening Data X 

Clinic Selection 

□~All 
Select Patients 

From: 

□~All 

a Report Type 

® Screening Data 0-5 

0 Screening Data 6-9 

To: 

□~All 

( 
-

0 Screening Data 10-15 

0 Screening Data 16+ 

} OK . I Cancel 

Notes: 

• You can select a status only one tooth at a time. Tere is not a way to select a status for multiple 
teeth at the same time. 

• If the patient is 6 to 9 years old, you can “double enter” statuses on primary and permanent teeth. 

• Teeth with pulpal involvement, abscess, fstula – Select Yes or No. 

Note: Tis option is available only if the patient is 0 to 5 years old. 

• Treatment Urgency – Select No obvious problems, Early care needed, or Urgent care needed. 

• Comments – Enter any comments regarding the screening. 

4. Click OK. 

Generating Electronic Screening Reports 
If electronic screenings are activated for your clinic, you can generate a report that contains screening data for 
patients. Te report contains patient information, such as ages and genders, and contains details regarding 
each patient’s oral health, such as the condition of his or her teeth and the urgency of treatment. Te report 
does not contain any patient names or birth dates. 

Tip: You may want to view the report every day to ensure that data is being entered correctly.  

To generate the report 

1. With or without a patient selected in the Patient Chart, click the Screening Forms Report button . 

Te Screening Data dialog box appears. 

2. Set up the following options: 

• Clinic Selection – Click the search button 
to select the clinics where patients were screened 
to include their screening data, or select the All 
check box to include screening data for patients 
who were screened in any clinic. 

2 

• Select Patients – Click the From and/or To 
search buttons  to select the range of patients who may have been screened in the specifed clinics 

3 

to include their screening data (the range can be open-ended), or select both All check boxes to 
include screening data for all patients who were screened in the specifed clinics. 

• Report Type – Select whether you want to include screening data for patients who were 0 to 5, 6 to 
9, 10 to 15, or 16 or more years old at the time of screening. 

3. Click OK. 
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Te Save As dialog box appears. 

4 

4. Select where you want to save the fle, change the File name (which contains the age range, clinic name or 
“Multiple”, and date by default) as needed, make sure that the Save as type is .csv, and then click Save. 

5. You can open the fle in a spreadsheet program, such as Microsoft Excel. 
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Printing from the Patient Chart 
You can print the following from the Patient Chart: 

• Patient’s Chart 

• Patient’s Progress Notes and Chart 

• Referral Recap Report 

• Referral Slip 

Patient’s Chart 
You can print a patient’s dental chart. 

To print a patient’s chart 

1. In the Patient Chart, with a patient selected, from 
the File menu, click Print Dental Chart. Te Print 
Options dialog box appears. 

1 

2. Select the desired print option(s): 

• Print Todays Work – To print completed work 
posted on the current system date. 

• Print Treatment Plan – To print treatment-planned work 
that was posted on the current system date. Ten, to include 
a list of treatment-planned work and the billed amount, 
patient portion, and insurance portion of each, select Print TP 
Estimate Detail. 

• Print Chart as Displayed – To include the graphical chart. 

• Print Selected Images – To include patient images if you are 
using Image. You can also include notes and/or annotations. 

3. Click OK. 

3 

2 
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Patient’s Progress Notes and Chart 
You can print the progress notes and graphical chart as they are currently being viewed in the Patient Chart. 

Tip : If you want to print the progress notes without the graphical chart, switch to the progress notes view in 
the Patient Chart, and then complete the steps that follow. For instruction on how to switch the Patient Chart 
view, see the “Working with views” topic  in the Dentrix Enterprise Help. 

To print the progress notes with the chart 

1. In the Patient Chart, with a patient selected, from 
the File menu, click Print Progress Notes With 
Chart. Te Print Progress Notes with Chart dialog 
box appears. 

1 

2. Set up the following options: 

• Note Range – To print all displayed progress 
notes, select All Progress Notes; or, to print notes specifc to 
a certain date range, select Date Range, and then type a date 
range. 

• Print Procedure Amounts – To include amounts for 
procedures that appear on the report. 

3. Click OK. 

2 

3 

Referral Recap Report 
Te Referral Recap Report shows any completed work within a specifed date range that has been fagged as 
“Referred By Doctor.” Treatment-planned work that has been referred to the practice by the same provider is 
also included. For information about attaching a referral to a procedure, see the “Editing treatment” topic in 
the Dentrix Enterprise Help. 

To print a referral recap 

1. In the Patient Chart, with a patient selected, from 
the File menu, point to Print Referral, and then 
click Referral Recap. Te Print Referral Recap 
dialog box appears. 

2. Under Completed Work Date Range, type the date 
range for the completed referred procedures you 
want to print. Only procedures that were completed 
within the specifed date range and are fagged as “RC” (Referred 
Completed) will be included on the report. 

3. Type any necessary Additional Notes that you want to have print 
on the report. 

4. Click Print to send the report to the Patient Chart printer or 
Batch to send the report to the Batch Processor. 

1 

3 

4 

2 



Chapter 4: Patient Chart     193 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

  

From: I 04/ 16/2013 To: I 04/ 16/2013 

Additional Notes----------~ 

.:LI 

0 
Print Batch Cancel 

Referral Slip 
You can print a referral slip for patients to give to the doctor they are being referred to. All procedures that 
have been fagged as “RTP” (Referred Treatment Planned procedure) and are within the specifed date range 
will be included on the slip. Te referral slip will also include the patient, provider, and referral’s information, 
as well as any notes you have entered. For information about attaching a referral to a procedure, see the 
“Editing treatment” topic in the Dentrix Enterprise Help. 

To print a referral slip 

1. In the Patient Chart, with a patient selected, from 
the File menu, point to Print Referral, and then 
click Referral Slip. Te Print Referral Slip dialog 
box appears. 

2. Under Date Range, type the date range for the 
referred procedures you want to print. Only 
procedures that fall within the specifed date 
range and are fagged as “RTP” (Referred Treatment Planned 
procedure) will be included on the referral slip. 

3. Type any necessary Additional Notes that you want to have 
printed on the slip. 

4. Click Print to send the slip to the Patient Chart printer or Batch 
to send the slip to the Batch Processor. 

1 

3 

4 

2 
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Chapter 5: Perio Chart 
Te Dentrix Enterprise Perio Chart is a clinical tool that allows you to record mobility, furcation grades, 
plaque, calculus, bone loss, pocket depths, bleeding and suppuration points, gingival margins, CAL levels, and 
MGJ measurements. Automatic calculation formulas allow you to expedite the charting process by eliminating 
the need to measure multiple indicators. 

Once entered, you can view data numerically or graphically. Also, you can print custom reports, charts, and 
letters for an insurance consultant or the referring dental professional. 

Tis chapter covers the following topics: 

• Opening the Perio Chart Window 

• Te Perio Chart Window 

• Entering New Perio Exams 

• Viewing Perio Exams 

• Changing the Perio Exam View 

• Comparing Perio Exams 

• Printing Perio Chart Reports 

Opening the Perio Chart Window 
You can open the Perio Chart from the Patient Chart. 

To open the Perio Chart 

In the Patient Chart, with a patient selected, from the Options menu, click Perio. 

Tip: If the selected patient does not have an exam, the Perio icon on the Patient Chart toolbar is gray . If 
the selected patient has an existing exam, the icon is blue . 

Te Perio Chart opens and displays the data for the last exam performed (if one exists) or displays a blank data 
chart for you to start a new exam. 
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The Perio Chart Window 
Te Perio Chart window is divided into the following areas: the data chart, tooth indicator controls, 
navigation controls, and data entry controls. 

Data chart Tooth indicator controls 

Navigation controls Data entry controls 

Tis section covers the following topics about how to use the Perio Chart window: 

• Te Data Chart 

• Te Tooth Indicator Controls 

• Te Navigation Controls 

• Te Data Entry Controls 

The Data Chart 
You can use the data chart to input and display all 
periodontal data relevant to the current perio exam in a 
numerical format. Te column that extends down the left 
side of the data chart indicates each measurement type. 

Te following list provides an explanation of the abbreviations used in the left column: 

• T# (Tooth Number) – Indicates the tooth number to which the displayed information belongs. 

• PD (Pocket Depth) – Indicates the depth of the periodontal pocket in millimeters. 

• Bld (Bleeding) – A red oval in this row indicates a bleeding point. 

• Sup (Suppuration) – A yellow oval indicates suppuration (infection) at that site. 

• GM (Gingival Margin) – Indicates the gingival margin (recession) measurement in millimeters. 

• CAL (Clinical Attachment Level) – Indicates the CAL measurement in millimeters. 

• MGJ (Mucogingival Junction) – Indicates the MGJ measurement in millimeters. 
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• FG (Furcation Grade) – Indicates the furcation involvement for the tooth. 

• TC (Tooth Code) – Indicates special conditions relevant to the tooth. Conditions can include the 
following: C for crown, P for pontic, I for implant, U for unerupted, M for missing, ID for impacted 
distal, and IM for impacted mesial. 

• PMB (Plaque, Mobility, and Bone Loss) – Indicates plaque, mobility, and bone loss measurements 
specifc to the tooth. 

Te shading within the data chart has special signifcance: 

• Yellow areas – Represent measurements taken from the facial (buccal) side of the tooth. 

• Blue areas – Represent measurements taken from the lingual side of the tooth. 

• White areas – Represent measurements that correspond to the tooth in general. 

Within the yellow and blue areas, you can input six measurements (three on the facial side and three on the 
lingual side) for each tooth. 

The Tooth Indicator Controls 
Te tooth indicator controls provide options for inputting data specifc to a 
selected tooth. Te information input through the  tooth indicator controls 
is displayed in the white areas of the data chart. From the tooth indicator 
controls, you can input mobility, furcation grade, plaque, and bone loss. In 
addition, you can reference the tooth number currently selected and a text 
description of any codes associated with that tooth (for example, a crown, 
pontic, or implant). 

Te following list explains the function of each control: 

• Tooth # – Tis feld references the current tooth being charted. 

• Mobility – Click the desired mobility classifcation. Te number appears in the center placement of the 
PMB line on the data chart. 

• Tooth Code – Tis feld displays applicable condition information about the tooth. 

• Furcation Grade – Click the search button to open the Furcation Grade dialog box, which displays 
the furcation grades relevant to the selected tooth. Select the appropriate furcation, and then click OK. 

• Plaque – From the list, select the appropriate plaque classifcation. A corresponding number appears in 
the left placement of the PMB line on the data chart. 

• Bone Loss – From the list, select the appropriate bone loss classifcation. A corresponding number 
appears in the right placement of the PMB line on the data chart. 
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The Navigation Controls 
For quick entry of perio exam data and to facilitate diferent charting styles, the Perio Chart allows you 
to set up a “paths” and “scripts” to indicate the tooth order, site to site movement on each tooth, and the 
measurement to be taken (for example, PD, GM, or CAL) at each site. For information about setting up 
charting paths and scripts, see the “Customizing perio entry settings” topic in the Dentrix Enterprise Help. 

Te navigation controls work in conjunction with the script settings. Te following list outlines the function 
of each control: 

• Script – Tis box displays the tooth number of the current position of the active script. It is a reference 
point in case the script is overridden by a diferent selection, so you know where the script stopped and 
where to recommence. 

• Left Arrow (<-) – Click this button to move from the current tooth to the previous tooth. 

• Right Arrow (->) – Click this button to move from the current tooth to the next tooth. 

• Arch – Click this button to switch between the upper and lower arch (or vice versa). 

• Prev – Click this button to rewind the script from the current tooth to the previous tooth. 

• Next – Click this button to advance the script from the current tooth to the next tooth in the script. 

• Home – Click this button to return to the frst tooth in the script. 

The Data Entry Controls 
Te data entry controls allow you to input data specifc 
to diferent sites on the selected tooth: pocket depths, 
bleeding and suppuration points, gingival margins, 
clinical attachment levels, and mucogingival junction 
measurements. 

Te following list outlines the function of each control: 

• Facial/Lingual – Click this button to switch from the facial side to the lingual side of a tooth (or vice 
versa). 

• Probing Depth – Enter the pocket depth measurements. 

• B (Bleeding) – Click the “B” oval, or press “B” on your keyboard, to indicate a bleeding point on the 
tooth. A red oval that corresponds to the selected tooth and site appears on the data chart. 

• S (Suppuration) – Click the “S” oval, or press “S” on your keyboard, to indicate an infection point on 
the tooth. A yellow oval that corresponds to the selected tooth and site appears on the data chart. 

Tip: To add both suppuration and bleeding to the same tooth, while hold down the Ctrl key, press “B”. 

• Gingival Margin – Enter the gingival margin measurements. 

• Clinical Att. Level – Enter the clinical attachment level. 

• MGJ – Enter the mucogingival junction measurements. 

• 0 – 9 – Click these buttons to enter charting measurements. 
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• 1- – To enter a measurement that is greater than nine millimeters, click 1- button followed by the 
appropriate number (for example, to enter a pocket depth of 12 millimeters, click the 1- button followed 
by the 2 button). Measurements greater than nine millimeters appear as a greater than sign (>) on the 
data chart. 

• + – To record a gingival margin that is above the CEJ, click the + button followed by the appropriate 
number. To indicate that the GM is a positive number, the number appears on the data chart as a white 
number in a black square. 

• Nxt – Click this button to move from the current site to the next site of the script. 

• Clear – Click this button to clear all entries on the current tooth. 

• Left, Down, and Right Arrows (<-, v, ->) – Click these buttons to move around the data entry area 
(Probing Depth, B, S, Gingival Margin, Clinical Att. Level, and MGJ) without advancing to another 
tooth. 

• Path – Tis button always displays the current path being used (for example, PBSL, PBSR, or none). 
To manually switch between paths while charting, click the button until the desired path appears on the 
button. 

Entering New Perio Exams 
Dentrix Enterprise ofers a great deal of fexibility for entering data into a perio exam. You can enter only the 
most basic information, such as pocket depths. Or, if you want to do a more comprehensive exam, almost 
every perio classifcation and measurement is available to be charted and noted. 

To enter perio measurements 

1. In the Patient Chart, with a patient selected, from the Options menu, click 
Perio. 

Te Perio Chart opens. 

Tip: If a patient has an 
existing perio exam, Dentrix 
Enterprise automatically 
opens the most recent exam 
as a reference. You can save 
time by entering only the 
measurements that have 
changed since the last exam. 

2. To choose the script that 
matches your charting style, 
click Setup on the menu 
bar. To select the desired 
path, click the Path button 
until that path’s name 
appears on the button. 

1 

4 2 

3 

3. Enter perio measurements, 
following the selected path 
and script. To enter information not included in the script, use the controls located on the right side of 
the Perio Chart. 
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Te following list contains the keyboard commands that can be used if you prefer using the keyboard for 
data entry: 

• Numeric key pad – Works the same as the number buttons on the data entry controls. 

• Number keys – Work the same as the number buttons on the data entry controls. 

• PAGE UP – Works the same as the Prev button on the data entry controls. 

• PAGE DOWN – Works the same as the Next button on the data entry controls. 

• HOME – Works the same as the Home button on the data entry controls. 

• DELETE – Clears all entries in the current selection. Works the same as the Clear button on the data 
entry controls. 

• Arrow keys – Works the same as the arrow buttons in the data entry controls. 

• Asterisk (*) – Works the same as the Facial/Lingual button on the data entry controls. It toggles 
between the two surfaces of the selected tooth. 

• ENTER – Advances the selection through the current script settings. 

4. From the File menu, click Save Exam. 

Viewing Perio Exams 
Once an exam has been saved, it can be viewed at any time. 

To view an existing exam 

1. In the Perio Chart, from the File menu, click Open Existing 
Exam. 

Te Perio Chart Open dialog box appears. 

2. Select the exam that you want to view. 

3. Click OK. 

1 

2 
3 



Chapter 5: Perio Chart     201 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

Margin -- Clinical Attachment Level - Mucogingival Junction 

• Bleeding o Suppuration e Bleeding and Suppuration 

Furcation: F1 v F2 v F3 T F4 T Mobilit!,I: 1 2 3 4 I Prb Depth 

Changing the Perio Exam View 
From the Perio Chart, you can view perio data in several diferent formats. Tis section covers the following 
view options: 

• Viewing the Graphic Chart 

• Viewing the Combined Graphic and Data Chart 

• Viewing Quadrants 

Viewing the Graphic Chart 
Unlike the data chart, which displays perio data numerically, the Perio Chart’s graphic chart view displays 
numeric perio data in a graphical representation. You cannot add or change data while in the graphic chart 
view. 

To view the graphic chart 

In the Perio Chart, from the Options menu, click Graphic Chart. 
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Viewing the Combined Graphic and Data 
Chart 
In the Perio Chart, you can view a combination of the data chart and graphic chart. Numerical data appears 
above the graphic portion of the chart. You cannot add or change data while in the data and graphic chart view. 

To view the combined graphic and date chart 

In the Perio Chart, from the Options menu, click Combined Graphic & Data Chart. 

Viewing Quadrants 
You can enlarge a quadrant to view that area close up. 

To zoom in on a quadrant 

1. While viewing the data chart or graphic chart, click in the quadrant you want to view. 

2. From the Options menu, click Quadrant Zoom. 

3. If you want to zoom back out to see all quadrants or to select a diferent quadrant to zoom in on, while 
in the quadrant zoom mode, right-click anywhere in the window to zoom out so that all quadrants are 
being viewed in the graphic chart (the pointer changes to a magnifying glass), and then click the desired 
quadrant. 

4. When you are fnished using the quadrant zoom feature, from the Options menu, click Quadrant Zoom 
again to get out of the quadrant zoom mode. 
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Comparing Perio Exams 
To help you educate your patients regarding periodontal disease progression, you can compare up to four 
saved perio exams with the current exam. 

To compare exams 

1. In the Perio Chart, from the Options menu, click Exam Comparison. 

Te Perio Comparative Selections dialog box appears. 
1 

2. Under Compare, select the type of comparison 
that you want view: 

• Probing Depths (Data) – To review 
a data comparison of probing depth 
measurements. 2 4 

• Gingival Margin – To review a comparison 
of gingival margin measurements. Select 
whether to view a Graphic or Data 
representation. 

• Clinical Attachment Level – To review a 
comparison of CALs. Select whether to view 
a Graphic or Data representation. 

3 
5 

• Mobility – To review a data comparison of 
mobility measurements. 

• Furcation Involvement – To review a data comparison of furcation grades. 

3. Under Display, select what you want to display: MGJ Line, Bleeding, Suppuration, Mobility, or 
Furcation Involvement. Tese options are not available if Probing Depths (Data) is selected under 
Compare. 

4. Under Select Comparison Exam, select the exams you want to compare to the current exam. 

5. Click OK. 
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Printing Perio Chart Reports 
From the Perio Chart, you can print a variety of diferent charts and letters with periodontal exam 
information. 

To print the Perio Chart reports 

1. In the Perio Chart, while viewing the exam you want to 
print, from the File menu, click Print. 

Te Perio Print Selections dialog box appears. 
1 

2. Specify the letters and information you want to print: 

• Letters – Select any of the following letters 
that you want to print (Microsoft Word 
must be installed): 

• Insurance Consultant Letter – Prints a 
letter that can be sent as documentation 
of Perio disease diagnosis to an 
insurance carrier. 

• Patient File – Prints a document that 
can be placed in the patient’s chart that 
documents the perio diagnosis for the 
selected exam. 

2 

3 

• Patient Initial – Prints a letter that can be sent 
to the patient to remind him or her of perio diagnosis and to suggest home care aids. 

• Patient Progress – Prints a follow-up letter that can be sent to provide an update for the patient 
on his or her perio status. 

• Patient Completion – Prints a congratulatory letter that can be sent to a patient on the 
completion of his or her perio treatment. Te letter contains several helpful reminders to aid the 
patient in maintaining perio health. 

• Referring Dentist Initial – Prints a letter that can be sent as documentation of Perio disease 
diagnosis to the referring dentist. 

• Referring Dentist Progress – Prints a letter that contains updated diagnostic information for the 
referring dentist. 

• Referring Dentist Completion – Prints a letter that contains fnal diagnostic information and 
explains that the patient should be returning to the referring dentist for general dental care. 

• Charts – Select any of the following perio chart information that you want to print: 

• Data Chart – Prints the data chart. 

• Pocket Depths Only – Prints the data chart but only includes pocket depths. 

• Graphic Chart – Prints the graphic chart (will print in color if sent to a color printer). 

• Combined Graphic & Data Chart – Prints the graphic and data chart (will print in color if sent 
to a color printer). 

• Exam Comparison – Prints the exam comparison chart. Tis option is available only if you are 
viewing an exam comparison. 

3. Click Print. 
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Chapter 6: Treatment Planner 
Te Treatment Planner can help you provide your patients with easy-to-understand treatment options. When 
the Treatment Planner is opened for a selected patient, his or her entire treatment plan is used to create a 
default treatment plan case. You can set up additional cases and visits, and you can view detailed treatment 
and insurance information. Also, you can group procedures in a treatment plan case by visit or by case to 
provide patients with diferent treatment options. 

Tis chapter covers the following topics: 

• Opening the Treatment Planner 

• Te Treatment Planner Window 

• Customizing Case Settings 

• Selecting the Case Details to Display 

• Working with Treatment Plan Cases 

• Viewing Case Status History 

• Adding Consent Forms to Cases 

• Signing Consent Forms 

• Treatment Consent Forms (Enhanced) 

• Editing and Deleting Procedures 

• Posting Completed Procedures 

• Updating Treatment Plan Fees 

• Generating Treatment Planner Reports 

Opening the Treatment Planner 
You can open the Treatment Planner from the Family File, Patient Chart, Ledger, and Appointment Book. 

To open the Treatment Planner 

Do one of the following: 

• In the Patient Chart or Ledger, with a patient selected who has treatment-planned procedures, from the 
Options menu, click Treatment Planner. 

• With a patient’s appointment selected in the Appointment Book, from the File menu, click Treatment 
Planner. 

• In the Family File, with a patient selected from the File menu, click Treatment Planner. 
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The Treatment Planner Window 
Te Treatment Planner window consists of a menu bar, toolbars, the Navigation panel, the case details, and 
the graphical chart or progress notes. 

Case Details Graphical ChartNavigation Panel 

Tis section covers the following topics on how to use the Treatment Planner window: 

• Te Treatment Planner Toolbar 

• Te Navigation Panel 
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The Treatment Planner Toolbar 
Te Treatment Planner includes toolbars with buttons you can click to access certain areas or features of 
Dentrix Enterprise. 

Te function of the buttons specifc to the Treatment Planner are explained in the following table. 

Click the Refresh button to update the data from other modules, such as the Ledger or Patient 
Chart. 

Click the Update Treatment Plan Fees button to update the treatment plan fees manually to 
refect any fee schedule changes. 

Click the Primary Dental Insurance Notes button to view the primary dental insurance plan 
note for the primary dental insurance plan of the patient currently being viewed in the Treatment 
Planner. You also have buttons for secondary, tertiary, and quaternary dental insurance if the 
current patient has those particular types of insurance coverage. 

Click the Insurance Benefts button to view a summary of the current patient’s insurance benefts. 
You also have the option to include all family members. 

Click the Print button to print one of the Treatment Planner reports. 

Click the Treatment Planner View button to select a Treatment Planner view. 

Click the Copy Case Detail to Clipboard button to copy the case detail currently being displayed 
to the Windows Clipboard so that you can paste the information into a word processing program. 

Click the Other Appointments button to view appointments that have been scheduled for the 
patient selected in the Treatment Planner and that patient’s family members. 

For a comprehensive explanation of all the Treatment Planner toolbars, see the “Using the Treatment Planner 
toolbars” topic in the Dentrix Enterprise Help. 
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The Navigation Panel 
From the Navigation panel, you can assign treatment to cases, set the order of the visits, create alternate 
cases, view insurance estimates, add supporting information, view case history statuses, and set up the default 
settings and required consent forms for new cases. 

Te Navigation panel consists of several sections that you can open by clicking the corresponding section 
button. 

SectionSection 
ButtonsButtons 

Note: If you resize the button area so that not all the buttons ft on the panel, a smaller version of any section 
button that does not ft on the panel in its full size appears at the bottom of the panel. 

Te following is a brief explanation of each section; 

• Treatment Plan Case Setup – Open this section to assign treatment to cases, create and link alternate 
cases, set a recommended case, change the status of a case, set the severity level for a case, set the order of 
visits for a case, add and sign consent forms, complete procedures, and print Treatment Planner reports. 

• Insurance/Case Amounts – Open this section to view insurance estimates, treatment plan case totals, 
insurance plan notes, and patient and family beneft details. 

• Supporting Information – Open this section to add notes and consent forms to a case. 

• Case Status History – Open this section to assign and view status changes for a case. You can also create a 
referral. 

• Settings – Open this section to set the defaults for all new cases that are created and to manage consent 
forms. 
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Customizing Case Settings 
Before treatment planning a case, set up the case defaults. Changes made to the default case settings afect all 
other computers on your practice’s network, and the selected settings will be used for every new case that is 
created. 

To customize case settings 

In the Treatment Planner, on the Navigation panel, from the Settings section, set up the following options: 

• Default Settings for New Cases 

• Estimate Expires – Select the default expiration date for all cases: 
“1 year from current date,” “3 months from current date,” “1 
month from current date,” “Beginning of next calendar year,” 
“Beginning of next fscal year,” “Beginning of next month,” or 
“Prim. Ins. Beneft renewal month.” 

• Default Case Note Template – Select the default that will be 
used to create case notes from a template. “[NONE]” is the only option that is available until another 
template has been set up. To add, modify, or delete a template, click Template Setup. 

• Automatic Case Status Updates – Select the case statuses that you want to be added automatically to the 
case status history: 

• Printed – A case will be updated with the “printed” status when the 
case is printed. 

• Proposed – A case will be updated with the “proposed” status to 
present or propose the case to the patient. 

Note: If you select a status, the status is automatically applied to the current case. 

• Setup Consent Forms – Any existing consent forms that will be used for new cases appear in the list box. 
Do any of the following: 

• New – To add a consent form, click New. 

• Edit – To edit an existing consent form, select that consent form, 
and then click Edit. 

• Delete – To delete a consent form, select that form, click Delete, 
and then click Yes to confrm the deletion. 

• Select Procedure Information – To select what procedure 
information is allowed on consent forms by default, click Select 
Procedure Information. 

• Select Electronic Signature Device – Select the device that will be used to sign cases at this 
computer. 

Important: If you are using Terminal Services or Citrix on this computer to connect remotely to a 
computer with Dentrix Enterprise installed, an ePad will not work for signing consent forms from 
this computer. 

For a comprehensive explanation of all the available case settings, see the “Customizing case settings” topic in 
the Dentrix Enterprise Help. 
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Selecting the Case Details to Display 
You can specify what, if any, procedure information you want to be displayed in the case details area. 

To select the procedure information to display 

1. In the Treatment Planner, from the View menu, click Procedure Information. 

Te Procedure Information dialog box appears. 

1 

2 

3 

2. Select the information you want to display in the case details. Te case details will have a column for each 
information item that is selected. 

3. Click OK. 

Working with Treatment Plan Cases 
Treatment-planned procedures can be grouped into a case. Tis section covers the following topics about 
treatment plan cases: 

• Te Treatment Plan Case Setup Section 

• Creating New Cases 

• Creating Alternate Cases 

• Linking Alternate Cases 

• Setting the Recommended Case 

• Ordering Procedures by Visit 
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The Treatment Plan Case Setup Section 
Te Treatment Plan Case Setup section on 
the Navigation panel displays the treatment 
plan cases that have been created for a 
patient. 

As you select a case in the list, the other 
sections (except for Settings) on the panel 
and the case details are updated to refect 
the information for the selected case. 

Te function of each button on the section’s toolbar is explained in the following table. 

Click the New Case button to create a new treatment plan case you can use to group treatment-
planned procedures. 

Click the Delete Case button to delete the selected treatment plan case. 

Click the Link Alternate Cases button to link alternate treatment plan cases together so that, 
when one of the cases is accepted, the others are automatically rejected. You can also set the 
recommended case. 

Click the Update Case Status button to change the status of the selected treatment plan case. 

Click the Set Case Severity button to specify a severity for the selected treatment plan case. 

Click the consent forms button to add, sign, or view consent forms for the selected case. Te 
appearance and functionality of the button varies depending on the status of the consent forms 
for the case: 

Tere are no consent forms attached to the case. Click the No Consent Forms button to 
add consent forma to the selected case. 

Te case has at least one unsigned consent form. Click the Case Has Unsigned Consent 
Forms button to sign the consent forms. 
Te case has at least one consent form that is missing one of the two required signatures. 
Click the Consent Forms Missing Signature button to sign the consent forms. 
All the consent forms for the case have been signed. Click the All Consent Forms Have 
Been Signed button to review the consent forms. 

Click the Move Case Up button to move the selected case up one place in the list. Click the 
Move Case Down button to move the selected case down one place in the list. 
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Click the Print button to select a Treatment Planner report you want to print. 

Click the Expand All button to view all the treatment-planned procedures for every case listed. 

Click the Collapse All button to show only the name and date of every case listed. 

You also have the following options at the bottom of the Treatment Plan Case Setup section: 

• Include Completed Cases – Selecting this option includes completed treatment plan cases in the case list. 

• Include Rejected Cases – Selecting this option includes rejected treatment plan cases in the case list. 

• Create Visit – When procedures that have not been assigned a visit number are selected, clicking this 
button  creates a new visit that is given the next available number for the corresponding case. 

• Delete Visit – When procedures that have been assigned a visit number are selected, clicking this button 
deletes the visit from the corresponding case. 

Creating New Cases 
To maximize the patient experience, you want make treatment planning customized and personal, but you 
also want to maintain efciency. When you post treatment-planned procedures in the Ledger or the Patient 
Chart, Dentrix automatically places those procedures into a default treatment plan case in the Treatment 
Planner. However, you can create additional treatment plan cases to group and organize procedures. Tis 
allows you to track the status of or prioritize various courses of treatment, create alternative treatment options, 
or provide diferent patient payment estimates, for example. You can create a customized patient experience all 
while maintaining an efcient workfow. 

To create a new case 

1. In the Treatment Planner, on the Navigation panel, from 
the Treatment Plan Case Setup section, click the New 
Case button . Te new case appears in the case list. 

2. Type a name for the case, and then press Tab or Enter to 
apply the name. 

3. All treatment-planned 
procedures are automatically 
added to the default case 
(“Treatment Plan” is the 

3 

1 

2 

name if it has not been renamed). Select the desired procedures in the default case (to select multiple 
procedures, while holding down the Ctrl key, click the procedures), and then drag the selected procedures 
to the new case. 

Tip: If all the procedures in the default treatment plan case will be put into the same case, you can rename 
the default case to avoid having to create a new case and move the procedures into the new case. 



Chapter 6: Treatment Planner     213 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

Create Alternate Case 

Set as Recommended Case 

Unlink Selected Case 

Create Alternate Case for: 

Treatment Plan 1 

lect procedures to copy into alternate Case: 

08090: Comprehensive ortho, adult dent 
I.ii D2790: Crown-lull cast high noble mil [tt19] 

D3330: Root canal therapy - molar [tt19] 
I.ii D 111 0 Prophylaxis adult 

0 
Cancel 

~ 

Creating Alternate Cases 
Customizing the patient experience is a huge part of providing customer service. One way to give your 
patients options in their treatment is to use alternate cases in the Treatment Planner. You can create alternate 
cases for a treatment-planned procedure in order to provide the patient with multiple treatment options, 
such as root canal therapy and a crown, versus an extraction, an implant, and a crown. When you create an 
alternate case, it is linked to the original case as an alternative treatment option. 

To create an alternate case 

In the Treatment Planner, on the Navigation panel, from the Treatment Plan Case Setup section, the default 
treatment plan folder (“Treatment Plan,” if it has not been renamed) currently includes all of the possible 
treatment options that are not already assigned to a case. Use one of the following methods to create an 
alternate case: 

To create an alternate case if each case has diferent treatment options 

1. Create a new case folder for the alternate case (such as “Extraction and Implant”). 

2. Select the procedures in the default treatment plan folder that need to be moved to the alternate case 
folder. Ten, drag those procedures to the alternate case. 

3. Rename the default treatment plan folder to be more descriptive (such as “Root Canal and Crown”). 

To create an alternate case if the cases have one or more treatment options in common 

1. Select the case for which you want to create an alternate case. 
Right-click that case, and then click Create Alternate Case. 

Te Create Alternate Case dialog box appears. 

2. Verify that the case being displayed in the Create Alternate 
Case For list is the case for which an alternate case is being 
created. 

Note: Te selected case is the case that will be fagged as the 
recommended case. If you do not want this case to be the 
recommended one, you can select a diferent case while 
in this dialog box, or you can change the recommended 

1 

2 

3 

4 

5 

case later. 

3. In the Name of Alternate Case text feld, type a name 
for the alternate case. 

4. Leave the check boxes selected for the procedures that 
need to be completed regardless of which of the other 
treatment options the patient chooses. Deselect the 
others. For example, a restoration (such as a three-surface 
composite flling) may need to be placed on a tooth 
regardless of whether the patient chooses to have a crown 
or an implant on a diferent tooth. 

5. Click OK. 
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Linking Alternate Cases 
When you create alternate cases with shared treatment, the alternate case is automatically linked to the 
original case. If you have created cases that are all alternate cases for each other but are not linked, you can 
link them manually. You can link as many treatment plan cases together as is necessary; however, if you want 
to link several cases together, make sure each case is functioning as an alternate treatment plan being ofered to 
a patient. 

Additionally, linking cases can be benefcial for updating statuses. For example, if a case is applied an Accepted 
status, the other linked cases are automatically given a Rejected status. 

To link alternate cases 

1. In the Treatment Planner, on the Navigation panel, from the 
Treatment Plan Case Setup section, either select the case that 
is already linked to another cases, or select the case that you 
want to be the recommended case and link to other cases. 
Right-click that case, and then click Link Alternate Cases. 

Te Linked Cases dialog box appears. 

2. If you right-clicked a case that is not already linked, from 
the Recommended Case list, select the recommended 
case; otherwise, this list is unavailable and displays the 
recommended case you right-clicked or the recommended case for 
the case you right-clicked. 

3. Select the cases you want to link. At least two cases must be selected. 

4. Click OK. 

Notes: 

• Linked cases have link icons (  or ) after them. Te background 
color of the icon varies, depending on how many sets of linked cases 
exist for the patient; for example, you could have two cases linked 
together and two other cases linked together, and the background 
color of the link icon for both of those sets will be diferent 

• When linked treatment cases exist, the recommended case will appear in the Patient Chart. 

Setting the Recommended Case 
Te recommended case is the case that contains the recommended treatment plan. Te recommended case 
can be changed after alternate cases have been created. 

To set the recommended case 

In the Treatment Planner, on the Navigation panel, from the 
Treatment Plan Case Setup section, select the case you want to set 
as the recommended case. Right-click that case, and then click Set 
as Recommended Case. Tis option is available only if the case is 
linked to an alternate case. 

Note: Te link icon  after the case becomes starred . Te 
starred link icon after the prior recommended case becomes a 
normal link icon. 

1 

2 

3 

4 
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Ordering Procedures by Visit 
Sometimes a course of treatment requires multiple visits. For example, a patient could have a root canal 
performed and a temporary crown placed on the frst visit and then the fnal crown seated on another visit. 
When more than one visit is required to complete a treatment plan case, you can organize the procedures in 
that case into visits, so you know which procedures will be done in each visit. 

To order procedures by visit 

1. In the Treatment Planner, on the Navigation panel, 
from the Treatment Plan Case Setup section, expand 
the appropriate case by clicking the plus sign (+). 

2. Select the procedures that will be completed in one 
visit (to select multiple, while pressing the Ctrl key, 
click each procedure). Next, right-click one of the 
selected procedures, and then click Create Visit. Te visit number 
appears next to the procedures. 

Repeat this step for all subsequent visits of the 
treatment plan. As visits are created, the number of 
the visit increases (1, 2, 3, and so forth). 

1 

2 
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Viewing Case Status History 
As a case is created and modifed, the Treatment Planner tracks the changes in status and provides a way for 
you to view those changes. After reviewing the status history of a case, you can update the case status. 

To view and update the status history of a case 

1. In the Treatment Planner, on the Navigation panel, from the 
Treatment Plan Case Setup section, select a case. 

2. Open the Case Status History section for the selected case, 
which is shown at the top of the section. 

1 

Te Case Status History table displays the status history for 
the selected case, which includes the date of the change, the 
current status of the case, and any comments made at the 
time of that particular change. 

3. If necessary, to update the status of the case, under Update 
Current Case Status, from the New Case Status list, select 
the appropriate status, and then click Update. 

2 

Tip: You can also update the status for a selected case 
by clicking the Update Case Status button on the 
Treatment Plan Case Setup section’s toolbar. 

3 
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I, the undersigned patient . hereby authorize the undersigned provider to perform the procedure{s) or course{s) of 
treatment listed below. I understand my dental condeion and have discussed several treatment options weh the D 
undersigned provider. I have been given a printed copy of the procedure or t reatment details and any post -op 
instructions. 

I understand the risk s inherent in the treatment{s). I have discussed these risks with the dentist . The dentist has 
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Adding Consent Forms to Cases 
You can add consent forms to cases for a patient and provider to sign. You can set up consent forms from the 
Settings sections of the Navigation panel. 

To add a consent form to a case 

1. In the Treatment Planner, on the Navigation panel, from the 
Treatment Plan Case Setup section, select a case. Next, 
right-click the case, and then click Consent Forms. Te 
Dentrix Consent Forms dialog box appears. 

2. From the Select Consent Form list, select the form you want 
to add to the selected case. 

3. Click Add. 

1 

Te Consent Form dialog box appears. 

4. Under Patient/Representative signature, the patient selected in 
the Treatment Planner is entered in the Name feld but can be 
changed. Also, the Relationship to patient has “Self ” entered by 
default but can be changed (for example, you can type “Spouse” 
or “Parent” if the person signing the form is the patient’s spouse 
or parent). Te name and relationship can be edited at a later 
time (for instance, when the consent form is going to be signed). 

5. Under Practice signature, click the Name search button to 
select the provider (primary or secondary) who will sign the form, 
or you can type the provider’s name in the feld. Te name can 
be entered at a later time (for instance, when the consent form is 
going to be signed). 

Tip: Te consent form can 
be signed by the patient and 
provider at a later time. Also, 
both signatures do not need to 
be acquired at the same time. 
For information about signing 
consent forms, see “Signing 
Consent Forms” in this chapter. 

6. Click Save. 

7. To print the consent form, click 
Print. You can print any consent 
form, signed or not. 

4 

32 

7 6 

5 
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Signing Consent Forms 

1 

Te patient and provider can electronically sign consent forms attached to a treatment plan case. Once a 
signature is added to a consent form and the form is saved, the signature cannot be removed. Te consent 
form is considered locked once both parties have signed it (both parties do not have to sign on the same date). 

To sign a consent form 

1. In the Treatment Planner, from the Treatment Plan Case 
Setup section of the Navigation panel, select a case that needs 
to be signed. Next, right-click the case, and then click 
Consent Forms. 

Te Dentrix Consent Forms dialog box appears. 

2. Double-click the consent form you want to sign. Te 
Consent Form dialog box appears. 

3. Under Patient/Representative signature, if the 
correct patient is not already entered in the Name 
feld, type the name of the person who will sign the 
form. Also, if the correct Relationship to patient is 
not already entered, type a relationship (for example, 
“Self,” “Spouse,” or “Parent”). Ten, have the patient or 
patient’s representative sign in the box using an input 
device. 

2 

Note: You can click Clear if the patient needs to re-sign. 
Tis button is unavailable if the consent form has been 
saved with a signature (even 
the slightest mark registers as a 
signature) or no signature has 
been added yet. Once the form is 
saved, the signature, name, and 
relationship cannot be changed. 

43 

4. Under Practice signature, if the 
correct provider is not already 
entered in the Name feld, click 
the search button to select 
the provider (primary or secondary) who will sign the form, or you can type the provider’s name in the 
feld. Ten, sign in the box using an input device. 

6 5 

Note: You can click Clear if you need to re-sign. Tis button is unavailable if the consent form has been 
saved with a signature (even the slightest mark registers as a signature) or no signature has been added yet. 
Once the form is saved the signature and name cannot be changed. 

5. Click Save. 

6. To print the consent form, click Print. 
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Treatment Consent Forms (Enhanced) 
With a certain global setting enabled, there are changes to the consent form interface and functionality in the 
Treatment Planner. Using a consent form template as a guide, you can quickly and accurately create a custom 
consent form with minimal typing or editing. Dentrix Enterprise comes with a default template, but you 
can modify it to suit your needs or create new ones. Templates are grouped by category. Also, each template 
can have any number of prompts, which are messages that prompt you to enter responses to user-defned 
questions. 

Important: Enable this functionality only if your workfow allows for creating a form and immediately 
signing it. With this functionality, when you add a consent form to a case, before you can save the form, 
the patient (or his or her representative), someone from the practice (such the dentist), and a witness (or 
interpreter) must sign it. 

Setting Up Consent Form Template Categories 
You can customize the categories for organizing consent form templates. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can set up consent form 
categories. 

To set up a consent form template category 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

8 
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Move Down 

Close 

New Category 
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Delete Category 

New Category 

Rename Category 
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.3. Click the Template Setup button 

Te Template Setup dialog box appears. 

4. Click Category Setup. 

Te Category Setup dialog box appears. 

5. Do any of the following as needed: 

• Create a new category – Click New 
Category, enter the category name in 
the box that appears at the bottom of 
the list, and then press Tab (or Enter 
if you want to close the Category 
Setup dialog box after making the 
new category). 

7 

4 

6 

5 

• Rename a category – Select the category that you 
want to rename, click Rename Category to make the name 
editable, change the name, and then press Tab (or Enter if 
you want to close the Category Setup dialog box after 
making the change). 

• Delete a category – You can only delete a category if it does 
not contain any templates. Select the category that you want 
to delete, click Delete Category, and then click Yes to 
confrm the deletion. 

• Change the order of the categories – Select a category, and 
then click Move Up or Move Down until you achieve the 
desired order. Repeat this process for any other categories 
that you want to move. 

6. If the Category Setup dialog box is still open, click Close. 

7. In the Template Setup dialog box, click Close. 

8. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could set up template categories. 
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Creating Consent Form Templates 
You can create consent form templates to use for adding consent forms to treatment plans. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can create consent form 
templates. 

To create a consent form template 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

3. Click the Template Setup button 

Te Template Setup dialog box appears. 

4. 

5. Click New Template. 

. 

Optionally, select the category that you want to add the 
template to. (Or, you can select a category later on.) 

11 

10 

5 
4 
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Te New Consent Form Template dialog box appears. 

6. If you selected a category in step 
4, that category is selected by 
default in the Category list, but 
you can change it; otherwise, 
select the Category that you 
want to add the template to. 

6 7 

7. In the Template Name box, 
enter a name for the template. 

8. Do any of the following as 
needed: 

8 

• Add prompts to the 
template (see “Adding 
Prompts to and Removing 
Prompts from Consent 
Form Templates”). 

Note: A consent form 
template can have multiple prompts with an odontogram to select teeth, quadrants, or sextants, 
but the text of a consent form can have only one odontogram. If you use a template with multiple 
odontograms, one consolidated odontogram will be inserted into the form text with all the applicable 
selections. If an odontogram has already been inserted into the form text, you cannot use another 
template with an odontogram for the same form. 

9 

• In the Consent Form Text box, enter the default text of the consent form template. 

Note: You can click the Check Spelling button to check the spelling of the text. Tis button is 
available only if a certain preference setting has been enabled. 

• To insert a prompt where the text cursor is located in the Consent Form Text box, select a prompt 
from the Consent Form Prompts list, and then click Insert Prompt in Text. 

Tip: You may need to add a space before and after the prompt placeholder (which uses the format 
“~[prompt name]~”), so the completed consent form will be displayed properly. 

• If you have added multiple prompts to the template, to change the order of the prompts, under 
Consent Form Prompts, select a prompt, and then click Move Up or Move Down to move the 
prompt up or down by one item in the list. When you add text to a form using this template, the 
prompts will appear in the specifed order regardless of where they are inserted in the text. 

9. Click OK. 

10. In the Template Setup dialog box, click Close. 

11. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could set up a template. 
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Editing Consent Form Templates 
You can edit consent form templates as needed. Any changes will not afect consent forms that have already 
been added to patient records using the same template. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can modify consent form 
templates. 

To edit a consent form template 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

9 

54 

3. Click the Template Setup button . 

Te Template Setup dialog box appears. 

4. Expand a category, and select the template that you want 
to edit. 

5. Click Edit Template. 

Note: Tis button is available only if a template is 
selected. 

8 
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Cancel 

Te Edit Consent Form Template dialog box appears. 

6. Do any of the following as 
needed: 

• Select a diferent Category 
to move the template to that 
category. 

• In the Template Name box, 
change the name for the 
template. 

• Add or remove prompts (see 
“Adding Prompts to and 
Removing Prompts from 
Consent Form Templates”). 

6 

Note: A consent form 
template can have 
multiple prompts with an 
odontogram to select teeth, 
quadrants, or sextants, but the text of a consent form can have only one odontogram. If you use a 
template with multiple odontograms, one consolidated odontogram will be inserted into the form 
text with all the applicable selections. If an odontogram has already been inserted into the form text, 
you cannot use another template with an odontogram for the same form. 

7 

• In the Consent Form Text box, change the default text of the consent form template. 

Note: You can click the Check Spelling button to check the spelling of the text. Tis button is 
available only if a certain preference setting has been enabled. 

• To insert a prompt where the text cursor is located in the Consent Form Text box, select a prompt 
from the Consent Form Prompts list, and then click Insert Prompt in Text. 

Tip: You may need to add a space before and after the prompt placeholder (which uses the format 
“~[prompt name]~”), so the completed consent form will be displayed properly. 

• To change the order of the prompts, under Consent Form Prompts, select a prompt, and then click 
Move Up or Move Down to move the prompt up or down by one item in the list. When you add 
text to a form using this template, the prompts will appear in the specifed order regardless of where 
they are inserted in the text. 

7. Click OK. 

8. In the Template Setup dialog box, click Close. 

9. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could edit a template. 
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Deleting Consent Form Templates 
You can delete a consent form template as needed. Tis does not afect any consent forms that were entered 
using that template. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can delete consent form 
templates. 

To delete a consent form template 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

3. Click the Template Setup button 

Te Template Setup dialog box appears. 

4. 
to delete. 

5. 

that appears, click Yes. 

6. 

7. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could delete a template. 

. 

Expand a category, and select the template that you want 

Click Delete Template (this button is only available if a 
template is selected). Ten, on the confrmation message 

In the Template Setup dialog box, click Close. 

7 

6 

5
4 
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Creating Consent Form Prompts 
You can create a consent form from a template dynamically using consent form prompts. When you add text 
to a consent form using a template that has prompts, Dentrix Enterprise will show messages that prompt you 
to enter responses to user-defned questions. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can create consent form 
prompts. 

To create a consent form prompt 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

3. Click the Template Setup button 

Te Template Setup dialog box appears. 

4. Do one of the following: 

• 
Edit Template. 

• Click New Template. 

. 

Expand a category, select a template, and then click 

12 

11 

4 

4 
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Consent Form Erompts 
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Disposal/ Use of extr teeth 
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Delete 

OK 
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Remove 
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Prompt Text: 
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Res ponse Type: I One Response from List 
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5. 

6. 

7. 

Te Edit Consent Form Template or New Consent form Template dialog box appears. 

Under Consent Form 
Prompts, click Select/ 
Setup. 

Te Consent Form 
Prompts dialog box 
appears. 

5 

Click New. 

Te New Prompt dialog 
box appears. 

Set up the following 
options: 

• Prompt Name – Tis 
name is used to identify 
the prompt in the list 
and template text. 10 

6 

Note: When you insert 
a prompt into the text of a template, 
a placeholder (which uses the format 
“~[prompt name]~”) appears in the 
text. 

• Prompt Text – Tis is a question 
or statement that explains how to 
respond to the prompt. When you are adding text to a 
consent form using a template with this prompt, you will 
see this text when the prompt appears. Tis text does not 
get inserted into the consent form text. 

9 

7 

• Response Type – Te selected type and its 
corresponding options (if applicable) determine how you 
can respond. Select one of the following types, and then 
set up the options for it as applicable: 

• Confrmation Only – To provide a yes or no 
response to the prompt text. 

• One Response from List – To provide a list of 
options from which you can select only one response 
to the prompt text. Enter a list of possible responses 
(one per line) in the lower box. 

8 

• Checkbox Responses – To provide a list of options from which you can select one or more 
responses to the prompt text. Enter a list of possible responses (one per line) in the lower box. 

• Date – To provide a date response to the prompt text. Do one of the following: enter a date in 
the Select a default date box if you want the prompt to use that date, clear the date from the 
Select a default date box if you want the prompt to not have a default date, or select the Default 
to “Today” check box if you want the prompt to use the system date by default. When you are 
adding text to a consent form using a template with this prompt, you will be able to change the 
date. 
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• Number/Amount – To provide a number or an amount as a response to the prompt text. 
Optionally, enter a number that you want to be the default response to the prompt text. When 
you are adding text to a consent form using a template with this prompt, you will be able to 
change the number. 

• Text – To provide text as a response to the prompt text. Optionally, enter the text you want to 
be the default response to the prompt text. When you are adding text to a consent form using a 
template with this prompt, you will be able to change the text. 

• Select Tooth – To provide a way to select teeth as a response to the prompt text. To allow only 
one tooth to be selected, leave the Allow multiple selections check box cleared. To allow more 
than one tooth to be selected, select the Allow multiple selections check box. 

• Select Surfaces – To provide a way to select surfaces as a response to the prompt text. 

• Select Quadrant – To provide a way to select quadrants as a response to the prompt text. To 
allow only one quadrant to be selected, leave the Allow multiple selections check box cleared. To 
allow more than one quadrant to be selected, select the Allow multiple selections check box. 

• Select Sextant – To provide a way to select sextants as a response to the prompt text. To allow 
only one sextant to be selected, leave the Allow multiple selections check box cleared. To allow 
more than one sextant to be selected, select the Allow multiple selections check box. 

8. Click OK. 

9. In the Consent Form Prompts dialog box, click OK. 

10. In the Edit Consent Form Template or New Consent form Template dialog box, click Cancel because 
you do not want to attach the prompt to the template; you were only accessing a template so that you 
could create a prompt. 

11. In the Template Setup dialog box, click Close. 

12. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could create a prompt. 
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Editing Consent Form Prompts 
You can edit consent form prompts as needed. Any changes to a prompt will not afect consent forms attached 
to patient records that used the same prompt. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can modify consent form 
prompts. 

To edit a consent form prompt 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

3. Click the Template Setup button . 3 

Te Template Setup dialog box appears. 

4. Do one of the following: 

• Expand a category, select a 
template, and then click Edit 
Template. 

• Click New Template. 

Te Edit Consent Form Template or 
New Consent form Template dialog 
box appears. 

4 

4 

9 

6 

12 

11 

5 

10 

5. Under Consent Form Prompts, click Select/Setup. 

Te Consent Form Prompts dialog box appears. 

6. Select the prompt that you want to edit, and then click Edit (this button is only available if a prompt is 
selected). 
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Prompt Text: 

Risks to my health , this procedure is not 
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Response Type: ICheckbox Responses 

Enter the list of checkbox items (one per line) : 

Pain 
Infection 
Cyst or tumor formation in the area of infected tooth 
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Increased risk of complications ~ surgery is 
postponed to a later day 
Possible delay of permanent tooth eruption 

..:.l 

OK Cancel 

Te Edit Prompt dialog box appears. 

7. Make changes to any of the following options as 
needed: 

7 

• Prompt Name – Tis name is used to 
identify the prompt in the list and consent 
form text. 
Note: When you insert a prompt into the 
text of a template, a placeholder (which uses 
the format “~[prompt name]~”) appears in 
the text. 

• Prompt Text – Tis question or statement 
explains how to respond to the prompt. 
When you are adding text to a consent form 
using a template with this prompt, you will see this text when the prompt appears. Tis text does not 
get inserted into the consent form text. 

8 

• Response Type – Te selected type and its corresponding options (if applicable) determine how you 
can respond, but you can change them as needed: 

• Confrmation Only – To provide a yes or no response to the prompt text. 

• One Response from List – To provide a list of options from which you can select only one 
response to the prompt text. Enter a list of possible responses (one per line) in the lower box. 

• Checkbox Responses – To provide a list of options from which you can select one or more 
responses to the prompt text. Enter a list of possible responses (one per line) in the lower box. 

• Date – To provide a date response to the prompt text. Do one of the following: enter a date in 
the Select a default date box if you want the prompt to use that date, clear the date from the 
Select a default date box if you want the prompt to not have a default date, or select the Default 
to “Today” check box if you want the prompt to use the system date by default. When you are 
adding text to a consent form using a template with this prompt, you will be able to change the 
date. 

• Number/Amount – To provide a number or an amount as a response to the prompt text. 
Optionally, enter a number that you want to be the default response to the prompt text. When 
you are adding text to a consent form using a template with this prompt, you will be able to 
change the number. 

• Text – To provide text as a response to the prompt text. Optionally, enter the text you want to 
be the default response to the prompt text. When you are adding text to a consent form using a 
template with this prompt, you will be able to change the text. 

• Select Tooth – To provide a way to select teeth as a response to the prompt text. To allow only 
one tooth to be selected, leave the Allow multiple selections check box cleared. To allow more 
than one tooth to be selected, select the Allow multiple selections check box. 

• Select Surfaces – To provide a way to select surfaces as a response to the prompt text. 

• Select Quadrant – To provide a way to select quadrants as a response to the prompt text. To 
allow only one quadrant to be selected, leave the Allow multiple selections check box cleared. To 
allow more than one quadrant to be selected, select the Allow multiple selections check box. 

• Select Sextant – To provide a way to select sextants as a response to the prompt text. To allow 
only one sextant to be selected, leave the Allow multiple selections check box cleared. To allow 
more than one sextant to be selected, select the Allow multiple selections check box. 

8. Click OK. 
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Supporting Information 

I Insert Dateline I ~ 

Informed Consent 

Form: 

Date Consent Fonn 

< 

Save Note 

Signatures 

> 

l~=ent~::::~~:.Rerr-,v;lected Fir: 0 
Note: Once a Consent form has been s igned by a 
patient, the treatment case that the form is 
attached to cannot be deleted. 

, Treabnent Plan c.,.., Setup 

supporting Information 

G c.,.., status i.tory 

'$ Settings 

.., 

9. In the Consent Form Prompts dialog box, click OK. 

10. In the Edit Consent Form Template or New Consent form Template dialog box, click Cancel because 
you do not want to attach the prompt to the template; you were only accessing a template so that you 
could edit a prompt. 

11. In the Template Setup dialog box, click Close. 

12. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could edit a prompt. 

Deleting Consent Form Prompts 
You can delete a consent form prompt that is not attached to a consent form template. Any deletion of a 
prompt will not afect consent forms attached to patient records that used the same prompt. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can delete consent form 
prompts. 

To delete a consent form prompt 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

10 

3. Click the Template Setup button . 
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Edrt Consent Form Template 

Ytegory: jt,ffijijij,-i 

Consent Eorm Text: 

Possible Risks or Complications: 
~Possible Risks or Complication~ 

Anesthetic Risks: 
~Anesthetic Ri sks~ 

Risks to my health if this procedure is not 
performed incl ude, but are not limited to: 
~Ri sks to my health~ 

Patient Consent/Understanding: 

lemplate Name: I oral & Maxillof acial Surge!)' 

Consent Form .E.rompts 

Possible Risks or Complication 
Anesthetic Risks 
Risks to my health 
Patient Consent/ Understanding 
Disposal/ Use of extr teeth 
Select teeth to be extracted 

ln.sert Prompt in Text 

OK 

Remove 

Consent Form Prompts 

Anesthetic Risks 
Disposal/ Use of extr teeth 
Patient Consent/ Understanding 
Possible Risks or Complication 

OK 

New .. =.=] 
Edit .. =.=] 

Delete Template::::] 

Category Setup7 

Move Up 

Move Down 

Close 

Te Template Setup dialog box appears. 

4. Do one of the following: 

• Expand a category, select a template, and then click 
Edit Template. 

• Click New Template. 

Te Edit Consent Form Template or New Consent 
form Template dialog box appears. 

5. Under Consent Form Prompts, click Select/Setup. 

Te Consent Form Prompts dialog box appears. 

4 

4 

95 

8 

6. Select the prompt that you want to delete, and 
then click Delete (this button is only available 
if a prompt is selected). If the prompt is not 
being used by a template, on the confrmation 
message that appears, click Yes. 

Note: You can delete a prompt only if it is 
not attached to a consent form template. If 
you try to delete a prompt that is attached to 
any templates (inserted in the text or not), a 
message will appear with a list of templates that 
are using the prompt; you must remove the 
prompt from those templates before you can 
delete the prompt. 

6 

7 

7. Click OK. 

8. In the Edit Consent Form Template or New Consent form Template dialog box, click Cancel because 
you do not want to attach the prompt to the template; you were only accessing a template so that you 
could delete a prompt. 

9. In the Template Setup dialog box, click Close. 

10. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could delete a prompt. 
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Supporting Information 
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Form: 

Date Consent Fonn 

Save Note 

Signatures 
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Remove Selected Form 
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Note: Once a Consent form has been signed by a 
patient, the treatment case that the form is 
attached to cannot be deleted. 

, Treabnent Plan use Setup 

5upporting Infonnation 

G) use status History 

-& Settings 

r Grouped Prompts 

["""category Setup7 

Move Up 

Move Dov.n 

Close 

" 

Adding Prompts to and Removing Prompts 
from Consent Form Templates 
You can add prompts to and remove prompts from a consent form template as needed. Tis does not afect 
consent forms that were created previously using the same template. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can modify a consent 
form’s prompts. 

To add and remove prompts 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 

3 

1 

3. Click the Template Setup button 

Te Template Setup dialog box appears. 

4. Do one of the following: 

• 

• Click New Template. 

. 

Expand a category, select the template that you want 
to modify, and then click Edit Template. 

8 

7 

4 

4 
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Edit Consent Form Template 

Y tegory: U•®i\ii(•ffi ..:.l 
Consent Eorm Text: 

·• Possible Risks or Complications : 
~ Possible Risks or Complication~ 

Anesthetic Risks: 
~Anesthetic Risks~ 

Risks to my health if this procedure is not 
performed include, but are not limited to: 
~ Risks to my health~ 

Patient Consent/Understanding: 

l ernplate Name: I oral & Maxillof acial Surgery 

" 

Consent Form E.rompts 

Possible Risks or Complication 
Anesthetic Risks 
Risks to my health 
Patient Consent/ Understanding 
Disposal/Use of extr teeth 
Select teeth to be extracted 

OK 

Remove 

Move!Jp 

MoveQ_ovm 

[ Cancel J 

Consent Form Prompts 

Anesthetic Risks 
Disposal/ Use of extr teeth 
Patient Consent/ Understanding 
Possible Risks or Complication 
Risks to my health 
Select teeth to be extracted 

OK 

L New _J 

L Edit _J 

L Delete=_] 

[ Cancel J 

Te Edit Consent Form Template or New Consent form Template dialog box appears. 

5 

6 

5. Under Consent Form Prompts, do any of the following as needed: 

• Add a prompt: 

a. Click Select/Setup. 

Te Consent Form Prompts dialog box appears. 

b. Select the correct prompt, or create a prompt (see 
“Creating Consent Form Prompts” on page 226). 

Note: A consent form template can have multiple 
prompts with an odontogram to select teeth, quadrants, 
or sextants, but the text of a consent form can have only 
one odontogram. If you use a template with multiple 
odontograms, one consolidated odontogram will be 
inserted into the form text with all the applicable 
selections. If an odontogram has already been inserted into 
the form text, you cannot use another template with an 
odontogram for the same form. 

c. Click OK. 

Note: Te prompt is added to the bottom of the Consent Form Prompts list. To change the 
order of the added prompt, select the prompt, and then click Move Up or Move Down to move 
the prompt up or down by one item in the list. When you add text to a form using this template, 
the prompts will appear in the specifed order regardless of where they are inserted in the text. 

d. To insert the added prompt into the text where the text cursor is located, select the prompt from 
the Consent Form Prompts list, and then click Insert Prompt in Text. 

Tip: You may need to add a space before and after the prompt placeholder, so the completed 
consent form will be displayed properly. 
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icalion: 
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IFl0007 

Clear 

Print 
0 Cciose 7 

Supporting Information 

I Insert Dateli oe I ~ 

Informed Consent 
Form: 

Date Consent Form 
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Save Note 

Signatures 
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l~~errt~;:::~~:.Re=:lected F,,:d 0 
Note: Once a Consent fo rm has been s igned by a 
patient. the treatment case that the form is 
attached to cannot be deleted. 

r Treatment Plan case Setup 

Supporting Information 

G case status History 

® Settings 

• Remove a prompt: 

a. Select the prompt that you want to remove, and then click Remove. 

A confrmation message appears. 

b. Click Yes. 

6. In the Edit Consent Form Template dialog box, click OK. 

7. In the Template Setup dialog box, click Close. 

8. In the Consent Form dialog box, click Close because you do not want to attach the consent form to the 
case; you were only accessing a form so that you could modify a template. 

Setting Up the Consent Form Template 
Preference 
You can customize an option for handling consent form template prompts. 

Note: Only users with the “Consent Forms, Template Setup” security right enabled can modify the template 
preference. 

To set up the preference 

1. In the Treatment Planner, on the Navigation panel, 
open the Supporting Information section. 

2. Under Informed Consent, click Add. 

Te Consent Form dialog box appears. 

2 
3 

1 

6 
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Template Setup 

1±1 OralSUrgery EditT emplate 

Delete Template 

Move Up 

Move Down 

r Grouped Prompts Close 

3. Click the Template Setup button . 

Te Template Setup dialog box appears. 

4. Select or clear the Grouped Prompts check box. With 
this check box clear, if a template has multiple prompts, 
each prompt will appear in separate dialog boxes for you 
to respond to in the specifed order. With this check box 
selected, all the prompts for a template will appear in one 
dialog box. 

5. Click Close. 

6. In the Consent Form dialog box, click Close because you 
do not want to attach the consent form to the case; you 
were only accessing a form so that you could set up the 
preference. 

54 

Default Consent Form Template and 
Prompts 
Tere are default text and prompts for the consent form template that gets installed with Dentrix Enterprise. 

Note: Te template text contains prompts, which are enclosed in tildes (~). 

Template 

• Template Name – Oral and Maxillofacial Surgery 

• Category – Oral Surgery 

• Template Text: 

“Possible Risks or Complications: 

~Possible Risks or Complication~ 

Anesthetic Risks: 

~Anesthetic Risks~ 

Risks to my health if this procedure is not performed include, but are not limited to: 

~Risks to my health~ 

Patient Consent/Understanding: 

~Patient Consent/Understanding~ 

Disposal/Use  of extracted teeth and/or other tissues: 

~Disposal/Use of extr  teeth~ 

Teeth to be extracted:  

~Select teeth to be extracted~” 
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Prompts 

• Prompt #1: 

• Prompt Name – Possible Risks or Complication 

• Prompt Text – “Possible Risks or Complications:” 

• Response Type – Checkbox Responses 

• Items: 

• “‘Dry socket’ or slow healing of an extraction site 

• You may experience local swelling, bleeding, bruising, and/or pain after the procedure 

• Possible infection and/or hospitalization and/or death and/or referral to a specialist for further 
treatment 

• Injury to nerves in or around the mouth that could cause temporary or permanently numb lips, 
chin, tongue, or loss of taste sensation 

• Decision to leave a small piece of root in the jaw when its removal would require extensive 
surgery and an increased risk of complications 

• Sinus involvement that may require surgery at a later date 

• Injury to nearby teeth, soft tissues, or fllings 

• Sore jaw or restricted mouth opening or jaw joint problems 

• Unusual reaction to medications given or prescribed 

• Impaired healing of the bone due to drugs, radiation therapy, or infection” 

• Prompt #2: 

• Prompt Name – Anesthetic Risks 

• Prompt Text – “Anesthetic Risks:” 

• Response Type – Checkbox Responses 

• Items: 

• “Include discomfort, rapid pulse, swelling, bruising, infection, anxious feelings, allergic reactions, 
and lip chewing 

• Anesthetics occasionally are not efective in some patients” 

• Prompt #3: 

• Prompt Name – Risks to my health 

• Prompt Text – “Risks to my health if this procedure is not performed include, but are not limited to:” 

• Response Type – Checkbox Responses 

• Items: 

• “Pain 

• Infection 

• Cyst or tumor formation in the area of infected tooth 

• Loss of bone around the teeth causing their loss 

• Increased risk of complications if surgery is postponed to a later day 

• Possible delay of permanent tooth eruption 

• Other_______________ 
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• A perfect result from recommended treatment cannot be guaranteed. If unexpected problems 
arise during the procedure the doctor will do what is deemed necessary to correct the condition 

• Medications given or prescribed for pain may cause drowsiness” 

• Prompt # 4: 

• Prompt Name – Patient Consent/Understanding 

• Prompt Text – “Patient Consent/Understanding:” 

• Response Type – Checkbox Responses 

• Items: 

• “I consent and understand to the above and agree to cooperate with Dr._______________ for 
proposed treatment 

• I will follow post-operative instructions to the best of my ability for my own comfort and safety 

• I have had an opportunity to ask questions about the above treatment 

• I have been counseled not to drive or perform hazardous chores until I have recovered from the 
efects of these medications” 

• Prompt # 5: 

• Prompt Name – Disposal/Use of extr teeth 

• Prompt Text – “Disposal/Use of extracted teeth and/or other tissues:” 

• Response Type – One Response from List 

• Items: 

• “I consent to the disposal of my extracted teeth, including other tissues and possible use of my 
extracted teeth by qualifed authorities for scientifc or educational purposes 

• I consent to the disposal of my extracted teeth, including other tissues in accordance with clinic 
policy and regulations. However, I do not authorize the use of my extracted teeth or other tissues 
for scientifc or educational purposes” 

• Prompt #6: 

• Prompt Name – Select teeth to be extracted 

• Prompt Text – “Select tooth/teeth to be extracted:” 

• Response Type – Select Tooth 

• Allow multiple selections – Yes 
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1±1 0:wU,W 
; Rename Case 

Delete Case 

Set Case as Patient's Default Treatment Plan 

Consent Forms .. , 0 -----~ 

Treatment Plan Case Setup 

!±I D .. . 

D 1nc1ude Comp!eted Cases 

D 1nc1ude Rejected Cases 

, Treatment Plan c.,.., Setup 

■ 

Adding Consent Forms (Enhanced) to Cases 
In the Treatment Planner, from the Supporting Information and Treatment Plan Case Setup sections on 
the Navigation panel, you can add a consent form to a case, enter or modify the text of the form as needed, 
and then have all parties digitally sign it. 

Important: When you add a consent form to a case, before you can save the form, the patient (or his or her 
representative), someone from the practice (such the dentist), and a witness (or interpreter) must sign it. 

Note: Te consent form symbol next to a case varies depending on the status of the consent forms for the case. 

No consent forms are attached to the case. 

Signed consent forms are attached to the case. 

To add a consent form to a case 

1. In the Treatment Planner, in the Treatment Plan Case Setup section 
on the Navigation panel, select the case to which you want to add a 
consent form. 

2. Do one of the following: 

• In the Treatment Plan Case Setup section, right-click the 
selected case, and then click Consent Forms. Te Dentrix 
Consent Forms dialog box appears. 

2 

1

• Open the Supporting Information section on the Navigation panel, and then scroll down to 
Informed Consent. 
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Form: 

Date Consent Fonn 

< 

Save Note 

Signatures 

Remove Selected Form 

Select Cor>sent Form: 

!consent for Mesthesia ..:.1 

> 

Note: Once a Consent form has been signed by a 
patient, the treatment case that the form is 
attached to cannot be deleted. 

r Treabnent Plan case Setup 

ln5m'ance/ case Amounts 

Supporting Information 

Dentnx Consent Forms 

Forms for selected Case: 

Informed Consent 
Form; 

Date Consent Fonn 

< 

Signatures 

Remove Selected Form 

Select Consent Form: 

Consent for M esthesi 

Note: Once a Consent I s been signed by a 

> 

patient, the treatment case that the form is attached to 
cannot be deleted. 

~ 

" 

Supporting Information 

J Insert Dateline 11 ~ 

Informed Consent 

Form: 

Date Consent Fonn 

< 

Save Note 

Signatures 

> 

Select Consent F 

Consent for Me 

Remove Selected Fi r: 0 
Note: Once a Conse m has been s igned by a 
patient, the treatment case that the form is 
attac hed to cannot be de leted. 

" 

2 

4 
3 

4
3 

3. From the Select Consent Form list, select the form that you want to add to the selected case. 

Note: You can manage the default consent forms from the Settings section of the Navigation panel. 

4. Click Add. 
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Consent Form D X 

~ ent for Anesthesia 

I, the undersigned patient, hereby give my consent for the undersigned provider to administer an anesthetic prior to the 
dental procedure(s) or course(s) of treatment listed below in order to achieve < local or general> anesthesia. I have 
agreed to the use of the anesthetic(s) listed below to achieve the desired anesthesia affect. However, I underst at 
the desired state of anesthesia may not be achieved alone and other anesthetic procedures or drugs may quired. I 
consent to the use of these additional procedures and drugs. 

Patient/Representative signature 

0 
Name: I Dan B. Fisher 

Date: I 1211/2020 

Relationship to patient lc.:Se= lf ____ ___c==,.., 
Witness/Interpreter signature 

0 
Name: 

Date: @ 1!2020 ] 

B OralSUrgery 

Oral &Maxill ofacial Surgery 

B Anesthesia 

Risks 

Clear 

Practice s ignature 

0 
I 1211/2020 

1,111111980 

jF10007 

alSUrQery 

O ,QQ 
Pron!. ~ L CI~ 

Te Consent Form dialog box appears. 

5 

7 

89 10 

6 

7 

7 

Note: Te patient’s name, birth date, and chart number appear in the lower-right corner for your 
reference. 

5. Do any of the following as needed: 

• Enter the text of the consent form, or modify any existing text. 

• Use a template to enter text for the consent form: 

a. In the template pane (on the right), expand a category to view the list of available templates 
for that category by clicking the plus sign (+) next to the category name, and then locate the 
template that you want to use. 

b. Double-click the desired template. 
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Consent Form Template O X 

(1) Poss ible Risks or Complic,,tions:------------, 

D 'Dry socket' or slow heali ng of an extraction site ;,, 
D You may experience loc,, I swelling, bleeding, bruising, and/or p, 
D Possible infection and/or hospitalization and/or death and/or ref,e 
D Injury to nerves in or aroulld the mouth that could c,,use temper, 
D Decis ion to leave a small piece of root in the jaw when its remm 

D Sinus involvement that may require surgery at a later date 
D Injury to nearby teeth. soft tissues. or fillings 
D Sore jaw or restricted mouth opening or jaw joint problems "" 
< > 

(3) Ris ks to my hea lth if this procedure is not performed include , but 
are not li mited to: 

D Pain " 
D Infection 
D Cyst or tumor formation in the area of infected tooth 

D Loss of bone a roulld the teeth c,,us ing their loss 
D Increased risk of complications if surgery is postponed to a late1 
D Poss ible de lay of permanent tooth eruption 
0 Other _____ _ 
D A perfect res ult from recommended treatment cannot be guarant "" 
< > 

[2]Anesthetic Risks :---------------, 

D Include discomfort. rapid pulse. swelling, bruising. infection, anxiou 
D Anesthetics occasionally are not effective in some patients 

< > 

(4) Patie nt ConsenUUllde rs tallding: ----------­

□ I consent a lld ullde rsta lld to the above a lld agree to cooperate with 
D I wi ll follow post-operative instroctions to the best of my ability for rr 
D I have had a n opportunity to ask questions a bout the a bove treatmer 
D I have been counseled not to drive or perform hazardous chores un1 

< > 

1

(5) Dis posal/Use of extracted teeth a oolor other tissues : 1(6] Select tooth/teeth to be extracted: 

I consent to the disposal of my extracted teeth. induding other tissues in c 

< ----~ > 

OK Cancel 

Any prompts that are associated with the template and that require responses appear. Te 
prompts may appear one at a time in individual dialog boxes, or they may appear grouped 
together in one dialog box. 

Note: A consent form template can have multiple prompts with an odontogram to select teeth, 
quadrants, or sextants, but the text of a consent form can have only one odontogram. If you use 
a template with multiple odontograms, one consolidated odontogram will be inserted into the 
form text with all the applicable selections. If an odontogram has already been inserted into the 
form text, you cannot use another template with an odontogram for the same form. 

c. Respond to the prompts that are associated with the template. If no prompts appear, skip this 
step. 

Te template text is automatically appended to any existing text for the consent form. 

d. After entering a clinical note using a template, edit the text, or enter additional text as needed. 

Note: To save the consent form, it must have text. Te text, including procedure information, can be up 
to 10,000 characters in length. 

6. Set up the following signature options: 

• Patient/Representative signature – Te patient selected in the Treatment Planner is entered in the 
Name box. Also, “Self ” is entered in the Relationship to patient box by default. If necessary, edit 
the patient information (for example, if the person signing is not the patient, enter the name of the 
patient’s spouse or parent, and enter “Spouse” or “Parent”). 

Note: Te signature, name, and relationship to patient are required to save the form. Once you save 
the form with a patient or patient representative signature (even the slightest mark registers as a 
signature), you cannot change the signature, name, and relationship. 
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• Practice signature – If the correct provider is not already entered in the Name box, click the search 
button to select the provider (primary or secondary) who will sign the form, or you can enter the 
provider’s name in the box. 

Note: Te signature and name are required to save the form. Once you save the form with a practice 
signature (even the slightest mark registers as a signature), you cannot change the signature and name. 

• Witness/Interpreter signature – In the Name box, enter the name of the witness or interpreter who 
will sign the form. 

Note: Te signature and name are required to save the form. Once you save the form with a witness 
or interpreter signature (even the slightest mark registers as a signature), you cannot change the 
signature and name. 

7. Have the patient or patient’s representative, the provider or staf member, and the witness or interpreter 
sign the consent form. All parties must sign before you can save the consent form. 

Notes: 

• If someone needs to re-sign, you can click the corresponding Clear button to clear the signature. 

• If there is at least one signature, you cannot change the text of the consent form. 

8. Click Save. 

Note: You can save the consent form only if it has text, all three names, the relationship to the patient, 
and all three signatures. 

9. Click Print. 

Note: You can print the consent form only if it is signed. 

10. Click Close. 

Te signed consent form appears in the list of forms for the selected case, and a copy is saved to the 
patient’s record as a Document Center document. 
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Signatures 
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Note: Once a Consent form has been signed by a 
patient, the treatment case that the form is 
attached to cannot be deleted. 

r Treatment Plan case Setup 

Supporting Information 
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V 

Treatment Plan Case Setup 

• I 

D Include Completed Cases 

D Include Rejected Cases 

r Treatment Plan case Setup 

■ 

Viewing and Printing Consent Forms 
(Enhanced) for Cases 
In the Treatment Planner, from the Supporting Information and Treatment Plan Case Setup sections on 
the Navigation panel, you can view and print a consent form that is attached to a case. 

Note: When you view a consent form for a specifc case, the information about that case that is listed in 
the case detail is shown at the bottom of the consent form if the form allows the viewing of procedure 
information, so patients know exactly which procedures they are giving consent to have performed. 

To view and print a consent form for a case 

1. In the Treatment Planner, in the Treatment Plan Case Setup section 
on the Navigation panel, select the case with the consent form that 
you want to view. 

2. Do one of the following: 

• In the Treatment Plan Case Setup section, right-click the 
selected case, and then click Consent Forms. Te Dentrix 
Consent Forms dialog box appears. 

1

2 

• Open the Supporting Information section on the Navigation panel, and then scroll down to 
Informed Consent. 

2 
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Dentnx Consent Forms 

Forms for selected Case: 

Informed Consent 

Form: 

Consent Fonn Signatures 

< 

Select Consent Form: 

!consent for .Anesthesia 

Remove Selected Form 

> 

Supporting Information 

Informed Consent 
Form: 

Consent Fonn 

< 

Signatures 

Remove Selected Form 

Select Consent Form: 

!consent for .Anesthesia 

> 

Note: Once a Consent form has been signed by a 
patient. the treatment case that the form is attached to 
cannot be deleted. 

Note: Once a Consent form has been signed by a 
patient, the treatment case that the form is 
attached to cannot be deleted. 

Consent Form D X 

I Consent for Anesthesia 

I, the undersigned patient, hereby give my consent for the undersigned provider to administer an anesthetic prior " 
to the dental procedure(s) or course(s) of treatment listed below in order to achieve < local or general> 
anesthesia . I have agreed to the use of the anesthetic(s) listed below to achieve the desired anesthesia affect. 
However, I understand that the desired state of anesthesia may not be achieved alone and other anesthetic 
procedures or drugs may be required. I consent to the use of these additional procedures and drugs. 

I understand the risks inherent in anesthesia. I have discussed these risks w ith the dentist and acknow ledge that 
they include, but are not limited to : allergic reaction, infection, bleeding, phlebitis ( irritation of vein ), nausea, blood 
clots, loss of limb function, paralysis, stroke, heart attack, brain damage, or death. 

I am aware of the fact that I w ill not be able to drive or operate any dangerous device for at least 24 hours after 
the procedure. I understand that I must have someone transport me to and from the office and care for me until I 
am able to care for myself. 

Patient/Representative signature Practice signature 

Clear 

Name: I Dan B. Fisher Name: I Dennis Smith, D.M.D 

Date: I 1211 /2020 Time: I 1 :05 PM Date: I 1211/2020 Time: IL1_:0_5_P_M __ ~ 
Relationshi p to patient: I Self 

~-------~ 

Witness/Interpreter signature Patient ldentiliciilion: 

Last, First Name: IRsher, Dan 

Clear 
Date of Birth: 111 / 11 / 1980 

Name: n/a 
Chart II: IF10007 

:====,---------;;====='--, 
Date: I 1211/2020 Time: 11:05 PM 

.., 

Te consent forms that are attached to the case appear in the Form list. 

3 
3 

Note: For each attached consent form, the date when it was signed (if applicable), its name, and who 
signed (patient and/or provider, if applicable) appear for your reference. 

3. Double-click the correct form. 

Te Consent Form dialog box appears. 

4 

5 6 

4. If any of the text of the consent form was entered using a template with prompts, to view the 
corresponding responses, click the View Prompts button . 
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Consent Form Prompts D X 

-111 Possible Risks or Complications:----------~ -121 Anesthetic Risks:---------------~ 

D 'Dry socket' or slow healing of an extraction site ;,. Include discomfort. rapid pulse. swelling, bruising. infection, anx.iou 
You may experience local swelling, bleeding, bruising, and/or pc D Anesthetics occasionally are not effective in some patients 

~ Poss ible infection aoolor OOSpitalization and/or death and/or refE 
D Injury to nerves in or around the mouth that could cause temporc 
D Decision to leave a small piece of root in the jaw when its remm 
D Sinus involvement that may require surgery at a later date 
O Injury to nearby teeth. soft tissues. or fi llings 
D Sore jaw or restricted mouth opening or jaw joint problems .., 
< > 

< > 

-131 Risks to my health if this procedure is not performed include. but - -141 Patient ConsenVUnderstanding: -----------, 
are not limited to: 

Pain 
~ Infection 
D Cyst or tumor formation in the area of infected tooth 

O Loss of bone around the teeth causing their loss 
0 locreased risk of complications if surgery is postponed to a late1 

O Possible delay of permanent tooth eruption 
0 Other ____ _ 

D A perfect res ult from recommended treatment cannot be guarant "" 
< > 

I con.sent aOO understaOO to the above and agree to cooperate with 

0 I wi ll follow post-operative instructions to the best of my ability for n 
O I have had an opportunity to ask questions about the above treatmer 
D I have been counseled not to drive or perform hazardous chores un1 

< > 

~

15) Disposal/Use of extracted teeth a nd/or other tissues: ~ 16] Select tootMeeth to be extracted: 

I consent to the disposal of my extracted teeth. ind uding other tissues inc 

< > 

OK O,ncel 

Treatment Plan 
Created: 5/17/2010 

2750: Crown-pore fuse high noble mtl [tf3 ] 
D2150: Amalgam-2 surf. prim/perm [tt14 MO,] 
D5120: Complete denture - mandibular [tt18-31 ] 

Edit or Delete Procedure 

Operator: I ENTERPRISE 

Dale: J04/16/2013 

rocedure: JD2391 2:J R 

Clinic rt C_E_N_T-RA_L __ 2j 
Tooth:[i'T 

~ -----
» 

100.00 

0.00 

2:.1 

,·--------

ncounter #: I 
Start Date: Completion Date: 

in composite-1 s, posterim 

0 verride Ins. estimate 

r P,im.lns r---­

r Sec. Ins. r----
r Do Not Bill Dental Insurance 

Procedu,e Status 

r. T ,eatment Plan 
Approval Status 

JNone ..:J 
r Completed 

(" E>1isting-Current Prov 

r E>1isting-Other P,ov 

r Require Start/Completion Date Modifier: I 
r Over,ide Proc Flags 

e,al scaling with hand instruments. Ult,asonic scaler on lower anteriors-lingual. 
Bak g soda used on upper and lower arch. Flossed all contacts. Patient rinsed 
with a medicated rinse after P>1. 

ID Number Type ID Number 

21 Remove l ha ..:.1 

You cannot edit any of the responses. When you are fnished viewing the responses, click OK. 

5. To print the consent form, click Print. 

6. Click Close. 

Editing and Deleting Procedures 
You can edit or delete existing treatment-planned procedures that are not in history. 

To edit or delete a treatment-planned procedure 

1. In the Treatment Planner, on the Navigation panel, 
from the Treatment Plan Case Setup section, expand 
the appropriate case by clicking the plus sign (+), and 
then double-click a procedure. 

1 

Te Edit or Delete Procedure dialog 
box appears. 

2. Do one of the following: 

• Make any necessary changes, and 
then click OK. For information 
about the options that are 
available for editing, see “Entering 
Treatment” in Chapter 4: Patient 
Chart. 

• Click Delete and then OK to delete 
the procedure. Te treatment-
planned procedure is removed from 
the Treatment Planner, Patient 

2 

OR 

2 
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El 

Tx Cli nics : 

AF 
CENTRAL 
DRAPER 
MESA 
No Oinic 
PINFnAI F 

Create Visit 

Delete Visit 

Move to Visit 1 (NEW) 

Treatment Plan Case Setup 

.- , ~ F' 

T x Providers : Billing Type for Patient's Guarantor: 

AMCCLURE 1: Standard Billing -finance charges 
DDS1 

~ 
2: Standard Billing - no finance charge 

DDS2 3: Insurance Family - delay finance chc 
DEF PROV 4: Insurance Family-finance charges 
DESMITH 5: Payment Plan -finance charges 
nHAYFS f'.; - P;:n.'!TIPnt Pb:m - nn fin;:in,...P rhr1mP~ 

Chart, and Ledger-Treatment Plan. 

Tip: To delete multiple procedures at the same time, in the Treatment Plan Case Setup section, while 
pressing the Ctrl key, click the procedures you want to delete. Next, right-click one of the selected procedures, 
and then click Delete Procedure(s). Ten, on the confrmation message that appears, click Yes. 

Posting Completed Procedures 
After you complete procedures, you can post those procedures from the Treatment Planner. 

To post a completed procedure 

In the Treatment Planner, on the Navigation panel, from 
the Treatment Plan Case Setup section, expand the 
appropriate case by clicking the plus sign (+), right-click 
the procedure you want to complete, and then click Set 
Complete. 

Tips: 

• To complete multiple procedures at the same time, while pressing the Ctrl key, click the procedures that 
you want to complete. Next, right-click one of the selected procedures, and then click Set Complete. 

• To set all the procedures in a selected case complete at the same time, click the Update Case Status 
button on the Treatment Plan Case Setup section’s toolbar, and then click Completed. 

• In the case details, a blue check mark appears next to any completed procedures. 

Updating Treatment Plan Fees 
To maintain the integrity of treatment plan estimates, Dentrix Enterprise does not automatically update the 
fees for procedures assigned to a treatment plan. If your fees have changed since the time a treatment plan 
was given to a patient, that treatment plan can be manually updated for that patient from the Treatment 
Planner to refect any fee schedule changes if certain criteria you specify for the procedures are met. You can 
also update treatment plan fees for all patients with treatment-planned procedures matching the criteria you 
specify. 

To update treatment plan fees 

1. In the Treatment Planner, from the Edit menu, click Update 
Treatment Plan Fees. 

Te Update Treatment Plan Fees dialog box appears. 

2. Set up the following options: 

• Update Treatment Plan Fees For – To update the fees for 
the currently selected patient only, select “Current Patient.” 
To update the fees for all patients with treatment plans, 
select “All Patients.” 

1 

• Procedure Information – Tis tab 
provides the following options for 
updating treatment plan fees: 2 

• Procedure Code(s) – Select 
the procedure or range of the 
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procedures to update for From and To. To update all procedures, leave From “<All>” To 
“<All>”selected. 

• Procedure Date Before – Select the cut-of date to use for updating fees for treatment-planned 
procedures. Only treatment-planned procedures dated on or before the selected date will be 
updated with the new fees. 

• Tx Clinics – To update treatment-planned procedures performed in specifc clinics, select the 
desired clinics (to select multiple clinics, while pressing the Ctrl key, click each clinic), or leave 
All selected to update procedures for all clinics. 

• Tx Provider – To update treatment-planned procedures performed by a specifc provider, select 
the providers (to select multiple providers, while pressing the Ctrl key, click each provider), or 
leave All selected to update procedures for all providers. 

• Billing Type for Patient’s Guarantor – If you are updating treatment plan fees for all patients, 
to update treatment-planned procedures for patients with specifc billing types, select the billing 
types (to select multiple billing types, while pressing the Ctrl key, click each billing type), or leave 
All selected to update procedures for patients with any billing type. 
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Update Treatment Plan Fees 

Update Treatment Plan Fees For: l eurrent Patient ..:.l 
Procedure Information j i Case Information i I~------------~ 

Update Treatment Planned Procedures in Cases With 

C urrent Status: 

Created 
Pnnted ~ 
Pre-Auth (Pnm) Li 
Pre-Auth (Sec) 
Follow-Up Made 
Referred 

l't] Al l 

Severi ty: 

!Immediate 
Eventual 
Optional 
None 

l't] Al l 

Case Financil')9 Flag: 

In Progress 
Needed 
Not Necessary 
Pending More Information 

l't] Al l 

El Exclude Default Treatment Plan 

[J Estimate Expiration Date Before: 

1 o.:·1&2012 GI 

• Case Information – Tis tab provides the following options for updating treatment plan fees: 

• Current Status – To update treatment-
planned procedures in cases with 
specifc statuses, select the case 
statuses, or leave All selected to update 
treatment-planned procedures in cases 
with any status. 

• Case Financing Flag – To update 
treatment-planned procedures in cases 
with specifc fnancing fags, select the 
fnancing types, or leave All selected to 
update treatment-planned procedures 
in cases with any fnancing fag. 

• Severity – To update treatment-
planned procedures in cases with 
specifc case severities, select the 
severity levels, or leave All selected to 
update treatment-planned procedures 
in cases with any severity. 

3 

• Exclude Default Treatment Plan – To exclude all procedures added to a default treatment plan, 
select this option. 

• Estimate Expiration Date Before – To update fees for procedures in cases created prior to but 
not on the date specifed, select this option, and then select a cut-of date. 

3. Click Update. 

Important: Depending upon which fee schedule is assigned to the patient, the fee for the patient’s 
treatment-planned procedures might not have been updated or not updated with the fee you might have 
expected. For more information about fee schedule hierarchy, see the “Updating treatment plan fees” 
topic in the Dentrix Enterprise Help. 
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L] 

Print Treatment Case 

Select Report Options : 

I Default [Modrried] 

Print 

rJ T reetment Plan Total 

rJ Finance Status 

rJ Patient Balance 

rJ Family Balance 

E] Fee Expiration Date 

rJ Treatment u se Note 

rJ Grapltic Cltart 

rJ Signed Consent Forms 

Appearance Options 

ll'\Surance 

E] Hide Dental Insurance Benefi ts 

rJ Hide Insurance Estimates 

rJ Hide Family Insurance Benefi ts 

rJ ~~ 8:.;':\i~:~ Maximums 

Patient Privacy 

rJ Hide Patient SSN 

rJ Hide Patient Chart Number 

rJ Hide Patient Birtltday 

Tooth Style: '"ls-h-ad_e_d ___ ..:.l--, Website Address: 

Report Style: I Contemporary ..:.J 
Header Styfo: I Provider Name ...:J 
rJ Use Cover Page 

E-mail Address : 

I Save Options .. Manage Options .. E] Pri nt Previel'I 

use Procedure Options 

Select Visits: 

Enter visit numbers and/or visit 
ranges. Example: 1.3. 5-7 

I'.'.'] Print Subtotals by Vis it 

I'.'.'] Use Patient Friendly Descriptions 

I'.'.'] Include Procedure Notes 

I'.'.'] Exclude Completed Procedures 

I'.'.'] Compare to Fee scltedule: 

[i Office j GJ 
Select Columns ... 

~-O_K_~! [ Cancel 

Generating Treatment Planner Reports 
You can print the following Treatment Planner reports: 

• Treatment Case Report – To report on a specifc case. 

• Patient Treatment Case Report – To report on the current patient. 

• Patient Proposed Treatment Case Report – To report on the current patient’s proposed cases. 

• Practice Treatment Case Report – To report on the whole practice. 

To generate a Treatment Planner report 

1. In the Treatment Planner, on the Navigation panel, from the Treatment Plan Case Setup section, select a 
case. 

2. From the File menu, point to Print, and then click the report you want to generate. (For the Patient 
Proposed Treatment Case Report, ignore steps 3 – 4.) 

3. Set up the report options. Te options for each report are explained in the sections that follow. 

4. Click OK. 

Treatment Case Report Options 
From the Print Treatment Case dialog box, set up any of the following options: 

• Print – Select the information you 
want to include. 

• Insurance – Select the insurance 
information you want to exclude. 
To include the amount of any 
deductibles applied, select Use 
Dental Plan Maximums and 
Deductibles. 

• Patient Privacy – Select the 
patient information you want to 
exclude. 

• Case Procedure Options 

• Type a visit or range of visits 
(for example, 1, 3, 5-7) you 
want to include on the report 
in the Select Visits feld, or 
leave “<ALL>” entered to 
include all visits. 

• Select the visit-specifc information you want to include. 

• To include a comparison of the current fee schedule to a selected fee schedule, select the Compare to 
Fee Schedule search button , and select a fee schedule. 

Tips: 

• To save the current report settings as a set for the next time you run this report, click Save Options. 

• To preview the report before printing it, select Print Preview. 
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at ient Treatment Case Report 

Erocedure Code Date Range 

F rem O I 08/1 5/2008 .:.J To: 0 I 08/15/2008 .:.J 
0 AII Dales 0 AII Dates 

By 0 Iniij;tiaii,] O Procedure Date 

Case [ee Expiration Date Range 

From O I 08/1 5/2008 .:.J TO O I 08/15/2008 .:.J 
0 AII Dates 0 AII Dates 

Select Proyider 

From: I <ALL> I Q 
fl.eport Options 

0 Print S ubtolals by Visit 

0 Include Finance S talus 

D Use Patient Friendl_i,.i Descriptions 

0 Exclude Completed Procedures from Case 

@ Include Patient Balance 

0 Include Family Balance 

D Use Dental Plan Ma,imums and Deductibles 

0 Compare lo Fee Schedule: I 1. FEE 1 I Q 
I ,2elect Columns ... 

D Save as Q_efaull 

D Print Preview 

Include Cases With 

,hase S talus: 

Created 
Printed 
Pre-Aulh (Prim) 
Pre-Aulh (Sec) 
Follow-Up Made 
Referred 
Proposed 
Accepted 
Rejected 
Completed 

0 AII 

C2se S everit_y: 

!
Immediate 
Eventual (F utu,e) 
Optional 
NONE 

0 AII 

Palient Privac_y 

0 Hide Patient SSN 

D Hide P alien! Chari Number 

0 Hide P alien! B irlhdale 

__ o_K _ _,11 I Cancel 

GJ 

Patient Treatment Case Report Options 
From the Patient Treatment Case Report dialog box, set up any of the following options: 

• Procedure Code Date Range – Enter a 
date or date range of treatment-planned 
procedures posted in the range to include. 
To include all dates, select All Dates for 
From and To. 

• Case Fee Expiration Date Range – 
Enter a date or date range of cases with 
an expiration date within that range to 
include. To include all dates, select All 
Dates for From and To. 

• Select Provider – To select a provider 
or range of providers for the patient’s 
treatment-planned procedures to include, 
click the From and To search buttons 

, and select the providers. To include 
all providers, leave From “<ALL>” To 
“<ALL>” entered. 

• Report Options 

• Select the options that correspond to 
the information you want to include. 

• To include a comparison of the current 
fee schedule to a selected fee schedule, select the Compare to Fee Schedule search button , and 
select a fee schedule. 

• Include Cases With – Select the case statuses that you want to include, or select All to include all 
statuses. Also, select the case severities that you want to include, or select All to include all severity levels. 

• Patient Privacy – Select the options that correspond to the patient information you want to exclude. 

Tips: 

• To save the current report settings as a set for the next time you run this report, select Save as Default. 

• To preview the report before printing it, select Print Preview. 

Patient Proposed Treatment Case Report 
Tere are no options to set up for this report. 
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Practice Treatment Case Report 

Include C[inic: Choose Patient Clinic 8'£: 
<- Al l Clinics C. Patient Default 

r Tltis Clinic r Treatment Case 

;i:elect Patient 

From: I <ALL> I D 
To: I !<ALL> I D 

f rocedure Code Date Range 

From: 0 104/ 16/2013 ..:.J To: 0 104/ 16/2013 ..:.J 
@ Al l Dates @ Al l Dates 

By: @ Entry Date e') Procedure Date 

Case Eee Expiration Date Range 

From: 0 104/ 16/2013 ..:.J To O 104/ 16/2013 ..:.J 
@ Al l Dates @ Al l Dates 

Select Proy:ider 

From I <ALL> I Q To I <ALL> I Q 

Select !iilling Type 

From I <ALL> I Q To I <ALL> I Q 

B_eport Options 

rJ Print Condensed Report 

rJ Print Subtota ls by Visit 

rJ Include Finance Status 

rJ Include Procedures for TreatmentCase 

D Use Patient Friendly Descriptions 

rJ Use Dental Plan Maximums and Deductibles 

rJ Exclude Completed Procedures from Case 

rJ Include Case Status History 

Include Cases Witlt: 

Case Status : 

Created 
Pnnted 
Pre-Auth (Pnm) 
Pre-Auth (Sec) 
Follow-Up Made 
Referred 
Proposed 
Accepted 
Rejected 
Completed 

0 Al l 

Case Severity: 

!
Immediate 
Eventual (Future) 
Optional 
NONE 

0 Al l 

Patient Privacy 

r:J Hide Patient SSN 

r:J Hide Patient Chart Number 

Cl Hide Patient Birthday 

r:J Save as Default 

IC) Prir-.t Previe"' 

OK Cancel 

Practice Treatment Case Report Options 
From the Practice Treatment Case Report dialog box, set up any of the following options: 

• Select Patient – To select a patient or 
range of patients with treatment-planned 
procedures within the range to include, 
click the From and To search buttons , 
and select the patient(s). You can also type 
names or partial last names (for example, 
From “a” To “c”) in the felds. To include 
all patients, leave From “<ALL>” To 
“<ALL>” entered. 

• Procedure Code Date Range – Enter a 
date or date range of treatment-planned 
procedures posted in the range to include. 
To include all dates, select All Dates for 
From and To. Also, select whether you 
want to include procedures by Entry Date 
or Procedure Date. 

• Case Fee Expiration Date Range – 
Enter a date or date range of cases with 
an expiration date within that range to 
include. To include all dates, select All 
Dates for From and To. 

• Select Provider – To select a provider 
or range of providers for the patients’ 
treatment-planned procedures to include, 
click the From and To search buttons 
, and select the provider(s). To include 
all providers, leave From “<ALL>” To 
“<ALL>” entered. 

• Select Billing Type – To select a billing type or range of billing types of patients with treatment-planned 
procedures to include, click the From and To search buttons , and select the billing type(s). 

• Report Options – Select the information you want to include. 

• Include Cases With – Select the case statuses that you want to include, or select All to include all 
statuses. Also, select the case severities that you want to include, or select All to include all severity levels. 

• Patient Privacy – Select the patient information you want to exclude. 

Tips: 

• To save the current report settings as a set for the next time you run this report, select Save as Default. 

• To preview the report before printing it, select Print Preview. 
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Chapter 7: Ledger 
Te Dentrix Enterprise Ledger displays a wealth of information in an easy-to-read format. Also, from the 
Ledger, you can enter payments, fle claims, print statements, and much more. 

Tis chapter covers the following topics about using the Ledger: 

• Te Ledger Window 

• Selecting Ledger Views 

• Changing an Account’s Billing Type 

• Entering Transactions 

• Editing Current Transactions 

• Deleting Current Transactions 

• Invalidating Transactions in History 

• Processing Dental Insurance Claims 

• Processing Medical Insurance Claims 

• Working with Treatment Plans 

• Generating Ledger Reports 

• Using Fast Checkout 

• Posting Batch Guarantor Payments 

• Posting Batch Insurance Payments 

• Searching for Payments 

• Working with Payment Plans 

• Using the Suspended Credits Manager 

• Working with Notes in the Ledger 

• Performing Month-end Routines 
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03/31/2003 Brent Crosby 
03/31/2003 < Fami ly> 
04/01/ 2003 Brent Crosby 
04/01/ 2003 Brent Crosby 
04/01/2003 Brent Crosby 
04/01/2003 Brent Crosby 
04/01/ 2003 Brent Crosby 
04/01/ 2003 Brent Crosby 

UR 
UL 
LL 
LR 

09630 
09630 
09630 
REFOS 

30.00 DESMITH AF 
-30.00 DESMITH AF 

Fu ll mouth debridemnt,eval/di .. , 50.00 MHAYES AF 
IRRIGATION PER QUAD 30.00 MHAYES AF 
IRRIGATION PER QUAD 30.00 MHAYES AF 
IRRIGATION PER QUAD 30.00 MHAYES AF 
IRRIGATION PER QUAD 30.00 MHAYES AF 
Referred To Oral Surgery 0.00 MHAYES AF 

06/19/ 2003 <Family> Payme... Ca re Credit -1495.00 DESMITH AF 
06/19/2003 <Fami ly> Adjust... Special Adj -1495.00 MHAYES AF 
06/19/2003 Brent Crosby Adjust... Special Ad j 1495.00 DESMITH AF 

In, 

No 
No 
No 
No 
No 
No 

12/03/2013 Brent Crosby O 14 D2391 Resin-1 surface,. poster R 90.00 DESMITH AF X 

AP 

05 5 2014 Brent Crosb Ml 20 D2150 Ama1gam-2 surf. pri m/ perm 125.00 DESMITH CENTRAL 

mmm111r.l!!l!ln.l!!'l!l•••■----•iihiffi•ititlufiiffiiiitil•li,:,■•••••--!miim--

31 -->60 61 -->90 91 --> Suspended 
0.00 0.00 0.00 0.00 

0.00 0.00 110.00 O.OO Payment Agreement Summary 
;=,_---------------------\-~ ~mount NA Pmt Due 

31 -->60 61 -->90 91 --> Suspended 

Billing Type (13)ManagedCareAccount LAmt_Past Due NA Due Date 
Last Gua,. Payment 1495.00 
Last Ins. Pa,ment 0.00 
Last Statement Date 
Outstanding Billed to edical/Dental 
Expected hom Dental surance 
Guarantor Portion of T tal Balance 

0.00 Payment 
0.00 Due Date 

Balance 

30.00 
0.00 

50.00 
80.00 

110.00 
140.00 
170.00 
170.00 

-1325.00 
-2820.00 
-1325.00 
-1235.00 
-1110.00 

The Ledger Window 
Te Ledger window consists of the menu bar, toolbar, transaction log, and various sections containing 
fnancial information. 

Transaction log 

Today’s 
charges 

Account information 

Tis section covers the following topics to help you understand how to use the Ledger window: 

• Te Ledger Toolbar 

• Te Transaction Log 

• Viewing Aged Balances 

• Viewing Account Information 

• Viewing Today’s Charges 

• Viewing Payment Agreement Information 

• Viewing Future Due Payment Plan Information 

Aged balances 

Payment 
agreement 
summary 

Future due 
payment 
plan 
summary 
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The Ledger Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Ledger are explained in the following table. 

Click the Patient Financing button to go to the Citi website to sign up and manage patient 
fnancing options. 

Click the Select Patient button to select a patient whose record you want to view in the Ledger. 

Click the Patient Finances button to view and add payment plans and change account billing types. 

Click the Guarantor Notes button to enter notes for an account and/or that account’s billing 
statements. 

Click the Enter Payment button to enter patient payments. 

Click the Enter Procedure button to post procedures to a patient’s Ledger. 

Click the Ins. Today’s Proc button to create and then display and/or batch (according to the setup 
options selected) an insurance claim for any procedures posted on the current system date. 
Click the Ins. Selected Proc. button to create and then display and/or batch (according to the setup 
options selected) an insurance claim for the selected procedures. 
Click the Print Walkout button to display and/or batch (according to the setup options selected) a 
family walkout statement. 
Click the Print Statement button to display and/or batch (according to the setup options selected) a 
billing statement. 
Click the Print Family Ledger button to display and/or batch (according to the setup options 
selected) a family ledger report. 

Click the Fast Checkout button to perform a fast checkout (according to the setup options selected). 

Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed 
in the Ledger. 
Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient 
currently being viewed in the Ledger. 
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Date Name 

05/15/ 2014 Sh irl ey Crosby 
05/15/ 2014 Sh irl ey Crosby 
05/15/ 2014 Sh irl ey Crosby 
05/15/ 2014 Sh irl ey Crosby 
05/15/2014 Sh irl ey Crosby 
05/15/ 2014 <Famil > 

Surface 

MO 

Tooth Check# Code Descri tion 

D2150 Ama lqam-2 surf. prim/ perm 
D3lli Pul pa l debridemnt-prim/ perm .. . 

UL D4220 Ginqiv curettaqe,surqica l / quad 
Dlll0 Prophylaxis-adult 
D0150 Comp ora l eva l-new/ estab pat 

1234234 Payme.. . Check Payment - Thank You 

----■ 
Prim Dental Claim - Sent 125 00 

N R D M s Amount Provider Clini c Ins AP 

125.00 DESMITH CENTRAL 
./> 0.00 DESMITH CENTRAL X 

190.00 DESMITH CENTRAL X 
f, 65.00 DESMITH CENTRAL X 

R f, 85.00 DESMITH CENTRAL X 
S -1000.00 <Multi pl ... CENTRAL 

■■■•■--ma-• 

Balance 

125.00 
125.00 
315.00 
380.00 
465.00 

-535.00 
II 

The Transaction Log 
Te transaction log is a written record of all transactions posted to a patient/family’s account. For each 
transaction, the date, patient or guarantor name, tooth number and surface (when applicable), procedure code 
or type, a description, amount, provider, and clinic are shown and whether or not insurance has been billed is 
indicated. 

Each column provides useful information about a fnancial transaction or procedure: 

• Date – Te date of the transaction or procedure. 

• Entry Date – Te date that the transaction or procedure was entered. Tis may be diferent than the 
Date; for example, if you backdated or postdated the transaction or procedure. 

• Name (Patient Name) – Te name of the patient associated with the transaction or procedure. For a 
fnancial transaction (payment, adjustment, and so forth), if it has been applied to the family, “<Family>” 
appears, or if it has been applied to the guarantor, the guarantor’s name appears. 

• Surface (Tooth Surface(s)) – Te surface associated with the procedure. 

• Tooth (Tooth Number) – Te tooth associated with the procedure. 

• Check # – Te check number associated with the payment. 

• Code (Procedure/Transaction Code) – Te associated procedure code, fnancial transaction type 
(payment, adjustment, or so forth), or “Ins” for claims. 

• * (Transaction Flags) – In this column, any of the following symbols may appear: 

* – An asterisk indicates that the transaction has been moved to history. History transactions cannot 
be edited or deleted. 

+ – A plus sign indicates that the procedure has been invalidated. Invalidated procedures still show on 
the Ledger but no longer appear in the Patient Chart. 

^ – A carat indicates that the procedure has been back dated to a month that has been closed out. 
When the procedure is moved to history, the carat will change to an asterisk. 

• Description – Te description of the transaction or procedure. 

• N (Has Note) – A musical note in this column indicates that there is a note attached to the procedure. 

• R (Has Referral by) – A letter R in this column indicates that a referral is attached to the procedure. 

• D (Has Diagnosis) – A letter D in this column indicates that the procedure has been cross coded with a 
dental diagnostic code. 

• M (Has Medical Cross Coding) – A triangle (appearance varies) in this column indicates that a certain 
stage of medical cross coding has been done for the procedure. 

• S (Payment Contains Suspended amount) – A letter S in this column indicates that the payment has a 
suspended amount. 

• Amount – Te amount of the transaction. 

• Provider – Te provider associated with the transaction. 

• Clinic – Te clinic associated with the transaction. 



Chapter 7: Ledger    257 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

0-->30 31-->60 61-->90 91--> Suspended Patient Bala nee 
480.00 350.00 1280.00 3071.00 0.00 5181.00 

0-->30 31-->60 61-->90 91--> Suspended Family Balance 

985.00 350.00 1280.00 3161.00 

Billing Type (13) Managed Care Account 
Last 6 uar. Payment 
Last Ins. Payment 
Last Statement Date 
Outstanding Billed to Medical/Dental 
Expected from Dental Insur a nee 
Guarantor Portion of Total Balance 

Today's Charges 
Est. Dental Ins. Portion 
Est. Patient Portion 

Pa ment A reement Summar 

Monthly Pmt 
Amt Past Due 

448.17 
000 

PmtDue 
Due Date 

-449.00 5327.00 

20. 00 Date 0410712015 
140.00 Date 0312412015 

0711512015 
165 0010 00 

000 
5776.00 

125.00 
125.00 

0.00 

448.17 
1212012008 

• Ins (Insurance Claim Created) – Any of the following may appear: 

X – An X in the Ins column indicates that the procedure is fagged as “Do Not Bill To Insurance.” 

No – A No in the Ins column indicates that the procedure is not attached to a claim. 

• AP (Approval) – If you are viewing the Ledger-Treatment Plan view, an approval status associated with 
the treatment-planned procedure may appear. 

• Balance (Running Balance) – Te patient’s or family’s running balance (depending on the Ledger view). 
Tis column only shows amounts if the transaction log is being sorted chronologically (in ascending 
order) by the Date column. 

Viewing Aged Balances 
Te aged balances and the total balances for the current patient and family are displayed. Any suspended 
amounts are also shown. 

Viewing Account Information 
Te account information displayed includes the billing type, amount and date of the last guarantor payment, 
amount and date of last insurance payment, date of the last statement, total amount of all outstanding claims, 
estimated amount insurance will pay, and estimated amount of the patient portion. 

Viewing Today’s Charges 
For the current system date, the total of all transactions, the estimated amount that dental insurance will pay 
according to the coverage setup in the Family File, and the estimated amount the patient owes according to 
the coverage setup in the Family File are displayed. 

Viewing Payment Agreement Information 
If a payment agreement exists for the account, the current status of the agreement appears. For information 
about setting up payment agreements, see “Creating Payment Agreements” in this chapter. 

Note: Any existing payment agreements from versions of Dentrix Enterprise prior to 11.0.2 Update 4 are 
converted to payment plans during the upgrade of Dentrix Enterprise to the current version. 
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Original Bal. 
Remain Bal. 

Future Due Pa ment Plans: Summar 

3000.00 
2500.00 

Payment 
Due Date 

2500.00 
Thu. 15th 

Viewing Future Due Payment Plan 
Information 
If a future due payment plan exists for the account, the current status of the payment plan is shown. For 
information about setting up future due payment plans, see “Creating Future Due Payment Plans” in this 
chapter. 

Selecting Ledger Views 
While in the Ledger, you can choose to display account information in several diferent ways. 

To switch between the Ledger views 

• Options – In the Ledger, with a patient selected, from the Options menu, select a view option. Te 
option with a check mark is the view currently being used. Te Ledger title bar also indicates the current 
view. 

• Ledger – When frst opened, the Ledger displays all transactions posted during the current month for 
the selected patient. 

• Ledger + History – You can see all transactions for the selected patient, including history 
transactions. 

• Treatment Plan – You can view and work with a patient’s treatment plan. 

• View – In the Ledger, with a patient selected, from the View menu, select a view option. Te checked 
option is the view currently being used. 

• Show Transaction Links – When the transaction for which you want to fnd links is selected, 
you can see all of the procedures that are linked to an insurance claim and all of the payments and 
adjustments that are linked to a procedure. 

• All With Running Balance – You can view transactions for the entire family. In addition, a column 
is added to the right side of the transaction log that displays a running balance for the account. 

• Family Members – You can quickly switch to any family member’s ledger by selecting that family 
member. 
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Billing Type 

1. Standard Billing - finance charges 

Guarantor Notes 

Account Note 

Billing Statement Note 

Print on Statement until: 11/10/2021 

Surface Tor 

_ox 

a() 
Billing Type Selection 

1. Standard Billi ance charges 

2. Standard Bi lli ng - no finance char .. . 

3. Insurance Family - delay finance c .. . 

4. Insurance Fami ly - finance charges 

4¥!:iiii 

Changing an Account’s Billing Type 
You can use billing types to group accounts into categories for billing and reporting purposes. For example, 
if you do not want to bill certain families, or if you need to indicate that you sent an account to collections, 
you can assign them a distinct billing type to keep them separate from other patients when you run reports or 
print statements. You can easily change an account’s billing type as needed (for instance, when the account has 
been sent to collections). 

You assign billing types per account. When you assign a billing type to a patient, Dentrix Enterprise assigns 
everyone in that patient’s family in the Family File that billing type. 

To change an account’s billing type 

1. In the Ledger, with a patient selected, on the File menu, click 
Patient Finances. 1 

Te Patient Finances window opens. 

2 

3 

4 

2. Under Billing Type, click Edit. 

Te Billing Type Selection dialog box appears. 

3. Select a billing type. 

4. Click OK. 

Tip: To add a note about the change in the billing type, enter an Account Note. 
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Entering Transactions 
Tis sections covers the following topics about posting transactions in the Ledger: 

• Posting Procedures 

• Posting Payments 

• Posting Payments to Payment Plans 

• Applying Suspended Credits 

• Posting Adjustments 

• Posting Finance and Late Charges 
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2:J 

Enter Procedure(s) 

Ope1ator: !ENTERPRISE 

Date: 04/16/2013 

P1ocedu1e: ID 212Q 21 
Clinic: ·1c-E-NT_R_A_L ___ 21 

Tooth: ! 
~-----

Surfaces: 21 
Amount: I ---6- 6-.0-0 

RVU I 000 

P,ovidei: 'IA_M_C-CL_U_R_E __ 21 

Encounter 1t 

Sta,t Date: 

03/31/2003 Brent Crosby 
n::in112nrn <F,.milv'> 

Completion Date: 

Amalgam-2 surface, prima,y Multi-Codes: 

Chait Status-----~ 

r T 1eatment Plan 
App1oval Status 

I None 3 
r, Completed 

r Do Not Bill Dental lnswance 

r O ve11ide P,oc Flags 
._ ___________ Modiliei: I r Requi,e Sta,t/Completion Date 

81idge 
CCAdult 
CCChild 
Cmlmp 
CmPClns 
DOAmalg. 
DO Comp. 
MODAmalg 
MOD Comp. 
NP Ex 
Oamalg 
□ resin 
Pa,tMand 
Pa,tMax 
PerioExam 
RC/C1wn 
Scale 

ID Numbe, Type ID Numbe, 

STM 

dd Change Delete 

Add 

2:J 

Posting Procedures 
All charges listed on an account are posted through the use of a procedure code. Typically, the procedure code 
used is one of the ADA codes that come pre-loaded with Dentrix Enterprise. However, dental ofces often 
perform procedures or assess charges that don’t have a standard procedure code (sometimes referred to as 
“administrative codes”). You need to add these charges and assign them to a procedure code. Most of the time, 
you post treatment in the Patient Chart; and then, when the procedures are completed, they are automatically 
posted to the Ledger. In some cases, however, you may need to post a procedure (such as an administrative 
code) directly in the Ledger. 

Note: According to your organization’s policies and standards, you may be required to enter and edit only 
administrative codes (such as those for missed or broken appointments) from the Ledger. Tat being the case, 
you would have to enter and edit procedure codes related to patient treatment from the Patient Chart. 

To post a procedure 

1. In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Procedure. Tis option is available only if a patient is 
selected, the selected patient is not archived, and you are not 
viewing the running balance for all family members. 

Te Enter Procedure(s) dialog box appears. 

2. Enter the procedure information: 

1 

a. By default, the procedure’s 
Date is today’s date, but you 
can change it. 

b. Click the Procedure search 
button . Te Procedure 
Codes dialog box appears. 
Select a procedure code 
Category to see a list of the 
corresponding procedure 
codes. Select the desired 
procedure code, and then 
click OK. 

c. Other felds will appear 
if the selected code requires 
additional treatment 
information. If required 
for the procedure code, 
enter additional treatment 
information: 

2 

3 

• Tooth – Type the 
appropriate Tooth number or letter. You can also enter a supernumerary tooth number or letter. 

• Range of Teeth – Type the frst tooth number or letter in the range, a dash, and then the last 
tooth number or letter in the range. 

• Surfaces – Click the Surfaces search button . Te Surfaces Selection dialog box appears. 
Select the applicable treatment areas, and then click OK. If multiple teeth have been entered, the 
treatment areas you specify will be applied to all those teeth. 

• Quadrants – Select the appropriate quadrant. 
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2J 

Enter Payment 

Operator: losMITH 

Date: 111/22/201 7 

Amount: I poo 

r Apply to Pmt Agreement 

Apply to Charges I <Family> 

Collecting Clinic: IAF 

EncCHJnter l:i 

CheckU 

Bank/Branch ii: 

2J 

2J 

Type 2:.1 
~~:~tcalr~~n~;~e~~~\~~~k You (cc] □ 
Visa 
Master Card 
Amex 
Ca,eCredit 
Capitation Payment 

..:J Credit Card Terminal: I KT erminal 

Transaction ID : 

..:JQ] 

Apply Remaining I Remove Applied I r Do not automalically allocate Cancel 

Date En counte ... Code Th Patient Provider Clinic Balanc"" 

12/03/03" D2385 15 Crystal Crosby MHAYES AF 130.00 4ll.OO• 10.00 0.00 90.0 
07/'19/14" D624ll Brent Crosby DESMITH AF 750 .00 0.00 750.00 0.00 750.0 

07/19/14" D624ll Brent Crosby DESMITH AF 750 .00 0.00 750.00 0.00 750.0 
07/19/14" D6750 Brent Crosby DESMITH AF 750.00 0.00 750.00 0.00 750.0 
07/19/14" [)6750 Brent Crosby 

D 
AF 750 .00 0.00 750.00 0.00 750.0 

07/1.9/14* D7111 31 Brent Crosby AF 71.00 0.00 14.20 0.00 71.0 
03/10/15" 00110 Brent Crosby CENTRAL 165.00 0.00 0.00 0.00 165.0 e 
03/10/15* D7285 Brent Crosby CENTRAL 165.00 0.00 165.00 0.00 165.0 
03/30/15" D2750 4 Brent Crosby CENTRAL 850.00 0.00 0.00 0.00 850.0 
03/30/15" POCHK Brent Crosby DESMITH CENTRAL 100.00 0.00 100.00 0.00 100.0 
04/17/15" 00150 Brent Crosby DESMITH AF 185.00 0.00 185.00 0.00 185.0 
04/17/15* DlllO Brent Crosby DESMITH AF 165.00 0.00 165.00 0.00 165.0 
03/14/17 00120 Brent Crosby DESMITH AF 155.00 0.00 0.00 0.00 155.0 
03/14/17 DlllO Brent Crosby DESMITH AF 165.00 0.00 0.00 0.00 165.0 
03/20/17 00120 Tom Crosby DESMITH AF 155.00 0.00 0.00 0.00 155.0 
03/ 20/17 00210 Tom Crosby DESMITH AF 185.00 0.00 0.00 0.00 185.0 .... 

Total Remainin Total Other Cr TotalGuarEst Total A lied Fami Char es Balance 
0.00 40.00 3639.20 0.00 5n6.00 

• Sextants – Select the appropriate sextant. 

• Arch – Select the appropriate arch. 

d. Dentrix Enterprise automatically enters the Amount for the Procedure being posted. But, you can 
change the amount as needed. 

e. Set up any of the following options: 

• Clinic – To change the clinic for the procedure, click the search button  to select the correct 
clinic. 

• Provider – To change the provider attached to the procedure, click the search button to select 
the correct provider. 

f. Click Add to add the procedure to the Procedure List. 

Note: Repeat these steps for any other procedures that you want to post. 

3. Click OK/Post. Te procedures posted in the Ledger automatically appear in the Patient Chart as well. 

Posting Payments 
Dentrix Enterprise uses line-item accounting to calculate account balances. You can view balances for the 
entire family and for individual patients within the family. When a patient makes a payment, you can credit 
the payment to individual patient charges or to the entire family balance (oldest balance frst). Dentrix 
Enterprise allows the posting of pre-payments and suspended payments that are not immediately allocated to 
a charge. Also, Dentrix Enterprise has a feature that allows you to quickly view linked charges and credits. 

All payments made by patients are classifed as guarantor payments and will be listed under the guarantor’s 
name. Keep in mind that, even though you may have selected a family member other than the guarantor, 
guarantor payments are always displayed in the Ledger view, so you can easily see when the last time a 
payment was made to the account. 

To post a payment 

1. In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Payment. 

1 

Te Enter Payment dialog box 
appears. 

2. Set up the following options: 

• Collecting Clinic – Click 
the search button to select 
a clinic. 

• Date – Payments are 
automatically assigned the 
current system date, but you 
can change the date as needed. 

2 

4 

• Type – Select the correct 
payment type. For information 
about how to set up payment 
types, see the “Customizing 
Payment Types” topic in the 
Dentrix Enterprise Help. 

3 
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• Amount – Type the dollar amount of the payment. 

• Check # – If the patient is paying with a check, type the Check # and Bank/Branch # of the check. 

• Apply to Charges for – Select “<Family>” to list charges for the entire family with the amount owed 
to each provider; or, to list only a specifc patient’s charges, select that patient. For information about 
how to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences” 
in Chapter 1: Introduction and Initial Setup. 

• Note – Document any unusual circumstances surrounding the payment. 

3. When you enter an amount, Dentrix Enterprise will automatically allocate the payment to the oldest 
provider balances, according to the charges listed. Te amount applied appears in the Applied column. 
You can apply any remaining amount or edit the applied amounts as needed: 

• To apply a remaining amount, select the desired charges (to select multiple charges, while holding 
down the Ctrl key, click each charge), and then click Apply Remaining. Te amount in the Total 
Remaining feld is applied to the selected charges. 

Note: If the amount exceeds the guarantor estimate, a dialog box will appear. Select either Do not 
apply the remaining amount (to only apply an amount equal to the guarantor estimate) or Apply 
the remaining amount to the balances (to apply the remaining amount but not exceed the total 
charge, which can be paid by insurance and will result in overpayment), and then click OK. 

• To remove applied amounts, select the desired charges, and then click Remove Applied. 

• To edit an applied amount, double-click the desired charge to enable the applied amount to be 
edited, type the correct amount to be applied, and then click the check mark 

• If a credit results from how you have applied or unapplied amounts, to have the credit not be applied 
to any listed charge when anyone attempts to apply suspended credits to the account, select Do Not 
Automatically Allocate. 

4. Click OK/Post. 

If all or a portion of the payment has not been applied to any charges, a message appears and ask if you 
want to suspend the amount. Click Yes. Te unapplied amount will be suspended but can be applied at a 
later time as explained in “Applying Suspended Credits” in this chapter. 

. 
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Operalor: JD SMITH Collecling Cljnic: JCENTRAL 

Q_ ate: J 12/2112020 

/\mount J 24.55 

Apply lo 

I Charges for: 

I♦ Payment Plan: Restorations-Dan 

r Payment Agreement 

Note: 
- ~ 

A2ply Remaining I fl emove Applied I r Do not automaticall~ allocate 

Date Encounte ... Code Th Pati ent Provider 

12/15/20 123 D2391 15 Dan B Fisher DSMllH 
12/15/20 123 D2392 2 Dan 8 Fisher DSMllH 

Clinic 

AF 
AF 

l,ype: Check Payment - Thank You 
Cash Pa ment · Thank You 

VISA [cc] 
Ame,ican Express [cc] 
Maste1Ca1d [cc] 
Discovery [cc] 
Online Payment (cc) 

r Payment method l<None> 

r Credit Card Terminal I Front Desk 

Pa Plan 

V 
V 

158.40 
158.40 

0,00 111 .68 
0,00 31.68 

..:.l 
..:.l .Q] 

Cancel 

24.55 133.85 
0,00 158.40 

Posting Payments to Payment Plans 
You can credit a payment toward a payment plan balance. 

To post a payment to a payment plan 

1. In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Payment. 

Te Enter Payment dialog box appears. 

2. Enter the 
payment 
information. For 
details on posting 
payments, 
see “Posting 
Payments” in this 
chapter. 

3. Under Apply to, 
select Payment 
Plan, and 
then select the 
payment plan 
to which you 
want to apply the 
payment. 

3 2 

4. Click OK/Post. 

1 

4 
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Apply Suspended Credrts = 00 
Select Suspended Credit{ s J to Apply 

Select All Note ... Operator: IDSMITH 

Date Encounte... Chee .. . Patient Clinic lied Balance 

05/15/14' 12342 .. . <Family> CEN ... Check:P ... 1000.00 585.00' 0.00 415.00 
07(29/14' <Family> AF Check:P ... 34.00 0.00 0.00 34.00 

ApplyloCha,gesfo, ~ 
Apply Credil(sl Remove Applied I 

Total Credits 

1034.00 

✓ Flagged to not automatically alloc 

Credits Balance 

440.00 

Cancel 

Date Encounte... Code Th Patient Provider Clinic Char er.. Guar.. A lied Balanu ... 

12/U3/03' 02385 15 C,y,tal Cm,by MHAYE5 AF 130.00 40.00' 10.00 0.00 90.0C~ 
07/"19/14* D7111 31 Brent Crosby DESMITH AF 71.00 0.00 14.20 0.00 71.0C 

li1llmll-lBllmiiltlliiil!i\lalilmliGllll~IDE!llllliE!IIIDE!IIB:!IIDEi 
07l 19/14* D6750 8 Brent Crosby DESMITH AF 750.00 0.00 750.00 0.00 750.0C 
07l 19/14* D6240 6 Brent Crosby DESMITH AF 750.00 0.00 750.00 0.00 750.0C E 
07l 19/14* D6240 7 Brent Crosby DESMITH AF 750.00 0.00 750.00 0.00 750.0C 
03/10/15* 00110 Brent Crosby DESMITH CENTRAL 165.00 0.00 0.00 0.00 165.0C 
03/10/15* D7285 Brent Crosby DESMITH CENTRAL 165.00 0.00 165.00 0.00 165.0C 
03/30/15* D2750 4 Brent Crosby DESMITH CENTRAL 850.00 0.00 0.00 0.00 850.0C 
03/30/15* POCHK Brent Crosby DESMITH CENTRAL 100.00 0.00 100.00 0.00 100.0C 
04/17/15* 00150 Brent Crosby DESMITH AF 185.00 0.00 185.00 0.00 185.0C 
04/17/15* Dlll0 Brent Crosby DESMITH AF 165.00 0.00 165.00 0.00 165.0C 
03/14/17 00120 Brent Crosby DESMITH AF 155.00 0.00 0.00 0.00 155.0C 
O:V14/17 n,110 RrPnt C rm:hv 11FC:,MITH AF 16'i.oo n.oo n.oo n.oo 16'i.oc .... 

Total Char es; Total Other Cr Total Guar Ert Total A lied Fami Char es Balance 

5816.00 40.00 3639.20 0.00 5776.00 

Applying Suspended Credits 
Since Dentrix Enterprise uses line-item accounting, payments and adjustments should be applied to posted 
procedures. However, for times when it is necessary to suspend a payment or credit (such as for a pre-payment 
or an overpayment), you may do so. Ten, once charges are posted, you can apply the suspended amount 
toward those charges. 

To apply a suspended credit 

1. In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Apply Suspended Credits. 1 

Te Apply Suspended Credits dialog box appears. 

2. Select the credits to be applied, 
or click Select All to select all 
suspended credits. 

Tip: To view or update the 
payment note for a selected 
credit, click Note. 

2 

3. From the Apply to Charges 
for list, select “<Family>” 
to list charges for the entire 
family with the amount owed 
to each provider; or, to list only 
a specifc patient’s charges, select 
that patient. For information 
about how to set up the Apply to 
Charges for list default selection, 
see “Setting Up Program 
Preferences” in Chapter 1: 
Introduction and Initial Setup.. 

3 
4 5 

4. Click Apply Credit(s). 

5. Click OK/Post. 

Tip: To see which charges and credits are linked, select a transaction in the Ledger, and then, from the 
View menu, click Show Transaction Links. All linked transactions will be selected. 
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~ Enter Credit Adjustment = l@LJ~ 

( 
Operator: !ENTERPRISE Collecting Clinic: jCENTRAL .::I Type: I 

·Cash Discount 
Date 104/17/ 2013 Encounter tt: J -Credit Adjustment 

-Write-Off 

Amount: I 0.00 

Apply to Charges for: J <Family> ::::1 
Note:

1
11 . 

~I 
~ OK/Post 

. 
Apply Remaining I RemoveApplied I r Do not automatically atlocatel I Cancel I 
Date I Encounte. . I Code I Patient I Provider I Clinic I Charge I Other .. . I Guar .. . I Appl ied I Ba lance I 
12/15/95' D1120 Timothy Smi ... HYGl 34.00 26B0 0.00 0.00 7.20 
10/15/96' D2160 James SAbb ... DDS2 90.00 0.00 0.00 0.00 90.00 
01/09/00' D6750 James SAbb ... DROBB CENTRAL 613.00 0.00 0.00 0.00 613.00 
01/09/12 D6240 James SAbb ... DROBB CENTRAL 620.00 0.00 0.00 0.00 620.00 
01/09/12 D6240 James SAbb ... DROBB CENTRAL 620.00 0.00 0.00 0.00 620.00 
01/09/12 D6750 James5Abb ... 0 CENTRAL 613.00 0.00 0.00 0.00 613.00 
01/ 20/12 D1110 Jam es SAbb ... PROVO 48.00 0.00 0.00 0.00 48 .00 
01/31/12 D0140 James SAbb ... CENTRAL 35.00 0.00 0.00 0.00 35.00 
01/31/12 D0160 Jam es SAbb ... CENTRAL 38.00 0.00 0.00 0.00 38.00 
02/27/12 D2150 Patricia Abb... D CENTRAL 75.00 0.00 15.00 0.00 75.00 

ota Kema1 ... ota ~-naraes ota utn er r ota 11.Juartst ota ieo am11v _naraes tia an ... 

I o.oo I 2786.00 26BO I 15.00 o.oo I 2759.20,~' 

1 

3 

2 

Posting Adjustments 
Dentrix Enterprise aligns itself with generally accepted accounting principles (GAAP), which recommends 
that you enter adjustments to correct posting errors, record refunds, and ofer discounts. Posting adjustments 
instead of just editing procedure amounts will allow you to accurately track how those adjustments 
(like friends and family discounts) afect revenue. In Dentrix Enterprise, you can enter the two types of 
adjustments: a credit adjustment, which lowers an account balance; and a charge/debit adjustment, which 
raises an account balance. Additionally, since Dentrix Enterprise uses line-item accounting, you allocate a 
credit adjustment to one or more procedures (line items). For information about setting up adjustment types, 
see the “Customizing Adjustment Types” topic in the Dentrix Enterprise Help. 

To post an adjustment 

1. In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Enter Adjustment. 

Te Select Adjustment Type dialog box appears. 

2. Select either Credit Adjustment (-) (if the adjustment reduces the 
account balance) or Charge Adjustment (+) (if the adjustment 
increases the account balance). 

3. Click OK. Ten, post the adjustment. 

For a credit adjustment, do the following: 

a. In the Enter Credit Adjustment dialog box, set up the following options: 

• Collecting Clinic – Click 
the search button to 
select a clinic. 

• Date  – By default, the 
adjustment’s date is 
today’s date, but you can 
change it. 

• Type  – Select the correct 
adjustment type. 

a 

• Amount – Type the dollar 
amount of the adjustment. 

c 

• Apply to Charges for – 
Select “<Family>” to list 
charges for the entire family 
with the amount owed to 
each provider; or, to list 
only a specifc patient’s 
charges, select that patient. 
For information about 
how to set up the Apply 
to Charges for list default 
selection, see “Setting Up Program Preferences” in Chapter 1: Introduction and Initial Setup. 

b 

• Note – Type the reason for the adjustment. 
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_:_J 

_:_J 

Enter Charge Adjustment 

Ope1ator: ENTERPRISE 

Date: 10411712013 

Amount: I 
Apply Charges: I <Family> 

Note: I 

~ 

0.00 

Clinic: CENTRAL 

Encounter it 

Provider: jDDS1 

iDiim [ZI X 

» Type: 
+Patient Refund 

2j 

..:.l 

OK/Post Cancel 

. 

b. When you enter an amount, Dentrix Enterprise automatically allocates the adjustment to the oldest 
provider balances, according to the charges listed. Te amount applied appears in the Applied column. 
You can apply any remaining amount or edit the applied amounts as needed: 

• To apply a remaining amount, select the desired charges (to select multiple charges, while holding 
down the Ctrl key, click each charge), and then click Apply Remaining. Te amount in the Total 
Remaining feld is applied to the selected charges. 

Note: If the amount exceeds the guarantor estimate, a dialog box will appear. Select either Do not 
apply the remaining amount (to only apply an amount equal to the guarantor estimate) or Apply 
the remaining amount to the balances (to apply the remaining amount but not exceed the total 
charge, which can be paid by insurance and will result in overpayment), and then click OK. 

• To remove applied amounts, select the desired charges, and then click Remove Applied. 

• To edit an applied amount, double-click the desired charge to enable the applied amount to be 
edited, type the correct amount to be applied, and then click the check mark 

• If a credit results from how you have applied or unapplied amounts, to have the credit not be applied 
to any listed charge when anyone attempts to apply suspended credits to the account, select Do Not 
Automatically Allocate. 

c. Click OK/Post. 

For a charge adjustment, do the following: 

a. In the Enter Charge Adjustment dialog box, set up the following options: 

• Clinic  – Click the search 
button to select a clinic. 

• Date  – By default, the 
adjustment’s date is today’s 
date, but you can change it. 

• Type  – Select the correct 
adjustment type. 

• Amount – Type the dollar 
amount of the adjustment. b 

a 

• Provider – Click the search 
button  to select the appropriate provider for the adjustment. 

• Apply to Charges for – Select “<Family>” to apply the charge to the entire family’s balance; or, to 
apply the charge to only a specifc patient’s balance, select that patient. For information about how 
to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences” in 
Chapter 1: Introduction and Initial Setup. 

• Note – Type the reason for the adjustment 

b. Click OK/Post. 
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Enter Finance Charge or late Charge 

Operator: !ENTERPRISE 

Date, 10411712013 

Amount: I 
Apply Charges: I <Family> 

Note: I 

~ 

0.00 

Clinic: lcENTRAL 

Encounter U: 

Provider: 100s1 

..:?.] 

..:?.] 

Type: r. Finance Charge 

r Late Charge 

OK/Post Cancel 

Posting Finance and Late Charges 
Dentrix Enterprise aligns itself with generally accepted accounting principles (GAAP), which recommends 
that you enter late charges and fnance charges instead of editing a procedure amount. Tis will allow you to 
accurately track how those late charges and fnance charges afect revenue. 

To post a fnance or late charge 

1. In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Enter Finance Charge or Late Charge. 

Te Enter Finance Charge or Late Charge dialog box appears. 

2. Set up the following options: 

• Clinic – Click the search 
button to select the 
correct clinic. 

• Date – By default, the 
adjustment’s date is today’s 
date, but you can change it. 

• Amount – Type the dollar 
amount of the charge. 

• Provider – Click the search button 

• Type – Select the correct type of charge: Finance Charge or Late Charge. 

• Apply to Charges for – Select “<Family>” to apply the charge to the entire family’s balance; or, to 
apply the charge to only a specifc patient’s balance, select that patient. For information about how 
to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences” in 
Chapter 1: Introduction and Initial Setup. 

• Note – Type an explanation for a fnance or late charge. 

3. Click OK/Post. 

1 

3 

2 

 to select the appropriate provider for the charge. 
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Date 

07/29/2014 
07/29/2014 
07/29/2014 

Name Surface T ooth Check# Code * Descri t ion 

Brent Crosby 5 D6750 Reta iner cm-pore fused-I 

Brent Crosby 8 D6750 Reta iner cm -pore fu sed- I 

Brent Crosby 6 Pontic-porcelain fused tc .. 
Edrt: or Delete Procedure ~ 

Operator: I DSMITH Encounter tt: 

Dale: liJ310712019 Start Dale: Completion Date: 

Procedure: 101110 ~ •P- r-op_h_9-la-,i,--a- d_u_ll _____ _ Procedure Status 
r T realmenl Plan Clinic: ~IA_F ____ ~ 

Approval Status 
Override Ins. estimate I None ..:J 

Amounq 48.00 

RVU I 2.00 

Provider: IDSMITH ~ 

Conditions----------~,. 

~ 
Invalidate Upon Completion: 

Diagnoses: ~ 

r. Completed 

r Existing-Current Prov 

r Existing-Other Prov 

Modilier: j 

r Automatic r None 

Notes: General sc g with hand instruments. Ultrasonic scaler on lower anteriors-lingual. 
~ I a used on upper and lower arch. Flossed all contacts. Patient rinsed 

..:::!.J edicated ,inse after Px. 

Related Referral--------------------------, 

Referred: 
IBY: Dr. Evans.Jell 

Editing Current Transactions 
From time to time, a posting mistake will be made, and you will need to correct it. You can edit and delete 
procedures, payments, and adjustments that have not been moved to history (when closing a month). 

Procedures attached to an insurance claim cannot be edited until the claim has been deleted. For information 
about how to delete a claim, see “Deleting Dental Insurance Claims” in this chapter. 

To edit a current transaction 

1. In the Ledger, with a 
patient selected, 
double-click a 
transaction. 

Te Edit Or Delete 
Procedure dialog box 
appears. 

2. Make any necessary 
changes to the transaction. 
For an explanation of the 
options available for editing 
transactions, see “Editing 
Treatment” in Chapter 4: 
Patient Chart. 

3. Click OK. 

1 

2 

3 
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Date 

07/ 29/2014 
07/ 29/2014 
07/ 29/ 2014 

Name Surface Tooth Ch eck# Cod e * Descri tion 
Brent Crosby 5 D6750 Retai ner crn -porc fu sed-I 
Brent Crosby 8 D6750 Retain er crn -porc fused -I 
Brent Crosby 6 Pontic-porcelain fused t c .. 

Notes: General scaling with hand instruments. Ultrasonic scaler on lower anteriors-lingual. 
::,- I Baking soda used on upper and lower arch. Flossed all contacts. Patient rinsed 

..::!..J with a medicated ,inse after Px. 

Credits>> I 
Related Referral-------------------------~ 

Referred: ID Number Type ID Number 
IBY: Dr. Evans.Jeff 2:J Remove l UiUlm ..:.J 

Deleting Current Transactions 
You can delete a transaction that has been posted in the Ledger or Patient Chart and has not been moved to 
history (when closing a month). 

Before you can edit or delete a procedure, you must delete any claims linked to that procedure. 

To delete a current transaction 

1. In the Ledger, with a 
patient selected, 
double-click a 
transaction. 

Te Edit Or Delete 
Procedure dialog box 
appears. 

2. Click Delete in the lower-left 
corner of the dialog box. On 
the confrmation message that 
appears, click OK. 

1 

2
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Brent Crosb 
04/01/2003 Brent Crosby -UR 

Operator: !ESME Clinic: fE.F 

,.... ..... , ..... ~ ..... 
Adjust... * Credit Adjustment 

imm11• Full mouth debrrdemn 

D9630 * IRRIGATION PER QUAC 

~ 
r Require Start/Completion Date 

Start Date: 

Completion Date: 

Date: ,.,I 0-1 /..,.09,.../""20"'00,,- Encounter tt: .------- Procedure Status 

r Treatment Plan 
Approval Status Procedure: ID 6750 

Tooth:l5 

Retainer crn-porc fused-hi nob 

Amount ! 61300 

RVU:,-1 ----O-□O 

Provider: IMHAYES 

Conditions: .2.:J 
Diagnoses: ..:.:J 

Notes: 

0 verride Ins. estimate 

r Pnm.lns r----
r Sec. Ins r----

I None ..:.J 
r. Completed 

r E :-:isting-Current Prov 

r E:-:isting-Other Prov 

Modifier: 1 r Do Not Bill Dental Insurance 

ID Number Type 

Cancel 

Invalidating Transactions in History 
Dentrix Enterprise saves your ofce from repetitive data entry by posting procedures to both the Ledger 
and Chart at the same time. However, a diferent standard regarding record keeping exists for each module. 
Te Ledger, as a fnancial record, uses generally accepted accounting principles (GAAP). In contrast, the 
Patient Chart is a clinical record of patient care. Ten, what do you do when you discover a posting error for 
a procedure in a month that has been closed out? Te procedure has been locked to prevent deletions and 
changes, which is good for a fnancial record, and you can simply enter an adjustment in the Ledger to correct 
the problem. However, the clinical record needs to accurately represent the actual care given, but you can’t 
delete or change the procedure or “adjust” the clinical record in the Chart. To solve this discrepancy, Dentrix 
Enterprise allows you to invalidate a procedure in history (in closed out months). Invalidating a procedure 
removes it from the Chart while leaving it in the Ledger. 

To invalidate a history transaction 

1. In the Ledger, with a 
patient selected, 
double-click a 
procedure in history. 

Note: If to the left of the procedure 
description, there is an asterisk (*), the 
transaction is in history. 

1 

2 

Te Validate/Invalidate Procedure in 
History dialog box appears. 

2. Under Validate/Invalidate Procedure, 
click Invalidate Procedure. 

3. Click OK. 

Te invalidated transaction is removed 
from the Patient Chart but left in the 
Ledger as a history transaction. In the 
Ledger, a plus sign (+) appears to the left of 
the transaction description to indicate that 
the transaction has been invalidated. 

Important: 

• Post an ofsetting adjustment equal to 
the amount of the procedure, as the 
account has already been billed for that 
procedure. 

3 

• If needed, post the procedure again using the correct information. Be sure to change the date to 
refect the date the procedure was originally posted, and change the charge amount to zero because 
the account has already been billed for the procedure. 
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Processing Dental Insurance Claims 
For most ofces, handling insurance claims is a big part of the practice management routine. Terefore, 
Dentrix Enterprise includes many features to help you generate claims for insured patients when they receive 
treatment. You can print claims or send them electronically. Also, you can post payments for claims submitted 
to insurance carriers. 

Additionally, billing dental insurance can be a complicated operation because of the inconsistent way diferent 
insurance carriers handle claims. Fortunately, Dentrix Enterprise has the tools to handle most insurance 
situations. 

Tis section covers the following topics about processing dental insurance claims: 

• Understanding Insurance in the Ledger 

• Creating Primary Dental Insurance Claims 

• Changing Dental Claim Information 

• Including Attachments with Dental Insurance Claims 

• Reprinting Dental Insurance Claims 

• Deleting Dental Insurance Claims 

• Posting Dental Insurance Payments 

• Creating Secondary Dental Insurance Claims 

• Editing or Deleting Dental Insurance Payments 

• Indicating Dental Insurance Benefts Used and Deductibles Met 

Understanding Insurance in the Ledger 
Te Ledger module provides much insurance information at a glance: 

• Insurance coverage – You can easily tell if a patient has insurance coverage by looking at the Ledger 
menu bar. Te Insurance option is available if a patient has been assigned insurance in the Family File. If 
the Insurance option is unavailable but the selected patient has insurance, on the View menu, make sure 
that All (with running balance) does not have a check mark. 

• Procedure or claim status – From the transaction log, you can quickly see the status of a procedure or 
claim. Te Ins column indicates whether or not a procedure has been billed to insurance: if the column 
is empty, the listed procedure has been attached to an insurance claim; if the column displays “No,” an 
insurance claim has not been created for the procedure. 

• Claim amounts – Once a dental insurance claim has been created, the Outstanding Billed to Insurance, 
Expected from Dental Insurance, and Guarantor Portion of Total Balance amounts will change to 
refect the amount of the procedures on the claim and the insurance coverage percentages. 

Note: Te insurance estimates in the Ledger and on billing statements only include procedures that have 
been billed to dental insurance. Te entire procedure cost is allocated to the Guarantor Portion of Total 
Balance until a dental claim is created for the procedure. 

• Submission status – An insurance claim will have “Not Sent,” “Sent,” or “Received” as part of its 
description in the transaction log. A claim is considered “not sent” until it is sent to the Batch Processor 
or printed. A claim is considered “sent” once it has been sent to the Batch Processor or printed. A claim is 
considered “received” when a payment is entered. 
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03/31/2003 Brent Crosby 
03131/2003 <F;imi~I'> 

[I] 
' 

Primary Dental Insurance Claim (02/13/2012) Sent 

Patient: Abboll, James S 
Subscriber: Abbott,James S 

Employer: HSPS 

Billing Provider: Smith, De 

Rendering Provider: Smith, Dennis D 

Print 

Pay-To Provider: Smith, Dennis D 

iJ ooth Surface Descri lion 
Limited oral evaluation 
Detail/e:-: tensive oral eval, 

Help 

Carrier: Aetna Dental 
Group Plan: HSPS Aetna 

[R elease of lnfo /Assigr 

Claim Information 

D iag. Codes:: 

Dale Code 
01 /3112012 D0140 
01 /3112012 D0160 

Creating Primary Dental Insurance Claims 
You will create an insurance claim each time an insured patient receives treatment. You can create a claim 
immediately after a patient checks out, or you can create a batch of insurance claims at the end of the day. In 
Dentrix Enterprise, creating and sending a claim can be as simple as clicking one button. Determine which of 
the following methods for creating claims you want to use in your ofce. 

To create a claim 

1. In the Ledger, with a patient selected, do one of the following: 

• Create a claim for today’s procedures. Tis option is the 
simplest way to create a claim. Use this method for creating 
a dental insurance claim immediately after procedures have 
been posted. From the Insurance menu, click Today’s 
Procedures, Today’s Procedures - Direct Print, or Today’s Procedures - Batch. Or, you can click 
the Ins. Today’s Proc. button  on the toolbar. 

1 

Dentrix Enterprise creates a dental claim that includes all procedures posted on the current system 
date. 

• Create a claim for specifc procedures. Use this method for creating a dental insurance claim for a 
specifc procedures or procedures that were posted on another date. 

a. Select the procedures for which you want to create a dental claim (to select multiple procedures, 
while holding down the Ctrl key, click the desired procedures). 

b. From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or 
Selected Procedures - Batch. Or, you can click the Ins. Selected Proc. button  on the toolbar. 

Dentrix Enterprise creates a dental claim that includes all selected procedures. 

Note: For information about how to set the printing default for the Ins. Today’s Proc. button and Ins. 
Selected Proc. button, see “Setting Up Direct Print Options” in Chapter:1 Introduction and Initial 
Setup. 

One of the following occurs: 
• If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create 

a dental claim, before the claim is sent, the Primary Dental Insurance Claim window appears, 
allowing you to edit the claim information. 

Note: You only need to edit a claim when it requires special handling, such as the addition of a 
narrative or to indicate that you are attaching X-rays. 

• Dentrix Enterprise sends the claim to the Batch Processor or prints it immediately. Ignore the steps 
that follow. 

2. Make any necessary changes to the dental 
claim as explained in “Changing Dental Claim 
Information” in this chapter. 

3. To batch, send, or print the dental claim, on the menu 
bar, click Print. 

2 

3 



274     Chapter 7: Ledger 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

Cancel 

f4' Primary Dental Insurance Cla ir (02/13/2012) Sent ~ 
File Claim Enter Paym ent ~ Die Print Help 

Patient: Abbott, James S Carrier: Aetna D entc 
S ubs:criber: Abbott, James S Group Plan: HS PS Aetn, 

Employer: HSPS !Release of lnfo/Assi n of Benefits) ISeiondary Insurance) 

Billing Provider: Smith, Dennis D Claim lnfmmatio : Non-Standard 

- Rendering Provider: Smith, Dennis D D iag. Codes:: 

I 
Pay-To Provider: Smith, Dennis D 

Tooth Surface Description Date Code Fee Ins Amt 
Limited oral evaluation 01131/2012 D0140 35. 00 0.00 A 

Detail/ extensive oral eval, 01/31 /2012 D0160 38.00 0.00 C 

~ 

Total Billed: 73.00 Pmt Date PmtAmt D escrintion Check II 
Est Ins Portion: 7300 A 

Ins Amt Total: 0.00 C 
Total Paid: 0.00 ~ 

Total Credit Adj: 23.00 Adi Date Adi Amt Tvoe 
Total Chrg Adj: 0.00 A 

Ded S/P/0: 2/0/0 C 
~ 

Status Invoice II: 010000360 Insurance Notes 
Create Date: 02/1312012 Tracer: Ask for Debbie if }IOU have coverage questions. 

Date Sent : 02/13/2012 On Hold: 
Re-Sent: 

I Voided: I Claim Status Note: 

I I 

Te Insurance Claim Print dialog box appears. 

4. Under Include, Claim is selected by default and unavailable if there are no 
attachments. If there are attachments, Claim and Attachment(s) are both selected 
by default. You can clear Attachment(s) if you are not including any attachments. 

5. Do one of the following: 

• Click Send to Batch to send the claim to the Batch Processor. 

• Click Send Electronically to send the claim through electronic fling. 

• Click Print to print the claim now. 

5 

4 

Note: If you click Cancel, the claim status will be “Not Sent.” (Tis is not 
recommended.) 

Changing Dental Claim Information 
When a dental insurance claim is created, a standard set of information is used to fll out the claim. If you 
need to add non-standard information to a dental claim, you can edit the claim information from the 
insurance claim window. You can access the insurance claim window from the Ledger using one of the 
following methods: 

• Double-click an existing claim in the Ledger transaction log. 

• If you have not yet created a dental claim for procedures posted today, from the Insurance menu, click 
Today’s Procedures. 

• If you have not yet created a dental claim for procedures posted on a day other than the current system 
date, select the procedures, and then, from the Insurance menu, click Selected Procedures. 

Te Insurance Claim window is made up of the following boxes called “blocks”: Subscriber Information, 
Billing Provider, Rendering Provider, Pay-To Provider, Claim Information, Diagnostic Codes, 
Procedure Information, Payment Information, Claim Status, and Insurance Plan Notes. 

Subscriber Information Diagnostic Codes Claim Information 

Providers 

Procedure 
Information 

Payment 
and 
Adjustment 
Information 

Claim Status Insurance Plan Notes 

To edit the information in any of these blocks, double-click the desired block. 
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Primary Dental Insurance Claim {02/13/ 2012) Sent 

File Claim Enter Payment Note Print Help 

Patient: Abbott, James S 
Subscriber: Abbott, James S 

Employer: HSPS 

Billing Provider: Smith . D er1 

Lifetime Annual Annual 
Individual Individual Family 

Standard Required: ~ · 1500.00 11500.00 

Met ~ ~ ~ 
Preventive Required: ~ I 1000.00 I 3000.00 

Met~~~ 

Other Required: ~ I 1500.00 I 4500.00 

Met~~~ 

Individual 

Maximum Benefits: I 50000.00 

Benelits Applied: ~ 

~ 
115000 00 

[oo6o 

Editing Patient and Subscriber Information 
Te Subscriber Information block displays the patient name, subscriber name, employer, insurance carrier 
name, and group plan name. If Release of Information and/or the Assignment of Benefts were selected 
in the Family File when assigning insurance, “Release of Info” and/or “Assign of Benefts” are listed in 
parentheses. 

To edit subscriber information for the claim 

1. Double-click the Subscriber Information 
block. 

Te Patient/Insurance Information dialog 
box appears. 

2. Edit the following information: 

• Signature on File – Whatever options 
are selected in the patient’s Family File are the defaults for 
all insurance claims created for the patient. Changes made 
to the Signature on File options in the Patient/Insurance 
Information dialog box  afect the corresponding dental 
claim only. Select or clear the options as needed. 

• Release of Information – Select this option to indicate 
to the insurance carrier that the patient has signed release 
forms authorizing the ofce to submit information on 
the patient’s behalf. 

• Assignment of Benefts – Select this option to indicate 
to the insurance carrier that the patient has signed 
release forms authorizing the insurance carrier to send 
reimbursement to the ofce rather than the patient. 

• ID Number (SS#) – Te subscriber’s ID number from the 
Family File is automatically put into the dental claim. You 
can change the subscriber ID that appears on this claim. 

3 

2 

• Deductible and Benefts – In the Family File, you can indicate a subscriber’s maximum benefts and 
deductible(s). With this information, Dentrix Enterprise can provide you with accurate insurance 
estimates, which take the plan maximums and deductibles into account. Te Patient/Insurance 
Information dialog box displays both the entered maximum benefts and deductibles for the carrier, 
as well as the benefts used and deductible met amounts. If necessary, you can edit deductibles 
met and benefts applied in the appropriatefelds. Once the information has been posted, Dentrix 
Enterprise will use the updatedinformation for calculating all future insurance estimates for the 
patient or family. 

• Update Secondary – If the secondary (or tertiary or quaternary) dental insurance information 
was entered after the primary dental claim was created, the dialog box has an Update Secondary 
Insurance (or Tertiary or Quaternary Insurance) check box. Dentrix Enterprise will not use the new 
secondary (or tertiary or quaternary) dental insurance information until this check box has been 
selected. 

3. Click OK. 
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Select Provider 

ID last Name: 

Primary Dental Insurance Claim (02/13/2012) Sent 

Fil e Claim Enter Payment Note Print Help 

Patient: Abbott, James S 
Subscriber: Abbott, James S 

Employer: HS PS 

Billing Provider: Smith, Dennis D 

A endering Provider: Smith, Dennis D 

Pay-To Provider: Smith, Dennis D 

Tooth Surface Descri lion 

Search By:------­

r, This Clinic r, All Providers 

r All Clinics r In ApptB ook 

B ~----~----~ 
r-----;;IDs--=.::----,N;:a::-m:-e---- I Clinic ID 

DDS1 
DDS2 
DR01 
DROBB 
JKD1 
MCCLURE 

Smith, Dennis D 
Brown, Mar_y D 
Hewitt, Mark 0 
Robb, David 
Kimball, Jacob A 
McClure, Jeffrey 

OK 

C 
C 
C 
MESA 
MESA 
AF 

Cancel 

Canier: Aetna Dental 
Group Plan: HSPS Aetna 

(Release of Info/Assign of B 

Claim Information: Not 

D iag_ Codes: 

Dale 
01/31/2012 
01 /31/2012 

Code 
D0140 
D0160 

F 

Changing Providers 
You can change the billing provider, rendering provider, and/or pay-to provider for the dental claim. For 
information about setting up the default providers for these blocks, see “Setting Up Practice Defaults” in 
Chapter 1: Introduction and Initial Setup. 

To change a provider for the claim 

1. Double-click the Billing Provider, Rendering 
Provider, or Pay-To Provider block. 

Te Select Provider dialog box appears. 

2. Search for and select the appropriate provider. 

3. Click OK. 

2 

3 
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Sent 

Help 

Carrier: Aetna Dental 
Group Plan: HSPS Aetna 

(Release of Info/Assign of Benefits) 

Claim Information: Non-Standa 

Diag. Codes: 

Insurance Claim Information 

Place of Treatment 

r Hosp 
r Other 

Pre-Authorization Number: 

First Visit Date Current Series: 

Original Reference Number (f:f:J: 

Student Status------------------~ 
School · City 

(.' None r Part-Time (" Full-Time 

Attachments------------------~ 

p- Aadiograph(s) Enclosed How Many? F r Other Attachments 

r Oral lmage(s) Enclosed: How Many? I 
r Model(s) Enclosed How Many? I 

lncludeAttachment(s) Insurance Ref f:f:: ~--------

r Disabled 

r Occup. Illness Or Injury: 

r Auto Accident 
r Other Accident 

Dates 

r---
r---

r Services Covered by Another Plan: 

Descriptions 

Prosthesis-------------------~ 
Replace Reason Prior Date 

r.' No r Initial r Replacement 

Date 01dered r Estimated 

r Orthodontic Treatment- Placement Date: r--- Mos. Remain: I 
Clear 

For Special/Medicaid Claims------~ 

Referring Prov: 

Reason for Pre-Auth: 
r. Required 

r Services Exceed Max. 

Service Authmization- Exception Code 

l<NONE> ..:J 
90-Day Indicator 

l <NONE> 

r Oral Surgery 
r Special Case/EPSDT 

r Medicare 
r E ligibilily Pending 

r Retroactive Eligibility 

..:J 
r Re-Evaluation 
r CHDP 

r ccs 

Referring Physician--------~ 
Referred: 

I ...:..:J Remove I 
ID Number Type ID Numbe, I ..:JI~~---
2nd ID Number 3e 2nd ID Number 

I ~ I 
Other Subscriber lnfo,mation--;:::::===:i 
Remaining Patient Liability Amount: 

Total Non-Covered Amount: 

~ P,imar_y Claim Adjustment Rea son( s) I 

Cancel 

Editing Claim Information 
Te Claim Information block displays information that is specifc to a patient and a dental insurance claim. 
Tose items are found on a standard ADA insurance claim form. Te standard information prints on the 
dental claim unless it has been edited. 

Te block displays “Standard” unless the information has been changed, in which case, “Non-Standard” is 
displayed. 

Note: When dental claim information is entered or cleared from the insurance claim window, the changes 
apply only to the claim currently being displayed and the associated primary, secondary, tertiary, quaternary, 
or medical claim. When a new dental claim is created, Dentrix Enterprise uses the default claim information 
that was defned for the patient from their appointment. For information about how to set up claim defaults, 
see the “Scheduling appointments for existing patients” topic in the Dentrix Enterprise Help. 

To change claim information for this claim 

1. Double-click the Claim Information block. 

Te Insurance Claim Information dialog box appears. 

2. Edit the following information: 

• Place of Treatment – To indicate where the treatment 
for this claim was performed, click Ofce, Hosp, 
ECF, or Other. If you 
select Other, type the 
appropriate code. 

1

2 

• Pre-Authorization 
Number – If a treatment 
pre-authorization was 
approved for this claim, 
type the appropriate pre-
authorization number. 

• First Visit Date Current 
Series – If this claim is 
for treatment that is part 
of a multi-visit treatment, 
type the frst date of 
service for this series of 
treatments. 

• Original Reference 
Number (#) – For a 
voided or resubmitted 
Medicaid claim, type 
the original reference 
number. 

3 

• Attachments – To add, edit, or remove claim attachments, select or clear the appropriate option. 
For more information about claim attachments, see “Including Attachments with Dental Insurance 
Claims” in this chapter. 

3. Click OK. 

For comprehensive details about all the options available for changing claim information, see the “Editing 
claim information” topic under “Dental” in the Dentrix Enterprise Help. 
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Tooth Surface Descriotion - Dale Code Fee Ins Ami 
Limited oral evaluation • ' 01131 / 201 2 D0140 35.00 0.00 
Detail/ e:-:tensive oral eval, \..J 01 131/201 2 D01 60 38.00 000 

Total Billed· 73nn1 P mt n~tP I P mt 6mt I n p'\"rrintion 

Edit Insurance Payment Amount For Proce 

lnsuranceAmount: ~O 

Applied Amount:~ 

P,e-T real Estimate: I 0. 00 

Current Coverage: '35.00 

~ 
~ 

Editing Procedure Information 
Te Procedure Information block lists all of the procedures attached to the dental claim and shows the 
tooth, surface, description, date, procedure code, fee, and amount insurance has paid or pre-authorized for 
each procedure. Te Date column shows the date of completion for the dental insurance claim (or the date 
recommended for the pre-treatment estimate—the recommended date does not print on a pre-treatment 
estimate). Te block can only show up to six procedures at one time, but you can use the scroll bar to view 
any additional procedures. 

To edit a procedure amount 

1. To edit the amount the insurance plan 
will pay for a procedure on this claim, 
double-click the desired procedure. 

Te Edit Insurance Payment 
Amount For Procedure dialog box 
appears. 

2. Type the Insurance Amount (from an EOB, the 
amount that the insurance carrier is paying). For 

dental insurance payments” topic in the Dentrix 
Enterprise Help. 

3. Update the payment table, if applicable. 

Important: It is important that you only the payment table only when the payment amount applies to 
all patients covered by a given plan. For example, if the estimated insurance portion is diferent from the 
payment amount because money is being withheld toward a deductible, do not update the payment table. 
Similarly, if a patient has exceeded his or her maximum beneft, do not update the payment table. 

4. Click OK. 

information about the applied amount, see the “Posting 

1

3 

4 

2 
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Total Billed: 73.00 Pmt Date PmtAmt 
Est Ins Portion: 73. 00 04/171201 3 50.00 Insurance Pa menl 

Ins Amt Total: 73. 00 
Total Paid: 50. 00 

71 Edit or Delete Insurancl! Payment 

Operator: ]ENTERPRISE 

Date: 1 □4/17/2013 

Amount: ) 

Pre·AuthNumber 

Claim c•nic: lcENTAAL 

~0.00 

Apply Remaining Remove Applied 

Adj Date Ad. Ami 

Collecting Clinic: !CENTRAL ..:.:J 
EncounterU· 

~----

CheckU: lt 2345 

Bank/BranchU 

Payment Type Ci' Check P aymenl 

[NOTE: Insurance Estimates are only for this claim) 

Not, l'h;, ;, , rote'" the ;"'"""" payment 

~ 

Delete 

OK/Post 

Date I T...I Surface I Code I Dl!scri t ion I Provider I Charae I 0th Ins I Guar Cr I Ins Est I Ins Amt I Aoolied I Balance I 
01/31/12 00140 Limited oral .. DDSl 35.00 0.00 23.00 0.00 0.00 12.00 0.00 
01/31/12 D0160 DetaiVextensi,.. DDSl 38 .00 0.00 0.00 0.00 0.00 38.00 0.00 

I TotalRemai ... I Total Char es l Total Other ins l TotalGuarCr l TotallnsErt l TotallnsAmt l TotalAoolied l Total Balances 

I 0.00 73.00 0.00 B .00 0.00 0.00 I 50.00 0.00 

Editing Payment and Estimate Information 
Te Payment/Estimate Information block displays the following information: 

• Te dates payments were received 

• Te check numbers and the amount applied to the deductible 

• Te total of the itemized payments/estimates 

• Te total charges for procedures on the claim 

• Te estimated insurance portion 

• Te total payment or authorized amount 

To edit or delete a payment or pre-authorization 

1. Double-click a payment or pre-
authorization. 

Te Edit or Delete Insurance 
Payment dialog box appears. 

2. Make any necessary changes, 
and then click OK/Post to apply 
the changes. For information 
about the options available for 
insurance payments, see “Posting 
Dental Insurance Payments” in 
this chapter. 

Note: To delete the payment 
or pre-authorization, click 
Delete and then OK on the 
confrmation message that 
appears. 

2 
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lnsuranc 

Create Q ate: jo113112011 

Status Date 

17 .(laim Sent jo1131 /2017 

r lracer Sent · 

r QnHold : 

r B.e-Sent: 

r \ioided: 

I I 
S talus Invoice ti: 010000360 
Create Date: 02/13/2012 Tracer: 0 

Date Sent : 02/13/2012 On Hold: 
Re-Sent: 

Voided: 
Claim S talus Note: 

I 
Ins 
Asl 

Claim Status,tlote:------------~ 

lnsert Dateline I 
·Tue -Jan 31 .2017 04:26:40 pm · >Batched 

0 

Updating Claim Statuses 
Te Claim Status block displays the dates the dental claim was created, sent, traced, placed on hold, re-sent 
and/or voided. When a dental claim is created, the Create Date defaults to the current date. When a dental 
claim is sent, the status is automatically fagged as “Sent,” and the Sent Date defaults to the current system 
date. 

Note: When a payment or pre-authorization amount is entered for a dental claim, the status is automatically 
fagged as “Received.” 

To manually change the status and date for the claim 

1. Double-click the Claim Status block. 

Te Insurance Claim Status dialog box appears. 

2. Select a Status: Claim Sent, Tracer Sent, On Hold, Re-Sent, 
or Voided; and then type or change the 
Date. You can also change the Create Date. 

Note: When the claim is listed in the Ledger, 
the status of “Not Sent,” or “Sent” and the 
associated date are displayed according to 
what is set in the Insurance Claim Status 
dialog box. Te “Received” status and date 
depend on the payment or estimate entered 
in the Insurance Claim Status dialog box 
for this claim. 

3. To enter an internal note regarding the claim 
status to help track claim activity, position your text cursor in the Claim Status Note feld, click Insert 
Dateline if you want to insert the current date and time, and then type the desired note. 

4. Click OK. 

1

2 

3 

4 
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I 
Insur a nee Notes 
Ask for Debbie ii ooverage questions. 

',i;' Insurance Plan Note ~ 
Insert Dateline I j2J 

I 
~sk for Debbie if you have coverage questions. a 

0 
~ 

Clear 11 OK I Cancel I , 
' 

~ Primary Dental Insurance Claim (02/13/2012) Sent 

Billing Provider· Smith, Dennis D 

~ Insurance Claim Note ~ 

Insert Date line I j2J 
A note specific to this claim here, such as remarks for unusual 
services.-Wed-Apr17,2013j 0 

Clear Cancel 

Help 

I 

Gr 

Editing Dental Insurance Plan Notes 
Te Insurance Plan Note block displays any notes that have been entered for an insurance plan from the 
Family File (for any patient with the same insurance plan). Te insurance plan note does not print on the 
insurance claim. For information about how to include a note on the claim, see “Adding Dental Insurance 
Claim Notes” in this chapter. 

To edit an insurance plan note 

1. Double-click the Insurance Plan Note block. 

Te Insurance Plan Note dialog box appears. 

2. Type or edit the notes for the insurance plan. 

3. Click OK. 

1

2 

3 

Adding Dental Insurance Claim Notes 
You can add a narrative to your claim to document and/or explain treatment. 

To add a note that will print on the claim 

1. On the insurance claim window’s menu bar, click Note. 

Te Insurance Claim Note dialog box appears. 

2. Type any notes regarding the claim. 

1 

Note: When submitting claims 
electronically, only the frst 125 
characters of the insurance claim note 
can be transmitted. 

3. Click OK. 2 

3 
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Donlr~ Lodgor - (Crosby, Bron!) [AF] [UTC -07:00 [MST)) [DESMITH] [CR0004C] [11/11/1973] [44] 

f il e Qptions Yiew !ransaction !nsuranc e £ rint Month End t!elp 

Oescri tion 

03/31/2003 Brent Crosby Adjust ... Initial Balance Forward 
03/31/ 2003 <Family> Adjust ... Credit Adjustm ent 
04/01/2003 Brent Crosby D4355 Full mouth debridemnt,evaVdi ... 
04/01/2003 Brent Crosby UR 09630 IRRIGATION PER QUAD 
04/01/2003 Brent Crosby UL 09630 IRRIGATION PER QUAD 
04/01/2003 Brent Crosby LL 09630 IRRIGATION PER QUAD 
04/01/2003 Brent Crosby LR 09630 IRRIGATION PER QUAD 
04/01/2003 Brent Crosby REFOS Referred To Oral Surq ery 
06/19/2003 <Fam ily> Payme .. . Care Credit 
06/19/2003 <Family> Adju il: ... Spec ial Adj 

06/19/2003 Brent Crosby Adjust ... Specia l A dj 

12/03/ 2013 Brent Crosby 0 D2391 Resin-1 surface, poster 
05 5 2014 Brent Crosb 

N R 

Sent _______ ~ 

Help 

Carrier: Aetna Dental 
Group Plan: HSPS Aetna 

[Release of Info/Assign of Benefits) 

Insurance Claim Information 

Pre•Authorization Number: 

First Visit Date Cuirent Series: 

Original Refe,ence Number [t:i): 

School City 

r Occup. Illness 01 lnju1y : 

r Auto Accident 
r Othe, Accident 

r Fuu.T ime 

How Many? f4 r Othe1 Attachments 

How Many? j 
How Many? 

Insurance Ref t:i: 

Dates Descriptions 

i----
i----

r Services Covered by Another Plan: 
Prosthesis------------------. 

Replace Reason Prior Date 
,r- No r Initial r Replacement 

Date Ordered· r Estimated 

r o,thodontic Treatment- Placement Date: i---- Mos. Remain: I 
Clear I 

Claim lnformalion: Non·Standa 

D iag. Codes: 

For Special/Medicaid Claims-----­

R efening Prov: 

Reason for Pre-Auth: 
,r- Required 
r Se,vices Exceed Max. 

Service Authmization· Exception Code 

l< NONE> ..:J 
90-Day Indicator 
l< NONE> 

r Oral Surgery 
1 Special Case/EPSDT 

r Medicare 
r Eligibility Pending 

r Retroactive Eligibility 

..:J 
r Re-Evaluation 
1 CHOP 
r ccs 

Referring Physician--------, 
Referred: 

ID Number Type 

I ..:.l 

_2.d Remove I 
ID Number 

2nd ID Number 3e 2nd ID Number 

I ~ 
Other Subscriber lnformation-----­

Remaining Patient Liability Amount: ~ 

Total Non-Covered Amount: ~ 

~ P,imary Clarm Adjustment Reasonjs) 

Cancel 

Including Attachments with Dental Insurance 
Claims 
You can attach radiographs, images, models, documents, and perio charts to dental insurance claims. 

To include attachments with a claim 

1. If you are not already viewing the 
insurance claim window, double-
clicking an existing dental claim in the 
Ledger transaction log. 

2. In the insurance claim window, 
double-click the Claim Information 
block. 

Te Insurance Claim Information 
dialog box appears. 

3. Select whether you are attaching 
radiographs, oral images, models, and/ 
or other, and then type the number of 
items being attached in the corresponding How 
Many? felds. 

4. Click Include Attachment(s). 
2

3 

4 

9 
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UR 
UL 
LL 
LR 

0 

Include Attachment(s) 

Date Doc T e/ Filename Ori in T e Note 

0212412011 Test rtl document.rt! Imported Support D ... 
011251201 2 1000051_2_113921.per Perio File 
041171201 3 MiPACS Xrays/pan DocCenter Support D ... 
041171201 3 123321 Non-Electronic Support D ... note for no 

rrr 

Attachment Information Remove Attachment 

AOIUSI ... 

D4355 
D9630 
D9630 
D9630 
D9630 
REFOS 

Payme ... 
Adjust ... 
Adjust ... 

D2391 

When an attachment is printed or sent electronically the 
most recent version of the attachment will be used. 

. 

Close 

1...reo1t '"'-0tusrment -j,V,WVC:•)Mtl ti 

Full mouth debridemnt,.eval/ di ... 50.00 MHAYES 
IRRIGATION PER QUAD 30.00 MHAYES 
IRRIGATION PER QUAD 30.00 MHAYES 
IRRIGATION PER QUAD 30.00 MHAYES 
IRRIGATION PER QUAD 30.00 MHAYES 
Referred To Oral Surgery 0.00 MHAYES 
Care Credit -1495.00 DESMITH 
Special Adj -1495.00 MHAYES 
Special Adj 1495.00 DESMITH 
Resin-1 surface,. poster R 90.00 DESMITH 

125.00 DESMITH ····-
Prima ry Denta l Insu rance Claim (02/13/2012) Sent 

Patient: Abbott, James S 
Subscriber: Abbott James S 

ce ... ~ nis O 

de 

Claim 

Print 

Cancel 

Print Help 

G, 

Te Include Attachments dialog box appears. 

5. Under Attach From, do any of the following: 

• Click Document Center to attach any images 
(such as .pngs and .jpgs) in the patient’s 
Document Center. 

5 
6 

• Click Import Perio Chart to attach any saved 
periodontal examination. 

• Click Import File to attach any fle with an .rtf 
or .txt extension. 

76. If you will be including an attachment of another 
type with a printed claim, click Non-Electronic. 
In the Attachment Information dialog box that 
appears, type an Attachment Note, select an 
Attachment Type and Transmission Code, type a 
Control Number, and then click OK. 

8 

7. If you want to view or add attachment information for an attachment, select the desired attachment in 
the list, click Attachment Information. In the Attachment Information dialog box that appears, type an 
Attachment Note, select an Attachment Type, and then click OK. 

8. Click Close to return to the Insurance Claim Information dialog box. 

9. Click OK. 

Reprinting Dental Insurance Claims 
If you have edited an insurance claim, you can reprint it. 

To reprint a claim 

1. In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log. 

Te insurance claim window appears. 

2. On the menu bar, click Print. Te 
Insurance Claim Print dialog box 
appears. 

3. If you are not including any attachments, clear the 
Attachment(s) check box. 

4. Click Send to Batch (to send the claim to the Batch 
Processor), Send Electronically (to send the claim 
through electronic fling), or Print (to print the claim 
now). 

2 

4 

3 
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, ' ..... , .. 
03/31/2003 Brent Crosby 
03/31/2003 <Family> 
04/01/2003 Brent Crosby 
04/01/2003 Brent Crosby 
04/01/ 2003 Brent Crosby 
04/01/ 2003 Brent Crosby 
04/01/2003 Brent Crosby 
04/01/2003 Brent Crosby 
06n.9/ 2003 <Family> 
06n.9/ 2003 <Family> 
06n.9/ 2003 Brent Crosby 
12/03/2013 Brent Crosby 
05n.5!2014 Brent Crosby 

rimmm!U&M 

, ....... ....... , , ........ ,, _,, ...... - I ------ I I ........... ,r ....... , 

Adiust ... Initial Balance Forward 
Adjust ... Credit Adjustment 

D4355 Full mouth debridemnt,eval/di .. , 
UR D9630 IRRJGA TION PER QUAD 
UL D9630 IRRJGA TION PER QUAD 
LL D9630 IRRJGA TION PER QUAD 
LR D9630 IRRJGATION PER QUAD 

REFOS Referred To Oral Surgery 
Payme ... Care Credit 
Adjust ... Special Adi 
Adiust ... Special Adj 

0 D2391 Resin-1 surface,. poster 

31-->60 61-->90 91--> Suspended 

Primary Dental Insurance Claim (02/13/2012) Sent 

1 e Claim Enter Payment Note Print Help 

atienl: Abbott James S 
Subscriber: Abbott.James S 

Employer: HSPS 

Billing Provider: Smith. Dennis D 

G, 

, .. , .. ,., 

R 

Deleting Dental Insurance Claims 
You can delete a dental claim after it has been created. If a secondary dental claim has been created, you must 
delete the secondary claim before you can delete the corresponding primary dental claim. If a dental claim has 
been paid and is in history, you cannot delete it. 

For information about how to delete a payment for a claim without deleting the claim, see “Editing or 
Deleting Dental Insurance Payments” in this chapter. 

To delete an insurance claim 

1. In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log. 

Te insurance claim window appears. 

2. From the File menu, click Delete. 
On the confrmation message that 
appears and cautions you that deleting 
the claim will also delete any attached 
payments and adjustments, click OK. 

1

2 
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041Ul, 2003 Brent Crosby 
06/19/2003 <Family> 
06/19/2003 <Fam ily> 

;i' Enter Insurance Payment 

0 

RE.FUS keterred To Ural Surqery 
Payme .. , Care Credit 
Adjurl... Specia l Adj 
Adju rl... Specia l Adj 

D2391 Resin-1 surface, porter 

Primary Dental Insurance Claim (02/13/ 2012) Sent 

nter Pa men Note Print Help 

Palienl: Abbott, James S 
Subscriber: Abbott, James S 

Employer: HSPS 

BillinQ Provider· Smith Dennis D 

Operator: !ENTERPRI SE Collecting Clinic: jCENTRAL ..::J 
Date: 1 □4117/2013 

Amount: ! ~ 38. 00 Check II:: 

,-----a""""""' 
,----- k/Branchll:: ,------

Payment Type: r. Check Payment 

P" AdjustYTD Benef~s/Deductible 

Code Descri tion Provid er Char e 

00140 limited oral .. DDSl 35.00 12.00 
f"Vllff'\ D~t;,il'M~ns DOSl :>R(Y'J '.!R('fl 

Gr 

Posting Dental Insurance Payments 
For Dentrix Enterprise to accurately track insurance deductibles and benefts used, you must link insurance 
payments to their corresponding dental claims. To help you make sure insurance payments are linked 
correctly, when you post an insurance payment, Dentrix Enterprise will automatically itemize the payment 
for each procedure according to the estimated insurance portion, but you can easily edit or remove the 
applied amount as needed. Deductibles will be applied according to the dental insurance plan’s coverage table 
automatically, but you can change or remove any amounts as needed. Also, you can write of an amount 
(make an adjustment) while posting the payment. 

Tip: For new ofces, if the claim for which you are posting payments was not created using Dentrix 
Enterprise, post the insurance payment as a guarantor payment. For information about how to add a 
payment type, such as “Insurance Payment,” to distinguish these payments from patient payments, see the 
“Customizing Payment Types” topic in the Dentrix Enterprise Help. 

To post an insurance payment 

1. In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log. 

Te Insurance Claim window appears. 

2. On the menu bar, click Enter Payment. 

Te Enter Insurance Payment dialog box appears. 
2 

3. Set up the following options: 

• Collecting Clinic – Click 
the search button to 
select the clinic that is 
collecting the payment. Te 
Claim Clinic (the clinic 
where the claim was created) 
appears for your reference. 

• Date – By default, the 
payment’s date is today’s 
date, but you can change it. 

3

6

4

5

• Amount – Dentrix Enterprise automatically inserts the estimated insurance portion in this feld, but 
you can change amount of the payment if the paid amount on the insurance check is diferent. 

• Payment Type – Select Check Payment or Electronic Payment (EFT). If the carrier is making 
payment to the ofce with a check, type the Check # and Bank/Branch # of the check. 

• Adjust YTD Benefts/Deductible – Leave this check box selected if you want Dentrix Enterprise to 
adjust the patient’s year-to-date benefts and any applied deductible accordingly. 

• Deductible Applied For Claim – If money has been withheld toward a deductible, type the withheld 
amount in the appropriate felds: Standard, Preventative, and/or Other. 

• Note – To document information regarding the insurance payment, type a note. 

4. In cases where your practice does not bill the patient, such as with some preferred provider (PPO) plans, 
you can quickly create an adjustment to ofset any remaining balance. Also, for instances where a negative 
payment (refund) is entered for a claim, you can enter an adjustment for that claim. Do the following: 

a. Under Enter Adjustment, from the list, select Write-Of(-) or Refund(+). 

b. Click $ to adjust of a dollar amount or % to adjust of a percentage of the claim’s remaining balance. 
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c. If you selected $, the unpaid balance for the claim appears in the Total Amount feld, but you can 
change the adjustment amount. If you selected %, the unpaid balance for the claim appears in the 
of feld. Type the percentage to be adjusted in the % feld, and Dentrix Enterprise will calculate the 
adjustment amount and populate the = feld. 

5. When you enter a payment amount, Dentrix Enterprise will automatically allocate the payment to the 
oldest provider balances, according to the charges listed. Te amount applied appears in the Applied 
column. You can apply any remaining amount or edit the applied amounts as needed: 

• To apply a remaining amount, select the desired charges (to select multiple charges, while holding 
down the Ctrl key, click each charge), and then click Apply Remaining. Te amount in the Total 
Remaining feld is applied to the selected charges. 

If the amount exceeds the guarantor estimate, a dialog box will appear. Do one of the following: 

• Select Do not apply the remaining amount to only apply an amount equal to the insurance 
estimate, and then click OK. 

• Select Apply the remaining amount to and Exceed insurance estimates to apply the remaining 
amount but not exceed the total charge (which will result in an overpayment), and then click 
OK. 

• If at least one of the selected procedures has a non-insurance credit amount (Guar Cr column) 
that can be suspended or re-allocated and one or more non-insurance credits have not been 
placed in history, select Apply the remaining amount to and Change guarantor credit 
allocations to suspend the non-insurance credit amount but apply the insurance payment, and 
then click OK. 

Tip: You can use the Change guarantor credit allocations option in cases where you have 
a primary claim with a pending secondary claim and paying the balance might result in a 
remaining balance that is less than what will be paid by the secondary insurance carrier. However, 
it is more practical to deal with that possibility when the secondary claim is paid rather than with 
the payment for the primary claim. 

• To remove applied amounts, select the desired charges, and then click Remove Applied. 

• To edit an applied amount, double-click the desired charge to enable the applied amount to be 
edited, type the correct amount to be applied, and then click the check mark 

• To save the paid amount as a reference for future estimates, double-click the procedure (or right-click 
the procedure, and click Edit Ins Payment Amount). In the Edit Insurance Payment Amount for 
Procedure dialog box, type the insurance amount from the insurance EOB, and then, if appropriate, 
you can update the payment table. If the applied amount exceeds the amount of the procedure, a 
message appears and asks if you want to automatically adjust the applied amount to the amount of 
the procedure or return to edit the applied amount. 

Te next time any patient with this insurance plan has the same procedure recommended or 
completed, Dentrix Enterprise will use the payment amount as the insurance estimate. 

Important: It is important that you update the payment table only when the payment amount 
applies to all patients covered by that plan. For example, if the estimated insurance portion is diferent 
from the payment amount because money is being withheld toward a deductible, do not update the 
payment table. Similarly, if a patient has exceeded his or her maximum beneft, do not update the 
payment table. 

. 

6. Click OK/Post. 

If the payment amount exceeds the allocated amount and/or the estimated insurance portion exceeds 
the allocated amount, a dialog box (or message) appears. Choose how you want to handle the insurance 
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04101, 2003 Brent Crosby 
06/19/2003 <Fami ly> 
06/19/ 2003 <Family> 
06/19/2003 Brent Crosby 
12/03/ 2013 Brent Crosby 0 14 

REfOS 
Payme ... 
Adjust ... 
Adjust ... 

D2391 

Referred Io Oral Surqery 
Care Credit 
Special Adj 
Special Adj 
Resin -I surface, poster 

0-->30 I 31-->60 ] 61-->90 91--> ! Suspended I Patient Balance Today's Cha19 

Billing Provider: Smith, Dennis D 

Carrier: Aetna Dental 
roup Plan: HSPS Aetna 

(Release of Info/Assign of Benefits) 

Claim Information: Non-Standar 

overpayment. For information about how to handle insurance overpayments, see the “Handling insurance 
overpayments” topic in the Dentrix Enterprise Help. 

If Write-Of was selected, the Enter Credit Adjustment for Insurance Claim dialog box appears. Make 
any necessary changes to the adjustment type, provider, and amount, and then click OK to post the 
insurance payment and corresponding adjustment. 

If the patient has secondary insurance or medical coverage, a message appears and reminds you to create 
a secondary or medical claim. Click OK, and then click Create Secondary or Create Medical on the 
Insurance Claim window’s menu bar. 

Note: At times, an insurance carrier will send partial payment for an insurance claim while waiting for more 
information on certain procedures. In this situation, Dentrix Enterprise provides the following methods for 
posting two separate payments to the claim: 

• Splitting an existing dental claim into two separate claims 

• Posting multiple payments to one dental claim 

For information about how to perform these tasks, see the “Posting partial dental insurance payments” topic 
in the Dentrix Enterprise Help. 

Creating Secondary Dental Insurance Claims 
For patients with additional dental insurance coverage, when you enter an insurance payment for their 
primary dental insurance claim, Dentrix Enterprise asks if you want to create a secondary dental insurance 
claim. However, if you choose to not create a secondary dental claim after entering an insurance payment 
for the primary dental claim, or if you add the patient’s secondary dental insurance plan after the entering an 
insurance payment for the primary dental claim, Dentrix Enterprise allows you to manually create a secondary 
dental insurance claim. 

With Dentrix Enterprise, you can also create tertiary and quaternary dental claims. 

To create a secondary claim 

1. In the Ledger, with a patient selected, 
double-click a primary dental claim. 

Te insurance claim window appears. 

2. If you added secondary insurance 
information after you created the 
primary claim, you must update the 
secondary insurance information on the 
primary claim before you can create the 
secondary claim. In the claim window, 2 

3 
4 

double-click the Patient/Subscriber 
Information block, select Update 
Secondary Insurance, and then click OK. 

3. From the Claim menu, click Create Secondary. 

Dentrix Enterprise creates the additional claim, and the insurance claim window displays that secondary 
claim. 

Tip: To switch back to the primary insurance claim, from the Claims menu, click View Primary Dental. 

4. While viewing the secondary claim, on the menu bar, click Print. In the dialog box that appears, click 
Print (to print the claim immediately) or Send to Batch (to send the claim to the Batch Processor in the 
Ofce Manager). 
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07/29/ 2014 Brent Crosby 
07/29/2014 Brent Crosby 

Brent Crosb 
Brent Crosb 

6 
7 

D6240 Pa ntie-porcelain fus ed t o-hn ob - D6240 Pontic-porce ed t o-hn ob .... •- --······ In s Prim Dental C - Rec'd 125 ,00 

~ Ed it or Delete Insu rance Payment = ~~ 

OperatOf: !ENTERPRISE Collecting Chnic: !CENTRAL .::.l 

0 Date: 1 □4/17/2013 Encounter It I 

Amount: I ~0.00 Check It j12345 

Pre-AuthNumbe,: I Bank/Branch It: I 
Claim Clinic: I CE NTRAL Payment Type: r♦ Check Payment Delete I 

Apply Remaining I Remove Applied I 
r Electronic Payment 

(NOTE: Insurance Estimates are only for this claim) OK/Post I Cancel I 
Note ITh;, ;, a oote lo, the"""""" paymeot . 
~ . 

Date I T ... ] Surface I Cod e I Desc ript ion I Provide r I Charq e I 0 th In d Guar Crl In s Est I Ins Amt I App li ed I Balance I 
01/31/12 00140 Limit ed ontl .. DDSl 35.00 0.00 23.00 0.00 0.00 12.00 0.00 
01/31/12 D0160 Detai1/W:ensi ... DDSl 38.00 0.00 0.00 0.00 0.00 38 .00 0.00 

~ IRema i ... _I_ Total ~ _Total Oth erln sJ_ Total Guar Cr l Total lns Est j_ Total lnsAmt J_ To~_ Total~ 
0.00 73.00 0.00 23.00 0.00 0.00 50 .00 0.00 

Editing or Deleting Dental Insurance 
Payments 
You can correct a mistake that was made when posting an insurance payment. You can also delete an 
insurance payment that was entered in error. However, you cannot edit or delete an insurance payment that 
has been moved to history (when closing a month). 

To edit or delete an insurance payment 

1. In the Ledger, with a patient selected, double-click an insurance payment in the transaction log. 

Te Edit or Delete Insurance Payment dialog box appears. 

1 

2 

2. Do one of the following: 

• Edit the payment 
amount or applied 
amounts as 
necessary, and then 
click OK/Post. 

• To delete the 
payment, click 
Delete. When 
a confrmation 
message appears, 
click OK to 
continue with the 
deletion. You are taken to the insurance claim window, where you can re-post the payment correctly. 
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04101, 2003 Brent lrosby 
06/19/2003 < Fa mi ly> 
06/19/ 2003 < Family> 
06/19/2003 Brent Crosby 
12/03/2013 Brent Crosby 0 

RHOS Referred lo Oral Surgery 
Payme... Care Credit 
Adjust.. . Special Adj 
Adjust... Special Adj 

92159 l,wl l """""'=' .... i&a.;;,: ...... 
D2391 Resin·lsu rface,.poster o R 

Primary Dental Insurance Claim (02/13/ 2012) Sent 

File Claim Enter Payment Note Print Help 

Patient: Abbott, James S 
Subscriber: Abbott, James S 

Employer: HSPS 

Carrier: Aetna Dental 
Group Plan: HSPS Aetna 

(Release of Info/Assign of Benefits) 

Billing Provider: Smith Dennis D Claim Information: Non-Standard 

Patient / Insurance Information 

Signature on File--------, 

P' Release of Information 

P' Assignment of 8 enelits 

ID Number [SStt): 1111111111 

Lifetime Annual Annual 
Individual Individual F amil_y 

Standard Required: ~ I 500.00 I 1500.00 

Mel~~~ 

Preventive Required: ~ 11000.00 13000.00 

Mel~~~ 

Other Required: ~ 11500.00 14500.00 

Mel~~~ 

Individual 

Maximum Benefits: I 50000. 00 

Benelits Applied: ~ 

~ 
115000 00 

[oooo 

Indicating Dental Insurance Benefts Used 
and Deductibles Met 
Typically, you will indicate deductibles met when posting an insurance payment, and Dentrix Enterprise 
will automatically track benefts used and deductibles met for patients. However, on occasion, you can have 
patients who come to your practice mid-year. Tese patients might have met part or all of their deductibles for 
the year or used part or all of the maximum benefts. 

1. In the Ledger, with a patient selected, 
double-click a sent (pending) dental 
claim in the transaction log. 

Te insurance claim window appears. 

Tip: If an insurance claim for this 
patient has not yet been created, you 
can post “dummy” procedures and create a 
“fake” claim and then delete them once the 
deductible information has been entered. 

2

2. Double-click the Subscriber Information 
block. 

Te Patient/Insurance Information dialog box appears. 

Notes: 

• In the Family File, you can indicate a subscriber’s 
maximum benefts and deductible(s). With this 
information, Dentrix Enterprise can provide you with 
accurate insurance estimates, which take the plan 
maximums and deductibles into account. 

• Te Patient/Insurance Information dialog box 
displays both the entered maximum benefts and 
deductibles for the carrier, as well as the benefts used 
and deductible met amounts. 

3. If necessary, edit deductibles met and benefts applied 
in the appropriate felds. Once the information has 
been posted, Dentrix Enterprise will use the updated 
information for calculating all future insurance estimates 
for the patient or family. 

4. Click OK. 

4 

3 
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Information - AF X 

General I Settings ) Optional SeUings ) Subscriptions I 
.Qescriptive ID: 

IAF 
Financial Number: 

C)inic TIN 

1101010100 

Clinic NPI 

Title: 

I My Dental Corporation 

8,ddress: 

p 234 Pine Drive 

I 
_(ity 

IAmerican Fork 

Phone 

hso1 1555-1111 

Upload Logollmage 

Ext r--

Internal ID: 

11000018 

Merchant ID: 

Entit~ ID Code: 

' Clinic DID: -

I 

ST Zip 

~ r,,;,,-
Fax 

hso1 1555-2222 

Cancel 

Processing Medical Insurance Claims 
For hospitals and skilled nursing facilities, if you submit dental insurance claims using eClaims (also known as 
eTrans), which is the electronic claims service that is provided by Henry Schein One, you can use it to submit 
medical insurance claims electronically as 837i fles. 

Important: Te submission of 837i fles is supported. Te submission of 837p fles is not supported. 

• Te 837i is the electronic version of the paper form UB-04. 837i fles are used to transmit institutional 
claims. Institutional claims are those submitted by hospitals and skilled nursing facilities. 

• Te 837p is the electronic version of the paper form CMS-1500. 837p fles are used to transmit 
professional claims. Professional claims are those submitted by physicians, suppliers, and other non-
institutional providers for either inpatient or outpatient services. 

Requirements 
For the successful transmission of medical insurance claims, make sure that the required information is set up 
in the following areas of Dentrix Enterprise: 

• Clinic Information – Verify the clinic information for each clinic where services are rendered. While 
logged in to a clinic, in the Ofce Manager, on the Maintenance menu, point to Practice Setup, and 
then click Clinic Resources Setup. In the Clinic Resource Setup dialog box, under Clinic Information, 
click Edit. In the Clinic Information dialog box, the following information is required: 

• Clinic TIN. 

• Title. 

• Address – Street, City, ST, and Zip. 
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er Inform ation X 

I Name: lsmith IDennis r User ID: IDSMITH ~ 
Last F st Ml Lo~ On 

!D IDSMITH Iitle lDMD r Non-Eerson 1!.ser Password: 1~m 
Confirm Pass!6!ord: I"""" 

Electronic Ax User I 
Specialt.1.r I Dentist ..:.l 

Sheet 
Address: I 1 234 Pine Dr fee Schedule: 11. OFFICE ~ 

I RVU Sch~dule: 11. ~ City State Zip 
Cjinic: IAF ~ IAmericcan Fork fuT I 111 1 1 

I TIN JI: 1111111111 ~I Pb one: I (801 )555-1111 E~t l 

E-Mail: IDocumentation@henryschein.com 
2S U: 1123-12-3412 

Assigned l□ peratory !Clinic 
St~te ID U:1123456 S late:[u"'r" ,,.~I State License Expiration: 10110112040 

Medicaid U: 112345M 

DEA U: 112345D 

Proyider ID Setup I DEA License Expiration: 10110112040 

.Class DEA Schedule: P- 11 P° III P° IVP°V 
r- Primary Tie to Primary Provider: I NPI : 11234567890 I r Secondary I 2:.1 r- Blue Cross lllff: 112345BCBS 

r Blue Shield IDU: 
Insurance Claim .Qptions Provider U: I 12345P 
r Print Provider's Signature Using: 0 ff ice U: I 1 23450 
r. Signature on File r Provider's Name 

Other IDU: 1123450ID 
r Use Clinic TIN 

UPINU: 112345UPIN 

OK I Cancel I 

• Billing Provider Information – Verify the provider information for each billing provider. In the Ofce 
Manager, on the Maintenance menu, point to Practice Setup, and then click Clinic Resources Setup. 
In the Clinic Resource Setup dialog box, under Provider(s), double-click a provider. In the Provider 
Information dialog box, the following information is required: 

• Name. 

• Specialty. 

• Address – Street, City, ST, and Zip. 

• Phone. 

• TIN #. 

• NPI. 
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er Inform ation X 

I Name: lsmith IDennis r User ID: IDSMITH ~ 
Last F st Ml Lo~ On 

!D IDSMITH Iitle lDMD r Non-Eerson 1!.ser Password: 1~m 
Confirm Pass!6!ord: I"""" 

Electronic Ax User I 
Specialt.1.r I Dentist ..:.l 

Sheet 
Address: I 1 234 Pine Dr fee Schedule: 11. OFFICE ~ 

I RVU Sch~dule: 11. ~ City State Zip 
Cjinic: IAF ~ IAmericcan Fork fuT I 111 1 1 

Pb one: I (801 )555-1111 E~t l 
TIN JI: 1111111111 [ill 

E-Mail: IDocumentation@henryschein.com 
2S U: 1123-12-3412 

Assigned l□ peratory !Clinic 
! st~te ID u:1123456 S late:[u'r' I ,,.~I State License Expiration: 10110112040 

Medicaid U: 112345M 

DEA U: 112345D 

Proyider ID Setup I DEA License Expiration: 10110112040 

.Class DEA Schedule: P- 11 P° III P° IVP°V 
r- Primary Tie to Primary Provider: I NPI : 11234567890 I r Secondary I 2:.1 r- Blue Cross lllff: 112345BCBS 

r Blue Shield IDU: 
Insurance Claim .Qptions Provider U: I 12345P 
r Print Provider's Signature Using: 0 ff ice U: I 1 23450 
r. Signature on File r Provider's Name 

Other IDU: 1123450ID 
r Use Clinic TIN 

UPINU: 112345UPIN 

OK I Cancel I 

• Rendering Provider Information – Verify the provider information for each provider who renders 
services. In the Ofce Manager, on the Maintenance menu, point to Practice Setup, and then click 
Clinic Resources Setup. In the Clinic Resource Setup dialog box, under Provider(s), double-click a 
provider. In the Provider Information dialog box, the following information is required: 

• Name. 

• Specialty. 

• Address – Street, City, ST, and Zip. 

• Phone. 

• State ID. 

• NPI. 
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Information X 

Last First Ml Suffix Lo~ On 
!:lame: lsmith loennis 11 User ID: IDSMITH ~ 

!D IDSMITH litle ID.M.D r Non-Person !J.ser Password: I"""" 

- Confirm Pass1Yord: lxm 

Electronic R :-: User I 
Specialt~: I Dentist ..:J 

Sheet 
Address: I 1 234 Pine Dr fee Schedule: 11. OFFICE 2d 

I RVU Sch~dule: 11. 2d Cit~ State Zip 
IAmericcan Fork ~ I 1 111 1 C!inic: IAF 2d 

Pbone: liso1 )555-1111 E~t l 
TIN J!: 1111111111 [I]! . 

E-Mail: IDocumentation@henryschein.com 
_25 U: 1123-12-3412 

Assign~d l□ peratory !Clinic 
St.ste ID U:1123456 State:[uT ,,.~I State License E:-:piration: 101 /01/2040 

Medicaid U: 112345M 

DEA U: 112345D 

Proyider ID Setup I DEA License Expiration: 101101 12040 

,Class DEA Schedule: 17 II f7 lll f7 1V f7 V 
r- Primary Tie to Primary Provider NPI : 11234567890 
r Secondary 

I 2J r♦ Blue Cross IDU: l l 2345BCBS 
r Blue Shield IDU: 

Insurance Claim Qptions Provider U: I 12345P 
r Print Provide,'s Signature Using: Office U: I 1 23450 
(.' Signature on File r P1ovide1's Name 

Other IDU: 1123450ID 
r Use Clinic TIN 

UPINU: 112345UPIN 

OK I Cancel I 

• Pay-To Provider Information – Verify the provider information for each pay-to provider. In the Ofce 
Manager, on the Maintenance menu, point to Practice Setup, and then click Clinic Resources Setup. 
In the Clinic Resource Setup dialog box, under Provider(s), double-click a provider. In the Provider 
Information dialog box, the following information is required: 

• Address – Street, City, ST, and Zip. 
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reel />,ddress: I 1234 Insurance Way 

Cjly, ST Zip: IAnylown 

Ehone: I 1aaaJ555-1234 

Contact 

Group tt: 1987651111 

Lasl l)pdale: 09/1712019 

I claim format:! UB04 

Fee .$.chedule: l<NONE > 

RVU Scbedule: I <NONE > 

P' 837i Pa~or ID : '36273 

Plan External ID : 

N ationa] Plan ID: 

Local: r----

.. :.H C)aim S elup I 
...::J Not~s 

» Proyider ID Setup 

...::.1 

5.Qurce of Payment: I Commercial Insurance Co. ,3 
MU Payor SOP: ...::J 

I Diagnostic Code System: I ICD 10 ..:J! 

r Do Not Include Group Plan Name for Electronic Claims 

Financial Class T_ypes------------~ 

r. No Financial Class T _ypes 

r Use Financial Class T _ypes 

r Write Off Estimated Insurance Portion 

I 1 : -Professional Discount 

r Post when Claim Created 

r R ece,ve Claim 

r Send lo Balch 

r Apply Insurance Portion to Maximums 

r Apply deductibles based on expected 
Patient Portion 

r♦ Post when Procedure Completed 

r Use Insurance Fee Schedule to Calculate: 
(adjustment amount= provider/patient fee 
schedule amount - insurance fee schedule amount) 

I 1 : -Professional Discount 3 ...::J 
r Post when Claim is paid 

r♦ Post when Procedure completed 

r Create/A eceive Claim 

r Send to Batch 
r Apply deductibles based on expected 

Patient Portion 

Rate Code Options:-----,.-_-_-,::,::,::,::;:--~ 

r Send Rate Code with Claim: _j 
Send R ale Code With: 

r, The T olal of All Procedures 

r Practice's Rate 

r NoAmount 
$ looo 

Send Procedure Codes With: 

lwith A Zero 10.00) Dollar Amount 

r Post Rate Code to Ledger 

Medicaid RAP Options:----------~ 

r Send dental claim as medical claim electronicall_y: 

FQHC Medicaid ID: 

Default Modifier: ...::.1 

,C:lear OK Cancel 

• Medical Insurance Plan Information – Verify the information for each medical insurance plan that is 
attached to a patient. With a patient selected in the Family File, double-click the Insurance Information 
block. In the Insurance Information dialog box, select the Medical Insurance tab, select a plan in the 
Coverage Order list, and then click Insurance Data. In the Medical Insurance Plan Information dialog 
box the following information is required: 

• Carrier Name. 

• Group Plan – Optional if Group # is present. 

• Address – Street Address, and City, ST Zip. 

• Group #. 

• Claim Format – UBO4 must be selected. 

• 837i – Check box must be selected. 

• Payor ID – Optional if Group Plan is present. 

Note: If blank, the default Provider ID will be populated on the claim form. 

• Source of payment – Cannot be [None]. 

• Diagnostic Code System – ICD 9 or ICD 10. 

• Advanced – Optional claim settings. 
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nsurance Information - (Crosby, Brent) X 

Dental Insurance j Medical Insurance i) 

Insurance Plans 

rwi 2. one 

~ cane Order 

Clear Coy:erage 

View Insurance Plan !:ii story 

Plan Information 

Sybscriber: I Crosby, Brent 

C.9.rrier: I ACME Medical 

! subscriber )d # : i 121 212121 

Signature on file 

17 Release of Information 17 Assignment of Benefits 

Plan Effective Date: 

Patient Information 
Relation t o Subscriber: 

r- Self 

r Spouse 

r child I ..:.] 
r Other '"l _____ ..:.l""' 

Plan Expiration Date: 

r Not Eligible 

La st Eligibility Check: 

Eligibility Start: 

Eligibility End: 

OK 

Insurance Data 

.-------

Cancel 

I 

• Patient – Verify the subscriber information for each medical insurance plan that is attached to a 
patient. With a patient selected in the Family File, double-click the Insurance Information block. In 
the Insurance Information dialog box, select the Medical Insurance tab, and then select a plan in the 
Coverage Order list. Te following information is required 

• Medical Insurance Plan. 

• Subscriber Id #. 
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Procedure Code Editor - Ex1st1ng X 

.Qescription: lsurgic removl resid tooth root 

Patient Friendly Desc,iption 

Surgical removal of a removed tooth's remaining roots 

i;ode Names Ireatment Flags 

ID7250 ADA Code 17 Difficult Proc. 
r Condition 

lsrgRmRThR Abbrev Desc 17 Remove Tooth 
17 Show in Chart 

CPT 

Medicaid 
[ Buto Continuing Care 

!NONE) ~ I 
Code 5 [ Proced!::!re Time cl] 

3 Unit(s) ~ 

P!ocedure Categor_i.i:( Oral Surger_i.i ..:J 
A2pointment Type: I Pl ..:.l 

Treatment Area: I Tooth ..:J Fjags I 
P ajnt T _i.ipe: I Extraction ..:.l 

Educational Y'.ideo 

Edit NQte Ne!t! Code He,t Code 

AMA{:PT Modifiers 
Code 

CPT-Place Of Service 99050 
CPT-Type Of Service 99202 
ICD-10.CM 99203 
ICD-~M 99212 

99213 

Fee Schedule I RVU Schedule I 
i 

2. OMO 
J DELTA 
4. BCB S 
5. CAP FEE 
6. ACME Preferred 
7. UB92Fee 
8. 
9. M005862 

E,1:!;penses------~ 
Lab Materials 

i---- i----

o ot _1 lo enta nsurance 
r Do Not Send Over HL7 
r Require Sjart/Completion Dates 

r Implantable Device 
r E claims: Require Attachment 

137.00 
124.00 
110.00 
10000 
516.20 
161.00 

0.00 
0.00 

.$_ave I _I __ c_los_e __ 

' I Description 

Mer Hours Appointment 

Level 2 Office Visit 

Level 3 Office Visit 

Level 3 Office Vis~ , Short 

Level 3 Office Vis~, Short 

i'>!Jd 

Q,ange 

.Q_elete 

• Procedure code – Verify each ADA procedure code that will be billed to medical insurance can be cross 
coded. While logged in to the Central clinic, in the Ofce Manager, on the Maintenance menu, point to 
Practice Setup, and then click Procedure Code Setup. In the Procedure Code Setup dialog box, select a 
category in the Procedure Code Category list, and then double-click a procedure in the list on the right. 
In the Procedure Code Editor - Existing dialog box, the following information is required: 

• Flag for Medical Cross Coding – Tis must be selected. 

• Medical cross coding: Verify the necessary medical codes are entered and cross coding is complete. In 
the Ofce Manager, on the Maintenance menu, point to Practice Setup, and then click Cross-Coding 
and Medical Code Setup. In the Medical/Cross Code Setup dialog box, perform cross coding on the 
following tabs: 

• Code Setup – Verify applicable codes exist for the following types: AMA-CPT, AMA-CPT 
Modifers, CPT-Place of Service, CPT-Type of Service, and ICD-10-CM or ICD-9-CM 
(depending on medical insurance plan). 
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Medical/Cross Code Setup D X 

Code Setup Cross Code Setup I 
!c ross code for: IAMA-CPT ! Link to l 1cD- l OCM 

Code I Description I Code I Description & 

99050 I Mer Hours Appointment I G89.1 Acute Pain 

99202 I Level 2 Office Visit I K00.6 Disturbance in Tooth Eruption 

"I KOU Impacted Tooth 

99212 I level 30ffice Visit . Short KOJ.81 Cracked Tooth 

99213 I Level 3 Office Visit . Short K04.0 Pulprtis ..... 
1:•I • • .. .. , 
K05.00 Acute Gingivitis 

K05.10 Chronic Gingivitis 

K05.32 Chronic Periodontitis . 

Codes attached to 99203 
Attach Code(s) Remove Code(s) I 

Code System Code System I Code I Description 

11•11!!!11111 , . . .. 
ICD-10<:M ICD-S<: M 13434 13434 
ICD-S<:M 

Medical/Cross Code Setup D X 

Code Setup Cross Code Setup I 
!c ross code for: lcDT I Link to: IAMA-CPT 

• Fla<Jged For Medic.i i Cross Coding 

CategOI)' & I Code I l'bbrev Desc I Description & Code I Description 

Endodontics D7130 RtRemvExR Root removal~ ---- 99050 I After Hours Appointment 

Periodontics D7140 ExtE,pTh Extract ,erupted th 99202 I Level 2 Office Visit 

Prosth , remov D7210 ExtSrErTh Extraction--surgica "I • 
Maxillo Prosth D7220 Ext lmpSfT Extraction-impact1 99212 I Level 3 Office Visit , Short 

Implant Serv D7230 Ext lmpPIB Extraction-impad1 99213 I Level 30ffice Visrt , Short 

Prost.ho . fixed D7240 Ext lmpCmB Extraction--impact1 

D7241 RmvlmpCmB Remov impact-co 

Orthodontics I I . 
Adiunct Serv I • l• I I ► I 

C odes attached to D7250 
Attach Code(s) Remove Code(s) I 

Code System Code System I Code I Description 

"I .. 
AMA-CPT 

• Cross Code Setup – Verify applicable medical and dental codes are cross coded: 

• AMA-CPT to ICD-9-CM and/or ICD-10-CM. 

• CDT to AMA-CPT. 
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[ t eleued: ID Number Type ID Number 

I 
..:2J Remove II ~I 

Medical Cross Coding 

AMA CPT : 199203 2:J I Level 3 Office Visit 

D jagnostic Codes 2:1 Modifier Codes 2:J 
IK04.6 Periapical Abscess 

125 
E&M Service 

l5 Anesthesia 
tartTime: ~ ..:2J End Time: ~.:J Minutes: 1 !,!nils: 121 

T ~pe of Ser vice: Pjace of S e,vice: 

1123 2:]I Surgery ~ 2j J Inpatient 

D~lete I Clear Medical C,oss Coding Information I ~ ~ 

f; Primary Medical Insurance Claim (12/21/ 2020) Sent X 

f ile £!aim Enter Payment N.Qte E.rint J::!elp 

Patient: Crosby, Brent Carrier: ACME Medical 
Sub,criber: Crosby, Brent Group Plan: 

Employer: General ElectJic (Release of Info/Assign of Benefits) 

Billing Provider: Smith, Dennis Claim Information: S landard 

Rendering Provider: Smith, Dennis 1)K04.6 
Diagnosis: 

Pay-To Provider: Smith, Dennis 

D es:cription I Date I PS I TS IAMACPTI Modi!. I U I Diao I Fee I In• Pd I 
Surnic removl resid tooth r"1 2/21 /202rl 21 I 123 I 99203 I 25 I 2 I I 825.921 0.001 " I I I I I I I I I I 

Posting Procedures and Submitting Claims 
With all applicable setup complete, you can post procedures, cross code them, and submit medical claims for 
them. 

To post a procedure and submit a claim 

1. Post a procedure that is cross coded for medical billing: 

• AMA CPT – ICD-9 or ICD-10 code (depending on the medical insurance plan). 

• Diagnostic Codes. 

• Modifer Codes. 

• Type of Service. 

• Place of Service. 

2. Create a primary medical claim with the following information: 

• Providers: 

• Billing Provider. 

• Rendering Provider. 

• Pay-To Provider. 
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Medical Insurance Claim Information X 

~ !_ype of Claim - ~ St!::!dent Status 

r MEDICARE r. None r Part-Time r Full-Time I r MEDICAID 

r CHAMPUS Referring Eh_vsician 

r CHAMPI/A Refened: 

r, GROUP 
IBY: Dr. Evans, Jell 2:1 Remove I 

HEALTH PLAN ID Number Type ID Number 

r FECA jNPI 3 11231 23123 
BLK LUNG Second ID Number Type Second ID Number 

r OTHER luPIN ~ 178978978'.l 

Attachments-----------------~ 

Include Attachment~) I Insurance Ref ft: 

Dates Patient Unable to y{ork: 

School, Cit~ 

Is Patient's Condition Related To -

r ]smployment7 

r /',uto Accident? State: j 

r Qther Accident? 

Accr_gent Date: I 

r Outside 1ab? Charges 

r Accept Assignment (§ov)? 

Date of Current Illness or Injury: 

Related !::i ospitalization Dates: first Date of Same or Similar Illness/Injury; 

Original Rel. No: 

Medicaid Resubmission Code: 

Prior authori,fation Number: 

1 Od. Reseryed for Local Use: 

blear 

H ame and Address of F acilit_y 
where services were rendered: 

Facilit~: 

OK Cancel 

• Claim Information (if applicable): 

• Referring Physician: 

• Referred. 

• ID Number – Only one ID is required: NPI or UPIN. But if you use both types, the frst 
one must be NPI. 

• Second ID Number – If you use two types, the second type must be UPIN. 

• Any additional details, such as Auto- Accident? or Prior authorization Number. 

3. Send the claim. 

Te eClaims Pre-Submission Summary dialog box appears. 

4. Correct any errors that the validation tool may fnd. 

5. Resend the claim. 

Note: You can create a secondary claim only after you receive the adjudication on the primary claim. 

Working with Treatment Plans 
Treatment Plans play an important part in generating and sustaining revenue for most dental ofces. Tis 
section covers the following topics about the Ledger features that can help you manage patient treatment 
plans: 

• Posting Treatment-planned Procedures 

• Creating Dental Pre-treatment Estimates 

• Entering Pre-treatment Estimate Authorizations 

• Completing Treatment-Planned Procedures 

Posting Treatment-planned Procedures 
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~ Enter Procedure(s) 

Operator: [ENTERPRISE 

Date: 04/ 1712013 

Procedure: jD212Q ..:J 
Clinic: r[ C-E-N-TR_A_L ___ ..:J 
Tooth: j 

Surfaces: 
,------

Amount: j 

Encounter ti: 

Start Date: Completion Date: 

Amalgam-2 surface, primar_i,.i Multi-Codes: 

Chart S talus ~~deult 
r♦ Treatment Plan CCChild 

Approval Status Crnlmp 

IN one ~ CrnPCI ns 
...:.J DO Amalg. 

r Completed DO Comp. 
L.,;;.~~~~~~~~~IMOD Amalg r Do Not Bill Dental Insurance ~~tComp. 

r Override Proc Flags Oamalg 
Oresin 

_____ ,.. ______ Modifier: I r Require Start/Completion Date PartMand 

ID Number Type 

..:l 
Change Delete 

ID Number 

PartMax 
PerioExam 
RC/Crwn 
Scale 
STM 

Add 

Most of the time, you post treatment-planned procedures in the Patient Chart; and then, when the procedures 
are completed, they are automatically posted to the Ledger. In some cases, however, you may need to post a 
treatment-planned procedure directly in the Ledger-Treatment Plan. 

Note: According to your organization’s policies and standards, you may be required to enter and edit 
procedure codes related to patient treatment from the Patient Chart. 

To add a procedure to a patient’s treatment plan 

1. In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the Ledger-Treatment Plan view. 

2. From the Transaction menu, click Enter Procedure. 

1 

2 
Te Enter Procedure(s) dialog box appears. 

3. Under Chart Status, leave Treatment Plan selected, and then 
select an Approval Status. Enter the other procedure information 
as explained in “Posting 
Procedures” in this chapter. 

Notes: 

• For information about 
how to set up approval 
statuses, see the 
“Customizing Approval 
Status” topic in the 
Dentrix Enterprise Help. 

• When a procedure is 
completed, the last 
approval status selected 
before the procedure was 
set complete appears next 
to the procedure in the 
AP column of the Ledger, 
Ledger-Treatment Plan, 
and Patient Chart. 

4. OK/Post. 

3 

4 
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03/31/ 2003 Brent Crosby 
03131/}()(13 <Famifv> 

[I] 
' 

Surface To . 

1 

2 

Creating Dental Pre-treatment Estimates 
Dentrix Enterprise includes many features to help you generate dental pre-treatment estimates and print them 
or send them electronically. Te process is similar to creating dental insurance claims. Create a pre-treatment 
estimate when a pre-authorization for treatment is required or when an insured patient requests a pre-
determination of benefts for recommended treatment. 

To create a pre-treatment estimate 

1. In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the Ledger-Treatment Plan view. 

2. Do one of the following: 

• Create a pre-treatment estimate for today’s procedures. 
Tis option is the simplest way to create a pre-treatment 
estimate. Use this method for creating a dental pre-
treatment estimate immediately after treatment-
procedures have been posted. From the Insurance 
menu, click Today’s Procedures, Today’s Procedures 
- Direct Print, or Today’s Procedures - Batch. Or, you can click the Ins. Today’s Proc. button on 
the toolbar. 

Dentrix Enterprise creates a dental pre-treatment estimate that includes all procedures posted on the 
current system date. 

• Create a pre-treatment estimate for specifc procedures. Use this method for creating a dental pre-
treatment estimate for treatment-planned procedures that were posted on another date. 

a. Select the procedures for which you want to create a dental pre-treatment estimate (to select 
multiple procedures, while holding down the Ctrl key, click the desired procedures). 

b. From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or 
Selected Procedures - Batch. Or, you can click the Ins. Selected Proc. button on the toolbar 
(for details about how to set the printing default for this button, see the topic about setting up 
direct print options). 

Dentrix Enterprise creates a dental pre-treatment estimate that includes all selected procedures. 

One of the following occurs: 
• If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create 

a dental pre-treatment estimate, before the pre-treatment estimate is sent, the Primary Dental 
Pretreatment Estimate window appears, allowing you to edit the claim information. 

Note: You only need to edit a pre-treatment estimate when it requires special handling, such as the 
addition of a narrative or to indicate that you are attaching X-rays. 

• Dentrix Enterprise sends the claim to the Batch Processor or prints it immediately. Ignore the steps 
that follow. 
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~ Primary Dental Pretreatment Estimate (01/30/ 2012) Sent 

P atienl: Abbott, James S 
Subscriber: Abbott, James S 

Employer: HS PS 

Rendering Provider: Smith, Dennis 

Pay-To Provider: Smith, Dennis 

Tooth S urlace 
31 

Date Received 

Print Help 

Ins Amt T tal: 

S talus Invoice II: 0 0000320 
Create Date: 0l /30/2012 Tr acer: 

Date Sent : 01 /30/2012 D n Hold: 
Re-Sent: 
Voided: 

Carrier: Aetna Dental 
Group Plan: HSPS Aetna 

Code 
D7110 

0,00 

(Seconda1y lnsu,ance) 

~ Ins fit 
71.00 000 

Total Fee: 71.00 
56.80 
0.00 

have cover age questions. 

Pre-Estim ... ~ 

Include~ 

P' Claim I 
P' Attachmenl(s 

Send lo batch 

Send Electronically 

Cancel 

[ 

3. Make any necessary changes to the dental pre-treatment estimate as explained in “Changing Dental Claim 
Information” in this chapter. You can also add attachments to the pre-treatment estimate. 

4. To batch, send, or 
print the dental pre-
treatment estimate, on 
the menu bar, click Print. 

Te Pre-Estimate Print 
box appears. 

5. If you are not including 
any attachments, clear the 
Attachment(s) check box. 

6. Do one of the following: 

• Click Send to Batch to 
send the pre-treatment 
estimate to the Batch 
Processor. 

• Click 
to send the pre-treatment 

4 

3 

fling. 

• Click Print to print the pre-treatment estimate now. 

Note: If you click Cancel, the pre-treatment estimate status will be “Not Sent.” 
(Tis is not recommended.) 

6 

5 
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1/ D•ntrix Ll!dgor, Troatm•nt Plan · (Crosby, Bront) [AF] [IITC -07:00 [MST]] [DESMITH] [CR0004C] [11/11/1973] [44] 

file Qptions ~iew Iransaction In surance .e_rint Month End .t!elp 

~ Pre-Treatment Estimate Update 

Procedure Status: 

r- Accepted r Rejected 

Estimate Amount: 150.0~ 

Current Coverage: 156.80 

Total Insurance Pre-Estimate 

Authorize Date: 104/ 17 /2013 

Pre-Auth Number: 111111 

Coverage Amount: 56.80 

Total Amount Billed: 

Itemized Total: 

Total Estimate: 

Note Print Help 

Entering Pre-treatment Estimate 
Authorizations 
When an authorization for a pre-treatment estimate has been received back from an insurance carrier, you can 
enter the pre-authorization in Dentrix Enterprise. 

To enter a pre-treatment estimate authorization 

1. 

2. 

3. 

4. 

amount is correct, click OK. 

• If the procedure was rejected, under Procedure Status, select Rejected, and then click OK. 

• If the actual estimate amount is diferent from what appears, type the correct amount in the 
Estimate Amount feld. To save the estimate amount as a reference for future estimates, under 
Update Payment Table, click Yes. Te next time a patient with this plan has the same procedure 
recommended or completed, Dentrix Enterprise will use the new estimate amount. Ten, click OK. 

Important: It is important that you update the payment table only when the payment amount 
applies to all patients covered by that plan. For example, if the estimated insurance portion is 
diferent from the payment amount because money is being withheld toward a deductible, do not 
update the payment table. Similarly, if a patient has exceeded their maximum beneft, do not update 
the payment table. 

Repeat this step for all the other procedures attached to the estimate. Once all procedures have been 
entered, the Total Insurance Estimate dialog box appears. 

5. Type the Pre-Auth Number. 

6. If you did not itemize payments, type the authorized amount in 
the Total Estimate feld. 

7. Click OK/Post. 
5 

In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the 
Ledger-Treatment Plan view. 

Double-click a pre-treatment estimate. 

Te pre-treatment estimate window 
appears. 

From the Enter Estimate menu, click 
one of the following options: 

• Total Estimate Only – To open the Total Insurance Pre-
Estimate dialog box. (Skip step 4.) 

• Itemize by Procedure – To open the Pre-Treatment 
Estimate Update dialog box. (Proceed to step 4.) 

Do one of the following: 

• Dentrix Enterprise automatically inserts the estimated 
insurance portion in the Estimate Amount feld. If the 

1 

2

3 

4 

6 
7 
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Completing Treatment-Planned Procedures 
When a recommended treatment has been fnished, you will need to set the procedure complete in the 
Ledger-Treatment Plan. Setting a procedure complete removes it from the Ledger-Treatment Plan and 
posts it in the Ledger with the appropriate charge and insurance coverage information (including any pre-
authorizations received). 

To set a treatment-planned procedure complete 

1. In the Ledger, with a patient selected, from the Options menu, click Treatment Plan to switch to the 
Ledger-Treatment Plan view. 

2. Select the procedures you want to complete. To select multiple procedures, while pressing the Ctrl key, 
click each procedure. 

3. From the Transaction menu, click Set Procedures Complete. 

Te selected procedures are transferred to the Ledger. 

5. To return to the Ledger, from the Options menu, click Ledger. 

Generating Ledger Reports 
You can print the following reports from the Ledger: 

• Walkout Statement 

• Single Billing Statement 

• Family Ledger Report 

• Patient Ledger Report 



Chapter 7: Ledger    305 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Print Report 

03/31/2003 Brent Crosby 
03/'31 nnm <Fiimilv> 

Walkout Fmm T_ype:----~ 

C. Enhanced Form 

Walkout Dale: j 0411712013 

Message: 
r Plain Form 

Select Repo,t T _ypes: ----~ 

17 Family Walkout 

r Walkout/Doctor's Statement 

r Appointment Card 

r Print Doctor Recommendations 

r PrintYTD Finance Charges, Late Charges 

r Print Adjustments Send to bate 

Save as Default 

Cancel 

A, 
A 

Walkout Statement 
A walkout statement is generally given to a patient as a receipt of charges posted and payments made on the 
day of treatment. Dentrix Enterprise provides you with several options when printing a walkout statement. 

To print a walkout statement 

1. In the Ledger, with a patient selected, do one of the following: 

• If you have set up your walkout statement defaults, click the Print Walkout button on the 
toolbar. Ignore the steps that follow. 

• To override the walkout default options to print a 
diferent type of walkout for the patient. From the 
Print menu, click Walkout. Te Print Report dialog 
box appears. 

2. Set up the following options: 

1 

• Select Report Types – Select the report types 
that you want to print: 

• Family Walkout – TTe family walkout 
statement shows all completed procedures, 
guarantor payments, and adjustments 
posted to the account on the date of 
the walkout. Te walkout then totals all 
charges and credits for the day to indicate 
a total balance, estimated insurance 
portion, and a “Please Pay” amount. In 
addition, as a reminder, Dentrix Enterprise prints the next future appointment at the bottom of 
the statement. 

4 

2 

• Walkout/Doctor’s Statement – If your ofce does not handle insurance for patients, the 
doctor’s statement can be printed for the patient to use in place of an insurance claim. Te 
doctor’s statement shows all procedures for the selected patient but does not include payments. 
A signature line is printed at the bottom of the statement for the doctor’s signature. Adjustments 
can be included on the statement by selecting Print Adjustments. 

• Appointment Card – You can generate a 4” x 6” reminder card that lists the next appointment 
for the patient. 

• Print Doctor Recommendations – If you have added recommendation notes to your 
procedure codes, these notes will be printed on the family walkout statement if Print Doctor 
Recommendations is selected. For information about adding recommendation notes, see “Editing 
Procedure Codes” in Chapter 1: Introduction and Initial Setup. 

• Print YTD Finance Charges, Late Charges, and Payments – If you want to add a row to the 
family walkout statement that shows the year-to-date account totals for fnance charges, late charges, 
insurance payments, and guarantor payments, select this option. 

• Print Adjustments – Normally, when you print a walkout/doctor’s statement, only procedures are 
printed on the report. If you want adjustments to show on the statement, select Print Adjustments. 

• Message – If you have a standard message that you want to print on all walkout statements by 
default, type the note. 

3. If you are not doing a one-time override of the default options, to store your settings as the default 
options for the next time you print walkout statements, select Save as Default. 

4. Click Send to Batch or Print. 

3 
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03/31/2003 Brent Crosby 
03.8112003 <F;imih•'> -------------ii'i== Single Billing Statement 

03/31/ 2003 Brent Crosby 
03Rlf7fl(H <Famitv'> 

Cancel 

~ Family Ledger Report ~ 

First Transaction Dale: ~ 

I Sendtobatco Print I 
Cancel 

Single Billing Statement 
You can generate a single billing statement for a selected account from the Ledger. Also, you can generate 
billing statements for a range of accounts from the Ofce Manager. 

To print a single billing statement 

1. In the Ledger, with a patient selected, from the Print menu, 
click Statement. 

2. Click Send to batch or Print. 

Te statement is generated, according to the options 
you have selected from the billing statement options set up in the Ofce 
Manager. Te Balance Forward date on the statement is automatically set to 
one month prior to the current date. To change the statement print options 
you must change the statement default settings in the Ofce Manager. 
For details about the billing statement options, see “Generating Billing 
Statements” in Chapter 8: Ofce Manager. 

1 

2 

Family Ledger Report 
Te Family Ledger Report shows an account history that includes all procedures, payments, adjustments, and 
service charges posted to the Ledger. You can also generate this report for a range of accounts from the Ofce 
Manager. 

To print the Family Ledger Report for the family being viewed in the Ledger 

1. In the Ledger, with a patient selected, do one of the following: 

• If you only want current transactions (transactions posted since the month was closed out) on the 
report, click the Print Family Ledger button  on the toolbar. (Ignore the steps that follow.) 

• If you want to include more transactions than the 
current transactions on the report, from the Print 
menu, click Family Ledger. Te Family Ledger Report 
dialog box appears. (Proceed to step 2.) 

2. Set up the following options: 

1 

3 
2 

• Balance Forward – You can change the date to include 
more transactions. 

• First Transaction Date – Type the date from which you want to 
print all transactions posted. 

3. Click Send to batch or Print. 
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First Transaction Dale: 03/18/2013 

Send lo batch Print 

Iii 

Patient Ledger Report 
Te Patient Ledger Report is very similar to the Family Ledger Report; however, instead of printing 
transactions for all family members, it shows transactions for the selected patient only. You can also generate 
this report for a range of patients from the Ofce Manager. 

To print the Patient Ledger Report for one patient 

1. In the Ledger, with a patient selected, from the Print 
menu, click Patient Ledger. 

2. Type a First Transaction Date. All transactions posted 
after the entered date will be included on the report. 

3. Click Send to batch or Print. 

1 

2 

3 

Using Fast Checkout 
Te Fast Checkout button combines the three tasks that are typically completed as a patient checks out 
after a visit. All at one time, you can collect a payment, generate an insurance claim, and print a receipt. For 
information about how to customize the Fast Checkout button to meet the needs of your ofce, see “Setting 
Up Checkout Options” in Chapter 1: Introduction and Initial Setup. 

To use Fast Checkout 

1. In the Ledger, with a patient selected, if you have not already done so, post the completed procedures for 
the day for the patient. 

2. On the toolbar, click the Fast Checkout button . 

3. Depending on the setup of the Fast Checkout button, any of the following may occur: 

• Te Checkout Options dialog box appears. Select the desired options, and then click OK. 

• Te Enter Payment dialog box appears. Enter the payment information, and then click OK. 

• Dentrix Enterprise creates an insurance claim. 

• Dentrix Enterprise prints or batches a walkout statement. 
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Batch Payment Entry 

Patient Name: 

Entries: 0 Batch Total: I 0.00 

Date Check# 

Edit 

!/ EntH Paymfflt 

0pel'ator: IDSMITH Collecting Clinic: !AF 

Oate: 111/22/2017 Encounteril: I 

Amount: ! poo Check ii: I 

r Apply to Pmt Agreement Bank/Branch ii: I 

Applj.itoCharges !<Family> 

N~:\I 
·1 I I 

Apply Remaining I Remove Applied I r Do not automatically allocate 

2:J 

..:.l 

Date I Encounte ... I Code I Th I Patient I Provider I Clinic 

12/03/03 .. D2385 15 Crystal Crosby MHAYES AF 
07/29/14* 06240 6 Brent Crosby DESMITH AF 
07/l.9/14* D6240 7 Brent Crosby DESMITH AF 

1'1"7'"'Q'1'1· f¥:""tc;n ' p, .. ,,tr,,.,.i., ni:c:,~TT'-' " 

Amount Encounter Clinic 

Close 

= ~~ 
Type . 

Cash Payment· Thank You 
□ Credit Card Paymen( - Thank You (cc] 

Visa 
MasterCard 
Amel! 
Care Credit 
Capitation Payment -

Credil: Card T erminat I KT erminal ..:.]Qj 
Transaction 10: I 

. 

10~ -
Cancel I 

130.00 40.00* 10.00 0.00 900 
750.00 0.00 750 .00 0.00 750.0 
750.00 0.00 750 .00 0.00 ''°" 
"'IC:nM OM -,c;nrv, n nn 1c;n.n1 

Posting Batch Guarantor Payments 
With Dentrix Enterprise, you can quickly enter a stack of checks and payments from patients and/or 
guarantors, saving you valuable time. 

To post a batch of guarantor payments 

1. In the Ledger, from the File menu, click Enter Batch Payments. 

Te Batch Payment Entry dialog box appears. 

2. Click the Patient Name search 
button  to search for and 
select a patient. 

3. In the Enter Payment dialog 
box that appears, enter the 
payment information. For details 
about the options available for 
entering a payment, see “Posting 
Payments” in this chapter. 

1 

2 

5 

4. Click OK/Post to post the 
payment to the Ledger and return to 
the Batch Payment Entry dialog box, 
where the payment now appears. 

Repeat steps 2 – 4 for all other 
guarantor payments you want to 
enter. When you are fnished making 
payment entries, compare the number 
of entries made to the number of 
payments in hand. 

5. Click Close. 

4
3
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:Q' Batch Insurance Payment Entry - Check 

Insurance Payment 
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,., .... , ..... , an 
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I• 

111 12233 "" 1 I 
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05/28/2019 IResin-3surface+, ... l14 1',,. JI D2387 IDS MITH I 158.40 0 .0( o.oo I 40.oo I I 126.72 126.72 126.T, -8.32 0.00 - Update 

\ 
- Credit Adjustment Charge Adjustment Deductible Applied for Claim 

Adj Date: los/29/2019 .:..I Adj Date: ,-105_/29_/20_19- .:..J"" Date I O,arge PaymentTolal: 362.72 Preventative: I 0001 

I I r., __ ,.,. I Adj Amount I 0.001 
Adj Amount 0.00 ~ :=====:._--~ 

Adj Type: I +Debtt Adjustment 3 
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Adj Type: J-Professional Discount 

Note: I 12:..1 
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Cred~~: 0.1)() Standard: I 0 001 

20.00 Other: I 0 001 Chargelqs: 

~ Posted Claims: 

Hide Posted Claims I Totals : #Posted: ~ Adj Amt Posted ~ Paid Amt Posted ~ 

Date 1 I Subsaiber Name I Subscriber ID I Patient Name I Pn/Sec I Billed Ml! I Est Ins I Adj Ml! I Paid Ml! Ed1tCla1m 

» I 

I 

I 

Posting Batch Insurance Payments 
When an insurance carrier sends your ofce one check or electronic funds transfer (EFT) to cover multiple 
claims for multiple patients, with Dentrix Enterprise, you can post the large insurance check to multiple 
patients without having to switch back and forth between diferent accounts and insurance claims. 

To post a batch of insurance payments manually 

1. In the Ledger, from the File menu, click Enter Batch Ins. Payment. 

Te Batch Insurance Payment Entry dialog box appears. 

2 

10 

4 

7 

5 

3 

9 

6 

8 

1 

Note: If you need to resume or delete a batch insurance payment entry session, under Pending Claims, 
click Pending Sessions. Te Pending Sessions for Manual Batch Payments dialog box appears. Select a 
session, and then click either OK (to resume it) or Delete (to delete it). 

2. Under Batch Entry Type, select Manual. 

3. Set up the following options: 
• Pmt Type – Select Check if a check was mailed to the ofce, or select Electronic if payment was 

received through an EFT. 

• Collect. Clinic – Click the search button to select the clinic that is collecting the payment. 

• Ins Type – Select the appropriate type of insurance: Dental or Medical. 

• Amount – Enter the amount of the check or EFT. 
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• Check # – Enter the check number. 

• Bank/Branch # – Enter the bank or branch number. 

4. Under Pending Claims, click the Select Patient or Insurance Carrier Name search button , select the 
correct patient or carrier, and then click OK. 

A list of all outstanding insurance claims for that carrier or patient appears. 

5. For each claim listed under Pending Claims, perform any of the following tasks as needed: 

• To split a claim into two claims in order to post a partial insurance payment, select the desired claim, 
and then click Split Prim Claim. 

• To view a claim, edit claim information, or enter a dental or medical insurance payment, select the 
desired claim, and then click Edit Claim. 

• To enter a payment, adjustments, and other details, select the desired claim, and then follow the 
instructions as explained in steps 6–7. 

6. For the claim selected in step 5, under Enter Payment, perform any of the following tasks as needed: 

• To enter or change the credit adjustment for each procedure, select a procedure; in the Cr Adj 
column, double-click the corresponding box; type the correct amount; and then either click the 
check mark , or press Enter. Te next procedure is selected, and the next box down in 
the same column becomes active, so you can enter the adjustment for each procedure in succession. 
Repeat as needed until you have entered the adjustment for all applicable procedures. Te total 
amount of all credit adjustments for the selected claim will be posted as a single credit adjustment, 
using the date, type, and note as displayed under Credit Adjustment (which is below the procedure 
list). You can change the adjustment’s details as needed. 

• To enter or change the details of the Credit Adjustment for the claim, do the following: 

a. Either change the Cr Adj for each procedure, or click Calculate to populate the Cr Adj for each 
procedure with the Balance for each procedure. Te total of those credit adjustments appears in 
the Adj Amount box. 

b. By default, the date of the adjustment is today’s date, but you can specify a diferent date as the 
Adj Date. 

c. Select the type of adjustment from the Adj Type list. Te default selection is determined by the 
setting in the Set Automatic Credit Allocation Options dialog box. 

d. To enter a note for the adjustment, either type in the Note box directly; or click the Note search 
button , type the note, and then click OK. 

Note: Te adjustment is attached to the claim, has the claim ID associated with it, and is viewable 
from the claim window. 

• To change the amount insurance is supposed to pay for each procedure (the actual insurance portion, 
not the estimated insurance portion), select a procedure; in the Ins Amt column, double-click the 
corresponding box; type the correct amount; and then either click the check mark 
or press Enter. Te next procedure is selected, and the next box down in the same column becomes 
active, so you can enter the insurance amount for each procedure in succession. Repeat as needed 
until you have entered the insurance amount for all applicable procedures. 

• To change the amount of the payment that is to be applied to each procedure, select a procedure; in 
the Applied column, double-click the corresponding box; type the correct amount; and then either 
click the check mark , or press Enter. Te next procedure is selected, and the next box 
down in the same column becomes active, so you can enter the applied amount for each procedure in 
succession. Repeat as needed until you have entered the applied amount for all applicable procedures. 

, 
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• To enter the amount of the deductible that is to be applied to each procedure, select a procedure; in 
the Deduct column, double-click the corresponding box; type the correct amount; and then either 
click the check mark , or press Enter. Te next procedure is selected, and the next box 
down in the same column becomes active, so you can enter the applied deductible for each procedure 
in succession. Repeat as needed until you have entered the applied deductible for all applicable 
procedures. 

• To update the payment table for a procedure (only if a deductible is not being applied and if the 
maximum beneft has not been exceeded), in the Pmt Table column, select Update. Repeat as needed 
for other procedures. 

• To add a Charge Adjustment (you can have multiple per claim), do the following: 

a. By default, the date of the adjustment is today’s date, but you can specify a diferent date as the 
Adj Date. 

b. Type the amount of the adjustment in the Adj Amount box. 

c. Select the type of adjustment from the Adj Type list. 

d. To attach a provider to the adjustment, click the Provider search button  to select the correct 
provider. 

e. To enter a note for the adjustment, either type in the Note box directly; or click the Note search 
button , type the note, and then click OK. 

f. Click Add. 

Note: Te adjustments are attached to the claim, have the claim ID associated with them, and are 
viewable from the claim window. 

• To edit a Charge Adjustment, do the following: 

a. Select an item in the list (the Date and Charge for each item in the list appear for your 
reference). 

b. Click Edit to populate the details of that adjustment in the boxes to the left of the lst. 

c. Change the Adj Date, Adj Amount, Adj Type, Provider, and Note as needed. 

d. Click OK. (Te label of the Add button changes to OK when you are editing an adjustment.) 

• To delete a Charge Adjustment, do the following: 

a. Select an item in the list (the Date and Charge for each item in the list appear for your 
reference). 

b. Click Delete. Te adjustment is deleted without confrmation. 

• To modify the deductibles being applied for the claim, under Deductible Applied for Claim, change 
the values for Standard, Preventive, and/or Other as needed. 

• If you have set up automatic adjustments for the insurance plan but don’t want to post those 
adjustments, under Auto Adjs From Ins Plan Will Be Posted, select Do Not Post Auto 
Adjustments. With this check box selected, only adjustments on the EOB will be posted 
automatically as applicable, according to the setting in the Set Automatic Credit Allocation Options 
dialog box. 

• To document information regarding the insurance payment, either type in the Note box directly; or 
click the Note search button , type the note, and then click OK. 

7. Click Post Claim. 
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Hide Enter Payment I Note: I I2:..l Find Claim I Skip/Process I Post Claim I Unapplied Amount 0.00 

Date / I Description I Th I Suiface I Code I Prov I O,arge I CrAdj I 0th Ins 1 ·-1 GuarCr I ·-I ins Est I ins Amt I Applied 

I : I : , · 11•.111-1 !II 

05/28/2019 I Bacteriologic studies I I I D0415 I DSMITH I 12800 1 

05/28/2019 I Re~n-3 suiface • .... I 14 I MOD 

Procedures Undercharged or Overpaid 

Date: 05/28/2019 

Code: D02 711 

Toot~ 

Surface: 

Desc: Bitewing -single film 

Charge: U B.00 

I D2387 I DSMITH I 15840 1 

Provider: DSMITH 

Guar Credit: 40.00 

Other Ins: 0.00 

Cla im Suspende-0 Amts: 

Action I Date I Prov / Proc Code I Adj Type / Ba lance 

Action To Perform: I Add Cha rge Adj t o Cla im and Apply Rema ining 

Date: 05/28/2019 Tooth: 14 Provider: DSMITH 

Code: D2387 Surface: MOD Gua r Credit: 40.00 

Desc: Resin-3 s urface +. post-perm Other Ins: o.oo 
Charge: 158.40 Claim Suspended Amts: 

Action I Date I Prov / Proc Code I Adj Type / Ba lance 

Actio n To Perform: I Add Cha rge Adj t o Claim and Apply Rema ining 

Ill 1•11 ·1 ■11 : II : II ·!•I 

o.oo I o.oo I I 000 1 I 12s.00 I 12800 1 108.0 

0.00 1 o.oo I I 4000 1 I 126.72 1 126.72 1 126.7 

Crecl it Adj Appliecl : 10.00 Ins Pmt Appliecl : 128.00 

Appliecl (Other): 0.00 Appliecl (Other): 0.00 

Amt Overappliecl (t his Proc): 50.00 

Cr Adj Suspendecl: 0.00 Ins Pmt Suspendecl : 0.00 

I Amount I Ap ply To I Note I DEL 

Crecl it Adj Appliecl : 10.00 

Appliecl (Other): 0.00 

Ins Pmt Appliecl : 126.72 

Appliecl (Other): 0.00 

Amt Overappliecl (t his Proc): 18.32 

Cr Adj Suspended: 0.00 Ins Pmt Suspended : 0.00 

I Amount I App ly To I Note I DEL 

OK Cancel 

Balance Deduct I Pmt Table 

· 1•11 111- ... 
20.00 0 00 Ir Update 

-8.32 0 00 Ir Update 

I 

Note: If you attempt to select another claim under Pending Claims, attempt to close the Batch 
Insurance Payment Entry dialog box, or click Next Check, after having made any changes to the 
amounts (such as Cr Adj and Applied) for any procedure under Enter Payment without clicking Post 
Claim, a message appears. To post the claim with the changes before switching to the other claim, closing 
the dialog box, or clearing the dialog box for the next check, click Post the Claim and Continue; to 
discard the changes for the claim and continue, click Continue without Posting; or to keep the changes 
and return to the dialog box with the claim still selected, click Cancel. 

If the Balance for any procedure under Enter Payment has a negative amount, the Procedures 
Undercharged or Overpaid dialog box appears; otherwise skip to step 9. 

8. Do the following to resolve the undercharges/overpayments (or if you want to skip this step, click OK): 

a. For a procedure, select an option from the Action To Perform list: 

• Add Charge Adj to Claim and Apply Remaining – Tis option adds a charge adjustment to 
the claim and applies it to the remaining balance (up to the maximum allowed charge for the 
procedure). 

• Suspend Credit for Refund or Credit to Patient – Tis option adds ofsetting adjustments to 
the claim to remove the balance, and posts a suspended credit to the patient’s Ledger for a refund 
or credit. 

• Allocate to Procedure with Remaining Balance – Tis option allows you to allocate the 
remaining amount to other procedures on the claim with a remaining balance. After you click 
Process, the Select Procedure dialog box appears. Select a procedure, and then click OK. 
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• Allocate to Existing Charge Adjustment on Claim – Tis options allows you to allocate the 
remaining amount to any charge adjustments that were added to the claim previously (charges 
that appeared under Charge Adjustment in the Batch Insurance Payment Entry dialog 
box prior to opening the Procedures Undercharged or Overpaid dialog box). After you 
click Process, the Select Charge Adjustment on Claim dialog box appears. Select a charge 
adjustment, and then click OK. 

• Reduce Guarantor Credit Amt and Apply to Proc – Tis option applies the guarantor credit to 
the remaining balance without using an adjustment. 

b. Click Process to perform the selected action. 

c. If the Adj Type/Balance box is empty, to select an adjustment type, double-click the box, select an 
adjustment type, and then click OK. 

d. To change the value in the Amount box, double-click the box; type the correct amount; and then 
either click the check mark , or press Enter. 

e. To change the selection in the Apply To box, select either Ins Payment or Credit Adj from the list to 
specify where to apply the Amount: 

• If the amount is being applied to the insurance payment, it reduces the Ins Pmt Applied and 
Amt Overapplied (this Proc) amounts and increases the Applied (Other) payment amount. 
If the amount that is being applied is from a guarantor credit, it also reduces the Guar Credit 
amount. 

• If the amount is being applied to the credit adjustment, it reduces the Credit Adj Applied and 
Amt Overapplied (this Proc) amounts and increases the Applied (Other) credit amount. If the 
amount that is being applied is from a guarantor credit, it also reduces the Guar Credit amount. 

f. To view or edit the default text in the Note box, click the link, make any changes, and then click OK. 

g. Repeat steps a–f as needed until the undercharge/overpayment for that procedure is resolved 
(RESOLVED! appears to the right of the Action To Perform list). 

h. Repeat steps a–g as needed to resolve the undercharges/overpayments for other procedures. 

i. Click OK. 

If any procedures still have a negative balance when you click OK, a dialog box appears so that you 
can specify how you want to handle the undercharges/overpayments. For information about handling  
insurance overpayments, see the “Handling insurance overpayments” topic in the Dentrix Enterprise 
Help. 

9. Repeat steps 5–8 as needed to enter insurance payments for other claims from a single check or EFT. 

Notes: 

• If you attempt to close the Batch Insurance Payment Entry dialog box before you have fnished 
posting claims for the insurance payment, a message appears. To save the batch entry session so that 
you can resume it later, click Yes, type a Pending Session Name to help you identify the session later, 
and then click OK. 

• If you attempt to close the Batch Insurance Payment Entry dialog box, or click Next Check, while 
the Amount under Insurance Payment difers from the Paid Amt Posted under Posted Claims, a 
message appears. To return to the batch entry session so that you can reconcile the diference, click 
Cancel; to exit the batch entry session because you will return later to reconcile the diference, click 
Yes; or to exit the batch entry session and either complete or not complete the payment, click No. If 
you click No, on the next message that appears, select either No (if you will reconcile the payment 
later) or Yes (if you are done with the payment), and then click OK. 
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P"lncludeHistoryP~s CheckBatchEntties: i,-----CheckBc,:chTolal:~ 

Date Name Subscriber Oescri t ion InsuranceCarri er Cli nic 

01/31/2012 <Famiy>Abbott, P... CheckPayment-Th. ,. 
01/31/2012 Abbott, :woes S Abbott, Jdmes S INSUl.ANCE PAVt,ENT Aetna Dental PROVO 
01/31/2012 Abbott , :wness Abbott, Pat:ricia INSUl.ANCE PAVf/ENT Aetna Life and. PROVO 

"mJ .00 
148 .00 DR068 
100,00 DR068 

• Any claims posted as explained in steps 4–8 appear under Posted Claims. To edit the details of a 
claim, select the claim, and then click Edit Claim. 

• If you end the batch entry session before all claims for the check or EFT are posted, all payments 
posted prior to the closing of the Batch Insurance Payment Entry dialog box remain posted to the 
individual accounts. 

10. To post the payments from another check or EFT,  click Next Check. 

For information about posting batches of  insurance payments from eEOBs, see the “Posting a batch of 
insurance payments from eEOBs” topic in the Dentrix Enterprise Help. 

Searching for Payments 
In Dentrix Enterprise, you can search for payments by check or bank number, amount, payment date, 
payment type, clinic, patient, or insurance name. also, you can print a report that lists the payments found by 
the search. Use this feature when you want to search for (and print a list of ) insurance payments entered in a 
batch. 

To search for payments 

1. 

Te Search Payments dialog box appears. 

2. Set up the following search options: 

• Select Date – Select your 
date range criteria. 

• By Date Type – Select 
whether you want to search 
by the date a payment was 
entered or by the date of a 
payment. 

• Select Insurance Carrier – 
Select your insurance carrier 
criteria. 

• Check Information – Type 
the Check # and Bank/ 
Branch #. 

• Amount – Type the amount 
range by which you want to 
search in the From and To felds, or leave From <ALL> To <ALL> entered to search for any amount. 

• Select Patient – Click the search button  to select the patient whose payments you want to search 
for, or leave <ALL> selected to include all patients in the search. 

• Clinic Selection – Select whether you want to search by Collecting Clinic or Rendering Clinic. 
Ten, click the search button  to select the desired clinics, or select All to search in all clinics. 

• Select Payment Types – Select the types of payments you want to search for , or select All to include 
all payment types. 

• Include History Payments – Select this check box to include payments that are in history. 

3. Click Search to begin your search. 

Te search results appear in the list box in the bottom portion of the dialog box. 

In the Ledger, from the File menu, click Search Payments. 1 

2 3 

4 

5 
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Payment Plans 

Active 

Status Plan Name Plan Type Next Payment 

_ o x 

()1111 
Payment Amount Plan Balance 

Create Payment Plano 
Plan Name: 

Payment Plan Date 

i 12/ 15/2020 

Select Plan Type: 

@ Family Plan 
Select any Family Charges 

Individual Plan 
Select individual Patient Charges 

4. To print a copy of the search results, click Print. On the message that appears, click Yes. 

5. To view a payment in the corresponding patient’s Ledger, select that payment, and then click OK. 

Working with Payment Plans 
Payment plans are set up for a specifc patient or for multiple family members. Dentrix Enterprise allows 
multiple payment plans per account. You can set up payment plans from the Family File or Ledger. 

Tis section covers the following topics about payment plans: 

• Creating Payment Plans 

• Printing Payment Plan Documents 

Creating Payment Plans 
You can create a payment plan for clients from the Ledger. 

To create a payment plan 

1. In the Ledger, with a patient selected, on the File menu, click 
Patient Finances. 

Te Patient Finances window opens. 

1 

2 
3 

2. Select the Payment Plans tab. 

3. Click New Plan. 

Te Create Payment Plan options appear. 

4. Set up the following options: 

• Plan Name – A name to identify the plan. 

• Payment Plan Date – Te date of the plan. Te current date is displayed 
by default. You cannot select a past date. 

• Plan Type – Select one of the following options: 

• Family Plan – With this option selected, the procedures for all family 
members are available. 

• Individual Plan – With this option selected, the list of family 
members appears. Select the correct family member to view only that 
patient’s procedures. 

4 
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Interest & Fees Interval 

% 3.00 E] I Monthly ·I 
~ Date Patient Provider Description 

~ 12/ 15/2020 Dan Fisher DSMITH Resin composit ... 

~ 12/15/2020 Dan Fisher D2392 Resin composit... 

Notes 

EJ 

Payment Amount 

[q 24.55 I 
Charge Estimate 

$158.40 $111.68 

$158,40 S31.68 

Amount Financed in Plan: 

Interest Amount 

Total Plan Amount: 

Final Payment 

z 6 

Balance 

$111.68 

S31 .68 

;:;;;;;; 

+ -

Financed 

111,681 

31,68 1 

143.36 

1.25 

144.61 

21.86 

5 

7 

6 

5. Select the check box of each procedure that you want to include, or select the check box at the top of the 
list to select all the procedures at once. 

Notes: 

• Only completed procedures that have an unpaid estimated patient portion appear. 

• Procedures that are included in another payment plan do not appear. 

For each procedure, the following fnancial information appears: 

• Charge – Te amount charged. 

• Estimate – Te estimated patient portion of the Charge. 

• Balance – Te remaining patient portion. Tis may be diferent from the Estimate, such as if a 
patient payment is applied. 

• Financed – Te amount to fnance. When you select a procedure’s check box, the Balance amount is 
inserted automatically in the Financed box. 

6. Set up the following terms: 

• 1st Payment Due – Te date when the frst payment is due. Tis date must be at least one day after 
the Payment Plan Date. By default, the date is one month in the future. 

• Interest & Fees – By default the interest is 0.00. To specify a diferent interest rate and late fees, do 
the following: 

a. Click the search button . 
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Payment Plan Terms 

Annual Finance Charge Percent: .... lo_.o_o_o _____________ __, 

Late Charge 

Annual late Charge Percent: Minimum Late Charge: 

10.000 10.00 

Grace Period (days): Minimum Balance to Charge: 

3 

i!SfHH 

-
Type FC % LC% Min Bal Min LC Grace x 

Payment Agreement Type 12.000 10.000 100.00 5.00 5 days 

Te Payment Plan Terms dialog box appears. 

b. To view your pre-set payment agreement types, click Select Type. Ten, to insert the values from 
one of the types into the applicable boxes, click the name of the correct type. 

For details about setting up payment agreement types, see the “Adding and editing payment 
agreement types” in the Dentrix Enterprise Help. 

c. Change any of the following as needed: 

• Annual Finance Charge Percent – Te fnance charge percent is used to calculate the 
fnance charge amount. Dentrix Enterprise will automatically calculate the amount to assess 
based on a monthly charge (for example, if 18% was entered as the annual percentage rate, 
then 1.5% would be charged monthly). If you do not want to apply fnance charges, type 0 
in the box. 

• Annual Late Charge Percent – If payment is missed, a late charge can be assessed. Te 
late charge percent is used to calculate the amount of a late charge. Dentrix Enterprise will 
automatically calculate the amount to assess based on a monthly, semi-monthly, bi-weekly, or 
weekly charge. If you do not want to apply late charges, type 0 in the box. 

• Minimum Late Charge – Te minimum amount to assess as a late charge. 

• Grace Period (days) – Te number of days (0–30) for the grace period. A late charge will 
not be assessed if a payment is late until after the specifed number of days after the due date. 

• Minimum Balance to Charge – Te minimum balance will be compared to the plan 
balance. Only if the plan balance is greater than the minimum balance will a fnance or late 
charge be assessed. Te amount must be at least 0.01. 

d. Click OK. 

• Interval – Select the frequency of the payments: Monthly (the default), Semi-Monthly, Bi-Weekly, 
or Weekly. 



318     Chapter 7: Ledger 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

Create Payment Plan 

Payment Method 

Billing Method 

C> 
C) 

C 

C> 

Notes 

Credit or Debit Carod 

Manual Payments 

~-
lise an existing Linked Credit or Deb;t Card 

Linked Acco\,;nts 

New Linked Account 

Add a new Linked Account 

Credit Card Terminal Card Name· 

The patient has ill thonzed this Mimer t nethod to be 
Sa\•ed o file for future trans.actions 

MMFM:ffii 

4¥1:HJA MMM m 

• Payment Amount – Te amount of each payment. Te amount must be at least 5.00 and no more 
than the Total Plan Amount or 99999.99, whichever is less. By default, the Payment Amount is the 
Total Plan Amount divided by the # of Payments. If you change the Payment Amount, the # of 
Payments is updated automatically. 

• # of Payments – Te number of payments to be made. By default, the number is 6. Te maximum 
number of payments is from 24 to 104, depending on the interval; you may need to adjust the 
Payment Amount to not exceed that limit. If you change the # of Payments, the Payment Amount 
is updated automatically. 

• Notes – Any notes, up to 8,000 characters in length, regarding plan. Te Notes box is available until 
you save the plan. 

7. Click Next. 

Te Payment Method options appear. 

8 

9 

8. Under Billing Method, select Manual Payments to post payments manually in Dentrix Enterprise. 

9. Click Next. 

Te Summary appears. 

10 

Note: To print documents regarding this plan, click Print. 

10. Click Save. 

https://99999.99
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Patient Finances - (Fisher, Dan) [AF] [UTC--07:00 [MST]) [DSMITHJ [FI0007) [11/11/1980) [40) _ox 

Payment Plans 

Active 

Status Plan Name 

Restorations-Dan 
Ind ividual Plan 

111;;;.1 
Plan Type Next Payment Payment Amount Plan Balance 

01/ 14/2021 $24.55 $144.61 

Print Report I Edit Plan Terms Mhfi@::il:il 

Print for Payment Plan X 

P'" I1uth in Lending Disclosure Statement 

P' 8mortization of P a_yments and Finance Charges 

Cancel 

Printing Payment Plan Documents 
You can print payment plan documents to give to a patient or guarantor. 

To print payment plan documents 

1. On the Payment Plans tab, click a Plan Name link, and then click Print Report. 

1 

Te Print for Payment Plan dialog box appears. 

2. Select the documents that you want to give to the patient/ 
guarantor: 

• Truth in Lending Disclosure Statement – Discloses the 
terms of the agreement. It includes the annual percentage 
rate, the fnance charge amount, the total amount fnanced, 
and the total amount paid at the end of the agreement. 

2 

3 

• Amortization of Payments and Finance Charges – Prints a schedule that lists the interest accrued 
on the balance amount for each payment interval. 

3. Click either Send to Batch or Print. 

Working with Future Due Payment 
Plans 
Use future due payment plans when treatment will be completed over time and you want to charge an 
account monthly while the work is in progress, such as for orthodontics. 

Tis section covers the following topics about future due payment agreements: 

• Creating Future Due Payment Plans 

• Posting Manual Charges to Future Due Payment Plans 
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03/31/2003 Brent Crosby 
03/3112003 <Feimilv> 

Select Payment Plan 

P,ovider: Clinic: 

Create Payment Plan [AMCCLURE][MESA] 

~

'"""""'ci;,;,~ 
avider: jAMCCLURE ..::] 

inic: ]MESA ..::] 

lnitialAgreementlnformation -----------------~ 

Date of Agreement· 104/17/2013 

Total Plan Amount· I 2000.00 

DownPayCharge ~ 

Insurance Estimates:--------~ 
PatArnt· PrimlnsAmt SeclnsArnt· 

TotolPlaa~r------.oo~ 

DowaPay~r------..;-r-------.-oo 

DownPayProcCode: ~ 2.:J ~------------~ 

LonthlyChargelnformation 

argeProc.Code:~ 2.:J 
ltolCharges: r,a­

ChaigeAmounl:~ 

P AutoChaige 

lnsurMce Esttnates: 
Pat Amt 

Monthly:~ 

Auto Ins Claim Options:------------------~ 

P Auto Prill Ins Claim 

r. Monthly 

r Recu-every ~ months 

Additional Proc. Code to Include: ~ ..::] 

r Maik Claims as Dllhodontic T reatmenl 

I Benef~s Applied for Othei Treatment: 

L PrlTlarylns: ~ Secondarylns: r------.oo 

~ 

Agreement Date: 

~ 
Current Plan Status:-----~ 

Charged Remaining 

TotalAmount: ~ I 2000.00 

It Monthly Charges· fa" r,a­

Pat Est Arnt·~~ 

PrimlnsEstAmt:~ ~ 

SeclnsEstAmt:~~ 

Date Amc:u-,t 

Dow, pay, r----~ 
Last Charge r----~ 
Last Claim: r----
Print Options-------~ 

P!Prinl:F'aymentBookl 

It of Months r-,s 
Monthly Amount· 1M 
FirstPayDueDate· 104/17/2013 

Moothly J I 

1 

2 

Creating Future Due Payment Plans 
You can set up future due payment plans for individual patients. 

To create a future due payment plan 

1. In the Ledger, with a patient selected, from the Transaction 
menu, click Process Future Due Payment Plan. 

Te Select Payment Plan dialog box appears and lists any 
previously created plans. 

2. Click New Plan. 

Te Create Payment Plan dialog box appears. 

3. Set up the plan options: 

• Provider and Clinic – Dentrix Enterprise automatically 
displays the patient’s primary Provider and the current 
Clinic. To change the provider and/or clinic, click the search 
buttons , and then select the appropriate provider and/or 
clinic. 

• Note – Type details or 
clarifcation for the payment 
plan in the Note feld. 3 

• Initial Agreement 
Information 

• Date of Agreement 
– Dentrix Enterprise 
automatically inserts 
the current date as the 
date of the agreement. If 
necessary, you can change 
the date. 

• Total Plan Amount – 
Type the total amount to 
be charged over time. 

• Down Pay Charge – If 
a down payment will be 
charged, type the amount. 

4 

• Down Pay Proc Code – Type the procedure code for the down payment charge, or click the 
search button to select the code. 

• Insurance Estimates – Patient and insurance portions for the total amount and the down payment 
are displayed. 

• Monthly Charge Information 

• Charge Proc Code – Type the procedure code, or click the search button to select the 
procedure code you want to use to post the monthly charge. If there is not an ADA code for 
the type of charge you need to post, you can create one. For details about procedure codes, see 
“Editing Procedure Codes” in Chapter 1: Introduction and Initial Setup. 

• # of Charges – Type the # of Charges to have Dentrix Enterprise calculate the Charge Amount, 
or type the Charge Amount to have Dentrix Enterprise calculate the # of Charges. 
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Payment Book 

Select Form Type 

r Pre-Printed Form 

C. Plain Form 

Select Printer Type 

r. Laser Printer 

r Dot Matrix Printer 

Cancel 

• Auto Charge – To have a charge posted to the account automatically when updating future due 
payment plans each month, select this option. If this option is cleared, no charges will be posted 
to the account unless done manually. 

• Auto Ins Claim Options 

• Auto Pri Ins Claim – To have a primary insurance claim generated, select this option. Next, 
select Monthly to have insurance claims created monthly when the charges are posted; or select 
Recur every, and then select the number of months to set a schedule for the insurance billing. 
Dentrix Enterprise will generate an insurance only if the specifed number of months has elapsed 
since the last claim was generated for the future due payment plan. 

• Additional Proc. Code to Include – Type an additional procedure code, or click the search 
button  to select a procedure code to include on the claim. 

• Mark Claims as Orthodontic Treatment – If the payment plan is being used for orthodontic 
work, select this option. When Dentrix Enterprise generates the automatic insurance claim, the 
orthodontic treatment information for the insurance claim information will be completed using 
the information entered for the payment plan. 

• Benefts Applied for Other Treatment – Te patient’s used benefts for primary and secondary 
insurance before the payment plan is posted appear. Te insurance estimates for the payment plan 
will be calculated using the amounts in the Primary Ins and Secondary Ins felds. You can change 
these amounts if necessary. 

• Current Plan Status – Information for the current payment plan appears, including remaining 
balance and number of monthly charges, patient and insurance estimates, date and amount of the 
down payment, date and amount of the last charge, and date of the last claim created for the payment 
plan. You can change the values of the total amount being charged and number of monthly charges, 
last amount charged and remaining, and date of the last claim. 

• Print Options – To provide the patient with a payment or coupon book, select Print Payment 
Book. Next, type the # of Months to print, the Monthly Amount, and the First Pay Due Date. 

• Manual Charge Entry – If an amount has been entered in the Down Pay Charge feld, to post a 
down payment charge, click Down Payment. In the Down Payment Charge dialog box, if necessary, 
edit the Date, and then click Post Charge. 

4. Click OK. 

Tip: During your month-end processes, run the utility for processing the future due payment plans to 
post charges to individual accounts all at the same time as explained in “Processing Future Due Payment 
Plans” in this chapter. 

5. If you had the option to print a payment book selected, the Payment 
Book dialog box appears. Click Print or Send to Batch. 

5 
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Select Payment Plan 

Providei: Clinic: 

Paymfflt Plan (AMCCLUREl[MESA] 

Providei and Clinic----, 

Provider: IAM CCLURE _J 
_J Clinic: jMESA 

Date of Agreement: 104/17/2013 

otalPlanAmount: I 200100 

DownPay Charge: ~ 

Note 

Insurance Estimates:--------~ 
PatAmt: PrimlnsAmt: SeclnsAml: 

Tota1P1~ j84MO ~ ~ 

DowoPay ~ r-------.oo r-------.oo 
lnitial Agreement Information 

DownPayProcCode:~ .2:J ~------------~ 
Monthly Charge Information -----------------~ 

~ 
Current Plan Status·-----~ 

Charged Remain""!l 

TotalAmounl: ~ I 2000.00 

II Monthly Charges ro j18 
PatEstAmt: ~~ 

PrimlnsEstAmt~ ~ 

SeclnsEstAmt:~~ 

Date Arnot.d 

Dowo "'' r----~ 
LastChari;ie r----~ 
last Claim: r----

ChargeP,oc. Code:~ ~ P- ,i-,t-Op-tion- , ~~~~~~~~~~~~~~.: 

Ii of Charges: r,a- Monthly Charge r Print Payment Book 

Charge Amount 

Auto Ins Claim Options· 

P' Auto Prim Ins Claim 

19 Monthly 

105. 

r Rec .... every ~ m 

Dale: 04/171201 3 

Amount: I 1 05. 56 

Procedure Code: ID 8690 

Encounter Number: 

Cancel 

llofMonth ~ 
Monthly Amount ~ 
FirstP6}JDueDate 104/17/2013 

ManualChargeEntry: ~~ 
D~P,ymeot l ~ 

~ ~~ 

Posting Manual Charges to Future Due 
Payment Plans 
At times it may be necessary to manually add a payment plan charge to a patient’s Ledger. 

To post a manual future due payment plan charge 

1. In the Ledger, with a patient selected, from the Transaction menu, 
click Process Future Due Payment Plan. 

Te Select Payment Plan dialog box appears. 

2. Double-click a payment plan. Te Payment Plan dialog box 
appears. 

3. Under Manual Charge Entry, 
click Monthly. 

Te Monthly Charge dialog box 
appears. 

4. If necessary, edit the Date of the 
transaction. 

5. Click Post Charge. 

1 

2 

3 

4 

5 
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Office Manager• American Fork Dental P 

? Suspended Credits Manager 

Date Name Amount Balance Allo ca 
Clinics 

1/ 18/2018 I Abbott James -55.00 -55.00 0.00 
l1l l\11 EJ 1/ 18/2018 Crosby Brent -100.00 -100.00 0.00 

Date Range: 1/ 18/2018 Crosby Shirley -20.00 -20.00 0.00 

1/ 18/2018 Winters Carl -216.00 -216.00 0.00 
Erom: 

0 ( 1/ 18/2018 . 
Io: 

1/ 18/2018 . 
EJ 

T>;ipe: 

All . 

0 

Using the Suspended Credits 
Manager 
From the new Suspended Credits Manager window in Dentrix Enterprise, you can apply credits to charges 
without having to open each patient’s Ledger one at a time. Te Suspended Credits Manager makes it possible 
for you to manage suspended credits for all patients from a central area of Dentrix Enterprise. 

Note: You can still apply suspended credits that are associated with a specifc patient’s account from that 
patient’s Ledger without using the Suspended Credits Manager. 

To apply suspended credits 

1. In the Ofce Manager or Ledger, from the File menu, click 
Suspended Credits Manager. Or, click the Suspended Credits 

Manager button  on the toolbar. 

Te Suspended Credits Manager window opens. 

1 

2. Set up the following flters 
as needed to flter the list 
of payments that have 
suspended credits: 

• Clinics – Select the 
All check box to 
include payments for 
any collecting clinic, 
or click the search 
button to select 
the desired clinics. 
By default, only the 
clinic that you are 
currently logged in to 
is selected. 

2 

3 

4 

• Date Range – Leave 
today’s date selected 
to include only 
payments made 
today, or change the 
From and To dates to 
include payments within the specifed date range. 

• Type – Select All to include payments entered in Dentrix Enterprise. 

3. To apply the selected flters, or ensure that you have the most recent payments listed, click the Refresh 

button . 

4. Click an Amount (which appears as a link) to open the corresponding payment and apply it to charges on 
the patient’s or family’s account. 
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Guarantor Notes 

Account note he1e 

0 

O G QJ [ 

Insert Dateline 

Clear 

Billing Statement Note----------------------~ 

B illlng statement note for this account onl_y he,~ Clear 

Print on Statement until: 1 □5l17 /2013 

OK Cancel 

Working with Notes in the Ledger 
Dentrix Enterprise can store important account and transaction information. Te Ledger provides the 
following types of notes: 

• Guarantor Notes 

• Transaction Notes 

• Procedure Notes 

Guarantor Notes 
Guarantor notes are attached to an account in the Ledger but are also available in the Family File and 
Appointment Book. Tey consist of the following note types: 

• Account note – Tis will usually contain information specifc to the fnancial situation of an account. 

• Billing statement note – Tis can contain account-specifc information that prints automatically on an 
account’s billing statement. Tis note can be anything from a payment reminder to a congratulations on a 
new baby. 

Account Note 
To add an account note 

1. In the Ledger, with a patient selected, from the File menu, click 
Guarantor Notes. 

Te Guarantor Notes dialog box appears. 

2. Click Insert Dateline to insert the current 
date at the position of the text cursor to 
record when the note is being input. 

3. In the Account Note feld, type any 3 

1 

2 

relevant account notes. 

4. Click OK. 

Note: Changes made in the Guarantor Notes 
dialog box afect the Patient Finances window, 
changes made in the Patient Finances window 
afect the Guarantor Notes dialog box. 

4 
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Guarantor Notes 

Account Note------------------------~ 

Account note here Insert Dateline I 
Clear 

Billing Statement Note-----------------------, 

Billing statement note for this only herel Clear 

Print on Statement until: 105/17/2013 

OK Cancel 

s, 

Billing Statement Note 
To add or clear a billing statement note 

1. In the Ledger, with a patient selected, from the File menu, click 
Guarantor Notes. 

1 

Te Guarantor Notes dialog box appears. 

2. In the Billing Statement Note feld, type 
a statement note. Tis note will be seen 
by patients, so grammar and spelling are 
important. 

3. Many notes are only relevant for a certain 
length of time. To have Dentrix Enterprise 
clear a time-sensitive note, type a Print 
on Statement until date. After the date 
entered passes, Dentrix Enterprise will 
no longer print the note on the account’s 
statements. By default, the date is one 
month in the future. 

4. Click OK. 

Note: Changes made in the Guarantor Notes 
dialog box afect the Patient Finances window, 
changes made in the Patient Finances window afect the Guarantor Notes dialog box. 

2 

3 

4 

Transaction Notes 
Each transaction type in the Ledger includes a note feld, allowing you to add clarifcation to any type of 
entry. You can enter notes while posting a transaction or editing an existing current transaction. For details 
about entering a note when adding a transaction, see “Entering Transactions” in this chapter. 

To add a note to an existing transaction 

1. In the Ledger, with a patient selected, double-click a transaction. 

2. In the edit or delete dialog box that appears, type a Note, and then click OK. 

Procedure Notes 
With a procedure note, you can add clarifcation to a completed procedure. Ledger procedure notes are 
directly linked to the Patient Chart procedure notes and, consequently, are generally used to note clinical 
information about the procedure rather than fnancial data. For details about procedure notes, see the “Adding 
and editing ADA-CDT dental codes” topic in the Dentrix Enterprise Help. 
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03/31/2003 Brent Crosby 
03111/2003 <F;imilv'> 

Adju~... Initi 
Adiurt (re( 

Performing Month-end Routines 
Dentrix Enterprise provides several utilities that you can run on a monthly basis to keep your accounts in 
good order. 

Important: Before running any of these utilities, close all Dentrix Enterprise modules on all computers, create 
a backup of your Dentrix Enterprise database on the server, and then open the Ledger on one computer and 
enable “single-user mode” (as explained in “Changing the Database Mode” in Chapter 8: Ofce Manager) to 
help avoid data corruption. 

Tip: To view a list of users who are currently logged on to Dentrix Enterprise, in the Ofce Manager, from the 
Maintenance menu, click Database User List. 

Tis section covers the following topics about month-end processes: 

• Applying Finance Charges 

• Applying Late Charges 

• Processing Future Due Payment Plans 

• Running the Month-end Update 

Applying Finance Charges 
Finance charges are applied to accounts with and without payment agreements at the same time. If Dentrix 
Enterprise determines that a fnance charge should be assessed for an account with a payment agreement set 
up, it will refer to the payment agreement terms when assessing the charge. 

It is recommended that applying fnance charges be done on a monthly basis. While you can run the utility 
at any time during the month, it is important to run it consistently and at approximately the same time each 
month. 

For information about how to post a fnance charge to an individual account manually, see “Posting Finance 
and Late Charges” in this chapter. 

To apply fnance charges 

1. Close all Dentrix Enterprise modules on all computers before continuing. 

2. From the server, back up of your Dentrix Enterprise database. 

3. Open the Ledger on one computer. 

4. Switch to single-user mode from the Ofce Manager. 

5. In the Ledger, from the Month End menu, click Finance Charge. 

5 
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Apply Fin ance Charges 

Finance Charge Date: 

l1J411712013 

Minimum Bala nee To Charge: 

~ 
Minimum Finance Charge: 

~ 
Past Due Da_ys to Charge 
r- Over O r Over 60 

r Over 30 r 

Finance Charge---­

Percenl: r,s­
r Monthly r- Yearly 

r Apply as Adjustment Type: 

21 

Clinics: 

AF 
CENTRAL 
DRAPER 
ME SA 

P All Clinics 

□ 

Primar_y Providers: 17 All P,oviders 

AMCCLURE McClure, Angela • 
DDS1 Smith, Dennis D D 
DDS2 Brown, Mary D 
DEF _PROV DEF _PROV, DEF ~ 

(7 All Types 

1: Standard Billing , finance char • 
2: Standard Billing - no finance c l:1 
3: Insurance Famil_i,.i · dela_1,1 finan(l..:J 
4: Insurance Famil_y - finance ch: 
5: P a_yment Plan - finance chargi 
6: P a_yment Plan - no finance chi ""'" 

r Save As Delaullo 

Cancel I 

Te Apply Finance Charges dialog box appears. 

6. Set up the following options: 
6 

• Finance Charge Date – Finance charges are calculated 
according to the aged balance for each family account as 
of the fnance charge date. Te Finance Charge Date is 
also used as the transaction date for each fnance charge 
entry. 

• Minimum Balance to Charge – Te minimum balance 
will be compared to each aged account balance. Only 
those accounts with an aged balance greater than the 
minimum will have a fnance charge applied. 

• Minimum Finance Charge – Te minimum fnance 
charge will be charged to accounts when the calculated 
fnance charge is less than the amount entered. 

• Past Due Days to Charge – Finance charges will be 
calculated on the portion of each account balance that 
is past due according to the Past Due Days to Charge 
option selected and the aging of the account as of the Finance Charge Date. Te Past Due Days to 
Charge defaults to Over 0 days, assuming charges are due to be paid when they are incurred, but can 
be changed. If you do not want to charge fnance charges to current accounts, you do not use Over 0. 

8 

• Finance Charge – Te fnance charge percent will be used to calculate the fnance charge amount. 
Type the Percent to charge, and then click Monthly or Yearly. Finance charges are always calculated 
on a monthly basis, so if the Yearly option is selected, the percentage entered will be divided by 12 
months (for example, if 18% is entered as a yearly amount, Dentrix Enterprise will apply 1.5% to 
accounts each time you apply fnance charges with this utility). 

• Apply as Adjustment Type – If you want the fnance charge to be posted as a charge adjustment, 
select this option, and then click the search button to select an adjustment type. 

• Clinics – Select the clinics with patients to whom you want to apply fnance charges, or select All 
Clinics to include all clinics. 

• Primary Providers – Select the primary providers of patients to whom you want to apply fnance 
charges, or select All Providers to include all primary providers. 

• Billing Types – Select the billing types of patients to whom you want to apply fnance charges, or 
select All Types to apply fnance charges to all accounts regardless of billing type. 

Tip: If you do not want to charge fnance charges to billing types that are labeled “No Finance 
Charges,” you must clear All Types and then select only the billing types that should receive fnance 
charges. 

7. If you want to save the current settings for the next time you run this utility, select Save as Default. 

8. Click OK. On the confrmation message that appears, click OK. 

Note: A progress bar appears and displays a count as each account is processed. You can click Abort if you 
need to stop applying fnance charges, but any fnance charges that have already been calculated before 
the button was clicked will still be applied (to delete those charges, you can print the Finance Charge 
Report from DXOne Reporting as a reference for when you go to each guarantor’s Ledger that appears on 
the report to delete the charge). 

9. Turn of single-user mode from the Ofce Manager. 

7 
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Select Clinic: 

AF 

DRAPER 
MESA 
No Clinic 
PINEDALE 

Select Provider: 

AMCCLURE 
DDS1 
DDS2 
DEF PROV 
DESMITH 
DHAYES 

r All Clinics 

17 All Providers 

McClure, Angela • 
S milh, Dennis D 1=7 
Brown, Ma,y D l::J 
DEF PROV, DEF 
Smith, Dennis E 
Hayes, Deborah T" 

Select Billing Type: 17 All Types 

1 : Standard Billing · finance char .... 
2: Standard Billing - no finance cB 
3: Insurance Family · delay financ ::: 
4: Insurance Family - finance chc ~ 
5: Payment Plan · finance chargt 
6: Payment Plan · no finance chc 
7: No Statement and No Finance T" 

OK Cancel 

Applying Late Charges 
Late charges are applied to accounts with payment agreements that have failed to make a payment within the 
grace period of their payment due date. Te utility can be run on a monthly basis. 

It is recommended that applying late charges be done on a monthly basis. While you can run the utility at any 
time during the month, it is important to run it consistently and at approximately the same time each month. 

For information about how to apply late charges to an individual account manually, see “Posting Finance and 
Late Charges” in this chapter. 

To apply late charges 

1. Close all Dentrix Enterprise modules on all computers before continuing. 

2. From the server, back up of your Dentrix Enterprise database. 

3. Open the Ledger on one computer. 

4. Switch to single-user mode from the Ofce Manager. 

5. In the Ledger, from the Month End menu, click Late Charge. 

5 

Te Apply Late Charges dialog box appears. 

6. Set up the following options: 

• Charge Date – Te Charge Date is also used as the transaction date 6 
for each late charge entry. 

• Select Clinic – Select the clinics with patients to whom you want to 
apply late charges, or select All Clinics to include all clinics. 

• Primary Providers – Select the primary providers of patients of 
patients to whom you want to apply late charges, or select All 
Providers to include all primary providers. 

• Billing Types – Select the billing types of patients to whom you want 
to apply late charges, or select All Types to apply late charges to all 
accounts regardless of billing type. 

Tip: If you do not want to charge late charges to billing types that 
are labeled “No Finance Charges,” you must clear All Types and then 
select only the billing types that should receive late charges. 

7. Click OK. On the confrmation message that appears, click OK. 7 

Note: A progress bar appears and displays a count as each account is processed. You can click Abort if 
you need to stop applying late charges, but any late charges that have already been calculated before the 
button was clicked will still be applied (to delete those charges, you can print the Late Charge Report 
from DXOne Reporting as a reference for when you go to each guarantor’s Ledger that appears on the 
report and delete the charge). 

8. Turn of single-user mode from the Ofce Manager. 
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Future Due Pay 

Select Clinic: 
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Select Billing Type: P All Types 

1 : Standard Billing , finance char • 
2: Standard Billing - no finance cB 
3: Insurance Family · delay financ = 
4: Insurance Family · finance ch,: -
5: Payment Plan · finance chargi 
6: Payment Plan · no finance chc 
7: No Statement and No Finance ..,.. 

~ 

Processing Future Due Payment Plans 
You can post charges due on all accounts with a future due payment plan. Te utility should be run on a 
monthly basis. 

While you can run the utility at any time during the month, it is important to run it consistently and at 
approximately the same time each month. 

To process future due payment plans 

1. Close all Dentrix Enterprise modules on all computers before continuing. 

2. From the server, back up of your Dentrix Enterprise database. 

3. Open the Ledger on one computer. 

4. Switch to single-user mode from the Ofce Manager. 

5. In the Ledger, from the Month End menu, click Future Due Payment Plan. 

5 

Te Future Due Payment Plan Update dialog box appears. 

6. Set up the following options: 

• Charge Date – Te Charge Date is also used as the transaction date 
for each payment plan charge entry. 

• Select Clinic – Select the clinics with patients to whom you want to 
apply payment plan charges, or select All Clinics to include all clinics. 

• Primary Providers – Select the primary providers of patients to whom 
you want to apply payment plan charges, or select All Providers to 
include all primary providers. 

• Billing Types – Select the billing types of patients to whom you want 
to apply payment plan charges, or select All Types to apply payment 
plan charges to all accounts regardless of billing type. 

• Create Insurance Claims – To have Dentrix Enterprise create 
insurance claims for the payment plan charges posted, select this 
option. 

7. Click OK. 

8. Turn of single-user mode from the Ofce Manager. 7 

6 
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Close Out Month 

This process will move cuuent 
items in the ledger to 'Histor_y'. 

Cancel 

Running the Month-end Update 
Running the month-end update is a crucial management routine. It is recommended that you perform this 
update each month. Te month-end update completes many maintenance tasks important to getting accurate 
patient data quickly: 

• Aging account balances – Close each month so that account balances will not remain current on your 
aging reports. 

• Moving procedures to history – All procedures posted during the month being closed will be moved 
into history, locking out changes and deletions. Tis portion of the process is vital for providing solid 
documentation if faced with litigation. 

• Creating totals records – To speed report generation, Dentrix Enterprise creates a monthly totals record 
each time a month is closed. Without this monthly record, Dentrix Enterprise must calculate analysis 
information each time a report is generated, which can greatly slow the report generation process. 

• Resetting insurance benefts (optional) – For all patients who have dental insurance coverage that resets 
during the month being updated, the benefts used and deductible applied amounts will be reset. 

You cannot close out the current month. You must wait until the frst day of the next month before Dentrix 
Enterprise will allow you to close out that month (for example, you cannot close out the month of June until 
the frst day of July). 

To run the month-end update 

1. Close all Dentrix Enterprise modules on all computers before continuing. 

2. From the server, back up of your Dentrix Enterprise database. 

3. Open the Ledger on one computer. 

4. Switch to single-user mode from the Ofce Manager. 

5. In the Ledger, from the Month End menu, click Update. 

Te Close Out Month dialog box appears. 

Dentrix Enterprise requires that months be closed out in 
chronological order. Dentrix Enterprise will display the correct 
month to be closed out in the Close Out Month feld. You 
cannot edit this date. 

6. To have Dentrix Enterprise reset all dental insurance plans 
whose beneft renewal month is the month following the Close 
Out Month, select Reset Insurance Benefts for [month]. 

5 

8 
7 

6 

7. To speed up the month end process, select Disable Audit Triggers During Month End Proc. 

8. Click OK. 

Note: Te amount of time required to run the update depends on many factors, including the processor 
speed of your server. However, a very important factor in the speed of the utility is the amount of 
information already in history. If you wait to close out the month, leaving two to three months current at 
a time, the update has more data to process and will take more time to run. Running the update monthly 
will reduce the time required considerably, as Dentrix Enterprise has less data to sort through. 

9. Turn of single-user mode from the Ofce Manager. 
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I: Dentrix Office M anager· American Fork Dental Practice <AF <UTC -07:00 [MST]> G:)1 B ~ 
Fil e View Report, Letters Maintenance An aly, i, Hel 

l~@l~l~lwtJ~I• l• l~l~l'fola:I ~ ~ lt;i1IOlfl l~~1 ~ )I 1;.~1 I I~~ l@I lil l~~~?IEI 
Batch Pre essor £This Clinic, Full Display) 

Date D escriotion Clinic Time Zone Ooerator Status 
I I I A 

03/1612017 Continuing Care Display Lisi · Mailing Labels AF UTC -06:00 DSMITH UnPrinled 
□ 09/1812017 Prim. Denial Ins. l(DX2007) Abbott, James-Smile Saver AF UTC -06:00 DSMITH Printed 

0911912017 Prim. Denial lns.l(DX2007) Smith, Angela-Smile Saver AF UTC -06:00 DSMITH Printed 
09/1912017 Billing Statements (From: <ALL> To: <ALL>) AF UTC -0600 DSMITH UnPrinted 
09/1912017 Single Billing Statement (Abbott, Patricia ) AF UTC -06:00 DSMITH UnPrinted 
11 12712017 8 lank ADA 2012 Claim Form AF UTC -07:00 DSMITH UnPrinled 

T -- -

Chapter 8: Offce Manager 
Te Dentrix Enterprise Ofce Manager provides powerful tools to enhance the management processes of your 
practice. Tis chapter covers the following topics: 

• Te Ofce Manager Window 

• Changing Fee Schedules Automatically 

• Changing the Database Mode 

• Maintaining Employers 

• Maintaining Insurance Carriers 

• Analyzing Referrals 

• Purging Appointments 

• Purging Dental Insurance Benefts Used 

• Generating Ofce Manager Reports 

• Generating Billing Statements 

• Printing Blank ADA Claim Forms 

• Creating Letters 

• Creating a Batch of Primary Insurance Claims 

• Submitting Electronic Claims 

• Sending Statements with QuickBill 

• Signing Mulitple Clincal Notes 

• Using the Document Center Audit Documents 
Utility 

The Offce Manager Window 
Te Ofce Manager window consists of a menu bar, toolbar, and Batch Processor. 

Batch Processor 

Tis section covers the following topics to help you understand how to use the Ofce Manager window: 

• Te Ofce Manager Toolbar • Printing Reports 

• Te Batch Processor • Deleting Reports 

• Previewing Reports 
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Batch Processor [This Clinic, Full Display) 
Date Descrintion Clinic Time Zone 0nerato1 Status 
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03/1612017 Continuing Care Display List - Mailing Labels AF UTC -06:00 DSMITH UnPrinted C 0911812017 Prim. Dental lns.[[DX2007J Abbot!, James-Smile Saver AF UTC -06:00 DSMITH Prinled 
09/1912017 Prim. Dental lns.((DX2007) Smith, Angela-S mile Saver AF UTC -06:00 DSMITH Printed 
09/1912017 Billing Statements (From: <ALL> To: <ALL>) AF UTC -06:00 DSMITH UnPrinted 
09/1912017 Single Billing Statement (Abbott, Patricia) AF UTC -06:00 DSMITH UnPrinted 
1112712017 Blank ADA 2012 Claim Form AF UTC -07:00 DSMITH UnPrinted 

. 

The Offce Manager Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Ofce Manager are explained in the following table. 
Click the Electronic Billing Submission button to send billing statements and/or a batch of billing 
statements to a clearinghouse to have them mailed for you. 
Click the Electronic Claim Submission button to submit dental and/or medical insurance claims 
electronically. 
Click the Create Batch Primary Ins Claims button to generate multiple claims for procedures 
posted within a specifed date range 

Click the Print Preview button to display the report selected in the Batch Processor. 

Click the Print Report(s) button to send the reports selected in the Batch Processor to the printer 
set up for use by the Ofce Manager. 

Click the Delete Report(s) button to delete all or certain reports. 

Click the Refresh/Clear Selection button to deselect any reports that are selected in the Batch 
Processor. 

Click the Day Sheet Report button to generate a day sheet. 

Click the Operator Day Sheet Report button to send the operator day sheet to the Batch Processor. 

Click the Referral Analysis button to monitor referrals or enter gratuities. 

Click the Collections Manager button to view and manage collections information to help you as 
you contact patients regarding their accounts. 

Click the DXOne Reports button to generate and manage reports. 

The Batch Processor 
Te Batch Processor is a report management tool that allows you to print and/or preview reports generated 
and sent to the Batch Processor. 

For each report listed, the Batch Processor displays the date the report was generated, a brief description of the 
report, and a status that indicates if the report has been printed, displayed, or sent (for claims and pre-estimates). 

Tip: Since the Batch Processor can easily become crowded with reports from every clinic, you can specify the 
reports you want to have displayed in the Batch Processor and the sort order of those reports. For information 
about setting up the view of the Batch Processor, see the “Setting up the Ofce Manager view” topic in the 
Dentrix Enterprise Help. 
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Previewing Reports 
You can preview a report before printing it. You can preview one or two pages at a time, zoom out to see more 
of the page, zoom in to see more detail, and easily navigate between reports and pages of the current report. 
While you are previewing a report, the report appears in a format as close to the printed report as possible. 

To preview a report 

1. In the Ofce Manager, 
from the Batch Processor, 
select the reports you want to 
preview. 

2 

2. From the File menu, click Print 1 
Preview. Te Print Preview 
window appears. 

3 

4 

3. Do any of the following for the report you are previewing: 

• Print Report – To print the report being displayed or all reports in the preview session, from the File 
menu, click Print Report. 

• Report Title – Select a report from the list to view that report (if you are previewing multiple 
reports). 

• View One Page / Two Page – To switch between viewing one or two pages (displayed side by side), 
from the Options menu, click View One Page or View Two Pages. 

• Zoom – To increase or decrease the zoom percentage (from 10% to 200%), from the Options menu, 
point to Zoom, and then click the appropriate percentage. 

• Previous / Next Page – To advance to the next page in a multi-page report, click the right arrow 
button. To go to a previous page of a multi-page report, click the left arrow button. 

4. To close the Print Preview window, from the File menu, click Exit. 
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Time Zone 0 erator Status 

DSMITH UrPrinted 8: DSMITH Pr'rled 

DSMITH UrPrinted 

DSMITH UrPrinted 

Time Zone 0 erator Status 

03/16/2017 Continuing Care Display l ist - Mailing labels DSMITH UrPrinted r:: 
09/19/2017 Pfim. Dental Ins. ((DX2007) Smith, Angela-S mi DSMITH Pr'rled 

09/19/2017 SingleBillingStatement(Abbott,Pa:tricia) DSMITH UrPrinted 
11/27/2017 Blank ADA 2012 Claim Form DSMITH UrPrinted 

Delete Options 

Printing Reports 
If you do not want to preview a report, you can send it directly to the Ofce Manager printer. 

Tip : To print certain pages of a report or to print more than one copy of a report, you must print that report 
from the Print Preview window so that you can enter the page range and the number of copies. 

To print a report from the Batch Processor 

1. In the Ofce Manager, 
from the Batch Processor, 
select the reports that you 
want to print. 

Tips: 

• To select multiple reports, 
while pressing the Ctrl key, 
click each report. 

1 

2 

• To deselect a report in the 
Batch Processor, from the 
File menu, click Clear; or select a diferent report. 

2. With reports selected, from the File menu, click Print. Dentrix Enterprise sends the report to the printer 
set up for the Ofce Manager. 

Deleting Reports 
You can delete any report from the Batch Processor that is not being previewed. 

Note: Do not try to delete a report that is currently being previewed. A report being previewed may have 
“Displayed” or “Schd” (followed by a number) in the Status column. 

To delete a report from the Batch Processor 

1. In the Ofce Manager, 
from the Batch Processor, 
select the reports that you 
want to delete. 

2 

2. From the File menu, click 
Delete. 

1 

Te Delete Options dialog box 
appears. 

3. Select one of the following 
options: 

• Selected Reports – To delete the reports selected in the Batch Processor 

• Printed Reports – To delete all printed and displayed reports listed in the 
Batch Processor 

• Sent Reports – To delete all sent claims listed in the Batch Processor (used 
with electronic claims) 

• All Reports – To delete all reports listed in the Batch Processor 

4. Click OK. 

4 

3 
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Fee Schedule Maintenance 

Show Clinic: jAII 

Ejnd Fee Schedule: 
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\[lew/Edit. . 

Automatic Fee Schedule Changes (UCR) 

2:...1 To l<ALL> 

Batch Proc 

~s 

I Increase by % ..:.J 

Round To: I Penny ..:.l 
Minimum Amount To Increase: ~ S 

~ Ca=I 

Changing Fee Schedules Automatically 
When you are logged in to the Central clinic, you can make changes to an entire fee schedule, or specifc 
segments of a fee schedule, without having to manually enter each amount for a procedure. 

To make automatic fee schedule changes 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Fee Schedule Maintenance. (Tis 
option is available only if you are logged in to the Central clinic.) 

Te Fee Schedule Maintenance dialog box appears. 

1 

2. Select the fee schedule that you want to update. 

3. Click Auto Changes. 

Te Automatic Fee Schedule Changes dialog box appears. 

4. To select the procedure code range for which you want to 
change the fee schedule, under Select Procedure  Code, 
click the From and To search buttons to select the frst 
and last procedure code in the desired range. Or, leave From 
<ALL> To <ALL> selected to include all procedures. 

5. To specify a condition that a procedure’s fee must meet for that 
procedure to get updated, under Where, select the Current 
Amount check box. Select greater than (>), greater than or 
equal to (>=), less than (<), less than or equal to (<=), or equals 
(=). Type the amount ($). 

6. Under Change Fee Schedule, set up the following options: 

• Change Amount – Type how much you want to increase 
or decrease the fee by (depending on the Change Type 
selection, this is a dollar amount ($) or a percentage (%). 

• Change Type – Select how you want to increase or decrease 
the fees: Increase by %, Increase by $, Decrease by %, or 
Decrease by $. 

2 

5 

4 

7 

6 

• Round To – Select whether you want to round the new fees 
to the nearest Dollar, Dime, or Penny (the default selection is controlled by a Central clinic setting). 

• Minimum Amount To Increase – Type the minimum amount required for a fee in the fee schedule 
to be changed. 

7. Click OK. 

Once Dentrix Enterprise has processed the changes, it will display the entire fee schedule for you to 
review in the Fee Schedule Change Results dialog box. 

3 
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Fee Schedule Change Results ~ 

lucR Fee Schedule t!ame: I Find Erocedure Code: I 

Procedure I Fee i/1 Fee #1 
I Difference ~ 

Clear • I 
Code UCR UCR 

BEFORE AFTER 

D5281 47500 484.50 9.50 Ccpy E.rom ► I 
D5410 3500 35.70 0.70 

Ccpy Io I D5411 3500 35.70 0.70 I 

D5421 3500 35.70 0.70 [mport . I 
D5422 3500 35.70 0.70 

I _. g.port . 
D5510 11 5 00 117.30 2.30 

D5520 9000 91 .80 1.80 Cli pQ<>ard • I 
D5610 7500 76.50 1.50 

D5620 100.00 102.00 2.00 

D5630 10000 102.00 200 

D5640 7500 76.50 1.50 

D5650 9000 -9.1 .80 1.80 • 

( ) ~ ve I Close I 
.I -

8. Do any of the following: 

• To change a procedure code’s amount (as 
displayed in the BEFORE column), click 
that procedure code’s fee in the AFTER 
column, and then type the new amount. 
Te background color of the AFTER cell 
changes to yellow, and the Diference 
between the original and the new fee 
appears with a green background (for 
an increase) or a red background (for a 
decrease). Repeat this process as needed to 
change other amounts. 

8 

Tip: To help you quickly fnd a procedure 
code, begin typing a procedure code in 
the Find Procedure Code feld. Te frst 
matching code is selected. 9 

• To replace all the amounts in this fee 
schedule with those from another fee schedule, click Copy From, and then search for and select the 
desired fee schedule. 

• To replace amounts in this fee schedule with those from a .csv, .xls, or .xlsx fle, click Import, and 
then search for and select the desired fle. 

• To change all amounts to zeros, click Clear, click Clear only the fee amounts, and then click Yes. 

• To change all amounts to zeros and clear the Fee Schedule Name feld, click Clear, click Clear only 
the fee amounts, and then click Yes. 

• To copy the data (procedure codes, before amounts, after amounts, and diferences) as text to the 
Windows Clipboard, click Clipboard, and then click Copy to Clipboard - tab delimited or Copy 
to Clipboard - comma delimited. You can paste the Clipboard contents into another program. 

Tip: You can use the contents of a copied fee schedule comparison to create a .csv, .xls, or .xlsx fle 
that you can import into Dentrix Enterprise to create a new fee schedule. 

• To export the data (procedure codes, before amounts, after amounts, and diferences) as text to a 
comma-delimited or tab-delimited fle, click Export to specify a name, a fle type (.csv or .txt), and a 
location for the .csv or .txt fle. 

Tip: You can use the contents of an exported fee schedule comparison to create a .csv, .xls, or .xlsx fle 
that you can import into Dentrix Enterprise to create a new fee schedule. 

9. Click Save. 
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Employer Maintenance 
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Changing the Database Mode 
You can turn on single-user mode for operations that require that Dentrix Enterprise be closed on all but one 
computer. After those operations have been completed, you must turn of single-user mode. 

To turn on singe-user mode 

In the Ofce Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and 
then click Enable Single User Mode. On the confrmation message that appears, click Yes. 

To turn of single-user mode 

In the Ofce Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and 
then click Disable Single User Mode. On the confrmation message that appears, click Yes. 

Maintaining Employers 
With the Employer Maintenance utility, you can add, edit, and delete employers without selecting a patient. 
Additionally, you can join and purge duplicate employers. For information about adding and editing 
employers from the Ofce Manager, see the “Adding and editing employers” topic in the Dentrix Enterprise 
Help. 

Tis section covers the following topics about employers: 

• Joining Employers 

• Purging Employers 

Joining Employers 
You can combine duplicate employers. 

Tip: You do not need to enable single-user mode when running this utility, but run it outside of peak ofce times. 

To join employers 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Employer Maintenance. 

Te Employer Maintenance dialog box appears. 

2. Click Join Employers. 

Te Join Employers dialog box appears. 

3. Click the Source Employer search button to select 
the employer that you want to merge into another. 

4. Click the Destination Employer search button to 
select the employer that you want the source employer 
to be changed to. 

5. Click Join. On the confrmation message that appears, 
click Yes. Ten, another message appears and states that 

1 

3 

4 

5
the employers have been joined, so click OK. 

Te source employer is now the destination employer. 
All patients with the source employer now have the 
destination employer attached to their records in the Family File. 
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Purging Employers 
You can purge employers from Dentrix Enterprise that are no longer attached to any patients. 

To purge an employer 

1 

2

4 
3 

OR 

3 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Employer Maintenance. 

Te Employer Maintenance dialog box appears. 

2. Click Purge. Te Purge Employers dialog box appears and 
lists all employers that are not attached to any patients. 

Tip: If an employer you want to delete is not listed, the 
employer is attached to at least one patient. You must clear 
that employer from those patients in the Family File before it 
can be deleted. To fnd patients with a certain employer, print 
the Employers and Employed Patients Report for that 
employer from the DXOne Reporting module. For 
information about this report, see “Reference Reports” 
in Chapter 9: DXOne Reporting. 

3. To delete all employers listed, click Delete All; or, to 
delete a certain employer, select that employer, and 
then click Delete. 

4. Click Close. 

Maintaining Insurance Carriers 
With the Insurance Maintenance utility, you can add, edit, and delete insurance plans without selecting a 
patient. Additionally, you can join and purge duplicate insurance plans. For information about adding and 
editing insurance plans from the Ofce Manager, see the “Adding and editing insurance plans” topic in the 
Dentrix Enterprise Help. 

Tis section covers the following topics about insurance: 

• Joining Insurance Plans 

• Purging Insurance Plans 
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Joining Insurance Plans 
You can combine duplicate insurance plans without moving subscribers one by one to another plan. Joining 
plans does not delete the old, unused insurance plan; it only moves the subscribers to a new plan so that the 
old plan can be purged. 

Tip: It is not necessary to be in single-user mode when joining insurance plans, but do not use this utility 
during peak ofce times. 

To join insurance plans 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Insurance Maintenance. 

Te Insurance Maintenance dialog box appears. 

2. Click Join Plans. 

Te Join Insurance Plans dialog box appears. 

3. Select one of the following join criteria: 

• Employer-based – To move all subscribers 
attached to one particular insurance plan linked 
to a specifc employer to another insurance 
plan that is linked to the same employer. Ten, 
select the Subscriber’s Employer must match 
Insurance Plan Employer Field check box 
if you want to move only subscribers who are 
assigned the same employer in the Family File. 

• Plan-to-Plan – To join insurance plans regardless of 
employers. 

3 

4. Click the Source Insurance Plan search button to 
select the plan you want to join with another. 

5. Click the Destination Insurance Plan search button 
to select the plan you want the Source Insurance Plan to 
be transferred to. 

4 

5 

6. Click Join. On the confrmation message that appears, 
click OK. Ten, another message appears and states that 
the plans have been joined, so click OK. 

Te source plan is now the destination plan. All patients 
with the source plan now have the destination plan 
attached to their records in the Family File. 

1 

6 
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Purging Insurance Plans 
You can purge insurance plans from Dentrix Enterprise that are not attached to any outstanding insurance 
claims. 

To purge an insurance plan 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Insurance Maintenance. 

1 

Te Insurance Maintenance dialog box appears. 

2. Click Purge. 

Te Purge Insurance dialog box appears. 

Tip: If an insurance plan you want to delete is 
not listed, the plan is attached to at least one 
outstanding claim. Tose claims must be paid before 
the plan can be deleted. To fnd outstanding claims 
for a certain carrier, print the Insurance Claim Aging 
Report for that carrier from the DXOne Reporting 
module. For information about this report, see 
“Ledger Reports” in Chapter 9: DXOne Reporting. 

3. To delete all insurance plans listed, click Delete 
All; or, to delete a certain plan, select that plan, and 
then click Delete. On the confrmation message that 
appears, click OK. 

4. Click Close. 

Analyzing Referrals 
You can use the Dentrix Enterprise analysis tool to view referral production and manage gratuities. 

To analyze the production of a referral source 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Referral Maintenance. 

Te Referral Maintenance dialog box appears. 

2. Select the referral you want to analyze. 

3. Click Analysis. 

Te Referral Analysis dialog box appears. Te dialog box 
lists the number of Total Referrals Made to/by this referral 
source. 

2 

4 
3 

OR 

3 

1 

3 
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4. Set up the following options: 

• Referral Date Span – From the list, select a date span. 
All patients who have been referred to/by the referral 
source within the date span appear in the list box. 

4 

• Production Date Span – For referral sources only, 
from the list, select a date span. Te production for 
the specifed date span of each referral appears in the 
Production column of the list box. Also, the total 
production generated by the listed referrals for the 
production date span appears in the Production feld. 

5. To enter a gratuity given to a referral source, click New 
Gratuity. In the New Gratuity dialog box, type the date 
the gratuity was given and the amount of the gratuity, 
select the type of gratuity sent, and then click OK. 

Tips: 

5 6 

8 

• To add a new gratuity type in the New Gratuity 
dialog box, from the Type list, select “<Add Gratuity 
Type>,” type a new type and amount, and then click Add. 

• To record the gratuity in each referred patient’s Ofce Journal, in the New Gratuity dialog box, select 
Add Journal, and then click the Provider search button  to select the provider for whom you also 
want to record the Ofce Journal entries. 

6. To view an analysis of the gratuities given to a referral, click Gratuity Analysis. 

Te Gratuity Analysis dialog box appears. Tis dialog box 
lists all gratuities and the total value of each. 

7. Click Close to return to the Referral Analysis dialog box. 

8. Click OK. 

7 
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• Insurance Plans with Renewal Month of: I April ..:.1 
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Cancel 

Purging Appointments 
If you are logged in to the Central clinic, you can purge appointments in the Appointment Book before a 
certain date for all clinics. 

Tip: You can purge appointments for only the clinic you are logged in to from the Appointment Book. 

To purge appointments 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Purge Appointment. 

Te Delete Appointments for All Clinics dialog box appears. 

2. Type a Cut of date. All appointments in all clinics prior the date 
entered will be purged. 

3. Click OK. On the confrmation message that appears, click OK. 

1 

2 

3 

Purging Dental Insurance Benefts 
Used 
With the Purge Insurance Benefts Used utility, you can selectively zero out insurance coverage benefts used. 
Purging used benefts will clear all of the current year’s benefts for the insurance plans that have the previous 
year’s benefts cleared. 

To purge used insurance benefts 

1. In the Ofce Manager, from the Maintenance menu, point to 
Reference, and then click Purge Dental Ins Benefts Used. 

Te Purge Dental Insurance Benefts Used dialog box appears. 

2. Select one of the following options: 

• Insurance Plans with Renewal Month of  – 

1 

To clear used benefts (reset them to $0) for 
insurance plans with benefts that renew on 
a specifc month, select this option, and then 
select the appropriate month from the list. 

• Selected Insurance Plan – To clear used 
benefts from a specifc insurance plan, select 
this option, and then click the search button  to select the appropriate insurance plan. 

3 

2 

3. Click OK. 

Tip: During the month-end update, Dentrix Enterprise will automatically purge benefts used for those 
insurance companies that renew their benefts the next calendar month. 
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Generating Offce Manager Reports 
Dentrix Enterprise provides many reports that you can use to gather information from your database. While 
some reports can be printed from the Ledger, the Patient Chart, the Appointment Book, the Family File, or 
DXOne Reporting, the Ofce Manager has the following categories of reports you can generate: 

• Reference reports 

• Management reports 

• Billing statements 

• Ledger reports 

• List reports 

• Blank ADA claim forms 

All reports you generate from the Ofce Manager will appear in the Batch Processor. 

For a comprehensive explanation of all the options for running these reports, see the “Generating Ofce 
Manager reports” topic and its subtopics in the Dentrix Enterprise Help. Also, to see samples of and read an 
explanation of what appears on each report, refer to the Dentrix Enterprise 11.0.2 Reports Reference. 

Reference Reports 
In the Ofce Manager, from the Reports menu, point to Reference, and then click a reference report option: 

• Procedure Code List – Te Procedure Code List is a list of procedure codes, including the procedure 
code number, description, abbreviated procedure codes, time allotted for each procedure, appointment 
type, paint type, and treatment area. 

• Dental Diagnostic Code List – Te Dental Diagnostic Code List is a list of all dental diagnostic codes 
that have been entered. 

• Medical Code List – Te Medical Code List is a list of all medical procedure codes entered. Codes are 
grouped by code type (AMA, ICD, modifer, place of service, and type of service). 

• Multi Code List – Te Multi-Code List is a list of all multi-codes or a range of multi-codes. 

• Standard Coverage Table Report – Te Standard Coverage Tables Report lists the coverage tables that 
are set up in the Ofce Manager. Te report includes the coverage percentage, co-payment, and pre-
authorization fag for each range of procedures. 

• Insurance Coverage Tables Report – Te Insurance Coverage Tables Report lists the coverage tables that 
have been set up for each selected insurance plan. 

• Updated Dental Insurance Payment Tables Report – Te Updated Dental Insurance Payment Tables 
Report lists all procedures and the covered dollar amount for procedures listed in the payment table for 
the selected dental insurance carriers. 

• Custom Practice Information Report – Te Custom Practice Information Report lists information that 
can be customized in Practice Defnitions: billing types, payment types, adjustment types, custom notes, 
medical alerts, appointment status types, and appointment check list. 

• Registration Information Report – Te Registration Information Report lists the practice information 
and serial number of your Dentrix Enterprise software. 
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Management Reports 
In the Ofce Manager, from the Reports menu, point to Management, and then click a management report 
option: 

• Day sheet (charges and receipts) – Te day sheet is a report designed to help you keep track of your 
daily production and collection fgures. It lists all transactions posted during the day (or date range 
specifed) including procedures, payments, adjustments, and fnance charges. Te day sheet can be 
customized to include or exclude specifed information, and can be printed in a variety of formats. 

Ledger Reports 
In the Ofce Manager, from the Reports menu, point to Ledger, and then click a ledger report option: 

• Family Ledger Report – Te Family Ledger report includes all transactions for all patients in the family 
posted since the beginning date specifed. Te date of treatment, tooth number, description, patient, 
charges, payments and a running balance are included on the report. Depending on report settings, the 
current balance of each patient in the family is also displayed on the report. 

• Patient’s Ledger Report – Te Patient’s Ledger report includes all transactions for a patient(s) posted 
since the beginning date specifed. Te date of treatment, tooth number, description, patient, charges, 
payments, and a running balance are also included on the report. 

• Payment Agreement Report – Te Payment Agreement Report displays analysis and management 
information for monitoring payment agreements. Te report includes information on the agreement 
terms, the remaining balance for the payment agreement, and missed payments, and the last payment 
date and amount. 

• Future Due Payment Plan Report – Te Future Due Payment Plan Report displays payments that can 
be expected based on established payment plans by month. You can also run the Monthly Totals Report. 

• Referral Recap Report – Te Referral Recap Report lists completed and treatment-planned work for 
each referral source that appears on the report. Each referred patient will appear on a separate page. 

List Reports 
In the Ofce Manager, from the Reports menu, point to Lists, and then click a list reports option: 

• Daily Appointment List – Te Daily Appointment List consists of three separate reports: 

• Operatory Appointment List – Tis report lists all appointments for a selected range of dates and 
by the selected providers and operatory ranges. Te list includes the appointment date, status, time, 
patient name, provider and operatory, appointment reason, and appointment duration. 

• Patient Route Slips – Patient route slips can be printed for all patients scheduled within the date 
range. Te route slip provides comprehensive account and treatment information for the scheduled 
patient. 

• Daily Appointment List – Tis report gives the same information as the Operatory List, but in a 
diferent format, and includes the patient phone numbers. 

• Unscheduled Appointment List – Te Unscheduled Appointment List displays patient appointments 
that have been broken (and not rescheduled) or placed on the wait/will call list during a specifed time 
period. Tis list can aid your ofce in rescheduling those appointments. 

• Unscheduled Treatment Plans Report – Te Unscheduled Treatment Plans Report displays patients for 
whom there has not been an appointment scheduled for their treatment-planned procedures. 
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• Treatment Plan Approval Report – Te Treatment Plan Approval Report lists pre-treatment estimate 
insurance claims that have been received and accepted. Te treatment plan, estimate amount, and 
whether the pre-treatment was accepted or rejected are also included on the report. 

• Treatment Plan Approval Status Report – Te Treatment Plan Approval Status Report lists treatment-
planned procedures for selected approval statuses, along with relevant patient and procedure information. 

• Insurance Eligibility Report – Te Insurance Eligibility Report lists insurance carriers and the patients 
eligible for coverage under each carrier and includes information such as the patient’s eligibility date, 
subscriber’s name and ID, insurance carrier’s address, group plan number, and patient’s next appointment. 

• Perio Exam List – Te Perio Exam Lists is a list of patients who have had a periodontal exam created 
within a specifed date range. 

• New Patient List – Te New Patient List is a list of all patients in the practice whose frst visit dates fall 
within a specifed date range. You can also print mailing and chart labels for this list of patients. Te list 
includes each patient’s name, address and frst visit date. 

• Patient Notes Report – Te Patient Notes Report displays any notes you have entered for a patient. You 
can indicate which patients to print based on name, provider, or billing type, and you can select which 
types of notes to include. 
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21 

21 

Billing Statements 

From: j<ALL> 2:J 
To: j<ALL> 2:J 

Run Report---------, 
r. ... by Provider 

From: l<ALL> 2:J To: l<ALL> 2:J 
r ... byClinic 

!CENTRAL 2:Jr All 

Select Billing T_ype:------~ 

l <ALL> 2:J 17 All 

Minimum Balance To Bill:ro,-­

r Include Credit Balances? 

Statement Message: 

Insurance Estimates ('Ins. Est.') and 
'Please Pa.Y' amounts based on 0 
insurance estimates are provided as a 
courtesy. In the event that your 

r ~:~~~~it: clinic settings for all 

17 Use same Statement Message for all 

21 

Balance Forward Date:102/27 /2019 

Options-----------~ 

P Skip Accounts With Claim Pending 

... 11 Patient Portion Less Than: [20:oo 
Procedures With Claims Pending ... 

Show: r- Current r All r None 

r Print Insurance Estimate 
P Print Agreed Payment 

P' Exclude Outstanding To Insurance 
r Print Practice lnfo1mation 
r Print Account Aging 

r Allow Credit Card Payment 
17 11 Nol Billed Since: '"I 0-2-/2 __ 7_/2-0-19-

17 Only Bill Accounts Aging: 

r- Over 30 r Over 60 r Over 90 

Select Report T,Ypes-------~ 

17 Billing Statement 

r Mailing Labels . Columns: l3 j:j 

r Save As Default 

Generating Billing Statements 
Billing statements provide guarantors with a record of their fnancial transactions with the practice. 

Printer-generated billing statements can save you the cost of pre-printed forms without losing the professional 
look of pre-printed forms. However, if you intend to use pre-printed forms, be sure to purchase forms that are 
supported by Dentrix Enterprise. 

For information about where to specify the billing statement form that you want to use, see “Setting Up 
Practice Defaults” in Chapter 1: Introduction and Initial Setup. Also, for information about how to set up 
billing statements to include the central ofce, clinic, or provider information, see “Setting Up Clinics” in 
Chapter 1: Introduction and Initial Setup. 

To generate billing statements 

1. In the Ofce Manager, from the Reports menu, click Billing. 

Te Billing Statements dialog box appears. 

2. Set up the following options: 

1 

2 

• Statement Date – Type a cutof date. 
Te statements will include procedures 
up to and including the date entered, and 
all statement calculations will be as of 
that date. 

• Balance Forward Date – Type a balance 
forward date. Dentrix Enterprise will 
calculate the total of all outstanding 
procedures posted up to the date entered 
and give the total balance forward 
amount on the statements rather than an 
itemization of procedures. 

• Select Guarantor – Click the search 
buttons to select the range of 
guarantors for whom you want to generate 
statements, or leave From <ALL> To 
<ALL> selected to include all guarantors. 3 

• Run Report – Select how you want to generate statements: 

• By Provider – To generate statements by provider, select this option, and then click the search 
buttons  to select a range of providers to generate statements for those providers’ patients; or 
leave From <ALL> To <ALL> selected to include patients for all providers. 

• By Clinic – To generate statements by clinic, select this option, and then click the search  
button  to select the clinics that have the patients for whom you want to generate statements. 
Or, select the All check box to include patients in all clinics. 

• Select Billing Type – Click the search button  to select the billing types of patients for whom you 
want to generate statements. Or, select the All check box to include patients with any billing type. 

• Minimum Balance to Bill – Dentrix Enterprise will generate statements for patients who have a 
balance equal to or greater than the amount entered. For example, if you enter 20, Dentrix Enterprise 
will generate statements for patients who have a balance of at least $20. 

• Include Credit Balances? –To generate statements for patients who have a credit balance, select this 
option. 
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• Statement Message – Type a message (such as “All payments are due on or before the 5th day of the 
month.”) that you want to have appear at the bottom of each statement. Tis box is available only if 
the Use same Statement Message for all check box is selected; in which case, this message will be the 
default message either on statements generated from this computer or on statements generated for all 
clinics from any computer (depending on whether the Use log-on clinic settings for all statements 
check box is clear or selected). 

Tip: For information about entering a customized billing statement note for any individual 
guarantor, see “Billing Statement Notes” in Chapter 7: Ledger. 

• Use same Statement Message for all – To use the same message on statements sent to patients of any 
clinic, select this check box. To use the custom message specifed for a given clinic on statements that 
are sent to patients of that clinic. If the clinic does not have a custom message specifed, no message 
will appear on the statements that are sent to patients of that clinic. 

• Options – Select the options you want to use to determine which accounts will receive a bill and 
what to include on the statements: 

• Skip Accounts with Claim Pending – To skip an account if the patient has any outstanding 
claims for which the guarantor portion of the balance is less than the dollar amount you specify 
in the If Patient Portion Less Tan feld. 

• Procedures With Claims Pending 
• Current – To include procedures posted in the current month for which a claim has been 

created and is still pending (not received). 
• All – To include all procedures posted for which a claim has been created and is still pending 

(not received). 
• None – To exclude all procedures for which there is still a claim pending. 

• Print Insurance Estimate – To include the estimated amount that dental insurance will pay on 
pending claims. 

• Print Agreed Payment – To have a box labeled “Please Pay Tis Amount,” which refects the 
patient portion of the balance or the payment amount required for a payment agreement set up 
previously, appear on statements. 

To have the “Please Pay” amount exclude the entire amount that has been billed to insurance on a 
pending claim, even if some of it is a patient portion, select Exclude Outstanding to Insurance. 

• Print Practice Information – If your default billing statement is not the Full Form/Download 
Form, and if you are using a pre-printed form without your practice information already printed 
on it, select this option. 

• Print Account Aging – If your default billing statement is the Full Form/Download Form, to 
include an aging summary on the statements that are formatted to allow report aging, select this 
option. 

• Allow Credit Card Payment – If your default billing statement is the Full Form/Download 
Form, to include credit card payment options on the statement, select this option. 

• If Not Billed Since – To skip patients for whom a billing statement has already been printed 
since the date you specify. (Te last statement date appears in each account’s Ledger.) 

Tip: Tis option works well for practices that print billing statements from the Ledger when 
an insurance payment is received for an account. You can use cyclical billing as statements are 
printed for individual accounts throughout the month and then printed from the Ofce Manager 
in a batch to ensure that each account has received a statement for the month. 

• Only Bill Accounts Aging – To generate statements for patients whose balance has aged at least 
as much as the aging bracket you select: Over 30, Over 60, or Over 90. 
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Dentrix Report, 

Send Blank ADA Form to Batch Processor? 

1 995 Claim Form 

r 2000 Claim Form 

r 2003 Claim Form 

r 2007 Claim Form 

r♦ 2012 Claim Form ----r Save As Default Claim Form 

~ No 

• Select Report Types – Select the desired report types: 

• Billing Statement – To print statements for all guarantors who fall within the specifed parameters. 

• Mailing Labels – To print mailing labels with the guarantor’s name and address. Be sure to enter 
the number of Columns of labels your label sheets have on them. 

• Use log-on clinic settings for all statements – To apply the current settings specifed for this clinic 
to all clinics, select this check box. Use this option if you want everyone to have the same default 
statement settings for all clinics while logged on to any computer. You must click OK with the Save 
As Default check box selected to update the default settings for all clinics. 

• Save As Default – To save the current settings for the next time you generate statements from this 
computer (or from any computer if the Use log-on clinic settings for all statements check box is 
selected). 

3. Click OK to send the billing statements to the Batch Processor. 

Printing Blank ADA Claim Forms 
Tere may be a circumstance when you need to print a blank ADA claim form. 

To generate a blank ADA claim form 

1.  In the Ofce Manager, from the Reports menu, click Blank 
ADA Form. 1 

Te Dentrix Reports dialog box appears. 

2. Select the claim form that you want to print. 

3. Click Yes. 

2 

3 
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03/16/2017 Cootinuino Care Dimlay List - Mailino label~ 

Letters ~ 

Birthday ... 

Continuing Care ... 

Refenal... 

Collection ... 

Inactive Patient. .. 

Welcome ... 

Misc ... 

EXIT 

Creating Letters 
With Dentrix Enterprise, you can create custom reports and letters as Microsoft Word documents or as data 
fles for use in spreadsheet programs, such as Microsoft Excel. 

Dentrix Enterprise provides an interface between your patient database and Microsoft Word (if installed) that 
allows you to create any letters that are applicable to the success and development of your practice. You can 
have Dentrix Enterprise merge information from patient records into your letters, based on various ranges, 
parameters, and flters that you establish. 

Dentrix Enterprise comes complete with pre-defned letter templates in seven categories that you can use and 
modify in conjunction with your patient database. For information about how to customize any letter from 
Microsoft Word, see the “Customizing Dentrix Enterprise letters” topic in the Dentrix Enterprise Help. For 
information about how to create your own letters and add them to any of the categories for future use, see the 
“Creating custom letters” and “Adding letters to categories” topics in the Dentrix Enterprise Help. 

Tis section covers the following topics about letter merges: 

• Merging Dentrix Enterprise Letters 

• Creating Appointment Reminder Cards 

• Creating Cards for Patients Without Appointments 

Merging Dentrix Enterprise Letters 
You can create letters by merging information from Dentrix Enterprise into Microsoft Word documents. Tis 
section covers the pre-defned templates installed with Dentrix Enterprise. 

To merge a Dentrix Enterprise letter 

1. Open and minimize Microsoft Word. 1 

2. In the Ofce Manager, click Letters on the menu bar. 

Te Letters window appears. 

3. Click the category button of the letter type you want to create: 

• Birthday – Birthday letters for patients with a birth date in a 
specifed range. 

• Continuing Care – Continuing care (recall or recare) notices to patients 
within a recall date range. 

• Referral – Referral letters for anyone who has referred or to whom you are 
referring patients within a specifed range of frst visit dates or referral dates. 

• Collection – Collection notices for patients within a specifed range of last 
payment dates. 

• Inactive Patient – Notices for patients within a specifed range of last visit 
dates. 

• Welcome – “Welcome to the Practice” letters for patients within a specifed range of frst visit dates. 

• Misc – Custom letters for specifc patients in your database. You will probably put many of the 
custom letters you create in this category. 

2 

3 
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Referral Letters < CENTRAL> 

Select Leiter 

Crea /Merge I __ V_ie_w_L_i,_I __, 

I I 

dlxlm49. doc 
dlxlm 15. doc 
dtxlm 16. doc 
dlxlm 1 6. doc 
dlxlm35. doc 

View Location I 

~ 
~ 
~ 

Close 

Create Data File and Merge Letters 

Create Data File ONLY 

Cancel 

4. In the dialog box that appears, select a letter, set up a 
date range (if applicable), and then click Create/ 
Merge. Te Create/Merge Options dialog box 
appears. 

5. Select Create Data File and Merge Letters. 

For details about the Create Data File ONLY and 
Merge Letters using existing data fle options, see 
the “Other create and merge options” topic in the 
Dentrix Enterprise Help. 

6. If you want Dentrix Enterprise to add an entry to 

4 

each patient’s Ofce Journal, indicating that a letter 
was sent to that patient, select Add to Journal. 

7. Click OK. 

When the merge is complete, in Microsoft Word, you can print the 
letters. Ten, close Microsoft Word without saving the changes to the 
document. 

Warning: If you save the changes to the document, patient 
information will be permanently saved in the letter template, 
rendering the template unusable. 

7 

5 

6 
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Patient Report View 

Leiter !:lame: IPatienl Report (by filters) 

Patient Filters I Data Fields I 

Continuing Care letters <CENTRAL> 

Select Letter 

Appointment Cards-Reminder 
Continuin Care -- W /0 A t 

Continuing Care Letter-Adult 
Continuing Care Letter-Child 
Continuing Care-Inactive 

dt,lm25. doc 
dt,lm26. doc 

dt,lm04.doc 
dt,lm05. doc 
dt,lm03.doc 

,,Q, I __ v_ie_w_L_is_t_. View Location I 

~ 
Merge Data File Name:ldt,lm22.oul = r'\ 
Merge Letter Iemplate: ldtxlm22.doc ~ 

Clinic: I CE N TAAL 3 P alien! Name: I <ALL> 2.:J to l<ALL> 2.:J 
E-mail Options------------------, 
r, All P alienls r 

Provider(s) ~~~1rn□v 
J7 All SHAYES 

Status 
r Patient 
r Inactive 

r N on-P alien! 

r Male 

r Female 

r G uar anlors Only 
Position------, 

r Married r Child 

r Single r O I her 

Use Priyacy Request for "No correspondence" lo skip palienL1,-=======~-----------~ 
r Does not appl_y for this letter C. Applies for Patients and Guarantors r Applies for ''Referred B_y Patients'' 

Birthday: ,--------- ...:..:J 
Consent Date: ~-------- ...:..:J 
1st Visit Date: ,--------- ...:..:J 

Last Visit Dale:~- ...:..:J 
Continuing Care: ~ 

Last Rel Date: ~-------- ...:..:J 
Last Pa_y Date: ~-------- ...:..:J 

Balance: ,---------=--- ...:..:J 
Pay Plan Bal: I ...:..:J 

Appointments: - ~ 

Notes: 

BillingType(s) 1: Standard Billing- rnancecharges • 
P All 2: Standard Billing· no finance charge r:;i 

3: Insur a nee Family -dela,Y finance ch<l:J 
4: Insurance Famil,Y - finance charges 
5: P a,Yment Plan · finance charges 
6: P a,Yment Plan · no finance charges ., 

Aging-----------, r (O)Bal r (-)Bal 

r ,-Jo r , -60 r ,.90 r ,.90. 

~ 

Close 

Creating Appointment Reminder Cards 
You can create reminder cards to send to patients with upcoming appointments. 

To create appointment reminder cards 

1. Open and minimize Microsoft Word. 

2. In the Ofce Manager, click Letters on the menu bar. 

Te Letters window appears. 

3. Click Continuing Care. 

Te Continuing Care Letters dialog box appears. 

4. Select Continuing Care -- With Appt. 

Note: Tis is the default for the letter template name 
when Dentrix Enterprise is initially installed, but the 
name might have been changed. 4 

5. Click Edit. 

Te Patient Report View dialog box appears. 

6. In the Merge Letter Template feld, type one of the 
following template document names, based on the 
type of cards you are using: 10 
• dtxlm29.doc – 2-wide, laser cards. 

• dtxlm24.doc – Single-wide, dot matrix cards. 

• dtxlm27.doc – 2-wide, dot matrix cards. 

1 

2 

3 

5 

6 

7 

8 

9 
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"Select Continuing Care Ranges ~ 

Ea 
.... on 1nu1ng 1_.are 1 _ype: . 

A 
. "Lab-Aspen Aspen Dental Lab -

"Lab-Alpine Alpine Dental Spe 
. "Lab-Heritag Heritage Dental Li 

"Lab-HiT ech Hi T ech"Dental Te := 
Prior Treatment - CALLAMALG Amalgam followup 

From:I 
CALL CROWN Crown follow-up c, ........ 
CALL RC Root Canal follow-
FMS Full Mouth Series 

Toj ORTHO Ortho post-treatme ...,.. 

I Include 
r All 

Clear I 
I 

I 
r- With Attached Appointment II I OK I r W ithout Attached Appointment 

Cancel I 

Select Appointment Range 

Search----------------, 

r Prosoective Patients with aonointment in date ranae 

C. Existing Patients with appointment in date range 

t I:. x1st1ng f-' at1ents with NU appointment 1n date range 

Appointment Date Range---------~ 

Beginning: I 11 /11 I 2012 Ending: In 1 /111201 3 

Clear OK Cancel 

Create/Merge Options 

r. Create Data File and Merge Letters 

Create Data File ONLY 

Merge Letters using existing data file 

OK Cancel 

7. Set up the continuing care flter: 

a. Click the Continuing Care search button . 

Te Select Continuing Care Ranges dialog box appears. 

b. Under Due Date and Prior Treatment Date, leave From 
and To blank. 

c. Under Include, select With Attached Appointment. 

d. Under Continuing Care Type, select the appropriate 
continuing care type. 

e. Click OK. 

8. Set up the appointment flter: 

a. Click the Appointments search button. 

Te Select Appointment Ranges dialog box appears. 

b. Under Search, select Existing patients with appointment in 
date range. 

c. Under Appointment Date Range, type the Beginning and 
Ending dates of the range of appointments for which you are 
printing cards. 

d. Click OK. 

9. Click OK to return to the Select Continuing Care Ranges dialog box. 

10. With Continuing Care -- With Appt still selected, click Create/Merge. 

Te Create/Merge Options dialog box appears. 

11. Select Create Data File and Merge Letters, and Add to Journal (if 
desired), and then click OK. 

When the merge is complete, in Microsoft Word, you can print the 
cards. Ten, close Microsoft Word without saving the changes to the 
document. 

11 

Warning: If you save the changes to the document, patient 
information will be permanently saved in the letter template, rendering the template unusable. 
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Continuing Care Letters < CENTRAL> 

Select Letter 

Oil 

dtxlm25. doc 

dtxlm29. doc 
dt, lm04.doc 
dt,lm05. doc 
dtxlm03.doc 

Q , __ v_ie_w_L_i,_1__, View Location I 

Patient Report View ~ 
Letter tlame: !Patient Report (by filters) 

Patient Filters I Data Fields I 
Merge Data File Name: ldt,lm22.out = r'\ 
Merge Letter I emplate: ldt, lm22.doc ~ 

Clinic: I CE N TAAL ..=.J P alien! Name: I <ALL> ~ to l<ALL> 2J 
E-mail Options-----------------, 
r- All P alienls r 

Provider(,) g~~l~~OV 

f7 All SHAYES 

Status 
r Patient 
r Inactive 

r Non-Patient 

r Male 

r Female 

r Guarantors O nl_y 
Position-----, 

r Married r Child 

r Single r Other 

Use Priyacy Request for "No correspondence" to skip patienLts=======~-----------~ 
r Does not apply for this letter r- Applies for Patients and Guarantors r Applies for "Referred By Patients" 

Birthday: 22,] E mp: 22,] 
Consent Date: ,--------- 22,] Ref B_1.1: ,------------ 22,] 
1 st Visit Date: ..22:,] Ref To: -2,] 

Last Visit Dale: ~ 22,] Ins Co 22.] 
Continuing Care: d City: ..2.d 

Last Ref Date: - .2.d Zip: ..22.J 
Last Pa_y Date: _________ 22,] Alerts: ..2.d 

Balance: ,--------- 22.J Notes: 22.J 
Pay Plan Bal:,-________ 22,] Proc: 22,] 

Appointments: _2.d 

Billing Type(s) 1: Standard Billing · finance charges A 

17 All 2: Standard Billing - no finance charge ~ 
3: Insur a nee Family - delay finance chil_:J 
4: Insurance Family - finance charges 
5: P a_yment Plan - finance charges 
6: P a_yment Plan - no finance charges """ 

Aging----------, r (O)Bal r (·)Bal 
r , -Jo r , -Go r , .90 r ,.90. 

Close 

Creating Cards for Patients Without 
Appointments 
You can create reminder cards to send to patients without appointments who need to schedule a return visit. 

To create cards for patients without appointments 

1. Open and minimize Microsoft Word. 

2. In the Ofce Manager, click Letters on the menu bar. 

Te Letters window appears. 

3. Click Continuing Care. 

Te Continuing Care Letters dialog box appears. 

1 

2 

3 

4. Select Continuing Care -- W/O Appt. 

Note: Tis is the default for the letter template name 
when Dentrix Enterprise is initially installed, but the 
name might have been changed. 

5. Click Edit. 

Te Patient Report View dialog box appears. 

6. In the Merge Letter Template feld, type one of the 
following template document names, based on the 
type of cards you are using: 
• dtxlm26.doc – 2-wide, laser cards. 
• dtxlm23.doc – Single-wide, dot matrix cards. 
• dtxlm28.doc – 2-wide, dot matrix cards. 

4 5 

10 

6 

7 

8 
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IP Select Continuing Care Ranges ~ 
- l,lue uate I L.ont1nu1ng 1_.are 1 _ype: 

F rom:I 11 111 12013 
. 

A 

"Lab- Aspen Aspen Dental Lab ~ 
"Lab-Alpine Alpine Dental Spe 

To: I 1 211212013 "Lab-Heritag Heritage Dental Li 
"Lab-HiT ech Hi T ech_Dental Te := 

Prior Treatment- CALLAMALG Amalgam followup 
CALL CROWN Crown follow-up c, _ 

From:11 CALL RC Root Canal follow-
FMS Full Mouth Series 

Toj ORTHO Ortho post- treatme ...,.. 

r All 
Clear I Include 

r With Attached Appointment 
I OK 

I (• Without Attached Appointment 
Cancel 

Create/Merge Options 

r. Create Data File and Merge Letters 

r Create Data File ON LY 

r Merge Letters using existing data file 

OK Cancel 

I 
I 
I 

7. Set up the continuing care flter: 

a. Click the Continuing Care search button . 

Te Select Continuing Care Ranges dialog box appears. 

b. Under Due Date, type the Beginning and Ending dates of 
the range for which you want to print cards. 

c. Under Include, select Without Attached Appointment. 

d. Under Continuing Care Type, select the appropriate 
continuing care type. 

e. Click OK. 

8. Click OK to return to the Select Continuing Care Ranges 
dialog box. 

9. With Continuing Care -- W/O Appt still selected, click Create/Merge. 

Te Create/Merge Options dialog box appears. 

10. Select Create Data File and Merge Letters, and Add to Journal (if 
desired), and then click OK. 

When the merge is complete, in Microsoft Word, you can print the 
cards. Ten, close Microsoft Word without saving the changes to the 
document. 

10 

Warning: If you save the changes to the document, patient information will be permanently saved in the 
letter template, rendering the template unusable. 
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2J 

2J 

2J 

03/16/2017 Continuing Care Displa}' List - Mailing Labels 
09/18/2017 Prim. Dental lns.((DX2007) Abbott, James-Smile Saver 
09/19/2017 Prim Dental !nsffDX20071 Smith Ang,;,la-Sm~"' Saver 

AF 
AF 
AF 

Clinic Selection---- Select Date Range------~ 

G P AIi 

{All Clinics Selected) 

P,ovider Selection 

~ P AIi 

{All Providers Selected) 

Billing Type Selection 

~ P AIi 

{All Billing Types Selected) 

From: 10411712013 

To: I 0411112013 

r♦ Entry Date 

r Procedure Date 

Note: Date Range refers to the date 
of the procedures on the claim. 

P Create Primary Dental Claims 

r Create Primary Medical Claims 

P Save as Default 

Print Send to Batch Send E lectronicall_y I Cancel 

Creating a Batch of Primary Insurance 
Claims 
In the Ofce Manage, you can create and batch, create and print, or create and send electronically all 
insurance claims for all procedure codes that are not currently attached to a primary insurance claim, are not 
fagged as “Do not bill to insurance,” and fall within a specifed date range. You can create batch insurance 
claims for multiple clinics only if you are logged in to the Central clinic; otherwise, you can create batch 
insurance claims for only the clinic that you are logged in to. 

To create a batch of primary insurance claims 

1. In the Ofce Manager, from the File menu, click Batch Ins 
Claims. 

1 

Te Create Batch Primary Insurance Claims dialog box appears. 

2. Set up the following options: 

• Clinic Selection – Click the search button to 
select the clinics you want to include on the report, 
or leave All selected to include all clinics. 

2 

• Provider Selection – Click the search button 
to select the providers you want to include on the 
report, or leave All selected to include all providers. 

• Billing Type Selection – Click the search button 
to select the billing types you want to include on the 
report, or leave All selected to include all billing 
types. 

• Select Date Range – Te date range defaults to the 
current system date. If necessary, in the From and 
To felds, type the date range for which you want 
to generate insurance claims. Also, select whether 
to search for procedures on primary insurance 
claims by Entry Date or Procedure Date. 

3 

• Create Primary Dental Claims – Select this option to include all primary dental insurance claims in 
the specifed date range. 

• Create Primary Medical Claims – Select this option to include all primary medical insurance claims 
in the specifed date range. 

• Save as Default – Select this option to save the current settings for the next time you create batch 
insurance claims. 

3. Click Print to print the primary insurance claims, Send to Batch to send the primary insurance claims 
to the Batch Processor, or Send Electronically to send the primary insurance claims electronically to the 
clearinghouse. On the message that appears and displays the total number of primary dental and medical 
claims that will be created, click OK. 
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Submitting Electronic Claims 
eTrans is an add-on program that you can use to transmit insurance claims electronically from Dentrix 
Enterprise to insurance carriers. You must frst register your practice if you want to use this service. Talk to 
your trainer, or contact eServices Customer Support at (800) 734-5561 for more information on how to 
purchase and install eTrans. 

Note: You can send electronic claims only from a computer with an Internet connection. 

To submit electronic claims with eTrans 

1. Create insurance claims, sending them to the Batch Processor. 

2. In the Ofce Manager, do one of the following: 

• To submit all or some of the batched claims, from the File menu, click ECS. 

• To submit specifc claims, select the appropriate claims in the Batch Processor, and then, from the 
File menu, click ECS. 

For more information on sending and editing electronic claims, setting up eTrans, and viewing reports 
regarding your electronic claims, refer to the eTrans User’s Guide, which is available for download from the 
Resource Center at www.DentrixEnterprise.com. 

Sending Statements with QuickBill 
If you have purchased, installed, and properly confgured QuickBill, you can send billing statements 
electronically to a clearinghouse where they are professionally printed, folded, and mailed to guarantors. 

For information on setting up QuickBill, refer to the QuickBill User’s Guide, which is available for download 
from the Resource Center at www.DentrixEnterprise.com. 

To send statements electronically 

1. Generate billing statements, sending them to the Batch Processor. 

2. In the Ofce Manager, select the appropriate billing statements and/or a batch of statements in the Batch 
Processor. 

3. From the File menu, click EBS. On the confrmation message that appears, click Yes. 

www.DentrixEnterprise.com
www.DentrixEnterprise.com
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Signing Mulitple Clincal Notes 
You can sign multiple clinical notes at one time from the Ofce Manager. 

To sign multiple clinical notes 

1. While logged in to Dentrix 
Enterprise as the user who needs to 
sign clinical notes, in the Ofce 
Manager, click the Signature 
Manager button . 

Te Signature Manager dialog box 
appears. 

2. Set up the following 
Filters as needed: 

• Date Range 
Selection – Select 
one of the following 
options: 

4 
5 

• Previous – To 

1 

view clinical 
notes for 
the specifed 
number of days 
prior to today’s 
date. Enter the 

3 
2 

number of days. 

• Date Range – To view clinical notes within the specifed date range. Select the starting and 
ending dates of the range. 

• Any Date – To view clinical notes for any date. 

• Clinic Selection – Select one of the following options: 

• Current Clinic – To view clinical notes for the clinic that you are currently logged in to. 

• Other – To view clinical notes for specifc clinics or all clinics. Either click the search button 
to select the clinics whose clinical notes you want to view, or select the All check box to include 
all clinics’ clinical notes. 

• Provider Selection – Click the search button  to select the providers whose clinical notes you want 
to view, or select the All check box to include all providers’ clinical notes. 

• Status Selection – Select whether you want to view all, unsigned, or signed clinical notes. 

3. Click the Refresh button to apply the specifed flters. 

Only the clinical notes that match the specifed criteria appear in the list. 

4. Click each clinical note to review it. Ten, select the clinical notes that you want to sign. To select 
multiple notes, while holding down the Ctrl key, click each note; or, while holding down the Shift key, 
click the frst and last notes to select those notes and all notes in between them. 
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Sign Clinical Note 

Attached Documents By: 

P' Patient r Referred BY r Dental Insurance Plan r Employer 

P' Provider/Staff r Referred TO r Medical Insurance Plan 

1" o optimize performance, Scan Date Range cannot exceed 180 Days. 

Clinical Notes, Approve 

User Name: Smith, Dennis 

OK Cancel 

Clear Selections 

Date I Total I Total 19/. A.Jdited Ir~~ Documents Audited □ 1 <.11:i; l"l. of 
Errors I 

Poor 

~ I Incorrect I klcorred I Othe.-
l.ocat10n Record Errors 
Errors Errors 

I Comment,/Follow-Up , 

5. Click the Sign button . 

Te Clinical Notes, Approve dialog box appears. 

6. Type your password, and then click OK. 

Te Sign Clinical Note dialog box appears. 

7. Sign, and then click OK. 

6 

7 

Using the Document Center Audit 
Documents Utility 
With the Document Center Audit Documents utility, you can identify audited documents and documents 
that have not been audited yet. From the utility, you can also access any document’s information to make 
changes or audit the document as needed. 

To view documents in the Document Center Audit Documents utility 

1. In the Ofce Manager, on the Analysis menu, click Document 
Center Audit Documents. 1 
Te Document Center Audit Documents window appears. 

2 

2. Apply flters, and view the resulting data on any of the following tabs. 
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Print Data Grid Cancel 
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Clear Selections 
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Reporting Tab 

On the Reporting tab, do the following: 

a. Set up the following flters: 

• Scan Date Range – Specify a date range to include documents that were acquired on those dates. Te 
current month is specifed by default. 

Note: Te date range cannot exceed 180 days. 

• Attached Documents By – Select any of the following types of entities to include documents that are 
associated with those types of entities: Patient, Provider/Staf, Referred BY, Referred TO, Dental 
Insurance Plan, Medical Insurance Plan, and Employer. 

b. Click the Refresh button . 

Te data grid is updated according to the specifed criteria. 

For each date that documents were acquired on, the data grid displays the following information: 

• Date – Te acquisition date. 

• Total Documents – Te total number of documents in the Scan Date Range. A document is 
counted once, regardless of the number of associated entities. 

• Total Audited – Of the documents included in the Total Documents count, the total number that 
have been audited (documents with an Audited status). 

• % Audited – Of the documents included in the Total Documents count, the percentage that have 
been audited (documents with an Audited status). Tis is calculated by dividing Total Audited by 
Total Documents. 

• Total Errors – Of the documents included in the Total Audited count, the total number that have 
been marked as having an error (Poor Scan, Incorrect Location, Incorrect Record, or any user-defned 
error type). 

• % of Errors – Of the documents included in the Total Audited count, the percentage that have been 
marked as having an error (Poor Scan, Incorrect Location, Incorrect Record, or any user-defned 
error type). Tis is calculated by dividing Total Errors by Total Audited. 
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REPORTING 

DOCUJ;IENTS REVIEW 

REVIEW DOCUL1ENTS 
AUDITED 

Document Status 

!'JI ~ 
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11011212020 O T I 

Document I Document 
Status Creation 

Date 

10/ 12/2020 

Audled I 10/ 12/2020 

Audied I 10112/2020 

Not Audled 11011212020 

Attached Documents By: 

P" Patient r Referred BY r Denta l Insurance Plan r Employer 

P° Provider/Staff r Referred TO r Medical Insurance Plan 

I Pttached 
Documents By 

I Name Pttached 
To 

I Document 
Type I Descripbon 

Provider/ Staff Dennis Smith, D.M.D Miscellaneous Agreement 

Paben! Crosby. Brent Miscellaneous Agreement 

Provider/ Staff Dennis Smlh. D.M.D Miscellaneous NPI 

Provider/ Staff Dennis Smith. D.M.D Miscellaneous EFT Pay 

Cancel 

User Document Created By 

_::..J r--A11 
User Clinic Clear Selections 

_::..J P° All 
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Dennis Smit ... AF Oick for Docum ... 

Dennis Smit ... AF Oick for Docum .. 

Dennis Smit ... AF Oick for Docum ... 
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• Poor Scan Errors – Of the documents included in the Total Errors count, the total number that 
have been marked with the Poor Scan error type. 

• Incorrect Location Errors – Of the documents included in the Total Errors count, the total number 
that have been marked with the Incorrect Location error type. 

• Incorrect Record Errors – Of the documents included in the Total Errors count, the total number 
that have been marked with the Incorrect Record error type. 

• Other Errors – Of the documents included in the Total Errors count, the total number that have 
been marked with any user-defned error type. 

• Comments/Follow-Up – In the box, enter any comments regarding that line of the data grid. Te 
comments appear on the report but are not saved anywhere in Dentrix Enterprise. 

Note: To return the flters to their default states and clear the data grid, click Clear Selections. 

c. Click Print Data Grid to preview the report. Ten, you can print or save the report. 

Documents Review tab 

On the Documents Review tab, do the following: 

a. Set up the following flters: 

• Document Status – Select one of the following options: 

• All – To include all documents (audited and unaudited). 

• Audited – To include audited documents only. 

• Not Audited – To include unaudited documents only. Tis option is selected by default. 

• Scan Creation Date – Select a date to include documents that were acquired on that date. Te 
current date is selected by default. 

• Attached Documents By – Select any of the following types of entities to include documents that are 
associated with those types of entities: Patient, Provider/Staf, Referred BY, Referred TO, Dental 
Insurance Plan, Medical Insurance Plan, and Employer. 
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• User Document Created By – Click the search button  to select the users who acquired 
documents that you want to include, or select the All check box to include documents that were 
acquired by any user. Te All check box is selected by default. 

Note: Which users are available depends on the following security rights: under Central Clinic Only, 
the “View All Providers” right; and under Practice/Clinic Setup, the “My Clinics, Select Provider” 
right. 

• User Clinic – Click the search button  to select the clinics where users acquired documents that 
you want to include, or select the All check box to include documents that were acquired by users in 
any clinic. Te All check box is selected by default. 

Note: Which clinics are available depends on the following security rights: under Central Clinic 
Only, the “View All Providers” right; and under Practice/Clinic Setup, the “My Clinics, View” right. 

b. Click the Refresh button . 

Te data grid is updated according to the specifed criteria. 

Note: A document may appear more than once in the data grid, depending on the number of 
attachments and the specifed flters. 

For each document, the data grid displays the following information: 

• Document Status – Te document’s audit status: Audited or Not Audited. 

• Document Creation Date – Te document’s acquisition date. 

• Attached Documents By – Te type of entity that the document is associated with: Patient, 
Provider/Staf , Referred BY, Referred TO, Dental Insurance Plan, Medical Insurance Plan, or 
Employer. 

• Name Attached To – Te name of the entity that the document is associated with. 

• Document Type – Te document’s type (the folder name in the document tree). 

• Description – Te document’s description (the fle name in the document tree). 

• Attached By User ID – Te name of the user who acquired the document. 

• User Clinic – Te clinic that the user who acquired the document was logged in to when he or she 
acquired the document. 

• Launch Document – Click the link to open the Document Information dialog box for the 
document. Ten, you can review or edit the document information and audit the document as 
needed. 

Note: Te corresponding entity’s Document Center is open behind the Document Information 
dialog box, and the corresponding document is selected. 

Note: To return the flters to their default states and clear the data grid, click Clear Selections. 



362     Chapter 8: Offce Manager 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

Document Center Audrt Documents - D X 

REPORTING 

DOCUJ;IENTS REVIEW 

REVIEW DOCUL1ENTS 
AUDITED 

User that Scan Date Range· : 
Audited 
Document(s) 110/ 1/2020 □· I 
[3r,,A11 11013112020 □· I 
-r o optimize performance. the Date 
Ranges cannot exceed 180 Days . 

Document I Document 11\Jdded 
Status Creation By User 

Date 

Attached Documents By: 

P" Patient r Dental Insurance Plan 

P° Provider/Staff r Medical Insurance Plan 

r Employer r Referred BY 

r ReferredTO 

ErrOf Type Audit Date Range·: 

....::.J r,, All 110112/2020 □• I 
110, 12/2020 □• I 

I Mached I Name I Document I Document I Document I Descripbon Documents Attached Type I\Jdded Errors By To Date 

10, 12/2020 I Dennis s .. I Provider/ S ... I Dennis S .. I Miscellane .. I 10/ 12/2020 I Poor Scan I Agreement 

Audled I 10/ 12/2020 I Dennis S .. I Patient I Crosby, Br . I Miscellane .. I 10/12/2020 I Poor Scan I Agreement 

Audied I 10/ 12/2020 I Dennis S .. I Provider/S .. 1 Dennis S .. I Miscellane .. I 10/12/2020 I No Errors I NPI 

Print Data Grid Cancel 

...::J 

User Documents Created By 

....::.J r,,A11 

User Clinic 

....::.J P° All Clear Selections 

I Mached 
By User ID 

I User 
Oinic 

I Launch 
Document 

I Dennis S ... IAF l □ickforD .. . 
I Dennis S ... IAF l □ickforD .. . 

I Dennis S ... IAF l □ickforD .. . 

Review Documents Audited tab 

Note: To access the Review Documents Audited tab, your user account must have the “Document Center, 
Review Documents Audited” security right enabled. 

On the Review Documents Audited tab, do the following: 

a. Set up the following flters: 

• User that Audited Document(s) – Click the search button to select the users who audited 
documents that you want to include, or select the All check box to include documents that were 
audited by any user. Te All check box is selected by default. 

Note: Which users are available depends on the following security rights: under Central Clinic Only, 
the “View All Providers” right; and under Practice/Clinic Setup, the “My Clinics, Select Provider” 
right. 

• Scan Date Range – Specify a date range to include documents that were acquired on those dates. Te 
current month is specifed by default. 

Note: Te date range cannot exceed 180 days. 

• Attached Documents By – Select any of the following types of entities to include documents that are 
associated with those types of entities: Patient, Provider/Staf, Referred BY, Referred TO, Dental 
Insurance Plan, Medical Insurance Plan, and Employer. 

• Error Type – Click the search button  to select the error types that are associated with documents 
that you want to include, or select the All check box to include documents with any error type. 
Te All check box is selected by default. Te default error types (No Errors, Poor Scan, Incorrect 
Location, and Incorrect Record) and any user-defned error types are available. 

• Audit Date Range – Specify a date range to include documents that were audited on those dates. Te 
current date is specifed by default. 

Note: Te date range cannot exceed 180 days. 
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• User Documents Created By – Click the search button  to select the users who acquired 
documents that you want to include, or select the All check box to include documents that were 
acquired by any user. Te All checkbox is selected by default. 

Note: Which users are available depends on the following security rights: under Central Clinic Only, 
the “View All Providers” right; and under Practice/Clinic Setup, the “My Clinics, Select Provider” 
right. 

• User Clinic – Click the search button  to select the clinics where users acquired documents that 
you want to include, or select the All check box to include documents that were acquired by users in 
any clinic. Te All check box is selected by default. 

Note: Which clinics are available depends on the following security rights: under Central Clinic 
Only, the “View All Providers” right; and under Practice/Clinic Setup, the “My Clinics, View” right. 

b. Click the Refresh button . 

Te data grid is updated according to the specifed criteria. 

Note: A document may appear more than once in the data grid, depending on the number of 
attachments, the number of associated error types, the number of auditors, and the specifed flters. 

For each document, the data grid displays the following information: 

• Document Status – Te document’s audit status: Audited or Not Audited. 

• Document Creation Date – Te document’s acquisition date. 

• Audited By User – Te name of the user who audited the document. 

• Attached Documents By – Te type of entity that the document is associated with: Patient, 
Provider/Staf , Referred BY, Referred TO, Dental Insurance Plan, Medical Insurance Plan, or 
Employer. 

• Name Attached To – Te name of the entity that the document is associated with. 

• Document Type – Te document’s type (the folder name in the document tree). 

• Document Audited Date – Te date when the document was audited. 

• Document Errors – Te error type that is associated with the document (No Errors, Poor Scan, 
Incorrect Location, Incorrect Record, or a user-defned error type). 

• Description – Te document’s description (the fle name in the document tree). 

• Attached By User ID – Te name of the user who acquired the document. 

• User Clinic – Te clinic that the user who acquired the document was logged in to when he or she 
acquired the document. 

• Launch Document – Click the link to open the Document Information dialog box for the 
document. Ten, you can review or edit the document information and audit the document as 
needed. 

Note: Te corresponding entity’s Document Center is open behind the Document Information 
dialog box, and the corresponding document is selected. 

Note: To return the flters to their default states and clear the data grid, click Clear Selections. 

c. Click Print Data Grid to preview the report. Ten, you can print or save the report. 
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Chapter 9: DXOne Reporting 
Te DXOne Reporting module provides you with reports that will assist you in analyzing your practice. 
You can schedule these reports to be generated automatically on a daily, weekly, monthly, or one-time basis. 
Additionally, you can send reports generated in DXOne Reporting as an email attachment to the Central 
clinic, a consultant, or an accountant. 

Tis chapter covers the following topics: 

• Opening DXOne Reporting 

• Te DXOne Reporting Window 

• Setting Up Report Security 

• Generating DXOne Reporting Reports 

• Working with Previewed Reports 

• Using Report Templates 

Opening DXOne Reporting 
You can open the DXOne Reporting module from the Ofce Manager. 

To open DXOne Reporting 

In the Ofce Manager, click the DXOne Reports button  on the toolbar. 
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DXONE Reporting 

File Reports Security Scheduling E-Mail Help 

5 
Select Report Category: Double Click to Launch Report Options: 
~--------
Reference Employers and Employed Patients 
Management Fee Schedule 

Ledger Insurance Carrier List 

Analysis Medical Code List 
1st Patient Health Assessment Report 

Audit Practice Organization List 
UDS Provider IDs List 

Custom RVU Schedule 

---

---

DXONE Reporting 

File Reports Security Scheduling E-Mail Help 

5 
Select Report Category: Double Cl ick to Launch Report Options: 
---------
Reference O Employers and Employed Patients 
Manageme Fee Schedule 

Ledger Insurance Carrier List 

Analysis Medical Code List 0 
List Patient Health Assessme 

Audit Practice Organization List 
UDS Provider IDs List 

Custom RVU Schedule 

The DXOne Reporting Window 
Te DXOne Reporting window consists of the menu bar, toolbar, report category list, and report list. 

Report Reports
categories 

Tis section covers the following topics to help you understand how to use the DXOne Reporting window: 

• Te DXOne Reporting Toolbar 

• Selecting a Report 

The DXOne Reporting Toolbar 
Te toolbar contains several buttons that you can click to access certain areas of Dentrix Enterprise and 
DXOne Reporting. 

Te function of the buttons specifc to DXOne Reporting are explained in the following table. 

Click the Open Report button to view a saved report. 

Click the Security button to assign rights to allow only certain users to access specifc reports. 

Click the Report Server button to assign services for running report jobs. 

Selecting a Report 
Reports are organized by category to help you fnd a report easily. 

To select a report 

1. From the Select Report Category list box, select a 
report category. 

2. A list of available reports for the selected category 
appears in the Double Click to Launch Report 
Options list box. To set up the flters for generating a 
report, double-click that report. 

1 
2 
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Setting Up Report Security 
In DXOne Reporting, you can control which reports can be generated by which users. 

To set up user rights and security for DXOne Reporting 

1. In DXOne Reporting, from the menu bar, click 
Security. Te Report Security dialog box appears. 1 

2 

2. Under User List, select a user. 

3 

4 

5 6 

3. Select the report for which you want to Set Security, or leave <General> selected to assign general rights 
(such as managing scheduled jobs and selecting clinics) for the selected user. 

4. Set up the following options: 

• Rights – Select the rights that correspond to the tasks that the user can do, or select the check box at 
the top of the list to select all the rights. 

Tip: If you have multiple employees with the same level of security, click Copy User Security to 
select the user from which you want to copy settings. 

• Clinics – Select the clinics for which the user can generate reports, or select the check box at the top 
of the list to select all clinics. 

• Provider/Staf – Select the providers and staf members for whom the user can generate reports, or 
select the check box at the top of the list to select all providers/staf members 

Tip: To select the user selected under User List, click Highlight Selected User. 

5. Click Save. 

If necessary, repeat steps 3–5 for each report the selected user will have access to. Ten, repeat steps 2–5 
for each user. 

6. Click Close. 
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Generating DXOne Reporting Reports 
Te reports in the DXOne Reporting window are grouped into the following categories: 

• Reference Reports 

• Management Reports 

• Ledger Reports 

• Analysis Reports 

• List Reports 

• Audit Reports 

• UDS Reports 

• Custom Reports 

Te sections that follow provide a description of each available report. For a comprehensive explanation of all 
the options for running these reports see the “Generating DXOne Reporting reports” topic and its subtopics 
in the Dentrix Enterprise Help. Also, to see samples of and read an explanation of what appears on each 
report, refer to the Dentrix Enterprise 11.0.2 Reports Reference. 

Reference Reports 
In DXOne Reporting, select Reference, and then double-click a reference report: 

• Employers and Employed Patients Report – Te Employers and Employed Patients Report is a list of all 
employers, including name, address, and phone number. You may also select to include employed patients 
with each employer. 

• Fee Schedule Report – Te Fee Schedule Report is a list of procedure codes and the associated fees. Lab 
and material expenses associated with each procedure are also included. 

• Insurance Carrier List – Te Insurance Carrier List is a list of carrier names, addresses, phone numbers, 
contact names, and all related insurance information. You can also include the insured subscribers for 
each insurance plan. 

• Patient Health Assessment Report – Te Patient Health Assessment Report displays health information 
entered for a range of patients in specifed clinics. Te blood pressure, pulse rate, age, height, weight, and 
body mass index (BMI) of each patient appears on the report. 

• Practice Organization List – Te Practice Organization List is a list of the primary and secondary 
providers and staf members that have been set up for your practice. Te report includes the 
corresponding provider or staf information. 

• Provider IDs List – Te Provider IDs List is a report of providers and relevant information. 

• RVU Schedule Report – Te RVU Schedule is a list of the procedure codes and the associated RVU fees. 
Lab and material expenses associated with each procedure are also included. 
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Management Reports 
In DXOne Reporting, select Management, and then double-click a management report: 

• Analysis Summary Report – Te Analysis Summary Report displays the transaction totals that are 
normally shown at the bottom of a day sheet, by provider, or by date, for a specifc provider and date 
range. 

• Appointment Cycle Time Report – Te Appointment Cycle Time Report helps you analyze changes in 
appointments’ statuses. Te report provides statistics regarding how long patients wait to be treated and 
how long they spend in treatment. 

• Appointment Statistics Report – Te Appointment Statistics Report provides an overview of the 
productivity and efciency of your practice regarding patient visits. Tis report displays statistics for late 
appointments, on-time appointments, wait/will call appointments, broken appointments, appointments 
that remained in specifed statuses for a specifed length of time, and appointment durations based on 
specifed statuses. 

• Assigned Rights Report – Te Assigned Rights Report lists the current security rights assigned to each 
selected user and clinic. 

• Daily Summary Report – Te Daily Summary Report displays statistics for new guarantors, new 
patients, patients seen, appointments made, production, collections, and adjustments. 

• Day sheet – Te day sheet lists all transactions for the day (alphabetically or chronologically), according 
to the providers and billing types selected. 

• Day sheet - adjustments – Te day sheet - adjustments lists all adjustment transactions for the day. 

• Day sheet - deposit slip – Te day sheet - deposit slip lists all payment transactions for the day in a 
format suitable for a bank deposit slip. 

• Day sheet - receipts – Te day sheet - receipts report lists all payment transactions for the day. 

• Dental Encounters Report – Te Dental Encounters Report lists procedures posted during a specifed 
date range (each procedure must be attached to a claim to appear on the report), along with the amount 
that is expected to be paid by insurance. For each procedure, the date of service, name of the patient who 
received treatment, the subscriber ID (Benefciary ID) of the subscriber of the patient’s insurance plan, 
and the appropriate NPI numbers are shown. 

• Finance / Late Charge Report – Te Finance / Late Charge Report lists accounts that received fnance 
or late charges, according to the parameters set. Te report lists the date of the charge, guarantor’s name, 
amount of the charge, billing type, and guarantor’s primary provider. A total of fnance and late charges 
are calculated and listed at the bottom of the report. 

• Insurance Carrier Production Report – Te Insurance Carrier Production Report lists insurance 
plans’ production amounts, payments, and adjustments. Te report can also include details about each 
procedure and insurance plan totals. Te summary report and the full report will give you grand totals. 

• Practice Statistics Report – Te Practice Statistics Report provides a detailed cross-section of the 
practice’s patient base, including demographic, age, and continuing care information. 

• Provider Accounts Receivable Totals Report – Te Provider A/R Totals Report lists each provider’s 
accounts receivables totals for a date range or lists a daily total for each day in the range. Suspended 
credits are not included on this report except when Initial Provider is selected under Group By; in which 
case, the full credit is always shown. 

• Referred By Doctor/Other Report – Te Referred By Doctor/Other Report lists each referring doctor 
or non-person referral source (for example, an advertisement) that has referred a patient to your practice 
within a specifed date range. For each referring doctor/other listed, a list of referred patients is included 
with patient information and details regarding production generated by the referral. You can also print 
mailing labels for each referral source. 
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• Referred By Patient Report – Te Referred By Patient Report lists each patient who has referred another 
patient to your practice within a specifed date range. For each referring patient listed, there is a list of 
patients that have been referred, including production details resulting from that referral. You can also 
print mailing labels for each referral source. 

• Referred To Doctor Report – Te Referred To Doctor Report lists the number of patients who have 
been referred to another practice during a specifed time period. Depending on report settings, this report 
also lists the name and referral date of each referred patient. Te statistics and patients on the report are 
grouped by referral. You can also create mailing labels for those doctors to whom your patients have been 
referred. 

• RVU day sheet – Te RVU day sheet is a list of RVU production items. Te report also displays the total 
RVU and net RVU. 

• RVU Production Summary Report – Te RVU Production Summary Report is a summary of RVU 
production. Te report also displays the Quantity, Total, Average, Percent, and Net RVU. 

• RVU Utilization Report – Te RVU Utilization Report lists insurance carriers and, for each carrier, the 
relevant RVU production items along with details about the procedure. 

Ledger Reports 
In DXOne Reporting, select Ledger, and then double-click a ledger: 

• Aging / Credit Balance Report – Te Aging/Credit Balance Report displays the guarantor’s name, phone 
number, billing type, last payment amount, last statement date, agreed payment amount and balances per 
aging period, insurance estimates, guarantor portion, and total account balance or credit. Te report also 
provides totals and payments for each amount. 

• Insurance Claim Aging Report – Te Insurance Claim Aging Report displays each insurance carrier with 
outstanding claims, including the insurance plan name, group plan name, insurance phone number, and 
group number, and each outstanding insurance claim. 

Te insurance claim information will include a notation of primary or secondary, the date the claim was 
sent, the date a tracer was sent, the date the claim was placed on hold, the date the claim was re-sent, 
the patient name, patient birthday, the subscriber name, subscriber ID number, the estimated insurance 
payment, and the amount billed to insurance. Te amount billed to insurance will be placed in the 
current, 31 – 60, 61 – 90, or > 180 column, based on how long ago the claim was sent and whether the 
Age Insurance Estimate instead of Total Billed fgure check box is selected. Te primary and secondary 
claim amounts will each be totaled and printed, and a combined total will appear at the bottom of the 
report. 

• Insurance Claims Not Sent Report – Te Insurance Claims Not Sent Report shows all insurance claims 
that have been created in the Ledger but not sent to the Batch Processor, printed, or sent electronically. 
Tis report includes the range of patients, providers, and carriers to be included. Te report includes the 
claim date, type of claim (primary or secondary) patient name, insurance company name, claim amount 
and expiration date. A total of the amounts for primary claims and secondary claims and a combined total 
prints at the end of the report. 

• Pre-Estimate Aging Report – Te Pre-Estimate Aging Report shows when pre-treatment estimates were 
sent to insurance carriers. You can specify the range of patients, providers, and carriers to be included. 

• Pre-Estimates Not Sent Report – Te Pre-Estimates Not Sent Report lists pre-estimates that have been 
created in the Ledger but not sent to the Batch Processor, printed, or sent electronically. Tis report 
includes the range of patients, providers, and carriers you specify. Te report includes the claim date, 
type (primary/secondary), patient name, insurance company name, amount, and expiration date. A total 
amounts for primary and secondary claims and a combined total appear at the end of the report. 
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• Procedures Not Attached To Insurance Report – Te Procedures Not Attached To Insurance Report 
shows insured patients with completed procedures that have not had an insurance claim created from 
the Ledger. Tis report includes the range of patients and providers you specify. Te report includes 
the patient name, each procedure with the date of the procedure, tooth number, procedure code and 
description, amount, and claim expiration date. Te total amount of unattached procedures is calculated 
for each patient. A grand total is provided, as well. 

• Provider Revenue Report – Te Provider Revenue Report lists credits allocated to charges that have been 
posted to each provider. 

• Secondary Insurance Claims Not Created Report – Te Secondary Insurance Claims Not Created 
Report creates a list of primary insurance claims for patients with secondary insurance claims that have 
not yet been created. Te report includes the primary claim date, patient name, secondary insurance 
company, claim account, and date the primary claim expires. Te report is sorted by the expiration date 
and indicates the total of the claims accounts. 

When primary insurance claims are evaluated for this report, they are only included if the patient had 
secondary insurance in the Family File at the time the primary insurance claim was created, and no 
secondary insurance claim was created. 

• Secondary Pre-Treatment Estimates Not Created Report – Te Secondary Pre-Treatment Estimates 
Not Created Report is a list of primary pre-treatment estimates for patients with secondary pre-treatment 
estimates that have not yet been created. Te report includes the primary pre-estimate date, patient name, 
secondary insurance company, claim account, and date the primary pre-treatment expires. Te report is 
sorted by the expiration date and indicates the total of the claims accounts. 

• Suspended Credits Report – Te Suspended Credits Report lists any payments or credits that have been 
suspended including the guarantor of the account, date and description of the credit, amount of credit 
and the amount suspended, the balance on the ledger, and the collecting clinic. 

• Utilization Report – Te Utilization Report is designed for use with managed care insurance plans. 
Te report lists all procedures that have been completed under selected insurance plans for selected date 
ranges. In addition, you can monitor co-payments versus the practice’s regular fees. 

Analysis Reports 
In DXOne Reporting, select Analysis, and then double-click an analysis report: 

• Adjustment Summary Report – With the Adjustment Summary Report, you can review the account 
adjustments applied during a date range in both a numeric and graphic format. 

• Insurance Transaction Analysis Report – Te Insurance Transaction Analysis Report displays charges 
(claims) and payments posted for a selected date range. Charges and payments are grouped by insurance 
carrier. Te report can be run for dental or medical insurance and includes an itemization of claims sent 
within the specifed range, as well as total insured charges, payments, and adjustments made for each 
carrier. 

• Payment Summary Report – With the Payment Summary Report, you can review the guarantor and 
insurance payments applied during a date range in both a numeric and graphic format. 

• Practice Analysis Report – Te Practice Analysis Report details production and receivable information as 
well as fnancial agreements and an activity analysis of the patients in your practice. 

• Production Summary Report – With the Production Summary Report, you can review production by 
procedure code categories for a date range. 

• Referral Analysis Report – Te Referral Analysis Report shows the production, number of patients, 
and percentage of totals associated with a particular referral and includes a breakdown by clinic. Use this 
report to analyze the efectiveness of your advertising dollars by running a single report. 
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List Reports 
In DXOne Reporting, select Lists, and then double-click a list report: 

• As Soon As Possible (ASAP) List – Te ASAP List shows patients that have requested an appointment 
as soon as possible. Select the providers and appointment date to be covered. Tis is useful for helping to 
keep the appointment list full in case of cancellations. Te list includes patient’s name appointment dates, 
time and status, provider, appointment reason, duration of appointment, and the patient’s phone number. 

• Birthday List – A Birthday List for a selected period can be printed with this report. You can select the 
range of patients and providers to be included and choose to print mailing labels. 

• Caries Prevalence and Periodontal Index Report – Te Caries Prevalence and Periodontal Index Report 
indicates, for various age ranges, how many patients have caries and how many do not, the number of 
patients with certain conditions, and patients’ perio measurements (for example, pocket depths and loss of 
attachment). 

• Clinical Notes Report – Te Clinical Notes Report lists clinical notes for patients. You can also print 
clinical notes from the Clinical Notes window. 

• Daily Appointment List – Te Daily Appointment List displays all appointments for a selected range 
of dates. Te report displays the following information for each appointment: date, time, status, patient’s 
name, provider and operatory, appointment reason, and appointment length, and patient’s phone 
number. 

• Document Center - Documents List Report – Te Document Center - Documents List Report displays 
the list of documents that were acquired within a specifed date range and their corresponding details. 
You can flter the list of documents to include documents that are associated with patients, providers/staf, 
referrals (inbound and outbound), insurance plans (dental and medical), and employers. 

• Initial Health History Report – Te Initial Health History Report displays the percentage of new oral 
health patients who have a First Visit Date in the Family File that is within a specifed time frame and 
who had an initial health history entered into their electronic records during the same time frame. Te 
Numerator and Denominator on the report are determined by the ADA and/or condition codes you 
specify. 

For example, you may want to track new patients who received a comprehensive oral exam (ADA code 
D0150)—the denominator code—and who have a history of smoking or tobacco use (a condition code; 
for example, 15995)—the numerator code. 

• Oral Health Education Report – Te Oral Health Education Report displays the percentage of oral 
health patients who received oral health education at least once during a specifed time frame. Te 
Numerator and Denominator on the report are determined by the ADA and/or condition codes you 
specify. 

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received oral hygiene instructions (ADA code D1330) or tobacco counseling (ADA code D1320)—the 
numerator codes. 

• Patient and Inactive Patient List – Te Patient/Inactive Patient List displays patients that have been 
entered into Dentrix Enterprise and information about each patient. You can flter the report to include 
patients with no continuing care date and no future appointments, a last visit before a specifed date, and 
a specifed status. 

• Patient Revenue List by Payer Report – Te Patient Revenue List by Payer Report displays the total 
amount of charges, payments, and adjustments that have been posted to a given patient’s record, on a 
given service date or entry date, and for a given payer. 
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• Periodontal Exam Report – Te Periodontal Exam Report displays the percentage of oral health 
patients who received a periodontal exam at least once during a specifed time frame. Te Numerator and 
Denominator on the report are determined by the ADA and/or condition codes you specify. 

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received a periodontal exam (ADA code D0180)—the numerator code. 

• Procedures by Contracted Amount Report – Te Procedures by Contracted Amount Report displays 
completed procedures (and other charges) and the payments and adjustments that are associated with 
those procedures (or charges). For each completed procedure, the contracted rate with the patient’s 
insurance carrier (payer) also appears. 

• Unscheduled Appointment List – Te Unscheduled Appointment List displays appointments that have 
been broken or marked as wait/will call. 

Audit Reports 
In DXOne Reporting, select Audit, and then double-click an audit report: 

• Audit - Appointments Report – Te Audit - Appointments Report details changes made to 
appointments. 

• Audit - Audit Log Status Report – Te Audit - Audit Log Status Report lists the changes to the “patient 
access logging” and “patient print logging” settings during the specifed date range. 

• Audit - Clinics Report – Te Audit - Clinics Report lists clinic information that has been inserted, 
modifed, and/or deleted. 

• Audit - Combined Report – Te Audit - Combined Report lists patient information that was created, 
altered, deleted, viewed, printed, and exported during the specifed date range. 

• Audit - Patients Report – Te Audit - Patients Report lists patient and medical consultation information 
that has been inserted, modifed, and/or deleted. 

• Audit - Providers and Staf Report – Te Audit - Providers/Staf Report lists provider and staf 
information that has been inserted, modifed, and/or deleted. 

• Audit - Transactions Report – Te Audit - Transaction Report lists all transaction entries that have been 
changed, deleted, or inserted. Appointment changes and limited patient changes are also included. 

• Audit Rights - Assigned Individually Report – Te Audit Rights - Assigned Individually Report lists 
any changes made to a user’s assigned password rights as well as the user who made the changes. 

• Audit Rights - Assigned to Grouips – Te Audit Rights - Assigned to Groups Report lists any changes 
made to a user group’s assigned password rights as well as the user who made the changes. 

• Audit Rights - Group Names Report – Te Audit Rights - Group Names Report lists user groups that 
were added, removed, and renamed as well as the user who made each change. 

• Audit Rights Users to Groups – Te Audit Rights - Users to Groups Report lists users who were added 
to and removed from user groups as well as the user who made each change. 

• Patient Information Accessed Report – Te Patient Information Accessed Report helps you track when 
any patient’s record has been viewed. A patient record is considered to have been viewed in the following 
situations: 

• When you select a patient in the Select Patient dialog box and then click OK. 

• When you select a patient in the Select Patient dialog box and then click More Patient Information. 

• When you double-click a patient’s appointment and then click Patient Info. 
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• When you switch from one module to another (patient-specifc modules only) with a patient selected. 
For example, if you open a patient’s Patient Chart and then switch to that patient’s Family File record, 
Dentrix Enterprise logs two entries for the report. 

• When accessing the same patient record later in the day (in the same module, at the same clinic, on 
the same date, and by the same user after a specifed number of minutes has elapsed since the last 
time that patient’s record was accessed). 

Each entry on the report provides the date and time when the patient information was accessed, the 
module from which it was accessed, the clinic from which it was accessed, the user who accessed it, and 
the name and chart number of the patient whose record it was. 

UDS Reports 
In DXOne Reporting, select Audit, and then double-click a UDS (Uniform Data System) report: 

• UDS – Age / Gender Report – Te UDS - Age/Gender Report lists the total of each gender for each age 
group. 

• UDS – Encounter and User Statistics Report – Te UDS - Encounter/User Statistics Report lists the 
number of encounters by provider and procedure code. 

• UDS – Insurance Financial Class Report (2012 and Prior) – Te UDS - Insurance Financial Class 
Report lists the total number of users per fnancial class type or self-pay (no insurance). 

• UDS – Insurance Financial Class Report (2013) – Te UDS - Insurance Financial Class Report (2013) 
lists the total number of patients who have completed procedures in their records within a specifed date 
range. 

• UDS – Medicaid/Medicare Report – Te UDS - Medicaid/Medicare Report is a new report that 
displays a count of patients with Medicaid and/or Medicare and who have had a visit within the reporting 
period. Patients are counted on the report if they have had claims created during the reporting period for 
any insurance plans that have the specifed fnancial classes attached. 

• UDS - Patient Related Revenue Report – Te UDS - Patient Related Revenue Report displays revenue 
totals for patients with procedures that were completed within a specifed date range and for which claims 
have been created. 

• UDS – Patient Status Report – Te UDS - Patient Status Report displays the total the number of 
patients who have completed procedures within a specifed date range and who have specifed statuses 
(race, language, poverty level, worker status, homeless status, sexual orientation, homeless status, veteran 
status, ethnicity, religion, user-defned, housing status, and/or gender identity) attached to their Family 
File records. Te report can also list patients on the report by ZIP Code and display patient information 
for the patients on the report. 

• UDS – Sealant Statistics Report – Te UDS - Sealant Statistics Report displays the percentage of 
children, ages 6 through 9, who are at a moderate to high risk for caries and who received a sealant on a 
permanent frst molar during the reporting period. 

• UDS – Tobacco Use and Intervention Report – Te UDS - Tobacco Use and Intervention Report 
displays the percentage of patients, ages 18 and older, who received screenings and interventions for 
cessation of tobacco use during the reporting period. 
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Custom Reports 
In DXOne Reporting, select Custom, and then double-click a custom report: 

• Visits By reports – Te Visits By reports display the number of visits to an ofce or clinic by community, 
dentist and facility, and tribal membership. All the procedure(s) for a given patient on a given day in 
the Ledger are counted as one visit. On the report, the frst visit, revisit, broken appointment, and PTC 
(planned treatment completed) values are calculated from the IHS condition codes and sometimes the 
ADA codes set up from the Ofce Manager. 

• RVU by Provider Report – Te RVU by Provider Report indicates, for each provider,  the number of 
services and RVUs (Relative Value Units) at each given level. A total of all providers is also shown at the 
bottom of the report. 

• OHSS Report – Te OHSS Report indicates, for various age ranges, how many patients have caries and 
how many do not, the number of patients with certain conditions, and patients’ perio measurements (for 
example, pocket depths and loss of attachment). 

• Dentist Activity reports – Te Dentist Activity reports display the number of patients seen by each 
provider and the types of treatment given. Also, the report displays the RVUs (relative value units) and 
RVU percentages for the treatment provided. Te values on the report are calculated using the IHS 
custom codes and ADA codes set up from the Ofce Manager. 

• Dental Hygienists Activity reports – Te Dental Hygienists Activity reports display the number of 
patients seen by each secondary provider and the types of treatment given. Also, the report displays the 
RVUs (relative value units) and RVU percentages for the treatment provided. Te values on the report are 
calculated using the IHS custom codes and ADA codes set up from the Ofce Manager. 

• Endodontic Tooth Access Report – Te Endodontic Tooth Access Report displays, for each provider, 
the number of teeth accessed, accessed and completed, accessed and extracted, accessed and restored, and 
accessed and crowned in a specifed date range. 

• Oral Health Status Report - Te Oral Health Status (OHS) Report displays OHS survey data within a 
specifed date range and can include patient details. 

Te sections that follow explain in more detail how to run these custom reports. 

Visits By reports 

1. Click the Job Name search button  if you want to select a job name from a list of available jobs and 
templates to apply the corresponding settings. You can leave the settings that are applied or change any of 
them as needed. 
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2. Set up the following options: 

• Date Range – Select Specifc Range, and then enter a date range in the From and To felds; or select 
Relative Date Range, and then select a date range. Te report uses the procedure date of Ledger 
transactions. 

Note: Using a relative date range is ideal when saving your report settings as default. Ten, you don’t 
have to manually enter a date range each time you run the report. 

• Time Zone – Select either Clinic Time to use the clinic time zone or UTC to use Coordinated 
Universal Time. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider/Staf – Click the search  button to select the providers and staf you want to include on 
the report, or select All to include all providers and staf. 

3. Select how you want to run the report: 

• Community – Te report will include visits by patients according to the community entered in the 
Current Community feld of the Addtional Info dialog box, which can be opened by clicking the 
Additional Info button in the Family File. 

Te communities will be listed on the report alphabetically; visits for patients without a community 
entered in the Family File will be given as well. 

• Facility and Dentist – Te report will include visits by patients according to the provider and clinic 
assigned to a procedure in the Ledger. 

Te dentists and clinics will be listed on the report alphabetically. 

• Tribal Mambership – Te report will include visits by patients according to the tribe entered in the 
Tribe of Membership feld of the Addtional Info dialog box, which can be opened by clicking the 
Additional Info button in the Family File. 

Te tribes will be listed on the report alphabetically; visits for patients without a tribe entered in the 
Family File will be given as well. 

4. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

5. Click OK to preview the report. 
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RVU by Provider Report 

1. Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them as 
needed. 

2. Set up the following options: 

• Date Range – Select Specifc Range, and then enter a date range in the From and To felds; or select 
Relative Date Range, and then select a date range. Te report uses the procedure date of Ledger 
transactions. 

Note: Using a relative date range is ideal when saving your report settings as default. Ten, you don’t 
have to manually enter a date range each time you run the report. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider/Staf – Click the search  button to select the providers and staf you want to include on 
the report, or select All to include all providers and staf. 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 
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VALUE UNITS BY PROVIDER 
Date Range : 8111201 O - 1 01311201 O 

Clini cs: <ALL> 

Providers: <ALL> 

Date: 11f11/2010 Report Generated By: enterprise Paqe 1 of 3 

Brown, Mary D. D.D.S. (DDS2) SERVICES RVU's 

LEVEL 0 : 30 0 

LEVEL 1: 47 376 

LEVEL 2: 44 868 

LEVEL 3 : 25 384 

LEVEL 4 : 0 0 

LEVEL 5 : 0 0 

LEVEL 9: 0 0 

T OTAL LEVEL 1-5: 116 1628 

Hayes, Sally H. Hygienist (HYG 1) SERVICES RVU"s 

LEVEL 0 : 40 0 

LEVEL 1: 35 412 

LEVEL 2 : 59 1544 

LEVEL3 : 26 356 

LEVEL 4 : 0 0 

LEVEL 5 : 0 0 

LEVEL 9 : 0 0 

T OT AL LEVEL 1-5: 120 23 12 

TOTALS: SERVICES RVU's 

LEV EL O: 70 0 

LEVEL 1: 82 788 

LEVEL 2 : 103 241 2 

LEV EL 3: 51 740 

LEVEL 4 : 0 0 

LEVEL 5 : 0 0 

LEVEL 9 : 0 0 

T OTAL LEVEL 1-5: 236 3940 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

4. Click OK to preview the report. 
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Clinic 

~ ~ All 

Survey Code 

El 
Job Name 

~ 

I Save as Defau lt 11 Clear Defaults 11 Schedule 1 1 OK 1 1 Cancel I 

» I 

» I 

» I 

OHSS Report 

1. Click the Job Name search button  if you want to select a job name from a list of available jobs and 
templates to apply the corresponding settings. You can leave the settings that are applied or change any of 
them as needed. 

2. Set up the following options: 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Survey Code – Click the search  button to select a survey code. Tese codes are supplied by the 
Department of Health (DOH). 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

4. Click OK to preview the report. 

Tis report prints on three pages with statistics for fve age groups: 

• Te age group 2 - 5 years is on the frst page. 

• Te age groups 6 - 14 years and 15 - 19 years are on the second page. 

• Te age groups 35 - 44 years and 55 years and older are on the third page. 

Be familiar with the following terms before reading this report: 

• Caries Free – No decayed, missing, or flled teeth 

• CPITN – Community Periodontal Index of Treatment Needs 

• Dmfs – Decayed, missing, or flled surfaces on primary teeth 

• DMFS – Decayed, missing, or flled surfaces on permanent teeth 

• Dmft – Decayed, missing, or flled primary teeth 

• DMFT – Decayed, missing, or flled permanent teeth 

• Dentate – Having teeth (i.e. a patient who does not have a full set of dentures) 

• Fluorosis – An abnormal condition of the tooth enamel caused by excessive exposure to fuoride 

Notes: 

• Te report considers a condition in its calculations only if that condition is marked as existing, existing 
other, or completed. Invalidated conditions are not considered. 
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Presc hoo l c h ild nm (2-5 ~ ars J: 

dmfs l dmft 

Mean dmfs for Max. Incisors & Posterior eeth 

Percent W!th history of decay otL . 
anterior teeth 

posterior teeth 

both anterior and posterior teeth 

Percent di caries history on >= 1 rna:xi llaiy mcisCM'S 
Percent W!th -caries history on >= 2 rnaxi llaiy mcisCM'S 

Percent w=tti caries history on >= 1 maxillary mcisCM'S 01 dmft >= 6 

Percent ~ dmk > 0 
maxAaiiy incisor decay only 

po51Erior decay <riy 

both posterior and incisOl decay 

Percent caries free chidren by individual ages and age cohorts 

2 Years: 

3Y~ : 
4 Years: 

5 Years: 

2-4 Years: 

3-5 Years: 

2-5 Years: 

20 112 

133.33 

66.67% 

66.67% 

66.67% 
3:,,33% 

0 .0 0% 

66.67% 

66.67% 

66.67% 

66.67% 

50.0 0% 

0 .0 0% 

0 .0 0% 

0 .0 0% 

50.0 0% 

0 .0 0% 

50.0 0% 

• Te reports is based on the procedure date. 

• Te report considers a patient in its calculations only if that patient has a valid survey code posted on the 
same date. Age group counts are based on patients that have a valid survey code posted. 

Preschool children (2-5 years) 

• dmfs – Te sum of the following: 

• Te total number of primary tooth surfaces with one or more untreated caries conditions (15104, 
15105, 15106, 15107) for every patient in this age group. 

• Te total number of primary tooth surfaces with a restorative code posted for that tooth (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) for every 
patient in this age group. 

Te maximum number of flled surfaces per tooth for codes D2930, D2932, D2933, D2934 are as 
follows: 4 surfaces for anterior teeth (c – h, m – r), and 5 surfaces for posterior teeth (a,b,i,j,k,l,s,t). 

• Te total number of primary tooth surfaces that have missing teeth conditions (15100, 15101, 15204 
– 15211) or extraction codes (D7111 – D7250) for every patient in this age group. 

Te maximum number of surfaces per tooth for missing teeth and extractions are as follows: 4 
surfaces for anterior deciduous teeth (c – h, m – r), and 5 surfaces for posterior deciduous teeth 
(a,b,i,j,k,l,s,t). 

Each patient, tooth, and surface combination is counted only once. 

• dmft – Te sum of the following: 

• Te total number of primary teeth with one or more untreated caries conditions (15104, 15105, 
15106, 15107) for every patient in this age group. 

• Te total number of primary teeth with a restorative code posted for that tooth (D1352, D2000 – 
D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) for every patient in 
this age group. 

• Te total number of primary teeth that have missing teeth conditions (15100, 15101, 15204 – 
15211) or extraction codes (D7111 – D7250) for every patient in this age group. 

Each patient and tooth combination is counted only once. If a particular patient has both a caries code as 
well as a restorative code for the same tooth, the caries code takes precedence. 
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• Mean dmfs for Max. Incisors & Posterior teeth – Te dmfs of primary maxillary incisors (c – h) and 
primary posterior teeth (a, b, i, j, k, l, s, t) for all patients in this age group divided by the number of 
patients in this age group. A surface with an untreated caries code that has been fxed later is counted only 
once. An untreated caries is a surface with an untreated caries code that has not had either a procedure 
that covers the same surface posted after the caries code was 

• Percent with history of decay on anterior and posterior teeth and both 

• History of decay on anterior teeth – Te total number of patients with a caries code (15104, 
15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, D2000 
– D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on any primary 
anterior tooth (c – h, m – r) divided by the total number of patients in this age group. 

Each patient is counted only once. 

• History of decay on posterior teeth – Te total number of patients with a caries code (15104, 
15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, D2000 
– D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on any primary 
posterior tooth (a, b, i, j, k, l, s, t) divided by the total number of patients in this age group. 

Each patient is counted only once. 

• History of decay on both anterior and posterior teeth – Te total number of patients with a caries 
code (15104, 15105, 15106, or 15107), a missing due to caries code (15204), or restorative code 
(D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) 
on any primary anterior tooth (c – h, m – r) and on any primary posterior tooth (a, b, i, j, k, l, s, t) 
divided by the total number of patients in this age group. 

Each patient is counted only once. 

• Percent with caries history on ≥ 1 maxillary incisors – Te total number of patients with a caries code 
(15104, 15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on one or more 
primary maxillary incisors (c – h) divided by the total number of patients in this age group. 

Each patient is counted only once. 

• Percent with caries history on ≥ 2 maxillary incisors – Te total number of patients with a caries code 
(15104, 15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on two or more 
primary maxillary incisors (c – h) divided by the total number of patients in this age group. 

• Percent with caries history on ≥ 1 maxillary incisors OR dmft ≥ 6 (severe ECC) – Te total number 
of patients with either of the following: a caries code (15104, 15105, 15106, or 15107), a missing due to 
caries code (15204), or restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, 
D6100, D6199 – D7259, D7999) on primary maxillary incisors; or a dmft ≥ 6 divided by the total 
number of patients in this age group. 

Each patient is counted only once. 

• Percent caries free children by individual ages and age cohorts – For each age group (2, 3, 4, 5, 2 – 4, 
3 – 5, 2 – 5), the total number of patients without caries conditions (15104, 15105, 15106, 15107), 
restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, 
D7999), missing teeth conditions (15100, 15101, 15204-15211) or extraction codes (D7111-D7250) 
posted on any primary teeth. 
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Ages &-14 Years: 

<--Percent Carie-5 Free-> eroent wi 
pm, & Penn Perm Teeth Untreated Oeca)' Untreated Decay Using Tobacco Dental Sealants Sealants Sealants 2nd Sealants 1st Mean i of Mean 

T~th Onl:.: Pm! & Perm teeth Penn tee-th Ruorosis 1st Molar molar or 2nd Molar sealed teeth dmfl / DMFT 

6 Yie-ars: 0 .00 0.00 100.00 100.00 0.00 100.00 100.00 100.00 100.00 100.00 1.00 0.00 18 .00 

7 Yie-ars: 0 .00 0.00 0.00 0 .00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10 .00 
8 Ye,.ar.;: 0 .00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10.00 

9 Ye.ars: 100.00 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10.00 
ID Years: 0.00 0.00 100.00 100.00 0.00 100.00 100.00 100.00 100.00 100.00 1.00 0.00 12.00 
11 Years: 100.00 100.00 0.00 0 .00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10.00 
12 Yie-ars: 100.00 100.00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0 .00 0.00 0.00 10 .00 
13 Yie-ars: 100.00 100.00 0.00 0 .00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10 .00 
14 Years: 100.00 100.00 0.00 0 .00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 10 .00 

6..e: Years: 0 .00 0.00 100.00 100.00 0.00 100.00 100.00 100.00 100.00 100.00 1.00 0.00 18 .00 

9- 11 Years: 80.00 80.00 20.00 20.00 0.00 20.00 20.00 20.00 20.00 20.00 0.20 0.00 I 0.40 
12-14 Years: 100.00 100 .00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0 .00 0.00 0.00 I 0.00 

6- 14 Years: 86.67 86.67 13.33 13.33 46.67 13.33 13.33 13.33 13.33 13.33 0.13 0.00 I 0.67 

• Percent with dmfs > 0 

• Maxillary incisor decay only – Te total number of patients with a caries code (15104, 15105, 
15106, or 15107) on any primary maxillary incisor (c – h) divided by the number of patients in this 
age group. 

Each patient is counted only once. 

• Posterior decay only – Te total number of patients with a caries code (15104, 15105, 15106, or 
15107) on any primary posterior tooth (a, b, i, j, k, l, s, t) divided by the number of patients in this 
age group. 

Each patient is counted only once. 

• Posterior and incisor decay – Te total number of patients with a caries code (15104, 15105, 
15106, or 15107) on any primary posterior tooth (a,b,i,j,k,l,s,t) or primary maxillary incisor (c – h, 
m – r). 

Each patient is counted only once. 

Ages 6-14 Years 

• Percent Caries Free – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 
6 – 14), the following percentages appear: 

• Primary & Permanent Teeth – Te total number of patients without caries conditions (15104, 
15105, 15106, 15107), restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – 
D6079, D6100, D6199 – D7259, D7999), missing teeth conditions (15100, 15101, 15204-15211) 
or extraction codes (D7111-D7250) posted on any primary (a – t) and permanent teeth (2 – 15, 18 
– 31) divided by the number of patients in the age group. 

Each patient is counted only once. 

• Permanent Teeth Only – Te total number of patients without caries conditions (15104, 15105, 
15106, 15107), restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, 
D6100, D6199 – D7259, D7999), missing teeth conditions (15100, 15101, 15204-15211) or 
extraction codes (D7111-D7250) posted on any permanent teeth (2 – 15, 18 – 31) divided by the 
number of patients in the age group. 

Each patient is counted only once. 
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• Percent with  – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 6 – 14), 
the following percentages appear: 

• Untreated Decay Primary & Permanent Teeth – Te total number of patients that have a caries 
condition (15104, 15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, 
D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for 
both for primary and permanent teeth in the age group divided by the number of patients in the age 
group. 

Each patient is counted only once. 

• Untreated Decay Permanent Teeth – Te total number of patients with a caries condition (15104, 
15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 
– D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for permanent teeth in the 
age group divided by the number of patients in the age group. 

Each patient is counted only once. 

• Using Tobacco – Te total number of patients with a condition code 15203 Tobacco Use in the age 
group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Dental Fluorosis – Te total number of patients with a condition code 15200 Dental Fluorosis in 
the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Sealants – Te total number of patients with a sealant code (D1351) divided by the number of 
patients in the age group. 

Each patient is counted only once. 

• Sealants on 1st Molars – Te number of patients with a sealant code (D1351) on tooth numbers 3, 
14, 19, or 30 in the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Sealants on 2nd Molars – Te total number of patients with a sealant code (D1351) on tooth 
numbers 2, 15, 18, or 31 in the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Percent with Sealants 1st or 2nd Molars – Te total number of patients with a sealant code 
(D1351) on tooth numbers 2, 3, 14, 15, 18, 19, 30, or 31 in the age group divided by the total 
number of patients in the age group. 

Each patient is counted only once. 

• Mean Number of Sealed Teeth – Te total number of teeth with a sealant code (D1351) for patients 
in the age group divided by the total number of patients in that age group. 

Each patient is counted only once. 

• Mean dmft/DMFT – Te dmft/DMFT of primary/permanent teeth for all patients in the age group 
divided by the total number of patients in the age group. 

Each patient and tooth combination is counted only once. If a particular patient has both a caries 
code as well as a restorative code for the same tooth, the caries code takes precedence. 
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Ages 1 5-1 9 Years : 

< eroent wi · 

Caries. Free Untreated Decay Using Tob-acco Dental Sealants Sealants Seaiants 2nd Seaiants 1st Mean# of 
Prim & Penn teeth Prim & Pemi teeth Fluorosis. 1st Molar mola, or 2nd Molar sealed teeth 

15 Ye-ars:: 02.31 7 .69 7.69 7 .69 7 .69 7-69 7.69 7.69 0118 
16Years.:: 100.00 0 .00 0.00 0 .00 0.00 0.00 0.00 0.00 0110 
17 Years: 96.67 3 .33 3.33 3.33 3.33 3.33 3.33 3.33 0113 
18Y~ 96.00 4 .00 4.00 4 .00 4 .00 4.00 4.00 4 .00 0114 
19Ye-ars:: 96.15 3 .85 3.85 3.85 3 .85 3.85 3.85 3 .85 0114 

<---------------------t',ercent wnr· ,_ _ _________________ _, 

15 Years.: 
16 Years: 
17 Years: 
18 Years.: 

19Years:: 

Perio Pockets 
< 4mm 

0.00 
0.00 
3.33 
4.00 
3.85 

Per cent wilh Hfghe-st CPITN of 0 , 1 ,2 ,3 ,4 

Peria Pocl:en. 
>= 4mm & < 6mm 

0.00 
0.00 
3.33 
4.00 
0.00 

CPITN 
4 

3 
2 
1 

0 

Perio Pockets 
>= 6mm 

Percent 
1.77 
0.00 

0.88 
0 .00 

0 .00 

0 .00 
0.00 
3.33 
4 .00 
0 .00 

l oss of Attadvnent 
< 3mm 

0.00 
0.00 
3.33 
4 .00 
3.85 

Loss of Attachment 
>= 3mm and < 5mm 

0.00 
0.00 
3.33 
4 .00 
3.85 

loss of Attachment 
>,= !fflm 

0.00 
0.00 
3.33 
4.00 
0.00 

Me.311DMFT 

0 .38 
0 .00 
0 .1 3 
0 .16 
0 .12 

Ages 15-19 Years 

• Percent with – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 6 – 14), 
the following percentages appear: 

• Untreated Decay Primary & Permanent Teeth – Te total number of patients that have a caries 
condition (15104, 15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, 
D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for 
both for primary and permanent teeth in the age group divided by the number of patients in the age 
group. 

Each patient is counted only once. 

• Untreated Decay Permanent Teeth – Te total number of patients with a caries condition (15104, 
15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 
– D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for permanent teeth in the 
age group divided by the number of patients in the age group. 

Each patient is counted only once. 

• Using Tobacco – Te total number of patients with a condition code 15203 Tobacco Use in the age 
group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Dental Fluorosis – Te total number of patients with a condition code 15200 Dental Fluorosis in 
the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Sealants – Te total number of patients with a sealant code (D1351) divided by the number of 
patients in the age group. 

Each patient is counted only once. 

• Sealants on 1st Molars – Te number of patients with a sealant code (D1351) on tooth numbers 3, 
14, 19, or 30 in the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 

• Sealants on 2nd Molars – Te total number of patients with a sealant code (D1351) on tooth 
numbers 2, 15, 18, or 31 in the age group divided by the total number of patients in the age group. 

Each patient is counted only once. 
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• Percent with Sealants 1st or 2nd Molars – Te total number of patients with a sealant code 
(D1351) on tooth numbers 2, 3, 14, 15, 18, 19, 30, or 31 in the age group divided by the total 
number of patients in the age group. 

Each patient is counted only once. 

• Mean Number of Sealed Teeth – Te total number of teeth with a sealant code (D1351) for patients 
in the age group divided by the total number of patients in that age group. 

Each patient is counted only once. 

• Mean DMFT – Te DMFT of permanent teeth for all patients in the age group divided by the total 
number of patients in the age group. 

Each patient and tooth combination is counted only once. If a particular patient has both a caries 
code as well as a restorative code for the same tooth, the caries code takes precedence. 

• Perio Pockets < 4 mm – Te total number of patients with a probing depth (PD or Pocket Depth) 
less than 4 mm for any tooth in the age group divided by the total number of patients in the age 
group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Perio Pockets ≥ 4 mm and < 6 mm – Te total number of patients with a probing depth (PD or 
Pocket Depth) greater or equal to 4 mm and less than 6 mm for any tooth in the age group divided 
by the total number of patients in the age group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Perio Pockets > 3 mm and < 6 mm – Te total number of patients with a probing depth (PD or 
Pocket Depth) greater than 3 mm and less than 6 mm for any tooth in the age group divided by the 
total number of patients in the age group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Perio Pockets ≥ 6 mm – Te total number of patients with a probing depth (PD or Pocket Depth) 
for any tooth higher than 6 mm in the age group divided by the total number of patients in the age 
group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Loss of Attachment < 3 mm – Te total number of patients with a clinical attachment level of less 
than 3 mm in the age group divided by the total number of patients in the age group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Loss of Attachment ≥ 3 and < 5 mm – Te total number of patients with a clinical attachment level 
greater than or equal to 3 mm and less than 5 mm in the age group divided by the total number of 
patients in the age group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 

• Loss of Attachment ≥ 5 mm – Te total number of patients with a clinical attachment level greater 
than or equal to 5 mm in the age group divided by the total number of patients in the age group. 

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted. 
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Ages 3-5-44 & 55+ Years: 

eroent wi 

Caries Free Untreated Decay Using Tobacco Oental 
Prim & Penn teeth Prim & Penn teeth Fluorosis 

35 Years: 100.00 0.00 0.00 0.00 
36 Years: 100.00 0.00 0.00 0.00 
37 Years: 100.00 0.00 0.00 0 .00 

38 Ye-a.rs: 98.04 0.00 1.96 t.96 
JflYears: 100.00 0.00 0.00 0.00 

40 Years: 117.78 2.22 2.22 2.22 
41 Years: 100.00 0.00 0.00 0 .00 

42 Ye-a.rs: 100.00 0.00 0.00 0 .00 
43 Y~ : 100.00 0.00 0 .00 0.00 
44 Years: 100.00 0.00 0.00 0.00 

55 Years: 1,600.00 127 t.27 0.00 

<-Percent with Perio Poc:k.,e,ts- --> <- -Percent with loss of Attachment- > 

< 4mm 
>= 4 

and < 6nvn 

35 Y,e,ars: 0.00 0.00 
36 Years: 0.00 0.00 
37 Years: 0.00 0.00 
38 Years: U!6 t.Q6 

3~ Years: 0.00 0.00 
40 Years: 2.22 2.22 
4 1 Years: 0.00 0.00 
42 Years: 0.00 0.00 
43 Years: 0.00 0.00 
44 Years: 0.00 0.00 
55 Years: 1.27 1.27 

Ag es 3-5-44 Years: 

Percent with Highest CPITN of D, 1,2.3,4 

>= 6mm 

0.00 
0.00 
0.00 
t.Q6 

0.00 
2.22 
0.00 
0.00 
0.00 
0.00 
1.27 

CPITN 
4 

3 

2 
1 
0 

< 3mm 

0.00 

0.00 
0.00 
1.96 

0.00 

2.22 
0.00 

0.00 
0.00 

0.00 

1.27 

>= 3mm 
and < 5mm 

0.00 

0.00 
0.00 
t.96 

0.00 

2.22 
0.00 

0.00 
0.00 

0.00 

t.27 

Percen·t 
0 .52 

0 .00 

0 .00 
0 .00 

0 .00 

>= 5mm 

0 .00 

0 .00 
0 .00 
1.116 
0 .00 
2 .22 
0 .00 
0 .00 
0 .00 
0 .00 

1.27 

Sealants Sealants Sealants 2nd Sealants 1st Mean # of Mea DMFT 
1st Molar molar or 2nd Molar sealed teeth 

0.00 0.00 0.00 0.00 0 .00 0 .00 
0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0 .00 o.oa 
0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0.00 0.22 
0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0.00 0 .00 
0.00 0.00 0.00 0.00 0.00 0 .00 

0.00 0.00 0.00 0.00 0.00 0 .10 

ercent with Pert:Efl,1 of Dentate Adults with 

Diabetes 
Ne-ed All 2B 20+ No Natural Untreated Root 

Bi21?,!X Te,;th Tee Teeth 0 ~ Caries 

0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 0 .00 100.00 100.00 0.00 0 .00 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 1.96 100.00 100.00 0.00 0 .00 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
2.22 2.22 Q7.78 100.00 0.00 2 .22 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 0.00 100.00 100.00 0.00 0 .00 0.00 
0.00 0 .00 1,600.00 1,60 1.27 0.00 1.27 0.00 

Ages 55+ Years: 

Percent with Highest CPIT N of 0, 1,2.3,4 CPITN 
4 

Percent 
D.15 

0.00 

0.00 
0.00 

0.00 

3 

• Percent with Highest CPITN of 0, 1, 2, 3, 4 – For each category, the percentage of patients in the 
age groupe that fall into that category divided by the total number of patients in theage group. Which 
category a patient corresponds to comes from his or her perio exam, using the following criteria: 

• A patient with a probing depth (PD or Pocket Depth) for any tooth higher than 6 mm pertain to 
category 4. 

• A patient with a probing depth (PD or Pocket Depth) for any tooth of 4 – 6 mm pertain to category 
3. 

• A patient marked as having only calculus (not set to “0 – None”) and a probing depth (PD or Pocket 
Depth) less than 4 mm for any tooth pertain to category 2. 

• A patient marked as having only bleeding for any tooth pertain to category 1. 

• Any remaining patients pertain to category 0. 

To be included, a patient must have a perio exam on the same date the selected survey code for the report 
was posted. 

Ages 35-44 & 55+ Years 

Tis section has the same columns as for 15 – 19 year olds plus the following: 

• Percent with diabetes – Te total number of patients with a code 15201 Diabetes in the age group 
divided by the number of patients in the age group for the report. 

Each patient is counted only once. 

• Percent need biopsy – Te total number of patients with the code 15202 Needs Biopsy or biopsy code 
(D7255 – D7258) in the age group divided by the number of patients in the age group. 

Each patient is counted only once. 
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• Percent with all 28 teeth – Te total number of patients without extractions (existing, existing other, or 
completed) or with extraction codes (D7111 – D7250) for teeth other than wisdom teeth (1, 16, 17, 32), 
and without condition codes (15100 Missing Tooth > 1 year or 15101 Missing tooth) in the age group 
divided by the number of patients in the age group. 

Each patient is counted only once. 

• Percent with 20 or more teeth – Te total number of patients with 8 or less missing teeth (not counting 
wisdom teeth) in the age group divided by the number of patients in the age group. A missing tooth 
(15100, 15101) can be posted as an extraction, a condition, or an existing/existing other code. 

Each patient is counted only once. 

• Percent with no natural teeth – Te total number of patients missing all 32 teeth int he age group 
divided by the number of patients in the age group. A missing tooth (15100, 15101) can be posted as an 
extraction, a condition, or an existing/existing other code. 

Each patient is counted only once. 

• Percent of dentate adults with untreated decay – Te total number of patients who do not have the 
denture codes D5110 and D5120 posted and have untreated decay (any condition code 15104 – 15107) 
in the age group divided by the number or patients in the age group. 

Each patient is counted only once. All teeth are considered. 

• Percent of dentate adults with root caries – Te total number of patients who have the deep dentinal/ 
cemental caries condition code 15104 posted in the age groupg divided by the number of patients in the 
age group. 

Each patient is counted only once. All teeth are considered. 

Dentist Activity reports 

1. Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them as 
needed. 

2. Set up the following options: 

• Time Periods – Select any of the following to indicate the time periods for which you want to run 
the report: 

• Monthly – Select a month, and then enter a year. Te number of services and the RVUs for the 
selected month of the specifed year will appear on the report. 

• Quarterly – Select a quarter, and then enter a year. Te number of services and the RVUs for 
each month of the selected quarter for the specifed year will appear on the report. 
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• Yearly – Enter a year. Te number of services and the RVUs for each quarter of the specifed year 
will appear on the report. 

Each selected item will produce a separate report. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider – Click the search  button to select the providers you want to include on the report, or 
select All to include all providers. 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

4. Click OK to preview the report. 

Each report provides the following details for the specifed time period: 

• Services – MTD / Month 1, Month 2, Month 3 / QTR 1, QTR 2, QTR 3, QTR 4 

• For each provider listed, services performed by that provider are listed under the corresponding 
procedure code categories. 

• For each service, the number of times that service was performed is given. 

• For each procedure code category, the number of times all listed services in that category were 
performed is given. 

• For each provider, the number of times all listed services in all listed categories were performed is 
given. 

• RVUs 

• For each provider listed, services performed by that provider are listed under the corresponding 
procedure code categories. 

• For each service, the number of RVUs is given. 

• For each procedure code category, the number of RVUs for all listed services in that category is given. 

• For each provider, the number of RVUs for all listed services in all listed categories is given. 

• Percent RVUs 

For each provider listed, the RVU percentage for a procedure code category and for all procedure code 
categories are given: 

• For each procedure code category, the RVU percentage for all listed services in that category is 
calculated by dividing the number of RVUs in that category by the total number of RVUs for all 
categories with services performed by that provider. 

• For each provider, the RVU percentage will always equal 100% (it is the sum of the RVU percentages 
of each category for that provider). 



390     Chapter 9: DXOne Reporting 

Dentrix Enterprise 11.0.2 User’s Guide

Monthly Report for period beqinninq Nov 2010 
Clinics: <ALL> 

11/11/2010 1240:51 PM 

Series Total Seivices 

Percent 
MTD RVUs RVUs 

Robb,David 
Persons Served 
Diagnostic 
D0120 1 25 
D0210 1 60 
Sub-Total 2 85 5.79% 

Oral Surgery 
D7140 500 
Sub-Total 500 34.06% 

Prosth, remov 
D5120 828 
Sub-Total 828 56.40% 

Restorative 
D2140 55 
Sub-Total 55 3.75% 

Total 5 1,468 I OD.OD% 

Smith,Dennis 
Persons Served 
Diagnostic 
D0120 2 50 
D0210 1 50 
Sub-Total 3 1 DO 4.00% 

Oral Surgery 
D7230 400 
Sub-Total 400 16.00% 

Prosth, remov 
D5110 2,000 
Sub-Total 2,000 80.00% 

Restorative 
D2140 0 
Sub-Total 0 0.00% 
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Quarterly Report for period beqinninq Oct 2010 
Clinics: <ALL> 

11 / 11/2010 124347PM 

Series T otal Seivices 

Month Month Month Percent 
1 2 3 RVUs RVUs 

Robb,Davi!I 
Persons Served 
Diagnosti c 
D0120 1 1 1 25 
D0210 1 1 1 60 
Sub-Total 2 2 2 85 5.79% 

Oral Surgery 
D7140 1 1 500 
Sub-Total 1 1 500 34 .06% 

Prosth, remov 
D5120 1 1 828 
Sub-Total 1 1 828 56.40% 

Restorative 
D2140 1 1 55 
Sub-Total 1 1 55 3.75% 

Total 5 5 5 1,468 100.00% 

Smith,Dennis 
Persons Served 
Diagnostic 
D0120 2 2 2 50 
D0210 1 1 1 50 
Sub-Total 3 3 3 100 4.00% 

Oral Surgery 
D7230 1 1 1 400 
Sub-Total 1 1 1 400 16.00% 

Prosth, remov 
D5110 1 1 1 2,000 
Sub-Total 1 1 1 2,000 80.00% 

Restorative 
D2140 1 1 1 0 
Sub-Total 1 1 1 0 0.00% 

Total 6 6 6 2,500 100.00% 
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Yearly Report for period beqinninq 2010 
Clinics: <ALL> 

11 /11/2010 1245:54PM 

Series Total Seivices 

QTR QTR QTR QTR Percent 
1 2 3 4 RVUs RVUs 

Robb,Davi!I 
Persons Served 
Diagnostic 
D0120 1 1 1 1 25 
D0210 1 1 1 1 60 
Sub-Total 2 2 2 2 85 5.79% 

Oral Surgery 
D7140 500 
Sub-Total 500 34.06% 

Prosth, remov 
D5120 828 
Sub-Total 828 56.40% 

Restorative 
D2140 55 
Sub-Total 55 375% 

Total 5 5 5 5 1,468 100.00% 

Smith,Dennis 
Persons Served 
Diagnostic 
D0120 2 2 2 2 50 
D0210 1 1 1 1 50 
Sub-Total 3 3 3 3 100 4.00% 

Oral Surgery 
D7230 400 
Sub-Total 400 16.00% 

Prosth, remov 
D5110 2,000 
Sub-Total 2,000 80.00% 

Restorative 
D2140 0 
Sub-Total 0 0.00% 

Total 6 6 6 6 2,500 1 OD.OD% 



Chapter 9: DXOne Reporting    393 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

~ Dental Hygienists Act,vrty Report X 
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Dental Hygienists Activity reports 

1. Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them as 
needed. 

2. Set up the following options: 

• Time Periods – Select any of the following to indicate the time periods for which you want to run 
the report: 

• Monthly – Select a month, and then enter a year. Te number of services and the RVUs for the 
selected month of the specifed year will appear on the report. 

• Quarterly – Select a quarter, and then enter a year. Te number of services and the RVUs for 
each month of the selected quarter for the specifed year will appear on the report. 

• Yearly – Enter a year. Te number of services and the RVUs for each quarter of the specifed year 
will appear on the report. 

Each selected item will produce a separate report. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider – Click the search  button to select the providers you want to include on the report, or 
select All to include all providers. 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

4. Click OK to preview the report. 

Each report provides the following details for the specifed time period: 

• Services – MTD / Month 1, Month 2, Month 3 / QTR 1, QTR 2, QTR 3, QTR 4 

• For each secondary provider listed, services performed by that provider are listed under the 
corresponding procedure code categories. 

• For each service, the number of times that service was performed is given. 

• For each procedure code category, the number of times all listed services in that category were 
performed is given. 

• For each secondary provider, the number of times all listed services in all listed categories were 
performed is given. 
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Hyqienists Monthly Activity Report for period beqinninq Nov 2010 
Clinics: <ALL> 

11/11/2010 12 5315PM 

Series Total Seivices 

Percent 
MTD RVUs RVUs 

Hayes,Sally 
Persons Served 
Diagnostic 
D0180 40 
Sub-Total 40 28.57% 

Periodontics 
D4910 70 
Sub-Total 70 5000% 

Preventive 
D1330 30 
Sub-Total 30 21.43% 

Total 3 140 I 00 .00% 

McClure,Angela 
Persons Served 
Diagnostic 
D0140 35 
Sub-Total 35 26.12% 

Periodontics 
D4910 78 
Sub-Total 78 58.21 % 

Preventive 
D1204 21 
Sub-Total 21 15.67% 

Total 3 134 I 00.00% 

• RVUs 

• For each secondary provider listed, services performed by that provider are listed under the 
corresponding procedure code categories. 

• For each service, the number of RVUs is given. 

• For each procedure code category, the number of RVUs for all listed services in that category is given. 

• For each secondary provider, the number of RVUs for all listed services in all listed categories is given. 

• Percent RVUs 

For each provider listed, the RVU percentage for a procedure code category and for all procedure code 
categories are given: 

• For each procedure code category, the RVU percentage for all listed services in that category is 
calculated by dividing the number of RVUs in that category by the total number of RVUs for all 
categories with services performed by that provider. 

• For each secondary provider, the RVU percentage will always equal 100% (it is the sum of the RVU 
percentages of each category for that provider). 
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Hyqienists/Dental Auxiliary Quarterly Activity Report for period beqinninq Oct 2010 
Clinics: <ALL> 

11 /11/2010 12 58:06PM 

Series Total Seivices 

Month Month Month Percent 
1 2 3 RVUs RVUs 

Hayes,Sally 
Persons Served 
Diagnostic 
D0180 1 1 40 
Sub-Total 1 1 40 28.57% 

Periodontics 
D4910 1 1 70 
Sub-Total 1 1 70 50.00% 

Preventive 
D1330 1 1 30 
Sub-Total 1 1 30 21.43% 

Total 3 3 3 140 100.00% 

McClure,Angela 
Persons Served 
Diagnostic 
D0140 1 35 
Sub-Total 1 35 26.12% 

Periodontics 
D4910 1 78 
Sub-Total 1 78 58.21 % 

Preventive 
D1204 1 21 
Sub-Total 1 21 15.67% 

Total 3 3 3 134 1 OD.OD% 



396     Chapter 9: DXOne Reporting 

Dentrix Enterprise 11.0.2 User’s Guide

Hyqienists/Dental Auxiliary Yearly Activity Report for period beqinninq 2010 
Clinics <ALL> 

11/11/2010125935PM 

Series Tota l Services 

QTR QTR QTR QTR Percent 
1 2 3 4 RVUs RVUs 

Hayes,Sally 
Persons Served 
Diagnostic 
D0180 40 
Sub-Total 40 28.57% 

Periodontics 
D4910 70 
Sub-Total 70 50.00% 

Preventive 
D1330 30 
Sub-Total 30 21.43% 

Total 3 3 3 3 140 1 DO.DO% 

McClure,Angela 
Persons Served 
Diagnostic 
D0140 35 
Sub-Total 35 26.12% 

Periodontics 
D4910 78 
Sub-Total 78 58.21 % 

Preventive 
D1204 21 
Sub-Total 21 15.67% 

Total 3 3 3 3 134 100.00% 
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Endodontic Tooth Access Report 

1. Click the Job Name search button  if you want to select a job name from a list of available jobs and 
templates to apply the corresponding settings. You can leave the settings that are applied or change any of 
them as needed. 

2. Set up the following options: 

• Date Range – Select Specifc Range, and then enter a date range in the From and To felds; or select 
Relative Date Range, and then select a date range. Te report uses the procedure date of Ledger 
transactions. 

Note: Using a relative date range is ideal when saving your report settings as default. Ten, you don’t 
have to manually enter a date range each time you run the report. 

• Time Zone – Select either Clinic Time to use the clinic time zone or UTC to use Coordinated 
Universal Time. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider/Staf – Click the search  button to select the providers and staf you want to include on 
the report, or select All to include all providers and staf. 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 

4. Click OK to preview the report. 

Te report provides the following details for the specifed time period: 

• For each provider, the tooth categories are listed: anterior teeth for teeth 6 – 11, 22 – 27; frst molars for 
teeth 3, 14, 19, 30; other molars for teeth 1, 2, 15 – 18, 31, 32; and premolars for teeth 4, 5, 12, 13, 20, 
21, 28, 29. 

• For each tooth category, the following statistics are given: 

• Total Accessed – Te number of teeth on which a pulpal debridement has been performed. A tooth 
is counted as accessed if the ADA code D3221 has been posted on that tooth. 
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Endodontic Tooth Access 
All Sites 

08/0112010 - 1013112010 
Date 11 /1112010 Paqe 1 of2 

Tooth Total Accessed 
Cateqory Accessed Completed Extracted Restored Crowned 

Bri11ht, Sallv 

Anteriors 10 10 10 10 10 
First Molars 10 10 10 10 10 
Other Molars 8 8 8 8 8 
Premolars 31 31 31 31 31 

Brown, Marv 
Anteriors 10 10 10 10 10 
First Molars 10 10 10 10 10 
Other Molars 8 8 8 8 8 
Premolars 31 31 31 31 31 

Erickson. Tracv 
Anteriors 10 10 10 10 10 
First Molars 10 10 10 10 10 
Other Molars 8 8 8 8 8 
Premolars 31 31 31 31 31 

• Accessed Completed – Te number of teeth on which a pulpal dedridement and endodontic therapy 
have been performed. A tooth is counted as accessed and completed if the ADA code D3221 and any 
of the following ADA codes have been posted on that tooth: D3310, D3320, or D3330. 

• Extracted – Te number of teeth on which a pulpal debridement and an extraction have been 
performed. A tooth is counted as accessed and extracted if the ADA code D3221 and any of the 
following ADA extraction codes have been posted on that tooth: D7111, D7140, D7210, D7220, 
D7230, D7240, D7241, D7250. 

• Restored – Te number of teeth on which a pulpal debridement and a restoration have been 
performed. A tooth is counted as accessed and restored if the ADA code D3221 and any restorative 
ADA code that is not a crown procedure included under “Accessed plus Crowned” have been posted 
on that tooth. 

• Crowned – Te number of teeth on which a pulpal debridement and a crown placement has been 
performed. A tooth is counted as accessed and crowned if the ADA code D3221 and any of the 
following ADA codes have been posted on that tooth: D2390, D2710, D2720, D2721, D2722, 
D2740, D2750, D2751, D2752, D2790, D2791, D2792, D2794, D2799, D6058, D6059, D6060, 
D6061, D6062, D6063, D6064, D6094, D6710, D6720, D6721, D6722, D6740, D6750, D6751, 
D6752, D6790, D6791, D6792, D6794, or D6793. 

Example scenarios 

Te following examples explain a few ways tooth counts are calculated for the columns on the report: 

• Te date range of the report is February 1 through February 28. A provider has performed a D3221 on 
tooth 11 on the 2nd and then extracted that same tooth on the 20th. On the report, tooth 11 will be 
counted once in the Total Accessed column and once in the Extracted column. 

• Te date range of the report is February 1 through February 20. A provider has performed a D3221 
on tooth 11 on the 2nd and then a performed a D3310 on the same tooth on the 27th. On the report, 
tooth 11 will be counted once in the Total Accessed column but not in the Accessed Completed column 
because the D3310 code was posted outside of the date range of the report. 
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Date Range □ OHS Status Clinic Group By 
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Current Day El ,/ All 

Age Other Options 

□ Diabetes El ~ All New Page For Each Clinic 

□ Excel Friendly 

El ,/ All 
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□ Dry Mouth 
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El 
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,/ All 

I Save as Defau lt 11 Clear Defaults I I Schedule OK 
1 1 

Cancel 

» I 

• Te date range of the report is February 1 through February 20. Provider #1 has performed a D3221 on 
tooth 11 on the 2nd, and then Provider #2 performed a D3310 on the same tooth on the 20th. On the 
report, the D3221 will be counted once in the Total Accessed column for Provider #1, and the D3310 
will be counted once in the Accesed Completed column for Provider #2. 

Oral Health Status Report 

1. Select any of the following: 

• OHS Status – To have the report include patients with a completed OHS survey that has one of 
the OHS statuses that you specify for the report, select the OHS Status check box. Click the search 
button  to select the desired OHS statuses, or select the All check box to include all OHS statuses. 
To not flter the report by OHS status, clear the OHS Status check box. 

Note: OHS class 5 and 6 are calculated based on the date that you generate the report. 

• Caries Risk – To have the report include patients with a completed OHS survey that has one of the 
caries risk levels that you specify for the report, select the Caries Risk check box. Click the search 
button  to select the desired caries risk levels, or select the All check box to include all caries risk 
levels. To not flter the report by caries risk level, clear the Caries Risk check box. 

• Tobacco Use – To have the report include patients with a completed OHS survey that has one of 
the tobacco uses that you specify for the report, select the Tobacco Use check box. Click the search 
button  to select the desired tobacco uses, or select the All check box to include all tobacco uses. 
To not flter the report by tobacco use, clear the Tobacco Use check box. 

• Diabetes – To have the report include patients with a completed OHS survey that has one of the 
types of diabetes that you specify for the report, select the Diabetes check box. Click the search 
button  to select the desired types of diabetes, or select the All check box to include all types of 
diabetes. To not flter the report by type of diabetes, clear the Diabetes check box. 

• Dry Mouth – To have the report include patients with a completed OHS survey that has one of the 
dry mouth descriptions that you specify for the report, select the Dry Mouth check box. Click the 
search button  to select the desired dry mouth descriptions, or select the All check box to include 
all dry mouth descriptions. To not flter the report by dry mouth description, clear the Dry Mouth 
check box. 
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Notes: 

• If all these check boxes are clear, the report will include patients with a completed OHS survey within 
the selected date range (in the OHS 1–6 columns) and patients who do not have a completed OHS 
survey (in the NO OHS column). 

• If at least one of these check boxes is selected, the report will include patients with a completed OHS 
survey within the selected date range and who meet the specifed flter criteria. Te report will not 
include patients who do not have a completed OHS survey (the NO OHS column will not appear on 
the report). 

2. Set up the following options: 

• Date Range – Select Specifc Range, and then enter a date range in the From and To felds; or select 
Relative Date Range, and then select a date range. 

• Clinic – Click the search button  to select the clinics you want to include on the report, or select 
All to include all clinics. 

• Provider – Click the search button  to select the providers you want to include on the report, or 
select All to include all providers. 

• Age – Click the search button  to select the ages you want to include on the report, or select All to 
include all ages. 

• Patient Tag – To have the report include patients with certain tags assigned to them, select the Run 
By Patient Tag check box; and then, click the search button  to select the desired patient tags, or 
select the All check box to include patients with any patient tag. To not flter the report by a patient 
tag, clear the Run By Patient Tag check box. 

• Group By – Select one of the following options: 

• No Group By – For no grouping. Te summary report will be generated. Te overall total 
numbers of patients will be displayed. 

• Clinic – To group the report by clinic. Select the Provider check box to group by provider within 
each clinic grouping. Each provider is listed with totals related to the clinic grouping. 

• Provider – To group the report by provider. Select the Clinic check box to group by clinic within 
each provider grouping. Each clinic is listed with totals related to the provider grouping. 

• Other Options – Select any additional flters for the report: 

• New Page For Each Clinic – To have each clinic appear on a separate page. Tis option is 
available only if the Clinic option under Group By is selected. 

• Excel Friendly (Includes All Patient & OHS Data) – To view the report with patient details 
and OHS data but without groupings and totals. Tis report format allows you to view the data 
in a spreadsheet program. 

Note: Te report is sorted by last name, then by frst name, then by OHS visit. A patient may 
appear more than once on the report. 

• Age as of June 30th – With this check box selected, the age of each patient will be calculated as 
of June 30 within the specifed date range. With this check box clear, the age of each patient will 
be calculated based on the date that you generate the report. 

3. Do any of the following: 

• To save these settings for future uses of this report, click Save as Default. 

• To schedule the report to run at a later time or on a recurring basis, click Schedule. 

• To clear any changes you have made to the settings and start over, click Clear Defaults. 
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Statistics 

Date Range: 5/20/2019 - 51'1612019 
Age: <ALL> 

Clinics: <ALL> 
Pro.ii(lers: <ALL> 

2WS/JOU R•potl eo~.,~.d ~ ; ,...t,i,,D P•~• l Of1 

Ag• St.atist!~s OHS1 OHS2 OI-IS3 OHS4 OHS5 OHS6 NO OHS Ag•Tobl 

Palient(s) lhat are 5 to 6 years old 0 1 0 0 0 0 0 1 
Patient(sJ lhat are 7 to 8 years old 0 0 0 0 0 0 1 1 
Pa · ent(s) lhat are 13 to 14 years old 0 0 0 0 0 0 2 2 
Palient(s) lhat are 15 to 16 years old 0 0 0 0 0 0 8 8 
Pa ent(sJ ltlat are 17 to 20 yeaffi old 0 0 0 0 0 0 413 4 13 
Patient(s) that are 21 to 30 years old 0 0 0 0 0 0 3,610 3,610 
Patient(s) that are 31 to 40 years old 0 0 0 0 0 0 3,7(),:l 3,704 
Palient(s) lhat are 41 to 50 years old 0 0 0 1 0 0 5,019 5,020 
Pa11ent(sJ ltlat are 51 to 60 yeaffi old 0 0 1 0 0 0 9,660 9.661 
Pa ·ent(s) lhat are 61 to 70 years old 0 0 0 0 0 0 10,271 10.2H 
Pa · ent(sJ lhat are 71 to 80 years old 0 0 0 0 0 0 2,436 2.436 
Panent(s) lhat are 81 years and older 0 0 0 0 0 0 2,036 2.036 
Palient(s) wiltlout a birtlldey entered 0 0 0 1 0 0 1(1,:l 105 

Total Numb•r or P.ttl•nts 0 ·1 1 2 0 0 37284 37268 

4. Click OK to preview the report. 

For each age group on the report, the following statistics appear: 

• Te number of patients who have a completed OHS survey, broken down into columns by OHS status. 

• Te number of patients who do not have a completed OHS survey. Depending on how you flter the 
report, this column may not appear on the report. 

• Te total number of patients. 

• Te report also displays the total number of patients across all age groups for each column of data on the 
report. 

Note: A patient may be counted more than once on the report. 
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Server Name: <Default> 

Analysis Summary - Standard :' 

11/12/2018 - 11/12/2018 Entry Date 
Clinics: <ALL> -

Providers: DSMITH 
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Re.port Da!e: 1111 212018 Report Generated By: DSMrTH 

Beg inning Charge Fmance Debit In itial Applied Applied Ins Applied Pats 
Bslance Charges Adj Charges Balances Paymel'lts Payments Credit Adj Seen 

Billed La!e Debit Credit Credi1 New 
to Ins Charges Special Adj Special Adj Initial Balances Pats . 

• I rn I ' 
Page 1 of 1 Main Report u . 100% --0--

[11 100% --01---~ 

[)0 2 / 3 ... 

Working with Previewed Reports 
When you generate a report from DXOne Reporting, the report appears in the Report Preview window. 

You can do any of the following with the report being previewed: 

• Print the report – To print the displayed report, click the Print Report button. Te Print 
dialog box appears. All installed Windows printers are listed. Te Windows default printer is 
selected by default, but you can select a diferent printer. To send the print job to the selected 
printer, click Print. 

• Export the report – To export the report, click the Export Report button. Te Export Report 
dialog box appears. Select where you want to save the fle, enter a File name, select the desired 
Save as type (.rpt, .pdf, .csv, .xls, data-only .xls, data-only .xlsx, .doc, editable Word® .rtf, .rtf, or 
.xml), and then click Save. 

• Change the zoom – To change the zoom percentage of the 
report, drag the slider to the desired percentage (the default is 
100%). You can also, click the Fit to Width or Full Page 
button. 

• Navigate  pages – For a multiple-page report, click the Go to Previous 
Page or the Go to Next Page button to navigate one page at a time. To 
navigate to the frst or last page of a multiple-page report, click the down 
arrow next to the last page number to open a menu, and then click Go to First Page or Go to Last Page. 

• Search for text – To specify if you want to perform a case-sensitive or a 
whole-word search, click the down arrow next to the Type the text to 
fnd box, and then select Match Case and/or Match Whole Word. An 
active flter has a check mark next to it; clicking an option with a check 
mark removes that flter. Next, in the Type the text to fnd box, enter the text to search for on the page 
currently being viewed, and then press Enter. Te frst matching text on the page has a red box around it. 
Continue pressing Enter to fnd other matches. If no matches are found, the search box’s background 
color changes to orange. 

• Copy text – To copy selected text to the Clipboard, search for or click to select some text (a red 
box appears around it), and then click the Copy button. 
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Select Report Category: Double Click to Launch Report Options: 
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Management 

Ledger 
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Audit 

UDS 

Custom 

2i DXO NE Reporting 

Fi le Reports Security Scheduling E-Mail - Help 

1, i, [s[M' --
Select Report Category: Double Cl ick to Launch Report Options: 

Reference Dental Hygienists Activity Aepo1t 

Management Dentist Activity Repo1I 
Endodontic T oolh Access 

Ledger DHSS 

Analysis AVU By P1ovidor 
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Visits By 

Audit 

UDS 

Custom 

1:,r 0HSS ~ 

[s~ s,,ec~::J [':'.J7:_J 
Job Name: 

Save as Default I 
Clear Defaults Schedule 

Using Report Templates 
You can have multiple templates for the custom IHS reports. For eachof these reports, you can select a 
template (a Job Name) to run that report without having to change the options for fltering the report 
when certain variations of the report are frequently required. Also, if an existing scheduled job or template is 
changed, it can be saved as a diferent template or job while preserving the original. 

Creating a Report Job Template 
You can create a template for running a custom IHS report. 

To create a report job template 

1. On the Ofce Manager toolbar, click the DXOne Reports button . 

Te DXOne Reporting window appears. 

2. In the Select Report Category list box, select Custom. 

Te custom reports appear in the right list box. 

3. Double-click the report for which you want to create a template. 

Te corresponding report dialog box appears. 
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~ Schedule Report 

Recunence pattern---------------~ 

r One Time 

r Daily 

r Weekly 

r Monthly 

r, T emplale Only 

Job Name: I clinic Provider Range List Selection 

..l£c.J1 
~ I~------------------

~ I 
Start Dale and Time: 11112812017 09:21 AM ..:J 

End by: 11112812017 09:21 AM ..:J (7 No End Dale 

Schedule I Cancel 

~ DXONE Reporting ~ 8 ~ 
File Reports Security Scheduling E-Mail Help 

I~ a[s~ ~ e ae 
Select Report Category: 
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Audit 

UDS 

Custom 

Double Click to Launch Report Options: 

4. Set up the options for fltering the report results. 

5. Click Save as Default to save the current settings for future uses of the report. 

6. Click Schedule. 

Te Scheduling Report dialog box appears. 

7. Under Recurrence pattern, select Template Only to indicate that the report job will serve as a template. 

8. Type a Job Name for the report job (up to 50 characters in length). Te job name will be visible for the 
scheduled report job in the Manage Scheduled Jobs dialog box. 

9. Click Schedule to save the report job as a template and schedule the report job. Te report job will 
appear in the Manage Scheduled Jobs dialog box. 

Scheduling a Report Job from a Template 
You can schedule a report job from a template for an IHS custom report. 

To schedule a report job from a template 

1. On the Ofce Manager toolbar, click the DXOne Reports button . 

Te DXOne Reporting window appears. 

2. In the Select Report Category list box, select Custom. 
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21 DXONE Reporting 

Fi le Reports Security 

1, ie l:a~ 
Scheduling E·Mai l ---

GJ ~ ~ 
Help 

Select Report Category: Double Click to Launch Report Options: 

Reference Dental Hygienists Activity Aepo1t 
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Endodontic T oolh Access 
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List 
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Audit 
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Custom 
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Job Name: 

Save as Default I 
Clear Del aults Schedule 

2,[ Select Template/Job 

Enter Job Name 

11 ~ 
Job Name I 
Clinic Provider Range List Selection 

r List Jobs For All Users OK Cancel 

I 

Te custom reports appear in the right list box. 

3. Double-click the report you want to schedule from a template. 

Te corresponding report dialog box appears. 

4. Select a template: 

a. Click the Job Name search button. Te search button is only enabled if templates have been created 
or jobs have been schedule for this report. 

Te Select Template/Job dialog box appears. Any existing templates/jobs that have been created for 
the report by the user you are currently logged on as are shown in the list box. 

b. Select List Jobs for all users if you want to view templates for all users for this report. If this option is 
selected, a User ID column appears to the left of the Job Name column and displays the user ID for 
each job/template. Te List Jobs for all users check box is available only if the current user has the 
“Scheduled Jobs – Manage All Users” DXOne Reporting security right enabled; in other words, the 
current user has rights to view reports or jobs for other users. 

c. Te templates are listed alphabetically in ascending order by default. To reverse the order, click the 
Job Name column header of the list box. Ten, to change the order from descending to ascending, 
click the list box’s Job Name column header again. 
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DXONE Reporting 

Reports Security Scheduling E-Mai l Help 

Select Report Category: 

Reference 

Management 

Ledger 

Analysis 

List 

Audit 

UDS 

Custom 

~ DXONE Reporting 

File Reports Security 

1, a~~ 
Select Report Category: 

Reference 

Management 

Ledger 

Analysis 

List 

Audit 

UDS 

Custom 

---
Double Click to Launch Report Options: 

Scheduling E-Mai l ---
Help 

Double Cl ick to Launch Report Options: 

Dental Hygienists Activity Repo1t 
Dentist Activity Repo1I 
Endodontic Tooth Access 
DHSS 
RVU By P10vider 
Visits By 

d. Select the appropriate report job template in the list box (if more templates exist than can be 
displayed at one time in the list box, you might have to click and drag the list box’s scroll bar slider 
down to fnd the template). Or, type all or part of the template name for which you want to search in 
the Enter Job Name feld, click the search button to show the closest matching template(s) in the list 
box, and then select the appropriate report job template. 

e. Click OK to assign the selected template to the report job. Te flter options associated with the 
selected template are applied to the report job. 

5. Click Save as Default to save the current settings for the next time the report options are accessed. Te 
current job name will not be saved as the deafult. 

6. Click OK to schedule the report. Te report job will appear in the Manage Scheduled Jobs dialog box. 

Editing a Report Job Template 
You can edit a report job template for an IHS custom report. 

To edit a report job template 

1. From the Ofce Manager toolbar, click the DXOne Reports Module button . 

Te DXOne Reporting window appears. 

2. In the Select Report Category list box, select Custom. 

Te custom reports appear in the right list box. 

3. Double-click the report you want to schedule from a template. 
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Job Name: 

Save as Default I 
Clear Del aults Schedule 

R Select Template/Job 

Enter Job Name 

Job Name 

~ 
I Clinic Selection I 
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_:J 
I 

Clinic P,ovider Range List Selection 

r List Jobs For All Users OK Cancel 

I 

Te corresponding report dialog box appears. 

4. Select a template: 

a. Click the Job Name search button. Te search button is only enabled if templates have been created 
or jobs have been schedule for this report. Te Select Template/Job dialog box appears. Any existing 
templates/jobs that have been created for the report by the user you are currently logged on as are 
shown in the list box. 

b. Select List Jobs for all users if you want to view templates for all users for this report. If this option is 
selected, a User ID column appears to the left of the Job Name column and displays the user ID for 
each job/template. Te List Jobs for all users check box is available only if the current user has the 
“Scheduled Jobs – Manage All Users” DXOne Reporting security right enabled; in other words, the 
current user has rights to view reports or jobs for other users. 

c. Te templates are listed alphabetically in ascending order by default. To reverse the order, click the 
Job Name column header of the list box. Ten, to change the order from descending to ascending, 
click the list box’s Job Name column header again. 

d. Select the appropriate report job template in the list box (if more templates exist than can be 
displayed at one time in the list box, you might have to click and drag the list box’s scroll bar slider 
down to fnd the template). Or, type all or part of the template name for which you want to search in 
the Enter Job Name feld, click the search button to show the closest matching template(s) in the list 
box, and then select the appropriate report job template. 

e. Click OK to assign the selected template to the report job. Te flter options associated with the 
selected template are applied to the report job. 

5. Edit the options for fltering the report results as necessary. 

6. Click Save as Default to save the current settings for the next time the report options are accessed. Te 
current job name will not be saved as the deafult. 

7. Click Schedule. 
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Te Schedule Report - Edit dialog box appears. 

8. Edit the Job Name. 

9. Do one of the following: 

• Click Save to save any changes to the template (its job name and report flters). 

• Click Schedule New to save the changes as a new report job that will appear in the Manage 
Scheduled Jobs dialog while preserving the original template (its job name and report flters). Te 
new job name must be diferent than the original to add the template as a new template. 
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Chapter 10: Document Center 
Te Document Center can help your ofce become paperless. You can scan, capture, and import documents 
(such as patient letters, EOBs, and referral letters) and images (such as patient pictures and X-rays). You can 
then attach these documents to patients, providers, employers, insurance plans, and referral sources. Also, 
these documents can be printed, emailed, or sent electronically (for claims). 

A document in the Document Center can be a document fle type (.txt, .rtf, .doc, .docx, and .pdf ), an image 
fle type (.bmp, .gif, .jpg, .png, and .tif ), a slide show presentation fle type (.ppt. .pptx), a spreadsheet fle type 
(.xls or .xlsx), or any other fle type (which can be stored but not previewed in the Document Center). 

Tis chapter covers the following topics: 

• Opening the Document Center 

• Te Document Center Window 

• Setting up the Document Center 

• Acquiring Documents and Images 

• Printing to the Document Center 

• Working with Unfled Documents 

• Entering Document Information 

• Working with Documents 

• Signing Documents 

• Signing Consent Forms 

• Printing and Exporting Documents 

Opening the Document Center 
You can open the Document Center from the Family File, Ledger, Chart, Appointment Book, Treatment 
Planner, Collections Manager, and Ofce Manager. 

To open the Document Center 

In a Dentrix Enterprise module, from the File menu, click Document Center. (In the Treatment Planner, 
from the File menu, point to Switch To, and then click Document Center.) 

When opened from the Family File, Ledger, Chart, Appointment Book, Treatment Planner, or Collections 
Manager, the Document Center displays the selected patient’s attached documents. When opened from the 
Ofce Manager, the Document Center gives you the option to select a provider to view his or her attached 
documents. 
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The Document Center Window 
Te Document Center window consists of a menu bar, toolbars, a document tree, a document thumbnails 
pane, a document preview area, and a document notes pane. 

Menu Bar Document Thumbnails Document Preview Area Toolbars 

Document Tree Document Notes 

Tis section covers the following topics to help you understand how to use the Document Center window: 

• Te Document Tree 

• Te Document Tumbnails 

• Te Document Preview Area 

• Te Document Center Toolbars 

• Viewing Documents 

The Document Tree 
Te document tree displays the document source (patient, provider/ 
staf, employer, referral, or insurance), the document types in use under 
that source, and the documents associated with each of those types. 
Te plus (+) or minus (-) sign next to a document type folder indicates 
whether the list item is expanded or collapsed. Click the plus sign to 
view the contents of the document type folder. Click the minus sign to 
hide the contents of the document type folder. Te document tree is 
where you will select documents for viewing, editing, printing, and so 
forth. 
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The Document Thumbnails 
For a selected document, thumbnails (miniature images) may appear for each page of the 
imported document. Click any of the thumbnails to preview the corresponding page. If you 
want to view an OLE document (one that has been imported using Object Linking and 
Embedding), you must have the appropriate program or viewer installed on the computer 
(for example, Microsoft Word is required to view a DOC fle). 

The Document Preview Area 
Te document preview area displays the document selected 
in the document tree. If the document has multiple pages, 
the Document Center displays the frst page initially, but 
you can view the other pages: 

• By clicking a thumbnail. 

• By clicking the Previous Page and Next Page buttons 
on the preview toolbar. 

• By scrolling. 

Note: In the Document Center, you can store fles of any type supported by Windows. However, you can pre-
view only the fles that are of the types supported for previewing in the Document Center (such as .pdf, .png, 
.jpg, .doc, .xls, and .ppt). 

The Document Center Toolbars 
Te Document Center includes toolbars with buttons to access certain areas or features of Dentrix Enterprise. 
Te toolbars specifc to the Document Center and some of the available buttons are explained in the following 
table. 

Patient Information Toolbar 

Click the Select Patient button to open the Select Patient dialog box and select a patient to 
view in the Document Center. 
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Acquire Toolbar 

Click the From Device button to acquire documents from a WIA- or T WAIN-compliant 
device, such as a digital camera or scanner.  You can also click the down arrow to select the 
acquisition source. 

Click the Import From File button to copy a fle from your computer’s hard drive, removable 
media, or another computer on the network into the Document Center. 

Click the Paste From Clipboard button to create a document from text and/or graphics on the 
Windows Clipboard. 

Click the Unfled Documents button to import an unfled document to the Document Center 
of the patient, provider, employer, referral, or insurance plan currently being vie wed. 

Document Toolbar 

Click the Print Document(s) button to send the selected documents to a printer. 

Click the Send Document(s) button to compose an email message to send to a patient, 
provider, employer, referral, or insurance plan with any selected documents included as 
attachments. 
Click the Export Document(s) button to save a copy of the selected documents in an alternate 
location (for example, a USB drive). 
Click the Document Information button to vie w or change the date, type, description, or 
notes of the selected document. 
Click the Modify Document Attachments button to change the source to which the selected 
document is attached. 

Click the Sign Document button to sign the selected document. 

Click the Modify Document button to change the color of, crop, rotate, or add a page to the 
selected document. 

Click the Delete Selected Document(s) button to delete the selected documents. 
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View Toolbar 

Click the Expand List button to expand all the document type folders to view their contents in 
the document tree. 

Click the Collapse List button to hide all the document type folders in the document tree. 

Click the By Single button to view documents of the selected patient, provider, employer, 
referral, or insurance plan. 

Click the By Family button to view documents of the selected patient’s family. Tis button is 
available only if a patient is selected. 

Click the Filters button to flter the types of documents being viewed and to view documents 
within a specifed date range. 

Click the Show Preview button to show and hide document preview area. 

Click the By Patient button to view the documents of a patient you select. 

Click the By Provider/Staf to view the documents of a provider you select. 
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Viewing Documents 
In the Document Center, you can view documents by patients, family, providers/staf, employers, referrals, 
and insurance plans. You can also apply flters to view documents acquired within a certain date range and 
assigned a certain document type. 

To change the view 

In the Document Center, from the View menu, click one of the 
following options: 

• By Patient – A dialog box appears, allowing you to select a patient. 

• By Provider/Staf – A dialog box appears, allowing you to select a 
provider or staf member. 

• By Employer – A dialog box appears, allowing you to select an employer. 

• By Referred BY – A dialog box appears, allowing you to select a referral. 

• By Referred TO – A dialog box appears, allowing you to select a referral. 

• By Dental Insurance Plan – A dialog box appears, allowing you to select a plan. 

• By Medical Insurance Plan – A dialog box appears, allowing you to select a plan. 

• By Single – To view documents of the selected patient, provider, employer, referral, or insurance plan. 

• By Family – To view documents of the selected patient’s family. Tis option is available only if a patient is 
selected. 

To flter the list in the document tree 

1. From the View menu, click Filters. 

Te View By [Source] Filter (the name varies, depending on 
the selected view) dialog box appears. 

2. Set up the following options: 

• Select Document Types – Select the document 
types you want to view, or select All Document 
Types to view all types. 

1 

2 
• Include Documents Attached To – Select the 

sources for which you want to view attached 
documents. 

• Reference Date – Enter a date range in the 
From and To felds to view documents that were 
acquired during the specifed range; select All 
Dates for both From and To to view documents 
regardless of the acquisition date; or enter a date 
for either From or To, and select All Dates for the 
other option to use an open-ended date range. 

• Save as default – To save the current flter settings 
for the next time you open the Document Center, 
select this check box. 

3. Click OK. 

3 
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Setting up the Document Center 
Tis section covers the following topics about what to set up before you start using the Document Center: 

• Selecting a Document Center Printer 

• Customizing Document Types 

Selecting a Document Center Printer 
You can print documents, images, and the Document Center List. Select the printer you want to use for 
printing from the Document Center. 

To select a printer 

1. In the Document Center, from the Setup menu, click 
Printer. 

Te Printer Setup dialog box appears. 

2. Set up the following options: 

• Select Printer – From the list, select the printer you 
want to use. 

• Picture Scaling – Select how you want the Document 
Center to scale images when printing: 

1 

2 

• Fit to Page – To ft the image on a single page. 

• 1/3 Page – To have the image scaled to ft on 1/3 of 
a page. 

• Actual Size – To print the image in the actual size 
that it was imported. 

3 

• Include Footers – To include footers on a printed page, 
select this check box. Te information in the footer will vary slightly based on the Document Center 
source selected (patient, provider/staf, employer insurance plan, or referral) but may include the 
reference date, the patient’s last name, frst name, middle initial, preferred name, and chart number, 
and the page number. 

3. Click OK. 
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Customizing Document Types 
All documents in the Document Center must be assigned to a document type. Tese types are used to 
categorize as well as describe the type of document. You can add, edit, and delete document types as needed if 
the pre-set ones do not meet your practice’s needs. 

To customize a document type 

1. In the Document Center, from the Setup menu, click 
Document Types. 

Te Document Types Setup dialog box appears. 

2. Perform any of the following functions: 

• Add – Type a unique description for the type you 
want to add, and then click Add. 

• Change – Select the type you want to change, 
type a new description, and then click Change. 

• Delete – Select the type you want to delete (it 
cannot be assigned to a signed document), and 
then click Delete. 

1 

3 

2 

3. Click Close. 

Acquiring Documents and Images 
You can import documents and images into the Document Center with a scanner or digital camera. You can 
also import documents and images from a fle on your computer, another computer on your ofce’s network, 
a disc, an external drive, or a saved email attachment. Also, using the Windows Clipboard copy and paste 
functionality, you can import any image or plain text. 

Te Dentrix Document Center can store any important document or image that you may need to attach to a 
patient, provider, staf member, insurance carrier, employer, and/or referral. 

To acquire a document or image from 

In the Document Center, from the Acquire menu, do one of the 
following: 

• Point to From Device, and then click the appropriate device. Te 
corresponding third-party program opens. Select the documents or 
images you want to acquire, and follow the program’s instructions 
for acquiring the document or image. Te specifc steps to 
complete this process depend on the device that you are using. 

• Click Import from File. Te Import dialog appears. Locate the directory where the fle is stored, select 
the desired fle, and then click Open. 

• Click Paste from Clipboard. If nothing is on the Windows Clipboard, this option is not available. 

When the acquisition is complete, the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Entering Document Information” in this chapter. 
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Printing to the Document Center 
Dentrix Enterprise has a printer driver that allows you to save a copy of a document from any program that 
allows printing, such as a word processing program or a Web browser, as a .pdf fle in the Document Center. 
You can use this tool even without any Dentrix Enterprise modules open. 

To print to the Document Center 

1. Use the desired program’s print capabilities to print a copy of 
whatever it is you are viewing (for example, in your browser, 
with a Web page being viewed, right-click anywhere on that 
page, and then click Print). 

A Print dialog box appears (the look and 
functionality may vary). 

2. From the list of available printers, select Send 
to Dentrix Document Center, and set up any 
other options as needed. 

3. Click Print. If you are not already logged on to 
Dentrix Enterprise, a login dialog box appears. 

4. Enter your credentials, and then click Sign In. 

34 

When the acquisition is complete, the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Entering Document Information” in this chapter. 

2 
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Working with Unfled Documents 
Sometimes you have a bunch of documents to scan or import or multiple image fles to import, and it would 
be nice to just do them all at once. Instead of having to acquire each item and attach it to an entity (such as a 
patient or a provider) one at a time, you can acquire a batch of related or unrelated documents and images for 
the same entity or various patients, providers, staf members, insurance carriers, employers, and/or referrals. 
Ten, as you have time, you can attach these “unfled” documents to the appropriate entities. 

A document as considered unfled if it was acquired using one of the following methods: 

• By printing with the Document Center Printer Driver from another program. Te printed document will 
be imported as a .pdf fle into the Document Center Unfled Documents window. 

• By acquiring a new document from a fle, a device, or the Windows Clipboard in the Document Center 
Unfled Documents window. 

• By removing all attachments from a document, thus making it an unfled document. 

Tis section covers the following topics about working with unfled documents: 

• Attaching Unfled Documents 

• Combining Documents 

For information about the features of the Document Center Unfled Documents window, see the “Working 
with unfled documents” topic in the Dentrix Enterprise Help. 

Attaching Unfled Documents 
You can assign an unfled document to one or more entities: patients, providers, referrals, employers, and/or 
insurance plans. 

To quickly attach an unfled document to one entity 

1. With the desired patient, provider/staf, employer, referral, or 
insurance plan being viewed in the main Document Center 
window, from the Acquire menu, click Unfled Documents. 

Te Document Center Unfled Documents window opens. 

2. Drag the desired unfled document from the Document Center 
Unfled Document window to the document tree in the Document 
Center. 

If the document does not have a type and a description assigned to it, 
the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Entering Document Information” in 

1

2this chapter. 
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To attach an unfled document to one or more entities 

1. In the Document Center, from the Acquire menu, click 
Unfled Documents. 

Te Document Center Unfled Documents window 
appears. 

2. Select a document. 

1 

3. Click the Document Information button  to view the document 
information. 

Te Document Information dialog box appears. 

4. Click Modify Attachments. 

Te Modify Document Attachments dialog 
box appears. 

5. Under Attach Document By, for each entity 
that you want to attach to the document, 
click the corresponding entity’s search 
button , and make your selection: 

2 

3 

4 

• Patient – In the Select Patient 
dialog box that appears, select a 
patient. 

• Provider/Staf – In the Select 
Provider/Staf dialog box that 
appears, select the desired provider or 
staf member. 

• Employer – In the Select Employer 
dialog box that appears, select the 
desired employer. 

5 

6 

• Dental Insurance Plan – In the Select 
Dental Insurance Plan dialog box that 
appears, select the desired insurance plan. 

• Medical Insurance Plan – In the Select Medical Insurance Plan dialog box that appears, select the 
desired insurance plan. 

• Referred BY – In the Select Referred By dialog box that appears, select the desired referral source. 

• Referred TO – In the Select Referred To dialog box that appears, select the desired referral 
destination. 

Te attachment associations appear in the Document Attachments list box. 

Note: To remove an attachment association, select it in the Document Attachments list box, and then 
click Remove Attachment. 

6. Click Close to return to the Document Information dialog box. 

Enter the appropriate document information as explained in “Entering Document Information” in this 
chapter. 
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Combining Documents 
You can quickly combine multiple images that you want to be stored in the Document Center as multiple 
pages of the same document. For example, you may want to combine a series of intraoral or extraoral images 
taken during a single visit. 

Notes: 

• You can combine images only in the Document Center Unfled Documents window. You cannot combine 
images that are attached to an entity (such as a patient or provider). 

• You can only combine image fles (such as .png or .jpg fles). You cannot combine .pdf fles or other non-
image fles (such as .doc or .xls fles). 

To combine documents 

1. 

2. 

3. 

In the Document Center, from the Acquire menu, click 
Unfled Documents. 

Te Document Center Unfled Documents window opens. 

Select the desired images. Te frst one selected will be on the 
frst page of the new document; the second, on the 
second page; and so on. 

Click the Combine Documents button . 

1 

2 

3 
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Entering Document Information 
Once the document has been captured, scanned, imported, or pasted into the Document Center, the 
Document Information dialog box appears so that you can attach information and categorize the document. 

To enter the document information 

1. In the Document Information dialog box, set up the following options: 

• Reference Date – By default, the 
date of the document is the current 
system date, but you can change 
it as needed. Tis date will appear 
for this document in the document 
tree and when it is printed. 

• Document Type – Select the type 
you want to assign the document. 

• Description – Type a description 
for the document. Tis description 
will appear for this document in 
the document tree and be used 
as a fle name for the document 
when the document is exported or 
attached to an email message. 

• Note – Type any pertinent notes 
regarding the document. Te note 

1 

2 

text will be appended automatically 
to the text of an email message with this document attached, and you can view the note when 
previewing this document. 

• Modify Attachments – To associate the document with a patient, provider/staf, employer, insurance 
plan, and/or referral other than the current patient, provider/staf, employer, insurance plan, or 
referral currently being viewed in the Document Center, click this button. For more information 
about document sources, see “Modifying Document Attachments” in this chapter. 

Note: If you are acquiring from the Document Center printer driver or the Document Center 
Unfled Documents window, by default, the document does not have any attachments associated 
with it. 

2. Click OK. 
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Working with Documents 
In the Document Center, you can view attached documents by patients, providers, insurance carriers, and 
referral sources. You can select flters to view documents acquired within a certain date range and assigned to a 
certain document type. From the Document Center, you can perform functions such as adding more pages to 
documents, adjusting the brightness and color of an image, and rotating a document. 

Tis section covers the following topics about working with documents: 

• Editing Document Information 

• Modifying Document Attachments 

• Deleting Documents 

• Modifying Documents 

Editing Document Information 
You can edit the date, type, description, note, attachments, and signatures assigned to a document as long as 
the document has not been signed. Once a document has been signed, you cannot change that document’s 
date, type, description, or note, but you can attach more sources to it. 

To edit document information 

1. In the Document Center document tree, select the 
document that has information you want to edit. 

2 

2. From the Edit menu, click Document Information. 

Te Document Information dialog box appears. 

3. Make the necessary changes to any of the options. For 
details about each available option, see “Entering Document 
Information” in this chapter. 

4. Under Document Errors, do one of the following to “audit” the 
document (specify whether there are errors or not): 

• Select the No Errors check box. 1 

• Select the check box 
of each applicable 
error type (Poor Scan, 
Incorrect Location, 
Incorrect Record, and 
any user-defned error 
type). 

5. Click OK. 

5 

3 4 
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Modifying Document Attachments 
You can modify attachment sources for a specifc document. You can associate a document with a patient, 
provider/staf, employer, dental insurance plan, medical insurance plan, inbound referral, and/or outbound 
referral. Also, you can assign additional sources to a document that has been signed. 

To modify a document’s attachments 

1. In the Document Center document tree, select a document. 2 

2. From the Edit menu, click Modify Document Attachments. 

Te Modify Document Attachments dialog box appears. 

3. Make the necessary changes: 

• Attach Document By – For each entity that you want to attach to 
the document, click the corresponding entity’s search button , and 
make your selection: 

• Patient – In the Select Patient dialog box that appears, select a 
patient. 

• Provider/Staf – In the Select Provider/Staf dialog box that 
appears, select the desired provider 
or staf member. 

• Employer – In the Select 
Employer dialog box that appears, 
select the desired employer. 

• Dental Insurance Plan – In the 
Select Dental Insurance Plan 
dialog box that appears, select the 
desired insurance plan. 

• Medical Insurance Plan – In the 
Select Medical Insurance Plan 
dialog box that appears, select the 
desired insurance plan. 

• Referred BY – In the Select Referred By dialog box that appears, select the desired referral 
source. 

• Referred TO – In the Select Referred To dialog box that appears, select the desired referral 
destination. 

Te attachment associations appear in the Document Attachments list box. 

• Remove Attachment – To remove an attachment, select it in the Document Attachments list box, 
and then click Remove Attachment. 

Tip: To view the signatures attached to a document, click Document Signatures. Tis button is available 
only if the document has one or more electronic signatures. 

4. Click Close. 

4 

3 OR 3 

1 
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Deleting Documents 
You can delete a document that has not been signed. Dentrix Enterprise will not delete the original document 
from the computer but will remove it from the Document Center. 

To remove a document 2 

1. In the Document Center document tree, select the document you 
want to delete. 

2. From the Edit menu, click Delete Selected Document(s). 

Do one of the following: 

• If the document has multiple attachment sources, a dialog box 
appears. Select whether you want to delete the document for only the 
current attachment source being viewed in the Document Center or 
delete the document for all attachment sources, and then click OK. 

• If the document is attached to only the source being viewed in the 
Document Center, a confrmation message appears. Click OK. 

Modifying Documents 
With the Document Center, you can add pages to, make color adjustments to, crop, sharpen, rotate, and 
assign an orientation to a document being previewed. You can make these modifcations only to documents of 
an image fle type (such as .jpg or .png).Also, you cannot modify a document that has been signed. 

To modify a document 

1. In the Document Center document tree, select the document you 
want to modify. 

2 

2. From the Edit menu, click Modify Document (the icon next to this 
menu item is highlighted if the document is already in modify mode). 

3. If the document being previewed has multiple pages, select the page you 
want to edit. 

Tip: You can click the Previous Page or Next Page button on 
the Preview toolbar to navigate between the pages of a multi-page 
document. 1 

4 

3 

1 
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       4. Te Modify Document toolbar appears at the top of the preview area. Make any necessary changes to the 
document. Te function of each button on the Modify Document toolbar is explained in the following 
table. 

Click the Add Page button to import an image as another page of the image being previewed. 

Click the Delete Page button to delete the selected page of the image being previewed. 

Click the Image Adjustments button to adjust the sharpness, saturation, contrast, and/or 
brightness of the image being previewed. 

Click the Crop Image button to crop the image being previewed to the area you select. 

Click the Invert Colors button to invert the colors of the image being previewed. 

Click the Convert To Grayscale button to change the image being previewed to a grayscale 
image. 

Click the Remove Spots button to sharpen the image being previewed. 

Click the Rotate button to rotate or fip the image being previewed. 

Click the Orientation button to specify the point of view used to acquire the image being 
previewed. Click <None>, No Orientation, Right Side of Mouth, Left Side of 
Mouth, Entire Mouth, Inner, or Outer. A watermark appears in the lower-right 
corner of the document to indicate the orientation of the document: R for right 
side, L for left side, M for mouth, I for inner, O for outer. 

Click the Undo button to undo the last operation performed on the image being modifed. 

Click the Undo All button to undo all edits made to the image being modifed since the last 
time it was saved. 
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Signing Documents 
You can apply signatures to a document attached only to patients, providers, and/or staf. You can apply a 
signature to a document for each patient, provider, or staf member attached to the document. 

Important: Once a document has been signed, you cannot change the document information, but you can 
attach the document to additional sources. 

To sign a document 

1. In the Document Center document tree, select the document you 
want to sign. 

2. From the Edit menu, click Sign Document. (Tis option reads, “View 
Signatures,” if the selected document already has a signature.) 

Te Sign Document dialog box appears. 

3. Te Name feld automatically displays the patient, provider, or staf 
member selected in the Document Center, but you can change the name 
as needed. 

4. Use a mouse or other supported device to add your signature in the 
Signature box. If you need to erase 
the signature so that you can re-sign, 
click Clear. 

5. Click OK. 

2 

3 

4 

5 

1 
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undersigned provider. I have been given a printed copy of the procedure or treatment details and any post-op 
instructions. 

I understand the risks inherent in the treatment(s). I have discussed these risks with the dentist . The dentist has 
addressed all questions and concerns I have presented . I understand the expeded results of the procedure(s) or 
course(s) of treatment . I understand that these results cannot be guaranteed and may not be achieved . I am aware of 
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Signing Consent Forms 
If you are viewing the Document Center of a patient who has consent forms in the Treatment Planner, the 
“Treatment Planner Consent Form” document type folder appears in the document tree. 

Te patient and/or provider can sign a consent form from the Document Center. Also, as with other 
document types, you can only edit unsigned consent forms. 

To sign a consent form 

1. In the Document Center document tree, select the consent 
form you want to sign. 

2. From the Edit menu, click Modify Document. 

2 

5 

3. Type the name of the patient and provider or staf member 
in the appropriate Name felds. 

4. Use a mouse or other supported device to add the 
signatures in the Signature boxes. If you need to erase a 
signature so that you can re-sign, click Clear. 

5. From the Edit menu, click Modify Document to save the 
signatures. 

4 

3 

1 
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Printing and Exporting Documents 
Te Document Center provides the following ways to print or export documents: 

• Print the Document Center List – Te Document Center List consists of the contents in the document 
tree for the current view. It will list all attached documents, according to the flters selected. In the 
Document Center, from the File menu, point to Print, and then click Document Center List. 

• Print documents – You can print a specifc document or multiple documents. In the Document Center 
document tree, select the documents you want to print. Ten, from the File menu, point to Print, and 
then click Print Document(s). 

• Send documents – You can send a document or multiple documents electronically as email attachments. 
In the Document Center document tree, select the documents you want to send. Ten, from the File 
menu, click Send Document(s). 

Tip: HIPAA constraints make it unwise for you to include patient information and provider/practice 
information within the same message for security/privacy. Be mindful of this when sending documents 
through email. 

• Export documents – You can export documents to your computer’s hard drive, a shared network 
location, or any removable media or hard drive. In the Document Center document tree, select the 
documents you want to export. Ten, from the File menu, click Export Document(s). 

• Attach documents to insurance claims – For instruction on how to attach Document Center documents 
to a dental insurance claim, see “Including Attachments with Dental Insurance Claims” in Chapter 7: 
Ledger. 
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Chapter 11: Other Features 
Dentrix Enterprise provides the following additional features: 

• Viewing More Patient Information 

• Sending Email Messages 

• Quick Labels 

• Quick Letters 

• Continuing Care 

• Patient Questionnaire 

• Prescriptions 

• Patient Alerts 

• Ofce Journal 

• Collections Manager 

Viewing More Patient Information 
Te More Information window provides you with access to an entire overview of patient information, such as 
basic demographics, future appointments, treatment plans, medical information, treatment requests, and aged 
balances. You can add a picture to a patient’s profle. You can customize the patient information view to suit 
your preferences. Also, you can quickly switch between viewing information for a patient and that patient’s 
family members. 

To use the More Information window 

1. Do one of the following: 

• In the Treatment Planner, with the correct patient selected, from the File menu, click More 
Information. 

• In the Patient Chart, Ledger, or Family File, with the correct patient selected, from the File menu, 
click More Information. 

• In the Appointment Book, with the correct patient’s appointment selected, from the File menu, click 
More Information. 

• In the Document Center, with the correct patient selected, click the More Information button on 
the Patient Information toolbar. 
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I Crosby, Tom N. 

Chart CRO101 

Clinic AF 

Prov1 DSMITH 

Status Active 

Billing Type 3 

Prov 

Home (801) 555-61TT 

Mobile 

Work (801) 555-3563 

Home Email documentation @hen ryschein.com 

Work Email 

Language 

Ethnicity 

Medica l Ins G) 
Primary: ACME Medical 

Continuin 

Date 

12/18/2019 

Care 

Type 

PERIO 

~ Pa!Tag 1 

Pat Tag 2 

Appt 

DSMITH 

DSM ITH 3/ 18/2020 PROPHY 09/ 17/2019 

Amount Clinic 

302.40 I AF 

158.40 AF 

Balance 

G 

A ging: 

0-30 

31 -60 

61-90 

90+ 

Suspended 

Total 

In s Est for Comp I Proc 

Ins Est f or Appt Pro c 

EST Portion 

Patient: Family: 

500.80 1181.62 

0.00 0.00 

0.00 0.00 

3222.70 3812.70 

-400.00 -400.00 

3323.50 4594.32 

460.80 1057.72 

0.00 0.00 

2862.70 3536.60 

A ge 

45 

140 
lzs 

• In the Ofce Manager, from the File menu, click More Information. When the Select Patient dialog 
box appears, select a patient. 

Note: Tere is also a More Information button on the Patient Information toolbar in the Treatment 
Planner, and on the toolbar of the Patient Chart, Ledger, Family File, Appointment Book, and Ofce 
Manager. 

Te More Information window appears. 
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Crosby, Brent 
Age 45 

DOB 11 /11/ 1973 

Sex M ale 

SSN 111 -11 -1111 

Marital Married 

123OakSI 
American Fork, UT 11111 

Chart CRO101 

Clinic AF 

Prov1 DSMITH 

Status Active 

Billing Type 3 

Home [801) SS5-61TT 

Mobfle 

Work (801) 555-3563 

Home Email documentation@henryschein.co m 

WorkEmafl 

Language 

Ethnicity 

2. Use or view any of the following options and features as needed: 

• Toolbar – Te toolbar provides the following buttons: 

To access the Patient Chart, Family File, Ledger, Appointment Book, Ofce Journal, or 
Document Center, click the corresponding button. When a patient-specifc module (not 
the Appointment Book) opens, the patient will be selected automatically. 

Also, if you have an appointment selected on the Appointments tab or under Next 
Appointments on the Summary tab, and then you click the Patient Chart button, the 
provider attached to that appointment will be selected automatically as the provider for the 
charting session. 

To manage the patient’s medical alerts, click the Medical Alerts/Problems button. 

To create a patient alert for the patient, click the Patient Alerts button. 

To select a diferent patient in the More Information window, click the Select Patient 
button. 

To select which tabs you want to include on or exclude from the window, and to select 
which buttons you want to include on or exclude from the toolbar of the window, click the 
Settings button. 

• Demographics – Te following information from the patient’s Family File appears for your reference: 
name, age, birth date, gender, Social Security Number, marital status, address, chart number, clinic, 
primary provider, patient status, billing type, home phone number, mobile phone number, work 
phone number, email address, language preference, and ethnicity. 

• To open the Patient Information dialog box (without having to open the Family File frst) to 
edit the patient’s information, click the patient’s name (which is a link). 
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• Patient picture: 

• To add a picture, click the box, click the Import from File button to select an image fle 
(such as a .jpg fle), use the available tools to make any necessary modifcations to the picture, 
click the Save button , click Yes to confrm the changes, and then close the dialog box. 

• To edit the picture, click the picture in the box, use the available tools to make any necessary 
modifcations to the picture, click the Save button , click Yes to confrm the changes, and 
then close the dialog box. 

• To remove the picture, click the picture in the box, click the Delete Image button , click Yes 
to confrm the deletion, and then close the dialog box. 
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U p d ated: 12/7/ 20 20 

Summary 
Dental Ins <D ® Medical Ins <D ~ I Pat Tag 1 

Primary: Delta PMI Primary: ACME Medical Pat Tag 2 

Appointments Next Appointments + ~ Continuina Care 
Date Clinic Prov Date Type Appl 

Procedures 
11/ 12/20199,00AM IAF I DSMITH 12/18/2019 I PERIO 

I 09/17/2019 11/ 13/20199'00AM AF DSMITH 3/ 18/2020 PROPHY 
Medical A lerts 

Treatment Plans 

Balance Aging: Patient: Family: 
Health Assessments 

0-30 500.80 1181.62 
Outstanding Claims 

31-60 0.00 0.00 
Treat ment Request s Created Sent Amount Clinic 61-90 0.00 0.00 

6/17/2019 1 6/17/ 201~1 302.40 I AF 90+ 3222.70 3812.70 
Billing 9/1 7/2019 9/17/2019 158.40 AF Suspended -400.00 -400.00 

Total 3323.SO 4594.32 

Ins Est for Comp I Proc 460.80 1057.72 

e Ins Est for Appl Proc 0.00 0.00 

EST Portion 2862.70 3536.60 

+ 

• OHS meter – With a certain global setting enabled, an OHS meter appears in the upper-right corner. 
By default, the OHS meter displays the patient’s most recent OHS score. If you select a diferent 
OHS survey (only one), on the OHS tab, the OHS meter displays the score that corresponds to that 
survey. 

• Summary tab – Tis tab displays the following: the dental insurance plans that are attached to the 
patient (if there are multiple, click a circled number icon to view the name of the corresponding 
carrier), the medical insurance plans that are attached to the patient (if there are multiple, click a 
circled number icon to view the name of the corresponding carrier), the patient tags that are attached 
to the patient, the patient’s future appointments, the continuing care types attached to the patient, 
the patient’s outstanding claims, the aged balances and suspended credits for the patient and family, 
the estimated insurance portion and patient portion of completed procedures for the patient and 
family, and the estimated insurance portion for the selected appointments in the Next Appointments 
list. 

• To view or edit the patient’s dental or medical insurance information, click the corresponding 
carrier link. 

• To edit the patient tags that are attached to the patient, click the Tags link. 

• To schedule an appointment for the patient, click the New Appointment button . 

• To open the Appointment Book and view one of the patient’s upcoming appointments, select 
that appointment in the Next Appointments list, and then click the Locate Appointment 
button . 
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Summary 
Date Time TimeZone Status Reason Prov Operatory Clin ic Ln 

11/ 13/2019 9:00 AM UTC-07:00 <none > ReEval DSMITH AF-OP-01 AF 10 

Appointments 11/ 12/2019 9:00AM UTC-07:00 <none > Sialo DSMITH AF-OP-01 AF 10 

2;16/2017 3:SO PM UTC -07 :00 <none> RtCrnPFHn=30 MHAYES AF-OP03 AF 90 
Procedures 

2/23/2017 10:00AM UTC -07:00 <none> Res2PosPr#3 DESMITH AF-OP02 AF 20 

Medica l A lerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing IC] Hide Past Appointments □ Hide Unscheduled Appointments + ~ \) 

+ 

Summary 
Date Th Surf Proc Description Status. Amount Prov Clinic 

S/14/2014 UR UR D4342 Scaling & Rootplan " Completed 100.00 DSMITH CENTRAL 

Appointments 5/14/2014 UL UL D4342 Scaling & Rootplan ... Completed 100.00 DSMITH CENTRAL 

5/14/2014 LR LR D4342 
Procedures 

Scaling & Rootplan ... Completed 100.00 DSMITH CENTRAL 

S/14/2014 LL LL D4342 Scal ing & Rootplan ... Completed 100,00 DSMITH MESA 

Medica l A le rts 4/20/2015 15 OB, D2392 Resin-2 surface, po ... Completed 210.00 DSMITH MESA 

5/14/2015 6 D2750 Crown -pore fuse hi ... Completed 850.00 DSMITH AF 

Treatment Pla ns S/14/201S POCHK Post Operative Check Completed 100.00 DSMITH AF 

Health Assessments 
10/20/2 .. , 14 0 , D2391 Resin -1 surface, po ... Tx 190.00 DSMJTH AF 

10/20/2 .. , 18 D2940 Protective Restorat i " Tx 160.00 DSMITH AF 

Treatment Requests 10/20/2 .. , 19 D2940 Protective Restorati " Tx 160,00 DSMITH AF 

Billing f2I Completed f2I Tx f2I Existing 0 Existing Other ~ 

• Appointments tab – Tis tab displays the patient’s past appointments (unless the Hide Past 
Appointments check box is selected), future appointments, and appointments on the Unscheduled 
List (unless the Hide Unscheduled Appointments check box is selected). 

• To schedule an appointment for the patient, click the New Appointment button . 

• To open the Appointment Book and view one of the patient’s appointments, select that 
appointment in the list, and then click the Locate Appointment button . 

• To open the Appointment Book, click the Appointments button . 

• Procedures tab – Tis tab displays the completed, treatment-planned, existing, and/or existing-other 
procedures for the patient, according to which check boxes are selected. 

• To open the patient’s Chart, click the Patient Chart button . 

• To open the patient’s Ledger, click the Ledger button . 
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Summary 
Problems 

Description Status Date Smoking Status: 

I Active 11012012015 
Never smo ked tobacco 

Appo intments Arthritis 

Last Alert Review: 
Procedures 10/ 20/2015 

Medications 
M edical Alerts De scription Statu s Date Most Recent Health Concerns: 

Treatment Plans 
Codeine I Active I 1012012015 - Patient states he th .. . 

Health Assessments 
Allergies 

Treatment Requests De scription Statu s Date 

Latex I Active I 101201201 5 

Billing • • 

Summary Tx Cases: Date Th Surf Proc Desc ripti on Status Amount Prov Clinic Visit 

All 9/ 17/2019 18 D29 ... Protective ... Created 158.40 DSM ITH AF 1 

Appointments Filling 9/ 17/ 2019 19 D29 ... Protective ... Created 158.40 DSM ITH AF 2 

Restorations 9/ 17/ 2019 14 0 , D23 .. . Resin -1 sur ... Created 158.40 DSMITH AF 1 
Procedures 

Medical Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing Show: 

D Completed 

D Rejected 

-=I 

• Medical Alerts tab – Tis tab displays the patient’s problems, medications, allergies, and smoking 
status. Te date of the last time medical alerts were marked as having been reviewed appears. You 
mark medical alerts as having been reviewed by selecting the second or third option under Medical 
Alert Review in the Medical History Review dialog box. Any health concerns entered also appear. 

• To manage the patient’s medical alerts, click the Medical Alerts/Problems button . 

• To manage the patient’s health concerns, click the Most Recent Health Concerns link. 

• Treatment Plans tab – Tis tab displays all the patient’s treatment-planned procedures. Or, you 
can click the name of a treatment plan to view only the treatment-planned procedures that are part 
of that case. You can also choose to show completed and/or rejected procedures by selecting the 
corresponding check boxes. 

• To open the patient’s Treatment Planner, click the Treatment Planner button . 
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Summary Blood Resp Pulse 
Inhaled 

Date Pu lse Temperature Age Weight Hgt/Len BMI 02 Prov Clinic 
Pressure Rate Ox 

Cone 
Appointments 

9/17 /2019 1120/80 

1: 

I98,6°F 

1: 

I 1601bs 16,0833. .. 121 .1 110 190% 190% I DSMITH IAF 

Procedures 9/12/2018 118/83 98.6 °F 152 lbs 6,0833... 20.1 10 90% 90% DSMITH AF 

Medical Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

< I > 
Billing 

B 

Summary 
Req Date Req Type Description Severity Rev Date Rev Prov Appl Date Status 

11/8/2017 I Patient j Broken tooth I 1 i u,s12011 I DESMITH I n,S/2017 I Reviewe 

Appointments 

Procedures 

Medica l Alerts 

Treatment Plans 
◄ L "' .I ' 

Health Assessments 
Appointments A + -Notes 

Treatment Requests 
Broken molar in LL. 0 K to schedule as . Date/Tlme 11 /08/201710:00AM UTC -07:00 
emergency ASAP. 

Oinic AF 

Billing Description EmergEx 
~ Provider DESMITH 

Summary 
Date Description Status Amount Prov Clinic 

7/2S/2019 I Single Billing Statement (Crosby, Brent L) I Printed 13831.12 I DSMITH I CENTRAL 

Appointments 7/25/2019 Single Billing Statement (Crosby, Brent L) Printed 3831 ,12 DSMITH CENTRAL 

Procedures 

Medica l Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing 

-

• Health Assessments tab - Tis tab displays the health assessments that were entered for the patient. 

• To manage the patient’s health assessments, click the Patient Health Assessment button . 

• Treatment Requests tab – Tis tab displays the treatment requests that were entered for the patient. 
For information about managing a patient’s treatment requests and linked appointments, see the 
“Managing treatment requests from the More Information window” topic in the Dentrix Enterprise 
Help. 

• Billing tab – Tis tab displays a history of billing statements that have been printed for the patient, 
and you can view any of the statements as needed. Dentrix Enterprise only saves single billing 
statements that are printed from the Ledger or that are sent to the batch processor from the Ledger 
and then printed from the Ofce Manager. 

• To view a statement, double-click the corresponding statement history entry. 

• To sort the statement history list, click the desired column header. 
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Summary Last Exam OHS Entry Age At lime OH, Natural Absc'd Active 
Immediate 

T Carious Extractions m CPI ACD 
Date Date of Exam Score Teeth # Teeth 

Lesions 
Treatment 

Appointments 
1217/2020 1217/2020 40 28 No 1-3 No No No 

Procedures 6/7/2020 40 28 No No No No 

Medical Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing 

Patient Forms 

OHS ~ 

Fami ly 'Y 

Status Nam e Age 

Guar Crosby, Brent 45 

Married Crosby, Shirley H. 42 

Single Crosby, Tom N, 16 

Child Crosby, Crystal 14 

• To copy the history list to the Windows Clipboard (in an Excel-friendly format), while pressing 
the Ctrl key, press P. 

• To delete a billing statement, select the desired entry, and then click the Delete button . 

Notes: 

• To select multiple, drag over the desired entries; select a desired entry, and then select the 
others while pressing the Ctrl key; or select the frst entry of desired range, and then select 
the last entry of the desired range while pressing the Shift key. 

• You can delete a billing statement only if your user account is allowed to do so (according 
to a security right). However, if you are not allowed to delete it, Dentrix Enterprise asks for 
a user who does have rights to delete statements to enter his or her credentials. If you are 
attempting to delete multiple statements, the overriding user must enter his or her credentials 
for each statement being deleted. 

• OHS – With a certain global setting enabled, an OHS tab is available. Te OHS tab lists the patient’s 
OHS surveys. 

• Family list – To view patient information for any of the current patient’s family members, select that 
family member from the list. You can expand and collapse the Family list as needed. 
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Summary last Exam OH, Entry Age At Time OH, Natural Ab 
Date Date Score Teeth# Tee 

Appointments 

Procedures 

12fl/2020 12fl/2020 

1~ 
128 I No 6/7/2020 28 No 

Medical Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing 

Patient Forms 

OHS 

~ Edit OHS Oral Health Status - Fisher, Dan B [AF] [UTC -07 00 [MSl]] [DSMITH] [FI0007] [11 / 11/1980] [40] X 

Patient Oral Health (Dental Provide r (objective] Observations) 

0 1. Was a complete examination includ ing charting of abscessed teeth, carious lesions and 
needed restorations completed at this a ppointment? 0 No @ Yes 

Yes 

Numberofremainingteeth: ~ B 
Are the re any abscessed teeth? @ No O Yes 

Howfil£.O),'.teeth haveactivecarious lesions? 0 0 @ 1-3 0 4-10 0 11+ 

Do any teeth require imm ediate treatmenVrestoratio n? @ No O Yes 

0 2. Are any teeth identified for extractions due to caries, periodontal disease or abscesses? @ No O Yes 

0 Soft Tissue Exam 

3a. Any definitively diagnosed oral or pharyngeal cancer? @ No O Yes 

3b. Any abnormal oral les io ns ind icated fo r biopsy? @ No O Yes 

0 4, Community Periodontal Index (CPI) 

Accept Previous Entry? O No @ Yes 

CPI Status 

0 5. Active Ca ries Depth Metric 

1-5 6-1 1 12-16 

0 
28-32 22-27 17-21 

Last Update: 12/7/2020 

Patient Oral Health Risk Factors 

0 6, Caries Risk: 

0 7. Smoking: 

0 8. Diabetes? 

0 9. Dry Mouth? 

I Low 

I Never smoked tot "" I 
I No patient history • I 
I Reduced sal iva flo• • I 

Last mod ified at 12/7/2020 by Smith, Dennis 

Accept Previous Entry? O No @ Yes 

Active Ca ries Depth 

1-5 6-11 12-16 

28-32 22-27 17-21 

Last Update: 12/7/2020 

Updated: 12[1 /2020 

Cancel 

Viewing or Editing OHS Surveys 
You can view all the details of an OHS survey. If the security rights assigned to your user account allow it, you 
can edit an OHS survey. 

To view or edit an OHS survey 

1. In the More Information window, on 
the OHS tab, double-click a survey. 

Te Edit OHS Oral Health Status 
dialog box appears. 

2. If allowed, make any necessary 
changes. For an explanation of the 
various options, see “Completing Oral 
Health Status Surveys” in the Patient 
Chart chapter. 

3. If you have made 
changes, click OK; 
otherwise, click Cancel. 

Note: Whether or not 
you have made changes 
to the survey, if you click 
OK, the Last Exam Date 
for the survey will be 
updated to today’s date. 

1 

2 

3 
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Summary Last Exam OHS Entry Age At Time OHS Natural Absc'd Active Immediate 
T Carious Extracti ons m CPI ACD Date Date of Exam Score Teeth # Teeth 

Lesions 
Treatment 

Appointments 
12/7/2.020 12/7/2.020 40 28 No 1-3 No No No 

Procedures 6/7/2.020 40 28 No 0 No No No 

Medical Alerts 

Treatment Plans 

Health Assessments 

Treatment Requests 

Billing 

Patient Form s 

OHS 

Graph Patient OHS - □ X 

Data Reid 

1 lii1~~□ 1 I I I I I I I i I u, ~ 

[otts"composite =::::J 
:c 0 

0 ~ 

I I I I I I I 
11 + 

I I Ii /Jv;Je Range ~g g 4-10 
J;i -la jj 1-3 

Minimum Maximum 
u__, 

0 

119 ~I 141 1:;:11 
I I I I I I I I I I 

Yes 

I I 
]I 

0 Show Values ..:>-- No 
No 

I I I I I I I I I I • [Pri;;---=i !!~ Yes 

I I 

~~ 

LC) 
., _ 
E ~ 
_§~ No 

No 
I I I I I I I I I I • Yes 

I I 

d 
-~ 

Ji No 
No 

I I I I I I I I I I • Yes 

I I 
'5 i ~ 
ci>i---~ 

No 
No 

I I I I I I I I I I • 
1 

I I i ii: u 2 
3 
4 I I I I I I I I I I 

1 

I I : 0 u 2 < 
3 
4 I I I I I I I I I I 

19 21 23 25 27 29 31 33 35 37 39 41 

Age 

L Oose J 

Viewing OHS Graphs 
You can view OHS data over time as graphs. 

To view OHS graphs 

1. In the More Information window, on the OHS tab, click Graph. 

1 

Te Graph Patient OHS dialog box appears. By default, the OHS Composite graph is displayed. 

2. Do any of the following: 

• To change which graph is 
being displayed, from the 
Date Field list, select any 
of the following graphs: 

• OHS Composite 

• OHS score 

• Natural teeth # 

• Active Carious 
lesions 2 

• Absc’d teeth 

• Immediate 
Treatment 

• Extractions 

• Soft Tissue Exam 

• CPI (6 line graphs; 
one for each sextant) 

Note: An X indicates 
that all teeth are 
missing, so the graph 
line ends. If, for 
example, the placement of an implant is done later, the graph line will start again after a gap. 

• ACD (6 line graphs; one for each sextant) 

Note: An X indicates that all teeth are missing, so the graph line ends. Te graph line may start 
again after a gap. 
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• 
To have an exact value appear next to each point on the graph, select the Show

 Values check box. 

• 
To print the graph that is being displayed currently, click Print. T

en, in the Print Preview
 dialog 

box that appears, click the Print button 
. 



Chapter 11: Other Features    441 

Dentrix Enterprise 11.0.2 User’s Guide

 

 

 

 

Sending Email Messages 
If you have email access, you can create and send email messages to patients quickly. 

To send an email message to a patient 

Do one of the following: 

• In the Family File, with a patient selected, from the File menu, click Send Message. 

• In the Appointment Book, with a patient’s appointment selected, from the File menu, click Send 
Message. 

• In the Document Center, with a patient selected, from the File menu, click Send Document(s). 

• In the Treatment Planner, with a patient selected, point to Switch To, and then click Send Message. 

Your email program opens so that you can compose and send a message. 

Note: Te patient’s email address, if one has been entered in the Family File, appears in the To feld. However, 
if no email address has been added for the patient, you can type an address in the To feld. 
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Phone: H (801)555·6177, W (801)555< 

Slalus: Active, M, Married, Guar, Ins, H 

Employer 

Quick Labels 

Selecl Label(s)-------~ 

P alien! Mailing Label 
Guarantor Mailing Label 
P alien! Chari Label 
Abbreviated Chart Label 
D elailed Chari Label 
Primary Dental Insurance Label 
Secondary Dental Insurance Label 
R elerred By P alien! Label 
R elerred By Dr /Olher Label 
R elerred To D oclor Label ,,, ..... O~, 

Prinl 

Close 

Quick Labels 
With Quick Labels, you can take advantage of the integration of Dentrix Enterprise with Microsoft Word to 
quickly create a label for a single patient. 

To print a quick label 

1. In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Quick Labels. Te Quick Labels dialog 
box appears. 

1 

2. Select the label you want to print: 

• Patient Mailing Label – A mailing label for the selected 
patient. 

• Guarantor Mailing Label – A mailing label for the 
selected patient’s head-of-house. 

• Patient Chart Label – A chart label for the selected 
patient, including his or her name, chart number, home 
phone, work phone, and address. 

• Abbreviated Chart Label – A chart label for the selected 
patient, including his or her name (in large, bold letters), 
SS#, date of birth, frst visit date, chart number, home 
phone, and work phone in a condensed format. 

2 
3 

• Detailed Chart Label – A chart label for the selected 
patient, including his or her name (in large, bold letters), SS#, date of birth, primary provider, chart 
number, frst visit date, marital status, gender, address, home phone, work phone, employer, primary 
insurance, and secondary insurance. 

• Primary Dental Insurance Label – A mailing label addressed to the patient’s primary dental 
insurance plan (if set up in the Family File). 

• Secondary Dental Insurance Label – A mailing label addressed to the patient’s secondary dental 
insurance plan (if set up in the Family File). 

• Primary Medical Insurance Label – A mailing label addressed to the patient’s primary medical 
insurance plan (if set up in the Family File). 

• Secondary Medical Insurance Label – A mailing label addressed to the patient’s secondary medical 
insurance plan (if set up in the Family File). 

• Referring Patient Label – A mailing label addressed to the patient who referred the patient to the 
practice (if set up in the Family File). 

• Referred By Dr/Other Label – A mailing label addressed to the doctor who referred the patient to 
the practice (if set up in the Family File). 

• Referred To Doctor Label – A mailing label addressed to the doctor that the patient has been 
referred to (if set up in the Family File). 

• Appointment Reminder Label – A reminder label listing the patient’s next appointment date and 
time. 

3. Click Print to print the selected label. For information about setting up a label printer for labels, see 
“Setting Up Default Printers” in Chapter 1: Introduction and Initial Setup. 
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Quick Letters - (Abbott, James SJ 

American Fork, UT 84003 

Phone: H (801)555·6177. 'W (801)555· 

Slalus: Active. M. Married, Guar. Ins, H 

Medical 
Alerls 

Employer 
H 

Select Letter-------------~ 

Letter Name 

Blank Letter Form 
Collection Notification 
Congratulations - G,aduation 
Congratulations - M auiage 
Congratulations · N ewB aby 
New Patient Welcome 
Patient Information-Consent 
Referred B_y Doctor 
R elerred By P alienl 
Referred lo Dr./Specialisl 

New Edit 

.doc 
B.doc 

dtxlm 12. doc 
dlxlm 11. doc 
dtxlm 1 0. doc 
dtxlm02. doc 
dtxpalv. doc 
dtxlm 15. doc 
dtxlm 16. doc 
dtxlm35. doc 

Delete Close 

1 

Quick Letters 
With Quick Letters, you can take advantage of the integration of Dentrix Enterprise with Microsoft Word to 
quickly create a letter for a single patient. 

To merge a quick letter 

1. Open and minimize Microsoft Word. 

2. In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Quick Letters. Te Quick Letters dialog 
box appears. 

2 

3. Select the letter you want to merge: 

• Address On Envelope (Form Feed) – An 
envelope for the selected patient. 

• Blank Letter Form –A blank letter for the 
selected patient with his or her name, address 
and greeting. 

3 

• Collection Notifcation – A 90 Day Past Due 
letter for the selected patient. 

• Congratulations – Graduation – A 
congratulations letter for a new graduate. 

• Congratulations – Marriage – A 
congratulations letter for a newly married 
patient. 

• Congratulations – New Baby – A congratulations letter for a new parent. 

• New Patient Welcome – A welcome letter for a new patient. 

• Patient Information – Consent – A patient information form with some patient information pre-
entered. 

• Referred by Doctor – A thank you letter for a doctor who referred the patient. 

• Referred by Patient – A thank you letter for a patient who referred the selected patient. 

• Referred to Doctor – A referral information letter for the doctor to whom the selected patient has 
been referred. 

4. Do one of the following: 

• To create and print the letter without reviewing it, click Print. 

• To create and review the letter in Microsoft Word prior to printing it, click Build/View. 

Note: Dentrix Enterprise adds an entry in the Ofce Journal that indicates a letter has been sent to the 
patient. 

4 
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Continuing Care 
Te Continuing Care module in Dentrix Enterprise is an up-to-date, fexible, and powerful means for 
monitoring your patients’ pending dental care (recall or recare). Te following is a short list of the advantages 
the continuing care system can bring to your ofce: 

• Multiple Recall Types – You can create as many continuing care types as needed. 

• Continuing Care Cards – You can efciently create continuing care reminder cards for patients with and 
without appointments to maintain communication with your patients. 

• Individualized Continuing Care – Each patient can have specifc continuing care defaults, such as 
intervals and providers. 

• Simplicity of Scheduling – Dentrix Enterprise helps you schedule continuing care for patients. By 
attaching the appropriate continuing care type to an appointment, the appointment automatically has the 
correct provider and amount of time needed. 

• Increased Tracking Ability – You can use continuing care to track not only exams and cleanings but 
patient statuses or activities, such as treatment plans. For example, you enter a treatment plan and assign 
it a continuing care type, which has a call back date. If the patient has not completed the treatment plan 
when the call back interval has lapsed, he or she appears on the continuing care list so that you can follow 
up with that patient to get an appointment scheduled. 

Te continuing care system is quite powerful, but there are two keys to using it efectively: 

• Knowledge – Because the continuing care system is so fexible, it will require you to learn how it works to 
make it work for you. 

• Time – It will take time to set up the continuing care system. Take the time now to get the system in 
place, and the benefts down the road will be well worth the efort. 

Tis section covers the following topics about the Continuing Care module: 

• Getting Started with Continuing Care 

• Opening Continuing Care 

• Using the Continuing Care List 

• Printing from Continuing Care 
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Getting Started with Continuing Care 
Before you start using the Dentrix Enterprise continuing care system, you must do some setup to get your 
continuing care program up and running. 

To get started with continuing care 

1. Set up the continuing care type defaults. 

Take some time to sit down as an ofce and defne what is to be tracked. Ten, add or modify existing 
continuing care types to meet the needs of your practice. For details about continuing care types, see 
“Setting Up Continuing Care Types” in Chapter 1: Introduction and Initial Setup. 

2. Assign continuing care types to procedures. 

Dentrix Enterprise can automatically assign continuing care types to patients when they have certain 
procedures completed. Additionally, Dentrix Enterprise will automatically update continuing care 
due dates when those procedures are completed. You will need to assign continuing care types to the 
procedures you want to use in this manner. For details about procedure codes, see “Editing Procedure 
Codes” in Chapter 1: Introduction and Initial Setup. 

3. Customize your Continuing Care view. 

Your practice will have a specifc way to organize or sort your list of continuing care patients. You can set 
up Continuing Care views to create many diferent ways of looking at the continuing care information. 
For details about Continuing Care views, see the “Managing Continuing Care views” topic in the Dentrix 
Enterprise Help. 

4. Customize patient continuing care defaults. 

For the next few months, when a patient schedules a continuing care appointment, take a minute to set 
up his or her continuing care defaults in the Family File. Teoretically, within six months, you will have 
set the continuing care defaults for every active patient in your continuing care program. For details about 
assigning continuing care to patients, see “Assigning Continuing Care” in Chapter 2: Family File, and see 
the “Overriding continuing care defaults” topic in the Dentrix Enterprise Help. 

5. Attach continuing care to appointments. 

From this point forward, when a patient schedules a continuing care appointment, make sure you attach 
the appropriate continuing care type to the appointment. For details about continuing care appointments, 
see “Scheduling Appointments” in Chapter 3: Appointment Book. 

Opening Continuing Care 
You can open the Continuing Care module from any main module. 

Tip: To view the continuing care for all clinics, you must access the Continuing Care module from the 
Appointment Book. 

To access Continuing Care 

In any module, from the File menu, click Continuing Care. Te Continuing Care window appears. 

If you open Continuing Care from the Patient Chart, Ledger, or Family File, the list shows continuing care 
information for the selected patient and his or her family members. If Continuing Care is opened from the 
Appointment Book or Ofce Manager, the list shows continuing care information for the entire patient 
database. 
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Fil e Edit Views Status Offic e Journ al Document Center 

ALL-> ALL ALL 
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Using the Continuing Care List 
As you go down the Continuing 
Care list, using the phone numbers 
shown, you can call each patient 
to schedule an appointment or 
change the status of the patient’s 
continuing care. For information 
about scheduling a continuing 
care appointment, see “Scheduling 
Appointments” in Chapter 3: 
Appointment Book. 

Printing from Continuing Care 
From Continuing Care, you can print the following: 

• Continuing Care List – To print the Continuing Care list for the entire practice, from the File menu, 
click Print. 

• Continuing Care Labels – To quickly print mailing labels, from the File menu, point to Print Mailing 
Labels, and then click the option that corresponds to the number of columns on your sheet of labels. 

Tips: 

• For instructions on how to create continuing care cards for patients who have already scheduled their 
continuing care visit, see “Creating Appointment Reminder Cards” in Chapter 8: Ofce Manager. 

• For instructions on how to create continuing care cards for patients who have not yet scheduled their 
continuing care visit, see “Creating Cards for Patients Without Appointments” in Chapter 8: Ofce 
Manager. 

Patient Questionnaire 
Patient Questionnaire is designed to replace the new patient forms, health history update, and other forms 
used in your ofce to collect information from patients. With Patient Questionnaire, you can create a custom 
set of questions that can be printed for your patients to answer. Once the patient completes the questionnaire, 
the answers can be input into Dentrix Enterprise so that you have an electronic copy of the information. 

For those ofces moving toward the “paperless ofce,” Patient Questionnaire is a way to computerize 
information that otherwise would be stored in a paper chart. Best of all, when the information needs to be 
reviewed for accuracy, a new copy with the previous answers can be generated; the patient only has to modify 
those items that have changed since the last visit. 

Tis section covers the following topics about questionnaires: 

• Setting Up Questionnaires 

• Printing Questionnaires 

• Entering Questionnaire Responses 
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Patient Questionnaires ~ 

Questionnaire Title 

Delete 

Questionnaire Setup - ~ 
r ' 

ues 1onnaire I e: Q t" . nl !New Patient Questionnaire l J 
Statement/Question I Default Response I New I '' 

If yes, please explain: y Edit I 
Have you ever had any complications following dental treatment? Delete I If yes, please explain: 

Have you ever been admitted to the hospital since your last visit? 
If yes, please explain: 

Are you currently under the care of a physician? 
If yes, please explain: 

I Move Up 
Do you have any health problems that need furthe, clarification? 
If yes, please explain: Move Down j 

◄ I "' .f ~ ~ Cancel I 

1 

OR2 2 

6 

3 

4 

Setting Up Questionnaires 
You can create and edit patient questionnaires to collect information from patients. Questions ask a patient 
to provide information. Statements provide a patient with information, such as instructions for completing a 
form. 

To create or edit a questionnaire 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Patient Questionnaire Setup. 

Te Patient Questionnaires dialog box appears. 

2. Click New to create a new questionnaire; or 
select an existing questionnaire, and then 
click Edit to edit that questionnaire. Te 
Questionnaire Setup dialog box appears. 

3. Type or change the Questionnaire Title. 

4. Do any of the following: 

• Add – To add a statement or question, 
Click New. In the Statement/Question 
for Questionnaire dialog box that 
appears, type the text for 
a statement or question as 
you want it to appear on the 
patient questionnaire form, 
select the appropriate text 
type, and then click OK. 

• Edit – To edit a statement or 
question, select that statement 
or question, and then click 
Edit. 

• Delete – To delete a statement 
or question, select that 
statement or question, and 
then click Delete. On the 
confrmation message that 
appears, click Yes. 

5 

Warning: If you delete a 
statement/question on a 
questionnaire assigned to a patient, Dentrix Enterprise also deletes the patient’s responses. 

Tips: 

• To change the type of statement or question (for example, from a “Note/Explanation” to a 
“Date”), delete the statement/question, and then re-enter it. 

• To arrange the order of statements and questions for your questionnaire, select an item, and then 
click Move Up or Move Down until the desired position is reached. 

5. Click OK to save the questionnaire and return to the Patient Questionnaires dialog box. 

6. Click Close. 
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Address: 1234 Oak St 

American F Olk, UT 84003 
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Slalus: Active, M, Married, Guar. Ins, H 

Medical 
Aleris 

Patient Questionnaire History - - (Abbott, James) [11/11/1962] [50] ~ 

Date Questionnaire 
02/0412009 New P alient Questionnaire 

Patient Questionnaire - test - (Abbott, James) [11/11/1962] [50] 

Questionnaire Dale: I 0411712013 

Statement/Question 

lf yes, please explain: 

Have you ever had any complications following dental treatment? 
If yes, please explain: 

Have you ever been admitted to the hospital since your last visit? 
If yes, please explain: 

Are you cunently under the care of a physician? 
If yes, please explain: 

Do you have any health problems that need further clarification? 
If yes, please explain: 

_ View__,p 

3 
Close I 

I Res□onse 1. 

Edit Close 

Printing Questionnaires 
You can print a questionnaire when a patient arrives for an appointment. Te printed questionnaire lists 
information that has been previously entered, including patient information, referral information, spouse or 
guarantor information, employment information, insurance information, and any answers that have been 
entered in the Patient Questionnaire module for a patient. Te patient can then correct those entries that are 
inaccurate and add any information not currently known. 

You can print a questionnaire from any module except the Ofce Manager. For a new patient with an 
appointment who does not yet have a Family File record, you must create a Family File record before you can 
print a questionnaire for him or her. 

To print a questionnaire 

1. In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Patient Questionnaire. 

1 

Te Patient Questionnaire History dialog box appears. 

2. From the Select Questionnaire list, select the questionnaire you 
want to print for the patient. 

3. Click New. 

Te selected questionnaire opens. 

4. Click a print button: 

• Print – To print the questionnaire. 
Te questionnaire has two pages: 
the frst page contains basic patient 
information, such as name, address, 
employer, insurance information, 
and referral sources; the second 
page contains your customized 
questions. Any information 
previously entered into Dentrix 
Enterprise prints on the form. 
Te patient will fll in the blanks 
and make corrections as needed. 

• Print Questions – To print a 
summary of patient information 
and your customized questions. 

2 
3 

4 
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Name: Crosby, B1ent 
Address: 1234 Oak St 

American Fork. UT 84003 

Phone: H (801 )555-61 77. W (801 )555· 

Patient Questionnaire History - - (Abbott, James) (11/11/1962] (50] 

View 

Patient Questionnaire - test - (Abbott, James) (11/11/1962] (50] ~ 

Questionnaire Date: 1 □411 71201 3 

Statement/Question .,...,. 
I Resoonse I_ 

II yes, please e,plain: 

Have you ever had an_y complications following dental treatment? 

Patient Questionnaire Response ~ 

I Do _you have an_y medical conditions we should be awa,e of? I 
r Yes Q r, No 

< Back I I Do Cancel I 

Print Questions I Print I Edit I 0 I 

Entering Questionnaire Responses 
Once a patient has completed a questionnaire, you can store the responses in Dentrix Enterprise. 

To input questionnaire responses from a patient 

1. 

from the File menu, click Patient Questionnaire. 

Te Patient Questionnaire History dialog box appears. 

2. Do one of the following: 

• From the Select Questionnaire list, 
select the questionnaire you want the 
patient to fll out, and then click New 
to add the questionnaire. 

• Select an existing questionnaire for the 
patient, and then click Edit to edit 
that questionnaire. 

Te Patient Questionnaire dialog box 
appears. 

3. Double-click the frst question 
listed. 

Te Patient Questionnaire 
Response dialog box appears. 3 

4. Select or type the appropriate 
patient response, and then click 
Next to advance to the next 
question. Repeat this until all 
questions are answered. 

5. Click OK to save the patient 
responses and return to the 
Patient Questionnaire dialog 
box. 

6. Click Close to close the Patient 
Questionnaire dialog box. 

7. Click Close to close the Patient 
Questionnaire History dialog box. 

In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 1 

OR2 2 

7 

6 

5 

4 
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Prescriptions Setup 

I l.sp I NOC/I 

24 

Ampicilliin 250 mg 18 

Oarvocet N Oarvocet N - 100 ... 12 

Daxycydine Doxycycline 100 .. 18 

Eiythromycin Eiythromycin 250 .. . 24 

Hycodaphen Hycodaphen 24 

KeflexCaps Keflex 250 mg ca ... 24 

Penicillin VK 500 .. 18 

Delete Print Setup I Route Setup 1 __ c_1os_• _ _. 

New Prescription 

Descri ption: 

IMoxicillin 

Drug Name: (Generic Name) 

IAmoxicillin 
0 r Drug Administered During Vis it Only 

Route: 

Dosage Form: 

!CAPS ULE ..:.l 
Brand Name: 

r Over-The-Counter r Controlled Substance 

NOC#: RxNorm #: Unique ID#: 

11111 12222 ..2:..1 1000, 
Dosage------~ Strength ------~ 

Qty Unit Qty Unit 

!Capsule 1mg 

Sig: ~ 

Duration:~ lweeks 

Disp: ~ Disp Unit 

Refi lls:~ 

r Dispense as Written 

..:.J lsuCCAL 

r, Generic Substitution Permitted 

Notes : 

..:.l 

Please advise our office if you experience an adverse reaction. Our 
emergency phone number rr (801 )555-5555. 

Cancel 

Prescriptions 
Te Prescriptions module can help you quickly create and accurately track medicines prescribed to your 
patients. Tis section covers the following topics about using the Prescriptions module: 

• Setting Up Prescription Types 

• Setting Up Prescription Printer Defaults 

• Entering Prescriptions 

• Re-printing Prescriptions 

Setting Up Prescription Types 
Prescription types are the default prescription settings. Te act as templates to help you quickly enter 
prescriptions into Dentrix Enterprise. You can add and edit these defaults at any time. 

To add or edit a prescription type 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Prescriptions Setup. 

1 

Te Prescriptions Setup dialog box 
appears. 

2. Do one of the following: 

• Click New to add a prescription. Te 
New Standard Prescription dialog 
box appears. 

• Select an existing prescription, 
and then click Edit to edit 
that prescription. Te Edit 
Standard Prescription dialog 
box appears. 

OR 

2 

2 

3. Set up the following options: 

• Description – Type a description for the prescription. Tis does not appear on the prescription. 

• Drug Name – 
Type the drug 
information. 3 

• Sig – Type the 
dosage interval 
and any 
instructions 
that you 
want to have 
print on the 
prescription. 

• Disp – Type 
the number or 
amount of the 
medication to 
dispense. 

4 
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Pr~ criptions Setup 

Date 

: .. 
11 /18/1997 

11 / 18/1997 

11 / 18/1997 

11/ 18/1997 

11 /18/1997 

11 / 18/1997 

11/ 18/1997 

11 / 18/1997 

New 

I Desaiption I Drug Name I Disp I NOC# ~ .. .. I 

Amoxicillin Amoxicillin 250 mg 24 

Ampicillin Ampicilliin 250 mg 18 

Darvocet N Darvocet N · 100 ... 12 

Doxycycline Doxycycline 100 .. 18 

Erythromycin 8)1hromycin 250 ... 24 -
Hycodaphen Hycodaphen 24 

KeflexCaps Keflex 250mg ca ... 24 

Penicillin VK Penicillin virr- -.... ~8 
~ 

Edit Delete ~ Route Setup Close 

Print Setup ~Qfil~ 1---------
Printer: 

Snagrt 11 
Send To OneNote 2010 

• .1 • I 
novaPDF 
Microsoft XPS Document Writer 
Fax 
Adobe PDF 

Form: 

!California State Form 

r Using preprinted paper 

..:.l 
r Pri nt Gender 

r Pri nt number for · Disp· as a word r Pri nt Chart# 

r Disable printi ng 

LeftOffset: 0 TopOffset: 0 

• Reflls – If the prescription may be reflled, type the number of reflls allowed. 

• Drug substitution 

• Dispense as Written – Select this option if the pharmacy may only use the drug named on the 
prescription. 

• Generic Substitution Permitted – Select this option if the pharmacy may fll the prescription with 
a generic drug. 

• Notes – Type any instructions regarding the prescribed medication for the patient. Te notes will 
print below the prescription. 

4. Click OK. 

For a comprehensive explanation of all the available options for prescription types, see the “Adding and 
editing prescription types” topic in the Dentrix Enterprise Help. 

Setting Up Prescription Printer Defaults 
You can customize the printer defaults for prescriptions printed from the Prescriptions module. 

To set up a prescription printer 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Prescription Setup. 1 

Te Prescription Setup dialog box appears. 

2. Click Print Setup. 

Te Print Setup dialog box appears. 

3. Set up the following printer options: 

• Printer – Select the printer you want 
to use to print prescriptions. 

• Form – If your state requires a 
specifc format for prescriptions, 
select the correct form. 

• Using preprinted paper – If you 
will be using preprinted paper when 
creating prescriptions, select this 
option. 

• Print number for “Disp” as a word – To list the 
number or amount of the medication to dispense as a 
word (for example, “four” instead of “4”), select this 
option. 

• Print Gender – To print a patient’s gender, select this 
option. 

• Print Chart # – To print a patient’s chart number, 
select this option. 

2 

3 

• Disable Printing – If you will be using the 
Prescriptions module to record prescription information but will not be printing prescriptions, select 
this option. 

4. Click OK to save the changes and return to the Prescriptions Setup dialog box. 

4 
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I Status I Drug Name 

04/18/2013 Darvocet N Darvocet N 

04/23/2013 AmOJ<icillin AmOJ<icillin 

New Patient Prescription ________ ______________ CJ @ ~ 

Amoxicillin 

Drug Name: (Generic Name) 

IAmOJ<icillin 500ng 
Dosage Form: 

lcAPSULE 

Brand Name: 

IAmOJ<icillin 

Encounter #: 

r Over-The-Counter 
NOC #: 

r Controlled Substance 
RxNorm#: 

152959-011 

age 

Qty 

ig: 

11234-002 

Unit 

)capsule 

Take 1 tablet 3times a day. 

reng 

Qty 

1500 

Pri nt 

Unique ID#: 

I 12345-0002 

Unit 

1mg 

..:.l 

...::..l 

~ 

Duration: 

r Drug Administered During Visit Only 

Route: 
~ ~ID_ays ___ ..:.l~ !AURICULAR (OTIC) 

Disp: iw--- Disp Unit lcapsule 

Refi lls: ~ 

r DispellSe as Written 

r. Generic Substitution Permitted 

lsmit.h, Dennis 

..:.l 

Entering Prescriptions 
In Dentrix Enterprise, you can add a prescription you are prescribing to a patient. 

To add a prescription 

1. In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Prescriptions. 

1 

Te Patient Prescription dialog box appears. 

2. Click the New Prescription button . 

Te New Patient Prescription dialog box appears. 

3. Click the Description search button to select a 
prescription type. 

4. Customize the prescription information for the 
patient as needed: 

• Dosage – Te 
amount of 
the drug that 
can be taken 
at one time 
(for example, 
1 Capsule). 

• Sig – Te 
dosage 
interval and 
instructions. 

• Drug 
Administered 
During Visit 
Only – Te 
drug was 
administered 
to the patient 
during his or her visit. 

• Duration – Te number of days, weeks, or months from the issued date that this prescription is 
valid. 

• Disp and Disp Unit – Te amount of the drug to dispense and the unit it is dispensed as. 

• Reflls – Te refll amount. 

• Drug substitution – Must be dispensed as written, or a generic drug substitution is allowed. 

• Notes – Instructions for the patient. 

5. If necessary, click the Prescriber search button  to select the provider who is prescribing the drug. 

6. Click Print to print the prescription. 

7. Click OK to save the prescription. 

3 

5 

6 7 

4 
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Edrt Patient Prescription 

Descri ption: 

lri.nlBll 
Drug Name: (Generic Name) 

11vnoxiallin srong 
Dosage Form: 

!CAPSULE 

Brand Name: 

l1vnoxiallin 

Encounter #: 

NOC #: RxNorm#: 

152959-011 11234-002 

Dosage Strength 

Qty Unit Qty 

11 lcapsule 1250 

Sig: 

Unique ID#: 

I 12345-0002 

Unit 

1mg 

Inactivate 

Phone: H (801)555·6177. W (801)555· 

Status: Active. M. Married, Guar. Ins, H 

Source: Local Manual 

r Drug Administered During fis,t Only 

Route: 

Duration: ~ ~ID_ays ___ ..:.J.., jAURICULAR (OTIQ ..:.J 

Disp: ~ Disp Unit 

Refi lls: io---
r Dispense as Written 

r, Generic Substitution Permitted 

Clinic: IAF 

Notes : I"'"'~,, ...... 
Prescriber: 

...::J 

!DESMITH ....::.J lsm~h. Dennis 

Re-printing Prescriptions 
You can re-print any prescription that has been added to a patient’s record. 

To re-print a prescription 

1. In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Prescriptions. 

Te Patient Prescription dialog box appears. 

2. Select the prescription that you want to re-print. 

3. Click the View Prescription button . 

Te Edit Patient Prescription dialog box appears. 

4. Click Print. 

5. Click Cancel to return to the Patient 
Prescription dialog box. 

3 

1 

2 

4 5 
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Phone: H (801 )555-6177. W (801)555-

Patient Alert - (Abbott, James S(Jim)) 

Start Date End Date Desc,iption Fam/Pat 

11 11912018 1112012019 Patient alert Pat 

Create Patient Alert - (Abbott, Ja 

'.;elect Date-------....:::,ee;­

Stari:1 11 /1412018 

r ,<l,lways 

r. E atient r E amily 

Description 

JAlert 

Note 

This is the alert not~ 

Delete 

Qptions-------~ 

r Show Symbol on 
Appointment 

r Display Aged Balance 
with Note 

~ Cancel ~ -

Patient Alerts 
Patient alerts are customizable alerts that you can attach to patients (and families) when you want a message to 
appear for certain conditions. A patient alert appears for a patient when someone accesses the specifed areas 
of Dentrix Enterprise. A patient alert attached to a family (a family alert) appears for a patient and any of that 
patient’s family members (as set up in the Family File) when someone accesses the specifed areas of Dentrix 
Enterprise. 

If a patient alert has been set up to have a fag symbol appear on appointments, the symbol appears on 
appointments for that patient. For a family alert, the symbol appears on appointments for all family members. 
Tere is also the option to include a patient’s aged balance in an alert for easy reference. 

Patient alerts are also essential in respecting patient’s requests for privacy and disclosure of information. You 
can manage patient alerts from any patient-specifc module, including the Family File, Patient Chart, Ledger, 
and Appointment Book.. Tis section covers the following topics about patient alerts: 

• Creating Patient Alerts 

• Suspending Patient Alerts 

• Suspending Patient Alerts Temporarily 

Creating Patient Alerts 
You can create up to 10 alerts for any patient. 

To create a patient alert 

1. In any patient-specifc module (for example, the Family File), with a 
patient selected, from the File menu, click Patient Alerts. 

If any patient alerts exist for the patient, the Patient Alert dialog box 
appears. However, if the patient does not have any patient alerts, the 
Create Patient Alerts dialog box appears; skip to step 3. 

2. Click New. 

Te Create Patient Alert dialog box appears. 

1 

2 

3. Set up the following options: 

• Select Date – In the Start and End felds, type the 
date range for which you want the patient alert to 
appear in the specifed areas, or select Always to 
always display the patient alert when information 
about the patient is accessed and/or to always 
display an icon on the patient’s appointments. 

3 

• Patient or Family – Patient is selected by default. 
To make this alert appear for all family members, 
select Family. 

• Description – Type a description for the 
patient alert (for example “Collections” or “Pre-
Medicate”). 

• Patient Alert should display for the patient in 
the following areas – In the list box, select all 
areas of Dentrix Enterprise in which you want the 
patient alert to appear, or select All to have the patient alert appear in all areas. 

4 
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Preferences 

General Options I Pnnt Options I Statement Fonns I Paths 

Find Appointment Time Defaults-----~ 

B_lock ji'5""3 Min. Appl ~ » I 
size: Length: I ' .., .....::::.:::.J 

P" All Operatories Selected 

r Sort Results By Operalory ID 

Quick Letters-----~ 

r♦ Include Today's Dale 

r Exclude Today's Dale 

C. ByView 

r ByClinic 

Spell Check--------, 
P' Enable Spell Check 
P' Mark All Misspelled Text 
P' Mark Misspelled New Text 

Additional Options-------~ 

r Pe,io Beep on E ntr_y 

., Suspend P alien! Alerts 

r Suspend Treatment Area Flags 

P' Auto-Insert Name/Dale (Clinical Nole) 

r Use Classic Clinical Noles Dialog 

r Use Classic Treatment Plan Presenter 

Instances of Presenter: [4' 
J7 Show Close Message for T x Planner 

P' Show Close Message for Doc Center 

'Apply lo Charges for' Default----~ 

r♦ Family r Ledger View 

Cancel 

Patient Alert - (Abbott, James S(Jim)) 

Description 

jAlerl 

Nole 

This is the alert note 

Balance Information 

0-->30 31-->60 61-->90 
1901 .00 000 000 

Payment Ami: 100.00 
(4) Bill Type: 

Start: I 04/17/2013 

End: I 04/1712014 

91--> Suspended Patient Balance 
703.00 000 

Ami Past Due: 
Last Payment: 

000 
0.00 

2604.00 

r Do Nol Show This Alert Again Today OK 

• Show Symbol on Appointment – To have a fag symbol show in the upper-right corner of 
appointments for the patient, select this option. 

• Display Aged Balance with Note – To have the patient’s account balance information show with the 
alert, select this option. 

• Note – Type a detailed description of the alert. 

4. Click OK. 

Suspending Patient Alerts 
You can suspend all patient alerts on a specifc computer. When this option is enabled, the workstation will 
ignore all patient alerts for all patients. 

To suspend patient alerts on a computer 

1. In the Ofce Manager, from the Maintenance menu, point to 
Practice Setup, and then click Preferences. 

Te Preferences dialog box 
appears. 

2. Under Additional Options, select 
Suspend Patient Alerts to disable 
patient alerts on this computer. 

1 

2 

3. Click OK. 

3 

Suspending Patient Alerts Temporarily 
When a patient alert appears for a patient, you can 
select the Do Not Show Tis Alert Again Today 
check box, and then click OK. Tat alert for that 
patient will not appear on any of the computers in 
the ofce for that day. 
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Offce Journal 
Like a journal of your daily activities, the Ofce Journal has two main functions: to keep a record of past 
events and to remind you of events in the future. Te Ofce Journal helps you keep a comprehensive record of 
contact made between your ofce and your patients. 

Also, Dentrix Enterprise automatically adds entries for appointments, billing statements, letters, payment 
agreement notes, payments, and privacy requests: 

• Appointments – Te Ofce Journal will record the following appointments: 

• Scheduled appointments – Te date, time, appointment provider, and appointment reason. 

• Purged appointments – Te original date, time, reason, and provider for the purged appointment. 

• Broken appointments – Te original appointment date, time, reason, and provider. 

• Billing statements – Te Ofce Journal will record the date, “Please Pay” amount, and account balance 
of billing statements generated. 

• HIPAA privacy – Te Ofce Journal will record when any privacy requests are made through the Family 
File. 

• Letters – Te Ofce Journal will record the date, provider, and the name of any letters generated for 
patients, using either Quick Letters or Letters from the Ofce Manager. 

• Payment agreement notes – Te Ofce Journal will record the date, provider, and notes of any payment 
agreements entered. 

• Payments – Te Ofce Journal will record the date, provider, and amount of any insurance and patient 
payments. You can view guarantor transactions when viewing a guarantor or an entire family in the Ofce 
Journal. 

Tis section covers the following topics about using the Ofce Journal: 

• Opening the Ofce Journal 

• Te Ofce Journal Window 

• Adding Manual Journal Entries 

Opening the Offce Journal 
You can open the Ofce Journal from any module, the ASAP List, the Unscheduled List, Continuing Care, 
and the Collections Manager. 

To open a patient’s Ofce Journal 

In any patient-specifc module (for example, the Ledger), with a patient selected, from the File menu, click 
Ofce Journal. 

Tip: From the Ofce Manager, you cannot select a patient, but you can still open the Ofce Journal. From 
the File menu, click Ofce Journal; cancel the dialog box that prompts you to select a provider or staf 
member; from the View menu, click By Patient; and then select a patient. 
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~ Office Journal - Patient: Abbott, Patric ia [11/11/1963 ] [49] 

• • File Edit View Help 

- - ◊r8 I Ii 1 ◊Iii. ~ =~ := 1 iji.. ~ 1 m 
El l'l) 12/12/2008 

____ , '··:c:'.1-
El ~ 12/11/2008 

~ Billing Statement 

Patient -After 01/17/2013 
Prov/Staff at All Clinics - Selected 

Letter 

Operator, ENTERPRISE 

Date, 12/12/2008 

Time, 

Note, 

New Patient A 

Welcome­
dtxlm02.doc 

' 1---"~'----.I ' 

A 

~ 

11 

-

The Offce Journal Window 
Te Ofce Journal window consists of a menu bar, toolbar, list of entries, and details pane. 

Menu Bar 

Toolbar 

Entries 

Details 

Tis section covers the following topics to help you understand how to use the Ofce Journal window: 

• Te Ofce Journal Toolbar 

• Changing the Ofce Journal View 

The Offce Journal Toolbar 
Te Ofce Journal includes a toolbar with buttons to access features of this module. 

Each button on the toolbar is explained in the following table. 

Click the Close Ofce Journal button to close the Ofce Journal module. 

Click the Add Journal Entry button to add an entry for the selected patient. 

Click the Select button to select a patient, provider, staf member, or referral. 

Click the Patient Alerts button to view and manage the selected patient’s alerts or add new alerts. 

Click the Expand button to expand the list of entry dates to see more information. 

Click the Collapse button to collapse the list of entries to see only the entry dates. 

Click the Journal button to switch between viewing entries by patient and family. 

Click the Info button to show or hide the additional details for the selected entry. 
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View Filters 

Filter By: ---+-~ 
r Thi s Clinic 

r- All Clinics 

Entries Dated After: 

1 □ 1 /17/2013 

Cancel 

Changing the Offce Journal View 
You can specify whether you want to view journal entries by patient or family, provider or staf, and by 
referral. You can also flter the list of entries that appear in the Ofce Journal according to criteria you specify. 

To change the view 

• Patient or Family – If you are not viewing the Ofce Journal by a patient name, to view entries for a 
certain patient, from the View menu, click By Patient, and then select a patient. To view entries for an 
entire account, while viewing a patient’s entries, from the View menu, click Family. 

Note: When viewing a family member who is not the guarantor, the Ofce Journal does not display 
entries for billing statements and guarantor payments. Tese items appear only when viewing the family’s 
guarantor. 

• Provider/Staf – If you are not viewing the Ofce Journal by a provider or staf member, to view entries 
for a certain provider or staf member, from the View menu, click By Provider/Staf, and then select a 
provider or staf member. 

• Referred BY or Referred TO – If you are not viewing the Ofce Journal by a referral, from the View 
menu, to view entries for a certain referral, click By Referral By or By Referred To, and then select a 
referral. 

To customize the view 

1. In the Ofce Journal, from the View menu, click Filters. 

A dialog box of flters appears (the name depends on the current view). 

2. Set up the flter options for the current view: 

• Patient or Family 
• Select Journal Entry Types – Select the 

entry types you want to view, or select All 
Journal Entry Types to include all types. 

• Filter By – Select Tis Clinic to view entries 
from the current clinic or All Clinics to 
include all clinics. 

• Entries Dated After – To view only items 
after a certain date, type a cut-of date. 

• Provider/Staf 
• Select Journal Entry Types – Select the 

1 

4 

2 

3 

entry types you want to view. For Phone 
Calls, Reminders, Miscellaneous, and 
HIPAA Privacy, select the accompanying Include Patient Entries check box to include all 
patient entries for any of the selected types too. 

• Entries Dated After – To view only items after a certain date, type a cut-of date. 

• Referral BY or Referred TO 
• Select Journal Entry Types – Select the entry types you want to view, or select All Journal Entry 

Types to include all types. 

• Select Provider/Staf – Select the providers and/or staf you want to view, or select For All Prov/ 
Staf to include all providers and staf. 

• Entries Dated After – To view only items after a certain date, type a cut-of date. 

3. Select Save as Default to save the current settings for the next time you open the Ofce Journal. 
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Add Journal Entry - Baber, Kirk 0 

Type 

I Phone Call ..:J 
Prov/Staff 

IDDSl ~ 

Description 
!Description here 

Note 
Note herel 

~ 

~ Office Journal - Patient Abbott, 

Edit View Help 

NH I I I ◊-- ~ =~ != 

Date (mm/dd!YY,YY,,.~)~----­
I04/17120n 

Time (hh:mm:ssl-) ______ _ 

r4:58:56 PM 

Cancel 

1 

4. Click OK to return to the Ofce Journal with the selected view settings. 

Adding Manual Journal Entries 
You can manually add four types journal entries into the Ofce Journal: Phone Call, Reminder, Misc, and 
HIPAA. Tese entries will include the date, time (except for reminders), and provider/staf members, and you 
can add a note. 

To add a manual entry 

1. In the Ofce Journal, from the Edit menu, click Add. 

Te Add Journal Entry dialog box appears. 

2. Set up the following options: 

• Type – Select a type: 

• Phone Call – Use when making 
a phone call to a patient. Record 
information regarding the 
conversation. 

• Reminder – Use with a future 
date as a reminder about a contact 
with a patient. 

• Miscellaneous – Use for any other 
contact with the patient for which 
you want to keep a record. 

• HIPAA Privacy – Use to track 
patient information disclosure 
history and other privacy related 
notes for patients, providers, staf, 
and referrals. 

3 

2 

• Prov/Staf – Click the search button  to select a provider or staf member to assign to the journal 
entry. 

• Description – Type a short description for the journal entry. 

• Note – Type a longer description of the journal entry. 

• Date – If needed, change the date of the journal entry. 

• Time – If needed, change the time of the journal entry. 

3. Click OK to save the entry. 

Notes: 

• Automatic entries (for appointments, billing statements, and so forth) cannot be edited, but you can edit 
manual journal entries. 

• Payment, appointment, and payment agreement note entries cannot be deleted from the Ofce Journal, 
but you can delete manual journal entries. 
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Collections Manager 
With the Collections Manager module you can increase your practice’s revenue by decreasing your account 
receivables. Te Collections Manager displays a list of overdue accounts that need to be contacted, based 
on aged balances, payment dates, and other information you select. From this list, you have access to all the 
relevant information for an account to make decisions about collections. 

Also, with the Collections Manager, you can merge a letter, dial a phone number, and send an email message. 
Once the patient is contacted, you can make notes regarding the contact, set up a payment agreement, 
or change a billing type. Pulling all of this information and functionality into one window can make the 
collections process smoother, more efcient, and more productive. 

Tis section covers the following topics about using the Collections Manager: 

• Opening the Collections Manager 

• Setting Up a View 

• Te Collections Manager Window 

• Contacting Patients 

• Removing Accounts from the List 

• Adding Ofce Journal Entries 

• Adding Guarantor Notes 

• Setting Up Payment Plans 

• Printing from the Collections Manager 

Opening the Collections Manager 
You can open the Collections Manager from the Ofce Manager. 

To open the Collections Manager 

In the Ofce Manager, from the Analysis menu, click Collections Manager. 

If a view has never been set up for the Collections Manager, the Collections Manager View dialog box 
appears so that you can set up a view for the Collections Manager before you can use the module; otherwise, 
the Collections Manager window appears and loads the view according to the flters set up previously. 
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Collections Manager View: Select Clinic 

Select G uar an tor 

From: I <ALL> 

To: l<ALL> 

r All Gua,antors 

2:.1 
2:.1 

Select Billing Type: P' All Billing Types 

1: Standard Billing - finance charges 
2: Standard Billing - no finance charges 
3: Insurance Family - delay finance cha,ges 
4: Insurance Family - finance charges 
5: Payment Plan - finance charges 
6: Payment Plan - no finance charges 
7: No Statement and No Finance Cha,ges 
8: Bad Debt· at risk 
9: Bad Debt · lo collections 

r Skip Accounts With Claim P_en_d_in_g __ _ 

11 P alien! Portion Less Than· I 0. 00 

For Payment Agreement (PA) & 
F ulure Due P aymenl Plans (FD): r All 

With a Payment Ag,eement 
With a F ulure Due P aymenl Plan 
With B olh a PA and a FD 

List Accounts-----~ 

r ... by Provider P' All 

C- ... by Clinic P' All 

Minimum Days Past Due 

C- Dver O r Over 30 

r Dver 60 r Over 90 

Ins Min Days Past Due 

r. Ove, 0 

r Over 60 

r Over 30 

r Over 90 

Select :It of Pmts Missed 

r No pmls missed 

(. 0 01 more r 2 or mo1e 
r 1 OJ more r 3 ormme 

Without a Payment Agreement 
Without a Future Due Payment Plan 
Without a PA and without a FD 

r Show Totals Show Columns ... 

Min Balance: ~ 

Accounts with r;::;-;:;;=;--­
suspended amount > = IO. OO 

r Last Pml Befo_re_: ____ _ 

r II Not Billed Since: 

r Last Visit Befor __ e: ____ _ 

r Previous OJ E nlry B elore: 

~ 
Cancel I 

Help 

1 

1 

OR 

2 

Setting Up a View 
Te frst time you try to use the Collections Manager, you must frst set up a view. Setting up a view allows 
you to flter out certain accounts so that only the accounts you want to contact appear. Once you have 
selected your view options, you can choose what account information you want to have appear in the list. 

To set up a view 

1. Do one of the following: 

• In the Ofce Manager, from the Analysis menu, click 
Collections Manager. If a view has never been set up for the 
Collections Manager, the Collections Manager View dialog 
box appears. 

• In the Collections Manager, click View Setup on the menu 
bar. Te Collections Manager View dialog box appears. 

2. Set up the following flters: 

• Select Guarantor – Click 
the From and To search 
buttons to select a 
range of guarantors to 
include, or select All 
Guarantors to view all 
guarantors that meet the 
search criteria. 

Tip: If you have a very 
large patient base and 
want to limit the length 
of the list for ease of use, 
you can use A – J names 
one week, K – S names 
the next week, and so on. 

3 

• Select Billing Type – 
Select up to 10 billing types for accounts you want to include (to select multiple items, while pressing 
the Ctrl key on your keyboard, click each item), or select All Billing Types to include accounts with 
any billing type. 

Tip: If you want the view to include more than 10 billing types, view the list by all billing types or in 
groups of 10. 

• Skip Accounts With Claim Pending – If your ofce waits for insurance to pay before collecting 
from an account, select this option. Dentrix Enterprise will exclude accounts that have insurance 
claims outstanding as long as the guarantor portion of the balance is less than the specifed amount in 
the If Patient Portion Less Tan feld. 

• For Payment Agreement (PA) & Future Due Payment Plans (FD) – Select All to include all 
accounts regardless of whether or not a payment agreement or future due payment plan has been set 
up for an account, or select one of the options in the list box to limit the view to only certain types of 
accounts. An account will be included if it matches at least one of the selected criteria. 
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• List Accounts 

• By Provider – Click the search button  to select the primary providers of the guarantors you 
want to include, or select All to include all providers. 

• By Clinic – Click the search button  to select the clinics of the accounts you want to include, 
or select All to include all clinics. 

• Minimum Days Past Due – Select a minimum number of days past due to include only accounts 
with the specifed minimum aged balance or older. 

• Ins Min Days Past Due – Select a minimum number of days past due to include only accounts with 
outstanding insurance claims that have the specifed minimum aged balance or older. 

• # of Pmts Missed – Select a number of payments missed to include accounts that have missed a 
certain number of payments toward a payment agreement. 

Tip: If you do not want to use this flter, select 0 or more. 

• Show Totals – To display the total amounts for all the guarantors included, select this check box. 

• Min Balance – Type an amount to exclude accounts with a balance less than that amount, or enter 
0.00 to include accounts with any balance. 

• Accounts with Suspended Amount – Type an amount to include accounts with a suspended amount 
equal to or greater than that amount, or enter 0.00 to include accounts with any suspended amount. 

• Last Pmt Before –To exclude guarantors who are making regular payments toward their account 
balances, select this check box, and then type the latest date a payment must have been posted. For 
example, if you allow guarantors 30 days to make a payment, enter a date that is one month prior to 
today’s date. 

• If Not Billed Since – To exclude accounts that have recently received a billing statement, select this 
check box, and then type the latest date an account a billing statement must have been sent. For 
example, if you want to include accounts that have received a billing statement over two weeks ago, 
enter a date that is two weeks prior to today’s date. 

• Last Visit Before – To exclude accounts with patients who have been seen recently, select this check 
box, and then type the latest date a family member must have been seen. 

• Previous Ofce Journal Entry Before – To exclude accounts based on the last manual entry in 
the Ofce Journal, select this check box, and then type the latest date a guarantor must have had a 
manual Ofce Journal entry entered. 

• Show Columns – To specify what information you want to display, click Show Columns. Tere will 
be a column for each item you choose to show. 

3. Click OK to open the Collections Manager with the selected view options. 
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Abbott, James 0.00 0.00 0.00 0.00 0.00 0.00 N/A 0.00 0.00 0.00 
Abboll. James S 0.00 0.00 0.00 0.00 0.00 -104.00 N/A 0.00 0.00 0.00 
HMlll:fuHIM l§•f◄ • 11111 11111 1111 §•ti• 11111 Id 11111 11111 @•ta■ 
Davis, Harmon 208.00 0.00 0.00 0.00 208.00 0.00 N/A 0.00 0.00 208.00 
Davis, James P 0.00 0.00 0.00 0.00 0.00 0.00 N/A 0.00 0.00 0.00 
Davis, Karen 92. 00 0.00 0.00 0.00 92.00 0.00 N/A 0.00 0.00 92.00 
Davis, Kelly 0.00 0.00 0.00 0.00 0.00 0.00 N/A 0.00 0.00 0.00 
Davis, Kristin 8000 0.00 0.00 0.00 BO.DO 0.00 N/A 0.00 0.00 BO.OD 
Davis, Lyle 0.00 0.00 0.00 0.00 0.00 0.00 N/A 0.00 0.00 0.00 
Davis, Patiicia 0.00 0.00 0.00 0.00 0.00 0.00 N/A 0.00 0.00 0.00 

~ 
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The Collections Manager Window 
Te Collection Manager window consists of a menu bar, a toolbar, and the list of guarantors that meet the view criteria 
you specify. 

Tis section covers the following topics to help you understand how to use the Collections Manager window: 

• Te Collections Manager Toolbar 

• Adjusting Column Widths 

• Sorting the List 

The Collections Manager Toolbar 
Te toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise. 

Te function of the buttons specifc to the Collections Manager are explained in the following table. 

Click the Send Message button to compose and send an email to the selected patient. 

Click the Ofce Journal button to record any communications with the selected guarantor. 

Click the Document Center button to attach a document, picture, or letters to the selected 
guarantor’s record. 

Click the Patient Alerts button to enter an alert for the selected guarantor. 

Click the Patient Finances button to add payment plans or change the selected account’s billing 
type. 

Click the Guarantor Notes button to enter notes for the selected account. 

Click the Print button to print the list of accounts being viewed. You have the option to include 
account notes on the printed list. 
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New Patient Welcome 
Patient I nfo,mation-Consent 
Referred By D oclor 
R efened B .v Patient 
Referred lo Dr./Specialisl 

New Edit 
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dlxlm08.doc 
dlxlm12.doc 
dlxlm11 .doc 
dlxlm1 O.doc 
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dtxlm15.doc 
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dlxlm35.doc 

Delete 

alance 

Close 

Adjusting Column Widths 
To make viewing and editing the Collections Manager list easier, you can adjust the width of each individual 
column. 

To adjust the size of a column 

Click the right column border of the column header you want to resize, and 
then drag it to the left to decrease the size of the column or to the right to 
increase the size of the column. 

Sorting the List 
To sort the list by any of the columns being displayed, click the desired column header. 

Contacting Patients 
Once you have generated a list of accounts that need to be contacted, the Collections Manager provides ways 
for you to quickly contact each patient. Tis section covers the following topics about contacting patients: 

• Sending Collection Letters 

• Sending Collection Email Messages 

Sending Collection Letters 
From the Collections Manager, you can quickly create a collection letter using any of your pre-written letter 
templates. 

To create a collection letter for a guarantor 

1. With a guarantor selected in the Collections Manager, from the File menu, 
click Quick Letters. 

Te Quick Letters dialog box appears. 

2. Select the letter you want to merge. 

3. Click Build/View to merge the letter in Microsoft 
Word. For more information about Quick Letters, see 

1 

2 

3 
“Quick Letters” in this chapter. 

Sending Collection Email Messages 
From the Collections Manager, you can quickly contact your patients through email. 

To send an email message 

With a guarantor selected in the Collections Manager, from the File menu, click Send Message to compose 
an send an email message. For more information about this email feature, see “Sending Email Messages” in 
this chapter 
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Removing Accounts from the List 
You can temporarily remove an account from the Collections Manager list. If no information has changed 
when the list is generated again, the account will reappear on the list. 

To remove a guarantor from the list 

With a guarantor selected in the Collections Manager, right-click that guarantor, and then click Hide 
Account. Te selected account is removed from the list for the current viewing session. 

Adding Offce Journal Entries 
After you have attempted to contact or have successfully contacted a patient, you can enter notes regarding 
the attempted or successful contact as an Ofce Journal entry. 

To add an Ofce Journal entry 

1. With a guarantor selected in the Collections Manager, from the File menu, 
click Ofce Journal. 

Te Ofce Journal opens. 

2. Add a journal entry as 
explained in “Adding 
Manual Journal Entries” in 
this chapter. 

3 2 

3. Close the Ofce Journal to 
return to the Collections 
Manager. 

1 
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Adding Guarantor Notes 
After you have contacted a guarantor, you can add notes regarding the account from the Collections Manager. 

To add an account and/or billing statement note 

1. 

2. 

3. 

With a guarantor selected in the Collections Manager, from the File menu, 
click Guarantor Note. 

Te Guarantor Notes dialog box appears. 

Type an account note and/or billing 
statement note. For information about 
guarantor notes, see “Working with Notes 
in the Ledger” in Chapter 7: Ledger. 

Click OK. 

1 

3 

2 

Setting Up Payment Plans 
From the Collections Manager, you can set up a payment plan for a patient you have contacted. 

To set up a payment plan 

1. In the Collections Manager, double-click a guarantor. If a payment plan 
does not already exists for the individual or family, on the message that 
appears and asks if you want to create a payment plan, click Yes . 

Te Patient Finances window opens. 

2. Select the Payment Plans tab. 
1 

3. To create a payment plan, click New Plan. For information about payment 
plans, see “Creating Payment Plans” in Chapter 7: Ledger. 

2 
3 
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Printing from the Collections Manager 
From the Collections Manager, you can print the following: 

• Collections Manager List 

• Mailing Labels 

For instructions on how to export the Collections Manager list to a spreadsheet program, such as Microsoft 
Excel, see the “Analyzing collections information” topic in the Dentrix Enterprise Help. 

Collections Manager List 
You can print all the accounts and the information for each, including guarantor notes, being viewed in the 
Collections Manager. 

To print the Collections Manager List 

1. In Collection Manager, from the Print menu, click Collections List. 

A dialog box appears. 

2. If you want to include Guarantor Notes for each account on the 
list, select Include Guarantor Account Notes. 

3. Click Yes. Te list prints from the default printer for the Ofce 
Manager. 

1 

2 

3 

Mailing Labels 
You can print mailing labels for all guarantors being viewed in the Collections Manager. 

To print mailing labels 

In the Collections Manager, from the Print menu, point to Mailing Labels, 
and then click the option that corresponds to the correct number of columns 
to print on the sheet of labels you are using. On the confrmation message 
that appears, click Yes. Te labels print from the default printer for the Ofce 
Manager. 
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	Structure Bookmarks
	• Misc – If the patient is being seen for something else, click Misc. The Procedure Codes dialog box appears. Select the 
	• To schedule an appointment for the patient, click the New Appointment button . 
	• To open the patient’s Chart, click the Patient Chart button . 
	• To manage the patient’s medical alerts, click the Medical Alerts/Problems button . 
	• To open the patient’s Treatment Planner, click the Treatment Planner button . 
	• To manage the patient’s health assessments, click the Patient Health Assessment button . 




